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INTRODUCTION 

How to use this documentation 

READ THE NEXT TWO PAGES, 
EVEN IF YOU DON'T READ ANYTHING ELSE. 

Many people read their user's manual only as a last resort. If you are 
one of those, the next two pages tell you where to find information when 
you need it. 

Installation To learn how to install Ventura Publisher for Windows, follow the 
procedures in the Ventura Publisher Installation and Configuration 
Guide. 

User interface Read the User Interface chapter to learn about the components of the 
screen, dialog boxes, using the mouse, and about keyboard shortcuts. 

Training To learn how to use the basic features, perform the exercises in the 
Ventura Publisher Training Guide. Chapter 3 of this Reference Guide 
describes each of the main tools used for creating documents in Ventura 
Publisher as well as their use. Also included in Chapter 3 is information 
on Ventura Publisher's file structure, and how to create the basic types 
of documents typically generated using electronic publishing. 

Menu options The Menu Options chapter contains a complete list of the options 
available in each menu and in the button bar. 

Examples To learn by looking at examples, select the Open Chapter option in the 
File menu and then select the example chapters contained in the 
TYPESET sub-directory. The style sheets associated with each of these 
chapters are shown in Appendix J. 

Problems If you have a problem, read through the Troubleshooting appendix 
(Appendix C). You should also consult the Troubleshooting heading in 
the index. 

1 -1 
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Advanced Other useful information about advanced installation, printers, word 
operation processors, and advanced operation is contained in the various appen­

dices. 

Cautions 

Do not use the Windows File Manager or the DOS COpy command to 
copy chapters. Use the Manage Publication option dialog box Copy 
All option instead (refer page 5-47). 

One final suggestion: don't lose your work due to a power outage or 
computer malfunction. Save your work often! 

Technical support 

Refer to the Product Registration booklet for details about telephone 
support. 
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Features and limitations 

Features Ventura Publisher for Windows is a professional page layout and docu­
ment composition system that lets you create typeset documents by 
automatically combining text from word processors with pictures from 
popular graphics software programs. Line art can be generated in CAD 
or other drawing packages and directly placed anywhere in a document. 
Images created by a graphic artist can be digitized with a scanner, 
converted to GEM, PCX, EPS, or TIFF file format, and then displayed, 
scaled, cropped, and moved on the computer screen. You can also create 
simple drawings directly in Ventura Publisher. 

The resulting pages are formatted automatically by style sheets. A style 
sheet is a computer file which contains typographic attributes (e.g., 
fonts, ruling lines, inter-line spacing.) These attributes are grouped 
together into tags which can then be applied to each paragraph in your 
document. By applying a tag to a paragraph, you change the typographic 
attributes for that paragraph. The same style sheet can be used for 
many documents, resulting in consistent typography from one document 
to the next. Also, a style sheet designed by a typographic professional 
can be used by an amateur to produce sophisticated documents. 

Ventura Publisher makes a unified chapter of each document by creat­
ing a unique chapter file for it. The chapter file binds together all the 
separate text, graphics, and style sheet files associated with a particular 
document and tells the computer where to look for them and how to 
place them on the page. 

Limitations Ventura Publisher is designed to handle large amounts of data in order 
to create extremely large chapters and publications. Ventura Publisher, 
however, does have its limitations. The following table lists the opera­
tionallimitations of Ventura Publisher. 

Max. number of files handled per chapter .......... 128 
Max. number of pages per chapter ................ 9,999 

Max. number of tags per style sheet . . . . . . . . . . . . . . . 128 

Max. number of colors per style sheet ............. 253 

Max. number of files listed in the Open File dialog box 128 

Max. number of chal!ters J!er publication . . . . . . . . . . . 128 

These are operational limits of the Ventura Publisher program itself. 
Your chapter and publication size may be further limited by the avail­
able memory in your computer. 
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Typographical conventions 

1-4 

In this manual, the ~ callout emphasizes important points. 

When a specialized term is used for the first time, it appears in italics. 
Ventura Publisher chapter names mentioned in the text appear in 
upper-case letters, as do computer file names and directories. 

The names of menus, and menu and dialog box options when they refer 
to actions which you should perform appear in boldface type (e.g., 
Chapter menu, Spacing option button). References to information that 
you are required to enter in a dialog box entry field or in a chapter will 
appear in monospaced type (e.g., This is an example). 

Throughout this manual, when you see Enter you should press the 
Enter key (sometimes called the Return key). Additionally, 

The term Cursor refers to the screen cursor that moves when you move 
the mouse. The shape of this cursor depends on the function selected, 
and on the nature of the action being performed (see figure 2-5 on page 
2-12). 

The term Text Cursor refers to the vertical line cursor that indicates 
the location where text is currently being added or deleted. The text 
cursor is always placed between characters, and is active only when 
you are using the Text tool. 

The phrase Select the ... means you should move the mouse cursor to 
the middle of the item that you are going to select, and then press the 
left mouse button once. 

When a procedure or description tells you to "Click on" a button, this 
indicates that a button is available for the option, and it is one of the 
default set of buttons. If the procedure or description tells you to "Select" 
the option from the menu, this indicates that either no button is avail­
able for that option, or the button is not part of the default set of buttons. 

Except when explicitly stated otherwise, the computer hard disk is 
always assumed to be C. The term floppy disk refers to either 5114" or 
3112" diskettes. 



USER INTERFACE 

This chapter will familiarize you with the operation of the components 
of the Ventura Publisher main screen. The main screen consists of the 
main work area, the menu bar, the button bar, the current selection 
indicator, the page number indicator, the zoom controls, and the page 
buttons. 

This chapter also describes the use of the mouse and the operation of 
keyboard keys that perform special functions within Ventura Publisher 
Windows Edition. The general operation of the Windows user interface 
is described in your Windows documentation and will not be repeated 
here. Your Windows documentation describes the general conventions of 
the Windows Graphical User Interface (GUI) such as operation of the 
pull down menus, selection of file names, and operation of dialog boxes. 

Title Bar 

1 
, ..... " ... 

Edit ~iew 

Rulers Tags List 

Current Selection --t--:t--_____ 

Indicator Page Buttons 

Zoom Controls 
Page Number 

Figure 2-1. Ventura Publisher main screen. 
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Menu Bar 

Button Bar 

Menu Bar 

The menu option chapters (Chapters 5 through 13) describe the opera­
tion of each menu, and menu option, and tool option in the button bar. 
Each of these chapters describe the options available in the menu. For 
each menu option described, the button for that option is also shown if 
one exists. 

The button bar consists of a number of icons (pictures), each repre­
senting a tool or option which you can use to create and modify your 
documents. The button bar also contains the Tags list and the Files list. 

Function Buttons Files List Tool Buttons Tab Buttons 

2-2 

Tags List Tool Option Buttons 

The appearance of any particular button on the button bar is dependent 
on the user's configuration of the button bar. The default set of option 
buttons for each tool is shown in the Tool Description section of Chapter 
3. A complete listing of all available buttons and their corresponding 
function is shown in Chapter 4. 

Operation summary 

To select a tool, move the mouse cursor to the appropriate button in the 
button bar and press the mouse button once. Aset of the most commonly 
used options for that tool appear as buttons below the tool buttons. The 
buttons and menu options that are not available with the selected tool 
or during the current operation will appear grayed. 



Menu Bar 

1 

9 

U::it:H IN I t:Ht-Avt:: 

When the cursor is placed over a button in the button bar and the mouse 
button is held down, a description of the selected button is displayed in 
the current selection indicator. If you do not want the button selected 
after viewing the button description, move the mouse cursor away from 
the button bar button without releasing the mouse button. 

Function buttons 

2 3 

10 11 

The function buttons provide easy access to many of the options avail­
able from the File and Edit menus (e.g., Open Chapter, Load TextlPic­
ture, Print). These options are available regardless of the tool currently 
selected. The factory default set of function buttons is shown below. 

I-New 9 - Undo/redo 
4 5 6 7 8 2 - Open chapter 10- Cut 

3 - Save 11- Copy 
4 - Save as 12 - Paste 
5 - Load text/picture 13 - Search & Replace 
6 - Load diff. style 14 - Spell check 

12 13 14 15 16 7 - Save style as 15 - Page size and layout 
8 - Print 16 - Go to page 

Tool buttons 

The tool buttons are central to the creation and modification of docu­
ments in Ventura Publisher. The following is only a brief description of 
the tool buttons in the button bar. Amore in-depth description of each of 
the tool buttons and how to use them starts on page 3-4. 

• The Selector tool allows you to: 

- Select, size, and move any frame or graphic. 

- Place text or pictures onto the page or in frames. 

- Cut, copy, and paste frames or graphics. 

• The Add Frame tool allows you to create new frames. Once the 
frame is created, the Selector tool is automatically selected. If the 
Shift key is held down while creating a frame, the Add Frame tool 
will remain selected allowing you to create multiple frames without 
having to re-select the Add Frame tool. 
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• The Paragraph tool allows you to apply typographical and page 
layout attributes to an entire paragraph (or group of paragraphs). You 
do this by selecting a paragraph, and then assigning it a tag from the 
Tags list. The Paragraph tool also allows you to create style sheets 
which contain these tags. 

• The Text tool is a built-in text editor that allows you to add and 
delete text, and also to change the attributes (e.g., font, underline) of 
any selected text on the page. The text tool also allows you to assign 
tags and change tag attributes of paragraphs in much the same 
manner as the Paragraph tool. 

• The Table tool is a built-in table creation and editing function which 
provides powerful features that let you interactively create and 
modify tabular information. 

• The graphic tools consist offive tool buttons. The graphic tools consist 
of: 

.111 Box Text tool 

Rectangle tool 

Round Rectangle tool 

Circle tool 

Line tool 

These graphic tools are part of a built-in drawing program which allows 
you to annotate any frame that you draw, create additional ruling lines, 
and much more. 

Option buttons 
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The option buttons provide easy access to many of the options available 
from the menus. The option buttons change to correspond to the options 
most used with the currently selected tool. Refer to Chapters 5 through 



Menu Bar 

Files list 

Tags list 
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13 for a more in-depth description of each of the option buttons and how 
to use them. 

The Files list displays, in alphabetical order, the names of all files 
currently loaded in your chapter. Use the Load TextlPicture option in 
the File menu to place file names in this list. Use the Remove 
TextlFile option button to remove file names from this list. 

To assign a file from the Files list: 

~ Click on the Selector tool ·button. 

~ Select the frame into which you wish to place the contents of a file 
already loaded into the Files list. 

~ Select the desired file name from the Files list. 

The files listed in the Files list will not be available for selection unless 
you first select a frame using the Selector tool. 

The Tags list displays, in alphabetical order, the names of all tags 
available to be assigned to paragraphs or frames (depending on the tool 
currently enabled) in your chapter. 

Use the Paragraph tool Add New Tag option button to create new 
paragraph tags. Use the Frame tool Add New Frame Tag option 
button to create new frame tags. Use the Update Tag List or the 
Update Frame Tag List option buttons to remove and rename tags 
listed in the Tags list. When a paragraph or frame is selected, the tag 
currently assigned to the paragraph or frame is displayed in the Tags 
list. 

To assign a paragraph tag from the Tags list: 

~ Click on the Paragraph tool or Text tool button. 

~ Select the paragraph to which you wish to assign the attributes 
contained in the tag. 
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~ Select the desired tag name from the Tags list. 

To assign a frame tag from the Tags list: 

~ Click on the Selector tool button. 

~ Select the frame to which you wish to assign the attributes contained 
in the tag. 

~ The base page cannot be assigned a frame tag. 

~ Select the desired tag name from the Tags list. 

Current selection indicator 

The current selection indicator shows which item (e.g., paragraph, 
frame, text attribute, graphic) is currently selected. When the Text tool 
is selected and the typing cursor is planted in text, the current selection 
indicator will also display special items when the typing cursor is placed 
at the location of the special item. 

The current selection indicator will also display a description of a 
selected button. When the cursor is placed over a button in the button 
bar and the mouse button is held down, a description of the selected 
button is displayed in the current selection indicator. If you do not want 
the button selected after viewing the button description, move the 
mouse cursor away from the button bar button without releasing the 
mouse button. 

Page number indicator 
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The page number indicator shows which page is currently displayed and 
whether the page is a left or right page. When you change a tag, 
renumber sections, or go to another page, the page number indicator 
shows which page is currently being reformatted. 
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Zoom controls 

The zoom controls allow you to control how your document is displayed 
on the screen. The zoom controls consist of five buttons as shown in 
Figure 2-2. 

Nonnal View 
Button ~ 

zoomB~t~~ _I lOO%!n~jl~l~t[DU _ ~~~~~d View 

Enlarged View / ~ Window Width 
Button View Button 

Figure 2-2. Zoom control buttons. 

The screen area displayed when a zoom factor is selected using the zoom 
buttons or from the zoom menu starts from the upper left corner of the 
display area before the zoom factor was selected. 

Zoom menu button 

The zoom menu button displays the current zoom factor. Clicking on the 
zoom menu button displays the zoom menu (Figure 2-3). 

25% 
50% 
75% 

100% 
150% 
200% 
400% 
600% 
800% 

Normal 
Enlarged 
Fit ,S.ides 
Fit Eage 

Customize ... 

Figure 2-3. Zoom menu. 
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The zoom menu allows you to select zoom factors not available using the 
zoom buttons, and customize the normal and enlarged zoom factors. The 
five zoom factors from 15% to 100% are static, and will be available on 
every installation of Ventura Publisher. The five zoom factors over 100% 
will be in a range from 150% to 1200%. The zoom factors displayed are 
dependent on the video driver installed in Windows. Ventura Publisher 
will determine the most accurate zoom factors for your video system. 

When the Customize option is selected, the Customize Zoom Factors 
dialog box is displayed. 

Figure 2-4. Customize Zoom Factors dialog box. 

The Customize Zoom Factors dialog box allows you to set the zoom factor 
associated with the normal and the enlarged views. Select the desired 
zoom factors for the corresponding views from the Normal and En­
larged list boxes. 

Clicking on the OK button saves the settings and exits the dialog box. 
Click on the Cancel button exits the dialog box abandoning all changes. 

Enlarged view button 
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The enlarged view button sets the page display into enlarged view. The 
default zoom factor for enlarged view is 200%. The enlarged view zoom 
factor can be changed using the zoom menu Customize option as 
previously described. 
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Normal view button 

The normal view button sets the page display into normal view. The 
default zoom factor for normal view is 100%. The normal view zoom 
factor can be changed using the zoom menu Customize option as 
previously described. 

Window width view button 

The window width view button sets the page display to fit the width of 
the Ventura Publisher application window. 

Reduced (fit to page) view button 

The fit to page, or reduced view button sets the page display to fit the 
height of the Ventura Publisher application window. 

Page buttons 

The page buttons allow you to move through your document by clicking 
or double-clicking one of the two buttons. Clicking on the upper page 
button will move you to the previous page of your document. Clicking on 
the lower page button will move you to the next page of your document. 

Double-clicking on the upper button will move to the first page of your 
document. Double-clicking on the lower button will move you to the last 
page of you document. 
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Rulers/tab bar 

Rulers 

Tab bar 
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Rulers/tab bar 

The rulers aid in the visual placement of elements on the page. 

To use the ruler, you must have the Show Rulers option in the View 
menu enabled. 

The unit of measure used for the rulers can be set using the Set Ruler 
option in the View menu. Refer to the Set Ruler section starting on page 
7-5 for information on setting the unit of measure for the rulers as well 
as the zero point. 

The tab bar allows you to interactively create, set, and delete tabs, 
adjust the In From Left and In From Right settings found in the 
Spacing dialog box, and adjust the In/Outdent Width setting found in 
the Alignment dialog box. 

To use the tab bar, you must have the Show Rulers option in the View 
menu enabled. 

Refer to the Using the tab bar section starting on page 3-54 for a 
description of the tab bar functions and how to use the tab bar. 



Mouse 

Mouse 

USER INTERFACE 

The mouse has two separate functions within Ventura Publisher: 

• Use it to move the mouse cursor to items on the screen that you want 
to select. Select items by placing the mouse cursor anywhere inside 
the item and then pressing the left mouse button once. Exact place­
ment of the cursor is not critical as long as the cursor lies within the 
item you are selecting. 

• Use it to draw frames and graphics. 

W Ventura Publisher uses only the left mouse button. 

The mouse cursor changes shape depending on the tool selected, as 
shown in Figure 2-5. 
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Selector Tool ks 
Move Frame 4 
Resize Frame ~ 
Pan Image ~ 
Add Frame Tool r 
Paragraph Tool ~ 
Text Tool TI 
Table Tool + 
Box Text Tool IA 
Rectangle Tool r 
Rounded Rectangle Tool r 
Circle Tool EB 
Line Tool tJ 

Figure 2-5. Ventura Publisher mouse cursors. 
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Keyboard Keys 

Various keys on the keyboard perform special functions: 

F1 Displays Help. Pressing the Fl key from within a dialog box will display 
information about that dialog box and the dialog box options. Pressing 
the Fl key from the Ventura Publisher main screen will display the 
general help for Ventura Publisher. 

Arrow keys Control the movement of the text cursor. 

Home Go to the first page of the document. 

End Go to the last page of the document. 

Page Up Go to the previous page. 

Page Down Go to the next page. 

Delete • Deletes the character to the right of the text cursor when using the 
Text tool. 

• Equivalent to selecting the Cut option when a block of text, a frame, 
or a graphic is selected. 

• Equivalent to selecting the Copy option when you press the Shift key 
simultaneously with the Delete key. 

Insert Equivalent to selecting the Paste option. 

Backspace Deletes the character to the left of the text cursor. 

Esc • The Esc key will halt a "go to page" operation. 

• Within a dialog box, Esc is equivalent to selecting the Cancel button. 

• At all other times, the Esc key redraws the current page. 

Shift • When used in conjunction with the mouse, the Shift key allows you 
to select multiple paragraphs, frames, or graphics. Press and hold 
down either Shift key while selecting in order to select several items. 
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• When using the Text tool, use the Shift key to extend or diminish the 
range of text selected. Press and hold down either Shift key and then 
press the mouse button. The text selected will extend or diminish to 
the current text cursor location. 

• Press the Shift key while adding frames or graphics to keep the Add 
Frame or a graphic tool selected. 

• Press the Shift key plus any keyboard arrow key to change the 
spacing between letters or the font size of selected text (Text tool). 

Tab • Inserts horizontal tab characters. 

• Within a dialog box, the Tab key moves the text cursor forward to the 
next entry field or, if the Shift key is pressed simultaneously, back to 
the previous entry field. 

Function keys Used to tag paragraphs, if the style sheet has assigned tags to these 
keys. Refer to Assign Function Keys option section in the Paragraph 
menu chapter. 
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Ctrl • Use with the Enter key to insert a line break. 

• Use with the Hyphen key to insert a discretionary hyphen. 

• Press and hold the Ctrl key while selecting graphics or frames with 
the mouse to select graphics or frames which are "hidden" beneath 
other graphics or frames. 

• Press and hold the Ctrl key and then type X to perform the last menu 
action. 

Alt • Use with the mouse to pan images within frames. Press and hold 
down the Alt key, move the mouse cursor to the center of the image 
to be moved, press and hold the mouse button, and then move the 
image. Release both the Alt key and the mouse button when finished. 

• Constrain graphics. Press and hold the Alt key while drawing 
graphics using any of the graphic tools. The graphic will be con­
strained to perfect proportions (e.g., a circle instead of an ellipse). 

• Add characters that are not on the keyboard. Press and hold down the 
Alt key, and type the ANSI equivalent on the keypad for the character 
you wish to enter; then release the Alt key. Appendix E shows the 
numbers for each character. Refer to the Text tool section in Chapter 
3 for more information. 
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Keys for special The following table lists the Ventura Publisher keyboard shortcuts for 
characters commonly used typographic characters. These shortcuts can be used 

instead of typing a number with the Alt key pressed. Also shown are the 
keyboard combinations for various types of typographic spaces. The + 
sign indicates that you should press several keys simultaneously. For 
instance, to create a copyright mark, press and hold both the Ctrl and 
Shift keys and then type C. 

Function Key 

Copyright mark © ........... . Ctrl + Shift + C 

Discretionary hyphen ........ . Ctrl + -
Emdash- ................ . Ctrl + ] 
Em space .................. . Ctrl + Shift + M 

En space ................... . Ctrl + Shift + N 

En dash- .................. . Ctrl + [ 

Figure space ............... . Ctrl + Shift + F 

N on-breaking space .......... . Ctrl + space 

Quote, open" ............... . Ctrl + Shift + 
Quote, closed" .............. . Ctrl + Shift + 
Registered trademark ® ...... . Ctrl + Shift + R 

Thin space ................. . Ctrl + Shift + T 

Trademark TM •••••••••••••••• Ctrl + Shift + 2 

Keyboard shortcuts 

Windows provides keyboard accelerators which let you press the Alt key 
plus an underlined letter in a menu or dialog box in order to access a 
feature. Using this approach, most features require several keystrokes 
to access. 

For faster access, Ventura Publisher provides keyboard shortcuts for 
certain menu features, as shown below: 

Function 
Add New Tag ............... . 
Bring to Front (graphics) ..... . 
Copy ...................... . 
Cut ....................... . 
Edit Special Item ............ . 

Key 

Ctrl + 2 
Ctrl + A 
Shift + Delete 
Delete 
Ctrl + D 

2-15 



USER INTERFACE 

Function 
Enlarged View .............. . 
Equation mode exit .......... . 
Fill Attributes (graphics) ...... . 
Selector tool ................ . 
Go to First Page ............. . 
Go to Last Page ............. . 
Go to Next Page ............. . 
Go to Page .................. . 
Go to Previous Page .......... . 
Line Attributes (graphics) ..... . 
Normal View ................ . 
Paragraph Tool .............. . 
Paste ...................... . 
Print ...................... . 
Recall Last Dialog Box ........ . 
Redraw Screen .............. . 
Reduced View ............... . 
Renumber Chapter ........... . 
Save ....................... . 
Select All (graphics) .......... . 
Send to Back (graphics) ....... . 
ShowlHide Tabs & Returns .... . 
ShowlHide Files list .......... . 
ShowlHide Tags list .......... . 
ShowlHide button bar ........ . 
Table Tool .................. . 
Text Tool ................... . 
Update Tags list ............. . 

Key 
Ctrl + E 
Ctrl + D 
Ctrl + F 
Ctrl + U 
Home 
End 
Page Down 
Ctrl + G 
Page Up 
Ctrl + L 
Ctrl + N 
Ctrl + I 
Insert 
Ctrl + H 
Ctrl + X 
Esc 
Ctrl + R 
Ctrl + B 
Ctrl + S 
Ctrl + Q 
Ctrl + Z 
Ctrl + T 
Ctrl + Y 
Ctrl + V 
Ctrl + W 
Ctrl + P 
Ctrl + 0 
Ctrl + K 

Keyboard Keys 

Cursor keys While using the Text tool, you can move the text cursor to another 
location on the screen by moving the mouse cursor to the desired new 
position and pressing the mouse button once. Once you have positioned 
the text cursor, you can use the keyboard arrow keys to move it back and 
forth one character at a time, as well as up and down one line at a time. 
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Some of the options within Ventura Publisher function as simple com­
mands which are executed as soon as you select them. The Show 
Rulers, Copy, Cut, and Paste options are examples of this type of 
option. 

Many options, however, contain features that require you to specify 
additional information. Whenever you select an option of this type 
(indicated by three periods after the option name in a menu), a dialog 
box is displayed on the screen. Dialog boxes control most of Ventura 
Publisher's features. 

The operation of the controls within a dialog box follows standard 
Windows conventions and, therefore, is not documented further here. 

Measurement controls 

Numerical settings in many dialog boxes may be set in inches, cen­
timeters, picas & points, or points. The measure used can be changed at 
any time. To change a unit of measure, click on the unit of measure 
button until the desired unit of measure is displayed. When the unit of 
measure is changed, the values for all settings corresponding to that 
unit of measure option are recalculated. The points unit of measure 
option provides the greatest precision. 

When setting measurements using the picas & points unit of measure 
option, the numbers to the left of the comma are picas, and to the right 
of the comma the numbers are points. Thus, to set three picas, two 
points, you should type 3,02. Since there are twelve points in a pica, 3,12 
is equivalent to 4,00. For those not familiar with typography, seventy­
two points and six picas both equal one inch. 

When changing between measurement units, the pound symbol (#) may 
appear in an entry field. This indicates that the setting is too large to be 
displayed in that measurement unit. For instance, if you set the top 
margin to 2.00 inches and then change the unit of measure to points, 
you will see pound symbols because two inches is larger than 99.99 
points, the largest setting allowed in the points measurement unit. If 
the pound symbol is displayed, the original setting is not lost. Simply 
select a different unit of measure and make the desired changes in that 
different measurement system. 
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Classic Interface 
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All users are encouraged to use the new interface. The classic interface 
is provided for users of previous versions who are more comfortable with 
its familiar look and feel. The new interface is easier to learn and use. 

This documentation describes Ventura Publisher while in the button bar 
mode. If you elect to use the classic interface, the button bar will not be 
available, but all options described can be selected from the menus 

If you are familiar with, and prefer using the classic Ventura Publisher 
interface, you may disable the Button Bar option in the View menu. 

While the appearance of the classic interface is similar to previous 
versions of Ventura Publisher Windows Edition, the Toolbox, Files list, 
and Tags list can be iconized, resized, or moved outside of the Ventura 
Publisher application window using standard Windows conventions for 
these functions. 



THE BASICS 

For those of you who are new to Ventura Publisher and don't want to 
take the time to go through the Training Guide, you've come to the right 
place. Ideally you should read the Training Guide. The Training Guide 
provides a series of exercises designed to acquaint you with basic 
operations and features. You should be able to produce simple docu­
ments after reading the Training Guide. 

Whereas this chapter really isn't a substitute for the Training Guide 
exercises, nor will it tell you everything there is to know about Ventura 
Publisher, it will describe the basics of Ventura Publisher. The topics 
included in this chapter are: 

Ventura Publisher file structure. This section describes how 
Ventura Publisher stores the data used in Ventura Publisher docu­
ments. 

Ventura Publisher tool descriptions. These sections describe the 
function of each of the main Ventura Publisher tools found in the button 
bar, as well as when and how they are used. 

Using the tab bar. The tab bar allows you to create, set, and remove 
tabs for the currently selected paragraph. The tab bar also allows for 
interactive adjustments of the Alignment dialog box In/Outdent Width 
setting, and the Spacing dialog box In From Left and In From Right 
settings. This section describes the functions and use of the tab bar. 

U sing Ventura Publisher as a word processor. This section 
describes the differences and similarities between Ventura Publisher 
and word processing applications. 

How to produce style sheets. This section provides step by step 
procedures for creating a style sheet. 

How to create documents. This section shows examples of the three 
basic types of documents typically created using electronic publishing. 
Each approach is described both visually and in writing. 
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Ventura Publisher file structure 

Chapters 
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Ventura Publisher is similar to other Windows programs you may 
already use. However, Ventura Publisher does contain several unique 
features which you must learn before you can enjoy the full power of the 
product. One of the unique features of Ventura Publisher is its file 
structure. Ventura Publisher documents are actually made up of several 
different files. 

Most programs can work with only one or a few files at one time. For 
instance, when you import a piece of clip-art into a drawing in a graphics 
application, that clip-art becomes part of the drawing into which it was 
imported. By contrast, Ventura Publisher can combine and publish up 
to 128 separate text and graphic files in one document. As a matter of 
fact, most Ventura Publisher documents contain no less than four files. 

Instead of integrating all of the text and graphics files into one docu­
ment, Ventura Publisher simply "remembers" the location of the original 
files. A single text or graphic file can be used by many Ventura Publisher 
chapters. 

To make it simple to save and retrieve all these different files, Ventura 
Publisher creates a bluepriJ?t of how they should be combined and where 
they appear in your document. This blueprint is called a chapter (Figure 
3-1). When you use the Open Chapter, Save, or Save As function 
buttons, you retrieve or save this blueprint. You also retrieve or save all 
the files which this blueprint (chapter) references. 
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Chapter File 

t which shows which files are in Creates a blueprin 
chapter and deter mines where they are placed. 

Text file 
MAG1.TXT 

Picture file 
PRINTER. GEM 

Text file 
MAG2.TXT 

Picture file 
PHOTO.TIF 

Figure 3-1. The chapter file creates a blueprint of how all files in your document 
should be combined together. 

Style sheets and paragraph tags 

All word processors let you change text to boldface, italic, underline, etc. 
These changes are usually called text attributes. Ventura Publisher 
doesn't restrict you to a few preset text attributes. Instead, you can 
create virtually any attribute you want by combining different fonts, 
spacing, special effects, color, and ruling lines. 

To help you keep track of all the different effects you've created and to 
let you apply these effects easily to different paragraphs in your docu­
ments, Ventura Publisher allows you to attach a name to a group of 
effects. These names are called tags. The tag names and the attributes 
associated with each tag are stored in a style sheet. The name of the style 
sheet used to create a document is stored in the chapter file so that it 
will automatically be loaded each time you open the chapter. 

A single style sheet can be used by a number of chapters. This allows for 
consistency of appearance from chapter to chapter for all chapters using 
the same style sheet. Additionally, updating of the appearance of all 
chapters using the same style sheet is automated because a change 
made to the style sheet in one chapter, is automatically reflected in all 
the chapters using the style sheet. 
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Selector tool 

The Selector tool allows you to: 

• Place files from the Files list into frames. 

• Select, move, resize, copy, and delete frames or graphics. 

• Remove files from selected frames, or from the Files list. 

• Change frame and graphic attributes 

• Create and apply frame tags 

• Cause frames to repeat on every page. 

Selector tool option buttons 

When you click on the Selector tool button, the tool option buttons 
change to display options that are commonly used with the item that is 
currently selected. The following is the default set of buttons available 
when a frame is selected. 

Buttons 15, 16, and 17 will not be displayed if a standard VGA (640 x 
480 resolution) video driver is installed in Windows. 

1 - Margins and columns 
2 - Sizing and scaling 

6 - Vertical rules 
7 - Ruling line above 

11 - Remove file 16 - Grid settings 
12 - Image settings 17 - Select all (graphics) 

3 - Frame typography 
4 - Anchors and captions 
5 - Repeating frames 

8 - Ruling line below 
9 - Ruling box around 
10 - Frame background 

13 - Add new frame tag 
14 - Update frame tag list 
15 - File type/rename 

The following is the default set of buttons available when a graphic is 
selected. 
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1 - Show on all pages 
2 - Bring graphic to front 
3 - Send graphic to back 
4 - Graphic line attributes 

5 - Graphic fill attributes 
6 - Grid settings 
7 - Select all 

THE BASICS 

Selecting frames and graphics 

To select a frame or graphic: 

~ Click on the Selector tool button. 

~ Place the cursor anywhere within the frame or graphic you wish to 
select and press the mouse button. 

Select multiple You can also select more than one frame or graphic simultaneously. 
frames or 
graphics ~ Press and hold down either Shift key on the keyboard. 

~ Select each frame or graphic with the mouse. 

The current selection indicator displays the word Multiple to indicate 
that more than one frame has been selected. To deselect a single frame 
or graphic in a group, first point to the frame or graphic while holding 
down the Shift key, then press the mouse button once. 

Selecting When one frame or graphic is entirely covered by another, it sometimes 
frame/graphic seems impossible to select the frame or graphic on the bottom. To select 

on bottom a frame or graphic which is covered by other frames or graphics: 

~ Click on the Selector tool button. 

~ Press and hold the Ctrl key and then select the first frame or graphic. 

~ While holding the Ctrl key, press the mouse button again to select the 
next frame or graphic down from the top. 

~ Continue pressing the mouse button, while holding the Ctrl key, until 
you select the desired frame or graphic. 
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Selector tool 

Placing files into frames 

To place files in frames, follow these steps: 

> Click on the Load TextJPicture function button. Use the Load 
TextlPicture dialog box (Figure 3-2) to build up a list of text, image, 
and line art files in the Files list. Refer to the Load TextlPicture 
option section starting on page 5-11. 

Figure 3-2. Load Text / Picture dialog box set to load an AutoCAD .SLD file. 

> Click on the Selector tool button. 

> Select the frame and then select the file from the Files list (Figure 
3-4). If a file is already in the frame, the new file takes its place. (The 
old file remains in the Files list, and its contents are not affected.) 

The current selection indicator shows the name of the file that is 
currently placed in the selected frame (Figure 3-3). 
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ClI<lPter 1 
The Adventure Begiru 
This trip re<llly begm in September las t year when 

Gerry won first prize in a raffre at the fashion show 
which Rush-Presbyteri1lI\-St. Lulre's Mediccl Cen­
ter holds every year. The prize was two round trip 
ticlrets to on United Airlines, and ten 

So f1ll', it's been along 1lI\d interesting day and I 
guess it's just about hclfover. We did the following: 

Arose at 5:30A.M. 
Left the house at 7:00 A.M. 
Arrived in Los Angeles at 12:35 PM. 
Arrived in Tokyct at 11:46 P.M. 
11 :31 P.M . Tuesday, M 1Il'ch 4th 
It's been along day, but in mmy ways re<llly quite 

fabulous. Let's go back to the beginning. As related 
on page 1, our trip yesterd<:ty was a good one with 
fine weather, accomp1lI\ied by underlying clouds 
much of the way. Our 5400 mire· flight from Los 
Angeles took us north <llmost to the Kurile IsI1lI\ds 
and then down into Tokyo. Letting down through 
the clouds oyer a rough sea we saw mmy fishing 
boats 1lI\d other vessels <Ill headed into Tokyo. Our 
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Figure 3-4. Select the frame first, then select the file you want to occupy that 
frame. 

;; II 

. 
Ol.11plar 1 
The Adventure Begiru 
This trip reaJ.lytegmin Seplamter last year when 

Gerry won first prize in a raffle nl the fashion show 
which Rush-Presbylari1lI\-St. Luke's Medical Cen­
ter holds every year. The prize was two round trip 
ticlrets to H Ko on United Airlines, and Ian 

~~n[]. 

;;. , 

So fllr, it's been a long 1lI\d interesting day and I 
guess it's just about half over. We did the following: 

Arose at 5:30 A.M 
Left the house nl7:00 A.M. 
Arrived in Los Angeles nl 12:35 P.M. 
Arrived in Tokyco at 11:46 P.M. 
11:31 PM. Tuesday, Mllrch 4th 
It's been along day, butin mmy ways really quite 

fabulous. Let's go back to the teginning. As relalad 
on page I, our trip yeSlard<:ty was a good one with 
fine wenlher, accomp1l!lied by underlying clouds 
much of the way. Our 5400 mile· flight from Los 
Angeles took us north almost to the Kurile 1s11lI\ds 
and then down into Tokyo. Letting down through 
the clouds over a rough sea we saw romy fishing 
bonls 1l!Id other vessels all headed into Tokyo. Our . . 

.. 

Figure 3-3. After the mouse button is pressed, the text or picture file is placed in 
the selected frame. 
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When a text file is placed directly on the page, any text that does not fit 
on the page automatically flows to succeeding pages. However, when 
placing text in a frame you have drawn, you must first manually select 
the next frame in which you want the text to continue, and then select 
the file name in the Files list. The remaining text (or as much of it as 
will fit) will then flow into that frame. 

You must always select a frame or the page before selecting a file to place 
in the frame or page. If no frame is selected, nothing happens. 

You can place the same line art or image file into more than one frame 
in a chapter and scale that picture differently in each frame. A text file, 
however, can only be used once in a chapter even if it fits entirely into 
one frame. An exception is repeating frames which allow the same text 
to appear on every page. Refer to the Repeating Frames option section 
starting on page 9-21. 

Types of files in Ventura Publisher can place text or picture files into frames (Figure 

3-8 

frames 3-5). Text files can originate in another word processor or be entered 
using the built-in word processor. Pictures, on the other hand, are 
always created and edited in another program. Pictures can be either 
line art or images. 

Text 

This is text entered directly 
inb a frame. Text entered 
into a frame from within 
Ventura Publisher is sbred 
in th e chapte r's CA P file. 

Line 
Art 

Figure 3-5. Text, line art, and images can all be placed in frames. 
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Pictures 

Line art refers to pictures stored as vectors and objects (mathematical 
expressions), whereas images refers to pictures stored as simple bits (1s 
and Os). Because the mathematical expressions can be recomputed to 
achieve the resolution required by any output device (printer or typeset­
ter), line art always prints at the maximum resolution that the output 
device can produce. By contrast, images can never be printed with more 
resolution than when they were first created. For instance, an image 
created with a 300 dot per inch scanner and printed on a 1200 dot per 
inch typesetter provides only 300 dots per inch quality. On the other 
hand, line art created on the computer screen (which is relatively low 
resolution), still prints with 1200 dots per inch resolution. 

Removing files from frames 

You can remove a file by either placing another file in the frame, or by 
selecting the frame and then selecting the Remove TextlFile option 
button. 

To place a different file in the frame, select the frame, and then select 
the desired file from the Files list. The selected file replaces the file in 
the frame. The old file is not removed from the Files list, nor is it 
modified in any way. 

To remove a file from the frame, select the frame, and then click on the 
Remove TextlFile option button. Select the Frame option from the 
Remove From list box in the Remove File dialog box (Figure 3-6) to 
remove the file from the frame only. Select the List of Files option from 
the Remove From list box to remove the file from both the frame and 
the Files list. Refer to the Remoye TextiFile option section starting on 
page 9-34. 

Figure 3-6. Remove File dialog box. COLUMBIA.GEM will be removed from 
both the frame and the Files list. 
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Moving frames or graphics 

3-10 

To move a frame (and its contents) or a graphic to another position on 
the page: 

~ Use the Selector tool to select the frame or graphic. 

~ Place the mouse cursor within the area of the frame or graphic, and 
press and hold the mouse button. The mouse cursor changes to a 
picture of a cross with arrows on each end. 

~ Move the frame or graphic to the desired new location, then release 
the mouse button (Figures 3-7, 3-8). If the Column Snap option is 
enabled in the View menu, the frame aligns with the nearest column 
guide when placed near that guide. Click on the Grid Settings option 
button to create a snap grid for graphics. 

To move a frame or graphic to another page, you must use the Cut or 
Copy function buttons and then the Paste function button as described 
in the Edit menu chapter. 

This frame ... 

Chaptor! 
Tho Ad .. otura Bogio. 
This tripraally begaoio So 

ao"Y wo 0 fir; t prize io 
which R.sh-Pros 
tar holds overy year. Tho was two ro. od trip 
tidea ~ to Hoog Ko ng 00 Aidinos,. 0.00 tao 

Chicago b:> Tokyo 
11:03 P.M. Chicago tima. 39.000 faatsomawhora 

over tho Wa.taro PdCific. wa ora 8 hou rs aDd 42 
miouta. out of Los Angela. with about2 mora hour 
b:> go b:> Tokyo. Wo wara abou t 0.0 hour 0.00 tao 
mio. taslata o. t of 1.0. A ngalas. 

Dig h~io tho Hoog Kong Hya;tHQlal..AJ~lnrQ'JL---.Jl.t:.UurulJoo.r..do..v" . .1'.t in many ways raally qu ita 
good £:>rt.oo. wo oooolud.d that wo waotod b:> 00 fab.lous. Lot'. go bdCk b:> tho begiooing. A'll!latad 
mora than speod taodaysioHoogKoogand raturrt 00 pago 1. our trip yesterday was 0. good 000 with 
b.tat tho sam. tim .. Uoitod haviogjust gottaoi~ fino w.athor. ,",oompanied by .oderlying olouds 
rou to< 0.00 meot flOm Pao Am.ricao. had rot muoh of tho way. Our 5400 mila' flOm Los 

.. , will be 
moved to 
here. 

Figure 3-7. Place mouse cursor inside the frame. Press and hold the mouse 
button. Move the frame to the new location. Release the mouse button. 
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Chapter I 
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Figure 3-8. Frame moved to new location. 

Re-sizing frames and graphics 

Any frame or graphic created in Ventura Publisher can be easily resized. 
Additionally, you can resize multiple frames and graphics by selecting 
multiple frames or graphics and sizing one of them. To increase or 
decrease the size of a frame or graphic: 

~ Use the Selector tool to select the frame or graphic. 

~ Place the mouse cursor on one of the handles found around the 
perimeter of each selected frame or graphic (Figure 3-8). 

~ Press and hold the mouse button. The mouse cursor changes to a 
bidirectional arrow. 

~ Continue holding the mouse button and move the selected corner or 
edge to the desired new location. When you are satisfied with the size, 
release the button. 

If the mouse cursor changes to a picture of a cross with arrows on each 
end instead of a bidirectional arrow, you have not placed the cursor on 
the handles. 
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When resizing multiple frames and graphics, each frame or graphic is 
sized proportionately. Additionally, multiple frames cannot be resized 
using the Sizing and Scaling dialog box. 

Change size of To change the size of a picture within a given frame size, use the Sizing 
picture only & Scaling option button. 

3-12 

Frame tags 

Many attributes can be applied to a frame (e.g., background color, sizing 
and scaling, ruling lines, margins and columns). The frame attributes 
are applied using the Selector tool option buttons and other options in 
the Frame menu. Once attributes have been applied to a frame, this 
combination of attributes can be saved as a frame tag. Once saved, the 
attributes stored in the frame tag can easily be applied to other frames 
by assigning the frame tag to the frame. 

Frame tags help ensure consistency between frames of a similar type 
within a chapter in the same manner that paragraph tag ensure consis­
tency between paragraphs of a chapter. By setting the attributes of an 
initial frame, and creating a frame tag from the attributes of that frame, 
all other frames tagged with that frame tag will have the same at­
tributes. Additionally, changes made to one frame assigned a frame tag, 
can be reflected in all other frames tagged with that frame tag. 

Initially, each chapter contains one tag called Default. Like the Body 
Text paragraph tag, the Default tag is a system tag and cannot be 
renamed or removed. However, the attributes of the Default tag can be 
changed. 

Frame tags cannot be assigned to the base page, header and footer 
frames, footnote frames, caption frames, or repeating frames. A frame 
that is assigned a tag and subsequently made a repeating frames will 
retain the frame attributes of the tag, however, it will no longer be 
tagged. 

The following attributes are not saved with a frame tag. 

• Frame contents. 

• Frame location. 

• Frame anchor name 

• Graphics attached to the frame 
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Managing frame The Add Frame Tag and Update Frame Tag List options allow you 
tags to add, delete, and rename the frame tags in the chapter as well as 

merge frame tags created in other chapters. Refer to the Add New Tag 
section starting on page 9-43 and the Update Frame Tag List section 
starting on page 9-45 for a complete description of how to used the 
option to create, rename, delete frame tags in the chapter, and merge 
frame tags from other chapter 

Changing frame A frame that does not have a tag assigned is completely autonomous and 
tag attributes can be changed at will. Once a frame is tagged, the changes to the frame 

are tracked by Ventura Publisher. 

If you change the attributes of a frame that is assigned a tag, and that 
frame is the only frame assigned that tag, Ventura Publisher will allow 
you to change the attributes without intervention since the changes will 
not affect other frames. 

If you make attribute changes to a frame that is assigned a tag that is 
also assigned to other frames, Ventura Publisher will display the follow­
ing alert. 

m Warning: The. chariges you have made tothi$ 

. 
...••.••. ••••.••.... . frame will affectallfr ames tagged as '[Tag 

....... Name)\SelecUhe mostappropJiate option 
berow~ 

UntagFrame 

Clicking on the Apply Globally button will apply the attribute change 
to the selected frame and all frames sharing the frame tag. The Undo 
function button can be use to undo the attribute change of a frame tag 
even after the change is globally applying to other frames. 

Clicking on the Untag Frame button will cause the frame to be un­
tagged. The frame will retain the attributes of the frame tag, as well as 
the attribute changes. However, this frame will not be affected by 
further changes to the frame tag that was assigned to the frame. 

Clicking on the Apply New Tag button will display the Add New Tag 
dialog box. A new tag can then be created for this frame (the tag can then 
be assigned to other frames). The new tag attributes will be a combina­
tion of the attributes of the original tag and the attribute change that 
prompted the alert to be displayed. 
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Clicking on the Undo Changes button will abandon the attribute 
changes, and the frame tag will remain unaffected. 

Frame tags and frame captions 

3-14 

Frames tags cannot be assigned to caption frames. However, captions 
are a frame attribute that is saved with a frame tag. By creating a tag, 
or tags from a frame that contains a caption, you can automatically 
create consecutively numbered captions for new frames by simply ap­
plying the tag to the frame. In order for this feature to work properly, 
you must have an understanding of captions and the proper way to enter 
information in a caption. 

When Ventura Publisher creates a frame caption it actually generates 
two paragraphs with separate paragraph tags. The first paragraph tag 
is called Z_LABEL FIG, Z_LABEL CAP, or Z_LABEL TBL. These tags 
are generated using the Anchors & Captions dialog box Inserts options, 
and are used to create consecutive numbering for your frames. The 
second tag is called Z_CAPTION and it is attached to the caption text 
that is unique to the frame. 

Do not enter frame specific caption text in the Anchors & Captions 
dialog box, instead, use the text tool to enter text directly into the 
caption frame. Otherwise, the text you enter in the Label field in the 
Anchors & Captions dialog box is saved with the frame tag, and all 
frames that use that tag will have that text. 

For example, if you enter "Figure [C#]-[F#] This is the first figure" in the 
Label field of the Anchors & Captions dialog box, every figure that uses 
that tag will contain the text "This is the first figure." Instead, enter 
"Figure [C#]-[F#]" in the Anchors & Captions dialog box and then type 
"This is the first figure" directly into the caption frame. This will allow 
all frames sharing this frame tag to display the correct chapter and 
figure number, and allow you to enter unique text for each frame. 
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Add Frame tool 

A frame is a rectangular area of the page which can contain text, line 
art, or images. You draw frames using the Add Frame tool. In addition, 
the page itself is a frame. 

The Add Frame tool has three primary purposes: 

• Add new frames to an existing layout. This allows you to place text 
and pictures wherever you want. 

• Block text from flowing into unwanted areas of the page. This is 
particularly useful for constructing runarounds, where text is made 
to flow around an irregularly shaped object. 

• Add additional space between lines or paragraphs. 

Add Frame tool option buttons 

The Add Frame tool is used to create a frame on the current page. When 
you click on the Add Frame tool button, the tool option buttons change 
to display functions that are commonly used with the Selector tool for 
editing frame settings. However, these option buttons are grayed and 
not available for selection until the Selector tool is enabled and a frame 
selected. Refer to the Selector tool section for a description of the tools 
available for editing the frame settings after the frame is created. 

Creating a frame 

To add a new frame, follow these steps: 

~ Click on the Add Frame button in the button bar. 

~ Move the mouse cursor to the point on the page where you want to 
start the upper left corner of the frame. 

~ Press and hold the mouse button. 

~ Drag the lower right corner of the frame to the desired location 
(Figure 3-9) and release the mouse button. Text already on the page 
flows around the frame (Figure 3-10). 

3-15 

II 



I HI:: IjAt:iICt:i 

3-16 

file .Edit Y:iew ~hapter 

C hap"r I <,Itiv""" gro, rd. Tiny ho' .... and even small £>0-
Tbe Adwt'lturt Begins b:mes Evezythirl,SMmtd mU'I1a.tum 
This uipreally be,onin Sop .. mberlas,yoorwhen A,4 2~ PM" ,be son woo t.irly hlgh.n ,h. sky. 

G'aywonfils'priuin ar.J!le~lxuL..----.b~~~d" be ,,,",,,.isibilityw .. 
whichR"b-Presby""n-St.Like'sMedicalCe... probably no' "'". ,;,.n 5 milos. Q,orontine ard 
tel' I-olds every year. The p.riz.ajwu two round tJip custorM proved no rbl.e:m. but immigratlOt'I was 
tickets ., Hon, Kong on Uni~ Aimne .. ard 'en slow wi,h m'<h .... ticn ., detail. Our 5:15 P.M. 
night:5inthaHongKongH~u~ot21.Analyz.ingolJr limousine-nally rathu luge bus dep~rt2d 
goed brtunt. Wt concluded tbit WI watlt.ed to cb promptly ard co.rrie us on our hOIJla.nd fifteen 

::~t t~h~ ~:dti~: ~:i~:~~~; j!::!:~~~ :;~:; I~!=~:~t~~~~ ~~~I~~~~t:~~; 
JOU tes ard e~uipment flOrn Pa~Ame.rioan. had rot into b:Jwnis 5en:ened ~ raise abating walls. Traffic 
)'at rtoeinduthority tofly toStherdestina.tiof'ls or crovu steadily at 6.b.fut SO miles an Mur ard we 
between pcants in tht F.v East i obs::elVed no speedi~, The new Imperial Hotel is 
On Febr,OlY 10,t-. Uni,"" ""'l~iIod ,his., ,hority. ..tty bi, .. g<>od as i't,np, .. ticn-somaw h .. moro 

ardonFabru.aryllthDabbia ba{s:an puttingouruip e1agantthan th'p.j~tz. a.rbon.our. roomio the new 
bJgather. W. left on M.ueh 2[jd "00 lttumad on !.ower looks txactly' the pictun: in thil tJ:avtl 
Mu::h 26th. We. entered savenjcountri.es:. tlave:Ia1 rolders. It's not a l'ltiooilly large. It has a. bay 
over 25.000 miIosonro",airlii>es..~~"1'Ginuwlth'heoc.onin'h. 
Kcda.chrom.& slidu. dmost 200 Koda.coloP backgroUf'ld,. vtry ~Ot furnitul1. aod "wall-.ap-
plin",ard 51/2 ho,rsof<olorardso,ndvideo"po. pointedony1and plastic ba,hroom. 
Chicaco .,TokYo "E1 ..... " abo,rd: Too,hbr"hes. teayclo,h b.,h-
I 1:0'3 PM. Chicogo time. 39.000 f •• , somewhere lObeS. kimonos. slip POt<. <offee moki",eq,ipmen~ 

Figure 3-9. Adding new frame. Mouse button still pressed down. 
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Add Frame tool 

Figure 3-10. Adding new frame. Mouse button released. Text flows around 
frame automatically, and Add Frame tool is no longer selected. 

Text containing horizontal tabs will not flow around frames if the tab 
stops and the frame occupy the same position on the page. 

Once the mouse button is released, Ventura Publisher automatically 
enables the Selector tool, and the frame just created is selected. This 
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allows you to move or resize the frame just created, or to place a file from 
the Files list into the frame immediately. 

Add multiple To prevent Ventura Publisher from automatically enabling the Selector 
frames tool, press and hold either Shift key on the keyboard prior to drawing a 

frame. As long as you hold the Shift key, Ventura Publisher allows you 
to draw another frame without first selecting the Add Frame tool. 

When you draw multiple frames that occupy the same location on the 
page, the last frame drawn on a page is placed on top of all other frames. 
Text placed in lower frames flows around frames on top. To place an 
existing frame on top, cut that frame and then immediately paste it back 
to the page. 

If text from a file is placed into more than one frame on a page, it always 
flows first into the frame which you drew first. 

Adding space You can add space between paragraphs using narrow frames. Enable the II 

between lines Column Snap and Line Snap options in the View menu to assure that 
these frames reach the exact edges of the columns and to force. each 
frame to be exactly 1,2,3, etc. lines high. 

The Vertical Justification feature automatically aligns adjacent 
columns at the bottom of the page. Refer to page 8-10 for more informa­
tion. 
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Paragraph tool 
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The Paragraph tool is used to assign style sheet tags from the Tags list 
to selected paragraphs. Tag attributes are changed using the Paragraph 
tool option buttons. A paragraph is defined as any group of words or 
numbers followed by a carriage return. 

The Paragraph tool allows you to format the chapter without having to 
specify point size, typeface, spacing, ruling lines, etc. for each para­
graph. 

Paragraph tool option buttons 

When you click on the Paragraph tool button, the tool option buttons 
change to display functions that are commonly used with the Paragraph 
tool. The following is the default set of option buttons available when a 
paragraph is selected. 

Button 15 will not be displayed if a standard VGA(640 x 480 resolution) 
video driver is installed in Windows. 

567 8 9 10 11 12 13 14 15 

1- Fonts 
2 - Alignment 
3 - Spacing 
4 -Breaks 
5 - Tab settings 

6 - Special effects 
7 - Ruling line below 
8 - Ruling line below 
9 - Ruling box around 
10 - Add new tag 

Selecting a paragraph 

To select a paragraph: 

11 - Paragraph typography 
12 - Auto-numbering 
13 - Update tags list 
14 - Attribute overrides 
15 - Define colors 

~ Click on the Paragraph tool button. 

~ Place the cursor over the paragraph you wish to select and press the 
mouse button. 
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The paragraph selected is highlighted in reverse video (white text on 
black background). To de-select a paragraph, either select another para­
graph, or move the mouse cursor to a part of the page which contains no 
text and press the mouse button once. 

Multiple You can select several paragraphs simultaneously as follows: 
paragraph 
selection > Click on the Paragraph tool button. 

> Hold down either Shift key on the keyboard and select each para­
graph with the mouse. The current selection indicator displays the 
word Multiple to indicate that more than one paragraph has been 
selected. 

> To de-select any paragraph in a multiple group, select the paragraph 
while still holding the Shift key. 

Using the Paragraph tool, you can select and apply tags to multiple, 
noncontiguous paragraphs. However, multiple paragraphs cannot be 
selected from multiple pages. 

Applying a tag to a paragraph 

When the Paragraph tool is selected, the paragraph tags available 
within the currently loaded style sheet appear in the Tags list. Each 
time you select a paragraph, the tag currently assigned to that para­
graph is displayed in the current selection indicator and the Tags list. 

To "tag" a paragraph, first select a paragraph or paragraphs with the 
Paragraph tool, and then select a tag name from the Tags list (Figures 
3-11 and 3-12). If multiple paragraphs are selected the same tag is 
assigned to all of the selected paragraphs. 
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Figure 3-11. Selecting and tagging a paragraph. The tag Chapter Title will 
be assigned. 
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Figure 3-12. After the mouse button is pressed, the paragraph is changed. Note 
how the tag has changed not only the font, but the space between paragraphs as 
well. 

Tagging with 
function keys 

Up to ten tags from the Tags list can be assigned to your keyboard's 
function keys (refer to the Update Tags list option section starting on 
page 10-66). You can then assign a tag to a paragraph simply by 
selecting the paragraph and pressing the appropriate function key. You 
can also use the function keys to tag text while you are using the Text 
tool. 
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Generated tags Text in headers, footers, section numbers, captions, table of contents, 
and indices is automatically tagged with generated tags. Generated tags 
are created by Ventura Publisher, and always have names which begin 
with Z_. Generated tags are assigned Body Text attributes when first 
created. You can change generated tags as you would any other tag. 

A list of the tags generated by Ventura Publisher is shown on page 3-64. 

When you tag a header or footer, the entire header or footer is selected. 
To change the attributes of any part of a header or footer use text 
attribute codes in the Headers and Footers dialog box. 

Modify tag 

To modify a given tag: 

~ Select a paragraph already formatted with the tag you wish to modify. 

~ Select any of the Paragraph tool option buttons and make the changes 
you desire. 

Note that as soon as you click on the OK button in any of the dialog boxes 
associated with the Paragraph tool option buttons, every paragraph in 
the entire chapter already formatted with this tag will be changed. If 
you then save the chapter or style sheet, the change to this tag will be 
permanently saved in the style sheet. 

The Paragraph tool and the tab bar 

The tab bar allows you to interactively create, set, and delete tabs, 
adjust the In From Left and In From Right settings, and adjust the 
In/Outdent Width setting for the currently selected paragraph. 

To use the tab bar, you must have the Show Rulers option in the View 
menu enabled. 

Refer to the Using the tab bar section starting on page 3-54 for a 
description of the tab bar functions and how to use the tab bar with the 
Paragraph tool. 
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Text tool 

The Text tool is a built-in word processor which can be used to: 

• Change text and paragraph tag attributes, 

• Add, delete, copy, or move text 

• Insert index references, frame anchors, and footnotes 

• Compose a new document directly in Ventura Publisher 

• Tag paragraphs 

Text tool option buttons 
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1 

When you click on the Text tool button, the tool option buttons change 
to display options that are commonly used with the item that is current­
ly selected. The following is the default set of option buttons available 
when a selected range of text is selected. 

2 3 4 5 6 7 8 9 10 11 12 13 14 
==-:!r= 

1-Normal 6 - Subscript 
2 - Bold 7 - Underline 
3 - Italics 8 - Double underline 
4 - Small capitals 9 - Strike-thru 
5 - Superscript 10 - Overscore 

11 - Font attributes 
12 - Uppercase 
13 - Lowercase 
14 - Initial capitalization 

The following is the default set of option buttons available when the 
paragraph is selected by placing the text cursor anywhere in the para­
graph. 

Button 15 will not be displayed if a standard VGA(640 x 480 resolution) 
video driver is installed in Windows. 
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1 2 11 12 13 14 15 

1- Fonts 6 - Special effects 11 - Paragraph typography 
12 - Auto-numbering 2 - Alignment 

3 - Spacing 
4 - Breaks 
5 - Tab settings 

7 - Ruling line below 
8 - Ruling line below 
9 - Ruling box around 
10 - Add new tag 

Changing text attributes 

13 - Update tags list 
14 - Attribute overrides 
15 - Define colors 

U sing the Text tool, you can make font and attribute changes to single 
characters, or blocks of text. You can also apply tag attributes to para­
graphs in much the same manner as using the paragraph tool. 

Text attributes include: 

• Bold 

• Italic 

• Overscore 

• Small caps 

• Strike-thru 

• Subscript 

• Superscript 

• Underline and Double Underline 

• Font 

To change text attributes: 

• Click on the Text tool button. The cursor changes to an "I-Beam." 

• N ext, move the mouse cursor directly in front of the first letter to be 
selected. 

• Press and hold the mouse button. 

• While holding the mouse button, drag the mouse cursor to the end of 
the last character in the text you want to select. 

• Release the mouse button. 
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Text tool 

The selected text (Figure 3-13) is shown in reverse video (white text on 
black background). If the wrong text is selected, repeat the selection 
process. 

.. 
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Chicago to Tokyo 

Figure 3-13. Using the Text tool to select text and change attributes. 

You can also select text by the following steps: 

~ Move the mouse cursor to the beginning of the text you want to select. 

~ Press and then release the mouse button. 

~ Move the mouse cursor to the last character in the text to be selected. 

~ Press and hold the Shift key, then press the mouse button once. 

You can extend or shorten an existing selection by using this Shift key 
and mouse combination. Note, however, that text cannot be selected 
across page or frame boundaries. 

Once text is selected, you can assign as many of the Text attributes as 
you desire. For instance, to change the selected text to boldface and 
underline, click on the Bold option button, and then click on the 
Underline option button. 

Clicking on the Normal option button clears all attributes from the 
selected text and returns the text to the attributes set by the paragraph 
tag. 
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Clicking on the Normal option button returns the selected text to the 
font set by the paragraph tag. If the paragraph tag is set at bold, italic, 
etc. and you want to set the selected text's font to medium weight (not 
bold or italicized), use the Set Font Attributes option button described 
on the next page. ' 

Text and font attributes that you set using the Text tool take precedence 
over font attributes applied with a paragraph tag. They will always 
override the attributes of the paragraph tag. 

Change Text To The Capitalize option button converts selected text to initial capital 
letters. The Upper Case option button changes every letter to upper 
case. 

The Normal option button restores text to the attributes specified in the 
paragraph tag. It does not, however, undo case conversions (e.g., upper­
case to lowercase). 

Set Font To change the font of selected text: 
Attributes 

~ Click on the Text tool button. 

~ Select the text whose font you wish to change. 

~ Click on the Set Font Attributes option button. The Font Setting 
For Selected Text dialog box (Figure 3-14) is displayed. 

Figure 3-14. Font Setting dialog box. Typeface selection shown is for PostScript 
prmters. 
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> Select the Face, Size, Style, and Color you desire and then select 
the OK button. 

Custom colors defined using the Define Colors option will appear in 
the Color list box of this dialog box. 

Interactive font The interactive font selection feature allows you to increase and de­
selection crease the font of selected text one point at a time simply by pressing 

Shift plus the up or down arrow keys on your keyboard. To use this 
feature: 

> Select the range of text you want to change. 

> Press and hold either Shift key and press the up or down arrows on 
the keyboard. The font will increase or decrease by one point each 
time you press the up or down arrow. 

Because the font size increases or decreases by one point each time you 
press the up or down arrow, interactive font selection works best when 
using a printer or typesetter for which Custom Size is enabled in the 
Font option dialog box (e.g., a PostScript printer). For other printers, 
you must press the up or down arrow several times to go from one font 
selection to the next. For example, if your printer has 14 and 18 point 
sizes available for a particular typeface, then you must press the up 
arrow four times to change from 14 to 18 point. 

Interactive Kerning is the process of moving letters closer together, and is usually 
on-screen used in headlines where certain letter combinations, such as a capital V 

kerning and followed by a capital A, appear to be too far apart when spaced with 
tracking normal proportional spacing. For example, the A in the word VALUE is 

kerned in the second line below. 
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Unkerned text: VALUE 

Kerned text: VALUE 
Tracking is the process of moving every letter in a word or sentence 
either further apart or closer together. 

Interactive kerning/tracking can be used in several ways to: 

• Make text fit a given space. 
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• Improve the appearance of large headlines. 

• Locally adjust typography without creating a new paragraph tag. 

This feature is particularly useful in creating headlines and titles, since 
you can instantaneously see the effect of your changes on the overall 
layout. This feature can also be used to manually kern (move to the left 
or right) individual characters. 

To use the interactive kerning/tracking feature, follow these steps: 

~ Click on the Text tool button. 

~ Place the text cursor at the beginning of the text you wish to adjust. 
Press and hold the mouse button. Drag the mouse cursor over the 
range of text you wish to adjust and release the mouse button. 

~ Press and hold either Shift key and press the left or right arrow key 
on the keyboard. 

Each time you press an arrow key, every letter in the selected text is 
moved closer together (left arrow) or further apart (right arrow). 

Alternatively, after selecting the characters, click on the Set Font 
Attributes option button. The Font Setting For Selected Text dialog box 
(Figure 3-14) is displayed. Then: 

~ Set the Kern option to Loose to move the characters apart and to 
Tight to move the characters together. 

~ In the entry field, enter the amount of space to add (looser) or subtract 
( tighter) between each character. 

The amount you enter is measured in Ems, where one Em equals the 
width of the @ character in the currently selected font. You will quickly 
discover that adding one full Em between each character makes a 
dramatic difference. Most kerning changes are made in small fractions 
of an Em. 

To move an individual letter to the left or right 

~ Select only a single letter. 

~ Press and hold the Shift key. 

~ Press either the right or left arrow key. The text following the selected 
letter will move in the direction of the arrow. 
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Shift text 

Text tool 

You can shift selected text up or down. In the Font Settings For Selected 
Text dialog box (Figure 3-14), set the Shift option to Up to move the 
text up, or to Down to move the text down. Then enter the amount by 
which you wish to shift the text in the entry field. 

Add, delete, copy, and move text 

The Text tool allows you to add and delete text. When adding and 
deleting text, enable the Show Tabs & Returns option in the View 
menu in order to see hidden formatting characters. 

To add or delete existing text: 

> Move the mouse cursor to the point directly after the character to be 
edited and press the mouse button. A vertical text cursor is displayed, 
indicating that you can begin typing. 

> Use the Backspace key to delete text directly to the left of the text 
cursor, and use the Delete key to delete text directly to the right of 
the text cursor. 

> Press any character key on the keyboard to add text. 

You can also add many characters not on the keyboard including: 

• Foreign language and special typographic characters 

• Math and Greek characters 

• Line Breaks 

• Special spaces 

• Discretionary hyphens 

Foreign Ventura Publisher can generate characters not normally found on a ~ 
language and standard keyboard. These include foreign language and other special 

special characters. These are useful for several tasks: 
characters 
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• Adding foreign words. 

• Adding real typographic characters such as: 

- Em dashes (- instead of --) 
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- True typographic quotes (" " instead of ") 

To add characters not on your keyboard: 

~ Locate the desired character and its ANSI code equivalent in Appen­
dixE. 

~ Hold down the AIt key on the keyboard. 

~ Enter the ANSI code using the numeric keypad. 

~ Mter the number is entered, release the AIt key. The character is 
displayed on the screen. 

For instance, to enter an accented lowercase E (e), press the AIt key and 
type 0233. 

You can delete foreign language and special characters and change their 
attributes just like any other keyboard character. 

If a special or foreign character entered does not print, this character 
may not be available for the printer you have currently selected. Print 
the CHARSET chapter located in the TYPESET directory to see the 
character set for your printer. 

Math and Greek Ventura Publisher provides a mathematical and Greek character set. 
characters Unlike the additional characters described in the previous section, these 

characters are selected by changing to the Symbol typeface. When you 
tag a paragraph with a symbol font tag, every character in the para­
graph is converted to a symbol character. For instance, an upper case F 
(ANSI code 070) displays as <P. 

To change all characters in a paragraph to symbols, click on the Para­
graph tool button, then create a new tag and change its typeface to 
Symbol. 

To create occasional symbols within a paragraph: 

~ Place the text cursor at the beginning of the text you wish to change. 
Press and hold the mouse button. Drag the mouse cursor over the 
range of text you wish to adjust and release the mouse button. 

~ Use the Set Font Attributes option button to change this range of 
text to Symbol characters. 

Line break When creating headlines and tables, you may want to end a line within 
a paragraph without breaking the text into two paragraphs. This is done 
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with a Line Break. Line breaks are created by holding down the Ctrl key 
while you press the Enter key. Line breaks add the normal inter-line 
spacing, but no inter-paragraph, above, below, or ruling line space. 

Line Break Example Line breaks 

This is a paragraph _, - ______ /--11 
which is broken ... , ________ ----l. 

into three lines using a line break 

This is a second paragraph 

This is a third paragraph 

Spaces Ventura Publisher can create several types of spaces that you can insert 
into your documents when working with the Text tool. Typical examples 
of situations in which you might use such spaces include: 

• Inserting a fixed width space when you don't want the space between 
two words to change, or when you want to add space between two 
numbers in a table without causing the table to misalign. 

• Inserting a non-breaking space when you want to keep two words 
together on the same line. 

The fixed width spaces - Em, En, Thin, and Figure spaces - neither 
increase nor decrease in size during justification. When working with 
text rather than with numbers, choose from among the Em, En, and 
Thin spaces. The Em space is the width of the M character in any font 
(Ventura Publisher actually uses the @ character which provides better 
typographic results); the En space is the width of the lower case n; and 
the Thin space is the width of a period. 

When you want to add space in tables of numbers that must remain 
aligned, choose the Figure space, which is the width of a number. All 
numbers are the same width, even in proportionally spaced fonts. 

The non-breaking space, on the other hand, changes in width as space 
is added or subtracted to make a line justify. Use the non-breaking space 
to keep two words together on one line. 

The following list summarizes the keyboard combinations used to create 
these special types of spaces: 
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Type of space Keystrokes required 

Em space Ctrl + Shift + M 

En space Ctrl + Shift + N 

Figure space Ctrl + Shift + F 

Thin space Ctrl + Shift + T 

Non-breaking space Ctrl + Space 

Discretionary Use discretionary hyphens to tighten a loose line. Aloose line is a line of 
hyphen text which contains too much space between words because the first 

word of the next line could not be hyphenated during the justification 
process. You can manually hyphenate this word by inserting a discre­
tionary hyphen. Unlike a normal hyphen, a discretionary hyphen only 
appears if the word is at the end of a line. The following example shows 
how a discretionary hyphen can tighten a loose line. 

This line is too loose because the word 
overextended has not been hyphenated. 

This line is not loose because the word over­
extended has been hyphenated with a dis­
cretionary hyphen. 

Placing a discretionary hyphen at the beginning of a word suppresses 
hyphenation for that occurrence of the word. If you place a discretionary 
hyphen at the beginning of a compound word such as Alsace-Lorraine, 
then that word will not be broken, even at the normal hyphen. 

To add a discretionary hyphen to any word: 

> Place the text cursor at the point in the word where you wish a 
hyphen to be inserted. 

> Press and hold down the Ctrl key. 

> Press the - (hyphen) key. This hyphen is neither displayed on the 
screen nor printed unless the word needs to be hyphenated. If the 
Show Tabs & Returns option is enabled in the View menu, a small 
hyphen is displayed at each discretionary hyphen point, although this 
hyphen is not printed. 

As you move the text cursor across a word containing a discretionary 
hyphen, the discretionary hyphen's presence is displayed in the current 
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selection indicator box. Once you have displayed the discretionary 
hyphen, you can remove it by pressing the Delete key. 

Start a new document 

You can use Ventura Publisher just like any word processor to create 
new text files. The resulting files can be saved in any file format 
available (e.g., WordStar, WordPerfect, DCA). 

• To create a new text file, click on the Text tool button and place the 
text cursor anywhere on the page. Begin typing. 

• To place text at a specific location, use the Box Text tool to place the 
a box at the location you desire, then use the Text tool to begin typing 
text into this box. 

• To save a text file, click on the Save As function button and save a 
new chapter. A text file will be created with the same file name as the 
chapter, but with the file extension for the word processor format that 
you most recently selected using Load TextIPicture option. If no 
other text files have been loaded, Ventura Publisher will save the new 
file in ASCII format. 

To change the file extension or word processor format: 

~ Click on the Selector tool button. 

~ Select the page or frame containing the text. 

~ Click on the File TypelRename option button. 

~ Change the default extension in the New Name entry field. 

~ Change the word processor file format by selecting the appropriate 
Text Format option. 

Text editing hints 

As you add or delete text, the page automatically reformats as you type, 
so you can always see the effect on the page layout. When editing across 
page boundaries, press the Page Down key to go to the next page, and 
place the cursor at the point where you wish to resume editing. 
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As you add or delete text, you may occasionally see some extra "ink" 
around certain characters and ruling lines. Press the Esc key to redraw 
the page and eliminate this ink. 

Text may suddenly disappear when you are editing near the end of a 
page or column. This is caused by the Widows, Orphans, and Keep 
With Next controls automatically placing text in the appropriate page 
or column. Scroll to a different part of the page, or press the Page Up 
or Page Down keys as necessary, and continue editing. 

As you move the text cursor with the keyboard arrow keys, the current 
selection indicator displays the presence of special items (e.g., text 
attributes, index references, footnotes, frame anchors, etc.). If you cut 
the special item using the Cut function button or by pressing the Delete 
key, the special item will not be cut to the clipboard. To reinsert the 
special item, immediately select the Undo function button. If you wish 
to copy the special item to other locations, select the Copy function 
button or press Shift + Delete and the special item will be copied to the 
clipboard. The copied special item can then be pasted elsewhere by 
placing the text cursor at another location in the document and then 
pressing the Insert key. 

To move, copy, or delete blocks of text, index references, footnotes, and 
anchors, refer to the Cut, Copy, and Paste sections of the Edit menu 
chapter. 

You can undo any cut to the clipboard by immediately selecting the 
Undo function button. 

Ventura Publisher places attribute settings (bold, italic, superscript, 
etc.) at both the beginning and the end of a block of text that is set to 
that attribute. Although the attribute settings do not appear on the 
screen, the current selection indicator flags their presence when the text 
cursor passes over the point at which they are located. If you accidental­
ly delete the attribute at the end of a block of text, the remaining text in 
the paragraph suddenly appears with that same attribute. Immediately 
select the Undo function button to reinsert the attribute code. To avoid 
this problem, look for the word Attribute in the current selection 
indicator before you delete text. 

Attributes are terminated at the end of each paragraph, even if the "end 
attribute" character has been deleted. 
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Use the keyboard arrow keys to move the text cursor a short distance. 
Use the mouse to move the text cursor to remote portions of the page. 

Tagging using the text tool 

Whenever you press the Enter key, you automatically create a new 
paragraph which has the same tag as the last paragraph. You may 
change the tag of the paragraph in which the text cursor currently 
resides simply by selecting a tag from the Tags list. If you want to assign 
tags by using the keyboard keys instead of the mouse, you can assign 
frequently used tags to the special function keys on your computer's 
keyboard. (Refer to the Assign Function Keys option section starting 
on page 10-71.) Once a tag is assigned to a function key, pressing that 
function key while using the Text tool immediately tags the entire 
paragraph in which you are typing. 

Multiple You can very easily tag several consecutive paragraphs while using the 
paragraph Text tool. 

tagging using 
the text tool ~ Select text spanning several paragraphs. 

~ Select a tag from the Tags list or press one of the function keys. All 
paragraphs included in the selection are tagged with the selected tag. 

Page break To create page breaks, you should follow these steps: 
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~ Select a paragraph tagged with the Body Text tag. 

~ Click on the Add New Tag option button. Ensure the Body Text tag 
is displayed in the Copy From list box. 

~ Enter a descriptive name for the tag (e.g., New Pg Mter) and click on 
the OK button. 

~ Click on the Breaks option button and set the Page Break for this 
tag to Mter. 

~ Click on the Update Tag List option and then select the Assign 
Function Keys button. Assign this tag to the function key of your 
choice. 

By pressing this function key while using the Paragraph tool or the Text 
tool in a paragraph tagged as Body Text, you can cause a page break to 
occur after the paragraph. If you want to create a page break after a 
paragraph tagged with a tag other than Body Text, or if you want to 



Text tool THE BASICS 

create a page break within a paragraph, press Enter and then press the 
function key. 

Changing tag attributes using the Text tool 

The text tool allows you to change the attributes of the tag assigned to 
the paragraph in which the text cursor is placed. When the Text tool is 
placed in a paragraph of text (and a range of text is not highlighted), the 
option buttons display functions that allow for changing of the at­
tributes of tag assigned to that paragraph. Simply select the desired 
option buttons and change the attributes of the paragraph in the same 
manner as you would using the Paragraph tool. 

The Text tool and the tab bar 

The tab bar allows you to interactively create, set, and delete tabs, 
adjust the In From Left and In From Right settings, and adjust the 
In/Outdent Width setting for the currently selected paragraph. 

To use the tab bar, you must have the Show Rulers option in the View 
menu enabled. 

Refer to the Using the tab bar section starting on page 3-54 for a 
description of the tab bar functions and how to use the tab bar with the 
Text tool. 
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Table tool 

Table tool 

A table is any text formatted in a row/column matrix. A cell is the 
intersection of a row and column. 

Spreadsheets provide a simple example of row/column formatting. How­
ever, most tables have more than one line of text in each cell, and require 
horizontal and vertical lines, different alignment, and different back­
ground patterns for each cell in the matrix. 

The Table tool allows you to: 

• Create tables and forms. 

• Apply different line attributes to a cell or group of cells. 

• Apply a background tint to any cell or group of cells. Figures 3-15 and 
3-16 show typical types of tables. 

All table information is stored in the text file. Refer to Appendix D for 
information on table format. 

Table tool option buttons 
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When the you click on the Table tool button, the tool option buttons 
change to display functions that are commonly used with the Table tool. 
The default set of Table tool option buttons is shown below. 

1 - Insert row 
2 - Insert column 
3 - Join cells 
4 - Split cells 
5 - Set tint 

6 - Set column width 
7 - Default line style 
8 - Hidden line style 
9 - Single line style 
10 - Double line style 

11- Thick line style 
12 - Add new table 
13 - Edit table settings 
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Other Prisoner's Plea Prisoner 1 Outcome Prisoner 2 Outcome 

Innocent (2, 10) (2, 10) 

Guilty (1, 5) (1, 5) 

Figure 3-15. Simple table. All cells the same size. 

Year Main Memory Control Memory Processor Memory 

1973 
64K 

lKx 1 lKPROM 256x4 32 registers 16x4 

Parity 
Dynamic 

1974 PMOS lKPROM 
PROM as 

lKRAM 
above 

1975 4Kxl 
lKx 1 16x4 64K 

32 registers Schottky Error Dynamic 

1976 Correction NMOS lKx4 bipolar 

2KPROM PROM 

16Kx 1 
lKRAM Schottky 

1977 256K 
Dynamic 

bipolar RAM 
Error 

Correction 
Si gate 

1979 NMOS lKPROM 4Kx 1 RAM 8x 32 256x4 

Figure 3-16. Table where different cell sizes are used. 

Insert new table 

You can insert a table between any two paragraphs while using either 
the Table tool or Text tool. You then insert text into the table using the 
Text tool. To modify the structure of the table, use the Table tool. 

To create a table, follow these steps: 

~ Click on the Table tool button. 

~ Place the table cursor between the two paragraphs where the table is 
to appear. The location for the table is marked by a short horizontal 
line. 
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Table tool 

~ Click on the Insert New Table option button. The dialog box shown 
in Figure 3-17 is displayed. 

You can also insert a table while using the Text tool as follows: 

~ Click on the Text tool button. 

~ Place the text cursor at the beginning of the paragraph to follow the 
table or end of the paragraph which will precede the table. 

~ Select the Insert Special Item option from the Text menu. 

~ From the secondary menu, select Table. The InsertlEdit Table dialog 
box (Figure 3-17) is displayed. 

Figure 3-17. Insert / Edit Table dialog box. 

Once the InsertlEdit Table dialog box is displayed, select the OK button 
to accept the default table values. A three row by three column table is 
displayed at the current location of the text cursor (See Figure 3-18). 
For information on how to change the settings in this dialog box, refer 
to page 13-10. 
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Figure 3-18. Table which results from the settings in Figure 3-17. 

Entering text into the table 

Use the Text tool to type text into the table. As you add text, new lines 
are automatically created and the row height increases to accommodate 
these new lines. Only one paragraph is allowed per cell. Use line breaks 
(Ctrl+Enter) to create additional lines of text within a cell. 

Use the cursor control keys to move the text cursor through the text 
within a cell. The arrow keys also move the text cursor to the next cell. 

You can cut, copy, and paste text within a cell, but you cannot select text 
in more than one cell at a time. You can cut and paste entire rows and 
columns as described in the next subsection. 

Edit tables 

When you first create a table, the Insert/Edit Table dialog box shown in 
Figure 3-17 is displayed. This dialog box lets you define the row/column 
grid into which your table entries are placed. Once you have defined a 
table, you can select and modify portions of it as follows: 

~ Click on the Table tool button. 

~ Position the mouse at the upper left hand corner of the first cell in the 
portion of the table that you wish to select. 

~ Press and hold the mouse button. 

~ Move the mouse to the lower right hand corner of the cell at the end 
portion of the table you wish to select. 

~ Release the mouse button. A gray textured outline highlights the 
selected portion of the table. 
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Using this method, you can select: 

• Any horizontal or vertical line between cells in the table. 

• Any single cell. 

• Any contiguous group of cells. 

• The entire table. 

You cannot select more than one contiguous group of cells at one time. 

Once you have selected a portion of the table, you can modify it in any 
one of the following five ways: 

• Cut, copy, and paste rows and columns. You can exchange one row 
with another, eliminate unwanted information, or copy information 
to another table. You can also remove the entire table. 

• Change every cell in the table. Select any portion of the table and then 
click on the Change Settings option button. This lets you change 
any of the values originally specified in the InsertlEdit Table dialog 
box except the number of rows and columns. 

• Add a new column or row. Place the table cursor at any point in the 
table, then select the Insert Row or Insert Column option buttons. 
The new column or row will be inserted either above (in the case of a 
row) or to the left of (in the case of a column) the current cell. 

• Change column widths. Select any cell or group of cells and then click 
on the Set Column Width option button. You can also interactively 
change the width of a column by pressing the Alt key while dragging 
the column to a new location using the mouse. 

• Apply cell attributes. Select any horizontal line, vertical line, cell, or 
group of cells and then apply an attribute from the Table menu. Use 
this to make one large cell out of several adjacent cells (Join Cells), 
apply a background tint, or override the default ruling lines between 
cells. 

Cut/copy/paste rows and columns 
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U sing the Table tool, you can cut or copy rows and columns. This lets 
you interchange one row or column with another. To do this: 

~ Click on the Table tool button. 
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~ Select the row(s) or column(s) you wish to cut or copy. You only need 
to select a portion of the row(s) or column(s). 

~ Click the Cut function button to remove the row or column from the 
table and place it on the clipboard. A message is displayed asking you 
if you want to Cut/Copy rows or columns. Make the appropriate 
choice. Or, select the Copy function button to copy the row or column 
to the clipboard. 

Once you have cut or copied a portion of the table onto the clipboard, you 
can paste this table segment to another location in the table. To do this: 

~ Select the line between the rows or columns where you wish to insert 
the portion of the table stored on the clipboard. Even if the ruling line 
is hidden, the line between rows and columns still exists and can be 
selected. 

~ Click on the Paste function button. 

~ Select whether to insert the table segment between rows or between 
columns. You can cancel if you decide not to paste. 

If you select the entire table, you can cut or copy the entire table. An 
alert message is displayed warning you that the entire table will be 
removed. 

Change every cell in the table 

To modify the entire table: 

~ Click on the Table tool button. 

~ Select any portion of the table and then click on the Change Set­
tings option button. 

~ The InsertJEdit Table dialog box is displayed. Make the changes you 
wish. (Refer to page 13-10 for a complete description of this dialog 
box.) 

Apply cell attributes 

While using the Table tool you can apply any of the attributes from the 
Table menu to any block of selected cells in the table. 
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Tag a cell 

Each cell in the table is initially tagged with a tag called Table Text. 
However, you can tag any cell in the table with other tags in order to 
change text alignment within a table cell or create certain special 
effects. While you can assign any Paragraph tool attribute option to tags 
which you apply to a table cell, only a few of these attributes are useful 
for tables. The most useful Paragraph tool attribute option for tables is 
the Alignment option. 

One advantage of the Table tool is that you can create most tables with 
only a few tags. For instance, if you occasionally want to change the font 
of text within a cell, select the text using the Text tool and use Text tool 
options rather than creating a new tag. If you need more space between 
lines in a particular cell, change to Text tool and use a line break 
(Ctrl+Enter) rather than create a new tag with more space above or 
below. 

The following subsections describe how each of the Paragraph tool 
options can be used for text within a table. 

Font You can create a tag with a different font. This is useful for table 
headings. However, as mentioned before, for occasional font changes you 
may find it easier to simply select text in the cell (using the Text tool) 
and then change its font using the Set Font Attributes option button 
(or the Shift + up/down arrow shortcut). If you set the Grow Inter­
Line To Fit option to On in the Paragraph Typography dialog box, 
any font size changes will automatically cause the space between lines 
to increase, and the row to grow. 

Alignment The Paragraph tool Alignment option is the most important option to 
use for table tags. The four settings which are particularly useful are: 

• Horizontal alignment 

• Vertical alignment 

• Rotated text 

• In from right to decimal 

Various combinations of horizontal and vertical alignment let you place 
the text in any corner, any side, or in the center of a cell. In addition, if 
you use the Paragraph tool Alignment option and set the Horiz. 
Alignment option to Decimal, you can align numbers by a fixed 
amount from the right side of each cell. 
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If you choose rotated text, you should limit the Maximum Rotated 
Height of the text to limit the vertical height of the cell. Use a line break 
(Ctrl+Enter) to limit the length of any line of the rotated text. 

Click on the Paragraph tool Spacing option button and use the Above 
option to move the text down within a cell, although a line break 
(Ctrl+Enter) may be simpler if you want to move text only occasionally. 
Change the Inter-Line option setting to change the space between lines 
within a given cell. 

To move all text in the table away from the ruling lines between each 
cell, click on the Table tool button, select any part of the table and click 
on the Change Settings option button. The Space Between Rows 
and Space Between Columns option settings determine the spacing 
between the lines of the table and the text entered in the table cells. To 
apply spacing globally to the text in tables throughout your document, 
use Paragraph tool Spacing option and set the In From Left and In 
From Right settings to adjust the spacing for the Table Text tag. 

Breaks/Special The Paragraph tool Breaks and Special Effects options are not par­
Effects ticularly useful for most tables. Set the Line Break option to Before or 

Mter, and the Keep With Next option to No. 

Tab settings The Table tool eliminates the need for tabs, although you can still use 
tabs within a cell in a table, if the need should arise. 

The Auto-Leader option in the Tab Settings dialog box is very useful 
however. This option lets you automatically fill a table cell with any 
character, such as a dash or period. To use this feature: 

> Click on the Paragraph tool button and select a cell paragraph to 
which you want the auto-leaders applied. 

> Generate a new tag name using the Add Tag option button. 

> Click on the Tab Settings option button. 

> Set the Auto-Leader option to On, then select a Leader Character 
and Leader Spacing option. Click the OK button to exit the dialog 
box. 

> Click on the Spacing option button and set the In From Left and In 
From Right settings to limit the width of the leader within the cell. 
Click on the OK button to exit the dialog box. 
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If you tag a blank cell, the leader character immediately fills one line of 
the cell. If you tag a cell which contains text, the leader character 
formats from the end of the last line of text to the right margin of the 
cell. You don't need to enter a tab character to make the leaders appear. 

Attribute The Paragraph tool Attribute Overrides option allows you to define 
Overrides line attributes that can be applied to selected text. Also, if you set the 

Line Width option to Margin-Wide, any line attribute will automat­
ically extend across the entire cell, minus any In From Left or In From 
Right values in the Spacing dialog box and Space Between Columns 
value in the InsertJEdit Table dialog box. This is useful to make the 
applied line attribute always cover the width of the cell, regardless of 
how much text a line contains. Use this for the double underline for 
subtotals in tables. For most table tags, set the Line Width option to 
Margin-Wide. 

Paragraph The most useful feature within this dialog box is Grow Inter-Line To 
Typography Fit. Set this option to On for most table tags. When turned on, you can 

select text within a cell and increase its font size, and the inter-line 
space automatically adjusts to make room for the larger font. 

Ruling lines You can place ruling lines above or below text. These rules will appear 
within the cell and should not be confused with the table rules, which 
appear around the table and between cells. 

Recommended You can create many tables with just the following tags: 
table tags 
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Tag Name Tag Settings 

Table Left Horizontal alignment = Left 
Vertical alignment = Middle 

Table Horizontal alignment = Center 
Center Vertical alignment = Middle 

Table Horizontal alignment = Decimal 
Decimal In From Right to Decimal = 2 picas 

Vertical alignment = Middle 

Table Horizontal alignment = Center 
Leaders Vertical alignment = Middle 

Tab Auto Leaders = On 
(select Leader character other than 
space) 

Table Horizontal alignment = Left 
Rotate Vertical alignment = Top 

Text Rotation = 90 
Maximum rotated height = 3 picas 
(adjust as necessary to fit your table) 

The following table shows some of the most common effects created with 
tags. In addition to those shown, you can create a large variety of 
alignment effects by combining the settings in the Alignment and 
Spacing option dialog boxes. In general, try to minimize the number of 
table tags you create. Use the Text menu Set Font Attributes option 
dialog box to set font attributes, and line breaks (Ctrl+Enter) to create 
additional space between lines. 

Rotated Text Line Width Decimal Alignment 
Marfrln Wide 

1,768.90 
"'tj 123.45 (123.45) Q) ................. ~ (25.34) 4,555,123.23 ro~ 
~ ~ o Q) 1,867.01 ~~ 

This is tagged the 
same as the cell 

"'tj 1,867.01 
above, but the cell Q)E 34,158.54 

23,455.78 
above contains no ~ ro ~ o ~ ~ 

~ 0 Q) 
text at all .......... ~~ 
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PRN to table import filter 
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The PRN to Table import filter can automatically recognize columnar 
data and convert it into a table. This converter can read a Lotus 1-2-3 
PRN, dBase TXT, or similar file. Other spreadsheet and database 
programs can produce files which can be read directly by this converter. 
Once you create the file, you can then use the PRN to Table option in 
the Load TextlPicture dialog box to insert the resulting table anywhere 
in the text of your document. 

The data in the text file created by your spreadsheet or database must 
be formatted with at least two spaces between each column. Refer to the 
documentation that accompanied your database or spreadsheet applica­
tion for procedures on creating a print file. Additional information about 
exporting spreadsheet and database information in a format suitable for 
import into Ventura Publisher can be found in the Text From Other 
Programs chapter (Chapter D). 

If the Destination option is set to List of Files, when the .PRN file is 
imported, a file with the same name, but a . TBL extension, is created. 
Any editing done to the imported table while in Ventura Publisher will 
be reflected in the .TBL file and not in the .PRN file. If the .PRN file is 
subsequently edited outside of Ventura Publisher and the chapter con­
taining the .PRN file is opened again, a new. TBL file will be created and 
any previous edits made to the table while in Ventura Publisher will be 
lost. 

If the Destination option is set to Cursor, the .PRN file is incorporated 
into the existing text file loaded in the chapter, and any editing done to 
the .PRN file outside of Ventura Publisher will not be reflected in the 
chapter. This is the recommended way of incorporating .PRN files. 
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The graphic tools allow you to draw lines, ellipses, circles, square-corner 
rectangles and squares, and rounded-corner rectangles and squares. 
You can also place text in a box and move this box anywhere on a page. 
Once you have drawn these objects, you can assign different line and fill 
attributes to each of them. You create drawings either on the current 
page or attached to a selected frame. 

To cut, copy, or paste graphics, use the Selector tool. 

The graphic tools are designed to let you: 

• Draw call-outs for pictures which you have loaded into frames from 
other drawing programs. 

• Place additional ruling lines and crop marks anywhere on the page. 

Graphic tool option buttons 

The graphic tool buttons are used to create various graphics on the 
current page. When the you click on one of the graphic tool buttons, the 
tool option buttons change to display functions that are commonly used 
with the Selector tool for editing the graphics. However, these option 
buttons are grayed and not available for selection until the Selector tool 
is enabled and a graphic selected. Refer to the Selector tool section for a 
description of the tools available for editing the graphics after they are 
created. 

Attaching graphics to frames 

Graphics are attached either to the base page or to a specific frame. If 
you attach a graphic to a frame, the graphic will be moved with the 
frame when that frame is moved, cut, or copied. The ability to tie 
graphics to frames is useful for creating callouts or adding typo­
graphically sophisticated text to pictures and graphs. Also, since frames 
can be anchored to the text, tying graphics to frames allows you to 
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anchor graphics to a specific point in the text. This feature is useful 
when you want to keep illustrations and the text that refers to them on 
the same page. 

To attach a graphic to a frame or page, use the Selector tool to select the 
frame or page, and then use the graphic tools to draw graphics. 

To attach existing graphics to a different frame, simply cut the graphic 
as describe later in this section, select the frame to which the graphic 
should be attached, and paste the graphic back onto the page. 

Grid settings 

Graphics can be snapped to an invisible grid which is defined using the 
Grid Settings option (Figure 3-19). The grid setting can be different 
for each frame or for each inserted page in the chapter. 

Figure 3-19. Grid Settings dialog box. 

The grid settings helps you align different graphic objects with one 
another. Refer to the Grid Settings option section in the Graphic 
menu chapter for more details. 

Drawing graphics 

~ Using the Selector tool, select the frame to which the graphic should 
be attached. 

~ Click on one of the graphic tool buttons. 

~ Place the mouse cursor where you want the drawing to begin. Press 
and hold the mouse button. 

~ Move the mouse to create the desired size and shape of the object. 
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~ Release the mouse button when the desired size and shape has been 
obtained. 

Mter each graphic is drawn, Ventura Publisher automatically changes 
to the Selector tool, so you can move or resize the graphic just drawn. 

Drawing If you want to draw several graphics of the same kind, you can retain 
multiple graphics the drawing tool currently selected, by depressing and holding either 

Shift key while drawing each graphic. As long as you depress the Shift 
key while drawing the graphic, the drawing tool remains available. 

Squares, circles, If you press and hold the Alt key while you draw or resize a graphic, the 
and constrained graphic will be constrained to perfect proportions. This means that you 

lines get: 

• A perfect circle instead of an ellipse 

• A square instead of a rectangle 

• Horizontal, vertical, or 45° lines 

Selecting graphics 

Graphics are selected and manipulated using the Selector tool. To select 
a graphic: 

~ Click on the Selector tool button. 

~ Place the cursor within the area of the graphic and click the mouse 
button. 

Handles will appear around the graphic. Also, the current selection 
indicator shows the type of graphic currently selected (e.g., circle, line, 
rectangle, box text). 

Selecting Multiple graphic objects can be selected by pressing and holding either 
multiple graphics Shift key and then selecting each individual graphic. These graphics 

can then be cut, copied, pasted, or moved. Attributes can be applied 
simultaneously to all selected graphics if they are of the same type (e.g., 
all rectangles). 

~ Only multiple graphics tied to the same frame can be selected this way. 
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All graphics associated with a frame can be selected by selecting the 
frame to which they are attached and then clicking on the Select All 
option button or pressing Ctrl+Q. 

Selecting When one graphic is completely covered by another graphic, it some­
graphic on times seems impossible to select the graphic on the bottom. To select a 

bottom graphic which is covered by several other graphics: 

> Click on the Selector tool button. 

> Press and hold the Ctrl key and then select the first graphic. 

> While holding the Ctrl key, press the mouse button again to select the 
next graphic down from the top. 

> Continue pressing the mouse button, while holding the Ctrl key, until 
you select the desired graphic. 

Resizing graphics 

Once a graphic is drawn, you can resize it as follows: 

> Select one or more graphics as describe previously in this section. 

> Place the mouse cursor over one of the little black handles around the 
edge of the graphic (or anyone of the graphics if more than one 
graphic is selected). 

> Press and hold the mouse button, drag the handle to resize the 
graphic or graphics, and then release the mouse button. 

When resizing multiple graphics, all graphics in that group will change 
size proportionally. 

Moving graphics 

To move a graphic: 

> Select one or more graphics as described previously in this section. 

> Place the mouse cursor within the area of the graphic (or within the 
area of anyone of the graphics if more than one is selected). 
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> Press and hold the mouse button and drag the graphic or graphics to 
its new location. Release the mouse button. 

Changing graphic attributes 

To change attributes of a graphic: 

> Select one or more graphics as describe previously in this section. 

> Click on the Line Attributes or Fill Attributes option buttons and 
make the appropriate selections. (Refer to the Fill Attributes and 
Line Attributes options section in the Graphic menu chapter for 
more information.) 

Repeating graphics 

Normally, graphics tied to the current page will show on that page only. 
They can, however, be made to repeat on every page as follows: 

> Select the graphic you wish to appear on all pages. 

> Click on the Show On All/This Page(s) option button. 

To prevent a graphic from repeating on all pages: 

> Select the repeating graphic from any page. 

> Click on the Show On All/This Page(s) option button. 

Superimposed If graphics are placed on top of one another, the last graphic drawn is 
graphics always placed on top. To change this order, first select the graphic you 

wish to move, then click on either the Send to Back or Bring to Front 
option button. The selected graphic is then placed either on the bottom 
of all graphics associated with this frame (Send to Back), or on the top 
(Bring to Front). 

Figure 3-20 shows a line behind a rectangle. Figure 3-21 shows the 
result of selecting the line and then clicking on the Bring to Front 
option button. 
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, 
Figure 3-20. Line behind a rectangle. Figure 3-21. Line brought to front of rectangle. 

Box text 
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The Box Text tool feature allows you to place text anywhere on the page. 
Unlike text in frames, which is formatted in columns and causes text in 
other frames to move aside, box text is formatted in a single column, and 
overlaps all text and pictures on the page. Think of box text as a Post-it™ 
(self-adhesive yellow note paper) that can be placed anywhere on the 
page. 

To create box text: 

~ Use the selector to select a frame (or the page) to which the box text 
will be attached. 

~ Click on the Box Text tool button. 

~ Draw a box in the same manner as you would draw a frame. 

If the Show Tabs & Returns option in the View menu is enabled, you 
will notice that the end of file marker (a small square) is displayed 
within the box. This shows you where to place the text cursor to begin 
typing. If necessary, use the Selector tool to make the box larger or 
smaller, to hold more or less text. Click on the Text tool button and enter 
text into this box. 

The text entered into this box is stored in the chapter's caption (.CAP) 
file. 

The line and fill attributes of the box text graphic can be changed the 
same as any other graphic. 

The text entered in a box text graphic is initially assigned the 
Z_BOXTEXT tag. The attributes of this tag can be changed using the 
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Text and Paragraph tools the same as any other text in Ventura 
Publisher. Additionally, any tag in the style sheet can be assigned to the 
box text. 

Box text callouts Use the box text and graphic line features to place callouts outside, but 
attached to, a frame that contains a picture. 

By creating box text and lines with arrow ends attributes, you can create 
callouts to annotate pictures placed in frames. 

By attaching the box text and line callouts to the frame containing the 
picture, moving the frame will cause the entire set of graphics to move 
as a single unit. 
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Using the tab bar 

The tab bar allows you to interactively create, set, and delete tabs, 
adjust the In From Left and In From Right settings, and adjust the 
In/Outdent Width setting for the currently selected paragraph. 

To use the tab bar, you must have the Show Rulers option in the View 
menu enabled. 

When placing and moving tabs on the tab bar, the tabs will snap to the 
tick marks on the ruler. The unit of measure used for the rulers can be 
set using the Set Ruler option in the View menu. Refer to the Set Ruler 
section starting on page 7-5 for information on setting the unit of 
measure for the rulers. 

Tabs and temporary margins are measured from the edges of the 
column, not the page. When the rulers are displayed and a paragraph 
selected, the zero point of the ruler will adjust to correspond to the left 
column edge for the currently selected paragraph. This allows you to 
better adjust the tab bar markers visually rather than having to calcu­
late the difference between the set zero point and the actual column 
edge. 

Once the Selector tool is enabled, or all paragraphs are deselected, the 
ruler zero point will return to the position set using the Set Ruler option 
or the interactive zero point adjustment feature. 

Interactive tabs 

The tab bar allows you to interactively adjust the tab settings for the 
selected paragraph. When a paragraph is selected, the tabs set for that 
paragraph are displayed in the tab bar (Figure 3-22). 

Figure 3-22. Tab bar with default tabs for the Body Text tag. 
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Placing a new To interactively place a new tab: 
tab 

~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph to which you want to interactively add a tab. 
Remember, the tab is actually added to the paragraph's tag. In other 
words, if you add a tab to one paragraph with that tag, you add it to 
all paragraphs with that tag. 

~ Click on the tab button of the type of tab you want to place. The 
following are the tab types: 

Left tab - text is left aligned at the tab location. 

Center tab - text is centered at the tab location. 

• III I Right tab - text is right aligned at the tab location. 

· IliJ Decimal tab - text is decimal aligned at the tab location. 

~ Click on the tab bar at the location you want the new tab. The tab 
snaps to the nearest increment marker on the ruler. If you want to 
place the tab without snapping to the ruler, hold the Ctrl key down 
while placing the tab. 

Moving a tab To interactively move a tab: 

~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph that has a tab you want to interactively move. 
Remember, the tab is actually a part of the paragraph's tag. In other 
words, if you move the tab in one paragraph with that tag, you move 
it in all paragraphs with that tag. 

~ Place the mouse cursor over the tab marker you want to remove. 

~ Click and hold the mouse button. 

~ Slide the tab marker to its new location and release the mouse button. 
The tab snaps to the nearest increment marker on the ruler. If you 
want to place the tab without snapping to the ruler, hold the Ctrl key 
down while moving the tab. 

Deleting a tab To interactively delete a tab: 

~ Click on either the Paragraph tool or the Text tool button. 
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~ Select a paragraph from which you want to interactively delete a tab. 
Remember, the tab is actually deleted from the paragraph's tag. In 
other words, if you remove a tab from one paragraph with that tag, 
you remove it from all paragraphs with that tag. 

~ Place the mouse cursor over the tab you want to remove. 

~ Click and hold the mouse button. 

~ Slide the tab off the ruler and release the mouse button. 

Interactive in/outdent and paragraph margins 
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The tab bar allows you to interactively adjust the In From Left and In 
From Right settings, and adjust the In/Outdent Width setting. 

Three separate markers are interactively set on the ruler: the first line 
in/outdent marker, the temporary left margin marker, and the tem­
porary right margin marker. These settings are associated with a para­
graph tag and are stored in the style sheet. Before you can change these 
settings, you must first select the paragraph with which you want to 
work. 

U sing either the Paragraph tool or the Text tool, select the desired 
paragraph. The markers for that tag are displayed on the tab bar 
(Figure 3-23). 

Figure 3-23. Tab bar with tab, in / outdent, and temporary margin markers. 

Refer to the Spacing section starting on page 10-10 for more informa­
tion about how the temporary left and right margins work. Refer to the 
Alignment section starting on page 10-5 for more information on setting 
the In/outdent Width setting. 
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In/Outdent The in/outdent marker sets the first line indent or outdent for the 
marker paragraph. It interactively changes the In/Outdent Width value in the 

Alignment dialog box. To interactively change the first line in/outdent of 
a paragraph: 

~ Ensure that the paragraph you want to work with is selected. 

~ Click on and hold the top indent marker (if the rulers aren't visible, 
enable the Show Rulers option in the View menu). 

~ Slide the in/outdent marker to the desired location and release the 
mouse button. The marker snaps to the nearest increment line of the 
ruler. If you want to place the marker between increments, hold the 
Ctrl key down while moving the marker. 

The number of lines in/outdented using this marker is set using the 
In/Outdent Height setting in the Alignment dialog box. Refer to page 
10-5 for information on setting the number of lines affected by the 
in/outdent marker. 

Temporary left The bottom, left marker sets the temporary left margin of the para­
margin marker graph. It interactively changes the In From Left value in the Spacing 

dialog box. 

~ Ensure that the paragraph you want to work with is selected. 

~ Click on and hold the temporary left margin marker (if the rulers 
aren't visible, enable the Show Rulers option in the View menu). 

~ Slide the indent marker to the desired location and release the mouse 
button. The marker snaps to the nearest increment line of the ruler. 
If you want to place the marker between increments, hold the Ctrl 
key down while moving it. 

Temporary right The right marker sets the temporary right margin of the paragraph. It 
margin marker interactively changes the In From Right value in the Spacing dialog 

box of the Paragraph menu 

~ Ensure that the paragraph you want to work with is selected. 

~ Click on and hold the temporary right margin marker (if the rulers 
aren't visible, enable the Show Rulers option in the View menu). 

~ Slide the marker to its new location and release the mouse button. 
The marker snaps to one of the increment lines of the ruler. If you 
want to place the marker between increments, hold the Ctrl key 
down while moving it. 
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Using Ventura Publisher as a word processor 

Differences from a word processor 

The Text tool provides a built-in text editor. Like a word processor, the 
Text tool allows you to add, delete, move, and copy text. However, unlike 
a conventional word processor, the text is displayed in the exact location 
and in the format that you will see on the final printed page. This results 
in the following differences in operation compared to most word proces­
sors: 

• You must always use the mouse to place the text cursor on the page 
at the location where you want to edit text before you begin typing. 

• Since you can place text anywhere on the page (by placing text in a 
frame or in box text), paragraph measurements are calculated from 
the left column edge, not from the edge of the page. For instance: 

- Tab Settings are measured from the left edge of the current 
column. 

- Paragraph Alignment and Spacing are also measured from 
the left edge of the current column. 

Word processing in Ventura Publisher 

You can create a new document directly within Ventura Publisher, 
without ever using an external word processor. Follow these steps: 

~ Ensure that you start with a new chapter by clicking on the New 
function button. Select a style sheet to use with the new chapter, or 
click on the Cancel button to use the currently loaded style sheet. If 
the New function button is not available, this means that an empty, 
untitled chapter is already displayed. 

~ Click on the Text tool button. 

~ Move the mouse cursor to the upper left corner of the page and press 
the mouse button once. 

~ Begin typing. 

~ Click on the Save As function button. The file name you choose will 
create both a chapter file and a text file. The chapter file will have the 
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extension CHP and the text file will have whatever extension and 
whatever file format you specified the last time the Load TextlPic­
ture option was used. 

You may want to create a different text file name or word processor 
format from those automatically provided when you click on the Save 
As function button. To do this, follow these steps prior to using the Save 
As function button: 

> Click on the Selector tool button. 

> Select the frame containing the text. 

> Click on the File TypelRename option button. 

> Enter the name of the text file (including the extension) you wish to 
create in the New Name entry field. 

> Select the desired a Text Format option then click on the OK button. 

When you save the chapter using the Save or the Save As function 
buttons, the text files will be saved with the file name and format you 
specify. The chapter must be saved before the text file will be saved in 
the specified format. 
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How to produce style sheets 
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Style sheet definition 

A style sheet is a computer file which controls text attributes (e.g., font, 
line spacing, color) and text placement (e.g., widow & orphan control, 
keep with next) for each paragraph in your document. When you design 
a style sheet, you give each set of typographic attributes a name. These 
names are called tags. 

You assign attributes from the style sheet to each paragraph in the 
document by first selecting a paragraph and then selecting the ap­
propriate tag from the Tags list. When you assign a tag name to a 
paragraph, the tag name is inserted invisibly into the paragraph, and 
the paragraph is reformatted according to the attributes contained in 
the style sheet for that tag name. 

The style sheet approach allows you to apply the same typographic 
formats to many chapters, regardless of which word processor you used 
and regardless of who wrote the chapter. It also allows you to instantly 
change the format of an entire chapter by loading a different style sheet. 

Loading a style sheet 

Load an existing style sheet by clicking on either the Load Diff. Style 
or New function button and selecting a style sheet name from the Open 
File dialog box. Once you have loaded a style sheet, you can modify it by: 

• Changing the Paragraph tool option settings. 

• Changing the setting for the Page Size & Layout, Chapter Typo­
graphy, Widows & Orphans, Auto-numbering, and Footnote 
settings. 

• Modifying the Frame tool options settings for the page. 

• Loading a new printer width table. 

If you save either the style sheet or the chapter, the changes made are 
saved in the original style sheet file. However, if you click on the Save 
Style As function button, and specify a new file name, then a new style 
sheet is created and the original style sheet remains unchanged. 
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Any modification to the style sheet is saved whenever you save the cur­
rent chapter. If you don't want these changes to affect other chapters 
which use the same style sheet, click on the Save Style As function 
button and enter a different style sheet name before saving the chapter. 

To assure that a style sheet is never modified, use the File Manager to 
set the style sheet file attribute to READ-ONLY. 

Creating style sheets 

To create a style sheet, follow these steps: 

~ Click on the new function button to start a new chapter and load a 
different style sheet. Most people find it easier to modify an existing 
design than to create a completely new style sheet. If you do want to 
start with a blank style sheet, load the DEFAULT.STY style sheet 
from the TYPESET directory. 

~ Click on the Save Style As function button to save the style sheet 
under a new name. This keeps you from accidentally modifying an 
existing style sheet and any chapter using that style sheet. 

~ Click on the Text tool button and enter some sample text on the base 
page. As you make changes to the style sheet, you can see the effects 
on this sample text. 

~ Click on the Selector tool button and select the base page frame. Click 
on the Margins & Columns option button and enter information for 
both the left and right page. If the document is to be bound, add 
additional space to the right margin on left facing pages, and to the 
left margin on right facing pages, to allow space for the binding. 

~ Change the settings for Headers & Footers, Page Size & Layout, 
Chapter Typography, Auto-Numbering, and Footnote Settings 
options. These five options are stored with the style sheet. 

~ Set the page's vertical rules. Click on the Vertical Rules option 
button, and enter information for both the left and right page. 

~ Modify existing tags. Use the Paragraph tool to select the sample text. 
Either select a tag that you wish to modify from the Tags list, or select 
the Add New Tag option button to create a new tag. Use the 
Paragraph tool options to change the attributes of the tags in the 
existing style sheet. You may want a different typeface or size, or 
perhaps different spacing between lines. For each tag, it is good 
practice to examine each of the Paragraph tool options starting with 
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the Font option and working across the option buttons to the Define 
Colors option. Any changes that you make are immediately reflected 
in the tagged paragraph. If you don't like what you see, change it. Pay 
special attention to Body Text, since the format for this tag provides 
the foundation for the overall design. 

~ Hint: use Ctrl + X to immediately retrieve the last option. 

~ Create new tags. To create a new tag name, click on the Paragraph 
tool button and tag a paragraph with a tag similar in design to the 
one you want to create. Then click on the Add New Tag option 
button. Enter a name for the new tag and click the OK button. The 
new tag name is then added to the Tags list, and the new tag is 
assigned to the selected text automatically. Once you have created a 
new tag, modify it by following the directions given in the previous 
instructions. 

~ Save the style sheet. Click on the Save Style As function button. 
Enter a new name if you want to create a new style sheet. Otherwise, 
select an existing name from the directory list, and then click on the 
OK button. 

~ Delete unwanted tag names. Click on the Update Tags List option 
button and use the Remove Tag option to remove any tags you do 
not need. The Body Text tag cannot be removed. Save the style sheet 
again to save any changes made in the Update Tags List dialog box. 

~ Click on the Print Style sheet option button in the Update Tags List 
dialog box to produce a printed copy of all the settings in the style 
sheet. The Print Style Sheet option actually produces a file that you 
can load into Ventura Publisher and then print. 

Examine the printed copy to make sure that the settings for each tag are 
correct. Pay particular attention to the font, spacing, and the breaks 
settings. If you want Body Text in adjacent columns to align, you must 
make the total spacing above and below each paragraph equal to a 
multiple of Body Text spacing (refer to the Spacing section in the 
Paragraph menu chapter for further details). 

You should save any style sheets to which you have made modifications 
under a different name. This assures that you don't inadvertently 
change the format of other documents. 

Menu options The following are stored with the style sheet: 
stored with style 

sheet • All paragraph tag settings 
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• Margin and column settings for the page. (Margin and column set-
tings for each individual frame are stored with the chapter.) 

• Page layout settings 

• Chapter typography settings (except Widows & Orphans) 

• Auto-numbering settings 

• The printer width table name 

Tag Names Most good designs use very few different tags. Although Ventura Pub­
lisher allows you to define up to 128 different tags, most design experts 
agree that you should use only one or two typefaces per chapter, and 
should only use three or four combinations of sizes (e.g., 10 point, 14 
point) and weights (e.g., bold, italic). Therefore, most style sheets should 
consist of only a few tag names. 

Pick tag names that are short, so that the user can enter them easily 
into the original word processor. (Refer to Appendix D for a description 
on how to enter tag names directly in your favorite word processor.) 

Choose tag names that make it easy for the user to see the hierarchy 
between related tags when looking at the Tags list. For instance, the 
names Heading and Sub Heading definitely reflect a hierarchy, even 
though the two names will appear in different parts of the alphabetized 
Tags list. A better choice is Head 1 and Head 2, or even Hi and H2. 

Choose identical tag names as you design different style sheets. This 
approach allows you to instantly reformat old text with new style sheets, 
and also reduces training as you design new style sheets. 

Unexpected new Text which you load using the Load TextlPicture option may contain 
tags in style tag names which do not match the tag names in the current style sheet. 

sheet Ventura Publisher adds these names, in capital letters, to the style 
sheet. They are assigned Body Text attributes. 

So that you may differentiate these added tag names easily from the 
tags you have already created, you should always enter tag names in 
lower case, or with initial capitals. You can then see whether the style 
sheet in use matches the tags already in the text. If you see a tag name 
in all capital letters, indicating that a mismatch has occurred, either 
select the correct style sheet, or modify the upper case tag attributes, as 
appropriate. If you do modify the uppercase tags, click on the Paragraph 
tool Update Tag List option button and use the Rename Tag option 
to rename the tag name using lower case or initial capitals. 
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Generated tags When you create a header, footer, caption, automatic section number, 
table of contents, or index, a tag is automatically created with the name 
Z_HEADER, Z_FOOTER, Z_CAPTION, etc. The initial tag attributes 
for these generated tags are taken from the current definition of Body 
Text. However, you can modify these generated tags like any other tag. 
For instance, to put a ruling line under each header, first click on the 
Paragraph tool button, then select the header and, finally, click on the 
Ruling Line Below option button to add the ruling line. 

Generated tags are always preceded by the capital letter Z. These tags 
are usually not shown in the Tags list because they are not generally 
assigned to any non-generated paragraph. However, by selecting the 
Preferences option in the Edit menu and setting the Generated Tags 
option to Shown, you can have all generated tags displayed in the Tags 
list. 

The following table lists the generated tags that Ventura Publisher will 
produce. 

Z_HEADER Header text 

Z_FOOTER Footer text 

Z_CAPTION 
Caption text (entered directly in the 

caption frame) 

Z_SEC1 thru Z_SEC10 Auto-number section numbers 

Z_LABELFIG Anchors and Captions dialog box 
figure number insert 

Z_LABELTBL 
Anchors and Captions dialog box 

table number insert 

Z_LABELCAP 
Anchors and Captions dialog box 
text (no inserts or chapter insert) 

Z_TOCTITLE Table of contents title text 
Z_TOC LVL 1 thru Z_TOC LVL 10 Table of contents text 

Z_INDEXLTR Index letter heads 
Z_INDEX MAIN Index body text 
Z_INDEX TITLE Index title text 

Z_FNOT# Footnote numbers 
Z_FNOT ENTRY Footnote text 

Z_BOXTEXT Box text 

Total number of The number of tags in the current style sheet, plus the number of 
, tags non-matching tags in all current text files, plus the number of generated 

tags, cannot exceed 128. 
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How to create documents 

Books 

Although every document is unique, most fall into one of three broad 
classifications. Each class of document is best created using a specific 
approach. The three classes of documents are: 

• Books 
Books contain only one text file, which continues from one page to the 
next. The typographic style and columnar structure remains essen­
tially the same from page to page, although each page may contain 
unique illustrations, tables, and figures. Books, technical manuals, 
proposals, databases, catalogs, overhead transparencies, and office 
correspondence are typical examples of these documents. 

• Newsletters 
These documents contain many text files, each representing a dif­
ferent article or story. The text in these documents does not usually 
flow consecutively from one column to the next, but instead skips 
columns ~r pages (e.g., the text on page one of a newspaper continues 
on the back page). Typography, however, is similar on every page in 
that the same fonts and text spacing are maintained. Examples 
include newsletters, newspapers, magazines, and some types of 
brochures. 

• Forms 
These documents have no structure or typographic consistency from 
page to page. Forms, price lists, and some types of brochures are 
typical examples of this type of document. 

The best way to design each class of.document is to use an approach 
which fits its unique characteristics. These approaches are described in 
the remainder of this section. 

You can create virtually any size book or technical manual using the 
steps outlined in this section. 

> Load a style sheet which is similar to the format you are trying to 
produce. Ifno similar style sheet is available, load the DEFAULT. STY 
style sheet from the TYPESET directory. 
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~ Immediately save the style sheet using the Save Style As function 
button. Pick a new name for the style sheet. This avoids making any 
unplanned changes to other documents which use the original style 
sheet you loaded. 

~ Click on the Load TextlPicture function button and load the text 
and picture files you plan to use in your document. 

~ Click on the Selector tool button. 

~ Click on the Page Size & Layout function button and set the desired 
orientation and paper size. 

~ Change the Chapter Typography settings, ifnecessary (refer to the 
Chapter menu chapter). 

~ Select the page, then modify Margins & Columns, Ruling Lines, 
and Frame Background for the page (Frame menu). These chan­
ges will affect every page in the document. 

~ Save the chapter using the Save function button. The chapter is 
given the same name as the text file you placed on the page, but with 
the extension changed to CHP. (Click on the Save As function button 
if you want to save the chapter under a different name.) 

The steps up to this point are the same for each of the three document 
types (e.g., book, newsletter, and form). The remaining instructions 
apply to book documents only. 

~ Select the page, then select the main text file (the one which should 
flow automatically from page to page) from the files list. This action 
will place that text file on the first page and, if necessary, automat­
ically create as many pages as necessary to fit the entire file in the 
document. 

~ Click on the Paragraph tool button. Modify the style sheet attributes 
to achieve the typographic effects you desire for each paragraph type. 
For instance, select a paragraph that you want to use as a headline, 
create a new tag using the Add New Tag option button (Figure 
3-24), and then modify the paragraph attributes for this new tag. You 
can now use this tag to format other paragraphs in the chapter. 
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Figure 3-24. Add new tag to create new paragraph attributes. The new tag is 
automatically assigned to the selected paragraph. 

I iMbAM , 
The Ad .,.nture Begins 
This trip reolly begon in September last year when 

Gerry won firs t prize in aroffle at the fashion show which 
Rush-Presbyterion-St. Luke's Medical Center holds 
every ye"', The prize was two round trip tickets to Hong 
Kong on United Airlines, lind ten nights in the Hong 
Kong Hylllt Hotel. Analyzing OUI good fortune, we con­
ci uded that we wanted to do more thon spend ten days in 

Chicag<> to Tokyo 
11.03 p, M. Chic,.;o time, 39,000 fee t some where aver 

the Western P",ific, we ore 8 hoors and 42 minutes out 
of los Angeles wi th about 2 more hoUI to g<l to Tokyo. 
We were about an hoor ond ten minutes late oot of Los 
Angel.." 

Travel Log 
S 

.. 

Figure 3-25. Use the Paragraph tool options to change the attributes of the new 
tag. 

~ Tag each paragraph that you want to be typographically different 
from Body Text. To tag a paragraph (and change its format), first 
select the paragraph, then select one of the tags from the Tags list. 

~ Use the Add Frame tool to draw frames where you want to place 
pictures or additional text. Once the frame is drawn, place pictures 
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or text into the frame by selecting the frame and then selecting the 
file name from the Files list (Figure 3-26). 
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Figure 3-26. Add new frame to position pictures or additional text where you 
want them. Select from the Files list the name of the file you wish to place in the 
frame. 

> Mter you have placed a file in a frame, select that frame, then look at 
each of the Frame tool options. Modify, as necessary, the settings for 
Margins & Columns, Sizing & Scaling, etc. for each frame. 

> If you want to annotate the information in a frame, select anyone of 
the graphic tools. Select the frame and then draw arrows, circles, box 
text, etc. to enhance the text or picture in the frame. 

> Use the Text tool and the Text tool options to edit text on the page, 
text in frames, and text in box text. 

> Use other options, such as Headers & Footers, Footnotes, Auto­
numbering, and Update Counters to generate additional text for 
the chapter automatically. 

When you are finished, save and then print the chapter. When all 
chapters have been created and saved, create a publication (a collection 
of all your chapters) using the Manage Publication option in the File 
menu. Use the Renumber option of the Multi-Chapter Operations 
dialog box to update cross references, number all pages correctly (if you 
number chapters with consecutive page numbers), create a table of 
contents, and produce an index. 
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Finally, use the Copy All option of the Multi-Chapter Operations dialog 
box to archive the publication to floppy disks or to another directory on 
your hard disk. 

Newsletters 

This section describes how to create newsletter chapters. A newsletter 
chapter contains multiple articles, each saved in a different text file. 
These articles can start on any page and can continue on any later page. 
Each portion of each article can be placed in a frame anywhere in the 
chapter. Each frame can have its own set of margin, column, and vertical 
rule settings. 

Newsletter Newsletters, newspapers, and magazines combine a variety of different 
Layout typographic styles, column widths, and margins. You can generate this 

type of complex layout by placing text into frames, rather than directly 
onto the page. For those familiar with the traditional publishing 
process, this strategy very closely mimics the process of pasting up 
galleys on a page: once you draw a frame and place text into it, the frame 
becomes a galley that can be "pasted" anywhere on the page. 

To compose a newsletter layout: 

>- Follow the first eight steps for the book strategy starting on page 
3-65. 

>- Click on the Frame tool Margins & Columns option button. 
Generate multiple columns to provide column guides to which frames 
can be snapped (Figure 3-27). Enable the Show Column Guides 
option in the View menu to show these guides on the screen. In the 
book approach, the column settings are used to format the text on the 
page. In this approach, the column settings provide a grid to align the 
separate frames which you will manually draw. You will then place 
the respective text files into these frames. 
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figure 3-27. First stfllJ in newspaper layout: Create underlying grid using the 
Margins & Columns dialog box options. 

~ Use the Add Frame tool to create frames wherever you want text to 
appear (Figure 3-28). 

frame and ----~I---

make it two 
columns. 
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Figure 3-28. Second step in newspaper layout: Create frames to hold various 
text files. Set margins ana columns for individual frames. 

~ Place text or pictures into each frame that you drew in the last step 
(Figure 3-29). To place text in a frame, select a frame, then select a 
file name from the Files list. 
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To place text into this 
frame, select the frame 
and then select the file 
you want to put into it. 

To continue the same 
file into this frame, 
select this frame next 
and then select the 
same file name from 
the Files list. 
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Figure 3-29. Place additional frames on page. Place text and J2ictures files in 
each frame. NEWSLOGO.TXT was placed in top frame, and NEWSLET.TXT 
was placed in second frame. 

> Increase or decrease the size of the frame to change the amount of 
text it contains. Move the frame around on the page to the location 
you want. 

> Use the InsertlRemove Page option in the Chapter menu to insert 
a new page. Continue drawing frames and placing text and pictures 
into these frames as needed to complete your layout. 

> To continue text into a new frame from a previous frame, first select 
the new frame, then select the text file name in the Files list. The text 
continues from the previous frame. This process can cOiltinue with as 
many frames as you wish, on different pages, until all text from the 
file is placed in the chapter. Each new frame can be placed on the 
current or any succeeding page. Text cannot be made to flow to a 
previous page. 

> Change frame attributes as needed using the Frame tool options. You 
can change the number of columns, margins, ruling lines, and frame 
background for each frame to create special effects. 

> Once you have placed text in a frame, you can tag it in exactly the 
same manner as text placed in the page. Tagging text changes text 
attributes, and changes the placement of text within the frame (e.g., 
right justified, centered). All tag spacing is measured from the edge 
of the frame, not from the edge of the page. Use the Paragraph tool 
Breaks option and set the Page Break settings to force text into the 
next frame. 
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If you want to annotate the information in a frame, select the frame, 
select one of the graphic tools, and then draw arrows, circles, box text, 
etc. to enhance the text or picture in the frame. Use the Text tool and 
Text tool option buttons to edit text in frames and text in box text. 

When placing text from the same file into different frames on the same 
page, you must always place the first part of the text into the frame that 
you placed on the page first, and the last part of the text into the frame 
that you placed on the page last. 

If you cut a frame and then immediately paste it back on the page, this 
frame becomes the last frame on the page. Use this technique to reorder 
text flowing within frames on the same page. 

Also note that if one text frame partially overlaps another text frame, 
the last frame created is displayed on top of the first frame created. The 
text in the bottom frame flows around the frame on top. 

Since the newsletter approach places text in frames rather than directly 
on the page, new pages are not created automatically. Therefore, use the 
InsertfRemove Page option in the Chapter menu to add new blank 
pages, as needed. Then continue placing new frames and adding text. 

Has all text Ventura Publisher doesn't require that all text from a given file be 
been put into placed in the chapter. This is a useful feature because newsletter layouts 
the chapter? often require that the end of a story be truncated in order to fit. Even 

when you truncate a story in this way, Ventura Publisher still saves the 
entire original article when you save the chapter. 

3-72 

However, most of the time you will want to make sure that all the text 
from an article has actually been placed into the document. To find out 
whether the entire contents of a file have been placed in the chapter: 

~ Enable the Show Tabs & Returns option in the View menu. 

~ Click on the Selector tool button. 

~ Select a frame which contains the text from the file you want to check. 

~ Click on the Go to Page function button. Select the File option from 
the Relative to list box. Select the Last option from the Which Page 
list box. Click on the OK button. This will take you to the last page in 
the chapter which contains text from this file. 

~ Select the frame on this page which contains text from this file. If the 
end of file marker is displayed in this frame, the entire file has been 
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placed in the chapter. Otherwise, you must draw another frame and 
continue text from the file into that frame by selecting the new frame 
and selecting the text file name from the Files list. 

>- Repeat the last two steps until the end of file marker for the text file 
is displayed in a frame 

Creating Different issues of a newsletter or newspaper often use the same layout. 
templates Rather than spend the time to place frames in the same place on the 

same pages for each new issue, you can create a template from an 
existing chapter, which you can then use to create subsequent chapters 
quickly. To create a template: 

>- Open an existing chapter. 

>- Use the Frame tool Remove Text/File option button to remove each 
file in the Files list from your chapter. For instance, use the Frame 
tool to select the first frame on the first page, and then click on 
Remove Text/File option button. 

>- Select the List of Files option from the Remove from list box, then 
click on the OK button. 

The file is removed from each frame in the chapter, but the frames, and 
all the frame settings, remain. After you have removed all files in this 
way, click on the Save As function button to save the chapter under a 
new name. For the next issue, all you need to do is retrieve this blank 
chapter, load the appropriate text and picture files, place these files in 
the frames that are already in the chapter, save the chapter under a new 
name, and then print. 

An even faster approach is to use the Windows File Manager command 
to copy the new text for the next issue to the same file names which you 
loaded into the chapter for the previous issue. Then, when you open the 
chapter, the text flows from frame to frame and page to page exactly as 
it did for the previous issue. 

Make sure you archive the text files from the last issue before you copy 
over them with the new text. Use the Manage Publication option in 
the File menu to copy entire chapters and publications to floppy disk or 
another drive and/or directory. 
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Ventura Publisher is extremely well suited to producing structured 
documents such as technical manuals and books. However, you can also 
use it to produce unstructured documents such as forms, price lists, and 
brochures just as easily. In this example we will create a simple invoice 
form using the Table tool. You will want to use the following techniques 
when creating these free-form documents: 

~ Click on the New function button to start a new chapter. Load the 
DEFAULT.STY style sheet from the TYPESET directory when the 
Open File dialog box is displayed. 

~ Using the Save Style As and Save As function buttons, save both 
the style sheet and chapter under a new name (e.g., FORM). This 
avoids making any unplanned changes to other documents which use 
the original style sheet you loaded. 

~ If desired, you can place a frame, or frames at the top of the page for 
entering your company name and logo. 

~ Click on the Table tool button. Place the cursor anywhere on the page 
and click the mouse. 

~ Click on the Insert New Table option button. 

When creating forms using the Table tool, use the following 
guidelines for determining the number of columns and rows to enter. 

- For columns, enter the maximum number of columns used by 
anyone row in the table 

- For rows, enter more than the actual desired rows. Extra rows 
can be deleted if required. 

These guidelines help forego the necessity of having to add rows or 
columns later after other rows and columns have been sized, joined, 
etc. The best approach is to first create a "thumb nail" sketch of the 
form. This will aid you in determining the maximum number of 
columns and rows to be entered into your form. 

~ Enter the maximum number of rows and columns the form is to have 
in the Rows and Columns entry fields. Click on the OK button. 

Now that the rows and columns of your form have been created, you can 
go about formatting the individual cells as required. Depending on how 
many rows you set for your form, your table may flow to the next page 
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Adjusting 
column width 

at this point. This will be adjusted as you change the Table Text tag 
spacing options. To format your table, use the following procedures. 

The first adjustment you will want to make is to the area of the form 
that uses the maximum number of columns. All adjustments to column 
widths should be done starting from the left-most column and working 
to the right. An easy way to perform these adjustments is to determine 
the desired width of each column ahead of time using your thumb nail 
sketch of the form. These measurements can be set by using the Table 
tool Set Column Width option as follows: 

As with any work you do in a document, it is advised that you save your 
work often while working with tables. If major formatting problems 
occur while working with the table, you can then revert to the last saved 
version. 

~ With the Table tool still selected, place the cursor anywhere in the 
table and click the mouse button. 

~ Click on the Set Column Width option button. The Set Table 
Column Width dialog box (Figure 3-30) is displayed. 

Figure 3-30. Table Column Widths dialog box. Note that the Width Setting 
option is set to Fixed for entry of predetermined column widths. 

~ Set the Column Number option to 1, set the Width Setting option 
to Fixed, and enter the desired column width measurement for the 
first column in the Fixed Width entry field. Repeat this step for each 
column in the table. 

Remember that these settings are for the part of your form that uses 
the maximum number of columns. Other rows using less than the 
maximum number of columns will be formatted later. 

~ After all the column width measurements have been entered, click on 
the OK button. Figure 3-31 shows an example of how your form may 
look if it were printed at this point. 
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Widget Technology A""""",,fT_,-. 
11523 Widger Tech Road Bug/uss/e, OK. 17394 

Figure 3-31. Initial column formatting of the sample invoice form. 

Formatting N ow that the column widths have been set, you can format each row of 
individual rows the form. You may want some rows to contain only one or two large cells 

(e.g., the rows for customer name and address), while others will contain 
the maximum number of cells (e.g., the rows containing the item num­
ber, quantity, description, cost, extended amount, etc.). This is where 
using a thumbnail sketch before creating the form comes in handy. If 
additional columns are required however, these columns can easily be 
inserted. If a row contains more cells than desired, you can join the cells 
using the Table tool. Use the following procedures to format individual 
rows of your form. 
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~ To join a set of cells in a row, select the cells you wish to join using the 
Table tool. 

Selected cells can span a number of columns, rows, and even the entire 
table. You cannot, however, select two noncontiguous sets of cells at a 
time. 

~ Click on the Join Cells option button. 
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If you make a mistake and join too many cells together, or simply 
wish to make further adjustments to the joined cells, you can split 
the joined cells by selecting the joined cell, and selecting the Split 
Cell option button. 

~ Format each of the rows of your form using the previous steps. Figure 
3-32 shows an example of how your form may look if it were printed 
at this point. 

Widget Technology '''"OM 01 '_"",a 
11523 Widger Tech Road Bugrussle, OK. 17394 

Figure 3-32. Invoice form after individual row formatting. Note the two large 
cells at the bottom of the form. Each of these cells was joined from two rows, with 
two cells in each row. 

You can add tinting to any joined cell or group of cells by selecting the 
cells and then clicking on the Set Tint option button. Refer to the Table 
menu chapter for more information on using the Set Tint option. 

Entering text N ow that the form has been formatted, you can enter the cell text. Each 
into cells cell can contain only one paragraph of text; however, as text is added, 

the text will wrap in the cell just as it does in any other paragraph. You 
can also use a line break (Ctrl + Enter) to create multiple lines of text 
in a single cell. When adding multiple lines of text in a single cell, all 
cells in the row will grow vertically as the cell containing the largest 
amount of text grows to accommodate that text. 
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When the table was created, a tag called Table Text was also created. 
The spacing settings of this tag, and any other tags added to the table, 
determines the vertical spacing of the cells. Text can be entered and 
formatted into each cell of the form just as any other text in a document. 
For the sample invoice form, the text we place in the cells will be 
formatted such that the text appears in the upper left corner of the cell 
with adequate space for writing below. Other text will be formatted such 
that is centered in the cell to act as a column title. 

~ Enter the desired text into each of the cells. 

~ Using the Paragraph tool options, create new tags for different text 
formats and format the text as desired. For example, most text in the 
above figure (e.g., P.O. Number, Check Number) was formatted using 
the Table Text tag with the following settings. 

Option Setting 
Font size 8 points 

Spacing Above 0 
Spacing Below 14 points 

Inter-Line Spacing 7 points 

~ The text used as column heads (e.g., Qty., Description) was created 
using a new tag and formatted with the following settings. 

Option Setting 
Font size/style 10 point Bold-Italic 

Horizontal alignment Center 
Spacing above 5 points 
Spacing below 5 points 

Inter-Line spacing 10 

Figure 3-33 shows the finished sample invoice form. 
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Widget Technology ADivisionofTechnographics 

11523 Widget Tech Road Bugtussle, OK. 17394 

Customer Name P.O. Number Date 

Street Address 

City State 

Telephone Zip Code 

Terms Sold By Payment Method 

Oty. Description Unit Price Extended Amount 

Notes: 
SubTotal 

Tax 

Received By: 
Shipping 

Total 

All claims for shortage. damage or shipping error must be made within 10 days after receipt of shipment. All merchandise 
returned must be in original packaging with all accompanying accessories and documentation present. We reserve the right 
to refund or replace parts. No return will be accepted without first obtaining an RMA number. Original sales receipt must 
accompany all returned merchandise. By signing this invoice. you aknowledge agreement to these terms and conditions 

Figure 3-33. Finished sample invoice form. 
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OPTIONS INDEX 

The following chapters describe the options you control through the 
menus at the top of the screen and the option buttons in the button bar. 
These options are presented in the order in which they appear in the 
menu bar, from left to right. This index provides an alphabetical refer­
ence to these menus. 

Most of the options available in the menus have corresponding buttons. 
However, not all of these buttons are included in the default set of 
buttons on the button bar, but can be installed using the button bar 
configuration utility. Refer to the Installation and Configuration Guide 
for instruction on configuring the button bar. 

In the following chapters, when a procedure or description tells you to 
"Click on" a button, this indicates that a button is available for the 
option, and it is one of the default set of buttons. If the procedure or 
description tells you to "Select" the option from the menu, this indicates 
that either no button is available for that option, or the button is not part 
of the default set of buttons. 

Menu conventions 

When a menu option or tool button is displayed in gray, or a button is 
not displayed, you cannot select it because you have not selected the 
proper tool or have not performed the procedure necessary to activate 
the option. Note also that some menu options are followed by an ellipsis 
C .. ) while others are not. Options which appear in a menu without an 
ellipsis are executed as soon as you select them. When you select an 
option from the menu that is followed by an ellipses, however, you must 
specify further information. Your choices will appear on the screen 
wi thin a dialog box. 

4-1 



UP IIUN~ INDEX 

/IiI Add new tag (frame) .......... 9-43 

Add new tag (paragraph) ..... 10-64 

AJignment .................. 10-5 

Anchors & captions ........... 9-14 

Attribute overrides .......... 10-27 

Auto-numbering ............ 10-41 

lID Box character ................ 11-3 

Breaks .................... 10-18 

IWU Bring graphic to front ......... 12-5 

Button bar .................. 7-13 

Changetextto .............. 11-48 

CHAPTER MENU ............ 8-1 

Chapter typography ........... 8-5 

Column snap ................ 7-11 m Copy ........................ 6-5 

Cross reference ............. 11-34 

Cut ......................... 6-5 
,~ [51 ....... 
-- Define colors ............... 10-49 

EDIT MENU ................. 6-1 

Edit special item ............ 11-43 

Edit table settings ........... 11-41 

Equation ................... 11-10 

Equation editor - Center col ... 11-10 

III Equation editor - Center pile .. 11-10 

Equation editor - Exit ........ 11-10 

Equation editor - Fraction .... 11-10 

Equation editor - Integral ..... 11-10 

Equation editor - Matrix ...... 11-10 

Equation editor - Over ....... 11-10 

I [m'l Equation editor - Square root .. 11-10 
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(g Equation editor - Sub/sup .... 11-10 

Equation editor - Summation . 11-10 

Exit ....................... 5-72 

FILE MENU ................ 5-1 

l£.ml File type/rename . . . . . . . . . . . . . 9-36 

Fill attributes (graphics) ...... 12-8 

Font settings . . . . . . . . . . . . . . . . 10-3 

Footnote ................... 11-4 

Footnote settings ............ 8-26 

Frame anchor . . . . . . . . . . . . . . 11-31 

Frame background ........... 9-31 

GRAPHIC MENU ........... 12-1 

Grid settings . . . . . . . . . . . . . .. 12-11 

Headers & footers ............ 8-19 

Image settings .............. 9-38 

Index entry ................. 11-5 

Insert column (table) ......... 13-2 

Insert/edit table ............ 13-10 

Insert table (Text tool) ....... 11-41 

Insert page/remove page ...... 8-30 

Insert row (table) ............ 13-2 

Insert special item ........... 11-2 

Join table cells .............. 13-3 

Line attributes .............. 12-6 

Load text/picture ............ 5-11 
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ImJ Manage width table .......... 5-22 

[II Margins & columns ........... 9-2 

Marker name .............. 11-35 

LQ] New ........................ 5-2 

Object properties ............ 6-52 

[ill Open chapter ................ 5-4 

~I Page size & layout ............ 8-2 

PARAGRAPH MENU ....... 10-1 
Ii Paste ....................... 6-5 

Paste link .................. 6-15 

Paste special . . . . . . . . . . . . . . . . 6-17 

Paragraph typography ....... 10-29 

Print ...................... 5-54 

Printer setup ................ 5-52 

Re-anchor frames ............ 6-22 

II Remove text/file ............. 9-33 

Renumberchapter ........... 6-24 

III Repeating frame ............ 9-21 

Revert to saved .............. 5-10 

Ruling box around frame ...... 9-28 

Ruling box around paragraph. 10-36 

Ruling line above frame . . . . . . . 9-28 

Ruling line above paragraph .. 10-36 

[lQJ Ruling line below frame ....... 9-28 

Ruling line below paragraph .. 10-36 

Save ........................ 5-7 

Save as ..................... 5-8 

Save style as ................ 5-20 

Search and replace ........... 6-37 
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Select all ................... 12-10 

Selected text - bold .......... 11-44 

Selected text - initial cap ...... 11-48 

Selected text - italic .......... 11-44 

Selected text - lower case ..... 11-48 

Selected text - normal ........ 11-44 

Selected text - overscore ...... 11-44 

Selected text - small capitals .. 11-48 

Selected text - strike-thru ..... 11-44 

Selected text - superscript ..... 11-44 

Selected text - subscript ...... 11-44 

Selected text - underline ...... 11-44 

Selected text - uppercase ...... 11-48 

Send graphic to back .......... 12-4 

Set preferences .............. 6-25 

Set ruler ..................... 7-5 

Set screening ................ 8-34 
room 
I!!I Set table cell tint ............. 13-4 

Set table cells to default line .... 13-8 

Set table cells to double line .... 13-8 

Set table cells to hidden line .... 13-8 

Set table cells to single line ..... 13-8 

Set table cells to thick line ..... 13-8 

Set table column width ........ 13-6 

Show column guides ........... 7-8 

II~I Show on all/this page(s) ....... 12-2 

Show loose lines .............. 7-10 

Show header/footer ........... 8-25 
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Showlhide pictures ............ 7-4 TEXT MENU ............... 11-1 

Show rulers .................. 7-5 Tool windows ................ 7-13 

Show tabs & returns ........... 7-9 UndolRedo ................... 6-2 

Sizing & scaling ............... 9-6 Update counters ............. 6-19 

'11 Spacing .................... 10-10 Update tag list (frame) ........ 9-45 

Special effects .............. 10-25 Update tag list (paragraph) ... 10-66 

Spell check .................. 6-29 Variable definition .......... 11-39 

Split table cells .............. 13-3 ttl Vertical rules ................ 9-25 
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Description 

FILE MENU 

mil 
New 
.Qpen Chapter ... 

,S,ave Ctrl+S 
Save As ... 
Revert to Saved ... 

Load Text/Picture ... 
Loa!! Ditt. Style ... 
Sa~e Style As ... 

Manage Width Table ... 
Manage Pulllication ... 

Print Setyp ... 
Erint ... Ctrl+H 

E~it 

Figure 5-1. File menu. 

The File menu controls the flow of information into and out of Ventura 
Publisher. The File menu provides seven basic functions: 

• You can open or save the entire chapter. 

• You can load individual text, line art, or image files into the chapter. 

• You can use a different style sheet than the one currently in use, or 
save a newly created style sheet. 

• You can print the chapter. 

• You can manage fonts using the Ventura Publisher width table. 

• You can manage chapters in your publication, including table of 
contents generation, index creation, renumbering, and copying. 

• You can finish using (Exit) Ventura Publisher. 
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New 

New 

Click on the New function button to remove the current chapter from 
memory and provide a new untitled chapter with your choice of style 
sheet. The last version saved is still available on disk. Use this option 
to start composing a new chapter. 

Operation 

5-2 

Click on the New function button. If any changes have been made to the 
chapter since it was last saved, the following alert is displayed. 

Click on the Save button to save the chapter file and all associated files 
(including the style sheet). Click on the Abandon button if you choose 
not to save the changes. 

If you have made any changes to the style sheet since the chapter or 
style sheet was last saved, a second alert is displayed. Since saving the 
chapter also saves the style sheet, this alert will appear only if changes 
have been made to the style sheet but not the chapter, or if you selected 
to Abandon the changes to the chapter in the previous alert. 

Click on the Save button to save the style sheet. Click on the Abandon 
button if you choose not to save the changes. If you click the Abandon 
button, any changes made to the style sheet settings remain in effect 
but are not saved to the style sheet file. If you want to use the original 
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style sheet settings, select the style sheet name from the Select Style 
Sheet dialog box when it is displayed. 

When you click on th~ New function button, the Select Style Sheet 
dialog box (Figure 5-2) is displayed allowing you to select a style sheet 
to associate with the new chapter. 

File H.ame: I OK lam 
&book-p1.sty 
&book-p2.sty 
&bro-12.sty 
&bro-p3. sty 
&inv-p 1. sty 
&Istg-p2.sty 
&ltr1-p 1. sty 
&ma - 3.st 

r-="'--:-~---.;..-----,...~~ I Cancel 

list FilesoflYpe: Oriyes: 

~IS=~~le_S_h~e~et=s~~~~lf~J ~I~ __ d: __ ~~~~~~ 

Figure 5-2. Select Style Sheet dialog box. 

If you wish to use the currently loaded style sheet with the new chapter, 
simply click on the Cancel button. Otherwise, use the Drives and 
Directories list boxes to locate the desired style sheet. When the name 
of the desired style sheet is displayed in the File Name list box, either 
select the style sheet name and click on the OK button, or double-click 
on the style sheet name. 
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Open Chapter 

Open Chapter 

Click on the Open Chapter function button to retrieve a previously 
saved chapter and its related style sheet, text, and picture files. 

Operation 
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Click on the Open Chapter function button. If another chapter is 
currently opened and any changes have been made to the chapter since 
it was last saved, the following alert is displayed. 

Click on the Save button to save the chapter file and all associated files 
(including the style sheet). Click on the Abandon button if you choose 
not to save the changes. 

If you have made any changes to the style sheet since the chapter or 
style sheet was last saved, a second alert is displayed. Since saving the 
chapter also saves the style sheet, this alert will appear only if changes 
have been made to the style sheet but not the chapter, or if you selected 
to Abandon the changes to the chapter in the previous alert. 

Click on the Save button to save the style sheet. Click on the Abandon 
button if you choose not to save the changes. If you click the Abandon 
button, any changes made to the style sheet settings remain in effect 
but are not saved to the style sheet file. 
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The Open File dialog box (Figure 5-3) is then displayed. Use the Drives 
and Directories list boxes to locate the desired chapter. When the 
name of the desired chapter is shown in the File Name list box, either 
select the chapter name and click on-the OK button, or double-click on 
the chapter name. 

&book-p1.chp 
&book-p2. chp 
&bro-12.chp 
&bro-p3. chp 
&inv-p 1. chp 
&lstg-p2. chp 
&ltr1-p1.chp 
&ma . 3.ch 

IDrectories: 
d:\tl'peset 

!C.7 d:\ 
e- typeset 

list Files ofIVlle: Driyei: 

I~C_ha~p_te_rs~~~~~I_!1 ~1~~d=:~~~~~~I~~1 

OK 

Cancel 

Figure 5-3. Open File dialog box for chapter (CHP) files. 

If the file name is not shown, you may have saved the chapter with an 
extension different than the CHP default used by Ventura Publisher, or 
the file may be saved in a different sub-directory than the one currently 
shown in the Open File dialog box. Either change the default extension 
in the File Name entry field, or change the sub-directory. 

As the chapter is loading, different messages appear on the screen. 
When text files are loading, the message Loading & Hyphenating 
Text File is displayed. Ventura Publisher places all possible hyphena­
tion points in the text in order to increase reformatting speed each time 
you add a frame or change a text attribute. For a large text file, this may 
take up to several minutes, depending on the speed of your computer 
and size of the chapter. 

Use the Open Chapter option to retrieve an entire chapter and all 
associated text, picture, and style sheet files. To add another text or 
picture file to an existing chapter, use the Load TextlPicture option 
instead. 

Network When using Ventura Publisher on a network server, only one user can 
operation open the same chapter for editing at anyone time. Once a chapter has 
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Open Chapter 

been opened for editing, no other user can open that chapter for editing 
until the first user is finished making changes and selects New, opens 
another chapter, or quits from Ventura Publisher. This prevents one 
user's changes from overwriting modifications made by another user. If 
a user tries to open a chapter already opened by another user, an error 
message is displayed. Other users can browse a chapter already opened 
by checking the Read Only check box in the Open File dialog box before 
opening the chapter. This allows multiple users to view a chapter while 
another user is editing it. 

If a file within a chapter is modified while the chapter is opened, 
Ventura Publisher detects that the time and date have been changed 
and displays the following alert when you next try to save the chapter 
(this alert is only provided if you have modified the same file). 

You can then either overwrite the other user's changes (not recom­
mended), or save the modified file under a new name using the File 
TypelRename option in the Frame menu. You must then use your 
word processor to merge the changes in the two files together. 

No user should delete any file contained in a chapter while that chapter 
is opened. Use the network services of your network to determine 
whether a chapter is already open. 
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Save 
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Click on the Save function button to store the chapter under the name 
shown in the title bar. The style sheet and each text file are saved if they 
have changed. 

Operation 

Click on the Save function button. The chapter file is saved under the 
file name shown in the title bar. IfUNTlTLED.CHP is displayed in the 
title bar, the chapter is given the same file name as the text file placed 
on the page, but with the extension CHP. 

The style sheet shown in the title bar, and all text files shown in the 
Files list, are also saved, if they have been changed. If you don't want to 
change the current style sheet, click on the Save Style As function but­
ton to save the style sheet under a new name prior to saving the chapter. 

Captions, graphics generated within Ventura Publisher, and chapter 
summary information are automatically saved in files which have the 
same name as the chapter, but which have the extensions CAP, VGR, 
and ClF respectively. The ClF file provides information to external 
document management programs (available from other companies). 
This information includes original creation date, date last saved, and 
date last archived. 

If selected in the Set Preferences option in the Edit menu, backup 
files (e.g., $HP) are automatically made for chapter, style sheet, and text 
files. 
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Save As 

Save As 

Click on the Save As function button to save the chapter under a new 
name. If the style sheet and any text file have the same name as that of 
the chapter, they will also be renamed. Otherwise, the style sheet and 
each text file will be saved-under their original names-if they have 
been changed. 

Operation 
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If you don't want to change the current style sheet, click on the Save 
Style As function button to save the style sheet under a new name prior 
to saving the chapter. 

> Click on the Save As function button, The Save File As dialog box 
(Figure 5-4) is displayed. 

Figure 5-4. Save File As dialog box for chapter (CRP) files. 

> Use the Drives and Directories list boxes to locate the directory in 
which you want the chapter file saved. When the name of the destina­
tion directory is shown in the Directories list box, enter a file name 
for the chapter in the File Name entry field and click on the OK 
button. 

If the extension is not specified, Ventura Publisher automatically adds 
CHP. 



~ave As FILE MENU 

If you specify an extension other than CHP for the chapter, do not use 
any numbers in the extension. 

If the file name you have selected is the same as that of a previously 
saved chapter file, the following alert is displayed. 

A Jile by that ... ameaiready 
exi$ts.Doyou wi$h to 
choose a new nameo( 
overwrite the exi$ting· file? 

H~!!=t.I!m!11 

Click on the New Name button to re-display the Save File As dialog box 
and select a different file name for the chapter. Click on the Overwrite 
button to save the chapter over the previously saved chapter file. 

All captions, graphics, and information for a chapter are automatically 
saved in files which have the same name as the chapter, but which have 
the extensions CAP, VGR, and CIF respectively. The CIF file provides 
information about a Ventura Publisher chapter to programs created by 
other companies as Ventura Publisher utilities. 

If selected in the Set Preferences option in the Edit menu, backup 
files (e.g., $HP) are automatically made for chapter, style sheet, and text 
files. 

If the text file placed on the page has the same name as the chapter file, 
and you save the chapter file under a new name, a text file with this new 
name is automatically created. 
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Revert to Saved 

5-10 

The Revert to Saved option replaces the chapter currently in memory 
with the last version saved. Use this option to recover from major 
mistakes. 

Operation 

Select the Revert to Saved option in the File menu. The following alert 
is displayed. 

Figure 5-5. Revert to Saved alert box. 

Click on the OK button to abandon all changes and automatically open 
the last version saved. All changes made since the last time the chapter 
was saved are lost. Click on the Cancel button to return to the opened 
chapter. 

If the chapter has been saved, but you want to clear the page and start 
with a new, untitled chapter, click on the New function button instead. 
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Load Text/Picture 

Click on the Load TextiPicture function button to place either text, 
line art, or image files in the Files list prior to placing them on the page 
or in a frame. Use this option to: 

• Build a list of all files in the chapter. 

• Combine text from several files into one file. 

Use the Load TextlPicture option to add another text or picture file to 
an existing chapter. To retrieve an entire chapter and all associated text, 
picture, and style sheet files, use the Open Chapter option instead. 

Operation 

> Click on the Load TextiPicture function button. The Load TextlPic­
ture dialog box (Figure 5-6) is displayed. 

Figure 5-6. Load Text / Picture dialog box. 

> Select the appropriate File Type option for the file you want to add 
(e.g., text, line art, or image). 

> Select the Format option corresponding to the format under which 
this file was saved, such as GEM, or Lotus 1-2-3. (Set the File Type 
option to Text and the Format option to Generated to load a table 
of contents, index file, or style sheet printout generated by Ventura 
Publisher.) 
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Load Text/Picture 

> If you want to load several files of the same type (e.g., four Lotus 1-2-3 
pictures) check the Several Files check box. 

> Click on the OK button when you are ready to select files. The Open 
File dialog box (Figure 5-7) is displayed. 

Figure 5-7. Open File dialog box. 

> Use the Drives and Directories list boxes to locate the desired text 
or picture file name. When the name of the desired text or picture file 
is shown in the File Name list box, either select the file name and 
click on the OK button, or double-click on the file name. 

Ventura Publisher will not properly load a file if the file name extension 
contains a number. If the file name extension of the file you wish to load 
contains a number, use the Windows File Manager to rename the file 
before loading it into Ventura Publisher. 

When loading text files, you will notice a delay-up to several minutes 
for very large files-as Ventura Publisher converts text and inserts 
hyphens. 

Don't load files directly from floppy disk. Ventura Publisher creates ad­
ditional files during the loading process, and the floppy disk may not 
contain sufficient space. Also, some types of image files will not load 
properly when loaded from a floppy disk. Additionally, your computer 
cannot load files as quickly from floppy disk. 

If you checked the Several Files check box, the Open File dialog box 
reappears after each file is selected. Each time the Open File dialog box 
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reappears you can select another file of the same type. Once all of the 
desired files have been loaded, click on the Cancel button to return to 
the Ventura Publisher main screen. 

Destination If you select the Text file type option, Ventura Publisher provides these 
Destination options: 

• List of Files 

• Clipboard 

• Cursor 

> Select the List of Files option to place the text file into the Files list. 
You can then place the contents of this file into a frame or page as 
described in the preceding paragraphs. 

> Select the Clipboard option to place a copy of the entire file on the 
clipboard. Any information currently on the clipboard will be erased. 
You can then use the Paste function button to paste a copy of this text 
anywhere in the chapter. The maximum file size that the Windows 
clipboard can accommodate is 64 kilobytes. If the text file is larger 
than 64 kilobytes, select the List of Files or the Cursor option 
instead. 

> Select the Cursor option to place a copy of the entire file at the 
current location of the text cursor. Note: you must place the text 
cursor where you want the text to appear prior to selecting the Load 
TextlPicture function button. 

Files brought into the chapter using the Clipboard or Cursor options 
are combined with the file into which they are placed. The original text 
file from which text was loaded will not be modified in any way. 

If you attempt to load more than 128 files in a single chapter, the 
following alert is displayed. 

Check the Files List for files that are not being used and remove them 
from the files list using the Remove TextlFile option button. Other-
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wise you will have to break your chapter into two chapters in order to 
load the rest of the files. 

Text changes made during load 

The following is a list of all changes that Ventura Publisher makes to 
text when a text file is loaded: 

• Multiple spaces are converted to a single space plus non-breaking 
spaces. 

• All possible hyphen points are temporarily inserted into the text. 
(They are not saved back into the text file.) 

• Information not used by Ventura Publisher, such as centering, in­
dents, and printing commands, is eliminated. 

• Two hyphens (- -) are converted to a single em dash (-), and inch 
marks (") are converted to open and closed quotes (" ") if you have 
selected the Auto-Adjustments option in the Set Preferences 
dialog box (Edit menu) prior to loading text. 

Importing PRN If the Destination option is set to List of Files, when the .PRN file is 
type files imported, a file with the same name, but a .TBL extension, is created. 

Any editing done to the imported table while in Ventura Publisher will 
be reflected in the .TBL file and not in the .PRN file. If the .PRN file is 
subsequently edited outside of Ventura Publisher and the chapter con­
taining the .PRN file is opened again, a new. TBL file will be created and 
any previous edits made to the table while in Ventura Publisher will be 
lost. 

If the Destination option is set to Cursor, the .PRN file is incorporated 
into the existing text file loaded in the chapter, and any editing done to 
the .PRN file outside of Ventura Publisher will not be reflected in the 
chapter. This is the recommended way of incorporating .PRN files. 

Additional information about exporting spreadsheet and database in­
formation in a format suitable for import into Ventura Publisher can be 
found in the Text From Other Programs chapter (Chapter D). 

Double carriage Most typists press Enter twice in a row to create blank lines between 
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returns paragraphs. However, when preparing a text file that will be used with 
Ventura Publisher, it is advisable to press Enter only once to signal the 
end of a paragraph. This is because Ventura Publisher treats each 
carriage return in the word processor file as a new paragraph and adds 
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above, below, and inter-paragraph spacing. As a result, text prepared 
with the double carriage return convention will appear to have too much 
space between paragraphs and unwanted spaces at the top of columns 
after it is loaded into Ventura Publisher. Also, many of the powerful 
formatting controls available with the Paragraph tool will not work 
correctly when a blank paragraph is inserted between each real para­
graph. 

To eliminate all double carriage returns entered in your word processor, 
type the following-from within your word processor-on the first line 
of the text file: 

/
~ ___ Enter a space after 

the equal sign. 

@PARAFILTR ON 

This command causes Ventura Publisher to remove all paragraphs 
which contain no text. Note, however, that when you save the chapter, 
the blank paragraphs are permanently eliminated. 

If you want to retain two carriage returns in some places, put a space in 
front of the second carriage return when working on the document from 
within your word processor. 

Double spaces Most typists type two spaces after a period or colon. This, however, is 
not considered correct when a page is typeset. Therefore, you should use 
the search and replace feature in your word processor to eliminate all 
double spaces after a period. 

Picture changes made during load 

Pictures stored in other than GEM format (e.g., a Lotus 1-2-3 .PIC or 
.CGM file), are automatically converted to Ventura Publisher's file 
format and saved in new files which have the same name as the original 
file, but with the extension GEM (line art) or IMG (image.) The original 
files remain unchanged. Your disk must have sufficient space available 
to hold both the original and the converted files. Otherwise an error 
message is produced and the load operation is halted. 

Graphics limitations 

Ventura Publisher converts several industry standard graphics formats 
into its own file format, as described above. These formats include: 
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• GEM 

• CGM 

• HPGL 

• Lotus 1-2-3 (PIC) 

• Macintosh PICT 

• Macintosh Paint 

• PC Paintbrush (PCX) 

• TIFF 

• Video Show 

• Windows metafile 

Because of the tremendous range of capabilities of programs which 
produce these file formats, graphics saved in these formats may not 
display and print from Ventura Publisher with absolute fidelity to the 
original. Refer to Appendix G for a list of the specific limitations of each 
graphic format. 

Don't use numbers in the file extensions for graphics files. Attempting 
to load a file having a number in the extension will result in an error 
message. 

Use PCX, PostScript, or TIFF formats to load files created by a scanner. 

PostScript files PostScript files must be in encapsulated PostScript format (EPSF), or 
an error message will result. If your graphics program produces Post­
Script files, check with the software manufacturer to make sure these 
are stored in encapsulated format. 

5-16 

Many PostScript files will not display on the screen. Instead the frame 
is filled with a large X, and the name of the file is displayed in the cur­
rent selection indicator. If the file does display, this means it contains a 
screen-resolution TIFF or Windows metafile image embedded within 
the PostScript file to let you see a representation of the PostScript file 
on you computer screen. 

You can only print PostScript files to PostScript printers. However, if 
the image displays on the screen (instead of a large X), you can print the 
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HPGL files 

FILE MENU 

page containing this file to a non-PostScript printer, and the TIFF or 
Windows metafile image embedded in the PostScript file will be printed. 

Encapsulated PostScript files, when imported into Ventura Publisher, 
do not produce an IMG or GEM format file. If the PostScript file contains 
a TIFF or Windows metafile image, the image part of the file will 
produce an IMG file. 

If you select the HPGL format option when loading line art, Ventura 
Publisher displays an additional dialog box which provides many cus­
tomization options. These options are designed to let you get the best 
possible fidelity when printing an image originally destined for a plotter 
to a laser printer or typesetter. Refer to page G--3 in Appendix G for a 
complete description of these options and how to use them. 

Color images Ventura Publisher will always display color and gray-scale images with 
the greatest possible accuracy. This rendering of color images may 
significantly increase the time it takes for a page to redraw on the 
screen, particularly when 24-bit images are involved. 

When working with a chapter containing color or gray-scale images, it 
is recommended that you hide these color images when you are not 
actually working with them. This will greatly reduce the time it takes 
to redraw a page containing images since Ventura Publisher is not 
required to ren~er the image on the screen. 

Ventura Publisher PostScript pages 

If you print a single page to a disk file as described on page 5-69, you 
can load that page back into a frame by selecting the Line-Art file type 
option and PostScript format option in the Load TextlPicture dialog 
box. Using this method, you can load a page into a frame and then 
expand or shrink it. These images will not display on the screen. 
Instead, an X will be displayed in the frame in which the file is loaded. 
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Load Ditt. Style 

Load Diff. Style 

Click on the Load Diff. Style function button to apply a different style 
sheet to the chapter currently on the screen. If the chapter is then saved, 
the reference to the old style sheet is replaced with a reference to the 
new style sheet. 

Operation 
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~ Click on the Load Diff. Style function button. If any changes have 
been made to the currently loaded style sheet since it was last saved, 
the following alert is displayed. 

Click on the Save button to save the style sheet. Click on the Abandon 
button if you choose not to save the changes. The Select Style Sheet 
dialog box (Figure 5-8) is then displayed. 

Figure 5-8. Select Style Sheet dialog box for style sheet (STY) files. 

~ Use the Drives and Directories list boxes to locate the desired style 
sheet. When the file name of the desired style sheet is shown in the 
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File Name list box, either select the style sheet name and click on 
the OK button, or double-click on the style sheet name. 

The Open Chapter option automatically loads the style sheet for the 
selected chapter. 

If you used a special set of fonts when you last used this style sheet, the 
width table for these fonts is automatically loaded when you load the 
style sheet. Refer to the Manage Width Table option section for more 
information on width tables. 
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Save Style As 

Save Style As 

Click on the Save Style As function button to create a new style sheet 
file or modify an existing style sheet. Use this option to save the 
currently loaded style sheet under a different name. 

Operation 
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> Click on the Save Style As function button. The Save File As dialog 
box (Figure 5-9) is displayed. 

Figure 5-9. Save File As dialog box for saving style sheet (STY) files. 

> Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the style sheet file to be saved. When the 
name of the destination directory is shown in the Directories list 
box, enter a file name for the style sheet in the File Name entry field 
and click on the OK button. If you want the style sheet to be saved 
over a previously saved style sheet file, select the file name of the 
previously saved style sheet file in the File Name list box and click 
on the OK button, or double-click on the style sheet file name. 

If the extension is not specified, Ventura Publisher automatically adds 
STY. 

Saving the chapter after modifying a style sheet, or saving a modified 
style sheet under its original name, changes the look of other chapters 
that use that same style sheet. Always save modifications to existing 
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style sheets under a new name unless you want those modifications to 
affect other chapters using the same style sheet. 

If the file name under which you are saving the style sheet is the same 
as that of a previously saved style sheet, the following alert is displayed. 

Click on the New Name button to re-display the Save File As dialog box 
and select a different file name for the style sheet. Click on the Over­
write button to save the style sheet over the previously saved style 
sheet file. 

If you have loaded a new width table in order to gain access to a different 
set of fonts, the reference to this width table will be stored with the style 
sheet. Refer to the Manage Width Table option section for more 
information on width tables. 

Style sheet Style sheets created in a previous version of Ventura Publisher and then 
compatibility saved in Ventura Publisher Windows edition 4.0 and above, as well as 

style sheets created in Ventura Publisher Windows edition 4.0 and 
above are not compatible with previous versions of Ventura Publisher. 
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Manage Width Table 
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A width table is a file in which font information for a particular printer 
is stored. The Manage Width Table option allows you to manage the 
fonts and width tables used in Ventura Publisher. 

Description 

One of the main purposes of the width table is to provide Ventura 
Publisher (and you) with information about fonts installed in Windows 
for any particular printer. The width table is responsible for ensuring 
that the correct fonts are displayed in the font list boxes of Ventura 
Publisher's dialog boxes. The width table is also responsible for ensur­
ing that the characters of the fonts are spaced properly, and will print 
with the same spacing and line endings as that which is displayed on 
the screen 

The width table does not tell Ventura Publisher anything about how the 
font should look on the screen except to the extent of how the characters 
should be spaced in relation to one another. The proper display of fonts 
on the screen is dependent on the capabilities installed in Windows for 
displaying fonts on the screen (e.g., Adobe Type Manager, TrueType 
fonts). 

Another purpose of the width table is to allow you to format a document 
for the printer or output device on which the document will ultimately 
be printed instead of the printer you have on your desk or attached to 
the network. This is important since different printers have slightly 
different ways of printing characters and the space between characters. 

For example, if you are creating a document that will ultimately be sent 
to a service bureau for imagesetting on a PostScript device, but you have 
an HP LaserJet attached to your computer, you can still create that 
document using a width table based on a PostScript device. Using this 
width table, you will still be able to proof the document on your HP 
printer, and be assured that the output will have the same line endings 
and page breaks when the document is output on the imagesetter. 
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Typically, you will only need one width table file. However, if you output 
your documents to a number of different printers you may be required 
to maintain different width table files for each type of output device. 

ENVIRON. WID width table file 

The first time Ventura Publisher is run, it generates a width table based 
on the font information for the default printer. This is required so that 
Ventura Publisher will know what fonts you have and will allow you to 
select them from the various dialog boxes containing font list boxes. This 
building of the width table can take a very short time if you have only a 
few fonts installed in Windows, or up to several minutes if you have a 
large number of fonts installed. The width table Ventura Publisher 
builds is named ENVIRON.WID 'and is always saved to the hard drive. 

When a style sheet is saved in Ventura Publisher, one item of informa­
tion that is saved with it is the name of the currently loaded width table. 
Each time that style sheet is loaded, the associated width table is also 
loaded. 

Whenever Ventura Publisher loads a style sheet containing a reference 
to the ENVIRON.WID width table, Ventura Publisher will rebuild the 
width table for the current default printer (again, this can take from a 
few seconds to several minutes). Additionally, when you run Ventura 
Publisher, the style sheet and width table last used are loaded. If this 
style sheet uses the ENVIRON.WID width table, load time will be 
increased as Ventura Publisher rebuilds the width table. 

Since the width table will not be rebuilt ifit is saved under a name other 
than ENVIRON.WID, assigning a renamed width table to all of your 
style sheet will decrease load time of both Ventura Publisher and 
chapters. 

The ENVIRON. WID width table is required for compatibility reasons 
and should not be used as a working width table file. It is important to 
note that the ENVIRON.WID width table file will continue to be loaded 
with a style sheet until you save a different width table with the style 
sheet. 

Whenever you create a style sheet, or save an existing style sheet under 
another name, it is important that you ensure that the ENVIRON.WID 
width table file is not associated with the style sheet. 
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Refer to the Creating a custom width table procedures starting on page 
5-29 for information on creating a custom width table and associating 
it with your style sheets. 

DOS/GEM version width table utilities 

Since the Windows version of Ventura Publisher will create width tables 
automatically from the fonts installed in Windows, the following 
DOS/GEM version width table utilities are not included with the Win­
dows version of Ventura Publisher. 

• WIDTOVFM.EXE 

• VFMTOWID.EXE 

• AFMTOVFM.EXE 

• HPLTOVFM.EXE 

Operation 

Since the width table is associated with a style sheet, ensure that the 
currently loaded style sheet is the one whose width table you want to 
edit. If necessary, use the Load Diff. Style option to load the correct 
style sheet. 

Additionally, since the purpose of the width table is to provide informa­
tion about the fonts associated with one of the printers you have 
installed in Windows, you should first use the Printer Setup option to 
ensure that the currently selected printer is the one with which you 
want the Manage Width Table option to work. Refer to the Printer 
Setup option section starting on page 5-52 for information of selecting 
a printer from within Ventura Publisher using the Printer Setup 
option. 

~ Once the correct style sheet and printer selection have been made, 
select the Manage Width Table option from the File menu. The 
Manage Width Table dialog box (Figure 5-10) is displayed. 
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Figure 5-10. Manage Width Table dialog box. 

The Manage Width Table dialog box provides you with options that 
allow you to generate, load, merge, edit, and save width tables 

Use This option generates a new width table based on the current default 
Environment's printer. The default printer can be changed by using the Printer Setup 

Width Table option. This option is used when you want to generate a new width table 
after installing a new printer or adding or deleting fonts in Windows. 

Load Different This option is used to load a previously saved width table. 
Width Table 

The width table loaded using this option does not have to be generated 
from the same printer to which you are printing your document for 
proofing. In fact, the width table used when creating a document should 
correspond to the output device on which the document will ultimately 
be output. 

> Click on the Load Different Width Table button. The Open File 
dialog box (Figure 5-11) is displayed. 
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Figure 5-11. Open File dialog box for width table (WID) files. 

~ Use the Drives and Directories list boxes to locate the desired 
width table. When the name of the desired width table is shown in 
the File Name list box, either select the width table name and click 
on the OK button, or double-click on the width table name. 

Add Fonts from This option is used to merge the fonts from another width table into the 
Width Table currently loaded width table. 

5-26 

~ Click on the Add Fonts from Width Table button. The Open File 
dialog box (Figure 5-11) is displayed. 

~ Use the Drives and Directories list boxes to locate the desired 
width table. When the name of the desired width table is shown in 
the File Name list box, either select the width table name and click 
on the OK button, or double-click on the width table name. 

The fonts from the selected width table will be merged with the 
currently loaded width table. 

Use the Save As New Width Table option to save the combined width 
table under a new or existing name. Refer to the follow section on the 
Save As New Width Table option for information on using this option. 

If the width table you are loading is for a different type of printer, the 
following alert will appear. 
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The cunent width table &: 
the merge width table are 
set for different devices: 

(ENVIRONMENT &: XEROX 40'(5) 
What should be done? 

1.[)9~~~iJI ·1·.··C~rt~el·· •. ' 

Click on the Cancel button to return to the Open File dialog box and 
select a different width table. Click on the Ignore button to allow the 
merge to take place. 

Merging width tables generated from different devices will cause unpre­
dictable results in formatting and printing your document. You should 
not use the Ignore button when this alert is displayed unless you are 
absolutely sure of the ramifications 

Save As New This option is used to save a modified width table, or the 
Width Table ENVIRON.WID width table under a new or existing name. 

~ Click on the Save As New Width Table button. The Save File As 
dialog box (Figure 5-12) is displayed. 

Figure 5-12. Save File As dialog box for saving width table (WID) files. 

> Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the width table file to be saved. When 
the name of the destination directory is shown in the Directories list 
box, enter a file name for the width table in the File Name entry field 
and click on the OK button. If you want the width table to be saved 
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over a previously saved width table file, select the name of the width 
table file in the File Name list box and click on the OK button, or 
double-click on the width table file name. 

If the extension is not specified, Ventura Publisher automatically adds 
WID. 

If the file name under which you are saving the width table is the same 
as that of a previously saved width table, the following alert is dis­
played. 

Click on the New Name button to re-display the Save File As dialog box 
and select a different file name for the width table. Click on the Over­
write button to save the width table over the previously saved width 
table file. 

Remove This option allows you to remove fonts from the width table. This is 
Selected Font particularly useful if you have a large number of fonts installed in 

Windows, but only want the fonts you use in a particular document 
listed in the Font list box of Ventura Publisher's dialog boxes. 
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To delete a font: 

> Select the desired typeface name from the Face list box. 

> If available, select one of the sizes from the Size list box. 

> Select a type style from the Styles list box. 

This option will remove all of the styles (one at a time) associated with 
a typeface before removing any of the type size options from the Size 
list box. Once all of the sizes for a particular typeface have been 
removed, the typeface name will be removed from the Face list box. 
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Creating a custom width table 

Creating a custom width table should only have to be done when you 
install a new printer, or add or remove fonts from Windows. Once you 
have created a custom width table, it can be saved with all of the style 
sheets you create. To create a custom width table: 

> Select the Printer Setup option from the File menu. Select the 
printer for which you are generating the width table and then click 
on the OK button. 

Selecting a new default printer from the Printer Setup dialog box and 
clicking on the OK button will cause an ENVIRON. WID width table 
to be generated in memory. Clicking on the Cancel button in the 
Printer Setup dialog box will not generate a width table. 

> Select the Manage Width Table option from the File menu. 

> If desired, use the Remove Selected Font button to delete fonts 
that you do not want saved with the width table. 

> Click on the Save As New Width Table button and save the width 
table with a file name other than ENVIRON. WID. The file name 
selected should reflect the printer for which the width table was 
generated (e.g., POSTSCRP.WID for a PostScript printer, 
HPLJIIP.WID for an HP LaserJet IIP). 

> Repeat the previous steps for each printer installed in Windows. 

Associating a Once the named width table is generated, it needs to be associated with 
width table with each of the style sheets that are to use the width table. To associate the 

a style sheet named width table with a style sheet: 

> Click on the Load Diff. Style function button and load the style 
sheet to which the width table will be associated. 

> Select the Manage Width Table option from the File menu. 

> If the path and name of the width table you want associated with the 
currently loaded style sheet is not displayed in the title bar of the 
Manage Width Table dialog box, select the Load Different Width 
Table button and load the desired width table. 

> Click on the OK button to exit the Manage Width Table dialog box. 

> Click on the Save Style As function button and save the style sheet 
under the same name. 
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~ Repeat the previous steps for each of your style sheets. 

Because custom width tables are never automatically rebuilt by Ven­
tura Publisher, if you add or remove fonts from Windows you must 
manually rebuild the custom width table using the previous steps. 
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Manage Publication 

The Manage Publication option allows you to combine a large number 
of chapters together into a publication. When you create and save a 
publication, you are simply creating a list of chapters that are to be 
grouped together. You can then print, generate a table of contents, 
create an index, or renumber the pages for the entire publication. 
Creating a publication allows you to: 

• Print very large publications, such as books or technical manuals. 
Each chapter can be created separately and can point to its own set 
of text, pictures and style sheets. 

• Quickly see every file associated with an individual chapter. 

• Automatically create front and back matter (table of contents and 
index.) 

• Automatically continue page numbers across chapter boundaries. 

• Copy every chapter listed in the publication as well as all of the files 
associated with the chapters, without accidentally losing a file. 

The Manage Publication option also includes a file management 
utility that allows you to copy all files associated with a chapter or 
publication. 

Always use Manage Publication to copy publications and chapters. 
Do not use the Windows File Manager or the DOS COPY command. 

Operation 

The Manage Publication option provides the tool necessary to group 
sets of chapters into publications for easy handling. As many as 128 
chapters can be included in a single publication. Publications can be 
copied, renumbered, edit, and printed. You can also generate a table of 
contents and index using the options in the Multi-Chapter Operations 
dialog box. 

Select the Manage Publication option from the File menu. If any 
changes have been made to the currently open chapter since it was last 
saved, the following alert is displayed. 
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Click on the Save button to save the chapter file and all associated files 
(including the style sheet). Click on the Abandon button if you choose 
not to save the changes. 

If you have made any changes to the style sheet since the chapter or 
style sheet was last saved, a second alert is displayed. Since saving the 
chapter also saves the style sheet, this alert will appear only if changes 
have been made to the style sheet but not the chapter, or if you selected 
to Abandon the changes to the chapter in the previous alert. 

Click on the Save button to save the style sheet. Click on the Abandon 
button if you choose not to save the changes. 

The Multi-Chapter Operations dialog box (Figure 5-13) is then dis­
played. 

Figure 5-13. Multi-Chapter Operations dialog box. 
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Multi-Chapter The Multi-Chapter Operations dialog box operates in two distinct 
Operations modes: the publication and the chapter mode. 

modes 
When a chapter name is selected (highlighted) in the publication list 
box, the mode changes to Chapter as displayed in the Mode status 
area. While in the chapter mode, all operations available are performed 
on the selected chapter only. To select a chapter name in the publication 
list box, click on the chapter name. To de-select a highlighted chapter 
name, click on the highlighted chapter name. 

When no chapter is selected in the publication list box the mode changes 
to Publication as shown in the Mode status area. While in the 
publication mode, all available options are performed on the entire 
publication. 

Add Chapter The Add Chapter option allows you to locate and add chapter names 
to the publication list box. This option is available regardless of the 
current dialog box mode. To add a chapter name to the publication list 
box: 

~ Click on the Add Chapter button. The Open File dialog box (Figure 
5-14) is displayed. 

Figure 5-14. Open File dialog box for chapter (CHP) files. 

~ Use the Drives and Directories list boxes to locate the desired 
chapter file. When the name of the desired chapter is shown in the 
File Name list box, either select the chapter name and click on the 
OK button, or double-click on the chapter name. 

~ Continue adding chapters in the same manner until all chapters that 
are to be included in the publication are listed in the publication list 
box. If you make a mistake and add a chapter that you don't want, 
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select the chapter name in the publication list box, and then click on 
the Remove Chapter button. 

The new chapter names will appear highlighted at the bottom of the 
publication list box. Refer to the Rearranging chapters section on page 
5-34 for information on arranging the order of chapters in the publica­
tion list box. 

If you attempt to load more than 128 chapter names in a single publica­
tion, the following alert is displayed. 

Check the publication for old or duplicate chapter names and remove 
them from the publication. 

Mter all of the chapters have been added and arranged, use the Save 
As option to save the publication. Refer to the Save As option section 
on page 5-37 for information on saving the publication. 

Remove Chapter The Remove Chapter option allows you to delete chapters from the 
publication list box. Only the chapter names are removed from the 
publication list box. The chapters themselves are not affected in any 
way. To remove a chapter name from the publication list box: 

> Highlight the chapter name in the publication list box by clicking on 
the chapter name. 

> Click on the Remove Chapter button. 

> Repeat the previous steps for each chapter that is to be removed from 
the publication list box. 

Rearranging You can easily change the order in which chapters are placed in the list 
chapters once you have created a list of chapters. 
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The order in which the chapters appear in the publication list box is 
important in that the order determines how the chapters will be num­
bered when using the Renumber option. 

~ Locate the chapter name you want moved in the publication list box. 
Select the chapter by clicking on the chapter name. 

~ Move the cursor to the new location (using the scroll bars if neces­
sary). As you move the mouse vertically along the list of chapters, you 
will see the cursor change to a horizontal insertion bar between the 
chapters. 

~ When the insertion bar is at the desired location, click the mouse and 
your highlighted chapter will be moved there. 

New The New option clears the publication list box of chapter names and 
starts a new, untitled publication regardless of the current dialog box 
mode. Simply click on the New button to clear the chapter names from 
the publication list box. 

Open The function of the Open option depends on the current dialog box 
mode. 

Chapter mode 

In the chapter mode, the Open option displays a list of the files as­
sociated with the selected chapter. To display the files associated with a 
chapter: 

~ Select the chapter name from the publication list box by clicking on 
the chapter name. 

~ Click on the Open button. The chapter names will be cleared from 
the publication list box and the files associated with the selected 
chapter will be displayed. (Figure 5-15). 
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Figure 5-15. Multi-Chcmter Operations dialog box displaying the files 
associated with SCOOP.CHP. 

~ Click on the Close button to close the chapter and re-display the 
chapter names in the publication list box. 

This display only allows you to view the files associated with the chap­
ter. The files cannot be edited or deleted using this option 

Publication mode 

In the publication mode, the open option allows you to load a previously 
saved publication. To load a previously saved publication: 

~ Ensure that the Mode status displays Publication. If the Mode 
status displays Chapter, one of the chapter names in the publication 
list box is selected. De-select the chapter by clicking on the chapter 
name (using the scroll bar if necessary). 

~ Click on the Open button. The Open File dialog box (Figure 5-16) is 
displayed. 
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Figure 5-16. Open File dialog box for publication (PUB) files. 

> Use the Drives and Directories list boxes to locate the desired 
publication. When the name of the desired publication is shown in the 
File Name list box, either select the publication name and click on 
the OK button, or double-click on the publication name. 

The publication path and name is displayed at the top of the publication 
list box, and the chapter names associated with the publication are 
displayed in the publication list box. 

Close The Close option is used to close the display of files associated with a 
selected chapter as described in the Open option section. This option 
has no effect in the Publication mode of the dialog box. 

Save The Save option saves changes made to a previously saved publication 
(regardless of the dialog box mode). This option is available only when 
an unsaved change has been made to a previously saved publication. 
This option is not available if the publication has not be previously saved 
(refer to the following Save As option section), or if the publication has 
not been modified in any way. 

To save a modified publication under its current name, simply click on 
the Save button. To save the publication under a new name, use the 
Save As option instead. 

Save As The Save As option allows you to save a newly created publication, or 
to save a previously saved publication under a different name. This 
option is not available if no chapter names are listed in the publication 
list box. To save a new publication, or save a previously save publication 
under another name: 
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~ Click on the Save As button. The Save File As dialog box (Figure 
5-17) is displayed. 

Figure 5-17. Save File As dialog box for publication (PUB) files. 

~ Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the publication file to be saved. When the 
name of the destination directory is shown in the Directories list 
box, enter a file name for the publication in the File Name entry field 
and click on the OK button. If you want the publication to be saved 
over a previously saved publication file, select the publication file 
name from the File Name list box and click on the OK button, or 
double-click on the publication file name. 

If the extension is not specified, Ventura Publisher automatically adds 
PUB. 

If the file name under which you are saving the publication is the same 
as that of a previously saved publication, the following alert is dis­
played. 

Click on the New Name button to re-display the Save File As dialog box 
and select a different file name for the publication. Click on the Over-
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write button to save the publication over the previously saved publica­
tion file. 

Print The Print option allows you to print the contents of the entire publica­
tion. You can use this option to print to either a printer, or to a file for 
output on a remote printer or imagesetter. 

The Print option is available only in the publication mode. To print a 
single chapter, load the chapter into Ventura Publisher and print it 
using the Print function button. 

Multi-chapter print to a printer 

> Load or create the publication you wish to print. 

> Ensure that the Mode status displays Publication. If the Mode 
status displays Chapter, one of the chapter names in the publication 
list box is selected. De-select the chapter by clicking on the chapter 
name (using the scroll bar if necessary). 

> Click on the Print button. 

> Ensure that the correct printer name is displayed at the top of the 
Print dialog box. If the correct printer is not displayed, select the 
printer using the Setup button in the Print dialog box. 

> Set the desired print options in the Print dialog box and click on the 
OK button. Refer to page 5-54 for more information on using the 
options in the Print dialog box. 

The most useful Page Range options in the Print dialog box for multi­
chapter printing are All, Left, and Right. The Current option will 
print page one of each of the chapters. The Pages option will print the 
selected range from each of the chapters 

Multi-chapter print to a file 

The procedures for printing a publication to a single file are the same as 
those of printing to a printer described above. The difference is that a 
special printer port must first be setup to multi-chapter print to a file. 
To setup the special printer port: 
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Setting up a special printer port requires editing of the WIN.INI file. 
You should always make a backup of this file before editing any of your 
INI files. 

>- Using an ASCII text editor (e.g., SYSEDIT, NOTEPAD) open your 
WIN .INI file located in the directory in which Windows is installed. 

>- Locate the section of the WIN.INI labeled [ports]. 

>- At the bottom of this section, add the line: 

MULTICHP.PRN= 

>- Save the WIN.INI file and close the ASCII test editor. 

>- Open the Windows Control Panel and double click on the Printers 
icon. 

>- Install a printer driver for the type of printer on which the publication 
will ultimately be output. Refer to the Printers dialog box Help or the 
Windows documentation for information on installing printer 
drivers. 

>- Set the newly installed printer to output to the MULTICHP.PRN 
port. Refer to the Printers dialog box Help or the Windows documen­
tation for information on assigning a printer port to the printer 
driver. 

>- Close the Printers dialog box and the Windows Control Panel. 

If you have installed soft fonts in Windows or are using a Windows font 
utility program (ATM, FaceLift), you will have to reinstall the soft fonts 
for this printer. Refer to the soft font or the font utility program 
documentation and Help for information on reinstalling the soft fonts. 
It is not necessary to reinstall TrueType fonts. 

If the soft fonts are not installed, they will not be included in the print 
file and will not be printed unless the fonts used are resident in the 
memory of the output device. 

>- Click on the Print button. 

>- Ensure that the printer name displayed at the top of the Print dialog 
box shows that the output will be directed to the MULTICHP.PRN 
port. If the correct printer is not displayed, select the correct printer 
using the Setup button in the Print dialog box. 
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> Set the desired print options in the Print dialog box and click on the 
OK button. The Print to File check box does not need to be checked. 
Refer to page 5-54 for more information on using the options in the 
Print dialog box. 

The most useful Page Range options in the Print dialog box for multi­
chapter printing are All, Left, and Right. The Current option will 
print page one of each of the chapters. The Pages option will print the 
selected range from each of the chapters. 

> When the Print to File dialog box is displayed, enter the full path and 
name for the print file in the Filename entry field . 

• Filename:>··.· .•• ·· .• 
I C:WPFILE1.PRN 

OK II' Cancel 
.... 

The files produced by printing an entire publication to a single file can 
be quite large depending on the content of the chapters. You can reduce 
the size of the print file by printing only a few chapters at a time to a 
different files. For example, remove all but the first three chapters, print 
to a file, reload the publication (do not save), remove all but the next 
three chapters (chapters 4 through 6), print to a different filename, 
reload the publication, etc. 

Once the print files have been generated, they can be printed using the 
DOS COPY command by entering the following at the DOS prompt: 

COpy [filename] [port]: /B 

where [f i 1 ename] is replaced with the full path and filename of the 
print file, and [port] is replaced with the port on which the printer is 
connected. For example: 

COPY VPFILE1.PRN LPT1: /B 

will output the print file VPFILEl.PRN to the printer attached to LPTl. 

The print files must be printed on the same type of printer that was 
setup in Windows when the publication was printed to a file from Ven­
tura Publisher. (i.e., if you set up an HP LaserJet printer to print to 
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MULTICHP.PRN, the files generated from printing to this printer 
driver can only be printed on an HP LaserJet printer). 

The print files can also be sent to a service bureau for output on an 
imagesetter. The files sent to a service bureau are typically PostScript 
format files. Installing and printing to file using a PostScript printer 
driver will create the PostScript files used by service bureaus. 

Make TOC Ventura Publisher can automatically generate a table of contents or 
table of figures by extracting tagged text from the publication. For 
instance, you can create a table of contents that contains every occur­
rence of text tagged as Chapter Head or Sub Headline, along with the 
associated chapter and page numbers. This table of contents is then 
stored as a text file in the Ventura Publisher Generated file format. This 
file can then be loaded and formatted later just like any other text file, 
saved as a chapter, and then added to the front of the publication file. 

To generate a table of contents: 

> If the publication for which the table of contents is to be generated is 
not displayed, use the Open option to load a publication. Otherwise, 
use the Add Chapter and Save As options to create a publication. 

> Click on the Make TOC button. The Generate Table of Contents 
dialog box (Figure 5-18) is displayed. The current publication name 
is shown in the TOC File entry field, with the last three letters 
changed to TOC and the extension .GEN added. This is the name of 
the text file which will be created during the process of generating the 
table of contents. 



Manage Publication FILE MENU 

••••• 

TOCfjle: IE:\TYPESET\&examTOC.GEN 

!.ille Siting: I Table 01 Conlents 

bvel!: I ('H eadin!! 1 J-(CIII< 196> (PilI 

levelZ;: I 
lIIvela: :=1 =========~. 

Level!: 1 
:============~ 

Levelll: ~I =============~ 
Level.6.: I 

~================~ 
Levell; I 
Levell.!!: :=1 ===========~. 

level!!,: I 
levuI1.Q: :=1 ===========~ 

, .. , 

Figure 5-18. Generate Table of Contents dialog box. 

~ Use the text cursor to change the TOe file name if you don't like the 
default name provided. 

~ Modify the Title String entry field, if desired. This is the title that 
is displayed at the top of the first table of contents page. 

~ Place the text cursor in the Level I entry field, and then select the 
Tag Text option. This places [*tag name] in the Level I entry 
field. 

~ Use the keyboard cursor keys to delete the words tag name and 
replace them with the first tag name associated with text you wish to 
place in the table of contents. 

~ Move the text cursor to the end of the Levell entry field. 

~ Select the Tab [-.] option. 

~ Select the Chapter # option Cifyou want chapter numbers included). 

~ Type a hyphen. If you want an En dash, type: <196> 

~ Select the Page # option. 

The Level I entry field on your display should look similar to the one 
in Figure 5-18. Repeat this procedure for additional levels. 

What you have just done is specify the text tagged with the name you 
specified to start at the left margin, followed by a tab, and then the 
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chapter number and page number on which that text was found. You can 
add any other text or format information you require. For instance, if 
you wish to place a text attribute (e.g., bold, italic) anywhere in the line 
of text you just typed, place the text cursor at the position where the 
attribute is to begin and select the Text Attribute option. Replace the 
text between the brackets with one of the codes shown on page D-5. For 
instance, if you want the chapter number to appear in italics, you would 
type <MI> [C#l <D>. 

When finished, click on the OK button. Ventura Publisher then auto­
matically creates a new text file which contains the extracted text. This 
text file is automatically tagged with different tags for each level, and 
another tag for- the title. These tags are called Z_TOCl, Z_TOC2, etc., 
and Z_TOC TITLE. You can then load the resulting text file (using the 
Load TextlPicture option), format it with a style sheet, edit it, and 
print it just like any other text file. Load this text file using the 
Generated format option in the Load/Text Picture option dialog box. 

Many documents use a different page format, including a different 
number of columns, for the table of contents or table of figures. If you 
place the generated text into a page which you have inserted using the 
InsertlRemove Page option in the Frame menu, this page's frame 
attributes can be set independent of the rest of the document. 

Make Index Ventura Publisher can automatically create an index from the refer­
ences you inserted into the text using the Index Entry option in the 
Insert Special Item secondary menu (Text menu). 
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To generate an index: 

~ If the publication for which the index is to be generated is not 
displayed, use the Open option to load a publication. Otherwise, use 
the Add Chapter and Save As options to create a publication. 

~ Ensure the Mode status displays Publication. If the Mode status 
displays Chapter, locate the highlighted chapter in the publication 
list box and deselect it by clicking on the chapter name. 

~ Click on the Make Index button. The Generate Index dialog box 
(Figure 5-19) is displayed. The current publication name, with the 
last three letters changed to IDX and the extension .GEN added, is 
shown in the Index File entry field. Change this name if you don't 
like the default name provided. 
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Figure 5-19. Generate Index dialog box. 
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~ Modify the Title String entry field, if desired. This is the title that 
will appear at the top of the first index page. 

~ If you want the letter A to appear before the first index entry 
beginning with the letter A, and a B before the first index entry 
beginning with the letter B, and so on, select On from the Letter 
Headings list box. An exclamation point (n is used as the heading for 
all nonalphabetic entries. 

The rest of the dialog box is automatically filled out as shown in Figure 
5-19, and usually does not need to be changed. For those wishing to 
change the default format: 

Before #s inserts the text you specify in front of the chapter and page 
numbers. The default is one horizontal tab character. For the index 
in this manual, the tab was replaced with a comma followed by a 
space. If you want to make the page numbers a different font than the 
rest of the index, place the typeface or size change code on this entry 
field. For example, to make the numbers print in ten point Helvetica, 
you would type: 

<P10F2> 

For Each # describes how the chapter and page numbers will appear 
in the index. If you don't want chapter numbers, delete both 
occurrences of [C#] -. If you want chapter numbers to appear bold, 
type: 

<B>[C#]<D> - [P#] - <B>[C#]<D> - [P#] 
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Between #s describes the punctuation that should be placed 
between each chapter/page number referenced. The default is a 
comma, followed by a space. 

Mter #s describes what punctuation should be placed after the 
chapter/page numbers. The default is no punctuation at all. If you 
changed font using the Before #s setting, you can reset to the default 
font by typing the font or size change code on this entry field. For 
example, to reset the typeface and size to the default specified by the 
paragraph tag, you would type: 

<P255F255> 

See defines the text that should be added for a cross reference entry. 
Usually the word See is used. If you want the word See to appear in 
italic, type: 

<MI>See<D> 

See Also defines the text that should be added for a secondary cross 
reference entry. Usually the words See Also are used. 

To save changes made to the default settings, save the publication after 
creating the index. 

During the process of generating an index, the actual text from each 
index entry is collected from the publication, along with the chapter and 
page number on which that entry is currently placed. This text is then 
sorted and placed into a text file. Each entry is followed by a line break 
and horizontal tab character. The last entry for each letter in the 
alphabet is followed by a paragraph end (carriage return). 

The index for this manual was generated with Ventura Publisher's 
index feature. 

Renumber The Renumber option automatically renumbers chapter, page, table, 
and figure numbers across chapter boundaries. This is used for books or 
other long documents which are numbered consecutively across chapter 
boundaries. 

To make this feature work, you must use the Update Counters option 
(in the Edit menu) and set the initial chapter, page, table, and figure 
counter for each chapter to Previous Number + 1. 

Renumber also updates all cross references. 

To renumber chapters, save the publication and then click on the 
Renumber button. 
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Copy All The Copy All option is used to copy and entire publication or chapter. 
Refer to the next section for procedures on copying a publication or 
chapter. 

Since both chapter and publication files point to many different text and 
picture files, each of which may be in a different sub-directory, copying 
every file in a complete chapter or publication using the File Manager 
or the DOS COPY command is a laborious process. In general, the File 
Manager and the DOS COPY commands do not work unless you intend 
to copy every file back to the same disk drive and sub-directory. 

If you are unfamiliar with the concept of paths and directories, please 
refer to the Windows or a DOS reference guide before proceeding with 
this section. 

Do not use the Windows File Manager or the DOS COpy command to 
copy chapters. 

The Copy All option automatically copies the files associated with a 
chapter or publication. The following files are not copied using the Copy 
All option. 

• Hyphenation dictionaries 

• Spelling dictionaries 

• Fonts 

• OLE server applications and server files 

• User font index 

If one or more chapters contain linked or embedded OLE objects, the 
.VPO file will be copied with the publication. However, neither the serv­
er application nor the server file will be copied. Refer to Appendix K for 
more information on publication and chapter file management for chap­
ters containing OLE objects. 

You can copy each type of file (e.g., style sheet, picture, text) to a 
different disk drive and sub-directory. Ventura Publisher automatically 
updates the references in the chapter (CHP) and publication (PUB) files 
to these new drives and sub-directories. 

To copy a publication, a group of chapters, or a single chapter: 
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> If you are copying a publication and the publication is not displayed 
in the Multi-Chapter Operations dialog box, use the Open button to 
load the publication you want to copy. If you are copying a single 
chapter, or a group of chapters, use the Add Chapter button to load 
the chapter name or names into the publication list box. 

Chapters listed in the publication list box do not have to be saved as a 
publication in order to copy them using the Copy All option. 

> If you are copying a publication or a group of chapters not saved as a 
publication, ensure that the Mode status displays Publication. If 
the Mode status displays Chapter, one of the chapters in the 
publication list box is selected and only that chapter will be copied. 
To deselect the chapter, locate the highlighted chapter in the publica­
tion list box and click on the chapter name. 

If you are copying a single chapter locate and select the chapter name 
in the publication list box. 

> Click on the Copy All button. The Copy All dialog box (Figure 5-20) 
is displayed. The PUB or CHP entry field shows the name of the 
publication to be copied. The destination entry fields show the disk 
drive and sub-directory to which each file type will be copied. 

Figure 5-20. QQRY All dialog box. Set to copy all files associated with 
&EXAMPLE.PUB to the A drive. You must include the backslash (\) at the end 
of each destination entry field or you may copy files to a different directory than 
you intended. 

> In each destination entry field, enter the disk drive name, followed 
by a colon, followed by a backslash (\), followed by the sub-directory 



Manage Publication FILE MENU 

(if any) where you wish to place that file type. 

Shortcut: if you want to save all files to the same disk and directory, 
enter information on the first destination entry field only, and then 
click on the Make all Directories as PUB & CHPs button. 

Some versions of DOS place a limitation on the number offiles that can 
be copied to the root directory of a floppy disk, but place no limitation 
on the number of files that can be copied to a sub-directory. Therefore, 
when you copy a chapter or publication containing a large number of 
small files, you should copy the chapter or publication to a sub-directory 
on the floppy disk. 

> Click on the OK button to begin the copying process. Ventura Pub­
lisher creates any directory names requested that were not already 
in existence. 

If one or more chapters contain linked or embedded OLE objects, the 
.VPO file will be copied with the publication. However, neither the serv­
er application nor the server file will be copied. Refer to Appendix K for 
more information on publication and chapter file management for chap­
ters containing OLE objects. 

For example, to save all files in the publication to the CHAPTERS 
directory on the A drive, edit each entry field to look like Figure 5-20. 

Pressing the Enter key does nothing in the Copy All dialog box. This 
reduces the chance of accidentally starting the copy process before you 
are ready. You must click on the OK button with the mouse to begin the 
copy process. 

Multi-chapter operation alerts 

File name At the beginning of the operation, Ventura Publisher compiles a list of 
collision file that are to be copied. If two files with the same name are to be copied 

from two different locations to a single destination location, the follow­
ing alert is displayed. 
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Insufficient disk If all the files from the publication will not fit on one disk, the following 
space message is displayed when the disk becomes full: 

If you are copying the publication to floppy disks, insert a blank, 
formatted disk in the drive, close the drive door, and then click on 
Continue or press Enter. 

If you are copying the publication to another hard drive, you will have 
to click on Cancel and then use the Windows File Manager or DOS 
commands to move or delete files from the target drive before the 
publication can be copied. 

Unable to locate If during copying, Ventura Publisher is not able to locate a file as­
file sociated with the chapter, the following alert will appear. The ap­

propriate action is dependent on the type of drive (floppy or hard) from 
which the publication is being copied. 
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Copying from a floppy drive 

If you are copying from floppy disks, insert the next floppy and click on 
Retry. If, after inserting the next floppy, the message reappears, make 
sure that the floppies are in the correct order. 

If the floppies are in the correct order, either click on Cancel and recopy 
the publication to the floppies from the original source, or click on Skip 
to continue the copy process. 

If you click on Skip, the missing file will not be available on the target 
disk. However, the reference to the file will remain in the chapter file 
until the chapter is opened from the target drive and then saved. Before 
opening the chapter from the target disk, you should locate the missing 
file, and then copy it to the target disk and directory with the other files 
of the same type (e.g., text, image) using the DOS COpy command or 
the Windows File Manager. The chapter can then be opened and saved 
as usual. 

Copying from a hard drive 

If you are copying the publication from a hard drive, either the file has 
been moved or deleted from the location it was in when it was loaded 
into the chapter, or the file is located on a network drive that you have 
not logged onto. Note the drive, path, and file name shown in the dialog 
box. 

If the drive and path shown in the dialog box is a network drive that you 
are not logged onto, click on Cancel, log onto the network, and then 
recopy the publication. 

If the drive and path shown in the dialog box is a local hard drive, or a 
network drive you are presently logged onto, you can either click on 
Cancel, open and reconstruct the chapter from which the file is missing, 
and then recopy the publication, or click on Skip to continue the copy 
process. 

If you click on Skip, the missing file will not be available on the target 
disk. However, the reference to the file will remain in the chapter file 
until the chapter is opened from the target drive and then saved. Before 
opening the chapter from the target disk, you should locate the missing 
file, and then copy it to the target disk and directory with the other files 
of the same type (e.g., text, image) using the DOS COPY command or 
the Windows File Manager. The chapter can then be opened and saved 
as usual. 
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Printer Setup 

Printer Setup 

The Printer Setup option lets you select a different printer, choose a 
different paper tray, scale the page larger or smaller, or configure to 
print to a file. The main use of the Printer Setup option is to change 
the currently selected printer and printer settings. 

Operation 
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To format your document for a different printer: 

~ Select the Printer Setup option from the File menu. The Printer 
Setup dialog box (Figure 5-21) is displayed. 

Figure 5-21. The Printer Setup dialog box. 

~ If the Default Printer selection is not the desired selection, select 
the desired printer from the Specific Printer list box. 

~ Set the desired Orientation and Paper options. 

~ Click on the Options button to set the options specific to the printer 
driver. The options and settings available when the Option button is 
selected are dependent on the printer selected and the corresponding 
printer driver. Refer to the printer driver Help after this option is 
selected for available options and settings. 

~ Click on the OK button to exit from the Printer Setup dialog box. 



Printer Setup FILE MENU 

If you click on the OK button to exit from the Printer Setup dialog box, 
Ventura Publisher will build a new width table based on the selected 
printer. This width table will be named ENVIRON. WID. You should not 
save your chapter when a width table named ENVIRON.WID is cur­
rently loaded. You should use the options available in the Manage Width 
Table dialog box to save this width table under another name before 
saving your chapter. Refer to the Manage Width Table option section 
starting on page 5-22 for more information on width table and renam­
ing the ENVIRON.WID width table. 

If you click on the Cancel button to exit the dialog box, all Printer Setup 
dialog box settings revert to those in effect before you entered the 
Printer Setup dialog box, and no width table is rebuilt. However, the 
setting made using the Printer Setup dialog box Option button will 
remain in effect. 

~ Select the Manage Width Table option in the File menu. Click on 
the Save As New Width Table button and save the width table 
under another name. Refer to the Manage Width Table option section 
starting on page 5-22 for more information on using the Manage 
Width Table dialog box options. 

If your document uses fonts not available with the new printer, the font 
used in your document will be substituted with a font available to the 
printer. In order to use the same fonts with different printers, the same 
fonts should be installed for each printer installed in Windows. Refer to 
Appendix I for additional information on the use of fonts. 
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Print 

Print 

Click on the Print function button to begin the printing process. The 
Print option allows you to: 

• Generate printed copies of the currently opened chapter. 

• Print to a file. This file can then be copied to a remote printer or sent 
to a typesetter. 

If you want to print a group of chapters or a publication to a printer or 
file, refer to the Multi-Chapter Operations dialog box Print option sec­
tion starting on page 5-39. 

To print all or part of the currently loaded chapter, click on the Print 
function button. The Print dialog box (Figure 5-22) is displayed. To stop 
a print in progress, click on the Cancel button in the printing message 
box. Ventura Publisher stops printing after the current page is finished. 
If you are using Windows Print manager or another print spooler, the 
spooler may still contain pages that will print even after Ventura 
Publisher has stopped printing. 

Figure 5-22. The Print dialog box. 

Print Range 
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To print the entire chapter, select the All option. To print only part of 
the chapter, select the Pages option, then type the number of the first 
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page in the From field and the last page number in the To field. The 
page numbers specified refer to the page numbers shown in the page 
number indicator. To print the current page only, select the Current 
Page option. 

Left/Right LeftIRight is used to print on both sides of the page (duplex printing) 
on printers which do not directly support duplex printing. To create 
duplex pages on non-duplex printer: 

~ Use the Left option and print all left pages. 

~ Turn the paper over and reinsert the paper tray (insert a blank sheet 
after the last page, if necessary). 

~ Use the Right option and print all right pages. 

Some printers will burn or smear the toner if a page is reinserted and 
printed on the second side. Refer to your printer manual. 

Print Quality 

Copies 

For printers with selectable levels of print quality (dots per inch for 
laser printers, for example), you can select the quality of the print from 
the Print Quality list box. As a general rule, a lower print quality, 
prints the page faster and uses less ink, toner, or print media; a higher 
print quality prints better looking text and graphics, but the page prints 
slower and uses more toner, ink, or print media. 

There are two ways to print multiple copies. If you check the Collate 
Copies check box you can enter the desired number of copies in the 
Copies entry field. However, this will cause Ventura Publisher to reload 
the chapter for each copy being printed, thus slowing the printing 
process. Leaving the Collated Copies check box cleared will speed the 
printing process, but the pages will have to be manually collated. 

Collate Copies 

Check the Collate Copies check box to print multiple, collated copies. 
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Print to file 

Setup 

Check the Print to File check box to output the pages to a file instead 
of the printer. Refer to the Printing to a file section starting on page 5-62 
for information on the various uses and procedures for printing to a file. 

Printer configuration is handled through the Printer Setup dialog box. 
Set the printer, paper orientation, and paper tray options in the Printer 
Setup dialog box (Figure 5-23). 

Figure 5-23. The Printer Setup dialog box. 

Printer Select the Default Printer option to use the Windows installed default 
printer. To print to a different printer, select the printer from the 
Specific Printer list box. 

It is important to note that, unlike accessing the Printer Setup dialog 
box using the Printer Setup option in the File menu, this Printer 
Setup dialog box will not cause a new width table to be generated. This 
is particularly useful if you are printing to a printer other than that 
setup as the ultimate output device (e.g., proofing to a laser printer 
before sending the document to a service bureau), or if you want to print 
a specialized driver such as a fax software driver. 

Orientation Select Portrait if you want to print in the portrait mode. Select 
Landscape if you want to print in the landscape mode. 
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Paper Select the paper size you want to print on from the Size list box. The 
size selected must match the size of the paper in the printer. Selecting 
a size smaller than is actually present in the printer may cause the 
printer to misfeed and jam. Selecting a size larger than present in the 
printer may cause jamming or an incomplete print of the page. 

Many printers have multiple trays and allow manual feeding of pages. 
Select the paper source (e.g. upper tray, lower tray, manual feed) from 
the Source list box. 

Options Click on the Options button to access the options for the installed 
printer driver. If you need help in the Options dialog box, click on the 
Help button to get printer specific information. This information varies 
from printer to printer. 

Options 

Certain printers can enlarge or reduce the page size (PostScript 
printers, for example, have this capability). If your printer allows en­
larging or reducing the page size (called scaling), use the Scaling option 
in the Options dialog box to enlarge or reduce the page to fit the paper 
size. 

Other typical information found in the Options dialog box are the 
margin settings, print destination, and header information. 

Click on the Option button to display the Ventura Print Options dialog 
box (Figure 5-24). 

Figure 5-24. Ventura Print Options dialog box. 
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Crop Marks Check the Crop Marks box to place crop marks at the exact edge of the 
page. This feature is useful primarily for typesetting machines, since 
most laser printers don't print to the edged of the page. note also that 
crop marks will print only if the paper in your printer is larger than the 
page size chosen in the Chapter menu. You can create custom page 
sizes which are smaller than the defaults in the Chapter menu (refer 
to the Sizing & Scaling option section in the Frame menu chapter). 

Tiling 

If you want to create custom crop marks closer to the center of the page: 

~ Select the page. 

~ Use the Line tool to draw individual crop marks. 

~ Select Show On All Pages option from the Graphic menu for all 
crop marks to show these custom drawn crop marks on all pages. 

If you have select page dimension of 11 x 17 or Broadsheet in the Page 
Size & Layout option dialog box (Chapter men), you can print on 
printers which only handle smaller paper sizes. Select the Tiling check 
box to print many small pages which can then be pasted together to 
create the larger page. 

The tiling option is not available if the Color Separations check box is 
checked. 

Reversed If your printer stacks the pages in the wrong order, you can reverse the 
Printing Order . normal printing order by checking the Reversed Printing Order 

check box. 

Print Hidden When printing a chapter containing hidden pictures, check the Print 
Pictures Hidden Pictures option to print all the hidden pictures in the chapter. 

If the Print Hidden Pictures is not enabled, the area of the page 
containing a hidden picture prints as solid black. Pictures that are not 
hidden will print regardless of the setting of the Print Hidden Pic­
tures option. 

Color If you check the Color Separations check box, a separate page or 
Separations separation is printed for each color selected in the Separation Colors 

dialog box. The color name you define is printed at the top of each page 
printed for that color. 
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If the Ventura Separator color extension is not installed, you can only 
perform spot color separation. With spot color separation, each sheet 
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Print Empty 
Plates 

contains only the text and graphics set for one specific color. Solid colors 
will print as 100% black, and tints of a color will print as a shade of 
black. Ventura Publisher prints a white mask on each color that is 
underneath another color. In other words, where two colors overlap the 
one underneath has a white mask. 

For example, if black text is entered in a frame with a solid green 
background, and the page is printed with the Color Separations 
option checked, one page is printed for the text and one for the frame. 
The page printed for the frame prints the green background as 100% 
black, but"a white mask for the black text prints in the frame. 

Black Text Black Text 

Figure 5-25. The first page prints the black text. The second page prints the 
green background as black, and prints a white mask in the frame for the black 
text. 

If the Ventura Separator color extension is installed, colors are 
separated according to the Ink Separations and Ink Alignments set­
tings set in the Define Colors dialog box for each color setting. 

The Print Empty Plates option is available only when the Color 
Separations option is checked. Check the Print Empty Plates option 
to produce a separation plate (color overlay), for each color in the 
Selected Colors list of the Separation Colors dialog box, regardless of 
whether that color is used on a page. If this the Print Empty Plates is 
cleared, a separation plate is produced only for those colors used on a 
page. 

Colors The Colors button is available only if the Color Separations option is 
checked. Click on the Colors button to display the Separation Colors 
dialog box similar to the one shown in Figure 5-26. This dialog box is 
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used to select the colors used in the separations. Only those colors 
selected in this dialog box are printed. 

Figure 5-26. Separation Colors dialog box. 

Available Colors 

The Available Colors list displays the color available in the currently 
loaded style sheet. These colors are defined using the Define Colors 
option in the Paragraph menu. 

Selected Colors 

The Selected Colors list displays the colors selected to be printed as 
separations. 

Only the chapter components (i.e. text, graphics, etc.) that are defined 
with colors from this list are printed as separations. Any chapter com­
ponents with a color that is not on this list will not print in the separa­
tions. 

Add to Selected Colors 

The Add to Selected Colors button adds the color currently selected 
in the Available Colors list to the Selected Colors list. Color names 
are selected from the Available Colors list by clicking on their color 
name. 
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Color names can also be added to the Selected Colors list by double 
clicking on a color name in the Available Colors list. 

Colors added to the Selected Colors list that are not used in the 
chapter produce a separation plate only when the Print Empty Plates 
check box in the Print· dialog box is checked. 

Add Process Colors 

The Add Process Colors button adds process cyan (C), magenta (M), 
yellow (Y), and black (K) colors to the Selected Colors dialog box. 
These process colors differ from the cyan, magenta, yellow, and black 
colors in the Available Colors list in that the process CMYK colors are 
used to separate the colors in the Available colors list and to separate 
pictures in the chapter into four process color plates. 

The Add Process Colors option and CMYK separations are only avail­
able when the Ventura Separator color extension product is installed. 

Remove Selected Color 

The Remove Selected Color button removes the color currently 
selected from the Selected Colors list. Color names are selected from 
the Selected Colors list by clicking on the color. 

Color names can also be removed from the Selected Colors list by 
double-clicking on them. 

Clear Selected Colors 

The Clear Selected Colors option removes all colors from the 
Selected Colors list. 
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Printing to a file 
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Ventura Publisher allows you to print all or part of your document to a 
file. This option is used for: 

• Print your document on a printer connected to another computer 
without the need to move the printer. 

• Send your document to a service bureau for printing at a higher 
resolution than a desktop printer is capable. 

• Print a page of a document to a file and then incorporate that page 
back into Ventura Publisher as a picture. 

The latter two items listed above require a PostScript printer driver be 
installed in Windows prior to printing to a file. 

Printing on a remote printer 

If circumstances do not allow you to have a printer connected to your 
computer, you can print your documents on a printer connected to 
another computer. 

In order to print your document on a remote printer, you must have a 
printer driver for that printer installed in your installation of Windows. 

Setup Before you can print a chapter to a file for output on a remote printer, 
you must generate a width table for that printer and apply it to your 
document. 

Applying a width table generated for a different printer than that of the 
width table used when the document was created may cause the line 
endings and page breaks of the document to change. Therefore, it is 
recommended that the document be created using a width table 
generated for the remote printer. 

To generate a width table for the printer and apply it to your chapter: 

> Click on the Load Diff. Style function button and load the style 
sheet used to produce the document that will be sent to the service 
bureau. 
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~ Select the Printer Setup option from the File menu. If the device on 
which the document is to ultimately be output is not displayed as the 
Default Printer, select the device from the Specific Printer list 
box. 

If the remote printer is not listed in the Specific Printers list box, the 
driver for that printer has not been installed in Windows. You must 
install a driver for the printer before you can create a width table for 
that printer. 

~ Click on the OK button. Ventura Publisher will display various 
messages as a width table for the output device is generated. This 
could take several minutes depending on the number of fonts in­
stalled in Windows and the speed of your computer. 

~ Select the Manage Width Table option from the File menu and save 
the width table under a name that describes the device or purpose of 
the width table (e.g., HPIIIP.WID, REMOTE.WID). Click on the OK 
button. 

~ Click on the Save Style As function button and save the style sheet 
under the same name (click on the Overwrite button when the alert 
is displayed). 

Apply this style sheet to all chapters that are to be output on the remote 
printer, or create additional style sheets and apply the width table 
generated for the remote printer to these style sheets.· 

Printing To print all or part of your document to a file for printing on a remote 
printer: 

~ In Ventura Publisher, open the chapter you wish to print to a file. 

~ Click on the Print function button. 

~ If the name of the remote printer is not displayed at the top of the 
Print dialog box, click on the Setup button. Select the correct printer 
from the Specific Printer list box and click on the OK button to 
return to the Print dialog box. 

~ Check the Print to File check box. 

~ Change the other Print dialog box options as desired and click on the 
OK button to start the print job. The Print to File dialog box (Figure 
5-27) is displayed. 
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Printing to a file 

Figure 5-27. Print to File dialog box. 

When printing to a file, you should printed to a hard disk rather than 
directly to a floppy disk. A floppy disk drive is slower than a hard disk 
and will cause the print operation to take a considerable amount of time. 
Also, if you write the file directly to a floppy disk and the file created is 
larger than can be stored on a floppy, an error message will be displayed 
and the printing operation aborted. 

~ Enter the path and file name to which you want the pages printed in 
the Filename entry field and then click on the OK button. 

~ Mter the document has been printed to a file, copy the file to a floppy 
disk using the Windows File Manager or the DOS COpy command. 

If your document contains many graphics or fonts, the file created may 
be larger than will fit on a floppy disk. If this happens you will have to 
create multiple files with fewer pages printed to each file. 

~ The file can be copied to the printer at the remote system using the 
DOS COpy command enter as: 

COpy [filename] [port]: /8 

Replace [filename] with the complete path and name of the print 
file. Replace [port] with the computer's port to which the printer is 
connected (e.g., COMl, LPTl). 

For example, to print the document file VPFILE1.PRN from the root 
directory of the computers hard disk to a printer connected to LPTl, 
type the following at the DOS prompt: 

COpy C:\VPFILE1.PRN LPT1: /8 

Copy operations performed to and from a floppy drive take longer than 
comparable operations performed to and from a hard drive. Therefore, 
copying a file from a floppy disk to a printer port may take a consider-
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able amount of time depending on the size of the file and the type of 
printer port (e.g., serial or parallel port). You may wish to copy the file 
to the computer's hard disk before copying the file to the printer. 

If you are copying the file to a printer connected to a serial port (e.g., 
COM! or COM2) and the document will not print, you may be required 
to initialize the printer port before copying your file to the printer. This 
can be done by entering the following MODE command at the DOS 
prompt. 

MODE [port] :9600,N,8,1,P 

Replace [port] with the COM port (e.g., COM! or COM2) to which the 
printer is connected. 

Sending a document to a service bureau 

Sending your document to a service bureau allows you to have your 
document printed at a higher resolution than most desktop printers can 
produce. Using the following procedures, you will be able to produce 
documents that can contain fonts not installed in your Windows instal­
lation, proof the documents on a printer attached to your computer, and 
output the documents to a file for output on a service bureau's imageset­
ter. 

Using ,PFM font When printing to a desktop laser printer, the fonts used in your docu-
metric files ment must either be resident in the printers memory, or downloaded 

from your computers hard disk. Most service bureaus have purchased a 
large number of fonts, however, normally you cannot use these fonts in 
you documents unless you have also purchased the fonts. 

In order that you may use some of these fonts in your document without 
having to purchase the fonts, Ventura Publisher supplies a PostScript 
font metric (.PFM) file for a number of popular typefaces. When in­
stalled, the font metric file allows you to apply the font to text in your 
document, print the document to a file, and have the document printed 
at a service bureau on a typesetter have the corresponding printer font 
in memory. 

The limitation is that the font cannot be displayed on the screen or 
printed on a desktop printer unless you also have the corresponding 
printer font file (.PFB). Instead, a font for which a .PFB is available will 
be displayed and printed. Although a substitute font will be displayed 
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on the screen and printed on your desktop printer, the line endings and 
alignment for the correct font will be maintained, and the font will print 
correctly when the document is printed on a typesetter have the cor­
responding printer font file in memory. Refer to Appendix I for informa­
tion on installing the .PFM files included with Ventura Publisher. 

Setup Ventura Publisher allows you to create documents using the character 
widths for printers other than the one currently connected to your 
computer. Using this capability, you can produce draft copies on your 
local printer with the knowledge that the line endings and page breaks 
will not change when the document is printed on the service bureau's 
imagesetter. 

In order to print your document to a file for output on an imagesetter, 
you must have a printer driver for the imagesetter (or similar device) 
installed in Windows. Additionally, if you want to proof your documents 
on a local laser printer, you must have a printer driver for that printer 
installed in Windows. 

Before you can print a chapter to a file for output on a imagesetter, you 
must generate a width table for the image setter and apply it to your 
document. 

Applying a width table generated for a different printer than that of the 
width table used when the document was created may cause the line 
endings and page breaks of the document to change. Therefore, it is 
recommended that the document be created using a width table 
generated for the imagesetter device. 

To format a document for a device other than the ultimate output device: 

~ Click on the Load Diff. Style function button and load the style 
sheet used to produce the document that will be sent to the service 
bureau. 

~ Select the Printer Setup option from the File menu. If the device on 
which the document is to ultimately be output is not displayed as the 
Default Printer, select the device from the Specific Printer list 
box. 

If the ultimate output device is not listed in the Specific Printers list 
box, the driver for that device has not been installed in Windows. You 
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must install a driver for the device before you can create a width table 
for that device. 

~ Click on the OK button. Ventura Publisher will display various 
messages as a width table for the output device is generated. This 
could take several minutes depending on the number of fonts in­
stalled in Windows and the speed of your computer. 

~ Select the Manage Width Table option from the File menu and save 
the width table under a name that describes the device or purpose of 
the width table (e.g., LINO.WID, IMGSET.WID). Click on the OK 
button. 

~ Click on the Save Style As function button and save the style sheet 
under the same name (click on the Overwrite button when the alert 
is displayed). 

Apply this style sheet to all chapters that are to be sent to the service 
bureau, or create additional style sheets and apply the width table 
generated for the image setter to these style sheets. 

Draft printing At various time during the production of the document, you may wish 
to print proof copies. Ventura Publisher allows you to create documents 
using the character widths for output devices other than the one cur­
rently connected to your computer. Using this capability, you can 
produce draft copies on your local printer with the knowledge that the 
line endings and page breaks will not change when the document is 
printed on the final, ultimate output device (such as an imagesetter). 

When you want to print these documents for proofing: 

~ Click on the Print function button. 

~ If the name of the proof printer (the printer connected to your 
computer) is not displayed at the top of the Print dialog box, click on 
the Setup button. Select the correct printer from the Specific 
Printer list box and click on the OK button to return to the Print 
dialog box. 

~ Change the Print dialog box options as desired and click on the OK 
button to start the print job. 

When a document is printed to a proof printer, you may notice a 
difference in kerning. This is normal since different output devices kern 
text differently. However, since the kerning used to create the document 
is based on the ultimate output device, all line endings and page breaks 
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will be the same as when the document is output on the ultimate output 
device. 

Additionally, if the proof printer does not have the typefaces used in the 
document resident in memory, and the typefaces are not available for 
downloading to the proof printer, the typefaces used in the document 
will be substituted with those available in the proof printer. 

Final printing to To print all or part of your document to a file for printing by a service 
a file bureau: 
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~ In VenturJ;} Publisher, open the chapter you wish to print to a file. 

~ Click on the Print function button. 

~ If the name of the remote printer is not displayed at the top of the 
Print dialog box, click on the Setup button. Select the correct printer 
from the Specific Printer list box and click on the OK button to 
return to the Print dialog box. 

~ Check the Print to File check box. 

~ Change the other Print dialog box options as desired and click on the 
OK button to start the print job. The Print to File dialog box (Figure 
5-28) is displayed. 

Figure 5-28. Print to File dialog box. 

When printing to a file, you should printed to a hard disk rather than 
directly to a floppy disk. A floppy disk drive is slower than a hard disk 
and will cause the print operation to take a considerable amount of time. 
Also, if you write the file directly to a floppy disk and the file created is 
larger than can be stored on a floppy, an error message will be displayed 
and the printing operation aborted. 

~ Enter the path and file name to which you want the pages printed in 
the Filename entry field and then click on the OK button. 
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~ After the document has been printed to a file, copy the file to a floppy 
disk using the Windows File Manager or the DOS COPY command. 

If your document contains many graphics or fonts, the file created may 
be larger than will fit on a floppy disk. If this happens you will have to 
create multiple files with fewer pages printed to each file. 

Also, the print file can be compressed using on of the many compression 
programs (e.g., PKzip, LHarc, etc.). Additionally, many service bureaus 
operate electronic bulletin board allowing large file to be sent using a 
modem. 

The floppy disk can then be sent to a service bureau for output on an 
imagesetter. 

Taking a screen grab of a page 

Ventura Publisher allows you to print a single page of a document to a 
file and then incorporated that page back into a document as a picture. 
The advantages of printing the page to a file rather than using the 
Windows built-in screen grab are: 

• The files generated by Windows PostScript are EPS format files; thus 
they can be scaled to any size without losing the picture resolution. 

• Only the document page is printed. None of the menus, the Toolbox, 
nor any of the other program screen items are printed. 

The disadvantages are: 

• Documents using this file, as with any other EPS file, can only be 
printed on PostScript or PostScript compatible printers or typeset­
ters. 

• The EPS picture files will not display on the screen unless a TIFF or 
Windows metafile image can be incorporated into the EPS file. 

Setup Printing a page of your document to a file requires that a PostScript 
printer driver be installed and properly configured in Windows prior to 
printing to a file. 
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Installing this printer will allow you to access the PostScript printer 
driver from Ventura Publisher and does not require you to have a Post­
Script printer connected to your computer. 

~ If you don't already have a PostScript printer driver installed in 
Windows, refer to the Windows documentation for instruction on 
installing a PostScript driver using the Windows Control Printer. The 
Apple LaserWriter NTX printer driver can be used for this purpose. 

~ Ifnot already open, open the Windows Control Panel and double-click 
on the Printer icon. 

~ With the PostScript printer driver selected in the Installed 
Printers list, click on the Configure button (in Windows 3.0) or the 
Connect button (in Windows 3.1). 

~ Select the COM4 option from the Ports list box. This setting is used 
only to help distinguish the printer when it is displayed in a list of 
other installed printers. The COM4 setting is actually not used. 

~ If you are running Windows 3.0, click on the Setup button. If you are 
running Windows 3.1, click on the OK button to return to the Printers 
dialog box, and then click on the Setup button. 

The PostScript printer properties dialog box is displayed. 

~ Click on the Options button. 

The Options dialog box is displayed. 

~ Set the Print To option to Encapsulated PostScript File. 

~ Leave the File entry field blank. 

~ If you are running Windows 3.0, ensure that the Header option is set 
to Download each job. If you are running Windows 3.1 ensure that 
the Send Header with Each Job check box is checked. 

~ Select the OK button in each dialog box until you return to the 
Printers dialog box. 

~ Make sure the Status option is set to Active. 

~ Select the OK button to exit the Printers dialog box and save your 
settings. Close the Windows Control Panel 

Printing ~ Open Ventura Publisher and load the chapter containing the page 
you want to print to a "screen grab" file. 
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~ Use the page buttons, or the Go to Page function button to display the 
page you want printed. 

~ Click on the Print button. 

~ If the printer name displayed at the Print dialog box is not the one 
setup for printing to COM4, click on the Setup button and select the 
printer from the Specific Printer list box, and then click on the OK 
button 

~ Set the Page Range option to Current. Do not check the Print to 
File check box. 

Make sure that only a single page is being printed to a file. If multiple 
pages are printed to a file, that file will not load, display, or print proper­
ly. 

~ Select the OK button to begin printing the page to a file. The Print to 
File dialog box (Figure 5-29) is displayed. 

Figure 5-29. Print to File dialog box. 

~ Enter the path and file name to which you want the page printed in 
the Filename entry field. 

The extension of the file name entered in the Filename entry field can­
not contain any numbers. If a number is entered in the file name exten­
sion an error message will be displayed when you attempt to load the 
file into a document. The default extension in the Ventura Publisher 
Load TextiPicture dialog box for the PostScript file format is EPS. 

The files created using this procedure can be imported into a document 
as a picture using the Load Text/Picture function button. Set the File 
Type option to Line Art, and select the PostScript option from the 
Format list box. The PostScript picture will be displayed in your 
document as a large X in the frame. The full size of this X represents the 
image area of the picture. 
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Exit 

Exit 

The Exit option ends the current Ventura Publisher session and returns 
you to the Windows Program Manager. Use this option to exit Ventura 
Publisher. 

Operation 
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Select the Exit option in the File menu. If you have made changes to 
your chapter or style sheet since they were last saved, the following alert 
is displayed. 

Click on the Save button to save the changes before quitting; click on 
the Abandon button to throwaway any changes made. Click on the 
Don't Quit button to return to the Ventura Publisher main screen. 

When you Exit from Ventura Publisher, the current interface mode, 
zoom factor, and preference settings are all saved. When you next use 
Ventura Publisher, you resume with the same settings that were in 
effect at the end of the previous session. These settings are saved in the 
VPWIN.INF file in the VENTURA sub-directory. You can delete this file 
prior to running Ventura Publisher if you always want to use the factory 
default settings. 

Any changes made to the text or picture files of a chapter outside of 
Ventura Publisher will automatically appear when the chapter is 
opened again. 
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Figure 6-1. Edit menu. 

Description 

The Edit menu performs the following operations: 

• Undo last changes to frames, text, graphics, and tag attributes. 

• Cut, copy and paste frames and their contents, selected text, 
graphics, and paragraph tags. 

• Establish OLE object links. 

• Update the table, figure, page, and chapter counters. 

• Re-anchor frames in a chapter. 

• Renumber the section numbers in a chapter. 

• Change various default settings which control Ventura Publisher's 
general operation. 

• Spell check all text in a chapter, a selected text file in the chapter, the 
captions, box text, and frame text in a chapter, or a selected block of 
text. 

• Search and replace text, text attributes, and tags. 

• Display and edit OLE object properties. 
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Undo/Redo 
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Click on the Undo function button to undo the previous text, tag, 
graphic, or frame editing action. When an editing action is undone, the 
Redo option becomes available and allows you to redo the initial editing 
action. 

The Undo option allows you to easily correct editing and formatting 
mistakes. Using the Undo and Redo options together also allows you 
to easily experiment with formatting changes. When changing a tag 
attribute for example, the Undo and Redo options allow you to toggle 
between the original attributes and the attribute change to see the effect 
before committing to the change. 

The Undo option is only available while the changed item is still 
selected. If the changed item is deselected either by selecting another 
item or changing tools, the Undo option for the last editing action will 
no longer be available. 

The Undo option is a one level undo only. This means that if, for 
example, you change the font of a tag and then change the spacing for 
the tag, only the spacing change can be undone using the Undo option. 
The previous font change would have to be undone using the Font 
option in the Paragraph menu. 

The Undo option will undo changes to multiple items if the items were 
edited at the same time using the multiple selection feature (pressing 
and holding the Shift key while selecting multiple items). 

Operation 

Frame tool The U ndolRedo option allows you to undo and redo frame moving, 
sizing, adding, and deleting. The option will undo changes made to 
multiple frames if the frames were changed at the same time using the 
multiple selection feature (pressing and holding the Shift key while 
selecting multiple frames). 

Changes made to frames using the Frame menu ruling lines and frame 
background options can also be undone and redone. 
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Paragraph tool The UndolRedo option allows you to undo and redo tag assignments 
made to a paragraph using the paragraph tool. 

Changes made using the following Pa~agraph menu options can also 
be undone and redone. 

The Undo!Redo option will undo and redo tag assignments made to 
multiple paragraphs if the paragraphs were selected at the same time 
using the multiple selection feature (pressing and holding the Shift key 
while selecting multiple paragraphs). 

• Font option 

• Alignment option 

• Spacing option 

• Breaks option 

• Tab Settings option 

• Special Effects option 

• Attribute Overrides option 

• Paragraph Typography option 

Just as making attribute changes to a tag will apply the attribute to all 
paragraphs with that tag, undoing changes to a tag will affect all para­
graphs with that tag. 

Text tool The U ndolRedo option allows you to undo and redo most of the text 
editing and formatting operations accomplished using the Text tool. The 
following is a list of the functions that can be undone and redone while 
using the Text tool. 

• Text attribute changes made using the options in the Text menu. 

• Text editing. 

• Tags applied to paragraphs using the Text tool. 

• The last interactive font or kerning change made using the Shift + 
arrow key combination. 

The Undo!Redo option will undo and redo tag assignments made to 
multiple paragraphs if the paragraphs were selected at the same time 
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Graphic tools 
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Undo/Redo 

using the Text tool. Adding and editing of special items cannot be undone 
using the Undo option. 

The UndolRedo option allows you to undo and redo graphic moving, 
sizing, adding, deleting as well as changes to the graphic line and fill 
attributes. The option will undo changes made to multiple graphics if 
the graphics were changed at the same time using the multiple selection 
feature (pressing and holding the Shift key while selecting multiple 
frames). 

Changes made to graphic line and fill attributes can be undone, how­
ever, changes made to a graphic using the other options in the Graphic 
menu cannot be undone using the Undo option. 
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The Cut, Copy, and Paste function buttons let you delete, move, and 
copy text, frames, and graphics. Use this option to: 

• Move text, frames, and graphics from one part of a chapter to another, 
as well as between chapters. 

• Move text between different files. 

• Place identical copies of the same picture on more than one page. 

• Make duplicate blank frames. (If you want to put the same frame on 
every page, use the Repeating Frames option instead.) 

• Copy or move selected graphics. 

• Move tags between style sheets. 

• Move information between different Windows applications. 

The Cut, Copy, and Paste options use the Windows clipboard as a hold­
ing place for the data. Only one item can be cut or copied to the clipboard 
at a time. If something is cut or copied to the clipboard, anything pre­
viously on the clipboard is cleared from the clipboard and cannot be 
pasted. 

• Cut removes the selected object and places it on an invisible clip­
board. 

• Copy places an identical copy of the selected object on the clipboard, 
but does not remove the selected item from the chapter. 

• Paste takes the last item which was cut or copied and places it: 

- At the current location of the text cursor, if the clipboard con­
tains text. 

- At the identical position on a new page or the current page, if 
the clipboard contains a frame or graphic. 

- Into the current style sheet, if the clipboard contains paragraph 
tags. 
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The clipboard is shared by all Windows programs and provides a method 
for moving information between them. Ventura Publisher supports im­
port and export of ASCII text, import of Windows metafiles, bitmapped 
images and OLE objects on the clipboard. Graphics drawn in Ventura 
Publisher and paragraph tags cannot be viewed on the clipboard or 
copied to other applications. 

Operation 

Cut and Copy To cut (delete) or copy a selected object: 
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~ Click on the tool which matches the object you wish to cut: 

- Text tool to cut/copy text 

- Selector tool to cut/copy frames or graphics 

- Paragraph tool to cut/copy tags 

~ Select the object to be deleted or copied. 

~ Click on the Cut (or press the Delete key) or Copy (or press 
Shift+Delete) function button. 

If you click on the Cut function button, the object disappears from the 
screen, and the text on the page is reformatted. If a mistake is made 
during a cut operation, you can restore the object by immediately 
clicking on the Paste function button, or by pressing the Insert key. 

If you cut a paragraph tag, the tag is not removed from the current style 
sheet. It is merely copied. Use the Paragraph tool Update Tag List 
option button to remove tags from the current style sheet. 

Text 

When cutting or copying text, the following special instructions apply: 

• When selecting text, you can include the Paragraph End mark. Move 
the text cursor in front of the first word of the next paragraph during 
text selection. 

• You can cut or copy any of the special items (e.g., frame anchors, 
markers, index entries) shown in the current selection indicator. To 
do this: 
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~ Move the text cursor until the special item is shown in the current 
selection indicator. 

~ Click on the Cut function button to cut or the Copy function button 
to copy the special item. 

If you cut the special item, the special item will be removed from the text 
but will not be cut to the clipboard. To reinsert the special item, imme­
diately click on the Undo function button. If you wish to copy the special 
item to other locations, click on the Copy function button or press Shift 
+ Delete and the special item will be copied to the clipboard. 

~ If you have copied the special item to the clipboard and wish to insert 
the special item elsewhere in you chapter, simply move the text cursor 
to the new location and then click on the Paste function button or 
press the Insert key. 

Note that if the current selection indicator is blank, pressing either the 
Delete or Shift+Delete keys will not cut or copy text attributes to the 
clipboard. 

Frames 

When cutting or copying frames, the following special instructions 
apply: 

• All graphics attached to a frame are also cut or copied when you cut 
or copy the frame. 

• Ventura Publisher automatically updates table and figure counters 
for frames which contain captions. The last frame pasted on a page is 
always assigned the highest table or figure number on the page. 

• If multiple frames are selected, they are all cut, copied, or pasted. 

Graphics 

When cutting or copying graphics, the following special instructions 
apply: 

• You can select multiple graphics for cutting or copying by pressing 
and holding either Shift key while selecting graphics. However, you 
can only select graphics attached to the same frame. 

Paste Once an object has been cut or copied to the clipboard, it can be placed 
elsewhere in the current chapter, or in another chapter. 
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A copy of the object remains on the clipboard after a paste operation. You 
can therefore place additional copies elsewhere in the chapter without 
re-cutting or recopying the object. 

To paste an object at a new location after it has been cut or copied: 

Text 

~ Use the Text tool to place the text cursor at the exact spot in the 
chapter's text where the cut text is to start. 

~ When the text cursor is placed correctly, click on the Paste function 
button, or press the Insert key. The inserted text is always converted 
to the attributes in effect at the point of insertion. 

If you have not placed the typing cursor before trying to pasting text 
from the clipboard, the following alert is displayed. 

Click on the OK button and place the typing cursor at the desired 
position before trying to paste the text from the clipboard. 

If there is no text on the clipboard, the Paste function button will be 
grayed and unavailable for selection. If there is no text on the clipboard 
and the Insert key is pressed, the following alert is displayed. 
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Frames 

~ Click on the Selector tool button. 

~ Go to the page where the frame is to be moved, and then click on the 
Paste function button, or press the Insert key. 

The frame, the file it contains, and any graphics attached to the frame 
are all placed on the page. The frame's original location on the page 
prior to the cut or copy operation determines where it is pasted. You 
can then move the frame to a new location on the page. 

Graphics 

~ Click on the Selector tool button. 

~ Select the frame (or the page itself) to which you want to attach the 
graphics currently on the clipboard. 

~ Click on the Paste function button, or press the Insert key. 

The location of the graphic prior to the cut or copy determines where it 
is pasted. You can then move the graphic to a new location. 

Pasting a frame or graphic onto the same page from which it was copied 
places two identical frames or graphics on top of one another. Since the 
two are identical and occupy the same position, you will see only one 
copy on the screen. However, you can select the frame or graphic on top 
and move it to another location on the page. 

Text, frames, graphics, and paragraph tags remain on the clipboard 
after you open a new chapter. This allows you to copy text, frames, 
graphics, or paragraph tags between chapters or style sheets. 

Text, frames and graphics 

~ Cut or copy the text, graphic, or frame. 

~ Save the chapter. 

~ Open the new chapter. 

~ Go to the page on which you want the text, frame or graphic to appear 
and click on the Paste function button, or press the Insert key. 
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Tags 

~ Click on the Paragraph tool button. 

~ Select a paragraph whose tag you wish to copy. To copy several tags, 
hold either Shift key and select multiple paragraphs. Each of the tags 
used by the selected paragraphs will be copied. 

~ Click on the Cut or Copy function button. Both of these buttons 
perform the same function with tags. Clicking on the Cut function 
button will not delete the tag name or attributes from the style sheet. 

~ Load another chapter that uses the style sheet to which you want to 
copy the tag. 

~ Click on the Paste function button. The tag name and attributes are 
copied to the style sheet. 

~ Click on the Save Style As function button to save the style sheet 
under another name, or click on the Save function button to save the 
chapter (and the style sheet). 

When copying tags to another style sheet, you should open a chapter 
using the style sheet to which you want to copy the tag instead ofloading 
the style sheet into your current chapter. Loading the style sheet into 
your current chapter will cause all tag names used in the currently 
loaded text file to be copied to the style sheet that you load. These tag 
names will have the same attributes as the Body Text tag in the loaded 
style sheet unless the tag name was previously defined in the style 
sheet. 

Import from You can import and export ASCII text, and import metafiles (line art) 
other and bitmapped images from other Windows applications through the 

applications Windows clipboard. 
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Many Windows applications have the capability of copying data to the 
clipboard as OLE objects. Data copied to the clipboard from an OLE 
capable application will always be pasted into Ventura Publisher as an 
embedded object when the Paste function button is selected. Addition­
ally, data copied to the clipboard from most Windows applications can 
be pasted in more than one format. The Paste option will always paste 
the data using the highest level format. 

The Paste option in the Edit menu will dynamically change wording to 
indicate the highest level of format of the data currently on the clip­
board. Additional format options may be available in the Paste Special 
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option dialog box. Refer to the Paste Special option section starting on 
page 6-17 for information on using the Paste Special option. 

Paste ASCII Text 

To copy ACSII text from another Windows application: 

> Switch to the other application. 

> Cut or copy the desired text. 

> Switch to Ventura Publisher. 

> Select the base page or a frame into which you wish to place the text. 

> Click on the Paste function button. 

The other application must save the text onto the clipboard in ASCII 
format in order to successfully import it into Ventura Publisher. 

Paste Bitmap and Paste Metafile 

To copy Windows metafiles (line art) or bitmapped images from other 
Windows applications: 

> Switch to the other application. 

> Cut or copy the image. 

> Switch to Ventura Publisher. 

> Select a frame into which you wish to place the image. 

> Click on the Paste function button. The Save File As dialog box 
(Figure 6-2) is displayed. 

Ventura Publisher will automatically detect the format of the data on 
the clipboard. When you paste a metafile or bitinapped image from the 
clipboard into Ventura Publisher, a file is created and automatically 
loaded as if the file was loaded using the Load. TextlPicture option. 
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Figure 6-2. Save File As dialog box for bitmapped images pasted from the 
Wzndows clipboard. 

~ Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the image to be saved. When the name 
of the destination directory is shown in the Directories list box, 
enter a file name for the image in the File Name entry field and click 
on the OK button. If you want the image to be saved over a previously 
saved image, select the file name of the previously saved image file in 
the File Name list box and click on the OK button, or double-click on 
the image file name. 

The default extension for bitmapped images is IMG. The default file 
extension for metafile line art images is WMF. The default extension 
will be added if no extension is specified in the File Name entry field. 

If the name selected for the image is the same as that of a previously 
saved image, the following alert is displayed. 

~ Click on the New Name button to re-display the Save File As dialog 
box and select a different file name for the image. Click on the 
Overwrite button to save the image over the previously saved image 
file. The image file is created and the image automatically loaded in 
the chapter and into the specified frame. 
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Paste Object 

The Paste Object option pastes the OLE object currently on the clip­
board into the Ventura Publisher chapter as an embedded object. To 
paste the item on the clipboard as a linked object use the Paste Link 
option described later in this chapter. To paste the item on the clipboard 
in another format use the Paste Special option described later in this 
chapter. 

~ Refer to Appendix K for more information on working with OLE objects. 

~ Switch to the other application. 

The original server file from which the object was copied must be saved 
in the server application before the object can be linked to the Ventura 
Publisher chapter. 

~ Cut or copy the object. 

~ Switch to Ventura Publisher. 

~ Click on the Selector tool button and select a frame into which you 
wish to place the object. 

~ Click on the Paste function button. The Save File As dialog box 
(Figure 6-3) is displayed. 

If this dialog box does not appear, or the dialog box indicates that the file 
will be saved as an IMG or WMF file, the data on the clipboard is not an 
OLE object. To verify the data type of the data on the clipboard, use the 
Paste Special option to view the data types available for the data on 
the clipboard. 
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Figure 6-3. Save File As dialog box for OLE object (VPO) files. 

~ Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the object file to be saved. When the 
name of the destination directory is shown in the Directories list 
box, enter a file name for the object file in the File Name entry field 
and click on the OK button. If you want the object file to be saved over 
a previously saved object file, select the file name of the previously 
saved object file in the File Name list box and click on the OK button, 
or double-click on the object file name. 

The default extension for object files is VPO. The default extension will 
be added ifno extension is specified in the File Name entry field. 

If the name selected for the object file is the same as that of a previously 
saved object file, the following alert is displayed. 

~ Click on the New Name button to re-display the Save File As dialog 
box and select a different file name for the object file. Click on the 
Overwrite button to save the object over the previously saved object 
file. 
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The Paste Link option is used to paste an OLE object on the clipboard 
as a linked object. 

To paste an object as an embedded object use the Paste Object or Paste 
Special options. To paste an OLE object in a different format (e.g., 
bitmap, metafile) use the Paste Special option. 

Refer to Appendix K for examples and more information on working 
with OLE objects. 

Operation 

The Paste Link option is available only when an object on the clipboard 
was copied from an application with OLE capabilities. This option will 
paste the OLE object into your chapter as a linked object. 

The original server file from which the object was copied must be saved 
in the server application before the object can be linked to the Ventura 
Publisher chapter. 

> Click on the Selector tool button and select the frame in which object 
will be pasted. 

> Select the Paste Link option from the Edit menu. The Save File As 
dialog box (Figure 6-4) is displayed. 

6-15 



L:;LlI I IVICI'oIU 

6-16 

Paste Link 

Figure 6-4. Save File As dialog box for OLE object (VPO) files. 

~ Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the object file to be saved. When the 
name of the destination directory is shown in the Directories list 
box, enter a file name for the object file in the File Name entry field 
and click on the OK button. If you want the object file to be saved over 
a previously saved object file, select the file name of the previously 
saved object file in the File Name list box and click on the OK button, 
or double-click on the object file name. 

The default extension for object files is VPO. The default extension will 
be added ifno extension is specified in the File Name entry field. 

If the name selected for the object file is the same as that of a previously 
saved object, the following alert is displayed. 

~ Click on the New Name button to re-display the Save File As dialog 
box and select a different file name for the object file. Click on the 
Overwrite button to save the object over the previously saved object 
file. 
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The Paste Special dialog box allows you to specify in what format the 
item on the Windows clipboard is pasted. Ventura Publisher will auto­
matically detect all formats available and will display these formats in 
the Paste Special dialog box. Use this option to select alternative 
formats for data pasted from the clipboard. 

Operation 

~ Copy or cut data from another Windows application to the clipboard. 

~ Switch to Ventura Publisher. 

~ Create or select a frame in which to paste the clipboard item. 

~ Click on the Paste Special option from the Edit menu. The Paste 
Special dialog box (Figure 6-5) is displayed. 

Figure 6-5. Paste Special dialog box. Dialog box shows the image on the 
chpboard will be pasted as a linked object. 

Source The Source field tells you from which application the data currently on 
the clipboard originated. 

Document The Document field tells you from which file the data currently on the 
clipboard originated. 
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Item The Item field describes the data currently on the clipboard. This 
information may be screen coordinates if the object was copied from a 
paint program, row and column coordinates if the object was copied from 
a spreadsheet, or other data pertinent to the server application being 
able to identify the object when it is edited. 

Data Type The Data Type list shows the available formats for the data currently 
on the clipboard. Select the desired format in which the data on the 
clipboard should be pasted. 

Paste and Paste The Paste and Paste Link buttons will be available only after a format 
Link is selected from the Data Type list box. The button available for 

selection is dependent on which format is selected from the Data Type 
list box. 
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For OLE objects, the original server file from which the object was 
copied must be saved in the server application before the object can be 
linked to the Ventura Publisher chapter. 

If the data currently on the clipboard originated from an application 
having OLE capabilities, the Embedded Object and Linked Object 
options will be displayed in this list. If the Linked Object format is 
selected, the data currently on the clipboard can be linked to the chapter 
by selecting the Paste Link button (available only when the Linked 
Object data type is available and selected). If the Embedded Object 
format is selected, the data currently on the clipboard can be pasted into 
the chapter as an embedded OLE object by selecting the Paste button. 

~ Refer to Appendix K for more information on working with OLE objects. 
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The Update Counters option allows you to reset the chapter, page, 
table, and figure counters at any point in a chapter. It also allows you to 
automatically link page, table, or figure counters across chapter boun­
daries. 

The counter numbering format can be set to Arabic numerals (1, 2, 3 ... ), 
Roman numerals, letters (A, B, C ... ), or text (One, Two, Three ... ). 

Use this option to: 

• Override automatic numbering for a given page, figure, or table. 

• Number book introductions, table and figure numbering, or appen­
dices using different number styles. 

• Consecutively number large books and technical manuals across 
chapter boundaries. 

Operation 

You can change counters in one of two ways: 

• Set the counter for the chapter, initial page, initial table or initial 
figure. Do this to link the current chapter with a previous chapter 
during a Manage Publication dialog box Renumber option. 

• Override and reset the counter for this page, table or figure. Do this 
to change the numbering sequence within a chapter. 

Set the initial To set the counter for the chapter, or the initial page, initial table or 
counter initial figure, follow these directions. 

~ If no initial counter is set, the default is one, in Arabic format (e.g., 1). 

> Select the Update Counters option in the Edit menu. The Update 
Counters dialog box similar to that shown in Figure 6-6 will appear. 
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Figure 6-6. Update Counter dialog box. Page numbering set to restart on this 
page. 

> Select the desired Which Counter option. 

> To start counting at one, numbered in Arabic (e.g., 1, 2, 3, ... ), do 
nothing. You don't need to make a selection. 

> To automatically continue numbering from the previous chapter, 
select the Previous Number + 1 option. Note that the actual num­
bering across chapters takes effect only when you select the Renum­
ber option in the Manage Publication option dialog box (File 
menu). 

> To start counting at a number other than one, or to change the number 
format, select the Restart Number option. 

- Enter the starting number in the Restart Number entry field. 

- Select the desired option from the Number Format list box. 

> Repeat the last three steps, if necessary, for the remaining initial 
counters, and then click on the OK button. 

Reset counter You can select any frame or page and override the counter and number 
for this table, format. To change either table or figure numbering format: 

figure 
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> Click on the Selector tool button and then select the frame whose 
caption you wish to renumber. 

> Select the Update Counters option in the Edit menu. Select the 
This Table, or This Figure option. (Note: This Table and This 
Figure options will not be available unless you select a frame prior 
to selecting the Update Counters option.) 

> Select the Restart Number option. 

> Enter the starting Restart Number. 



Update Counters 

~ Select the Number Format. 

~ Click on the OK button. 

Reset page or ~ Go to the page on which you want renumbering to start. 
chapter 

numbering ~ Select the Update Counters option in the Edit menu (see Figure 
6-6). Select This Page. 

~ Set the Update Method option to Restart Number. 

~ Enter the starting number in the Restart Number entry field. 

~ Select the desired option from the Number Format list box. 

~ Click on the OK button. 

To override the Restart Number option, select the frame or page and 
then select the Previous Number + 1 option. 

The Restart Number option is attached to the selected page or frame. 
If you move the selected frame to another page, the number will restart 
at the new frame location. Similarly, if text is moved to another location 
due to the editing process, the page number will still restart on the 
original page. 
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Re-Anchor Frames 
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The Re-Anchor Frames option moves every frame in the chapter to the 
page on which its anchor appears. You can also choose to move only those 
frames that are located on the current page. Use this option to move 
frames to anchor points in the text. 

Operation 

Refer to the Anchors & Captions option section in the Frame menu 
chapter. If the name of the frame anchor you specified through the 
Anchors & Captions option matches a frame anchor in the text, 
selecting the Re-Anchor Frames option causes the associated frame to 
move to a new location. 

~ Select the Re-Anchor Frames option in the Edit menu. The follow­
ing alert is displayed. 

~ Click on the This Page button to re-anchor the frames on the 
currently displayed page only. Click on the All Pages button to 
re-anchor the frames throughout the chapter. Click on the Cancel 
button to cancel the operation. 

If the anchor name in the text does not match an anchor name given to 
a frame, Ventura Publisher displays the following error message. 



Re-Anchor Frames 

If you click on the Ignore button, Ventura Publisher will ignore the 
error and continue with the re-anchoring. If you click on the Rename 
button, Ventura Publisher will display the InsertJEdit Anchor dialog box 
and allow you to rename the frame anchor the in text. If you click on the 
Delete button, the frame anchor will be deleted from the text. 
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Renumber Chapter 
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The Renumber Chapter option updates the numbering of paragraphs 
defined in the Auto-Numbering option. Use the Renumber Chapter 
option after you have edited your document to renumber the entire 
chapter according to the Auto-Numbering option dialog box (Para­
graph menu) settings. 

Operation 

Select the Renumber Chapter option in the Edit menu, or press 
Ctrl+B. The entire chapter is then renumbered. Select the Renumber 
Chapter option any time you want to update section numbering. 

Section numbers are not added, deleted or modified during text editing 
or paragraph tagging. You must select the Renumber Chapter option 
to update section numbers. 

Section numbers are not saved in the text file. Instead, they are 
regenerated each time you load the chapter. 
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Set Preferences 

The Set Preferences option allows you to: 

• Show or hide tags in the Tags list for generated text (e.g., captions). 

• Control the size below which text is greeked. Greeking is described on 
the next page. 

• Choose whether to create backup files. 

• Turn screen kerning on or off. 

• Choose whether to adjust the inter-line spacing when you change 
fonts sizes. 

• Convert inch marks and hyphens into their typographic equivalents. 

• Change the tab-align character for decimal numbers. The US uses the 
period, Europe uses the comma. 

Operation 

Select the Set Preferences option. The Set Preferences dialog box 
(Figure 6-7) is displayed. 

Figure 6-7. Set Preferences dialog box. 

Hide generated Set the Generated Tags option to Hidden to reduce the number of tags 
tags shown in the Tags list. Since generated text tags are automatically 
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Greeking 

Backup files 
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Set Preferences 

assigned to headers, footers, section numbers, etc., you don't need to see 
them in the Tags list. 

The word greeking describes the practice in the graphics art industry of 
quickly drawing horizontal lines on a page to approximate how a real 
page of text will look. Ventura Publisher uses greeking to speed up the 
time required to redraw the screen when displaying either a Reduced 
or Facing Pages View. Select larger numbers to display only the 
largest text as readable text. Select smaller numbers to display much 
smaller text as readable text. The numbers in the list box refer to the 
screen pixel height of the font. 

Depending on the resolution of your display, text below a certain size 
may not be readable in Reduced or Facing Pages View when greek­
ing is completely turned off. This is normal. 

Set the Keep Backup Files option to Yes to create style sheet, chapter, 
and text backup files each time you save a chapter. Backup files have 
the same name as the original, with the first letter of the extension 
changed to $. Unless your hard disk is almost out of space, you should 
always set the Keep Backup Files option set to Yes. 

Using backup files 

If you ever need to use your backup files, you should take every step 
possible to preserve your information. Therefore, the following proce­
dure is recommended: 

~ If the original chapter file is still available and can be read, use the 
Manage Publication option dialog box Copy All option to copy this 
chapter to a floppy disk before attempting to retrieve the backup 
version of the chapter. 

~ Minimize Ventura Publisher using the minimize button. 

~ Double-click on the DOS Prompt icon in the Main window. 

~ Go to the drive and directory containing the chapter file and then use 
the DOS RENAME command to rename the backup files to their 
original names (e.g., without the $ in the extension). For example: 

RENAME &BOOK-Pl.$HP &BOOK-Pl.CHP. 

You must delete the original files before the RENAME command will 
let you rename the files. 
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~ Do not delete any original file without first copying it to a floppy disk. 

On-screen When you set the Automatic Pair Kerning option in the Paragraph 
kerning Typography option dialog box to On, the change in the space between 

letters is shown on the screen as well as on the printed output. However, 
the additional calculations necessary to adjust the space between each 
character take additional time and, therefore, slow down the screen 
drawing speed. Also, because of the relatively limited resolution of the 
computer screen, the subtle differences provided by kerning may not be 
noticeable at small font sizes (e.g., less than 18 points). Therefore, to 
provide optimum performance, you can choose whether to show kerning 
on the computer screen. 

To show kerning on-screen, select the minimum font size you wish to 
kern. All characters equal to or above the font size chosen will be kerned. 
18 or 24 point are typical font sizes to choose. 

If kerning is turned on in the Paragraph Typography option dialog 
box, and if the printer fonts provide kerning information (refer to 
Appendix 1), the printed output will always be kerned, regardless of 
whether you select on-screen kerning. 

Auto Whenever you change a tag's font size, the font's line attributes, super-
adjustments script font, subscript font, small font, above, below, inter-line, and 

inter-paragraph spacing for that font increase or decrease automat­
ically. Thus, if the font was originally 12 points with 14 point Inter-Line 
spacing, and you increase the font size to 24 point, the Inter-Line 
spacing is automatically increased to 28 points. If you don't want these 
options automatically adjusted, set the Auto-Adjustments option to 
None. 

Quote and em dash conversion 

Word processors and typewriters use inch marks (") instead of typo­
graphic open and close quotation marks (" "), and two hyphens (- -) 
instead of an em dash (-). Ventura Publisher allows you to continue to 
use these conventions within your word processor, then automatically 
convert them into their correct typographic equivalents whenever you 
load text using the Load TextlPicture option. To enable this conversion, 
select the" and - option from the Auto-Adjustments list box. You can 
also enter em dashes (as well as en dashes) and open and close quotes 
directly in Ventura Publisher using the Alt key and ANSI characters. 
Refer to the Toolbox chapter for details. 
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Once converted, em dashes and open/close quotes are not converted back 
into their typewriter equivalents when the text is saved back to the word 
processor file. 

The quotation mark conversion algorithm works on a paragraph basis. 
The first inch mark encountered which either starts a paragraph or is 
preceded by a space is converted to an open (beginning) quotation mark. 
The next inch mark is converted to a close quotation mark, unless a 
numeral precedes it. This allows you to still use inch marks as they were 
originally intended, e.g., 7" means seven inches. 

Set the Auto-Adjustments option to Both if you want both the typo­
graphic and style conversions. 

Apostrophe Certain printers cannot print typographic apostrophes (' and ') and 
mapping quotes (" and "). When printing from Ventura Publisher to one of these 

printers (e.g., HP LaserJet+) the apostrophe or quotes will not appear 
in the text. 

Setting the Apostrophe Mapping option to Unmapped allows you to 
convert the typographic apostrophe and quotes to non-typographic 
apostrophe ( , ) and quotes (") when printing to a printer not capable of 
printing the typographic equivalent. 

Decimal tab One of the choices in the Tab Settings option dialog box (Paragraph 
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character menu) is decimal tab. When selected, the text aligns at the first decimal 
point in the text. Ventura Publisher initially assumes that the period is 
used as the decimal point. However, European countries use the comma 
instead. Refer to Appendix E and enter the decimal (ASCII) value in the 
Decimal Tab Char entry field for the character you wish to use as a 
decimal point. (The comma is decimal value 44.) 

This option also allows you to set the decimal tab character to a slash 
(I), an equal sign (=) or other character to force alignment around some 
other character. 
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Spell Check 

EDIT MENU 

Click on the Spell Check function button to check the spelling of all text 
and captions, specified text files, or selected text in the currently loaded 
chapter. 

Operation 

Click on the Spell Check function button. The Spell Check dialog box 
(Figure 6-8) is displayed. 

Figure 6-8. Spell Check dialog box. 

Entire Chapter The Entire Chapter option will check the spelling of all text in the 
chapter including frame text, box text, and text entered into caption 
frames. This option is particularly useful for final spell checking of a 
document containing modified text files imported from different sources. 

Check Captions The Check Captions option will check the spelling of frame text, box 
text, text entered into caption frames, and footnotes only. 

The spelling of text entered into dialog boxes such as the Headers & 
Footers, Anchors and Captions, and Equations dialog boxes cannot be 
checked. 

Check [filename] The Check [filename] (the name of the currently selected file will be 
displayed) option will check the spelling of the currently selected text 
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file. A text file is selected by placing the typing cursor in the text file or 
selecting a portion of the text in the text file using the Text tool, selecting 
a paragraph of the text file with the Paragraph tool, or selecting the text 
file frame with the Frame tool prior to selecting the Spell Check option. 
This option is particularly useful for checking the spelling of a newly 
imported text file that may not have been spell checked in the original 
word processor. 

Selection Range The Selection Range option is available only if a range of text is 
selected using the text cursor prior to the Spell Check option being 
selected. This option will check the spelling of the selected range of text 
only. This option is particularly useful for quickly verifying a single 
word, or spell checking a modified section of text. 

Choose File The Choose File option allows you to spell check one or more files, 
including the caption file, from the currently loaded chapter. When 
selected the Choose File dialog box (Figure 6-9) is displayed. 
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Figure 6-9. Choose File dialog box. 

The files list displays the file names of all text files imported into the 
currently loaded chapter. One or more of these files can be spell checked 
by selecting the file name from the file list. To deselect a specific file 
name, simply click on the selected file name. 

All Files 

The All Files option simply selects all imported text files for spell 
checking. This option is equivalent to selecting the Entire Chapter 
option in the Spell Check dialog box. 
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Modified Files 

The Modified Files option selects only those text files that have been 
modified since the chapter was opened or last saved, whichever occurred 
last. 

Deselect All 

The Deselect All option deselects all selected file names in the file list. 

Check Captions 

The Check Captions check box can be used in conjunction with the 
other options in this dialog box to include box text, captions, and frame 
text in the spell check. Using this option alone is equivalent to selecting 
the Check Caption option in the Spell Check dialog box. 

Performing a spelling check 

The spelling check begins when you click on either the OK button in the 
Spell Check dialog box or the Check button in the Choose File dialog 
box. 

If the text does not contain suspected misspellings, or the spell checker 
is finished checking the selected text, the following alert is displayed. 

Click on the OK button to return the Ventura Publisher main screen. 

When the spell checker locates a suspected misspelled word, the Check 
Spelling dialog box (Figure 6-10) is displayed. This dialog box allows you 
to correct or otherwise act on the suspected misspelled word. 
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Figure 6-10. Check Spelling dialog box. All spelling corrections are made using 
thzs dialog box. 

Context The context is a short string of text surrounding the suspected misspell­
ing. The context of a sentence can aid in determining whether the word 
is a spelling error or a correctly spelled word that is unknown to the 
spelling dictionary. 

Unknown Word The Unknown Word field displays the word that is suspected of being 
misspelled. This field is a display field only, and cannot be edited. A 
particular word will be displayed in the Unknown Word field under 
one or both of the following conditions. 
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• The word, as spelled, was not found in the Houghton-Mifflin or the 
personal dictionary. 

• The capitalization of the word did not match that of a word found in 
either the Houghton-Mifflin or the personal dictionary. 

A word containing special items (e.g., index entry, thin space, etc.) 
within the word, and words containing a slash (e.g., DDE/OLE) may 
appear as misspelled because the spell checker cannot differentiate be­
tween the word and the special item embedded within the word. The 
spell checker will view each part of the word on either side of the special 
item as a whole word. The spell checker will, however, bypass anyat­
tribute codes embedded within a word. Also, the text inside of a special 
item code (e.g., frame anchor code, index code) will not be spell checked. 
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Change To The Change To entry field is used to specify the correct spelling that is 
to be used for a misspelled word. Words are entered into the Change To 
entry field either by selecting a word from the suggestion list box, or by 
typing a word directly into the Change To entry field. 

Suggestion list 
box and the 

Guess button 

The initial entry in the Change To entry field will be the first word in 
the suggestion list box. If the spell checker can not determine any 
spelling suggestions, the suspected misspelled word itself will be dis­
played in the Change To entry field. 

The suggestion list box (located to the right of the Guess button) 
displays suggested spelling corrections for the suspected misspelled 
word. The suggested spelling corrections are derived from the 
Houghton-Mifflin look-up dictionary and list correctly spelled words 
that are similar to the suspected misspelling. If available for selection 
(not grayed), click on the Guess button to broadened the look-up algo­
rithm in order to include more suggested spelling corrections in the 
suggestion list. 

Since the words found in the personal dictionary tend to be unique words 
and are time consuming to correctly search, the spell checker does not 
search the personal dictionary for possible words to add to the sugges­
tion list box. 

To use one of the suggested spelling corrections from the list, simply 
select the word to be used from the suggestion list. The selected word 
will be placed in the Change To entry field. 

Add to personal The Add to personal dictionary option allows you to "teach" the spell 
dictionary checker words that are not already in the personal or look-up dic­

tionaries. When the spell checker identifies a correctly spelled word as 
a possible misspelling, you can add the word to a personal dictionary 
using the Add to personal dictionary check box. This allows you to 
add words that are unique to your subject of writing to the personal 
dictionary. 

The Add to personal dictionary option also allows you to correct the 
spelling of a misspelled word, if necessary, and then add the corrected 
word to the dictionary if it does not appear in the suggestion list. 

The word added to the personal dictionary when the Add to personal 
dictionary check box is checked is dependent on whether the Change 
or the Skip button is selected. 
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Change/Change 
All 

Skip/Skip All 

Spell Check 

If the Add to personal dictionary check box is checked and you click 
on the Change or Change All button, the word entered in the Change 
To entry field will be added to the personal dictionary. 

If the Add to personal dictionary check box is checked and you click 
on the Skip or Skip All button, the word in the Unknown Word field 
will be added to the personal dictionary. 

If the Add to personal dictionary check box is cleared, neither word 
will be added to the personal dictionary. 

Click on the Change button to substitute the word displayed in the 
Unknown Word field with that displayed in the Change To entry 
field. The Change button is used to correct only the single occurrence 
of the word. To change all occurrences in text of the word displayed in 
the Unknown Word field, click on the Change All button. 

If the Add to personal dictionary check box is checked, the word 
displayed in the Change To entry field will be added to the personal 
dictionary when either the Change, or the Change All button is 
selected. 

If the Change All button is selected for a particular word, the spelling 
check must be allowed to check the entire text in order to replace all 
occurrences of the word. If the spelling check process is aborted using 
the Done button, any occurrences of the word for which the Change All 
was selected appearing after the point at which the Done button was 
selected will not be changed. 

Click on the Skip button to continue with the spelling check without 
performing any corrections to the word displayed in the Unknown 
Word field. The Skip button will bypass a single occurrence only. To 
bypass all other occurrences of the word in the chapter, click on the Skip 
All button. 

If the Add to personal dictionary check box is checked, the word 
displayed in the Unknown Word field will be added to the personal 
dictionary when either the Skip, or the Skip All button is selected. 

Done Click on the Done button to stop the spelling check. Any spelling 
corrections made up to the point the Done button is selected will not be 
undone. 
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The spelling corrections made during a search and replace can only be 
undone using the Revert to Saved option in the File menu to load the 
chapter as it was last saved before the search and replace. 

Editing"the personal dictionary 

The personal dictionary is an ASCII text file saved in the VENTURA 
directory containing the other Windows version Ventura Publisher files, 
or your preferences directory if you are running Ventura Publisher from 
a network. The personal dictionary file, named SPLDICT.PD, can be 
edited using a text editor capable of opening and saving files in ASCII 
format (such as Windows NOTEPAD). 

Opening and saving the SPLDICT.PD file in a format other than ASCII 
will cause incorrect spell checking. 

You can edit the words in the personal dictionary as well as add or delete 
words using the text editor. Since the spell checker will also check for 
proper capitalization of a word, all acceptable capitalization variations 
of a word should be entered into the personal dictionary. 

If you want to start with an empty personal dictionary file, open the 
SPLDICT.PD file and remove all the words. Do not delete the 
SPLDICT.PD file as you will not be able to add words to the dictionary 
file if it does not exist. If the SPLDICT.PD file is inadvertently deleted, 
simply create a new SPLDICT.PD file in the VENTURA directory if you 
are using Ventura Publisher on a stand-alone system, or in your 
preferences directory if you are running Ventura Publisher on a net­
work. 

The following is an example of how the personal dictionary file may 
appear. 

malleable 
PhotoTouch 
Ventura 
VENTURA 
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Spell Check 

Each word in the personal dictionary must be entered on a separate line. 
Also, the personal dictionary file should end with a blank line. 

Notice that Ventura appears twice in the previous example. This allows 
you to specify that the word can appear in text with the initial letter 
capitalized as well as with all letters capitalized (such as in a headline). 
In the above example, Ventura will appear as a misspelling any time it 
is spelled incorrectly or the capitalization differs from initial capitaliza­
tion or all uppercase (e.g., ventura, VenTura). 
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Search & Replace 

Click on the Search & Replace function button to locate and optionally 
replace text, text attributes, and paragraph tags in the currently loaded 
chapter. Additionally, you can search for special items that have been 
inserted into the text of the chapter. The options available in the Search 
and Replace dialog box allow you make the search subject as broad or 
specific as necessary. 

Search and replace can only be performed on that text which is visible 
in the chapter. If a text file continues past the end of a frame without 
flowing into another frame, you cannot search and replace in the text 
continuing past the end of the frame. 

Operation 

Click on the Search & Replace function button. The Search and 
Replace dialog box (Figure 6-11) is displayed. 

Figure 6-11. Search and Replace dialog box in Text/Attributes mode. 

The operation of the Search and Replace dialog box is divided into three 
modes; search and replace text or text attributes, search and replace 
tags, and search for special items. These modes are controlled by select-
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ing either the Text/Attributes, Tags, or Special Items options at the 
top of the Search and Replace dialog box. 

Text! Attributes mode 

When the Text/Attributes mode option is selected, the dialog box 
shown in Figure 6-11 is displayed. The following options are available 
for performing a search or search and replace of text or text attributes 
in the chapter. 

The Search & Replace option is capable of locating and optionally 
replacing text and text attributes in text imported into Ventura Publish­
er, text entered into frames or on the base page from within Ventura 
Publisher, box text, and text entered into caption frames. The Search 
& Replace option cannot be performed on footnotes, equations, and text 
entered as labels in a dialog box such as that entered into the Headers 
and Footers dialog box. 

Header and footer text generated using the 1st Match and Last Match 
options in the Headers and Footers dialog box will be affected as the 
corresponding text in the chapter is searched and replaced. 

Search For and The Search For entry field allows you to enter a specific text string for 
Replace With which to search. 
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Ventura Publisher attribute and special item codes cannot be used in the 
Search For or Replace With entry fields. Use the Search Attributes 
and Replace Attributes options to search and replace text attributes 
or the Special Items mode option to search for special items. 

The Replace With entry field allows you to enter replacement text for 
the text entered in the Search For entry field. If the text entered in the 
Search For entry field is found after you click on the Replace button, 
the search text will be replaced with the text entered in the Replace 
With entry field. 

If replaced, any text found matching the specified Search For options 
will be replaced with the text in the Replace With entry field exactly 
as it was entered in the field, regardless of the capitalization of the 

. matching text, or the capitalization of the text in the Search For entry 
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field. Ifno text is entered in the Replace With entry field, the matching 
text will be deleted. 

Search The Search Attributes check boxes allow you to specify attributes for 
Attributes and which to search. Ifno text is entered in the Search For entry field, text 

Replace containing the selected Search Attributes options will be located. If 
Attributes text is entered in the Search For entry field, selecting any of the 

Search Attributes options will reduce the scope of the search to 
locating only the search text having attributes matching those selected 
in the Search Attributes options. 

The Replace Attributes options allow you to specify attributes to be 
applied to text when the Replace button is selected. 

Checking the Normal check box clears all other Replace Attributes 
check boxes, and will convert any text matching the specified Search 
For options to the setting of the paragraph tag in which the text resides. 
This option is similar to using the text tool to highlight a string of text 
and then selecting the Text tool Normal option button. The exception to 
this is if a typeface is selected from the Font list box. In this case all style 
attributes will convert to that of the paragraph tag in which the match­
ing text resides, but the typeface of the replacement text will the 
typeface selected from the Font list box. 

Fonts list box The Fonts list box allows you to add typeface attributes to the Search 
Attributes and Replace Attributes options. 

To include typefaces in the Search Attributes and Replace At­
tributes options, simply select the desired typeface name from the 
corresponding Font list boxes. Selecting the Default option from the 
Search Attributes option Font list box will cause the search to locate 
the text entered in the Search For entry field regardless of the typeface 
assigned to that text. Selecting a typeface from the Font list box will 
reduce the scope of the search to locating only that text matching the 
text entered in the Search For entry field and assigned the typeface 
selected from the Font list box. 

Match The Match UpperILower Case check box determines whether the 
Upper/Lower search will locate text matching the capitalization of the text entered in 

Case the Search For entry field, or if the case will be ignored. If checked, the 
search will locate that text which exactly matches the capitalization of 
the text entered in the Search For entry field. If cleared, the case of the 
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text entered in the Search For entry field will be ignored during the 
search. The Replace With text is not affected by this option. 

If replaced, any text found matching the specified Search For options 
will be replaced with the text in the Replace With entry field exactly 
as it was entered in the field, regardless of the setting of the Match 
UpperlLower Case check box, the capitalization of the matching text, 
or the capitalization of the text in the Search For entry field. 

Confirm Replace The Confirm Replace check box allows you to control the progress of 
the search and replace. 
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This option is applicable only when the Replace button is selected and 
has no affect when the Search button is selected. 

If the Confirm Replace check box is cleared, the search and replace 
will be performed without any user intervention. All text elements 
matching the specified Search For options will be automatically 
replaced with the selected Replace With options. 

To ensure that only whole words are found and replaced, enter a space 
before and after the word entered in the Search For entry field. Other­
wise text that is part of a word may be replaced with the text entered in 
the Replace With entry field. For example, if you search and replace 
the word mate (without spaces) with the word spouse, the word amal- . 
gamate would automatically be changed to amalgaspouse. 

If the Confirm Replace check box is checked and matching text 
elements are found, the page containing the matching text element is 
displayed, the text element is highlighted, and the following dialog box 
is displayed. 
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If the highlighted text is obscured by the alert, the alert window can be 
moved by clicking on the alert window title bar and dragging it to a 
convenient location. 

Click on the Done button to stop the search and replace operation. Any 
replacements made up to the point the Done button is selected will 
remain. 

Click on the Skip button to continue the search and replace operation 
without affecting the highlighted text or paragraph. 

Click on the Replace button to replace the highlighted text or para­
graph with the selected Replace With options specified in the Search 
and Replace dialog box. 

Search from The Search from Start of Chapter option check box determines 
Start of Chapter where the search will begin. This option is applicable to both the search 

and the search and replace operations. 

The search function searches through the chapter page by page. The text 
elements (e.g., box text, text file frame, frame caption, etc.) on each page 
are searched in the order in which the page elements where created on 
the individual page. 

If the Search from Start of Chapter check box is checked, the search 
will start at the beginning of the chapter and proceed through the 
chapter page by page to the last text element placed on the last page of 
the chapter. 

If the Search from Start of Chapter check box is cleared, the search 
will begin at the location of the text cursor if the Text tool is selected and 
the typing cursor placed in text, the currently selected frame or box text 
if the Frame tool is selected, or the currently selected paragraph if the 
Paragraph tool is selected. If nothing on the current page is selected, or 
if the base page is selected, the search will begin with the first text 
element created on the current page and proceed through the chapter 
page by page to the last text element placed on the last page of the 
chapter. 

Clear Click on the Clear button to clear all the settings in the Search and 
Replace dialog box. 
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Cancel Click on the Cancel button to exit the dialog box abandoning all changes 
made in the dialog box. 

Search Click on the Search button to begin the search for text elements 
matching the specified Search For options. The search will only locate 
text elements matching the specified Search For options. None of the 
Replace With options are applicable when the Search button is 
selected. 

When a text element matching the specified Search For options is 
found, the page containing the text element is displayed, the text 
element is highlighted, and the following dialog box is displayed. 

If the highlighted text is obscured by the alert, the alert window can be 
moved by clicking on the alert window title bar and dragging it to a 
convenient location. 

Click on the Done button to stop the search leaving the last text element 
match highlighted. 

Click on the Continue button to continue the search for other text 
elements matching the specified Search For options in the Search and 
Replace dialog box. 

When the search has reached the end of the chapter, the following dialog 
box is displayed. 

Click on the OK button to return to the Ventura Publisher main screen. 
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Replace Click on the Replace button to begin the search and replace operation. 
When selected, a search is performed for text elements matching the 
Search For options. 

If matching text elements are found and the Confirm Replace check 
box in the Search and Replace dialog box cleared, the specified Replace 
With options will automatically be applied to the text elements. 

If a matching text element is found and the Confirm Replace check 
box is checked, the page containing the matching text element is dis­
played, the text element is highlighted, and the following alert is dis­
played. 

eonfirm Replace 

If the highlighted text is obscured by the alert, the alert window can be 
moved by clicking on the alert window title bar and dragging it to a 
convenient location. 

Click on the Done button to stop the search and replace operation. Any 
replacements made up to the point the Done button is selected will 
remain. 

The changes made during a search and replace can only be undone using 
the Revert to Saved option to load the chapter as it was last saved 
before the search and replace. 

Click on the Skip button to continue the search and replace operation 
without affecting the highlighted text or paragraph. 

Click on the Replace button to replace the highlighted text element 
with the Replace With options specified in the Search and Replace 
dialog box. 

If replaced, any text found matching the specified Search For options 
will be replaced with the text in the Replace With entry field exactly 
as it was entered in the field, regardless of the capitalization of the 
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matching text, or the capitalization of the text in the Search For entry 
field. 

When the search and replace has reached the end of the chapter, the 
following alert is displayed. 

Click on the OK button to return to the Ventura Publisher main screen. 

Tags mode 

When the Tags mode option is selected, the dialog box shown in Figure 
6-12 is displayed. The following options are available for the searching, 
or searching and replacing of paragraph tags in the chapter. 

Figure 6-12. Search and Replace dialog box in Tags mode. 

Search For and The Search For tag list is used to select a tag name for which to search. 
Replace With The Replace With tag list is used to select a replacement tag for the 

search tag if the Replace button is selected. 
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The names of generated tags (e.g., Z_BOXTEXT) will be displayed in the 
Search and Replace dialog box tag lists only if the Generated Tags 
option in the Set Preferences dialog box is set to Shown. If the 
Generated Tags option is set to Hidden, generated tags will not be 
displayed in the Search and Replace dialog box tag lists. 

Confirm Replace The Confirm Replace check box allows you to control the progress of 
the search and replace. 

This option is applicable only when the Replace button is selected and 
has no affect when the Search button is selected. 

If the Confirm Replace check box is cleared, the search and replace 
will be performed without any user intervention. All paragraphs with 
the specified Search For tag will be automatically replaced with the 
selected Replace With tag. 

If the Confirm Replace check box is checked and matching tags are 
found, the page containing the matching tag is displayed, the paragraph 
is highlighted, and the following alert is displayed. 

If the highlighted paragraph is obscured by the alert, the alert window 
can be moved by clicking on the alert window title bar and dragging it 
to a convenient location. 

Click on the Done button to stop the search and replace operation. Any 
tag replacements made up to the point the Done button is selected will 
not be undone. 

Click on the Skip button to continue the search and replace operation 
without affecting the highlighted paragraph. 

Click on the Replace button to replace the tag applied to the high­
lighted paragraph with the selected Replace With tag. 
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Text contained within a paragraph having attributes set using the at­
tribute options in the Text menu will not be affected by changes to the 
paragraph tag. 

Search from The Search from Start of Chapter check box determines where the 
Start of Chapter search will begin. This option is applicable to both the search and the 

search and replace operations. 
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The search function searches through the chapter page by page. The text 
elements (e.g., box text, text file frame, frame caption, etc.) on each page 
are searched in the order in which the page elements where created on 
the individual page. 

If the Search from Start of Chapter check box is checked, the search 
will start at the beginning of the chapter and proceed through the 
chapter page by page to the last text element placed on the last page of 
the chapter. 

If the Search from Start of Chapter check box is cleared, the search 
will begin at the location of the text cursor if the Text tool is selected, the 
currently selected frame or box text if the Frame tool is selected, or the 
currently selected paragraph if the Paragraph tool is selected. Ifnothing 
on the current page is selected, or if the base page is selected, the search 
will begin with the first text element created on the current page and 
proceed through the chapter page by page to the last text element placed 
on the last page of the chapter. 

Cancel Click on the Cancel button to exit the dialog box abandoning all changes 
made in the dialog box. 

Search Click on the Search button to begin the search for tags matching the 
specified Search For tag. The search will only locate paragraphs with 
a tag matching the selected Search For tag name. None of the Replace 
With options are applicable when the Search button is selected. 

When a paragraph tagged with the specified Search For tag name is 
found, the page containing the paragraph tag is displayed, the para­
graph is highlighted, and the following alert is displayed. 
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If the highlighted paragraph is obscured by the alert, the alert window 
can be moved by clicking on the alert window title bar and dragging it 
to a convenient location. 

Click on the Done button to stop the search, leaving the last paragraph 
match highlighted. 

Click on the Continue button to continue the search for other para­
graphs with a tag matching the selected Search For tag name. 

When the search has reached the end of the chapter, the following alert 
is displayed. 

Click on the OK button to return to the Ventura Publisher main screen. 

Replace Click on the Replace button to begin the search and replace operation. 
When selected, a search is performed for paragraphs with a tag match­
ing the selected Search For tag name. 

If matching paragraph tags are found and the Confirm Replace option 
in the Search and Replace dialog box is not selected, the specified 
Replace With tag will automatically be applied to the paragraph. 

The changes made during a search and replace can only be undone using 
the Revert to Saved option to load the chapter as it was last saved 
before the search and replace. 
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If a matching paragraph tag is found and the Confirm Replace check 
box is checked, the page containing the matching paragraph tag is 
displayed, the paragraph is highlighted, and the following alert is 
displayed. 

If the highlighted paragraph is obscured by the alert, the alert window 
can be moved by clicking on the alert window title bar and dragging it 
to a convenient location. 

Click on the Done button to stop the search and replace operation. Any 
replacements made up to the point the Done button is selected will 
remain. 

The changes made during a search and replace can only be undone using 
the Revert to Saved option to load the chapter as it was last saved 
before the search and replace. 

Click on the Skip button to continue the search and replace operation 
without affecting the highlighted paragraph. 

Click on the Replace button to replace the tag applied to the high­
lighted paragraph with the selected Replace With tag. 

Text contained within a paragraph having attributes set using the at­
tribute options in the Text menu will not be affected by changes to the 
paragraph tag. 

When the search and replace has reached the end of the chapter, the 
following dialog box is displayed. 
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Click on the OK button to return to the Ventura Publisher main screen. 

Special Items Mode 

When the Special Items option is selected, the dialog box shown in 
Figure 6-13 is displayed. The following options are available for per­
forming a search for special items in the chapter. 

Figure 6-13. Search and Replace dialog box in Special Items mode. 

Search For The Search For special items list box is used to select the type of special 
item for which you want to search. 

Item Name Certain special items such as frame anchors and index entries have item 
names. If you want to search for a specific instance of that special item, 
such as a specific frame anchor, type the name of the special item in the 
Item Name field. If you don't type in a specific name, the search will find 
the first instance of that special item. For example, if you type in a 
specific frame anchor name, the search will find the anchor with that 
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name. If you don't specify a name, the search will find the next frame 
anchor regardless of its name. 

Search from The Search from Start of Chapter check box determines where the 
Start of Chapter search will begin. 
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The search function searches through the chapter page by page. The text 
elements (e.g., box text, text file frame, frame caption, etc.) on each page 
are searched in the order in which the page elements where created on 
the individual page. 

If the Search from Start of Chapter check box is checked, the search 
will start at the beginning of the chapter and proceed through the 
chapter page by page to the last text element placed on the last page of 
the chapter. 

If the Search from Start of Chapter check box is cleared, the search 
will begin at the location of the text cursor if the Text tool is selected, the 
currently selected frame or box text if the Frame tool is selected, or the 
currently selected paragraph if the Paragraph tool is selected. Ifnothing 
on the current page is selected, or if the base page is selected, the search 
will begin with the first text element created on the current page and 
proceed through the chapter page by page to the last text element placed 
on the last page of the chapter. 

Clear Click on the Clear button to clear all selections in the Search For list 
box and Item Name field. 

Search Click on the Search button to begin the search for the special items 
specified in the Search For list and, when appropriate, under the Item 
Name field. 

When a specified special item is found, the page containing the item is 
displayed, the special item is highlighted, and the following alert is 
displayed. 
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If the highlighted special item is obscured by the alert, the alert window 
can be moved by clicking on the alert window title bar and dragging it 
to a convenient location. 

Click on the Done button to stop the search at the currently matched 
item. 

Click on the Continue button to continue the search for the next 
matching item. 

When the search for special items reaches the end of the chapter the 
following alert is displayed. 

Click on the OK button to return to the Ventura Publisher main screen. 

Cancel Click on the Cancel button to exit the Search and Replace dialog box. 
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Object Properties 
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The Object Properties option allows you to view and edit the proper­
ties of linked and embedded OLE objects pasted into your Ventura 
Publisher chapter. 

~ Refer to Appendix K for more information on working with OLE objects. 

Operation 

The options available in the Object Properties dialog box are depend­
ent on the how the object in the currently selected frame was pasted into 
the chapter. 

If this option is not available (grayed) the currently selected frame does 
not contain a linked or embedded OLE object. 

Linked objects 

When a frame containing a linked object is selected and the Object 
Properties option is selected from the Edit menu, the Link Properties 
dialog box (Figure 6-14) is displayed . .The options in this dialog box 
allow you to edit the properties of the object as well as start the server 
application and load the server file for the object. 

Figure 6-14. Link Properties dialog box. 
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Source The Source field tells you from which application the data currently on 
the clipboard originated. 

Document Name The Document Name field tells you from which file the data currently 
on the clipboard originated. This field can be edited if the server file has 
been moved to a different location. 

Item Name The Item Name field describes the data currently on the clipboard. This 
information may be screen coordinates if the object was copied from a 
paint program, row and column coordinates if the object was copied from 
a spreadsheet, or other data pertinent to the server application being 
able to identify the object when it is edited. 

The information in this field should not be edited unless you know how 
the server application will process the information when the object is 
edited. 

Update The Update option allows you to specify how a linked object is updated. 

Automatic 

Selecting Automatic will cause the object to updated anytime the object 
is modified. 

Manual 

Selecting Manual will cause the object to be updated only when the 
Update button is selected from the Link Properties dialog box. 

OnSave 

Selecting OnSave will cause the object to be updated only when the 
original server file is saved in the server application. 

Edit The Edit button will start the server application for the selected object 
and automatically load the associated server file. 

Play If the object contains animation or audio script data the Play button is 
used to start this script. 

Unlink The Unlink button is used to severe the link between the object and the 
server application. Once unlinked, the object cannot be updated in any 

6-53 



t:UII Mt:I\lU Object Properties 

6-54 

way by the server application, nor can the server application be started 
using the unlinked object. 

Update The Update button will retrieve the most current version of the object 
from the server file. 

OK The OK button confirms and applies any changes made in the Link 
Properties dialog box. 

Cancel The Cancel button abandons any changes made in the Link Properties 
dialog box, including unlinking of the object. 

Embedded objects 

When a frame containing an embedded object is selected and the Object 
Properties option is selected from the Edit menu, the Embedded 
Object Properties dialog box (Figure 6-15) is displayed. The options in 
this dialog box allow you to edit the properties of the object as well as 
start the server application and load the server file for the object. The 
dialog box displays the name of the . VPO file for the currently selected 
object. 

Figure 6-15. Embedded Object Properties dialog box. 

Change to The Change to Picture button will convert the embedded object to a 
Picture static picture. This option is similar to the Unlink option found in the 

Link Properties dialog box for linked objects. Once converted to a 
picture, the embedded object cannot be updated nor can the server 
application and file be started using the embedded object. 

Edit The Edit button will start the server application for the selected object 
and automatically load the associated server file. 
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Play If the object contains animation or audio script data the Play button is 
used to start this script. 

OK The OK button confirms and applies any changes made in the Em­
bedded Object Properties dialog box. 

Cancel The Cancel button abandons any changes made in the Embedded 
Object Properties dialog box, including unlinking of the object. 
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VIEW MENU 

facing Pages View 
Win!low Width 
Seduced View Ctrl+R 

.j Normal View Ctrl+N 
.Enlarged View Ctrl+E 

.j Show All Pictures 
.s.et Rulers ... 

.j Show Ryler 
Show ,!;.olumn Guides 

.j Show labs & Returns Ctrl+ T 
Show .Loose Lines 

.j CQlumn Snap 

.j Line Snap 

.j Button B~r 
Tool.!!ox Window 
Tag List Window 
File List Window 

Ctrl+W 
Ctrl+V 
Ctrl+Y 

Figure 7-1. View menu. 

Description 

The View menu provides four different ways to present the chapter on 
your computer screen: 

• Facing Pages View (fit facing pages to window width) 

• Window Width View (fit page to width of application window) 

• Reduced View (fit page to height of application window) 

• Normal View (100% default - user definable)) 

• Enlarged View (200% default - user definable) 

It also lets you change other aspects of how information is displayed on 
your screen. 

A check mark is placed next to each option in the View menu that is 
currently enabled. 
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Views 

Views 

The options in the View menu let you perform the following: 

• Check the overall layout of a page. 

• Provide better resolution when you are drawing graphics or editing 
text. 

Operation 

7-2 

Select the desired option in the View menu. You can also use the 
keyboard to select any view, by pressing one of the following key com­
binations: 

View Ventura Key Windows Key 

Facing Pages View None Alt + V + F 

Window Width None Alt + V + D 

Reduced View Ctrl + R Alt + V + R 

Normal View Ctrl + N Alt+ V + N 

Enlarged View Ctrl + E Alt + V + E 

The zoom factor for the Normal View and Enlarged View options is 
definable using the options in the zoom menu. Additionally, the zoom 
menu allows custom zoom factors not available in the View menu. Refer 
to the Zoom Controls section of Chapter 2. 

Depending on the current zoom factor, a certain amount of the applica­
tion window may not be covered by the chapter page. If you notice the 
screen flickering in the area of the screen not covered by the chapter 
page (primarily on interlaced monitors in a high-resolution mode), you 
can set the Application Workspace to a different color using the Color 
option in the Windows Control Panel. You may need to experiment with 
a number of color settings before finding a color that will not cause the 
screen flickering. 

When changing to a more magnified view, you can zoom into a specific 
area of the page as follows: 
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~ Place the mouse cursor at the spot which will be the upper left corner 
of the more magnified view. 

~ Use the keyboard shortcuts shown above to change views. 

In Facing Pages View, you cannot drag frames from one page to 
another. Use Cut, Copy, and Paste instead. The Facing Pages View 
option is available only when the Sides option of the Page Size & 
Layout option dialog box (Chapter menu) is set to Double. 
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Show pictures/hide pictures 

The Hide Pictures option replaces line art and images with a gray 
rectangular box. Show Pictures shows pictures which were previously 
hidden. Use this option to: 

• Increase the screen drawing speed. 

• See the frame margins, if the frame contains a picture. 

Operation 

To hide all pictures in the chapter: 

~ Make sure that no frame containing an image is selected. 

~ Select the Hide All Pictures option in the View menu. 

To turn all pictures back on again, select Show All Pictures from the 
View menu. The frame and the picture it contains can still be moved, 
sized, scaled, cut, copied, and pasted while pictures are hidden. 

To hide or show just one picture: 

~ Click on the Selector tool button. 

~ Select the picture you wish to hide/show. 

~ Select either the Hide This Picture or Show This Picture option 
in the View menu. 

When pictures are hidden, a gray box is displayed within each frame, 
covering the exact area occupied by the picture. The space between this 
gray box and the frame edge shows you the current frame margin 
settings. 

When printing a chapter containing hidden pictures, enable the Print 
Hidden Pictures option in the Print dialog box to print all the pictures 
in a chapter. If the Print Hidden Pictures option is not enabled, the 
area of the page containing a hidden picture will print as solid black. 
Pictures that are not hidden will print regardless of the setting of the 
Print Hidden Pictures option setting. 



Set Ruler 

Set Ruler 

VIEW MENU 

The Set Ruler option allows you to set different ruler measurement 
units for the vertical and horizontal rulers shown on the edge of the 
screen. 

Operation 

~ Select the Set Ruler option. The Set Ruler dialog box (Figure 7-2) is 
displayed. 

Figure 7-2. Set Ruler dialog box. 

~ Select the desired measurement unit for both the horizontal and 
vertical ruler. 

~ Set the horizontal and vertical zero points. 

Tabs and in/outdent settings are measured from the edges of the column, 
not the page. When the rulers are displayed and a paragraph selected, 
the zero point of the ruler will adjust to correspond to the left column 
edge for the currently selected paragraph. This allows you to better ad­
just the tab bar markers visually rather than having to calculate the 
difference between the set zero point and the actual column edge. 

Once the Selector tool is enabled, or all paragraphs are deselected, the 
ruler zero point will return to the position set using the Set Ruler op­
tion or the interactive zero point adjustment feature. 
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You can also set the rulers interactively, as shown below. 

To move the rulers with the 
mouse, or to pull the ruler 
cross-hairs onto the screen, point 
to the 0,0 box, press and hold the 
mouse button, and then ... 

... drag the cross-hairs onto the 
screen. Use these cross hairs to 
check for vertical and horizontal 
alignment. In Facing Pages View, 
you can check for alignment across 
pages. When you release the mouse 
button ... 

... the zero points move to the 
mouse location. To reset only the 
vertical ruler, move the mouse to 
the top ruler before releasing the 
mouse button. Double-click in the 
0,0 box to reset both the horizontal 
and vertical rulers. 

IC ~~ 
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~ 

(~ 

Ruler zero point 
set to location of 
mouse prior to 
releasing the 
mouse button. 

Set Ruler 
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Show Rulers 

VIEW MENU 

The Show Rulers option turns rulers at the top and left edges of the 
screen on or off. The on-screen rulers help position pictures and 
graphics. The Show Rulers option also controls the displaying of the 
tab bar located below the horizontal ruler. 

Tabs, in/outdent, and temporary margins are measured from the edges 
of the column, not the page. When the rulers are displayed and a para­
graph selected, the zero point of the ruler will adjust to correspond to 
the left column edge for the currently selected paragraph. This allows 
you to better adjust the tab bar markers visually rather than having to 
calculate the difference between the set zero point and the actual 
column edge. 

Once the Selector tool is enabled, or all paragraphs are deselected, the 
ruler zero point will return to the position set using the Set Ruler op­
tion or the interactive zero point adjustment feature. 

Operation 

To display the rulers, select the Show Rulers option in the View menu. 
A check mark is displayed next to the menu item when the option is 
enabled. To hide the rulers, select the Show Rulers option again. 

When rulers are shown, the position of the mouse cursor is always 
shown by a thin hairline which moves across the face of each ruler. 
These hairlines allow you to make accurate frame and graphic place­
ment on the page. 

To ensure precise frame size and placement, use the Sizing & Scaling 
option in the Frame menu. 

To make precise graphics placement, use the Grid Settings option in 
the Graphic menu. 
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Show Column Guides 

The Show Column Guides option paints faint dashed lines on the 
screen to show the outline of each column. The column guides help: 

• Determine how much space is left at the bottom of the column. 

• Aid in frame placement. 

Operation 

To enable column guides, select the Show Column Guides option in 
the View menu. A check mark is displayed next to the menu item when 
the option is enabled. To disable column guides, select Show Column 
Guides again. 

~ Column guides cannot be printed. 

When Column Snap is enabled, frames which you create, move, or 
resize will snap to these column guides. The Column Snap option 
works regardless of whether the column guides are shown. 
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Show Tabs & Returns 

The Show Tabs & Returns option provides visual markers for tabs, 
non-breaking spaces, line breaks, end of paragraph marks, end of file 
marks, index points, frame anchors, discretionary hyphens and other 
hidden inserted characters. Enable the Show Tabs & Returns option 
to help locate hidden characters while editing text. 

Operation 

Tab 

~ 

To show tabs and returns, select the Show Tabs & Returns option in 
the View menu or press Ctrl + T. A check mark is displayed next to the 
menu item when the option is enabled. To hide these characters, select 
Show Tabs & Returns again. Figure 7-3 shows some of the symbols 
used to display hidden characters. 

The symbols shown in Figure 7-3 are affected by the font specified for 
the paragraph in which the symbols appear. If the typeface used in the 
paragraph is a not a Roman type face (e.g., decorative or symbol face), 
the Ventura Publisher sympols may appear different than shown below. 

Showing these characters takes additional space, which changes the 
location of characters on the screen slightly. This shift in no way affects 
how the page is printed. 

It is recommended that you enable the Show Tabs & Returns option 
whenever possible to avoid accidentally deleting hidden characters. 

Discretionary 
Non -breaking 

and other Line Break Paragraph End of file Hyphen fIxed spaces 

• U ~ , [I 
Figure 7-3. Common hidden characters. Index, anchors and other hidden text 
display as small circles. Actual characters shown on your screen may be different. 
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Show Loose Lines 
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The Show Loose Lines option highlights lines which exceed the Max­
imum Space Width setting in the Paragraph Typography option 
dialog box. Although Letter Spacing may be turned on to compensate 
for the loose line which results when this space is exceeded, the line will 
still be flagged as loose. This option helps provide a visual landmark to 
aid in editing loose lines. You should place a discretionary hyphen in the 
first word below the loose line to correct a loose line. 

Operation 

To enable the displaying of loose lines, select the Show Loose Lines 
option in the View menu. A check mark is displayed next to the menu 
item when the option is enabled. To disable the displaying of loose lines, 
select the Show Loose Lines option again. 

Loose lines are shown in reverse video (e.g., white text on a black 
background) on a monochrome display. They are shown in red on a color 
display. When displaying the page in reduced or facing pages view, loose 
lines may not b~ visible, depending on the resolution of your monitor. 

To correct a loose line, place a discretionary hyphen in the first word 
below the loose line. Refer to the Text tool section of Chapter 3 for more 
information on discretionary hyphens. 
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The Column Snap option forces all frames to align with the sides of the 
page's column guides. Use this option to force picture and text frames 
placed on the page to align perfectly with the text columns. 

Operation 

To enable column snap, select the Column Snap option in the View 
menu. A check mark is displayed next to the menu item when the option 
is enabled. To disable column snap, select the Column Snap option 
again. A frame positioned within approximately 0.1 inch of a column 
guide will snap to that guide when Column Snap option is enabled. 

Turning column snap on does not move frames already in the chapter 
until those frames are moved or resized. 

When re-sizing a frame already placed on the page, only the side of the 
frame currently being moved snaps to a column guide. 

Frames do not snap to the top or bottom of the column guides. However, 
if the top margin is an integral multiple of Body Text tag inter-line 
spacing, and the Line Snap option is enabled, you can force the frame 
to align exactly with the top of the column guide. 

Refer to the Line Snap option section starting on the next page. 
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Line Snap 

Line Snap 

The Line Snap option forces frames to line up exactly with the Body 
Text inter-line spacing in the page. Enable this option to: 

• Ensure that frames in adjacent columns line up exactly. 

• Force the top of one frame to align with the bottom of the frame above 
it. 

• Force a line or lines of text in a column to move down by exactly one 
line, by increasing the height of a frame that has been snapped to the 
column. 

Operation 
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To enable line snap, select the Line Snap option in the View menu. A 
check mark is displayed next to the menu item when the option is 
enabled. To disable line snap, select the Line Snap option again. 

This option uses the inter-line spacing for Body Text to create an 
invisible grid to which frames are snapped. If Line Snap is enabled or 
if the Body Text tag inter-line spacing changes after frames have been 
placed, you must move both the top and bottom of each frame in order 
to align the frame with the new Body Text grid. 

If you change the font size of the Body Text tag, while the Auto-Adjust­
ments option is set to either Styles or Both in the Set Preferences 
option dialog box (Edit menu), the inter-line spacing for the Body Text 
tag will change. When you next select a frame, it will jump to the new 
line grid. To avoid this problem, either set the Auto-Adjustments op­
tion to None prior to changing the Body Text tag font size, or disable the 
Line Snap option prior to selecting a frame that you have already 
placed in the chapter. 
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Button Bar and Tool windows 

The Button Bar option allows you to switch between the button bar 
interface and the "classic" interface. When a check mark is displayed 
next to this option, the button bar interface is displayed. 

The tool window options are only available when the classic interface is 
in use (a check mark does not appear next to the Button Bar option). 
The Toolbox Window, Tag List Window, and File List Window 
options let you specify whether or not these windows are displayed. 

The main purpose of these options is to let you hide or display the tool 
windows while the classic interface is in use. 

Operation 

To switch between the button bar interface and the classic interface, 
simply select the Button Bar option from the View menu. 

To place a window on the screen, select the appropriate window option 
from the View menu. A check mark is displayed next to the menu item 
when the window is displayed. To remove the window from the screen 
choose the option again. 

The classic interface and the use of these tool windows is not covered in 
this manual. If you are familiar with, and prefer to use the classic 
interface, refer to the Classic Interface section of Chapter 2 for informa­
tion on the changes to the classic interface and the tool windows. 
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Eage Size & Layout .. . 
.c.hapter Typography .. . 

Headers & Footers ... 
Show Page H~ader 
Show Page FQoter 
footnote Settings ... 

Insert/Remove Page ... 
.G.o to Page... Ctrl+G 

.set Screening ... 

Figure 8-1. Chapter menu. 

Description 

CHAPTER MENU 

The Chapter menu controls page formatting for the entire chapter. It 
is, thereby, distinguished from the Frame menu, which controls format­
ting for each individual frame. 

The individual options available in the Chapter menu are described on 
the following pages. 
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Page Size & Layout 

8-2 

Click on the Page Size & Layout function button to define the physical 
size of the paper used in the printer, printing orientation, and selection 
of either single or double sided formatting. You are permitted only one 
set of size and layout specifications per chapter. Use the Page Size & 
Layout option to: 

• Change between portrait and landscape display and printing. 

• Change paper sizes. 

• Permit different formatting on left and right pages. 

Operation 

~ Click on the Page Size & Layout function button. The Page Layout 
dialog box (Figure 8-2) is displayed. 

Figure 8-2. Page Layout dialog box. Settings shown are typical. 

Orientation Select whether you want the chapter to be printed in Portrait or Land­
scape (Figure 8-3). 
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Portrait Landscape 

Figure 8-3. Portrait us. Landscape printing. 

Paper type Select the physical size of the paper on which your chapter will be 
printed. Smaller page sizes can be printed on printers that handle only 
one size of paper if you decrease the page's height and width using the 
Selector tool Sizing and Scaling option button. 

Sides/Start on 

Broad Sheet and 11 x 17 page sizes 

If you select either Broad Sheet or 11 x 17 as the paper size, a dialog box 
is displayed at print time giving you two options: 

• Overlap. This option allows 11 x 17 inch pages to be printed on four 
8.5 x 11 inch pages which can then be manually pasted together to 
form an 11 x 17 inch page. 

Broad Sheet pages can be printed on either three 8 x 24 inch strips, 
four overlapping 11 x 17 inch pages, or nine overlapping 8.5 x 11 inch 
pages. These pages can then be manually pasted together to form one 
18 x 24 inch page. 

• Normal. This option allows you to print the page size unaltered if 
your printer supports these sizes. 

The Broad Sheet strip option is intended for use only with typesetting 
equipment and will not work with laser printers. 

Set the Sides option to either Single for single-sided page format or 
Double for double-sided format. Set the Start On option for the page 
side you want page one to start on (Left Side or Right Side). If you set 
Sides to Single and Start On to Left Side, only the Left Side settings 
for headers & footers, margins, column widths, vertical rules, and tag 
(In From Left, In From Right) spacing are applied to each page. The 
same comment applies to single-sided formatting starting on the right 
side. 
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Page Size & Layout 

The Facing Pages View option in the View menu will display two 
facing pages only when the Sides option is set to Double. 

You must set the Sides option to Double in order to allow different 
headers & footers, margins, column widths, vertical rules, and tag (In 
From Left, In From Right) spacing settings for left and right pages. 
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Chapter Typography 

The Chapter Typography option controls the character-to-character 
and line-to-line formatting for the entire chapter. You can override these 
settings for any frame or any page you have inserted manually (refer to 
the Insert!Remove Page option section later in this chapter) by select­
ing that frame or inserted page, then using the Frame Typography 
settings in the Frame menu. Use the Chapter Typography option to: 

• Control text placement from column to column and page to page. 

• Match typography to the style of document you are creating. 

Operation 

Select the Chapter Typography option in the Chapter menu. The 
Chapter Typography Settings dialog box (Figure 8-4) is displayed. 

Chapter (Default) Typography Settings 

Figure 8-4. Chapter TYpography dialog box. Settings shown are typical. 

Widows & A widow is a single line of text at the top of a page or column which has 
Orphans been separated from the paragraph that finishes the previous page or 

column. 

An orphan is a single line of text at the bottom of a page or column which 
has been separated from the paragraph that starts the next page or 
column (Figure 8-5). 
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Widow ______ _ 

Orphan~ 

Figure 8-5. A widow (single line) at column top and an orphan (single line) at 
column end. 

The Widows and Orphans options control the number oflines that can 
be widowed or orphaned. To operate: 

~ Select the Chapter Typography option in the Chapter menu. 

~ Move the mouse cursor to the widow or orphan number and select the 
minimum number of lines to leave at the top or bottom of the page or 
column. 

The default setting is two. This means that at least two lines must 
remain on the previous page or column or be forced to the next 
page/column, if possible. 

Set both the Widows and Orphans options to 2 for most work. Set both 
to 1 if you want to disable this option. Magazines and books often allow 
widows and orphans so a setting of one may be proper for these doc­
uments. 

The Widows and Orphans option settings are stored in the chapter 
(CHP) file. 

Column balance Set the Column Balance option to On when your document has 
multiple columns and you want all columns to end at the same position 
at the bottom of the page. Figures 8-6 and 8-7 show the difference at 
the bottom of a page between column balance on and column balance off. 
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Figure 8-6. Column balance off. Figure 8-7. Column balance on. 

Column balance reduces text formatting speed. Therefore, you should 
temporarily turn column balance off if you plan to make extensive chan­
ges on a page. 

Column balance and frame-wide text 

U sing the Paragraph tool Alignment option and setting the Overall 
Width option to Frame-Wide overrides the column settings for any 
paragraph. This allows you to automatically format headings which 
straddle several columns of text. However, if this heading starts 
anywhere but on the first line of the page, it will interfere with text in 
adjacent columns. 

To solve this problem, set the Column Balance option to On. Figures 
8-8 and 8-9 show the results. 

8-7 



CHAPTER MENU Chapter Typography 

SETUP AND INSTALLATION SETUP AND INSTALLATION 

System requirements 

:rox Ventura Publi~her requires an IBM pc, 
AT, PS/2, or a compatible computer which 
the same software as Ihc~e machines. Your 
)uter must also contain the following or 
_alent: 

40 kilobytes of RAM. 

~ hard disk drive with one 10 Ihree 
~egabylesavailablespace 10 hold soflware 
nd fOnls (space required depends on 
,rinters installed-see Ihe Sot'tware Instal­
atlon !ieCtion whichfoJ[ows.) At lea.,ttwo 
l Ihree megabytes should still be available 
fter installation. This space is needed to 
Lold yourdocumenl files and any additional 
onlsyoumaylaferchoo~toinslall 

~ graphics board: 

AT&T 6300(640 X 4(0) or Xerox 6065. 

Hercules Graphics Card. or equivalent 

IBM Color Card and compa!ible color 

IBM Enhanced Graphics Adapler 
(EGA) or compatible 

IBM VGA or compatible 

Micro Db.play Systems Genius di~play 

Wyse700 

Other(seeAppendixJforacomp1eteli~t 

of graphic boards and moniton; sup­
poned) 

Software Installation 

System requirements 

:roxVenturaPublisherrequiresanIBMPC. 
AT. PS/2. or a compatible computer which 
the same software as Ihese machines. Your 
)uter must also contain the following or 
_alen!: 

40 kilobytes or RAM 

~ hard disk drive with one 10 Ihree 
~egabytesavailable space 10 hold software 
nd fOnls (space required depends on 
,rinters inslalled-see the Sortware Instal­
ationsection which follows.) AI leasllwo 
llhree megabytes should still be available 
fterinstallation. This space is needed to 
tOld your document files and any additional 
onlsyou may IdterchooM: 10 in!oolall. 

• A graphics board: 

.. AT&T 6300 (640 X 4OOjorXcrox 6065. 

It HerculesGraphicsCard.orequivalent 

» IBM Color Card and compatible color 
momtor 

It IBM Enhanced Graphics Adapter 
(EGA) or compatible 

.. IBM VGA or compatible 

» MicroDisplaySystemsGeniusdisplay 

.. Wyse700 

.. Other(seeAppendixJforacomplelelist 
of graphic boards and monitors sup­
poned) 

Software installation 

you previously inslalled version 1.0 of 
'x Ventura Pubiisher.pleaseconsull the sec-

Preparlngrorlnstallatlon 

Updating From Version 1.0 in Appendix You need to know Ihe following about your 
f you previously installed version 1.1. computer hardware: 

'er Ywhen asked by Ihe installation pro- It The type of graphics board installed in 

:i~~:tr:: ~:~~~~~~:~::I~~i~~itn~~e;;i'ons your computer. 

,ded for use by a person who has basic ,. The printer port u~ed by your printer. 
liaritywith the IBM PC(orcompatible) and e.g .• serial. parallel or special printer in-
:. Additional in\tallation information is teriace. 
ided in Appendix A 
lie thai Xerox Ventura Publi!ooher will not .. The serial pon or special board used by 

ite when ~hared among muhiplecomputers. yourmou~e. 

you previously installed version 1.0 of I A. If you previou~ly installed ver~ion 1.1. 
'xVenturaPubli.<.her.pleaseco~sulllhesec- answer Y whe~ a~ke~ by the in.<.lalla.tion pro­
Updating From Version 1.0 In Appendix gram "Are you mSlalhng for the fin;t time?" 

sitlicensedforsharingfromafileserver You should make backup copies of your dis-
19 multiple compUler workstations on a tribution disks 10 guard agamst accidental 
nunicalions network. However. a network damage. Read the Software License and War­
on of Xerox Ventura Publisheris available. ranty Agreement included with this product 10 
act Xerox al 1-(800)-822-8221 for price understand the legal restrictions governing 
Ivai lability. copying and installalion. 

Figure 8-8. Column balance off. Note 
how text does not balance above frame-wide 
text near bottom of page. 

Figure 8-9. Column balance on. Note 
how text fills both columns above frame-wide 
text. 
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Column balance limitations 

Certain options in the Chapter and Paragraph menus can limit the 
extent to which column balance is implemented. In particular, the 
Widows and Orphans options in the Chapter Typography option 
dialog box (Chapter menu) and the Keep With Next option in the 
Breaks option dialog box (Paragraph menu) force text to the next 
column or page. This creates gaps at the bottom of the previous column 
or page. Therefore, if you use the Widows, Orphans, and Keep With 
Next options when Column Balance is turned on, you may need to 
manually add additional space between paragraphs using narrow 
frames if you want multi-column pages to balance exactly. Refer to the 
Add Frame tool section in Chapter 3 for instructions on using frames to 
add space between lines and paragraphs. 

Even if you do not use the Widows, Orphans, and Keep With Next 
options, setting the Column Balance option On still cannot always 
make each page balance perfectly. This is because Column Balance 
adjusts the number of lines in adjacent columns, but does not actually 
change the space between lines or paragraphs (vertical justification). 
Therefore, for example, if a two column page contains an odd number of 
lines, one column will be a line shorter than the other. Proper use of the 
vertical justification feature can solve this problem. 
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Move down to 
1st baseline 

Ventura Publisher provides two different ways to determine where the 
first line of text will begin on a page or within a frame. If you set the 
Move Down To 1st Baseline By option to Cap Height, the top of the 
column aligns with the top of the tallest capital letter in the font you 
have chosen. If you set the Move Down To 1st Baseline By option to 
Inter-Line, the first line of text starts at a distance from the top margin 
equal to the inter-line spacing set in the Paragraph tool Spacing option 
dialog box. See Figures 8-10 and 8-11. 

Kerning You can turn kerning globally on or off for the entire chapter by selecting 
the Pair Kerning option. This overrides the settings you chose for the 
Automatic Pair Kerning option in the Paragraph Typography 
option dialog box (Paragraph menu), but does not change them. If you 
set Pair Kerning to On, kerning will once again take effect for those 
paragraph tags for which you set the Automatic Pair Kerning option 
to On. Set the Pair Kerning option to Off to improve print and screen 
refresh speeds, especially when the Automatic Pair Kerning option is 
On for the Body Text tag. Note, however, that changing this setting may 
change where text is placed in your document. 

seTUP AND INSTALLATION 

Xcro,. Ventura PubliMlcr requires an IBM PC, 
XT. AT. PS/2. or a compatible computcrwhich 
runs lhe same softwarc IlS these machines. Your 
:omputer must also Contain the following or 
equivalcm: 

640 kllobylesof RA!'of. 

A hard disk drive with onc 10 three 
megabytcs8vailable space to hold software 
and fonts (space required depends on 
printers inslalled-seelhe Software Instal· 
latlon section which follows.) At least two 
10 three megabytcs should still be available 
aflcr installalion. This space is needed 10 
hold your document files and any additional 
(omsyoumaylaterchooscloinslall. 

A &raphlCl board: 

.. AT&T6300(640 X 400) or Xerox 6065. 

.. Hercules Graphics Card. orequivalenl 

.. IBM Color Card and compatible color 

.. IBM Enhanced Graphics Adapter 
(EGA)orcompalible 

.. IBM VGA or compatible 

.. MicroDisplaySystemsGeniusdispJay 

tion Updating f'rom Version 1,0 in Appendtx 
A. If you pre\liously installed version 1.1. 
answer Y when a.~ked by the installation pro­
gram"Areyouin~tallingforthefirsttimer' 

This seclion provides installalion instructions 
inlended for use by a person who has basic 
familiarity with the IBM PC(orcompatible)and 
DOS. Additional installation information is 
pro\lidedin Appendill. A. 

NOIe that Xeroll. VenlUra Publi~her will nOl 
operate when shared among multiple computers, 
nor is it licensed for sharing from a file server 
among multipJe computer workstations on a 
communications network. However, a network 
versionofXerolt VenturaPubli~herisavailable. 
COnlacl Xerox at 1-(800)-822-8221 for price 
and availability. 

Preparing for installation 

You need to know the following aboul your 
computer hardware: 

.. The Iype of graphics board installed in 
your computer. 

.. Theprinlerportu~dbyyourprinter, 

e.g., serial. parallel or special printer in· 
terface. 

.. Theserialportorspecialboardu~dby 

your mouse . 

.. Wy~100 You should make backup copies of your dis· 

.. Other (see Appendix Jfora complete list tribution disks to guard against accidenlal 
of graphic boards and monitors sup- damage. Read the Soflware Licen~ and War· 
poned) ranty Agreement included with this product to 

undersland the legal resuictions governing 
"...so-=-nw-ar-,.I,--ns"'""'tal""'lat::-ion---- 1 copying and installation. 

Younccdl.S-3.5megabytesofspaceonyour 
If you previously installed venioR 1.0 of compuler's hard dbk to hold all printer foms. 

XeroIl.VenturaPublisher,plea~consultthesec· screen fonlS, system software, application 

Figure 8-10. Move down by cap height. 
The top of the words Setup and Installa­
tion touch the top of the column. 

seTUP AND INSTALLATION 
Xerm, VenturaPublhherrequire~llnlBM PC. 

XT, AT. PS12. or a compatible computer which 
runs the same soflware as !helot machines. Your 
~omputer must also contain the following or 
equi ... alent: 

640 kilobytes of RAM. 

A hard disk drive with one 10 three 
megabytesa ... ailable space to hold software 
and fonts (space required depends on 
primers installed-see the Sonware Instal· 
Iatlon seclion which follows.) At least two 
to three megabytes should still be a ... allable 
after inslallation. This space is needed to 
hold your document files and any additional 
fonts you may lalerchoose to install. 

A graphics board: 

.. AT&T6300(640X400)orXerox6065. 

.. Hercules Graphics Card. or equivalent 

.. IBM Color Card and compatible color 

.. IBM Enhanced Graphics Adaptct 
(EGA) or compatible 

.. IBM VGA or compatible 

.. Micro Display Systems Genius display 

tion Updatina From Venlon 1.0 in Appendix 
A. If you pre ... iously installed version !.t. 
an5werY when a. .. ked by the installation pr(). 

gram "Are you installing for the first time?" 
This section pro\lides instaJlation instructions 

intended for use by a person who has ba~ic 
famlliaritywi!h the IBM PC(orcompatible)and 
DOS. Additional in"taliation information is 
providedinAppendixA. 

Note that Xeroll. Ventura Publisher will nOI 
operate when shared among multiple computers. 
norisillicensedforsharingfromafile~rver 

among multiple computer workstations on 8 
communications network. Howe ... er. a network 
versionorXeroItVenturaPublhherisa ... ailable. 
Contact Xerox 8tI-(800)-822.8221 for price 
and availability. 

Preparing for instaliatioR 

You need to know the following about your 
computer hardware: 

• The type of graphics board installed in 
yourcompuler . 

.. Theprinterportu~dbyyourprinter • 
e.g .• ~rial.parallelorspecialprinlerin· 
lerface. 

.. The serial port or special board used by 

.. Wyse100 You should make backup copies of your dis· 

.. Other(~eAppendiJdforacompletelist tribution disks to guard against accidental 
of graphic boards and monitors sup- damage. Read the Software License and War· 
ported) ramy Agreemem included wilh this product 10 

understand the legal restriclions gO\leming 

Software installation copying and installation. 
You need I.S-3.S megahylesofspaceonyour 

If you pre\liou!>ly installed venion 1.0 of computer's hard disk to hold all pnnter fOnls. 
Xerox Ventura Publi~her, please consult the sec· screen fonts. system software, application 

8-11. Move down by inter-line. The distance 
from the top of the column to the base of the 
words Setup and Installation equals the 
Inter-Line space for the tag applied to this para­
graph. 
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Vertical justification 
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Vertical justification assures that text always reaches the exact bottom 
of each column or page (see Figure 8-12). 

No vertical justification 

Chapter 1 

• The Adventure Begins 
This trip really began in September last 

year when Gerry won first prize in a raffle at 
the fashion show which Rush-Presbyterian­
St. Luke's Medical Center holds every year. 
The prize was two round trip tickets to Hong 
Kong on United Airlines, and ten nights in the 
Hong Kong Hyatt Hotel. Analyzing our good 

fortune, we concluded that we wanted to do 
more than spend ten days in Hong Kong and 
return, but at the same time, United, having 
just gotten its routes and equipment from Pan 
American, had not yet received authority to 
fly to other destinations or between points in 
the Far East. 

On February 10th, United acquired this 
authority, and on February 11 th Debbie began 
putting our trip together. We left on March 
2nd and returned on March 26th. We entered 
seven countries, traveled over 25,000 miles on 
four airlines, made over 500 Kodachrome® 
slides, almost 200 Kodacolor® prints, and 5 
112 hours of color and sound vide9tape. 
• Chicago to Tokyo 

11:03 P.M. Chicago time. 39,000 feet 
somewhere over the Western Pacific, we are 
8 hours and 42 minutes out of Los Angeles 
with about 2 more hour to go to Tokyo. We 
were about an hour and ten minutes late out of 
Los Angeles. 

Vertical justification turned on 

Chapter 1 

• The Adventure Begins 

This trip really began in September last 
year when Gerry won first prize in a raffle at 
the fashion show which Rush-Presbyterian­
St. Luke's Medical Center holds every year. 
The prize was two round trip tickets to Hong 
Kong on United Airlines, and ten nights in the 
Hong Kong Hyatt Hotel. Analyzing our good 

fortune, we concluded that we wanted to do 
more than spend ten days in Hong Kong and 
return, but at the same time, United, having 
just gotten its routes and equipment from Pan 
American, had not yet received authority to 
fly to other destinations or between points in 
the Far East. 

On February 10th, United acquired this 
authority, and on February 11th Debbie began 
putting our trip together. We left on March 
2nd and returned on March 26th. We entered 
seven countries, traveled over 25,000 miles on 
four airlines, made over 500 Kodachrome ® 

slides, almost 200 Kodacolor® prints, and 5 
112 hours of color and sound videotape. 

• Chicago to Tokyo 

11:03 P.M. Chicago time. 39,000 feet 
somewhere over the Western Pacific, we are 
8 hours and 42 minutes out of Los Angeles 
with about 2 more hour to go to Tokyo. We 
were about an hour and ten minutes late out of 

Figure 8-12. VerticalJusti/ication example. 
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The options of the Paragraph tool Spacing option dialog box cannot 
force text to the bottom of the column or page because: 

• The paragraph may not contain enough text to reach the bottom of 
the page. 

• The Keep With Next setting in the Paragraph tool's Breaks option 
dialog box makes headings go to the next column or page. This creates 
a gap at the bottom of the current page. 

• The Widows and Orphans options keep single lines of text from 
appearing at the top or bottom of columns or pages, also creating a 
gap. 

• Page and column breaks force an artificial end to this page. 

You should use vertical justification for virtually any document where 
the text continues from one page to the next. For forms, advertisements 
and similar documents, vertical justification is usually not needed. 

Vertical justification automatically adds space before and after frames, 
tables, paragraphs and, if desired, between each line of text, until the 
text reaches the bottom of the column or page. The space is added in this 
order: 

• First, between frames and the surrounding text, until the maximum 
amount allowed for each frame is added. 

• If additional space is still needed, it is added between paragraphs or 
between tables and paragraphs until the maximum amount allowed 
for each paragraph or table is added. 

• Finally, if more space is still needed, it is added between lines of text 
until the maximum amount allowed for each paragraph is added. 

Space is always added, never subtracted. Text is never moved across 
page boundaries. 

Vertical justification controls appear in four options: 

• Chapter Typography 

• Frame Typography 

• Paragraph Typography 

• InsertlEdit Table 

The Chapter Typography option dialog box in the Chapter menu 
turns vertical justification on or off for the chapter. Once turned on, the 
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Frame Typography option in the Frame menu also lets you specify 
the maximum amount of space that can be added around any frame on 
the page. 

The Frame Typography option is identical to the Chapter Typo­
graphy option and lets you override the global settings for any selected 
frame. This lets you either stop vertical justification within a selected 
frame or add more space around a given frame on a page. 

The Paragraph Typography option dialog box (Paragraph menu) 
settings let you specify the maximum amount that can be added above 
and below a paragraph. You can also specify the maximum amount of 
space that can be added between lines in a paragraph. The paragraph 
typography settings can be different for each paragraph tag. This lets 
you, for example, force most space to be added around headings, with 
little or no space added between Body Text paragraphs. 

The InsertlEdit Table option dialog box settings (Table menu) let you 
specify the maximum amount of space that can be added above and 
below a table. The settings can be different for each table. 

General This section provides detailed instructions about how to use the vertical 
guidelines justification controls in the Chapter Typography option dialog box. By 

default, the vertical justification feature is disabled (Vert. Just. Al­
lowed option is set to 0%) For most work, all you need to do is select the 
Chapter Typography option and set the Vert. Just. Allowed option 
to 75%, Vert. Just. Within Frame option to Feathering, and Vert. 
Just. Around Frame option to Moveable. The defaults built into each 
style sheet will do the rest. The automatic defaults are: 

• Vert. Just. Allowed in the Chapter Typography option dialog box 
is set to 0%. 

• At Top of Frame and At Bottom of Frame: (Chapter Typo­
graphy option dialog box) are set equal to Body Text tag inter-line 
spacing. If they have been changed, you will probably want to restore 
both the At Top of Frame and At Bottom of Frame settings to the 
same value as that set for Body Text tag Inter-Line Spacing in the 
Paragraph menu Spacing option dialog box. 

• Vert. Just. At Top of Para and At Bottom of Para options in the 
Paragraph Typography option dialog box (Paragraph menu) are 
set equal to the Body Text tag Above and Below value in the 
Spacing option dialog box (Paragraph menu). If Body Text tag 
Above and Below values are both zero, the Vert. Just. At Top of 
Para and At Bottom of Para options are both set equal to Body Text 
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tag Inter-Paragraph value. If the Body Text tag Above, Below, and 
Inter-Paragraph values are all zero, then the Vert. Just. At Top of 
Para and At Bottom of Para options are set at zero. You may want 
to add more space if the tag's font is bigger than Body Text. 

• Between Lines of Paragraph option in the Paragraph Typo­
graphy option dialog box (Paragraph menu) is set at zero. If you 
want to use this control, set it at about 10% of the Body Text tag 
Inter-Line spacing. For tags which have larger fonts, such as head­
ings, you can set this to a larger proportion of that tag's inter-line 
spacing. 

If Body Text in adjacent columns must be kept aligned, then select 
Carding for the Vert. Just. Within Frame option in the Chapter 
Typography option dialog box (Chapter menu) and make every verti­
cal justification setting in the Chapter Typography, Frame Typo­
graphy, Paragraph Typography, and InsertlEdit Table dialog 
boxes an integer multiple of Body Text inter-line spacing. 

Refer to the vertical justification headings for the Frame Typography 
and Paragraph Typography option sections for further information 
on controls which affect vertical justification. 

Vertical justification example 

The example shown in Figure 8-13 shows how a page looks with the 
frame, paragraph, and inter-line spacing all working together. 
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Chapter 1 

• The Adventure Begins 
This trip really began in September last 

year when Gerry won first prize in a raffle at 
the fashion show which Rush-Presbyterian­
St. Luke's Medical Center holds every year. 
The prize was two round trip tickets to Hong 
Kong on United Airlines, and ten nights in the 
Hong Kong Hyatt Hotel. Analyzing our good 

fortune, we concluded that we wanted to do 
more than spend ten days in Hong Kong and 
return, but at the same time, United, having 
just gotten its routes and equipment from Pan 
American, had not yet received authority to 
fly to other destinations or between points in 
the Far East. 

On February 10th, United acquired this 
authority, and on February 11th Debbie began 
putting our trip together. We left on March 
2nd and returned on March 26th. We entered 
seven countries, traveled over25,OOO miles on 
four airlines, made over 500 Kodachrome® 
slides, almost 200 Kodacolor® prints, and 5 
112 hours of color and sound videotape. 

• Chicago to Tokyo 
11 :03 P.M. Chicago time. 39,000 feet 

somewhere over the Western Pacific, we are 
8 hours and 42 minutes out of Los Angeles 
with about 2 more hour to go to Tokyo. We 
were about an hour and ten minutes late out of 
Los Angeles. 

Chapter 1 

• The Adventure Begins 
This trip really began in September last 
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Chapter Typography 

Figure 8-13. Vertical justification (on right column) with space added around 
frame, between paragraphs and between lines within the paragraph. The 
Chapter 'TYpography and Paragraph Typography controls were set exactly as 
described m this section. 
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Vertical Justification Within Frame 

The Vert. Just. Within Frame option enables vertical justification. 
When set to Off, no vertical justification takes place within the chapter. 

When set to Feathering, the exact space required to make the text 
reach the bottom of the column is added between frames and text, and 
between paragraphs. When set to Carding, space is only added in 
multiples of the Body Text tag inter-line spacing (see Figure 8-14). 
Carding lets you achieve the goal of vertical justification (e.g., a uniform 
page bottom from one page to the next) while maintaining baseline 
alignment of body text from column to column and across facing pages. 
By contrast, feathering adds the exact space required, but body text in 
adjacent columns may no longer align. 

Carding does not force body text to align. Rather, it maintains alignment 
if each paragraph in the style sheet is designed so that its spacing is an 
exact multiple of Body Text's inter-line spacing. 
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Figure 8-14. Cardinfi (on the left) versus Feathering (on the right). Feathering 
adds space more uniformly, but may result in mis-alignment between Body Text 
lines in adjacent columns. 

Vertical Justification Around Frame 
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The Vert. Just. Around Frame option determines how space is added 
around a frame on a page. You have two choices. If set to Fixed, each 
frame remains fixed in its position. Space is only added below the frame. 
If set to Moveable, the frame is moved down to create space above the 
frame. Extra space is then added below the frame. You should always 
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select Moveable unless your layout requires that frames not move at 
all. See Figure 8-15. 
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Figure 8-15. Fixed frame does not allow space to be added to any paragraph 
above the frame, or to the frame itself. 

At Top of Frame 

The At Top of Frame option sets the maximum amount of space that 
can be added between a frame and the text which precedes it. This 
amount is in addition to the Vertical Padding setting for that frame in 
the Sizing & Scaling option dialog box. At Bottom of Frame operates 
in the same manner. Both of these options are available for selection 
only if the Vert. Just. Around Frame option is set to Fixed or 
Moveable. 

8-17 



CHAPTER MENU Chapter Typography 

If different amounts are set for the At Top of Frame and At Bottom 
of Frame options, and if less than the maximum amount of space is 
needed to make the last line of text reach the bottom of the page, then 
the space is added proportionally to the top and bottom of all frames in 
the column. For example (assuming just one frame in the column): 

• At Top of Frame is set at 24 points. 

• At Bottom of Frame is set at 12 points. 

• Six points additional space is needed to make the text reach the exact 
bottom of this column. 

• Then four points will be added above the frame and two points below 
the frame. 

Vertical Justification Allowed 
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The Vert. Just. Allowed option determines the amount of vertical 
justification on each page. The normal setting for most work is 100%. 
This setting is available for selection only when the Vert. Just. Within 
Frame option is set to Feathering or Carding. 

On any given page, the amount of space that can be added is determined 
by the maximum settings in the Chapter Typography, Frame Typo­
graphy, and Paragraph Typography option dialog boxes. If text still 
will not reach the bottom of the page even after all this space has been 
added, then no vertical justification takes place at all. This prevents the 
creation of very loose pages on the last page of a chapter, before a page 
break, and other circumstances where little text appears on the page. 

You can increase or decrease the maximum amount of space which 
vertical justification attempts to fill by specifying a value for Vert. Just. 
Allowed greater or less than 100%. For instance, if the Vert. Just. at 
Top option of a paragraph is 12 points, and if you specify a Vert. Just. 
Allowed value of 150%, Ventura Publisher will actually try to add up 
to 18 points before deciding not to vertically justify a given page. 
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Headers & Footers 

The Headers & Footers option defines text which is placed at the top 
and bottom of each page in the chapter. 

Each header and footer can have three separate entries: one left-just­
ified, one centered, and one right-justified, each up to two lines. 

You can also specify different headers and footers for the left and right 
page. Thus, pages 1, 3, 5, 7, ... can have a different set of headers and 
footers from pages 2, 4, 6, 8. 

Chapter numbers and page numbers can be inserted into any header or 
footer. 

Also, you can automatically create headings for books, manuals and 
directories by copying, to the header or footer, the first and/or last 
occurrence on a page of any paragraph tagged with a specified tag. 

Use the Headers & Footers option to: 

• Create page and chapter numbers. 

• Create automatic section titles. 

• Create directory headings. 

• Create chapter headings. 

Operation 

To create headers and footers: 

>- Select the Headers & Footers option in the Chapter menu. The 
Headers & Footers option dialog box (Figure 8-16) is displayed. 
Additionally, a floating Tags list is displayed allowing easy insertion 
of tag names for the First Match and Last Match options. 
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Figure 8-16. Headers & Footers dialog box. The word Page is set at 12 point. 

If either the right or left header/footer doesn't appear on the screen when 
you click on the OK button, make sure the Sides option in the Page Size 
& Layout dialog box is set to Double. Also check to make sure you have 
defined a header or footer for both the left and right pages. Finally, 
make sure the header/footer is turned on for this page. (Refer to Show 
Page Header, and Show Page Footer options later in this chapter.) 

Define Use the Define option to define either a header or a footer (or both) and 
whether the header or footer will be on the right or the left hand page. 
Each of these options have their own Usage setting and definition entry 
fields. 

Usage Use the Usage options to set the state of any of the Define options. The 
U sage option for the selected Define option must be set to On before 
the definition entry fields will be available. 

Definition entry The definition entry fields are where the text that is to appear in the 
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fields header or footer is entered. Each of the Define options have different 
definition entry fields allowing you to define different headers and 
footers for the left and right pages. The definition entry fields also allow 
the entering of text attribute codes and other special codes for format­
ting the headers and footers. The codes are described below. 

Inserts The Inserts options allow you to enter special codes and format the text 
entered in the definition entry fields. Inserts are entered into the 
definition entry fields by placing the typing cursor at the location in the 
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desired definition entry field and then selecting the desired insert. The 
Inserts options and their function are: 

Chapter #/Page # 

Use the Chapter # and Page # inserts to place a chapter or page 
number in the header or footer. 

Selecting the Chapter # insert places the [C #] code in the definition 
field. Selecting the Page # insert places the [P#] code in the definition 
field. 

Chapter and page numbers automatically start with one (1). You can 
override this default, however, using the options in the Update 
Counters option dialog box (Edit menu). 

1 st Match/Last Match 

Section and chapter headings are often placed in the header or footer of 
a long document or directory. Changing these headers as you revise a 
document can be a time-consuming and error-prone process. Fortu­
nately, Ventura Publisher can automatically place section headings and 
chapter titles in the header or footer. 

For instance, suppose that you want text tagged with a tag called Major 
Heading to appear left-justified on each left page. 

>- Select the Left Page Header option. 

>- Place the text cursor in the Left: entry field. 

>- Select the Major Heading tag from the floating Tags list. 

>- Select the 1st Match option at the bottom of the dialog box. You will 
see the following appear in the Left entry field: 

[<Major Heading] 

This command copies the first occurrence of text tagged with the Major 
Heading tag to the top left of every left-hand page. If no text on a given 
page is tagged as Major Heading, the most recent paragraph in the 
chapter tagged with Major Heading is used. In this way, a section that 
continues for several pages will have the same headers. The headings 
at the top of every page in this Reference Guide were automatically 
generated using this feature. Figure 8-16 shows how to place text from 
paragraphs tagged with Major Heading and Minor Heading into the left 
page header. 
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Headers & Footers 

Ventura Publisher also copies any index entries in the tagged text to the 
header or footer; as a result, index entries can be created to specify the 
entire range of pages in a section of the document. For instance, if the 
paragraph tagged with the Header tag contained an index entry, the 
page numbers listed in the index for that index entry would include all 
pages in which the text from the Header tag appeared in the header or 
footer. 

Ventura Publisher copies all attributes and font changes from the 
tagged text into the header or footer. 

Text Attr. 

You can use the text attributes described in Appendix D to modify the 
header or footer text. Selecting the Text Attr. option inserts the code 
<D> into the definition entry field. The D can then be replaced with the 
desired attribute codes. 

Figure 8-16 shows how these attributes can be used to change the word 
Page to 12 point. 

The <%n> kerning code cannot be used in a header or footer. Use the 
<Kn> code to control the kerning of text in headers and footers. Refer to 
Appendix D for more information using the kerning codes. 

Copy To Facing Page 

If the Sides option in the Page Size & Layout dialog box is set to 
Double, you can cause a header or footer to be mirrored on opposite 
pages using the Copy To Facing Pages option. 

For example, the heading used in this Reference Guide are set using the 
Copy To Facing Pages option. For all left hand pages, the primary 
head (the text associated with tag assigned to the chapter title) is set as 
a left header, and the secondary head (the text associated with the tag 
assigned to the section title) is set as a right header. By using the Copy 
To Facing Pages option, the primary head appears on the left of all left 
hand pages and on the right of all right hand pages. The secondary head 
appears on the right of all left hand pages, and on the left of all right 
hand pages. 

If the Sides option is set to Single, and the Start On option is set to 
Left Side in the Page Size & Layout dialog box, only the left page 
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header and footer are used. The converse is true for Single and Start 
On: Right Side. 

Date and time 

Although there are no insert option for this feature, time and date can 
also be entered in the headers and footers. The date and time are 
entered in the header or footer by entering the following codes in the 
definition entry field. 

[D] = Date 

[H] = Time 

The format of the time and date is determined by the format set in the 
Windows Control Panel. Additionally, text attribute codes can be used 
to set the size, typeface, color, etc. of the time and date headers. 

A time entry in the header or footer will update each time the page is 
refreshed. 

Header/footer continuation 

The current match option is another feature for which no insert option 
exist. The current match feature allows more flexibility in controlling 
the information placed in the header or footer. Unlike the First Match 
and Last Match options, the current match feature allows you to 
specify that the text associated with a particular tag appear in the 
header offooter, even if the text appears on a previous page. This feature 
also allows you to specify additional text to appear in the header or 
footer if the text associated with the tag appears on a previous page. For 
example, the "Copy to Facing Page" heading on the previous page could 
appear as "Copy to Facing Page (Continued)" in the header or footer of 
this page. It is also possible to make text associated with a tag not 
appear in the header or footer if the text appears at the top of a page. 

Use of this feature is described in detail in the Creating Continuation 
Headers and Footers section of Chapter 14. 

Cancel Click on the Cancel button to exit the dialog box abandoning all changes 
made in the dialog box. 
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Taggi ng headers & footers 
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The tags Z_HEADER and Z_FOOTER are automatically created the 
first time you create either a header or footer. These header and footer 
tags are each initially assigned Body Text tag attributes. However, you 
can change the tag attributes for both header and footer. For instance, 
to place the header closer to the body of the document: 

~ Click on the Paragraph tool button. 

~ Select the header. 

~ Click on the Spacing option button and increase the header tag's 
Above spacing. 

To place the footer closer to the body of the document, decrease the footer 
tag's Above space. 

To place a ruling line below each header: 

~ Click on the Paragraph tool button. 

~ Select the header. 

~ Click on the Ruling Line Below option button. Customize as 
desired. 

If the header Above space plus the header Below space is larger than 
the top margin, the top margin will be increased beyond what you set 
for the page's top margin. 

To correct this situation: 

~ Click on the Paragraph tool button. 

~ Select the header text paragraph. 

~ Click on Spacing option button. 

~ Decrease the Above or Below space. 

The same procedure applies to footers. 

You cannot change the tab settings for the Z_HEADER and Z_FOOTER 
tags. 
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Show Page Header/Footer 

The Show Page Header or Show Page Footer options enable (and 
suppress) the header or footer for the current page. 

Operation 

To turn the headers off for the page currently displayed, disable the 
Show Page Header option in the Chapter menu. To turn headers back 
on, enable the Show Page Header option again. A check mark will be 
displayed next to the menu option when the option is enabled. The 
Show Page Footer option works identically. 

The state of the Show Page Header and Show Page Footer options 
remains associated with the page number shown in the page number 
indicator, even if text is moved from one page to another. Therefore, do 
not turn headers or footers off until you have finished creating the chap­
ter. 
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Footnote Settings 

The Footnote Settings option controls the chapter footnote format­
ting. Footnotes are created using the Insert Special Item: Footnote 
option in the Text menu (refer to the Text menu chapter for more 
information on inserting footnotes). 

Operation 

Usage & Format 
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~ Select the Footnote Settings option in the Chapter menu. The 
Footnote Settings dialog box (Figure 8-17) is displayed. 

Figure 8-17. Footnote Settings dialog box. 

# From Start of Page (1,2,3). This restarts footnote numbering at 
the top of each page, and numbers each footnote with an Arabic 
number. 

# From Start of Page (User-Defined). Same as above, but instead 
of Arabic numbers, each footnote reference is shown by whatever is 
defined in the User Defined Strings entry field. The default strings 
are shown in Figure 8-17, but you can enter any other characters for 
up to eight footnote references per page. 

# From Start of Chapter (1,2,3). Same as the first option above, but 
the numbers continue increasing throughout the chapter. 
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You must select one of the three options above, or you can't create foot­
notes for the chapter. 

Start with To start footnote numbering at a number other than one, place the text 
cursor in the Start With # entry field and enter the starting number. 
This is useful when you are printing a single chapter in the middle of a 
long document. 

Number template You can place fixed text immediately before and after the footnote 
reference at the bottom of the page by typing up to three characters in 
the Number Template entry field. The # character specifies where to 
place the footnote number. For example, typing (#) on this entry field 
places parentheses around each footnote reference number at the bot­
tom of the page. 

Position of N ext, select your choice of Subscript, Superscript, or No Shift. These 
number settings control the vertical placement of the footnote reference number 

or character within the text. The size and placement (e.g., superscript 
and subscript font size) of the footnote reference in text is controlled by 
the Attribute Overrides option settings for the tag of the paragraph 
in which the reference in placed. 

The placement of the matching footnote number at the bottom of the 
page is controlled with paragraph tag settings. The procedure for 
modifying these settings is described at the end of this section. 

User defined If you selected the # From Start of Page (User Defined) option, you 
strings may alter any or all of the character strings that appear in the User­

Defined Strings entry fields. Use the cursor and backspace keys to 
erase the default characters, and then type in the ones you wish to 
substitute. 

Ruling lines If you want to place a ruling line above the footnotes at the bottom of the 
page, enter the Space Above Line, Height of Line, and the 
Separator Line Width (the width of this line). The separator line 
width controls the length of the line across the page and is measured 
from the left margin. 

To turn footnotes off, select the Off option and then click on the OK 
button. Turning footnotes off does not affect the footnote text stored in 
the text files. As soon as footnotes are turned back on, all footnotes will 
once again be displayed. 
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You can place footnote references on the base page only. Ventura Pub­
lisher ignores footnotes in frames or in box text. 

Footnote frames 

Footnotes are placed at the bottom of the page in a frame that Ventura 
Publisher creates when footnotes are turned on. This frame is automat­
ically enlarged as you add additional footnotes. If you wish, you can 
select this frame using the Selector tool and change any of the attributes 
available in the Frame menu to achieve different footnote formatting. 
You cannot, however, change the number of columns in the footnote 
frame. 

If you have specified a large amount of Above or Below space for the 
Body Text tag prior to turning footnotes on, the frame which is automat­
ically created to hold the footnote will be much larger than you probably 
want. To correct this problem: 

~ Click on the Paragraph tool button. 

~ Select the footnote number. 

~ Click on the Spacing option button and decrease the Above or 
Below option settings. 

Repeat this process for the footnote text. 

Customizing footnote tags 

The footnote number at the bottom of the page is automatically assigned 
a tag called Z_FNOT #, and the footnote text is automatically tagged 
with a tag called Z_FNOT ENTRY. You can change each of these tags 
independently to achieve different formatting effects. Use the various 
Paragraph tool options to customize the footnote number and entry tags. 

Footnote One common effect that you can create by changing the Paragraph 
numbers menu options for the Z_FNOT # and Z_FNOT ENTRY tags is to place 

the footnote number on the same line as the footnote. To do this, follow 
the procedures given in the Auto-Numbering option section of the 
Paragraph menu chapter for placing section numbers on the same line 
as the paragraph that follows. 
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You can also make the footnote number at the bottom of the page 
superscript. To do this: 

~ Click on the Paragraph tool button. 

~ Select any footnote number at the bottom of the page. 

~ Click on the Font option button. Set the font size smaller than that 
of the footnote text. Initially the font size for the footnote number will 
be the same as that of the footnote text. Reduce the footnote number 
font size by 2 to 4 points. 

~ Click on the Breaks option button and set the Line Break option to 
Mter. 

~ Click on the Spacing option button and set the Above, Below, and 
Inter-Line options to zero. 

~ Select any footnote entry at the bottom of the page. 

~ Click on the Breaks option button and set the Line Break option to 
Mter. 

~ Click on the Spacing option in the Paragraph menu. Set the Above 
option setting to zero. Adjust the Inter-Line spacing to control the 
vertical placement of the footnote number in relation to the footnote 
text (typically 2 to 5 points). Adjust the Below spacing to control the 
spacing between footnote entries (typically equal to the font point size 
of the footnote text). Adjust these spacings as required to obtain the 
desired effect. 
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Insert IRemove Page 
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The InsertJRemove Page option allows you to insert or remove one or 
more blank pages anywhere in your chapter. Use the InsertlRemove 
Page option to: 

• Add additional pages when text is placed in frames (e.g., newsletter 
or newspaper layout). 

• Create multiple page formats in the same chapter. 

• Remove pages which have been added. 

Operation 

To insert a page: 

~ Go to the page where the new page is to be inserted. 

~ Select the InsertlRemove Page option from the Chapter menu. 
The InsertlRemove Pages dialog box (Figure 8-18) is displayed. 

Figure 8-18. Insert/Remove Pages dialog box. 

~ Select either the Insert New Page(s) Before Current Page or 
Insert New Page(s) Mter Current Page option, depending on 
whether the blank page or pages should appear before or after the 
currently displayed page. 

~ Enter the number of desired pages to add in the Number of Pages 
entry field. 

~ Click on the OK button. 
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Inserted page Any text file that you place directly in an inserted page, rather than in 
attributes a frame placed on top of the inserted page, automatically inserts addi­

tional pages as needed, until all text is placed in the chapter. Text 
already on the page that precedes the inserted page flows around the 
inserted file. 

Example: If text from file TEXTl.DOC originally flows from page one 
to page eight, and a new page is inserted between pages six and seven, 
the text from file TEXT1.DOC will flow from page one to page six, skip 
page seven, and finish on pages eight and nine. If you place the text file 
TEXT2.DOC on the blank page seven, and if this file fills five pages, the 
text in the file TEXTl.DOC will then flow from page one to page six, then 
finish on pages twelve and thirteen. The text from the file TEXT2.DOC 
will be placed on pages seven through eleven. 

All attributes from the original page are copied to the inserted page. 
However, you can customize the Frame menu settings for each inserted 
page. This allows you to change the page format in the middle of a 
document. You cannot, however, change from landscape to portrait 
format or vice versa. 

Remove current To remove an inserted page: 
page 

~ Use the Remove TextlFile option in the Frame menu to remove the 
file from the inserted page. 

~ Select the Remove Page(s) option from the InsertJRemove Page(s) 
dialog box. 

~ Enter the number of pages to remove in the Number of Pages entry 
field. 

The page is removed from the chapter. You cannot remove the current 
page until you have removed all files from that page. The chapter is 
reformatted from the first page of the chapter after you remove a page. 
If you select to remove multiple pages, pages are removed starting with 
the current page and progressing toward the end of the chapter until the 
selected number of pages have been removed. 

When you remove a page, the page number indicator counts through all 
the pages in the chapter and renumbers them. Do not become alarmed 
when you see this happen: only the page you selected is being removed. 
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Go to Page 

Go to Page 

Click on the Go to Page function button to go directly to a desired page 
in your chapter. Use the Go to Page option to: 

• Find a specific page in a long chapter without searching. 

• Find the page on which a selected file continues, in a chapter which 
contains multiple text files. 

This is especially helpful in a newspaper or magazine layout, where 
many articles are placed across multiple, noncontiguous pages. 

Operation 
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To go to another page: 

> Click on the Go to Page function button, or press Ctrl+G. The Go To 
Page dialog box (Figure 8-19) is displayed. 

Figure 8-19. Go to Page dialog box. Set to go to page 21. 

> Select which page to go to. You can go to the first, previous, next or 
last page in the chapter merely by selecting one of these options from 
the Which Page list box, and then selecting the OK button. 

You can also go directly to a specified page number by choosing Selected 
and then entering the appropriate page number in the Selected Page 
entry field. The current page number is shown for reference. 

To halt a Go to Page operation, press the Esc key. 
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Go to next page In newsletter, newspaper, or magazine documents, text files can start in 
in file a frame on one page and then continue in a frame on a much later page. 

In a chapter with many files, it can become difficult to find the next page 
that contains the remainder of the file. The Relative To File option 
solves this problem. To go to the next page that contains text from a 
selected file: 

~ Using the Selector tool, select the frame that contains the file. 

~ Click on the Go to Page function button. 

~ Select the File option from the Relative To list box. 

~ Set the Which Page option to First, Prev , Next, or Last to go to the 
first, previous, next, or last page which contains text from the selected 
file. 

When you change pages, you must place the text cursor at the desired 
location on the new page before you can resume editing. 

Keyboard shortcuts 

To move forward or back one page at a time, or go to the beginning or 
end of a chapter, use the following keyboard shortcuts (make sure Num 
Lock is off if you are using the number pad keys): 

Action Keyboard shortcut 

Previous page Page Up key 

Next page Page Down key 

First page Home key 

Last page End key 

Page buttons 

The page buttons also allow you to maneuver through your document. 
Click on the upper page button to display the previous page of the 
chapter or double-click on the upper button to display the first page of 
the chapter. Click on the lower page button the display the next page of 
chapter, or double-click on the lower page button to display the last page 
of the chapter. 
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Set Screening 

Set Screening 

The Set Screening option allows you to define chapter-wide screening 
model and line screen values. The values set in this dialog box will apply 
to all components of a chapter with the exception of gray-scale images 
which use the screening values set in the Image Settings dialog box. The 
Set Screening options are applicable only when used in conjunction 
with the Ventura Scan and Ventura Separator color extension products. 

The Set Screening options are used to: 

• Determine optimal scan resolution for images being scanned into 
Ventura Publisher using the Ventura Scan color extension product. 

• Optimize the output of your chapter for the device on which it will be 
printed (e.g., laser printer or image setter) after the chapter is 
separated using the Ventura Separator color extension product. 

Operation 
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Chapter-wide screening is set by selecting a screening model. A screen­
ing model is a set of values which directly correlate to a specific output 
device. The screening model contains information about the CMYK 
screening angles, line frequency, dot function, and resolution used by 
imagesetters. 

The screening models allow Ventura Scan to calculate the optimum 
resolution for images scanned into Ventura Publisher. The screening 
model also allows the chapter to be printed or separated using settings 
that are optimal for the device (imagesetter) on which the chapter will 
ultimately be output. 

The screening information is saved with the chapter. This allows the 
chapter to be sent to a service bureau using Ventura Publisher with 
Ventura Separator installed for separation using the screening values 
you set in the Select Screening Model dialog box. If the service bureau 
changes the screening values, or applies a custom screening model using 
Ventura Separator, the values set using Ventura Separator will be saved 
with the chapter. 
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To set the screening for your chapter: 

~ Select the Set Screening option from the Chapter menu. The Select 
Screening Model dialog box (Figure 8-20) is displayed. 

Figure 8-20. Select Screening Model dialog box. 

~ Select a screening model from the Screening Model list box. The 
options in this menu correlate to the device on which the chapter will 
ultimately be output as shown in the following table. 

Screening Model Option Output Device 

Default 300 Laser Printer 
Default 600 Varityper or CompugraJ)hic 
Default 635 Linotype 
Default 1200 Varityper or Compugraphic 
Default 1270 Linotype 
Default 1524 ECRM Pell Box - Monotype 
Default 1693 Linowe 
Default 2400 Varityper or Compugraphic 
Default 3048 ECRM Pell Box - Monoty~e 

Default 3386 Linotype (models 330 & 530 only) 

~ Select a halftone line screen option from the Line Screen menu. The 
halftone line screen determines how fine (or coarse) the image will be 
when output. This option is particularly important when using con­
tinuous-tone pictures in your chapter. The lower the line screen 
value, the coarser the image will be when output. 

~ Save the chapter. Since the screening information is saved with the 
chapter, you must save the chapter in order for the settings to be 
saved. If you change nothing in your chapter but the screening values 
and then select Open Chapter or Quit from the File menu before 
saving the chapter, you will be asked if you want to save the chapter. 
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FRAME MENU 

Margins & Columns ... 
Sizing & Scaling ... 
Frame Iypography ... 

Anchors & !;.aptions ... 
Repeating Frame ... 

!lertical Rules ... 
Ruling Line Above ... 
Ruling Line Below ... 
Ruling Bo~ Around ... 
frame Background ... 

R~move Text/File ... 
File Type/Rename ... 
Image Setting ... 

Add New Tag ... 
Update Tag List ... 

Figure 9-1. Frame menu. 

The Frame menu controls the format of frames, as well as the page 
format (remember, the page is just another frame). Using the Selector 
tool option buttons you can control margins, columns, ruling lines, frame 
sizing and scaling, frame typography, anchors and captions, background 
fill patterns, and image settings. 

The base page itselfis much like any other frame, except that Margins 
& Columns settings for the page are stored in the style sheet file. All 
other frame settings are stored with the chapter file. 

Changes made to any page affect all non-inserted pages (refer to In­
sert/Remove Pages section in the Chapter menu chapter). Changes to 
each inserted page or changes to frames which you draw affect only that 
one page or frame. 

The Selector tool must be enabled and a frame selected to gain access to 
the frame editing option buttons. 
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Margins & Columns 

9-2 

Click on the Margins & Columns option button to set the margins for 
any page or frame, including frames automatically generated by Ven­
tura Publisher (e.g., header, footer, footnote, or caption frames). 

For the page or for any frame, Margins & Columns sets: 

• The top, bottom, left, and right margins 

• The number of columns 

• The width of each column and inter-column spacing (gutters) 

Use the Margins & Columns option to: 

• Set unique margins & columns for each frame 

• Set different margins and column widths for left pages than right 
pages 

• Create complementary facing pages 

• Create padding between an image in a frame and the edges of the 
frame 

Operation 

You can change the margins and number of columns for the page or any 
frame by following the basic steps which follow. For special situations, 
you must modify these steps slightly as described in the sections on the 
next several pages. 

Generated frames such as header, footer, footnote, and caption frames 
cannot be set to multiple columns. 

Basic steps The basic steps given here allow you to create pages or frames which 
have the same widths for each column and the same margins for the left 
and right pages. 

~ Click on the Selector tool button. 

~ Select the frame or page to be changed. 
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~ Click on the Margins & Columns option button. The Margins & 
Columns dialog box (Figure 9-2) is displayed. 

U of ~olumns: 01 @20 3 04 05 06 07 

lieUings For:C Left Page @' Right Page 

Widths liutters 
CQlumn·l: [0 rI:!IJ 

2:[0 ... [0 
3:[0.[0 
4:[0[0 
5:[0<[0 
6:[0 •.• [0 
7:[0[0 
8:[0 

Actual Frame 'Width';' 8.5 

o Copy To Facing Page 

I···.· ()~ 

Figure 9-2. Margins & Columns dialog box. Right page settings shown. 

~ Select the number of columns you want for the page or frame you 
selected. 

~ Set each margin (top, bottom, left, right). 

~ Set the first gutter space (the space between the first and second 
column). 

~ Select the Make Equal Widths option. 

~ Click on the OK button. 

Ventura Publisher will automatically calculate the column widths. 

Unequal column You can also independently set each column's width as well as the gutter 
widths space between each column. This allows you to create unusual page 

designs where each column is different from the next. 

~ Select the number of columns. 

~ Set each margin (top, bottom, left, right). 

~ Set each column width. 

~ Set each gutter space. 
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Mter entering all information, but before selecting the OK button, make 
sure that the Calculated Width (which shows the current sum of left 
margin, right margin, column widths, and inter-column space) equals 
the Actual Frame Width. Ventura Publisher cannot do this for you 
because you have independent control over each setting, and it is, 
therefore, possible to create margin and column widths that don't equal 
the width of the page or frame. 

If the margin and column appearance on-screen does not match what 
you specified, check to make sure that the Calculated Width value 
equals the Actual Frame Width value. 

If the Sides option is set to Double in the Page Size & Layout option 
dialog box, each frame or page can have different margins, column 
widths, and gutter space for the left pages than for the right pages. This 
is useful for creating binding margins and for making left pages which 
look different from right pages. 

To set different margins and columns for left and right pages, follow the 
procedures for either equal or unequal column widths. However, before 
clicking on the OK button, select Settings For the other page, then 
enter all settings for that page. You must set both pages before you click 
on the OK button or the settings for the one page will be automatically 
reflected to the other page. 

Copy to facing page 

You can mirror the left and right margin and column settings of one page 
to the opposite page by selecting the Copy to Facing Page option. The 
margin settings automatically reflect, e.g., the right margin setting on 
one page becomes the left margin setting on the opposite page. 

Whenever you create a caption using the Anchors & Captions option, 
a frame is automatically created for the new caption. This caption frame 
is automatically attached to the frame which contains the picture. The 
caption frame's settings can be changed independently by selecting it 
and setting its margins. The caption frame can also be selected and 
made larger or smaller. 

Hint: if you set different left/right page margins for a frame, use the 
Anchors & Captions option after you have set the frame's margins. 
Since the caption's initial margins are copied from the frame's margins, 
this eliminates the need to set the caption's margins. 
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Header & footer When you first create a header or footer, a frame is automatically 
frames created to hold it. This frame's margins are initially set to vertically 

center the text. To place the headers and footers in a different location 
within the header or footer frame you can change either the frame 
margins or change the header or footer paragraph tag's above, below, or 
leftJright spacing. Changing the tag spacing is a better choice because it 
is stored in the style sheet and will therefore affect other documents in 
a similar manner. 

Footnote frames When you first create a footnote, a frame is automatically created to hold 
it. The frame's margins are initially set to vertically center the footnote 
text. However, like header & footer frames, you can change either the 
frame margins or the paragraph's above, below, or left/right spacing to 
change the footnote's location within a frame. 
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Sizing & Scaling 

Click on the Sizing & Scaling option button to precisely control the size 
and placement of frames. It also allows you to exactly control picture 
reduction or enlargement and position within the frame. Finally, this 
option controls the way text is formatted around a frame. Use the 
Sizing & Scaling option to: 

• Control the flow of text around a frame 

• Place the frame at a precise location 

• Scale pictures 

• Crop pictures 

• Create runarounds 

Operation 

Text flow around When you create a frame, Ventura Publisher automatically causes text 
in your document to flow around it. You can override this setting, either 
to allow text to be superimposed on pictures, or to create runarounds. 

To allow text to flow under a frame, set the Flow Text Around option 
to Off. If the text contains tabs, text may not completely flow around 
frames. 

Use of this option to make text wrap around irregularly shaped pictures 
is covered in Chapter 14. 

Frame placement Normally, you would use the mouse to position frames where you want 
them on a page. If, however, you want to position a frame with absolute 
precision, use the Sizing & Scaling option as follows: 
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~ Click on the Selector tool button. 

~ Select a frame. 

~ Click on the Sizing & Scaling option button. The Sizing & Scaling 
dialog box (Figure 9-3) is displayed. 



Sizing & Scaling 

£lowText Aiound: ~ 

Left Side: m 
Frame :w.idth: §] 

H,2riz. Padding: D 
J:jctUteScaling:@'Fit in Frame 

Aspect Ratio: ~'Maintained 

HOJi!. Crop~ D 
Pict. Width: ~ 

lOPSide:··~ 

Frame .H.eight: 0' 
Yerl. Padding: D I'-~~~~"" 

r OK 

Figure 9-3. Sizing & Scaling dialog box. 

FRAME MENU 

> Set the Left Side and Top Side coordinates of the frame. These 
numbers refer to the distance of the upper left corner of the frame from 
the upper left corner of the physical page (Figure 9-4). 

i 
Top Side 

Left Side ---J 
1 -

Frame 
Frame Height 

Page ----f 

r- Frame Width -.j 

Figure 9-4. Frame placement defined. 

> Set the frame size by modifying the Frame Width and Frame 
Height settings. 
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Padding Padding is particularly important when you place pictures across 
column boundaries in multi-column documents. Use Vert. Padding to 
control the spacing between frames and adjacent text and to prevent 
vertical rules between columns from touching the top and bottom of the 
picture frame. Use Horiz. Padding to keep text in adjacent columns. 
from touching the sides of the picture. 

Scaling Pictures The Picture Scaling and Aspect Ratio options let you control a 
picture's size and aspect ratio. 

Fit in frame 

When you set the Picture Scaling option to Fit In Frame, you can 
increase or decrease the size of a picture by changing the size of the 
frame that contains it. 

If you set Aspect Ratio option to Maintain, the height to width aspect 
ratio of the original picture is maintained as you make the frame larger 
and smaller (Figure 9-5). By contrast, setting Aspect Ratio to Dis­
torted scales the picture to fill the entire frame, even if this distorts the 
image (Figure 9-6). 

By scale factors 

Setting the Picture Scaling option to By Scale Factors (Figure 9-7) 
allows you to precisely increase or decrease the size of the picture, 
independent of the size of the frame. When you select this option, the 
Pict. Width and Pict. Height options control the width and height of 
the picture. For instance, setting Pict. Width to 03.00 inches makes the 
picture exactly three inches wide. 

Figure 9-5. Fit in 
Frame, Aspect Ratio: 

Figure 9-6. Fit in 
Frame, Aspect Ratio: Dis­
torted. 

Figure 9-7. By Scale Fac­
tors. Scale width & height 
both doubled. Maintain 
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When you set the Aspect Ratio option to Maintained, only the Pict. 
Width option can be set. The Pict. Height is automatically increased 
or decreased as necessary to maintain the original aspect ratio of the 
picture. Neither the Pict. Width nor Pict. Height values can exceed 27 
inches. 

When you set the Aspect Ratio option to Distorted, you can enter 
settings for both the Pict. Width and Pi ct. Height options. 

Cropping Any picture can be cropped as follows: 

> Click on the Selector tool button. 

> Select the frame which contains the picture you wish to crop. 

> While pressing the Alt key, place the mouse cursor in the center of 
the selected frame. 

> Press and hold the mouse button and move the image to a new 
location within the frame. 

Ignore any "clutter" that may be created as you crop the image. This will 
be eliminated when you release the mouse button. 

You can also crop pictures by specifying the Horiz. Crop and Vert. 
Crop amount. These numbers move the scaled picture relative to the 
frame (see Figure 9-8). You can specify positive and negative numbers 
to move the picture in either direction. 
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Actual Picture Size ---+ 
(shaded area) 

Frame 
(1.25 x 1.5 inch) 

Horizontal Crop (+) 

Vertical Crop 
(+) 

Figure 9-8. Cropping for picture which is scaled 1.5 inches in the horizontal 
direction, 3.0 inches m the vertical direction. Horizontal crop is +0.25 inches. 
Vertical crop is +0.50 inches. 

Custom size The Page Size & Layout option offers several fixed page sizes. If your 
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pages document requires that you create custom size pages, use the Frame 
Width and Frame Height options to create a custom size page. Custom 
pages must be smaller than the size selected in the Page Size & 
Layout option dialog box. To create custom size pages, follow these 
steps: 

~ Click on the Selector tool button. 

~ Select the page. 

~ Click on the Sizing & Scaling option button. 

~ Set the Frame Width and Frame Height to the size of the page you 
want to create. 

~ Click on the OK button. 

Note that after you click on the OK button, the custom page is positioned 
at the upper left corner of the page. If you want to center the custom 
page, adjust the Left Side and Top Side values as necessary. 
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Bitmapped Bitmapped images look best when printed at exactly their original size. 
images If this is not feasible, you can obtain the next best results by making the 

picture an exact integer multiple larger or smaller (e.g., 2X, 3X, 4X ... 
or V2X, V3X, V4X ... ). If you scale the picture by an odd amount, the 
picture may be marred by horizontal and vertical moire lines. These 
result from the scaling process and are unavoidable. 

You will see similar moire lines when the image is displayed on the 
screen. These lines result from the difference between the resolution of 
the screen and the printer resolution. They are normal, do not affect 
printing, and should be ignored. 

To ensure that your bitmapped images are always scaled correctly, al­
ways set the Picture Scaling option to By Scale Factors and the 
Aspect Ratio option to Maintained. Immediately after you select By 
Scale Factors, the Picture Width option will show the original size of 
the image. If you click on the OK button at this point, the picture will 
print at exactly its original size, with the best possible quality. If you 
want to double or halve the size of the image, simply enter a Picture 
Width which is exactly twice or half the original picture width. 
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Frame Typography 
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Click on the Frame Typography option button to override the global 
settings defined in the Chapter Typography Settings dialog. Settings 
will apply only to the frame or inserted page you have selected. Use the 
Frame Typography option to fine-tune the typography on a given 
page. 

Operation 

~ Click on the Selector tool button. 

~ Select the frame or inserted page you wish to change. 

~ Click on the Frame Typography option button. 

The Frame Typography option dialog box (Figure 9-9) is displayed. 
Operation of the options in this dialog box is identical to the operation 
of the Chapter Typography Settings dialog box. Selecting Default sets 
that option to the value provided in the Chapter Typography Settings 
dialog box. Selecting any other setting overrides the Chapter Typo­
graphy Settings dialog box settings for this frame. 

Figure 9-9. Frame Typography Settings dialog box. 
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The vertical justification controls in the Frame Typography option 
dialog box function in the identical manner to those in the Chapter 
Typography Settings dialog box. Having separate controls for each 
frame allows you to: 

• Increase or decrease the vertical justification space around a selected 
frame. 

• Enable or disable vertical justification for text placed within a frame, 
contrary to the global setting in the Chapter Typography Settings 
dialog box. 

• Enable or disable vertical justification for inserted pages, contrary to 
the global setting in the Chapter Typography Settings dialog box. 

If you want to change vertical justification for text placed within the 
frame, change Vert. Just. Within Frame and Vert. Just. Allowed. 

If you want to change the amount of space added around the frame, 
change Vert. Just. Around Frame, then specify At Top of Frame and 
At Bottom of Frame values. 

Remember that if text is placed into an inserted page, additional in­
serted pages are automatically created until all text is flowed. A change 
made to any of the inserted pages which contain this text file will affect 
all pages which contain this text file. 
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Anchors & Captions 
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Click on the Anchors & Captions option button to: 

• Assign an anchor name to a frame. 

• Create captions for pictures by attaching a caption frame above, 
below, or to the left or right of any given frame. 

• Automatically generate figure/table numbers. 

• Anchor a picture to a location in the text. 

Three different caption counters-a Table # counter, a Figure #, and a 
Chapter # counter-can be used to number captions. These counters 
are automatically updated as you add and delete captions. Refer to the 
Update Counters section in the Edit menu chapter. 

All captions for a chapter are stored in the chapter's caption (CAP) file. 

Operation 

~ Click on the Selector tool button and select a frame for which you 
want to create a caption or specify an anchor name. 

~ Click on the Anchors & Captions option button. The Anchors and 
Captions dialog box (Figure 9-10) is displayed. 

Figure 9-10. Anchors and Captions dialog box. 

If a frame tag has been applied to the selected frame, the name of the 
frame tag will appear in the title bar of the dialog box. Changes made in 
this dialog box when a frame tag name is displayed in the title bar will 
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affect all other frames in the chapter having the same tag applied. Refer 
to the Creating a Caption section (page 9-16) for information on how 
frame tags are affected by changes made in this dialog box. 

Anchor Enter the anchor name you wish to assign to a frame in the Anchor 
entry field. This name must exactly match the anchor name you inserted 
into the text using the InsertlEdit Anchor option. Whenever the 
Re-Anchor Frames option is selected from the Edit menu, this frame 
will be moved to the page that contains the corresponding anchor 
reference in the text. 

Caption 

If the anchor name entered into the Anchor entry field has previously 
been applied to another frame, the following alert is displayed when you 
click on the OK button. 

A tag/frame bl' that name 
already exisl$;Trl' again 
with a differenfname. 

Click on the OK button to re-display the Anchors and Captions dialog 
box and give the frame a different anchor name. 

Selecting an option other than Off from the Caption list box will cause 
a caption frame to be created. The caption frame is attached to the frame 
for which the caption is being created, and will be placed according to 
the option selected from the Caption list box. Selecting the Off option 
from the Caption list box will remove the caption frame if one exists. 

The creation and location of the caption frame becomes part of the frame 
tag associated with the frame to which the caption is attached. The op­
tion selected from the Caption list box will affect all frames having the 
same frame tag as the tag associated with the frame to which this cap­
tion is attached. 

Refer to the Creating a Caption section (page 9-16) for information and 
procedures for creating a caption frame and entering caption text. 

Label The Label entry field allows you to enter text that is initially entered in 
the caption frame. This entry field should be used for text associated 

9-15 



t-HAME MENU Anchors & Captions 

9-16 

with the variable text entered into frames (e.g., figure number, table 
number). Other descriptive text should be entered directly into the 
caption frame after the caption frame is created. 

The text entered in this field becomes part of the frame tag associated 
with the frame to which the caption is attached. The text entered in the 
Label entry field will appear with all frames having the same frame tag 
as the tag assoCiated with the frame to which this caption is attached. 

Refer to the Creating a Caption section below for information and 
procedures for creating a caption frame and entering caption text. 

Inserts The Inserts options allow you to set up counters in the Label entry 
field. The inserts are used for automatic numbering of figures and tables 
contained with in the frame to which the caption is associated. 

You can use either the table or figure number (not both) plus chapter 
number in each caption. 

For example, if the caption settings shown in Figure 9-10 were the ninth 
caption in the fifth chapter, and the previous eight captions all specified 
the [F#] figure counter, this caption would display as: 

Figure 5-9 

If you want to change the text attributes of the generated portion of the 
caption, click on the Text Attr. button. The default code <D> for normal 
body text is displayed. You can modify this code to insert other text 
attributes, as described in Appendix D. 

Refer to the Creating a Caption section below for information and 
procedures for creating a caption frame and entering caption text. 

Creating a Caption 

When a caption is created, the caption frame consists of two paragraphs. 
The first paragraph contains the text (and inserts) entered in the Label 
entry field of the Anchors and Caption dialog box. This part of the 
caption contains text automatically generated by Ventura Publisher, 
including the chapter, table, and figure counters. This text is stored in 
the chapter (CHP) file. 
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The second paragraph can contain any text you wish, and can be as long 
as you like. This text is entered by typing the text directly into the 
caption frame. 

The text entered directly into the caption frame will not appear in cap­
tions of other frames sharing the same frame tag. Only text entered into 
the Label entry field of the Anchors and Captions dialog box will appear 
in the caption of frames having the same frame tag. 

To create a caption: 

> Click on the Selector tool button. 

> Select the frame for which a caption is to be created. 

> Click on the Anchors & Captions option button. The Anchors and 
Captions dialog box (Figure 9-10) is displayed. 

> Select a option from the Caption list box corresponding to the desired 
placement of the caption frame. 

> Type the first part of the generated caption on the Label entry field. 
This is usually a word like figure or table. 

> Using the Inserts options, select the Table #, Figure #, or Chapter 
# options at any point that you want to insert a generated number. 
Selecting these options places the following codes on the label entry 
field: 

Inserts Code 

Table # [T#] 

Figure # [F#] 

Chapter # [C#] 

> Click on the OK button. 

If the selected frame is tagged with a frame tag that is shared with other 
tags in the chapter, the following alert is displayed. 
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caption text 
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Anchors & Captions 

Click on the Apply Globally button to confirm the change to the tag 
and apply it to all other frames tagged with the frame tag. 

Click on the Untag Frame button to apply the change, but remove the 
tag assignment from the frame. The attributes of the frame tag will 
remain in affect for that frame. However, the caption changes made to 
the frame will not effect the frame tag, and changes to the frame tag will 
no longer affect this frame. 

Click on the Apply New Tag button to display the Add New Tag dialog 
box and create a new tag name. The created frame tag will have the 
same attributes of the old tag as well as the new changes. 

Click on the Undo Changes to abandon the changes made to the frame. 

Once the caption frame is attached, it always moves with the original 
frame, even when you use the Cut, Copy, or Paste options in the Edit 
menu. You can resize the caption frame in the vertical direction. 

To remove a caption, select the frame and set the Caption option to Off. 

If no text is displayed in the caption frame, click on the Selector tool 
button, select the caption frame, and make this frame longer or wider 
until the caption is displayed. Then click on the Paragraph tool button, 
select the caption, and adjust the above, below, and in from left/right 
space as necessary using the Spacing option button. 

If you make the caption frame longer you will notice an end of file mark 
o in the caption frame next to or below the caption. Select the Text tool 
button, and place the text cursor directly in front of this end offile mark. 
You can then type additional text directly into the caption frame in 
exactly the same manner as you would add text to any other frame in 
the chapter. By making the caption frame larger, you can make this 
free-form caption very long. 
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It is important that this text be entered in the caption frame rather than 
the Label entry field of the Anchors and Caption dialog box. Any text 
entered in the Label entry field is also saved with the frame tag 
associated with the frame. The text entered directly into the caption 
frame is not part of the frame tag. 

This additional text is saved in the chapter's caption (CAP) file. 

Caption tags A number of tags are automatically generated when you add a caption 
to a frame. The basic attributes for these tags are initially copied from 
Body Text tag. 

Caption text consists of two paragraphs; a paragraph generated by 
entering text in the Anchors and Captions dialog box, and additional 
text entered direct into the caption frame. 

You can change the caption tags so that additional caption text immedi­
ately follows the generated caption. To do this: 

> Click on the Paragraph tool button. 

> Select the generated caption (the first paragraph). 

> Change the generated caption's tag attributes using the Paragraph 
tool option buttons as follows: 

Paragraph option Setting 

Font Same as additional text caption 

Line Break Before 

Alignment Left 

Spacing No space below 

Ruling Lines Above (As desired) 

Ruling Lines Below None 

> Select the additional text paragraph and change the tag attributes to: 

Paragraph option Setting 

Font Same as generated caption 

Line Break Mter 

Alignment Indent relative to previous line plus 1 pica 

Spacing No space above 

Ruling Lines Above None 

Ruling Lines Below As desired 
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Anchors & Captions 

The figure captions in this document consist of two parts. For instance, 
the words "Figure 5-45" are created in the caption dialog box, and the 
remaining text is entered as additional text using the Text tool. 
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Repeating Frame 

Click on the Repeating Frame option to duplicate a frame, its ruling 
lines, background, and contents, on every page in the chapter. Use the 
Repeating Frame option to: 

• Create a letterhead, placing the company logo on every page of the 
chapter. 

• Create thumb tabs by placing a box at the edge of every page with a 
page number in it. 

• Place a large header or footer on every page. 

Operation 

~ Create the frame you wish to repeat. If it is to repeat on left pages 
only, make sure you create it on a left page. The same comment 
applies to the right page. 

~ Load a picture or text file into the frame, or simply enter text in the 
frame. 

~ Add ruling lines, background pattern, etc. 

~ Make sure that this frame is selected. 

~ Click on the Repeating Frame option button. The Repeating Frame 
dialog box (Figure 9-11) is displayed. 

Figure 9-11. Repeating Frame dialog box. 

~ If you want the frame to appear only on left pages, set the For All 
Pages option to Left. If you want the frame to appear only on right 
pages, set the For All Pages option to Right. 
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Repeating Frame 

~ If you want the frame to appear on both left and right pages, set the 
For All Pages option to Left & Right. The frame is automatically 
reflected, like a mirror image, on facing pages as shown in Figure 
9-12. 

The Sides option in the Page Size & Layout dialog box must be set to 
Double for this mirror effect to occur. 

Left Page Right Page 

Figure 9-12. Repeating Frames reflected. 

To place the frame in the same position on both left and right pages 
without reflecting: 

~ Copy the frame to the next page. (Refer to the Copy option section in 
the Edit menu chapter.) 

~ Select the frame on the left page, then set the For All Pages option 
to Left. 

~ Select the frame on the right page and then set the For All Pages 
option to Right. 

You can select a repeating frame, but the selection boxes around the 
edge of the frame are displayed in gray rather than black to alert you to 
the fact that this frame is a repeating frame. Repeating frames cannot 
be cut, copied, or pasted. They can, however, be resized and moved. Any 
change made to a repeating frame changes every occurrence of that 
frame on all pages. 

You can repeat up to six separate frames within a chapter. Repeating 
frames cannot have captions. 
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Hide/show To remove a repeating frame from the current page only: 
repeating frames 

~ Click on the Frame tool button and select the frame. 

~ Click on the Repeating Frame option button. 

~ Select the Hide This Repeating Frame option in the Repeating 
Frame option dialog box. 

To restore this frame to view, select Show This Repeating Frame. 
Once you select another frame, however, you must select Show All 
Hidden Frames to make all hidden repeating frames on the current 
page reappear. You can then selectively re-hide any repeating frame on 
the current page that you don't wish to see. 

Delete repeating To remove a repeating frame from the entire chapter: 
frames 

~ Click on the Frame tool button and select the repeating frame. 

~ Click on the Repeating Frame option button. 

~ Set the For All Pages option to Off in the Repeating Frame dialog 
box. 

The frame is removed from every page except the current page. Since 
this is now a normal frame, you can remove it from the page using the 
Cut option in the Edit menu. 

Large headers To creClte a header larger than allowed by the Headers & Footers 
and footers option or create a multi-column header: 

~ Disable the Show Headers & Footers option in the Chapter menu. 

~ Create a frame at the top of a page. Make it extend the entire width 
of the page. Make its height equal to the top margin. 

~ Type the header text directly into this frame. Use the Cross Ref. 
option in the Insert Special Item secondary menu (Text menu) to 
insert page or chapter numbers into this frame. 

~ Make this frame a repeating frame. 

The same technique works for footers. Use the Cross Ref. option to 
place chapter and page numbers in this repeating frame. 
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Create more Normally, the same exact text appears in each repeating frame, even if 
columns per you place a large text file in the frame. However, if you first place the 

page text file in the page, then continue it into the repeating frame, the text 
will flow naturally from page to page. 
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This means you can use repeating frames to create more columns per 
page, or to produce unusual formats. For instance, you can produce 
documents where text flows into a single column at the top of the page, 
and then into four columns at the bottom of the page. 

To create this effect: 

~ Place a text file in the page. 

~ Draw a frame. 

~ Use the Margins & Columns option to set four columns in the 
selected frame. 

~ Continue the text file from the page into this frame by selecting the 
text file name in the Files list. This will cause the text in the page to 
continue into the frame. 

~ Click on the Repeating Frame option. 

~ Set the For All Pages option to Left & Right to make this frame 
repeat on both left and right pages. 

~ Optional: draw yet another frame (up to six repeating frames are 
allowed) and repeat the previous three steps. 

On each page, the text will flow from the page into the repeating 
frame(s). 

Do not completely cover the page with repeating frames when using this 
technique. Some text must still flow into the page. 

This same technique can be used to create a large document which 
contains more columns per page than the eight Ventura Publisher can 
normally handle. Simply start the text on the page and continue it into 
several frames. Each frame can have up to eight columns. Since the page 
can have eight columns and up to six repeating frames are allowed per 
chapter (each of these with up to eight columns) it is possible to create 
a document containing up to 56 columns on each page. 
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Click on the Vertical Rules option button to set ruling lines in the 
gutter between each column on either left pages, right pages, or all 
pages, or between columns of text within any frame. You can also place 
up to two vertical rules anywhere within a page or within a frame. Use 
the Vertical Rules option to: 

• Place rules between columns 

• Place rules at edge of page or column 

Operation 

~ Click on the Selector tool button. 

~ Select the frame in which you want to place vertical rules. 

~ Click on the Vertical Rules option button. The Vertical Rules dialog 
box (Figure 9-13) is displayed. 

Figure 9-13. Vertical Rules dialog box. 

Settings For The Settings For options allow you specify different vertical rules for 
left and right pages. 

Inter-Col. Rules To place ruling lines between each column, set the Inter-Col. Rules 
option to On and enter the inter-column rules Width value. 
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Rule 1 Positionl The Rule 1 Position and Rule 2 Position entry fields allow you to 
Rule 2 Position specify where the vertical rules will appear in the currently selected 

frame. The rule position valu.es ar-e measured frol1l the left edge of the 
physical page, not the edge of the frame (Figure 9-14). Also, the vertical 
rule settings are independent of the frame's margin settings. 

Vertical Rule Placement 
Measured From Edge Of 
Underlying Page 

Vertical 
Rule 
Within 
Frame 

q\'\". 

Figure 9-14. Vertical Rule placement is measured from the edge ofpage, not the 
edge of the frame. 

The unit of measure button to the right of the Rule 1 Position entry 
field allows you to change the unit of measure used for both the vertical 
rule position values. 

Rule 1 Widthl The Rule 1 Width and Rule 2 Width entry fields allow you to set the 
Rule 2 Width width of the vertical rules. If a value is not entered in an entry field, no 

vertical line will be shown for the corresponding vertical rule. 

The unit of measure button to the right of the Rule 1 Width entry field 
allows you to change the unit of measure used for both the vertical rule 
width values. 

Copy To Facing If the same settings are desired for the opposite page (when Double is 
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Pages selected for the Sides option in the Page Size & Layout option dialog 
box), choose Copy to Facing Page. If different settings are desired for 
the opposite page, select Settings For the opposite page, and enter the 
opposite page vertical rule information as described above. 
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Click on the OK button to exit the Vertical Rules dialog box and save the 
settings. Click on the Cancel button to abandon the setting changes and 
exit the Vertical Rules dialog box. 

If you don't immediately see a vertical rule within the frame, the frame 
is probably in the wrong position on the page relative to the rule 
position. (See Figure 9-14.) 

Frame-wide paragraphs (refer to the Alignment option in the Para­
graph menu) interrupt vertical rules. Column-wide paragraphs do not. 
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Ruling Lines 

You can place up to three ruling lines, each of different height and with 
different spacing between each rule. These ruling lines can be placed 
above, below, or around a frame or the page. Pattern and color can be 
assigned to each set of ruling lines. 

All three ruling lines dialog boxes function the same way. 

Use the ruling line options to isolate pictures or text in frames from the 
surrounding text. 

Operation 
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~ Click on the Selector tool button. 

~ Select the desired frame. 

~ Click on the appropriate ruling line option button (Ruling Line 
Above, Ruling Line Below, or Ruling Box Around). A dialog box 
corresponding to the type of ruling line option selected (Figure 9-15) 
is displayed. 

Figure 9-15. Ruling Lines dialog box. 
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Width Set the Width option to Frame to make this ruling line available. None 
of the other options in this dialog box are available until this option is 
set to Frame. 

Style The Style list box allows you to select from a number of pre-defined line 
styles. If you don't want to use one of the pre-defined styles, click on the 
User-Defined button. 

User-Defined 

When the User-Defined option is selected, the User-Defined Rule Style 
dialog box (Figure 9-16) is displayed. 

s.pac~ •• fhOY~· •. ~.U.I.~ .. ·.I:· •. :=14====~ 
Space Above Rule. 2: 10 

:=======r 

Overall Height: 0 

m:~l II Cancel 

Figure 9-16. User-Defined Rule Style dialog box. 

Enter the appropriate ruling line height, as well as space between each 
ruling line, for each of the three rules. As soon as you move the text 
cursor to a new field, sample ruling lines appear to aid in determining 
the proper line thicknesses and spacing. This display is limited to about 
0.5 inch. The total height occupied by all ruling lines is shown on the 
Overall Height line of the U ser-Defined Rule Style dialog box. You can 
create larger ruling lines, but they will not display in the dialog box. 

The Dimensions button is used to change the unit of measure for the 
ruling line settings. 

You must click on the User-Defined button in order to gain access to 
the User-Defined Rule Style dialog box. 

Click on the OK button to exit the User-Defined Rule Style dialog box 
and save the settings. Click on the Cancel button to abandon the setting 
changes and exit the User-Defined Rule Style dialog box. 
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Color The Color list box allows you to select a color for the ruling lines. The 
same color and pattern is assigned to all rules defined for a particular 
frame. 

Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in this list box. 

Pattern The Pattern list box lists eight pre-defined ruling line patterns. These 
patterns range in shading value from 0% to 100% in 12.5% increments. 

Dimensions The Dimensions button is used to change the unit of measure for the 
dashed line settings. 

9-30 

Dashes If you wish to make dashed rules, check the Dashes check box. When 
checked, the Dash Width and Dash Spacing options become available. 

The Custom Indent and Custom Width options are not available for 
frame ruling lines. They are only available for paragraph ruling lines. 

Dash Width 

The Dash Width option allows you to enter a value for the amount of 
dash that will be visible between dash spaces. 

Dash Spacing 

The Dash Spacing option allows you to enter a value for the amount of 
space that will be visible between dashed lines. 

Depending on the resolution of your screen, the dashes may not display 
in the Normal view. If dashes do not display on the screen, select the 
Enlarged View option from the View menu to see the dashed lines. 

If ruling lines overwrite text or pictures inside the frame, increase the 
margins of the frame using the Margins & Columns option in the 
Frame menu. 
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Frame Background 

Click on the Frame Background option button to set the frame 
background color and pattern. Use the Frame Background option to: 

• Isolate a picture or text frame from the surrounding text. 

• For printers that support white on black printing, you can set the 
background to black and the text within the frame will automatically 
change to white. 

Operation 

~ Click on the Selector tool button. 

~ Select the desired frame. 

~ Click on the Frame Background option button. The Frame Back­
ground dialog box (Figure 9-17) is displayed. 

Figure 9-17. Frame Background dialog box. 

Color The Color list box allows you to select a color for the background of the 
currently selected frame. Select a color from the list box by clicking on 
the color name. 

Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in this list box. 
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Pattern The Pattern list box displays nine pre-defined ruling line patterns. 
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These patterns range in shading value from 0% to 100% in 12.5% 
increments. 

Selecting a background pattern that is too dark may make the printed 
output unreadable. For most applications, stay with the lightest pat­
terns. 

The background pattern fills the frame, minus: 

• The space above any ruling line above the frame, and below the ruling 
line below. 

• The space above the ruling box around. 
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Remove Text/File 
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Click on the Remove TextlFile option button to remove a file from 
either a frame or the Files list. The file is not deleted from disk. 

• Set the Remove from option to List of Files when you wish to 
eliminate one or more text or graphic files from a chapter. 

• Set the Remove from option to Frame when you wish to create an 
empty frame. Choose this option when you have set a frame's mar­
gins, columns, ruling lines, background pattern, etc., and want to use 
Copy Frame and Paste Frame options to create more frames with 
these identical settings, but with nothing in them. 

Operation 

To remove a file name from either the Files list or from a frame or page: 

~ Click on the Selector tool button and select the frame. 

~ Click on the Remove TextlFile option button. 

If the text in the frame was entered into the frame from within Ventura 
Publisher (i.e., not imported using the Load TextlPicture option) the 
following alert is displayed . 

.ili\·· .. ····D()y~~\IIi~ht~re~~~~ .. ih~ 
U ....... · ............................................................................. te ..•.. K ...•. · .. t. f.r.· .. ~~ ... t.h.· ~ ... s ...... e.· ...... I .. ~~le.d .. ·.f ..... ~ ..•.. ·.a ....•.... · ....... m .••. · .....•..•. e .. · •..•... · ....•.. or. cancel the·request1 

Click on the Remove Text button to remove the frame text from the 
frame. Click on the Cancel button to cancel the operation. 

Otherwise, the Remove File dialog box (Figure 9-18) is displayed. 
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Remove Text/File 

Figure 9-18. Remove File dialog box. 

~ If you selected a frame containing a file, the File Name entry field 
displays the name of the file in that frame. Ifno file name is displayed, 
enter the name of the file you wish to remove in the File Name entry 
field. 

~ Select the List of Files option from the Remove From list box to 
remove the file from both the frame and the Files list. Select the 
Frame option in the Remove From list box to remove the file from 
the frame but not from the Files list. 

It is a good idea to remove excess files from the Files list, since excess 
files slow down the time it takes to open a chapter. All text files in the 
Files list are loaded into memory, whether or not they are placed 
anywhere in the chapter. 

You can place a file into a frame, even if that frame already contains a 
text or picture file: 

~ Select the frame. 

~ Select a file from the Files list. 

When placing a file into a frame already occupied by a file, the first file 
will automatically be removed from the frame to make way for the 
second file. It is never possible to have two separate files occupying the 
same frame. 

If the frame contains frame text (text entered directly into the frame 
from within Ventura Publisher), the following alert is displayed. If the 
text cursor has been placed in the frame, but no text was entered, the 
frame, in effect, still contains frame text. 
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Click on the OK button to place the file in the frame (deleting the frame 
text). Click on the Cancel button to cancel the operation. 
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Click on the File TypelRename option button to create a new text file, 
or change the word processor format of an existing file. Use the 
Filefrype Rename option to: 

• Create a new text file. The next time the chapter is saved, a new text 
file is created. The file with the old name remains unchanged. 

• Convert from one word processor format to another. This option 
allows you to use text files from several word processors, and yet save 
each file in a common format. 

• Convert caption and frame text to text files. 

Operation 

> Click on the Selector tool button. 

> Select the page or frame containing the text file you want to rename 
or convert. 

> Select the File TypelRename option in the Frame menu. The File 
Type/Rename dialog box (Figure 9-19) is displayed. 

Figure 9-19. File Type/Rename dialog box 

> Enter or edit the new file name in the New Name entry field. 

> Select the word processor format to be used. 

> Click on the OK button. 
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When you next save the chapter, a new text file is created. The chapter 
will point to this new file instead of the old file. The old text file remains 
unchanged but will no longer appear in the Files list. 

Convert frame Text that you type into a blank frame is stored in the chapter's caption 
text to text files (CAP) file. This type of text is call frame text. If you select a frame, click 

on File TypelRename option button, and then specify a file name and 
text format, you can cause this text to be stored in a separate file rather 
than in the chapter's caption file. 

Converting text 
to a different 

word processor 
format 

You cannot convert the text within frame captions to separate text files. 

The chapter containing the converted frame text must be saved before 
the frame text will be saved to the specified file. 

Text loaded into a chapter using the Load TextlPicture option is loaded 
using a format option corresponding the the word processor in which the 
text was saved. If you select the frame containing the text, click on the 
File TypelRename option button, and then specify a file name and a 
different text format, you can save the text file as a different word 
processor format. 

The chapter containing the converted text must be saved before the 
frame text will be saved to the specified file. 
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Image Settings 

Image Settings 

Click on the Image Settings option button to control halftone process­
ing for images which contain shades of gray. This control is available 
only for TIFF images. In addition the image settings control only affects 
printing to PostScript printers. 

Gray-scale TIFF images will print to non-PostScript printers, but the 
image settings will have no effect. Also, a representation of a PostScript 
image is printed to non-PostScript printers if the PostScript file contains 
a TIFF bitmap or Windows metafile representation of the PostScript 
code (if an image is displayed on the screen, an image will print). 

Definitions 
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Gray-scale image. A gray-scale image is a scanned image in which 
every dot in the picture is a shade of gray rather than just black. 

Halftoning. Half toning is the process of modifying a gray-scale image 
so that it can be printed by a device that is capable of producing only 
black dots. Half toning converts each gray dot within a picture into a 
pattern of black dots: light shades are represented by sparsely spaced 
dots, while dark shades are represented by densely spaced dots. If 
half toning is done by the scanner, the resulting image is called a 
dithered image. The gray information for dithered images is thrown 
away before the image is brought into Ventura Publisher. Therefore, the 
Image Settings option is not available for dithered images. 

r 

Displaying gray-scale images 

When a gray-scale TIFF image file is loaded into a Ventura Publisher 
chapter, Ventura Publisher will attempt to display the image file as a 
gray-scale image instead of a dithered black and white image. The 
properties of the graphics card and graphics driver installed in Windows 
determine if a gray-scale image will display as a gray-scale image on the 
screen. Refer to Appendix G for a description of the necessary criteria 
for displaying gray-scale. 

The best way to test if your graphics system is capable of displaying gray 
scale in Ventura Publisher is to load the file POT4.TIF included on the 
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EXAMPLES Ventura Publisher program disk. If this image displays on 
the screen as a gray-scale image, other TIFF images containing gray­
scale information will display as gray-scale. If the image is displayed as 
a black and white dithered image, your graphics system is not capable 
of displaying gray-scale in Ventura Publisher. 

Operation 

To change the halftone image settings: 

> Select the frame which contains the gray-scale image. 

> Click on the Image Settings option button. The Image Settings 
dialog box (Figure 9-20) is displayed. 

Figure 9-20. Image Settings dialog box. 

> Set the Halftone Screen Type, Halftone Screen Angle, and 
Lines Per Inch options as desired and then click on the OK button. 

The image setting changes made to a gray-scale image will not be dis­
played on the screen but will be apparent when the image is printed. 

Recommended settings. Set the Halftone Screen Type option to 
Default for most work. This option uses the screen type stored in your 
printer and is optimized for your hardware. The screen angle is normal­
ly 45 degrees. Set the Lines Per Inch option to 60 for laser printers, 90 
for 1200 dot per inch typesetters, and 150 for 2540 dot per inch typeset­
ters. These settings will work for most situations. However, you may be 
able to dramatically reduce the size of gray-scale images, and also obtain 
better results if you understand the halftone process. This is described 
in the following subsection. 

t 
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The Custom option uses settings stored in the PS2.EFF file supplied 
with the DOS/GEM version of Ventura Publisher and is not useful with 
the Windows version of Ventura Publisher. If this option is selected in 
the Windows version of Ventura Publisher, the Dot screen type will be 
used. 

Halftoning process 
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The Image Settings option is but one control in the process which 
starts with scanning a photograph into the computer, and ends with the 
printing of that photograph from Ventura Publisher. 

A number of parameters in this process interact to produce various 
different levels of picture quality. What follows is a definition of each 
parameter along with recommended ranges. Use these formulas and 
ranges to decide the trade-off that is best for your particular situation. 

Printer resolution. Printer resolution is the number of dots that the 
printer can place within a square inch of paper or film. Laser printers 
usually print at 240, 300, 400, or 600 dots per inch. Most print at 300 
dots per inch. Once you buy a printer or typesetting machine, the dots 
per inch is fixed. 

Gray levels. Each dot which a printer or typesetting machine puts on 
paper or film is black, not a shade of gray. Therefore, gray must be 
approximated by a group of dots. For instance, you can print a small 
square which is five dots wide and five dots high. If you print all the dots 
in this little square, then the square looks totally black. If you print 
every other dot, then the square looks 50% gray. If you print only every 
fifth dot, then the square looks 20% gray. Thus, this little square in 
essence becomes a gray dot which can have 5 x 5 = 25 shades of gray. 
However, instead of being able to print 300 dots per inch, you can only 

. t 300 60 d t . h pnn -- = gray 0 s per Inc . 
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Screen frequency. The screen frequency refers to how many gray dots 
you place on the page per square inch. The screen is set in lines per inch. 
This unit of measure is used because in the traditional printing process, 
fine-mesh screens are placed over the photograph to convert the gray 
image into a series of dots. In the example in the previous paragraph, 
the screen frequency is 60 lines per inch. 
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Screen type and angle. The screen produces a regular pattern 
through the image. To make this pattern less noticeable, the screen is 
normally rotated at an angle with respect to the picture. Also, to create 
special effects, you can use screens which use patterns other than 
circular dots. 

Scanner controls. If you use a scanner to create an image, you can 
usually vary the number of gray levels stored with each image, as well 
as the resolution. Scanners which recognize and store gray information 
usually let you vary the number of gray levels stored with every dot in 
a picture. The more gray levels per dot, the bigger the resulting file. 
Typical values are 16 levels (4 bits per dot), 64 levels (6 bits per dot), and 
256 levels (8 bits per dot). Most scanners for desktop publishing can 
create images at 300 dots per inch, but let you scan at lower resolutions 
in order to create smaller files. 

Halftoning As you can see from the previous paragraphs, you can trade resolution 
guidelines for levels of gray. Therefore, before you scan an image, you should decide 

on the number of gray levels and the screen frequency you want. The 
relationship between these two is: 

Printer Resolution 
Screen Frequency = ----;::::.=====--

~Gray Levels 

Thus, if you want to print 25 levels of gray on a 300 dot per inch printer, 
you should select a screen frequency of 60 lines per inch. Typical screen 
frequencies and gray levels are as follows: 

• Screen frequency. Newspaper picture quality is created with 
screen frequencies of 65-75 line per inch. Magazine picture quality is 
created with screen frequencies of 120-150 lines per inch. 60, 75, 120, 
133, and 150 are typical values. 

• Gray levels. The eye cannot discern 256 different gray levels. There­
fore, storing more than 256 levels of gray is a waste of space. At the 
other end of the spectrum, 32 gray levels is coarse, but adequate for 
many uses. 

You can significantly decrease the size of scanned image files without 
degrading image quality by limiting scanner resolution to roughly the 
screen frequency, and by limiting the number of gray levels stored to just 
slightly more than the screen frequency and printer resolution allow. 
Restating the formula given earlier: 
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For instance, if you intend to print with a 60 line per inch screen to a 
300 dot per inch printer, you should scan the image at only 20% more 
than 60 dots per inch, which is roughly 75 dots per inch. Also, you should 
scan for just a little more than 25 levels of gray, which translates to 32 
or 64 gray levels on most scanners. You will need to experiment with 
your particular setup to find values that produce pleasing results with 
the smallest possible numbers. 

The scanner resolution you use also depends on the enlargement done 
in Ventura Publisher. The general formula is: 

Scanner Resolution ~ 1.2 x Screen Frequency x Magnification 

Thus, if you plan to double the size of the image using the Sizing & 
Scaling option, and you have set screen frequency to 60 lines per inch, 
you should scan the image at 1.2 x 60 x 2 ~ 150 dots per inch. The factor 
of 1.2 is based on experience. You should experiment to see what works 
for you. 

Finally, if you want to create special effects, you can try changing the 
Halftone Screen Angle and Halftone Screen Type options. 

Figures 9-21, 9-22, and 9-23 show the results of changing the Lines 
Per Inch setting. The image was scanned at 75 dots per inch with 16 
levels of gray. 

Figure 9-21. 45 de­
gree angle, 30 lines 
per inch, default 
screen. 

Figure 9-22. 45 de­
gree angle, 60 lines 
per inch, default screen. 

Figure 9-23. 45 de­
gree angle, 120 lines per 
inch, default screen. 
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Click on the Add New Tag option button to create new frame tags. 
Frame tags allow you to save combinations of frame characteristics in a 
tag that you can apply to frames. This ensures consistency between 
frames of a similar type within a chapter. For example, you might want 
to set up frames with the same size, border and background throughout 
a chapter. Additionally, you can maintain the same frame consistency 
throughout your chapters by creating frame tags in one chapter, and 
using the Merge Tags option in the Update Frame Tag List dialog box, 
merge the frame tags into your other chapters. 

Refer to the Frame tags section starting on page 3-12 for a detailed 
description of frames tags and their use. 

Operation 

To add a new tag: 

~ Either click on the Add Frame tool button and draw a new frame or 
click on the Selector tool button and select an existing frame. 

~ Click on the Add New Tag option button. The Add New Tag dialog 
box (Figure 9-24) is displayed. 

Figure 9-24. Add New Tag dialog box. 

~ If the currently selected frame has previously been assigned a tag, 
that tag name will appear in the Copy From list box. If you want the 
tag to have the initial properties of another frame tag, select the name 
of that frame tag from the Copy From list box. If the currently 
selected frame does not have a tag assigned, you can select the 
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<Selected Frame> option in the Copy From list box to apply the 
properties of the currently selected frame to the frame tag. 

~ Enter the name of the new tag in the Name to Add field. Try to make 
the name as descriptive as possible. The name can be up to 13 
characters long. 

~ Click on the OK button. 

If the name entered in the Name to Add entry field is the same as that 
of an existing frame tag, the following alert is displayed. 

Click on the OK button to return to the Add New Tag dialog box and 
specify a different tag name in the Name to Add entry field. 
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Update Tag List 

The Update Tag List option provides several tools to help you manage 
frame tags These tools include: 

• Add Tag 

• Delete Tag 

• Rename Tag 

• Load frame tags created in other chapters 

Refer to the Frame tags section starting on page 3-12 for a detailed 
description of frames tags and their use. 

Operation 

~ Click on the Selector tool button. 

~ Click on the Update Frame Tag List option button. The Update 
Frame Tag List dialog box (Figure 9-25) is displayed. 

Default 
<No Tag> 
Doodah 
Ima e Frames 

Figure 9-25. Update Frame Tag List dialog box. 

Add Tag The Add Tag option duplicates the function of the Add Tag option in 
the Frame menu. For more information about the Add Tag option, 
refer to the Add New Tag section of this chapter. 
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Delete Tag To delete a frame tag: 

The Default and <No Tag> frame tags cannot be deleted. However, the 
attributes of the Default frame tag can be changed. 

~ Select the tag you want to delete from the Tag List list box. 

~ Click on the Delete Tag button. The Delete Tag dialog box (Figure 
9-26) is displayed. 

Figure 9-26. Delete Tag dialog box. 

~ Frames tagged with the tag you are about to remove must be con­
verted to some other tag. Select this tag name from the Name to 
Convert to list box and then click on the OK button. If you don't 
specify a name the Default tag is used. 

The frame tags Default and <No Tag> are reserved by Ventura 
Publisher and cannot be deleted. If you have selected one on these tags 
names from the Tag List list box and click on the Delete Tag button, 
the following alert is displayed. 

Click on the OK button to return to the Delete Tag dialog box. 

Rename tag To rename a frame tag: 
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The Default and <No Tag> frame tags cannot be renamed. However, the 
attributes of the Default frame tag can be changed. 
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>- Click on the Rename Tag button. The Rename Tag dialog box 
(Figure 9-27) is displayed. 

HewTag Name: I Newsletter Text 

I; {Q:~l III, Cancel 

Figure 9-27. Rename Tag dialog box. 

>- Enter the new tag name in the New Tag Name field. This is the 
name that will replace the old frame tag name throughout the docu­
ment. 

>- Click on the OK button. 

If the name entered in the New Tag Name entry field is the same as 
that of an existing frame tag, the following alert is displayed. 

Cannot add . the .lag'[Tag Name}" 
because it ha$ alreadjlbeen defined, 

I·····•·• ·••· •... i.-.O .. · •. ·.· .. k .... · .. ~.,. .... .... _. 

Click on the OK button to return to the Rename Tag dialog box and 
specify a different tag name in the New Tag Name entry field. 

The frame tags "Default" and "<No Tag>" are reserved by Ventura 
Publisher and cannot be renamed. If you select one of these tag from the 
Tag List list box and click on the Rename Tag button, the following 
alert is displayed. 

Click on the OK button to return to the Rename Tag dialog box. 

Merge Tags Ventura Publisher stores frame tags in a file with the same name as the 
chapter but with an extension of FRM. For example, if you are working 
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on a chapter named EXAMPLEl.CHP, the frame tags are stored in a file 
named EXAMPLEl.FRM. 

V se the merge frame tags option to import frame tags created in another 
chapter. This feature allows you to maintain continuity between chap­
ters in a publication or between related documents. The Merge Frame 
Tags option also allows you to merge multiple frame tag files together. 
All the frame tags defined in a chapter are saved in the frame tag file 
associated with the chapter you are working on. If you merge two or 
more frame tag files that have frame tags with the same name, the 
frame tag that is merged first is the one that is used. To merge frame 
tag files: 

~ Click on Merge Tags button. The Open File dialog box (Figure 9-28) 
is displayed. 

Figure 9-28. Open File dialog box for frame tag (FRM) files. 

~ Use the Drives and Directories list boxes to locate the desired 
frame tag file. When the name of the desired frame tag file is shown 
in the File Name list box, either select the frame tag file name and 
click on the OK button, or double-click on the file name name. 

If the FRM file contains a frame tag with the same name as one in the 
currently loaded chapter, the frame tag from the FRM file will not be 
merged. Use the Rename Tag option to change the name of the tag in 
the currently loaded chapter, then merge the frame tag file. 
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font Settings ... 
Alignment ... 
~pacing ... 
Breaks ... 
lab Settings ... 
Special.Effects ... 
Attribute .Qverrides ... 
Earagraph Typography ... 

Ruling Line Abo~e ... 
Ruling Line Below ... 
Ruling Bo~ Around ... 

Auto-Numbering ... 
Qefine Colors ... 

Add New: Tag ... Ctrl+2 
.update Tag List ... Ctrl+K 

Figure 10-1. Paragraph menu. 

The Paragraph menu defines the individual tags (paragraph formats) 
contained within a style sheet. These tags are used to change the text 
format for each paragraph in a chapter. 

Each tag defines a set of font, alignment, spacing, and other typographic 
characteristics for a paragraph. A collection of tags, plus the current 
page layout and margin and column settings, is stored in a style sheet. 
Ventura Publisher includes a series of style sheets designed by typo­
graphers (refer to Appendix J). You can also create your own style sheets 
as described in Chapter 3. 

In order for the tag attributes options in the Paragraph menu to be 
selected, the Paragraph tool or the Text tool must be enabled and a para­
graph selected. 

The tag Body Text is reserved by Ventura Publisher. Although you can 
change the characteristics of the Body Text tag, you cannot remove or 
rename the tag. All text not formatted with a specific tag is automat- . 
ically formatted with the Body Text tag attributes. 
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Note that before you can change a tag's attributes, you must first select 
a paragraph that has been tagged with this tag. This allows you to see 
what that tag's attributes currently look like, and also allows you to see 
immediately the effect of any changes you have made. 

Any attribute changes made to selected text using the Text tool and the 
Text menu options, take precedence over the paragraph tag attributes. 

Selecting paragraphs 
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Paragraphs can be selected using both the Paragraph tool and the Text 
tool. 

Using the Paragraph tool, simply place the mouse cursor over the 
paragraph and click the mouse button. To selected multiple paragraphs, 
press and hold the Shift key while selecting the paragraphs. 

U sing the Text tool, simply place the cursor anywhere over text of the 
paragraph and click the mouse button. When the typing cursor is placed 
in text, the paragraph is, in effect, selected, and the tag attribute option 
buttons are available. 

To select multiple paragraphs with the Text tool, place the cursor 
anywhere inside of the first paragraph of text, click and hold the mouse 
button, and swipe the cursor over the paragraphs you wish to select. You 
are not required to select all of the text in the paragraph to select the 
paragraph. When the Text tool is used to select multiple paragraphs, 
only the text attribute options are available. Using these options will 
affect only the highlighted text and not the tag attributes. 

Only the Paragraph tool can be used for select noncontiguous para­
graphs. Selecting multiple paragraphs is only effective for applying tags 
to multiple paragraphs. If you select multiple paragraphs that are as­
signed different tags and change the tag attributes, the attribute chan­
ges affect only the tag assigned to the first paragraph selected. 
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The Font option defines the typeface, type size, type style (bold, italic), 
color, and attributes for each paragraph. Use the Font Settings option 
to: 

• Set the font for each paragraph tag 

• Change text to white to print white text on a black background 

• Change text colors for color separations 

• Create additional paragraph line attributes for tables 

Operation 

To change a tag's font: 

~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph assigned with the tag you wish to modify. 

~ Click on the Font Settings option button. The Font dialog box 
(Figure 10-2) is displayed. The typefaces and fonts available depend 
on the printer width table currently loaded. 

Figure 10-2. Font dialog box. Size option displays the word Custom for 
PostScript printers; displays discrete sizes for other printers. 
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Auto adjust 
styles 

Attributes 
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Font Settings 

~ Select the desired Face, Size, Style, Color, and Attributes options. 
The font Size options are displayed in points, where 72 points equal 
one inch. Ten, eleven, and twelve points are standard sizes for Body 
Text. 

Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in the Color list box. Custom colors can be created using the 
Define Colors option as described on page 10-60. 

When you click on the OK button, the paragraph selected, and all other 
paragraphs tagged with the same tag will be formatted with the new 
font. Note, however, that the paragraph font does not override any font 
attributes that you assign to blocks of text using the Text tool. 

For PostScript printers, select the size (in points) in the Custom Size 
entry field (Figure 10-2). Any integer size between 1 and 254 points is 
allowed. For other printers, only certain font sizes are available, and the 
Custom Size entry field is unavailable. Instead, select one of the 
discrete sizes under the Size option. 

Depending on the printer installed, not all styles are available for every 
typeface. With the HP LaserJet Plus, for instance, Normal type is avail­
able for 10 point Dutch (Times Roman) type, but is not available for 24 
point Dutch. You can add additional fonts to overcome these limitations. 
If you have a PostScript printer, you can print only the fonts actually 
installed in your printer or on your computer's hard disk. 

You can make adjustments to paragraph tags more automatic by setting 
the Auto Adjustments option in the Set Preferences option dialog 
box (Edit menu) to Styles or Both. Once set to Styles or Both, 
changing the size of the font will automatically change the tag's spacing 
and line attributes. For instance, changing from 10 point to 18 point 
increases the tag's Inter-Line, Inter-Paragraph, Above, and Below 
spacing by a factor of 1.8. If you want a different spacing, change the 
space in the Paragraph menu Spacing option dialog box after chang­
ing fonts. 

If you wish to apply an attribute to the entire paragraph as part of the 
tagging process, select the attribute or attributes from the Font dialog 
box. If you wish to change the attributes of selected text within a 
paragraph, use the Text tool and the Text tool option buttons as 
described in the Set Font Attributes option section of Text menu chapter. 
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The Alignment option controls the way in which text lines up within a 
column. The controls available include horizontal alignment, vertical 
alignment, text rotation, hyphenation controls, first line indent/outdent, 
decimal alignment, and column-wide or frame-wide overall paragraph 
width. Use the Alignment option to: 

• Change the justification and hyphenation of paragraph text. 

• Center headlines. 

• Align text within tables. 

• Force a paragraph to go across the entire frame or page, even when 
the document has multiple columns. 

• Cause the first lines in a paragraph to be indented either by a fixed 
amount, or relative to the length of the last line in the previous 
paragraph. 

• Change hyphenation algorithms or dictionaries (allowing simul­
taneous hyphenation in two languages within the same document). 

Operation 

~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph assigned with the tag you wish to modify. 

~ Click on the Alignment option button. The Alignment dialog box 
(Figure 10-3) is displayed. 
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Figure 10-3. Alignment dialog box. 

Horizontal Use the Horiz. Alignment option to align text horizontally within a 
alignment page, frame or box text. 

Selecting Left causes text to align with the left column guide; this type 
of alignment is also known as "ragged right." Selecting Right causes 
text to align with the right column guide. Choosing Center causes text 
to be centered within the column. 

Selecting Justified causes the edge of text to align evenly with both left 
and right column guides. Note, however, that tabs cannot be displayed 
with justified text. 

If the selected paragraph consists of numbers in a table, set the Horiz. 
Alignment option to Decimal to align text automatically without using 
tabs. The first decimal point in the line will be placed at the distance 
from the right margin that you specify using the In From Right to 
Decimal setting at the bottom of the dialog box. 

The default decimal character is a period. To change the decimal char­
acter to a comma (e.g., foreign language usage), refer to Set Preferen­
ces in the Edit menu section. 

Vertical Use the Vert. Alignment option to align a paragraph vertically within 
alignment a page, frame or box. Combine this option with the Horiz. Alignment 

option to place text at any corner, on any side, or in the middle of any 
page, frame or box text. 
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The Middle and Bottom options should be used only for text within 
frames or box text. Use on the page itself will work, but may become 
confusing. 

Text rotation Ventura Publisher allows you to rotate selected paragraphs in incre­
ments of 90 degrees. Use this option to create headings for tables or 
annotate graphs and charts which you have placed in frames. 

To use this option once you have set the alignment options: 

~ Select the desired rotation option from the Text Rotation list box. 
The available options are None, 90, 180, and 270. 

~ Set the Maximum Rotated Height option to the height you wish 
the rotated paragraph to occupy. 

Hints for rotating text 

Edit the text before you rotate it, if possible. If you must edit the text 
after tagging it for rotation, you may find it easier to tag the text 
temporarily with a tag which has the Text Rotation option set to None. 
Assign the tag which contains the rotated text attributes when you are 
finished editing. 

You will find rotated text easier to work with if you place the text in a 
box or frame rather than directly on the page. This is because rotated 
text displaces other text on the page. If you place rotated text in a frame 
or box, on the other hand, you can move the frame or box easily to 
position the text properly. You can then anchor the frame or box to the 
surrounding text. 

Hyphenation You can turn hyphenation on or off for any paragraph tag. Select the 
language for which hyphenation should be performed. The default 
installation sets both hyphenation options to US DIeT. Refer to Appen­
dix B if you want to change hyphenation. 

The Successive Hyphens option controls the number of consecutive 
lines of text that can be hyphenated. The default setting is 2. To change 
this number, select the desired number from the list box. 

The hyphenation algorithms can be overridden at any specific point in 
text by using discretionary hyphens. If you always want to hyphenate a 
word at a different place in the word, or if you don't want to hyphenate 
a given word, you can modify Ventura Publisher's hyphenation diction­
ary. Refer to Appendix B for more information on hyphenation. 
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Overall width To override column settings and make a paragraph print across the 
entire frame or page, set the Overall Width option to Frame-Wide. 
Text after a frame-wide paragraph continues below the frame-wide 
paragraph. Frame-wide paragraphs in other than the left column print 
over the paragraphs in the left column. Therefore, Column Balance 
should always be turned on whenever frame-wide tags are applied to 
paragraphs which are not at the top of the frame. Refer to the Chapter 
Typography section in the Chapter menu chapter for more information 
about column balance. 

Frame-wide paragraphs interrupt vertical rules. 

First line The First Line option allows you to force the first line of a paragraph 
indent/outdent in or out from the left margin by the space specified on the In/Outdent 

Width entry field. To set an indent of 0.1 inch: 

Relative indents 

10-8 

~ Set the First Line option to Indent. 

~ Set the Relative Indent option to Off. 

~ Position the text cursor on the In/Outdent Width entry field and 
type .1 (make sure the measurement units are set to inches). 

If you specify a temporary margin using the In From Left setting in the 
Spacing option dialog box, the In/Outdent Width value is calculated 
from this temporary margin. 

The In/Outdent Width setting can also be adjusted interactively using 
the markers on the tab bar. Refer to page 3-56 for more details on using 
the tab bar for adjusting the In/Outdent Width setting. 

Do not use the In/Outdent Width option in conjunction with right 
aligned or centered text. 

Setting the Relative Indent option to On adds a first line indent to the 
current paragraph exactly equal to the length of the last line in the 
previous paragraph. If you specify an In/Outdent Width value, Ven­
tura Publisher adds this additional fixed amount to the length of the 
previous line. When used in conjunction with the Breaks option in the 
Paragraph menu, this option is useful to create lead-ins. The Putting 
It Together chapter (Chapter 14) describes lead-in paragraphs in more 
detail. 

The In/Outdent Height option allows you to specify the number of 
lines for which the indent/outdent is to take effect. Normally, only the 
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first line is indented or outdented, but you can indent any number of 
lines. This can be used to make space for a lead-in which uses a much 
larger font. 

If you set the First Line option to Outdent, and then specify a very 
large number for In/Outdent Height, you can force the entire para­
graph to move to the left of the existing margin. 

To indent the entire paragraph, use the In From Left spacing option in 
the Spacing dialog box instead~ 
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The Spacing option controls the space between lines and paragraphs, 
and sets temporary margins. Use the Spacing option to: 

• Set inter-line spacing (leading) 

• Set space between paragraphs 

• Set temporary left and right margins (for quotes, bullets, etc.) 

• Create complementary left and right pages (Figure 10-4) . 
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Figure 10-4. Complementary left and right pages. 

Operation 
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~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph assigned with the tag you wish to modify. 

~ Click on the Spacing option button. The Spacing dialog box (Figure 
10-5) is displayed. 
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Above: EJ.II..o_ ......... __ -" 
!!elriw:. EJ 

Inter-Line: EJ.l"';'''''''''''''''''''''''''''''''''''''''''''''''''~ 

Inl~r • .eara~taph: . EJ 
And in Above:.· @ Always 

lieUings For: 0 left Page 
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Figure 10-5. Spacing dialog box. Add in Above When Not at Column Top 
means above space is not added when paragraph is at top of column or page. 

Above/Below The Above and Below spacing options both add additional space 
between paragraphs. For instance, if you set Inter-Line spacing to 
12.00 points and Below space to 12.00 points, you will create exactly 
one blank line between paragraphs, much like pressing the Enter key 
twice in a row in your word processor. However, unlike a word processor 
where you can only add discrete lines of space between paragraphs, 
Ventura Publisher allows you to add any amount of space above or below 
a paragraph. 

Interaction between above and below space 

Above and Below settings always add additional vertical space be­
tween paragraphs. Think of Above and Below space as the minimum 
acceptable blank space between the currently selected paragraph and 
the paragraphs which precede and follow it. 

Ventura Publisher prevents interference between Above and Below 
space settings for adjacent paragraphs. If, for example, you add Below 
space to a paragraph, and the paragraph that follows it has Above space 
added to it, only the greater of the two spaces is used. This option lets you 
design each paragraph tag without needing to compute the endless 
permutations of how much space can appear between each possible pair 
of paragraph tags. 

Inter-Line The Inter-Line spacing option ("leading") sets the space between the 
base of the characters on one line and the base of the characters on the 
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following line (Figure 10-6). Typesetting aesthetics usually allow a 
comfortable amount of spacing between lines, depending on the font size 
selected. A good rule of thumb is that inter-line spacing should be 
roughly 1.2 times the font size. Thus, a tag which uses 10 point type 
should have 12 point inter-line spacing. Make the Inter-Line spacing 
greater than this nominal amount when the columns in your document 
are wide. 

Inter-line space is measured 
from baseline of one line to 

baseline of the next line. 

Now is the time 
for all good men 
to come to the 

Total space between paragraphs is 
controlled by above, below, 

inter-paragraph, and ruling line 
space. See next paragraph for 

details. 

{ 
aid of their country. 

N ow is the time 
for all good men 
to come to the 
aid of their country. 

Figure 10-6. Paragraph vertical space. 

Inter-Paragraph Whereas Above and Below space always add additional space between 
paragraphs, Inter-Paragraph spacing only adds space between para­
graphs that have identical settings for Inter-Paragraph space. 

Inter-Paragraph space is occasionally useful when you want the space 
between similar paragraphs to be greater than the space between these 
paragraphs and the headings or other paragraphs which precede them. 
The &PRPT-P1.STY style sheet in Appendix J provides a good example 
of how to use the Inter-Paragraph spacing option. In this style sheet, 
the space between Body Text paragraphs is set with Inter-Paragraph 
space. The Inter-Paragraph settings for Head Levell and Head Level 
2, on the other hand, are different and, therefore, do not apply when the 
two types of paragraphs are placed adjacent to one another. 

For most style sheets, you will not need to use the Inter-Paragraph 
space setting. As a rule of thumb, use Above and Below space settings 
to control the amount of space between paragraphs, and set Inter­
Paragraph space to zero. 

Add in above Setting the Add in Above option to When Not at Column Top 
suppresses any Above space when the paragraph begins a new column. 
You should almost always select When Not at Column Top whenever 
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In From 
Left/Right 
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Above space is set to anything other than zero. Otherwise, you could 
introduce an extra undesired space at the top of a page. 

If you inadvertently set spacing in inches instead of points, you might 
set spacing which is greater than the page length. If this happens, an 
alert is displayed. The Spacing option dialog box settings will also be 
adjusted so that the paragraph will not be spaced off the page (and the 
next page, and the one after that, etc.). Readjust the spacing values so 
that the paragraph spacing is not greater than that of the page. 

This frame haS: te~twhich 
wQn'tJitonany .. pagijc)ue 
to·. invalidlag/columi1seuings. 
Change the hlg/columnsettings 
$Qthat. it ·can JormClr correctlY~ 

Set temporary margins using In From Left and In From Right 
options. In From Left and In From Right refer to the distance 
towards the center of the column from the column edges (Figure 10-7). 
You can set the In From Left and In From Right options differently 
for left and right pages. To enter different settings for each page, first 
set the Settings For option to Left Page and enter its In From Left 
and In From Right settings, then repeat for the Right Page. You can 
copy the In From Left and In From Right settings to the opposite 
page at any time by selecting Copy To Facing Page. 

Note that the Settings For option applies only to the In From Left and 
In From Right options, not to the rest of the spacing options. 

The In From Left and In From Right settings can also be adjusted 
interactively using the markers on the tab bar. Refer to page 3-56 for 
more details on using the tab bar for adjusting the In From Left and 
In From Right settings. 
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In From Left 
Margin is 
measured 
from left 
column edge 

In From Right 
Margin is 
measured 
from right 
column edge 

U
-+l 1+ 

- ==== 

Figure 10-7. In from left/right setting. 

Spacing 

Total space between paragraphs 
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The spacing between paragraphs depends on how the Move Down To 
1st Baseline By option is set in the Chapter Typography and Frame 
Typography dialog boxes. 

Inter-Line 

If the Move Down To 1st Baseline By option is set to Inter-Line, the 
following formula is used to calculate spacing between paragraphs: 

• Either the space Below value for the first paragraph or the space 
Above value for the second paragraph is used, whichever is greater 

plus 

• The Inter-Paragraph spacing is used, if it is the same value for the 
first and second paragraphs 

plus 

• The Inter-Line spacing of the second paragraph is used 

Cap-Height 

If the Move Down To 1st Baseline By option is set to Cap Height, 
the formula used to calculate spacing between paragraphs depends on 
the type size of the text in the first and second paragraphs. 
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When the first paragraph and the second paragraph have text of 
the same type size: 

• Either the space Below value for the first paragraph or the space 
Above value for the second paragraph is used, whichever is greater 

plus 

• The Inter-Paragraph spacing is used, if it is the same value for the 
first and second paragraphs 

plus 

• The Inter-Line spacing of the first paragraph 

When the type size of the second paragraph is larger than that 
of the first paragraph: 

• Either the space Below value for the first paragraph or the space 
Above value for the second paragraph is used, whichever is greater 

plus 

• The Inter-Paragraph spacing is used, if it is the same value for the 
first and second paragraphs 

plus 

• The Inter-Line spacing of the first paragraph plus the difference in 
type sizes between the first and second paragraphs 

When the type size of the second paragraph is smaller than that 
of the first paragraph: 

• Either the space Below value for the first paragraph or the Space 
Above value for the second paragraph is used, whichever is greater 

plus 

• The Inter-Paragraph spacing is used, ifit is the same value for the 
first and second paragraphs 

plus 

• The Inter-Line spacing of the first paragraph less the difference in 
type sizes between the first and second paragraphs 
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Other paragraph attributes such as a ruling line below the first para­
graph or a ruling line above the second paragraph will affect the spacing 
between paragraphs. However, the overall space of these attributes is 
simply added to the paragraph space as calculated previously. 

Extra carriage returns between paragraphs 

Because space between paragraphs is controlled by the paragraph tag's 
Above, Below, and Inter-Paragraph settings, you should press the 
Enter key only once at the end of each paragraph, not twice as you 
normally do in a word processor. If you have already created a document 
in a word processor which contains two carriage returns (Enters) at the 
end of each paragraph, go back to your word processor and place the 
following statement as the first line in the file: 

@PARAFILTR ON 
~ ~lace a space after the equal 

= / sIgn. 

This causes two consecutive carriage returns to be converted into one 
carriage return when the file is loaded into Ventura Publisher. (If you 
want to preserve two carriage returns at some point in your document, 
place a blank space in front of the second carriage return.) 

Multiple column spacing 

To ensure that text in adjacent columns aligns properly, the total verti­
cal space for every tag in a multi-column style sheet should always equal 
an integer multiple (e.g., 1, 2, 3, ... ) of Body Text tag's Inter-Line 
spacing. 

To assure that adjacent columns of Body Text always align when design­
ing a multi-column style sheet, follow these rules for each tag: 

> Set Inter-Line spacing to an integral multiple of Body Text's Inter­
Line spacing. 

> Set Inter-Paragraph spacing to an integral multiple of Body Text's 
Inter-Line spacing. 

> Set Above space and overall ruling line height above so that both 
together equal an integral multiple of Body Text's inter-line spacing. 
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~ Set Below space and overall ruling line height below so that both 
together equal an integral multiple of Body Text's Inter-Line spac­
ing. 

The style sheets in Appendix J provide examples of how to set multi­
column tag spacing. 

Margin width ruling lines 

Ruling lines which are set to Margin Width are affected by the In 
From Left and In From Right settings. A paragraph ruling line set to 
Margin Width will move in from the left and right margins by the In 
From Left and In From Right amount. 
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Breaks 

Breaks 

A break controls the flow of text between paragraphs. Mter a break, the 
next paragraph can begin on a new line (Line Break), at the top of a 
new column (Column Break), at the top of a new page or frame (Page 
Break), or at the top of the next left or right page or frame 
(BeforelUntil Left, BeforelUntil Right). 

The break can occur before, after, or both before and after the para­
graph. If your settings for a particular paragraph tag include Page 
Break: Before and Mter, for example, any paragraph so tagged will 
always start at the top of a new page, and will be the only paragraph on 
that page. 

Use the breaks option to: 

• Create vertical tabs 

• Create outdented heading 

• Create paragraph lead-ins 

• Create page breaks 

• Keep paragraphs from being split across columns or pages 

• Keep auto-numbers, footnote numbers and caption numbers on same 
line as text which follows 

Operation 
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To adjust the break settings for paragraphs: 

~ Click on either the Paragraph tool or the Text tool button. 

> Select a paragraph assigned with the tag you wish to modify. 

> Click on the Breaks option button. The Breaks dialog box (Figure 
10-8) is displayed. 
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Figure 10-8. Breaks dialog box. These are the appropriate settings for most 
tags. 

Page and The Page Break settings control whether text is forced to the next page 
Column breaks (or frame). For most tags, set the Page Break option to No. 

If you set the Page Break option to Before, then any paragraph tagged 
with this tag will appear at the top of a new page or at the top of the next 
frame. If you set the Page Break option to Mter, then the following 
paragraph will begin on a new page or in a new frame. 

The Page Break BeforelUntil Left option forces the text to a left page, 
inserting a blank right page if necessary. The Page Break 
BeforelUntil Right option forces the text to a right page, inserting a 
blank left page if necessary. 

Column Breaks work the same way except the paragraph is displayed 
at the top of a new column instead of a new page or frame. 

Line break A Line Break controls whether space is added between paragraphs. If 
you set the Line Break option to Mter for this paragraph, or Line 
Break option to Before for the next paragraph (or both), then the space 
between these two paragraphs is determined by the formula described 
on page 10-14. When no line break is set between two paragraphs, the 
space between these paragraphs is set by the Next Y Position option. 

Next Y Position The ''Y'' in Next Y Position refers to vertical space. 
Normal 

Assuming that the Page Break, Column Break, and Line Break 
between two successive paragraphs are all set to No, setting the Next 
Y Position option to Normal causes both paragraphs to begin at the 
identical vertical position on the page. This may cause both paragraphs 
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to print on top of each other, which is not particularly useful. However, 
if you increase the second paragraph tag's In From Left spacing, and 
increase the first paragraph's In From Right spacing, the two para­
graph's will print next to each other. This is how you create a vertical tab, 
as shown in Figure 10-9. 

First paragraph. No line 
break after. In From 
Right (Paragraph Spacing 
option) set to 12,00 picas 
from right margin, In 
From Left 7,06 picas from 
left margin. Allow Within 
set to NO, Keep With 
Next set to YES. 

Second paragraph. No line break 
before. In From Left (Paragraph 
Spacing option) set to 16,00 picas 
from left margin. Next Y Position 
set to Normal (which makes this 
paragraph format on the first line 
of the previous paragraph). 

Figure 10-9. Vertical tab. 

Next Y Position If no break of any type is set between two paragraphs and if the Next Y 
Beside Last Line Position option is set to Beside Last Line of Previous Paragraph 

for the second paragraph, the second paragraph begins on the same line 
as the last line of the previous paragraph. For example, the next 
"paragraph" is actually two different paragraphs. The first paragraph­
The style sheet examples-is formatted with the Line Break option 
set to Before. The second paragraph (the remainder of the text) is 
formatted with the Line Break option set to Mter, the Relative 
Indent option set to On (Alignment option dialog box), and the Next 
Y Position option set to Beside Last Line of Previous Paragraph. 

This is a 
separate -! The style sheet examples!in Appendix J show how tag options can be 
paragraph combined together. 
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Most paragraphs in the style sheets supplied with Ventura Publisher 
have the Line Break option set to Before. However, if you change Body 
Text Line Break option to Mter in order to place lead-ins or section 
numbers on the same line, as in the previous paragraph above, you may 
find that text sometimes overlaps the previous paragraph during text 
editing. To fix this problem, change the Line Break option from Before 
to Mter for the other tags in the style sheet. 



Each break further down in the dialog box is overridden by the break 
shown immediately above (e.g., if both the Page Break and Column 
Break options are set to Before, only the Page Break option takes 
effect). 

Allow Within This setting controls line breaks within a paragraph. You can use this 
setting to keep an entire paragraph together in a frame or on one page 
or column. If you set Allow Within to No, the tagged paragraph will 
never be split across the column, frame, or page boundaries. This setting 
is recommended: 

• When the Keep With Next is set to Yes. 

• For any heading or paragraph that is moved into the margin using a 
combination of Breaks and In from Left and In from Right spac­
ing. 

Keep with Next This setting can keep the tagged paragraph in the same column, frame, 
or page as the next paragraph. Set Keep With Next to Yes for lead-ins 
and section numbers. It is also recommended for headings, when you 
want to prevent headings from being left alone at the bottom of a page 
or column. 

The Keep With Next option should be set to No for Body Text, since 
Body Text paragraphs are usually separate paragraphs. 
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Tab Settings 
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Whenever Ventura Publisher encounters a horizontal tab character in 
the text, it positions the next character at the next tab location. You may 
set up to 16 tabs for each paragraph tag. Placement of each tab is 
measured relative to the left column edge rather than the page edge. You 
can choose right, center, left, or decimal alignment of text relative to 
each tab position. 

You can fill the space created by the tab with any character. These fill 
characters are called leaders (pronounced leed-ers.) 

Interactively setting tabs 

In addition to the settings in this dialog box, tabs for the currently 
selected paragraph can be created, adjusted, and deleted using the 
ruler/tab bar. Refer to the Tab bar section starting on page 3-54 for 
information on using the tab bar. 

Operation 

~ Click on either the Paragraph or the Text tool. 

~ Select a paragraph assigned with the tag you wish to modify. 

~ Click on the Tab Settings option in the Paragraph menu. The 
dialog box shown in Figure 10-10 is displayed. 

Figure 10-10. Tab Settings dialog box. 
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> Choose the Tab Number you want to set. Start with tab number 1. 

> Check the Enabled check box to enable this tab stop. 

> Choose whether the Tab Alignment is to be Left, Center, Right, or 
Decimal aligned. 

> Set Tab Options to Leadered if you want to place leader characters 
between the last tab and this tab stop. 

> Enter the Tab Location. The tab location is measured from the left 
edge of the current column, not from the left edge of the page. 

> If you want to set additional tab stops, repeat this process for addi­
tional tab numbers. 

Leaders If you choose Leadered for any tab stop, follow these steps: 

> Select one of the Leader Char options (spaces, periods, underlines, 
or some other character which you define) for this tag. You may choose 
only one leader character for the paragraph tag. 

> If you want to define your own leader character, choose the decimal 
number which corresponds to the character you want to put in the tab 
space, place the text cursor in the box at the end of the Leader Char 
entry field, and type this number. Refer to the character set table in 
Appendix E or the Quick Reference Guide for a list of available 
characters. 

> Enter the Leader Spacing between leader characters. For instance 
if you select Leader Spacing: 2, you will put two spaces between 
each leader character. 

Auto-Leader 

If you select Auto-Leader, the leader characters you have selected will 
be placed between the end of the last line of the paragraph and the right 
margin, even if you insert no tab at the end of the paragraph. Use this 
option to completely fill a box with dots or dashes. This is useful for 
tables. 

Setting the Horiz. Alignment option in the Alignment dialog box 
(Paragraph menu) to Justified overrides the tab settings for the tag. 
Therefore, tabs do not work if Horiz. Alignment is set to Justified. 
Also, tabs cannot be set for headers or footers created with the Headers 
& Footers option in the Chapter menu. 

10-23 



t-'AHAl::iHAt-'H MeNU 

Tables 

Tab Settings 

Do not set tabs to create a first line indent. Set the First Line option to 
Indent in the Alignment option dialog box instead. 

Tabs are designed to be used on a single line. Terminate this line with a 
paragraph end (Ehter) or line break (Ctrl + Enter). Also, when tabs are 
set, automatic word wrap will not work. Therefore, text on any line 
which contains a tab may extend beyond the right margin. Use a line 
break (Ctrl + Enter) to force this text down to the next line. 

When using proportionally spaced fonts, you cannot format tables (such 
as those imported from a spreadsheet) using spaces between entries. 
Therefore, you must use tabs to make columns align correctly. 

Equations 
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You can also use tabs to format simple equations. Set a center tab stop 
at the position on the page where you want to center the equation. Then, 
type a tab character followed by the equation. The equation automat­
ically centers itself at the location defined by the tab stop. Ventura 
Publisher provides a complete equation option which should normally 
be used to create equations. 



t)peClal I=TTects 

Special Effects 

The Special Effects option allows you to add a Big First Character 
(also called a drop cap) or Bullet at the beginning of a paragraph. You 
can select font and text attributes (bold, italic, etc.) for the bullet or big 
character independently from the rest of the paragraph. Use the Special 
Effects option to create: 

• Drop caps at beginning of paragraph 

• Real typographic bullets for lists (e.g., • instead of *) 

Operation 

~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph assigned with the tag you wish to modify. 

~ Click on the Special Effects option button. The Special Effects 
dialog box (Figure 10-11) is displayed. 

Figure 10-11. Special Effects dialog box. 

None Set the Special Effect option to None to remove an existing special 
effect from a given paragraph tag. 

Big first To create a big first letter: 
character 

~ Set the Special Effect option to Big First Char. 
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~ Click on the Set Font Properties button. 

~ Select the desired Face, Size, Style, Color, Attributes (overscore, 
etc.) options, and character Shift Up or Down. 

~ Click on the OK button to return to the Special Effects dialog box. 

~ Specify a setting for Space for Big First. This option specifies how 
many lines of text the first character will occupy. Norntal creates the 
number of line automatically. Custom allows you to specify the 
number of lines. 

When you select Custom, the big character rests on the baseline of the 
last line specified in the Space for Big First setting. When you select 
Normal, the top of the big character aligns with the top of the first line 
of the paragraph. These default positions can be overridden by selecting 
Set Font Properties and then selecting Shift Up or Down. 

Bullet To add a bullet: 
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~ Set the Special Effect option to Bullet. 

~ Click on the Set Font Properties button. Use the Font Settings 
dialog box to make the bullet a different font from the rest of the 
paragraph. The actual font selections available depend on the printer 
installed. Select the desired Face, Size, Style, Color, Attributes 
(overscore, etc.) options, and character Shift Up or Down. 

~ Cli<;!k on the OK button to return to the Special Effects dialog box. 

~ Select the Show Bullet As option for the desired bullet type. To use 
some other bullet character, select the Other option, and enter the 
decimal number for the bullet character in the Bullet Char entry 
field. Refer to Appendix E or the Quick Reference Guide for a complete 
listing of the available characters. 

~ Set the desired Indent Mer Bullet value. This indent specifies the 
space between the beginning of the bullet and the text following the 
bullet. 
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Attribute Overrides 

The Attribute Overrides option allows you to customize the following 
text attributes of a paragraph tag: overscore, strike-thru, underline, 
small text, superscript, and subscript. Use the Attributes Overrides 
option to: 

• "Fine tune" typography. 

• Adjust superscript and subscripted character vertical placement. 

• Create special effects (e.g., move strike-thru up so that it can be used 
as a second overscore). 

Operation 

> Click on the Paragraph tool or the Text tool button. 

> Select a paragraph assigned with the tag you wish to modify. 

> Select the Attributes Overrides option. The Attributes Override 
dialog box (Figure 10-12) is displayed. 

Figure 10-12. Attribute Overrides dialog box. 

Line Width The Line Width option controls what portion of the line of text is 
covered by a line attribute. The usual setting is Text-Wide, which 
applies the attribute only to the currently selected text. However, if you 
select Margin-Wide, the attribute extends from the left to right margin, 
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even if the text is only a few characters long. This is useful in tables to 
place a line above or below an entry in a table. 

Line heights You can modify the line and spacing settings for the overscore, strike­
thru, underline, and double underline attributes. These settings will 
affect tag attributes as well as attributes set to a selected range of text 
using the Text tool. For each line attribute, you can specify both the 
height (thickness) of the line and the distance to shift this line from the 
text baseline. The height and shift for Underline 1 controls both the 
underline and the first line in the double underline. Underline 2 
controls height and shift for the second line in the double underline. 

Attribute fonts You can set the font size and vertical placement of text which is super­
script, subscript, and you can change the font size of small text. Specify 
both the size of the font (in points) and the distance to shift the super­
or subscript characters vertically from the text baseline. 

The font size can be larger than the paragraph font as well as smaller. 
You can, therefore, use this option to create a shortcut for font changes. 
For instance, if you often need to set selected text to 14 point within a 
paragraph set to 12 point, set the Small Cap Size option to 14 point. 
Then, any time you want 14 point text, simply select that text and assign 
Small from the Text menu. 

Auto-adjust Attribute height and font size automatically increase and decrease 
when you change a paragraph tag's font size, unless you set the Auto­
Adjustments option to None in the Set Preferences option dialog 
box. If Auto-Adjustments is set to Style or Both, then the height of 
each attribute scales proportionally to the font size change, and each 
attributes' font size is set to two points less than the tag's fonts size. 
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Paragraph Typography 

-
~ 

The Paragraph Typography option allows you to control important 
typographic attributes for each tag, including kerning, letter spacing, 
spacing between words, and spacing between lines. The Paragraph 
Typography option controls: 

• Automatic Pair Kerning-Makes headlines more attractive by 
placing individual letters closer together. It can also reduce the page 
count of long documents which contain large blocks of body text. 

• Letter Spacing-Reduce visual impact of loose lines (lines with too 
much space between words) by adding space between letters. 

• Tracking-Expand or condense headlines to fit a given space. Adjust 
tracking of Body Text to expand or condense the size of the entire 
document with only a subtle change in overall appearance. 

• Grow Inter-Line To Fit-Automatically increases space between 
lines whenever selected text is made larger. 

• Space Widths-Controls the amount of space between words on a 
justified line. 

• Vertical Justification. Automatically adds space between para­
graphs and between lines within paragraphs to make text exactly 
reach the bottom of the column. 

Operation 

> Click on either the Paragraph tool or the Text tool button. 

> Select a paragraph assigned with the tag you wish to modify. 

> Click on the Paragraph Typography option button. The Paragraph 
Typography dialog box (Figure 10-13) is displayed. 
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Figure 10-13. Paragraph Typography dialog box. 

Automatic pair Certain pairs of letters should be squeezed together in order to improve 
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kerning the appearance and readability of the page. The classic example is the 
capital letter A followed by a capital V (e.g., AV). Note how the upper left 
position of the V actually precedes the lower right position of the A. The 
process of reducing space between certain pairs of letters is called 
kerning. 

Ventura Publisher allows you to reduce the space between characters in 
one of two ways: manually or automatically. Manual kerning is 
described in the Text tool section Chapter 3. Automatic pair kerning is 
described here. None of the automatic kerning controls have any affect 
on manual kerning and vice versa. 

Automatic pair kerning is most frequently used in headings and other 
parts of documents which use large type sizes. Automatic kerning can 
be used for body text as well, but will reduce formatting speed by about 
30% and will increase print time. The style sheets supplied with Ventura 
Publisher turn automatic kerning on only for headings. 

Only a few of the over 30,000 possible pairs of characters actually 
require kerning. Depending on the font, a width table contains between 
100 and 500 kerning pairs. 

To turn automatic pair kerning off for the entire chapter, use the 
Chapter Typography option in the Chapter menu. If you turn kern­
ing On in the Chapter Typography option dialog box, you must still 
set the Automatic Pair Kerning option to On for the currently 
selected paragraph. 
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To see the effect of automatic kerning on the computer screen, On­
Screen Kerning must be turned on in the Set Preferences option 
dialog box (Edit menu). 

This option will work only if the font width table for your printer 
includes kerning information. 

Grow Inter-Line When you select text within a paragraph and change its font size using 
the Text menu Set Font Attributes option, the space between lines is 
not adjusted unless you set the Grow Inter-Line To Fit option to On. 
For example, the Grow Inter-Line Tqyit op1jion is turned Off for this 
paragraph and, therefore, the words Ulg "LeX"L overlap the pre­
vious line. 

By contrast, the Grow Inter-Line To Fit option is turned On for this 

paragraph so that the big text does not overlap the previous line. 

Grow Inter-Line To Fit is very important for creating local overrides 
to paragraph font settings without needing to create a new tag. For 
instance, if you want to change a paragraph's font, but don't need to 
change alignment or spacing between this paragraph and the para­
graphs before and after it: 

~ Click on the Text tool. 

~ Select the entire paragraph. 

~ Change the font typeface, style and size. 

The inter-line spacing is automatically adjusted if the Grow Inter-Line 
To Fit option is set to On. 

Letter Spacing When a line of text is justified, Ventura Publisher adds or subtracts 
space between each word until the last character in the line exactly 
reaches the right column. If a word at the beginning of a line is long 
compared to the length of the previous line (very likely in a multi­
column document), the space between words on the previous line above 
may exceed the Maximum Space Width value. This results in a loose 
line (Figure 10-14). 

Letter spacing is controlled by these settings: 

• Letter Spacing On/Ofr 

• Minimum, Normal, and Maximum space widths 
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Paragraph Typography 

• Letter Spacing Up to: __ Ems 

The automatic letter spacing control attempts to improve the ap­
pearance of a loose line by adding additional space between letters, 
thereby reducing space between words. Technically, the line is still 
considered loose and will still be flagged by the Show Loose Lines 
control in the View menu. However, it will look better with additional 
space between letters. 

If the Letter Spacing option is set to On, Ventura Publisher adds 
additional space between letters until the space between words is equal 
to or less than the Maximum Space Width value. 

To use the Letter Spacing option: 

>- Select the paragraph using the Paragraph tool. 

>- Click on the Alignment option button and set the Horiz. Alignment 
option to Justified. 

>- Click on the Paragraph Typography option button and set the 
Letter Spacing option to On. 

>- Set the Minimum Space Width to less than the Normal Space 
Width. A typical number is 0.700 (e.g., 70% of Normal Space 
Width). Values above 1.000 have no effect. The Minimum Space 
Width is the smallest space that can appear between words in a 
justified line. 

>- Set the Normal Space Width option to 1.000. 

>- Set the Maximum Space Width to the largest space allowable 
between words during justification. A typical value is 2.000 (e.g., twice 
the Normal Space Width). 

>- Set the Up To amount to the maximum space allowed between letters 
during letter spacing. 0.100 Ems is a typical amount. 

The Up To setting prevents letter spacing from adding more space 
between letters than between words. In extreme cases this can actually 
happen. For most documents, keep this set to 0.100 Ems. 

The resulting space width is calculated and shown in Ems, a typo­
graphic measurement equal to the width of the capital M in the current 
paragraph font size. 
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Normal Space Width 

The Normal Space Width setting allows you to control the amount of 
space between words. This allows you to increase or decrease the size of 
any paragraph formatted with this tag. For instance, choosing a value 
of 2 doubles the space between every word. 1.000 is the normal setting 
for most documents. 

Tracking Tracking allows you to increase or decrease the space between every 
letter in a paragraph. To use this control: 

~ Select the Looser option to increase, or the Tighter option to 
decrease space between letters. 

~ Enter, on the Tracking entry field, the amount to add or subtract 
between individual letters. 

Tracking is set in Ems, which are equal to the width of the capital M in 
the current font. You will quickly find that even a few hundredths of an 
Em makes a dramatic difference. 

Tracking is typically used for very large headlines. Larger type sizes 
often look better if the letters are moved slightly closer together. You can 
also change tracking for body text. This will dramatically change both 
the look of the document and the number of pages needed to fit ~.ll the 
text in your document. 

Local tracking The Tracking option controls tracking for the entire paragraph. To 
override override the tracking setting for an individual paragraph or just for part 

ofa paragraph, click on the Text tool and use the manual kerning/track­
ing option described in the Chapter 3. 
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Example: 
Normal Space Width 
(line is not justified) 

1 
Line is not justified. Normal space width. 

t-'aragrapn I ypograpny 

This line is justified and has as many characters as possible on one line 

t 
Maximum number of characters on a justified _______ 

line results in Minimum Space Width. 

This 

Letter spacing OFF results in more 
than the Maximum Space Width value 

1 
is a loose line and therefore the line 

This is a loose line and therefore the line 

1 
Letter spacing ON adds space between 

letters and reduces space between words 
up to the Maximum Space Width value 

Figure 10-14. Letter spacing controls. 

Vertical justification 

During vertical justification, additional space is first added between 
every picture and the text which surrounds these pictures. If, after all 
space has been added between pictures and the surrounding text, more 
space is still needed, space is next added between paragraphs, and 
between paragraphs and tables. The amount added before each para­
graph or table can be different than the space added after. 

Vertical The Vert. Just. At Top of Paragraph and At Bottom of Paragraph 
justification options set the maximum amount of space that can be added above and 

between below a paragraph during vertical justification. If less than the maxi-
paragraphs mum amount of space is needed, then space for each paragraph is added 

in proportion to each paragraph's Vert. Just At Top of Paragraph and 
At Bottom of Paragraph amounts. The following example describes 
how this adjustment works. Assume, for instance, that within a given 
column: 
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• Twenty-four points additional space is needed to make text reach the 
bottom of a page. 

• There are two complete paragraphs in the column, one tagged with 
Head and one tagged with Body Text. 

• The tag called Head allows 18 points Vert. Just. At Top of Para­
graph and 12 points At Bottom of Paragraph. 

• The Body Text tag allows 12 points Vert. Just. At Top of Paragraph 
and six points At Bottom of Paragraph. 

Using these assumptions, an additional nine points is added above, and 
six points is added below the Head. Six points will be added above and 
three points below the Body Text. 

If the Vert Just. At Top of Paragraph option is set at zero, then no 
space is added above this paragraph during vertical justification. The 
same comment applies to the At Bottom of Paragraph option. 

Vertical The last step in vertical justification is to add space between lines in 
justification each paragraph, if needed. Space is added between lines only if the text 

between lines doesn't reach the exact bottom of the column, even after all space has 
been added between pictures and text, and between paragraphs and 
tables. The maximum amount allowed between lines for each paragraph 
tag is set by the Between Lines of Para option (see Figure 10-13). 
This setting also determines the allocation of space among different 
paragraphs in a column. Thus, if you set ten points between lines for a 
tag called Head, but only one point between lines in Body Text, then ten 
times more space will be added between lines in each Head in a column 
than will be added between Body Text lines. 

If you set Between Lines of Para at zero, then no space will be added 
between lines for paragraphs tagged with this tag. 

Vertical The InsertlEdit Table dialog box contains a Vert. Just. Top and Vert. 
justification for Just. Bottom setting which functions identically to the paragraph 

tables settings described in the last subsection. Each table is treated just like 
a paragraph for purposes of vertical justification. 

The Vert. Just. Top and Vert. Just. Bottom settings can be different 
for each table in your document. 

Refer to page 8-10 for more information on vertical justification. 
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Ruling Lines 

Ruling Lines 

All three ruling line options function in an identical manner and provide 
the capability to place ruling lines above, below, and around a para­
graph. 

You can place up to three ruling lines, each of different thickness, with 
different spacing between each rule, above, below, or around a para­
graph. You can then assign texture and color to each set of ruling lines. 
Ruling lines can be dashed. The paragraph ruling line options allow you 
to: 

• Isolate text from surrounding copy. 

• Provide lines between entries in a table. 

• Place a ruling line on top of text to create the "reverse video" effect 
shown in Figure 10-17. 

• Create change bars. 

Operation 
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~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph assigned with the tag you wish to modify. 

~ Click on the desired ruling line option button (Ruling Line Above, 
Ruling Line Below, or Ruling Box Around). A ruling line dialog 
box (Figure 10-15) corresponding to the ruling line option selected is 
displayed. 

The Ruling Boxes Around is primarily intended for headlines and 
other short paragraphs. Placing a ruling box around a long paragraph 
which continues into the next column or page causes the first part of the 
paragraph to be enclosed in a box. The second part of the paragraph is 
placed in the next column or page without any ruling box. To avoid this 
problem, set the Allow Within option to No using the Breaks option 



Ruling Lines PARAGRAPH MENU 

button. Also, a ruling box around a paragraph is only as wide as the first 
line in the paragraph. 
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Figure 10-15. Ruling Box Around dialog box. Each ruling line dialog box 
operates identically. 

Width Select one of the ruling line Width options. These options include: 

• Text-The ruling line width equals the width of the first line of text. 
Any indent set using the Alignment and Spacing options (Para­
graph menu) will affect a Text ruling line. 

• Margin-The ruling line width equals the width of the current 
column, less the paragraph's In From Left and In From Right 
spacing as set in the Paragraph menu Spacing option dialog box. 

• Column-The ruling line width equals the width of the current 
column. 

• Frame-The ruling line width equals the width of the frame if you 
have set the Overall Width option in the Alignment option dialog 
box (Paragraph menu) to Frame-Wide. 

• Custom-You can set the starting point and width of the ruling line 
to any value you wish. Specify distance in (+) or out (-) from the left 
margin (Custom Indent) and width of the ruling line (Custom 
Width). 

Style The Style list box allows you to select from a number of pre-defined line 
styles. If you don't want to use one of the pre-defined styles, click on the 
User-Defined button. 
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Figure 10-16. User Defined Rule Style dialog box. 

User-Defined When the User-Defined option is selected, the User-Defined Rule Style 
dialog box (Figure 10-16) is displayed. Enter the appropriate ruling line 
height, as well as space between each ruling line, for each of the three 
rules. As soon as you move the text cursor to a new field, sample ruling 
lines appear to aid in determining the proper line thicknesses and 
spacing. This display is limited to about 0.5 inch. The total height 
occupied by all ruling lines is shown on the Overall Height line of the 
User-Defined Rule Style dialog box. You can create larger ruling lines, 
but they will not display in the dialog box. 
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The Dimensions button is used to change the unit of measure for the 
ruling line settings. 

You must click on the User Defined button in order to gain access to 
the User-Defined Rule Style dialog box. 

Click on the OK button to exit the User-Defined Rule Style dialog box 
and save the settings. Click on the Cancel button to abandon the setting 
changes and exit the User-Defined Rule Style dialog box. 

Color The Color list box allows you to select a color for the ruling lines. The 
same color and pattern is assigned to all rules defined for a particular 
tag. 

Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in this list box. 
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Pattern The Pattern list box lists eight pre-defined ruling line patterns. These 
patterns range in shading value from 12.5% to 100% in 12.5% incre­
ments. 

Dimensions The Dimensions button is used to change the unit of measure for the 
dashed line settings. 

Dashes If you wish to make dashed rules, check the Dashes check box. When 
checked, the Dash Width and Dash Spacing options become available. 

Dash Width 

The Dash Width option allows you to enter a value for the amount of 
dash that will be visible between dash spaces. 

Dash Spacing 

The Dash Spacing option allows you to enter a value for the amount of 
space that will be visible between dashed lines. 

Depending on the resolution of your screen, the dashes may not display 
in the Normal view. If dashes do not display on the screen, select the 
Enlarged View option to see the dashed lines. 

Custom Indent! The Custom Indent and Custom Width options are available only if 
Custom width the Custom option is selected from the Width list box. These options 

allow you to enter custom values for the starting location and width of 
the ruling line. 

White text on black rule 

U sing the Ruling Lines Above option, you can create reverse video text, 
e.g., placing a black ruling line over white text as shown in Figure 10-17. 
Refer to page 14-9 for the procedures to create this effect. 

Some printers are not capable of printing white text. Printing the 
CAPABILI.CHP (found in the TYPESET directory if the example chap­
ters where installed) will allow you to determine if your printer is 
capable of printing white text. 
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Auto-Numbering 

'1J. 
1.~. 

Click on the Auto-Numbering option button to setup automatic section 
numbering for selected paragraph types. These section numbers can 
contain combinations of numbering styles and punctuation. The Auto­
Numbering option allows you to create: 

• Technical manual section numbers 

• Outlines 

Operation 

Section Numbers This option automatically inserts numbers, letters or Roman numerals 
before every paragraph tagged with a specified tag. For example, the 
first paragraph tagged with the tag called Heading will be numbered 
1, the next Heading paragraph will be numbered 2, and so on. You can 
create up to ten levels of section numbering by specifying ten different 
tag names in the Auto-Numbering dialog box. 

To number paragraphs automatically, follow these directions: 

> Click on the Auto-Numbering option button. The Auto-Numbering 
dialog (Figure 10-18) is displayed. 

Figure 10-lB. Auto-Numbering dialog box. This example will place 1., 2., etc. in 
front of every paragraph tagged as a Heading; 1.1., 1.2., ... 2.1., 2.2., etc. in 
front of every paragraph tagged as a Section Sub, and so on. 
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~ Set the Usage option to On. Place the text cursor on the Levell 
entry field. 

~ Select the desired tag name from the floating Tags list and then 
choose one of the following: 

This determines whether Arabic, letters, or Roman numerals will be 
used. 

For example, if you select the Heading tag name from the Tags list 
and then select Arabic numbering (e.g., 1,2), this places the entry: 

[ *Heading , 1] 

on the Level I entry field. 

~ Click on the OK button. In this example an Arabic number is inserted 
before every paragraph tagged with the Heading tag. Each succeed­
ing Heading paragraph is numbered consecutively, even if other 
paragraphs intervene. 

Numbers other To start numbering with a number other than one, enter this number 
than one just inside the right bracket, without erasing the default numbers. For 

instance, to start numbering with the number 3, modify the preceding 
example to look like this: 

[*Heading,1,3] 

This starting number is optional and is always entered in Arabic. If a 
starting number is omitted, one is assumed. 

The starting number does not represent an actual Arabic number, but 
represents the starting number's relation to the default number or 
letter. For example, iflowercase letters are used for auto-numbering and 
you want to start with the letter d, the above example would look like: 

[*Heading, a, 4] 

Adding You can add punctuation (periods, hyphens, etc.) by placing the desired 
punctuation punctuation marks before or after the [ ] brackets that contain the tag 

name. For instance, to place a period after the section number as-
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sociated with paragraphs tagged with Heading, change the Levell 
entry field to: 

[*Heading,l] . 

Repeat the above procedure for each additional level or tag that you wish 
to number automatically. 

Example: the dialog box shown in Figure 10-18 will place 1.,2., etc. in 
front of every paragraph tagged as a Heading; 1.1., 1.2., ... 2.1.,2.2., etc. 
in front of every paragraph tagged as a Section Sub, and so on. 

Numbering hierarchy 

Each time a tag specified in the Auto-Numbering option dialog box is 
encountered, the numbers for all lower level paragraphs are reset to 
their starting number. 

Renumbering 

Outlines 

Section numbers are added, deleted, or changed only when you make a 
change in the Auto-Numbering option dialog box, and then select the 
Renumber Chapter option in the Edit menu. Section numbers cannot 
be edited, although you can cut (delete) text which contains them .. 

Only text in pages can be auto-numbered. Text in frames and box text 
cannot be auto-numbered. 

In the previous examples, the section numbers accumulate at each level. 
Thus, a third level heading includes the numbers from the first and 
second levels, e.g., Section 2.5.3. 

For outlines and certain other numbering schemes, however, you will 
want to suppress the previous numbering levels. For instance you want: 
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I. First level 
A. Second level 

not 

I. First level 
---.... -@Secondlevel 

Auto-Numbering 

To auto-number without including previous level numbers, use the 
Suppress Previous Level option. For instance, to suppress level one 
numbering for a level 2 paragraph: 

> Place the text cursor at the far left of the Level 2 entry field. 

> Select the Suppress Previous Level option. This places a [-] at the 
current text cursor position. 

> Add the section number as described under Section Numbers. 

Figure 10-19 shows the settings for an outline that follows normal 
conventions (uppercase Roman letters, followed by uppercase letters, 
then Arabic numbers). 

Figure 10-19. Numbering for outline. Note that the [-J characters at the 
beginning of levels 2 and 3 suppress printing of previous level numbers. 
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Generated section number tags 

When section numbers are generated, each of the ten levels is automat­
ically tagged with the following tags: 

Level 1 Z_SEC1 

Level 2 Z SEC2 

000 ... 
Level 10 Z_SECIO 

Although you cannot change these tag names, you can alter their 
typographic settings. Generated tags are not shown in the Tags list, 
unless you set the Generated Tags option to Shown in the Set 
Preferences option (Edit menu) dialog box. 

Altering Initially, these generated tags have the same attributes as Body Text, 
generated which means that the section numbers appear on the line above the 

section number heading with which they are associated. If you want to place section 
tags numbers on the same line as their associated paragraphs, you can alter 

these generated tags by changing Paragraph menu settings for both 
the section number tag and the tag of the associated paragraph. 

Change the section number's tag attributes to: 

Paragraph option Setting 

Font Same as paragraph 

Alignment Left 

Spacing No space below 

Breaks 
Line break before, 

Keep with next 

Ruling Lines Above As desired 

Ruling Lines Below None 

Change the paragraph's tag attributes to: 

Paragraph option Setting 

Font Same as section tag 

Alignment 
Indent relative to previous 

line, plus one pica 

Spacing No space above 
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Paragraph option Setting 

Breaks Line break after 

Ruling Lines Above None 

Ruling Lines Below As desired 

During text editing, some paragraphs may print over the first line of the 
previous paragraph if you set the tags as described above. However, if 
you change the Line Break (Breaks option, Paragraph menu) for all 
other tags in your style sheet from Before to Mer, you eliminate this 
effect. 

Figure 10-20 shows the results of changing the tags. 

Changing 
paragraph tags 

places section 
numbers on same 

line with the 
headings. 

8.5.1 TextBlocking (Run Arounds) 

PlaCing text around an irregular object is called a Run 
Around. Normally, Ventura Publisher automatically 
"flows" text around rectangular Frames, However, text 
can also be made to flow around irregular objects. 
The technique for doing this, which involves turning 
Text Flow Around off in the Frame Menu, is 
described under the Layout heading in the Reference 
Section. 

8.5.2 Creating Multiple Frames 

Figure 10-20. Generated section numbers placed on same line as headings. 

Chapter numbers 

You can include chapter numbers at any level by selecting the Chapter 
# option in the Auto-Numbering option dialog box. This places [C#] at 
the current text cursor position and automatically inserts the chapter 
number at that location within the section number. 

Independent numbered lists 

If you create an outline or a numbered list using the approach shown in 
Figure 10-19, you cannot reset the top level number back to one. If you 
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want to have several independent numbered lists within the same 
chapter, you need a way to reset numbering. 

To reset numbering: 

~ Place Body Text as the tag name in the Levell entry field. 

~ Create your numbered list hierarchy starting in the Level 2 entry 
field. 

Thus, as soon as any body text paragraph is encountered, the outline or 
list numbering resets itself. Body text paragraphs will now be num­
bered. You can, however, eliminate numbering at any level merely by 
deleting the paragraph numbering type. For instance, if you want to use 
the Body Text tag to reset numbering, place the following in the Level 
1 entry field: 

[ * Body Text] 

~ 
Note that numbering is removed 

This technique works with any paragraph tag, not just body text. 

Auto-text addition 

You can place text on any level, either before or after the tag name. 
Figure 10-18 shows periods placed after some of the tag names. Other 
text can be placed on these lines as well. If the section number is 
eliminated, as described in the previous paragraph, you can add text to 
the beginning of every paragraph tagged with the designated tag. For 
instance, to place the words Daily Times: at the beginning of every 
paragraph tagged as a Question (e.g., for a chapter that contains the 
text of an interview), type: 

[*Question]Daily Times: 

at the appropriate level. 
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Text attributes 
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You can use any of the text attributes (e.g., bold-<B» shown in 
Appendix D. You must place these attributes outside the command 
brackets (e.g., outside the [ ] brackets). 

Example: to change the word Times in the above example to bold italic, 
type: 

<B>[*Question]Daily <BI>Tirnes:<D> 
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Define Colors 

The Define Colors option allows you access to the complete 
PANTONE® Color library as well as the ability to define custom colors 
and shades of gray. A total of253 colors from a palette of 16.8 million can 
be defined for use in a chapter. You can then apply these colors and 
shades of gray to text, ruling lines, graphics, etc. 

The capability to see the colors on the monitor is dependent on the video 
hardware attached to your computer and the video drivers installed in 
Windows. 

Color separations definition 

Conventional ink printing creates colors two ways: 

• Process Color. A page is run through the press four times, once for 
each of the four process colors (cyan, yellow, magenta, and black). The 
colors are, in essence, mixed on the page to produce an almost 
limitless range and hue of colors. 

Process color is used to print color photographs and other images that 
require reproduction of a large range of colors. Because the color you 
see depends on correct placement of the different color dots placed on 
the page by the printing press, process color requires near-perfect 
alignment of the four colors on the page to produce good results. This 
perfect alignment is called registration. 

• Spot Color. A page is run through the press once for each specific 
color on the page. Each color printed on the page is generally 
separated from the other colors on the page instead of being mixed 
together. 

Spot color is used when only a few discrete colors are needed, such as 
a single color for headings and ruling lines. Registration is not as 
critical with spot color, because no color mixing is done on the page. 

Ventura Publisher supports both process and spot color. 

PANTONE is a registered trademark of Pan tone, Inc. 
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Ventura Publisher supports process color separation of all page ele­
ments (text, graphics, and pictures) through the installation and use of 
the Ventura Separator color extension product. 

You can print colors in one of four ways: 

• If you print to a color PostScript printer such as the QMS Color 
Script™ 100, each page is printed in color. 

• If you print each page to a black and white laser printer or imageset­
ter, the colors are converted to shades of gray (some limitations 
apply-refer to the Limitations section for your printer in Appendix 
F). 

• If you print each page to a black and white laser printer or imageset­
ter, and click on the Color Separations option in the Print option 
dialog box, a separate black page is printed for each color you have 
defined. Colors are not converted to shades of gray. 

• If you print each page to a file using either spot color separation or 
process color separation, the files can then be sent to a service bureau 
and printed on an imagesetter. 

Color models Colors can be defined in Ventura Publisher using one of six color models. 
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These color models are: 

• CMYK - Cyan, Magenta, Yellow, Black 

• CMY - Cyan, Magenta, Yellow 

• RGB - Red, Green, Blue 

• HLS - Hue, Lightness, Saturation 

• PANTONE MATCHING SYSTE~ solid color definitions 

• PANTONE MATCHING SYSTEM process color definitions 

PANTONE Color computer hard copy simulations used in Ventura Pub­
lisher are four-color process simulations and may not match 
PANTONE-identified solid color standards. Use PANT ONE Color Ref­
erence Manuals for accurate color. PANTONE Color simulations are 
only obtainable on licensed hardware when driven by qualified-licensed 
software packages. Contact Pantone, Inc. for a current list of qualified 
licensees. Pantone, Inc. assumes no responsibility for color inaccuracies 
on non-licensed output devices. 

PANTONE MATCHING SYSTEM is a registered trademark of Pantone, Inc. 
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Operation 

> Click on either the Paragraph tool or the Text tool button. 

> Click on the Define Colors option button. The Define Colors dialog 
box (Figure 10-21) is displayed. The colors displayed in this dialog 
box are those colors that have been defined for use with the current 
style sheet. The first eight colors are default colors and cannot be 
edited or deleted. 

Color names displayed in the Define Colors dialog box may appear with 
an asterisk. An asterisk will appear in a color name when a color defined 
in a style sheet from a previous version of Ventura Publisher has the 
same color name as one of the version 4.0 and above default colors but 
different color values. Refer to page 10-62 for more information on how 
colors defined in previous versions of Ventura Publisher are imported 
into Ventura Publisher Windows edition 4.0 and above. 

S K White 
S K Black 
S K Red 
S K 
S K 
S K 
S K 
S K 

S 

Figure 10-21. Define Colors dialog box. 

Color list box The color list box displays the colors defined in the currently loaded style 
sheet. Selecting any of the colors shown will allow you to duplicate, and 
then edit and save the color under another name using the selected color 
as a base for the new color. Selecting any of the non-default colors will 
allow you to edit, delete, or duplicate that color. With the exception of 
changing the Ink Separations and Ink Alignment settings, the eight 
default colors appearing at the top of the color list cannot be edited or 
deleted. 
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Color numbers for the colors defined in the Define Colors dialog box can 
be determined by using the Update Tag List dialog box Print 
Stylesheet option. The generated text file will list all color numbers 
necessary for entering color formatting codes from within a word proces­
sor. 

Colors are selected by clicking on the color name. Double-clicking on a 
color name will display a vertical color bar for that color along the right 
edge of the other horizontal color bars. This allows you to see how the 
selected color appears in comparison with the rest of the colors in the 
list. 

Two columns of letters appear to the left of the color names. These 
letters relate to the Ink Separations and Ink Alignment settings for 
the corresponding color. 

These settings will not appear in any other dialog box displaying a color 
menu. If you have defined two identical colors with different Ink 
Separations or Ink Alignment settings you should include the cor­
responding setting in the name of at least one of the identical colors. 

Ink separations The Ink Separations options allow you to specify whether the selected 
color will be a spot color or a process color. These settings only apply 
when the chapter is either spot- or process-color separated using the 
options in the Print dialog box. 

Ink Alignment 
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A color set as a process color will separate like a spot color unless the 
Ventura Separator color extension product is installed. A color can be 
defined as a process color without Ventura Separator installed to allow 
for the chapter to be separated by a service bureau using Ventura Pub­
lisher with Ventura Separator installed. 

The Ink Alignment options allow you to specify how a color will act 
when placed on top of another color. These options are applicable only 
when the Ventura Separator color extension product is installed or if 
your chapter is to be sent to a service bureau using Ventura Publisher 
and Ventura Separator. 
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Top layer 

Bottom layer 

Top layer 

Bottom layer 

Overprint 

A color defined as an Overprint color will not obscure a color placed 
below, but will blend with the color. This capability is available only 
when the color is process color separated. 

Overprint can only be accomplished when the chapter is process color 
separated using the Ventura Separator color product. If a color is 
defined as an Overprint color and subsequently separated using spot 
color separation, the color will act as if it were a Knockout color. 

Figure 10-22. Example of how overprint colors separate. 

Knockout 

A color defined as a Knockout color will completely obscure a color 
placed below the knockout color. When separated, any colors below the 
knockout color will produce a white mask corresponding to the area 
covered by the knockout color. 

Figure 10-23. Example of how knockout colors separate. 
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Edit/new! These three options operate similarly and will be described together 
duplicate with any differences in operation noted. Each option performs the 

following general functions. 

Edit - The Edit option is used to edit an existing color or color name 
selected from the Define Colors dialog box. 

New - The New option is used to add a new color to the Define colors 
dialog box. 

Duplicate - The Duplicate option is used to add a new color to the 
Define Colors dialog box based on an existing color selected from the 
Define Colors dialog box. 

PANTONE colors cannot be edited. In order to redefine a PANTONE 
color, you must add the PANTONE color to the Define Colors dialog box 
and then click on the Duplicate button. The Specify Color dialog box will 
appear with the CMYK (for PANTONE process) or RGB (for PANTONE 
solid) equivalents displayed. The color values can then be edited as 
desired and the color saved to the color list under a new name. 

When one of these options is selected, the Specify Color dialog box 
(Figure 10-24) is displayed. 

Figure 10-24. Specify Color dialog box with CMYK color model selected. 
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Name 

When the Edit option is selected from the Define Colors dialog box, the 
Name field will display the name of the color selected in the Define 
Colors dialog box. When the New option is selected from the Define 
Colors dialog box, the Name field will be blank. When the Duplicate 
option is selected from the Define Colors dialog box, the N arne field will 
display "Copy of' followed by the name of the color selected in the Define 
Colors dialog box. 

If the Duplicate option is selected when a PANT ONE color is selected 
in the color list, the "Copy of' will not appear. Instead, the Name field 
will be left and a new name will be required. 

If the Edit option was selected from the Define Colors dialog box, 
changing the name in the Name field will overwrite the name of the 
color selected in the Define Colors dialog box. If the New option is 
selected from the Define Colors dialog box, a new name must be entered 
in the Name field before the color can be added to the Define Colors 
dialog box list. 

A maximum of 25 characters can be entered for the color name. 

If a color name entered in the Name field is the same as that used by a 
previously defined color, the following alert is displayed when you click 
on the OK button to exit the Specify Color dialog box. 

If the Name field is left blank, the following alert is displayed when you 
click on the OK button to exit the Specify Color dialog box. 
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Click on the OK button from either alert to return to the Specify Color 
dialog box and enter or change the name in the Name entry field. 

Color Model 

A color model is simply a set of color components used to define a single 
color. By manipulating the color component values of the color model, 
you can define a color from a palette of up to 16.8 million colors. Ventura 
Publisher provides the following color models. 

- CMYK - Cyan, Magenta, Yellow, blacK 

- CMY - Cyan, Magenta, Yellow 

- RGB - Red, Green, Blue 

- HLS - Hue, Lightness, Saturation 

Ventura Publisher also supplies 2 PANTONE color definition libraries. 

- PANTONE solid - PANTONE color definitions for spot color 
printing 

- PANTONE process - PANTONE color definitions for process 
color printing 

PANTONE color definitions are not true color models since the com­
ponents of the colors cannot be edited or user defined. Instead, the colors 
are pre-defined colors generated as a common standard for the pre-press 
and printing industry to ensure consistency throughout the pre-press 
operations and printing of color. 

The Color Model list box allows you to select a color model for use in 
defining a color. Selecting one of the top four color model options (CMYK, 
CMY, RGB, or HLS) will change the color model setting bars at the 
bottom of the dialog box to display the individual settings available for 
the selected color model. When changing color models, the color settings 
from the previous color model are translated to the new color model in 
order to maintain the same color across color models. 

When changing from CMYK, CMY, RGB, or HLS color models to one of 
the PANT ONE color definition library options, the color settings from 
the previous color model are not translated. 

Selecting one of the PANTONE options will display the Select 
PANTONE Color dialog box for the selected PANT ONE definition 
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library (solid or process). This dialog box allows you to select one of the 
pre-defined color definitions for use in you chapter. Refer to the PAN­
TONE color model section starting on page 10-58 for more information 
on working with PANTONE colors. 

Color chip 

The color chip, located in the center of the Specify Color dialog box, 
allows you to view how changes to the different color model settings 
affect the color you are defining. 

When the New option is selected from the Define Color dialog box, the 
color chip is initially white. As you modify the settings for the selected 
color model, the color produced using those settings is displayed in the 
color chip. 

When the Edit or Duplicate option is selected from the Define Colors 
dialog box, the color chip is divided. Initially, both halves of the color chip 
will be identical. As you modify the settings for the selected color model, 
the right side of the color chip will change to reflect the changes while 
the left side of the color chip will remain the same as the color originally 
selected. This allows you to view how the changes to the color model 
settings affect how the color is changed in comparison to the color 
originally selected. 

The color chip is not used when one of the PANT ONE color definition 
library options are selected. 

Color model component settings 

The color model component settings comprise three or four color bars at 
the bottom of the dialog box depending on the color model selected 
(except PANTONE) from the Color Model list box. 

A color model component is adjusted by either dragging the arrow at the 
bottom of each color bar, or by entering a percentage in the entry field 
of each color bar. Each color model component can be set to any value 
between 0 and 100% in increments of 1 %. 

As you change the settings for each component of the color model, the 
color bars will redraw to show you how further adjustments to each 
setting will affect the color you are defining. 
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If you enter a percentage value in the entry field for any color bar, you 
must move out of the color bar entry field using the Tab key or by click­
ing in another entry field before the color bars will update. 

PANTONE color Ventura Publisher provides both the PANTONE solid color and 
definitions PANTONE process color definition libraries. When one of the PAN­

TONE color definition libraries is selected from the Color Model menu, 
the Select PANTONE dialog box (Figure 10-25) is displayed. 
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When selecting a PANTONE color for use in your document, select the 
PANTONE color from the library that matches how the document is to 
be separated (PANTONE Solid for spot color or PANTONE Process 
process color separated). 

The PANT ONE solid color definition library is used to reproduce the 
PANTONE colors shown in a PANTONE solid color chip book when the 
color is printed as a spot color. Similarly, the PANTONE process color 
definition library is used to reproduce the PANTONE colors shown in a 
PANTONE process color chip book when the color is separated into 
CMYK color components. 

The PANTONE solid color definitions selectable in Ventura Publisher 
will faithfully match the PANTONE solid color inks used by printers. 
PANTONE solid colors that are process color separated cannot be 
reproduced correctly. 

The PANT ONE process color definitions selectable in Ventura Publisher 
are designed to be process color separated, and no spot color inks are 
available for these colors. 

PANTONE colors cannot be edited. In order to redefine a PANTONE 
color, you must first add the PANTONE color to the color list in the 
Define Colors dialog box, and then, with the PANTONE color selected, 
click on the Duplicate button. The Specify Color dialog box will appear 
with the CMYK color model (for PANT ONE process) or RGB color model 
(for PANTONE solid) equivalents displayed. The color model com­
ponents can then be edited as desired, and the color saved to the color 
list under a new name. 
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Selecting a PANTONE color 

Selecting one of the PANT ONE color definition options from the Color 
Model menu will display the Select PANT ONE dialog box (Figure 
10-25). 

Figure 10-25. Select PANTONE® Solid Color dialog box. 

PANTONE colors can be selected from the Select PANTONE dialog box 
in one of three ways: 

• If you know the name of the PANTONE color you want to select, 
simply highlight the name in the PANT ONE entry field, type the first 
three or four characters of the PANTONE name you want to select, 
and then press the TAB key. The first PANT ONE name matching the 
characters you entered will be displayed in the PANT ONE entry field 
and shown as highlighted in the PANTONE chip area of the dialog 
box below the PANTONE color entry field. 

If the correct PANT ONE color is not displayed in the PANTONE 
entry field, the desired PANTONE color will probably be displayed in 
the PANT ONE chip area of the dialog box. Simply click on the desired 
color chip. 

• Selecting the PANT ONE list box located next to the PANT ONE color 
entry field displays a scrolling list from which a PANT ONE color can 
be selected. 

• Click and drag the arrow below the PANTONE color bar at the bottom 
of the dialog box to the approximate color you wish to select. As you 
move the arrow, the color chips will update to display the PANTONE 
colors in the color range corresponding to the position of the arrow. 
When the desired PANT ONE color is displayed in the color chip area 
of the dialog box, select the desired color chip. 
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The color chip columns in this dialog box directly correspond to the color 
chips found on each page of a standard PANTONE chip book. 

Defining and using custom shades of grays 

Custom shades of gray can be defined the same as any other color in the 
Define Colors dialog box. Once you define a shade of gray, you can use 
it within any of the dialog boxes that support color. To assign a gray level 
after you have defined it using the Define Colors option, follow these 
steps: 

~ Select the shade of gray from the Color list box within any dialog box 
containing color options. 

~ If the dialog box includes a Pattern list box, select the solid pattern 
option. ' 

The Pattern setting available in most dialog boxes provides an alter­
nate, but less flexible, way to produce shades of gray. Combining a gray 
color with a pattern can be confusing and is not recommended. 

Color printing 

The Define Colors option allows you to create a color name and assign 
a unique color value to that name. The actual hue you create is useful 
only when you print to a color printer which can print a large range of 
colors. Only color printers such as the QMS ColorScript™ printer are 
supported. However, by assigning color names to text and graphics, you 
can create color separations which can be sent to an offset printing 
facility as the input to color production of your document. 

Process color separation and separation of color pictures loaded into a 
chapter are supported only when the Ventura Separator color extension 
is installed. 

Spot color If you plan to have your document printed using the spot color separa­
tion and printing process, follow this procedure: 
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~ Define the desired colors using the options in the Define Colors dialog 
box as described previously. Set the Ink Separations setting for each 
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color to Spot. Set the Ink Alignment setting for each color to 
Knockout. 

A color set to Process will separate like a spot color unless the Ventura 
Separator color extension product is installed. Likewise a color set to 
Overprint will separate like a knockout color unless Ventura Separator 
is installed. A color can be defined as a process and overprint color 
without Ventura Separator installed to allow for the chapter to be 
process color separated by a service bureau using Ventura Publisher 
with Ventura Separator installed. Refer to the Process color section 
below for information on using process and overprint colors in a docu­
ment that is to be process color separated. 

~ Assign the Color Names you have defined to fonts, ruling lines, 
background fill patterns, and graphics. 

~ When you print draft copies of your document, ensure the Color 
Separations check box is not checked in the Ventura Print Options 
dialog box. This will produce a black and white representation of your 
final color page. Each color is converted to an appropriate shade of 
gray, depending on the capabilities of your printer. 

~ When you are ready to print the final copy, check the Color Separa­
tions check box and use the Colors option dialog box to select the 
colors to be included in the separation. Ventura Publisher will print 
a separate black and white page for each color selected in the Separa­
tion Colors dialog box. 

For each separation plate (page), only the text and Ventura Publisher 
graphics for that color is printed, and each color is printed in 100% black. 
During the offset printing process, these individual black and white 
pages are transferred to color plates. The people who make these plates 
and the people who control the printing presses determine the shade 
and hue of each color. Refer to the Print option section starting on page 
5-54 for more information on using the separations options in the Print 
dialog box. 

Process color If you plan to have your document printed using the process color 
separation and printing process, follow this procedure: 

~ Define the desired colors using the options in the Define Colors dialog 
box as previously described. 

A color set to Process will separate like a spot color unless the Ventura 
Separator color extension product is installed. Likewise a color set to 
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Overprint will separate like a knockout color unless Ventura Separator 
is installed. A color can be defined as a process and overprint color 
without Ventura Separator installed to allow for the chapter to be 
separated by a service bureau using Ventura Publisher with Ventura 
Separator installed. 

>- Assign the Color Names you have defined to fonts, ruling lines, 
background fill patterns, and graphics. 

>- When you print draft copies of your document, ensure the Color 
Separations check box is not checked in the Ventura Print Options 
dialog box. This will produce a black and white representation of your 
final color page. Each color is converted to an appropriate shade of 
gray, depending on the capabilities of your printer. 

>- When you are ready to print the final copy, check the Color Separa­
tions check box and use the Colors option dialog box to select the 
colors to be included in the separation. If Ventura Separator is not 
installed, you cannot perform process color separation on the chapter. 
However, you can copy the chapter to a floppy disk using the Manage 
Publication option and send the chapter to a service bureau using 
Ventura Publisher with Ventura Separator installed for process color 
separation. If Ventura Separator is installed, refer to the Ventura 
Separator documentation for a description of how Ventura Separator 
operates and procedures for creating process color separations. 

Colors defined in previous versions of Ventura Publisher 

The colors defined in the Define Colors dialog box in all versions of 
Ventura Publisher having color capabilities are stored in the style sheet. 

In versions of Ventura Publisher prior to version 4.0, you have the 
capability of applying a total of 8 colors to any component of your 
chapter. Six of these colors (color numbers 2 through 7) are user 
definable using the options in the Define Colors dialog box. The colors 
white and black (color numbers 0 and 1) are not editable colors. 

In Ventura Publisher 4.0 and above you have the capability of applying 
a maximum of 254 colors to components of your chapter. In Ventura 
Publisher 4.0 and above however, the first 8 colors (color numbers 0 
through 7) are not editable colors. 

When loading a style sheet in Ventura Publisher version 4.0 and above 
that was generated in an earlier version, Ventura Publisher 4.0 and 
above will analyze the colors stored in the style sheet. If the colors in the 
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earlier version style sheet have not been redefined or renamed from the 
standard default color values and names, Ventura Publisher will bring 
these colors straight across to match the eight non-editable default 
colors in Ventura Publisher 4.0 and above. 

If one or more colors have been redefined or renamed in the earlier 
version style sheet, Ventura Publisher 4.0 and above will reassign these 
colors (and the color numbers) below the 8 non-editable colors in Ven­
tura Publisher 4.0 and above. It is important to note that Ventura 
Publisher will not reassign the color number of the components of a 
chapter to the new reassigned color number. For example, consider the 
following scenario: 

In a version of Ventura Publisher prior to 4.0, I have redefined the 
default color red (color number 2) to be a 50% gray (CMYK set to 50%), 
and changed the name to 50% Gray. I have then assigned this color to a 
tag named Headline. All other colors are left at the default color values 
and names. 

When this chapter is opened in Ventura Publisher 4.0 and above, the 
color named 50% Gray (color number 2 in the previous version) will not 
match the non-editable color number 2 (red) in Ventura Publisher 4.0 
and above. The 50% Gray color value and name will then be reassigned 
to color number 9 in Ventura Publisher 4.0 and above. However, any 
paragraphs tagged with the Headline tag name will appear in red since 
Ventura Publisher has not reassigned the color number applied to the 
Headline tag, and color number 2 is red in Ventura Publisher 4.0 and 
above. 

Color names displayed in the Define Colors dialog box may appear with 
an asterisk. An asterisk will appear in a color name when a color defined 

. in a style sheet from a previous version of Ventura Publisher has the 
same color name as one of the version 4.0 and above default colors but 
different color values. 

The 50% Gray color name and number can again be applied to the 
Headline tag by using the Paragraph tool to selecting any paragraph 
tagged with the Headline tag, and changing the color in the Fonts 
option dialog box to the reassigned 50% Gray color. 
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Add New Tag 

The Add New Tag option allows you to create new paragraph tags. 

Operation 
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~ Click on either the Paragraph tool or the Text tool button. 

~ Select a paragraph to which you want to apply the new tag. 

~ Click on the Add New Tag option button, or press Ctrl + 2. The Add 
New Tag dialog box (Figure 10-29) is displayed. 

Figure 10-29. Add New Tag dialog box. 

~ Enter the name of the new tag in the Name to Add entry field. If you 
want to copy the settings from a tag other than the one selected, select 
the tag name from the Copy From list box. 

)0- Click on the OK button when finished. The new tag name immedi­
ately appears in the alphabetized Tags list, and the currently selected 
paragraph is tagged with this new tag. 

If the name entered in the Name to Add entry field is the same as that 
of a previously created tag, the following alert is displayed. 
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Click on the OK button to return to the Add New Tag dialog box and 
enter another name in the Name to Add entry field. 

10-65 



PARAGRAPH MENU Update Tag List 

Update Tag List 
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The Update Tag List option provides several tools to help you manage 
the paragraph tags that are stored in the style sheet. These tools 
include: 

• Delete tags 

• Rename tags 

• Assign tag names to function keys 

• Print the style sheet 

• Save the style sheet 

• Add a new tag 

The last two functions are duplicates of those found elsewhere in Ven­
tura Publisher: the ability to save a style sheet is described in the Save 
Style As option section of the File menu chapter, and the Add Tag 
option duplicates the function described in the Add New Tag option 
section of this chapter. 

Operation 

~ Click on either the Paragraph tool or the Text tool button. If you select 
the Text tool 

~ Click on the Update Tag List option button. The Update Tag List 
(Figure 10-26) is displayed. 

Figure 10-26. Update Tag List dialog box. 
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Tag List list box The Tag List list box displays all of the tags in the currently loaded style 
sheet. Select a tag from the list box by clicking on the tag name. 

Delete Tag The Delete Tag option permanently removes the selected tag from the 
style sheet. To delete a tag: 

> Select the name of the tag you wish to delete from the Tag List list 
box. 

> Click on the Delete Tag button. The Delete Tag dialog box (Figure 
10-27) is displayed. 

Figure 10-27. Delete Tag dialog box. 

> If the name of the tag you wish to delete is not displayed in the Name 
to Delete list box, simply select the desired tag name from the list 
box. 

> Paragraphs tagged with the tag you are about to remove must be 
converted to some other tag. Select this tag name from the Name to 
Convert to list box. 

If, for example, you remove a tag called Headline and replace it with a 
tag called Sub Head, each paragraph in the entire chapter previously 
tagged with Headline is tagged with the Sub Head tag, and the tag 
Headline is removed from the style sheet. 

> Click on the OK button. 

If you attempt to delete the Body Text tag, the following alert is dis­
played. 
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Click on the OK button to return to the Delete Tag dialog box. 

Recovering deleted tags 

Use caution with this option if you use the same style sheet for more 
than one chapter. Although Delete Tag removes the selected tag from 
paragraphs in all text files in the currently opened chapter, all other text 
files previously formatted with this style sheet may still contain para­
graphs tagged with the removed tag name. When you once again open 
chapters containing these text files combined with the revised style 
sheet, all paragraphs previously tagged with the removed name will be 
formatted as Body Text, and the removed tag name will appear in upper 
case in the Tags list. 

Once you delete a tag, this tag is removed from the current chapter. If 
you decide you do not want these tags removed from the current chapter 
after you click on the OK button in the Delete Tag option dialog box, 
you can still recover the original chapter as follows: 

~ Click on the Cancel button in the Update Tags List option dialog 
box. 

~ Click on Abandon when asked if you want to save or abandon 
changes to the style sheet. If you want to save the changes, save them 
under a new name. 

~ Select the Revert to Saved option in the File menu. 

Rename tag The Rename Tag option allows you to change the names of existing 
tags. To rename a tag: 
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~ Select the name of the tag you wish to rename from the Tag List list 
box. 

~ Click on the Rename Tag button. The Rename Tag dialog box 
(Figure 10-28) is displayed. 

Figure 10-28. Rename Tag dialog box. 
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> If the name of the tag you wish to rename is not displayed in the Old 
Tag Name list box, simply select the desired tag name from the list 
box. 

> Enter the new tag name in the New Tag Name entry field and click 
on the OK button. 

If you attempt to rename the Body Text tag, the following alert is 
displayed. 

You can'tremoveonename 
the default Ilodyrfucftag. 

Click on the OK button to return to the Delete Tag dialog box. 

Add New Tag The Add New Tag option allows you to create new tag names. To add a 
new tag: 

> Click on the Add New Tag button. The Add New Tag dialog box 
(Figure 10-29) is displayed. 

Figure 10-29. Add New Tag dialog box. 

> Enter the name of the new tag in the Name to Add entry field. If you 
want to copy the settings from a tag other than the one selected, select 
the tag name from the Copy From list box. 

> Click on the OK button when finished. The new tag name immedi­
ately appears in the alphabetized Tags list, and the currently selected 
paragraph is tagged with this new tag. 

If the name entered in the Name to Add entry field is the same as that 
of a previously created tag, the following alert is displayed. 
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Click on the OK button to return to the Add New Tag dialog box and 
enter another name in the Name to Add entry field. 

Save As New The Save As New Style sheet option allows you to save the style sheet 
Stylesheet under another name. Saving the style sheet under the same name after 

making modifications to the style sheet will cause those modifications 
to be applied to other chapters that use the same style sheet. To ensure 
that you don't make unwanted changes to other chapters, you should 
always save the style sheet under a new name after making style sheet 
modifications unless you want those modifications to affect other chap­
ters. To save the style sheet under another name from the Update Tag 
List dialog box: 

10-70 

~ Click on the Save As New Stylesheet button. The Save File As 
dialog box (Figure 5-9) is displayed. 

Figure 10-30. Save File As dialog box for style sheet (STY) files. 

~ Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the style sheet file to be saved. When the 
name of the destination directory is shown in the Directories list 
box, enter a file name for the style sheet in the File Name entry field 
and click on the OK button. If you want the style sheet to be saved 
over a previously saved style sheet file, select the file name of the 
previously saved style sheet file in the File Name list box and click 
on the OK button, or double-click on the style sheet file name. 
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If the extension is not specified, Ventura Publisher automatically adds 
STY. 

If the file name under which you are saving the style sheet is the same 
as that of a previously saved style sheet, the following alert is displayed. 

Click on the New Name button to re-display the Save File As dialog box 
and select a different file name for the style sheet. Click on the Over­
write button to save the style sheet over the previously saved style 
sheet file. 

Assign Function The Assign Function Keys option allows you to assign tag names to 
Keys the keyboard function keys. These tags can be assigned to paragraphs 

using either the Paragraph tool or the Text tool. 

If you use this option to tag paragraphs while using the Text tool, it 
greatly decreases the time required to format and edit a document 
because it eliminates switching between the Paragraph and Text tools. 

> Click on the Assign Function Keys button. The Assign Function 
Keys dialog box (Figure 10-31) is displayed. 

Figure 10-31. Assign Function Keys dialog box. 
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~ Select one of the Function Keys options. 

~ Select the tag name you wish to assign to the selected key from the 
Tag Name list box. 

~ Repeat the last two steps for each function key to which you wish to 
assign a tag. 

~ Click on the OK button when finished. 

Function keys F1 and FlO are reserved by Windows and cannot be reas­
signed. 

Once you have assigned tags to function keys, you can apply them by 
using either the Paragraph tool or the Text tool to select a paragraph, 
and then pressing the function key corresponding to the tag that you 
want applied to the paragraph. 

Print style sheet The Print Stylesheet option generates a text file containing a descrip­
tion of the attributes of all tags in the currently loaded style sheet. To 
generate this style sheet file: 
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Click on the Print Stylesheet button. The save File As dialog box 
(Figure 10-32) is displayed. 

Figure 10-32. Save File As dialog box for generated (GEN) style sheet 
description files. 

Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the file to be saved. When the name of the 
destination directory is shown in the Directories list box, enter a file 
name for the style sheet description file in the File Name entry field 
and click on the OK button. If you want the file to be saved over a 
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previously saved file, select the file name from the File Name list box 
and click on the OK button, or double-click on the file name. 

If the extension is not specified, Ventura Publisher automatically adds 
GEN. 

If the file name under which you are saving the style sheet description 
file is the same as that of a previously saved file, the following alert is 
displayed. 

t1iA ......• : I .. · ... · •.. · •.......... ·.: .. ·.: •. A. f.·.i.'e.· .•. b ... ~.·:· .. t ... h. a .. ·.t. n .. a.· .•. In .... e.·. a ... lr.e .... · •. a:: .• : ••.. d •.•.•.• ' ... :·.·· ... · \..Ijl < exists. Do you wi:shto 
choose a new name or 
oveJwrite.·.~heeKi$ting •. file7: 

Click on the New Name button to re-display the Save File As dialog box 
and select a different file name for the style sheet. Click on the Over­
write button to save the style sheet over the previously saved style 
sheet file. 

Once the style sheet description file has been generated, you can then 
load this file into Ventura Publisher using the Load TexWicture 
option and selecting the Generated text format. Create your own style 
sheet to format this text, or use the STYLOG .STY style sheet provided 
in the TYPESET directory. 

The text file generated using this option lists the color numbers for all 
colors defined in the Define Colors dialog box. These color numbers are 
used for entering text color formatting codes in a word processor and 
dialog boxes within Ventura Publisher. 

Cancel Click on the Cancel button exits the Update Tag List dialog box and 
abandons all changes to the style sheet. 

The Cancel button will not undo a change made to a style sheet that 
was saved to disk using the Save As New Stylesheet option. 

OK Selecting the OK button exits the Update Tag List dialog box. If any 
unsaved changes have been made to the style sheet, the following alert 
is displayed. 
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Click on the Abandon button to abandon the changes to the style sheet. 

Click on the Save button to save the changes to the style sheet under 
the current style sheet name. 

Click on the Save As button to display the Save File As dialog box 
(Figure 10-33). 

Figure 10-33. Save File As dialog box for saving style sheet (STY) files. 

Use the Drives and Directories list boxes to locate the drive and 
directory in which you want the style sheet file to be saved. When the 
name of the destination directory is shown in the Directories list box, 
enter a file name for the style sheet in the File Name entry field and 
click on the OK button. If you want the style sheet to be saved over a 
previously saved style sheet file, select the file name of the previously 
saved style sheet file in the File Name list box and click on the OK 
button, or double-click on the style sheet file name. 

If the extension is not specified, Ventura Publisher automatically adds 
STY. 
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If the file name under which you are saving the style sheet is the same 
as that of a previously saved style sheet, the following alert is displayed. 

·~_t_'.t(_ 

rT\ ... I .... · A file by that name already \:.V exisb. Do you wish to 
choose a new name or 
overwrite the existing file? 

.. 

1r~:~!i.::ij~:i!!~J~1 I 0 verwrite , 

Click on the New Name button to re-display the Save File As dialog box 
and select a different file name for the style sheet. Click on the Over­
write button to save the style sheet over the previously saved style 
sheet file. 
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Figure 11-1. Text menu. 

Description 

The Text menu lets you: 

• Insert: 

- Box characters 

- Footnotes 

- Index references 

Equations 

- Frame anchors 

- Cross references 

- Tables 

• Change text attributes (bold, italic, subscript, point size, etc.) 
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Insert Special Item 

11 -2 

The Insert Special Item option provides convenient access to the 
following features: 

Box characters 

Footnotes 

Indices 

Equations 

Frame anchors 

Cross references 

Cross reference markers 

Variable definitions 

Tables 

Operation 

To insert any special item: 

~ Place the text cursor at the location where you want to insert a special 
code. 

~ Select the Insert Special Item option in the Text menu. The secon­
dary menu (Figure 11-2) is displayed. 
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Figure 11-2. Special Item menu. 
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~ Select the special item you want to insert, or press the appropriate 
accelerator key. The dialog box for the selected option will appear. 

Each special item is described on the following pages. 

Box Character 

Many fonts do not provide square box characters. Ventura Publisher 
therefore includes the capability to generate them. To insert a box 
character: 

~ Click on the Text tool button. 

~ Place the text cursor where you want the box to appear. 

~ Select the Insert Special Item option in the Text menu. 

~ Select the Box Char option from the secondary menu. The following 
alert is displayed. 
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Footnote 

11 - 4 

Insert Special Item 

Click on the Hollow button to insert a hollow box CD). Click on the 
Filled button to insert a filled box C.). Click on the Cancel button to 
cancel the operation. 

You can use the Text menu Set Font Attributes option dialog box to 
change the size of the box character, shift it up or down, or move it left 
or right. 

The Footnote option places footnote references at the current text 
cursor position, and also adds a footnote at the bottom of the current 
page. 

Footnotes must first be enabled using the Footnote Settings option in 
the Chapter menu. To create a footnote, follow these steps: 

~ Click on the Text tool button. 

~ Place the text cursor where you want the reference inserted. 

~ Select the Insert Special Item option in the Text menu. 

~ Select the Footnote option from the secondary menu. 

Depending on the current footnote settings, a number or character 
appears next to the text cursor. The same footnote reference appears 
at the bottom of the page, followed by the end of file marker 0 • 

~ Place the text cursor in front of the end of file marker at the bottom 
of the page and type the desired footnote text. 

To delete the footnote reference and the footnote itself: 

~ Place the text cursor at the footnote reference in the main body of text. 

~ Move the text cursor back and forth until the current selection 
indicator displays the word Footnote. 

~ Press the Delete key. Both the footnote reference and the footnote 
itself are deleted. 

Footnotes which are too long to fit on 'the current page will automatically 
continue onto the next page. 
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Footnotes can be created from within your word processor even if your 
word processor does not support footnoting. Refer to page D-9 for 
details. 

See also the Footnote Settings option section starting on page 8-26. 

Index Entry 

The Index Entry option inserts an index reference at the current 
position of the text cursor. After all index entries have been inserted, use 
the Manage Publication option dialog box to generate an index. 

A primary entry is the major heading you wish to index. 

A secondary entry is an optional subheading which appears under the 
primary entry. 

The sort keys are an optional setting which overrides an index entry's 
normal alphabetic position. This is useful, for instance, to place entries 
beginning with articles (e.g., a, an, the), in a different alphabetic posi­
tion than the entry's spelling dictates. 

~ Position the text cursor at the location in the text that you wish to 
reference and select the Insert Special Item option in the Text 
menu. 

~ Select the Index Entry option from the secondary menu. The In­
sert/Edit Index Entry dialog box (Figure 11-3) is displayed. 

Figure 11-3. Insert/Edit Index Entry dialog box. 

~ Set the Type of Entry option to Index. 

~ In the Primary Entry entry field, type the primary index reference. 

11 - 5 
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~ Optional: in the Secondary Entry entry field type a subheading. 
This will appear in the index as a subheading under the primary 
reference. 

For instance, in a book about the movie industry, a primary reference 
might be Movie Technologies and a secondary reference Sound, 3-D, 
or Wide Screen. 

Be careful to type precisely the same words in the Primary and 
Secondary entry fields for each index entry that references the same 
concept. Otherwise, you will create two different entries instead of 
multiple page references to the same entry. For instance, if you have a 
reference at one point to Wide Screen, and another reference to Wide 
Screens, two separate entries will appear in the index instead of two 
page references under the same entry. 

Sort keys Use the primary and secondary sort keys to place numbers and/or 
phrases beginning with articles (e.g., a, an, the), in an alphabetic 
position different from what the spelling of the number or phrase would 
suggest. For instance, if the primary entry is The Maltese Falcon, and 
you want to alphabetize this entry under Maltese rather than The, enter 
Maltese Falcon on the Primary Sort Key entry field. Sort keys work 
with all three Type of Entry options. Sort keys are optional. Leave this 
entry field blank for most index entries. The same sort key name cannot 
be used for different Primary Entry names. 

See, See also The See and See Also entry fields are used to reference other index 
entries. The index in this reference guide provides many good examples 
of how to use the See and See Also options. 

11 - 6 

If you set the Type of Entry option to See, the word See precedes the 
secondary entry when you generate an index using the Manage Publi­
cation option dialog box Make Index option. The See Also option 
works like the See option, except that the words See Also precede the 
secondary entry. The Make Index option in the Manage Publication 
option dialog box allows you to substitute the words of your choice in 
place of See and See Also. 

See and See Also index entries are alphabetized according to the entry 
or sort key. They are not placed a.lphabetically under See. 

No page or chapter number is placed after a See or See Also entry. 
Therefore, the locations of these entries within a chapter or publication 
do not matter. It is therefore recommended that you group all See and 
See Also references together at the beginning or end of a chapter. You 
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can then add and delete these cross-references without searching for 
them. 

If you want to include chapter and page references in the See and See 
Also entries: 

~ Set the Type of Entry option to Index. 

~ Begin the Primary Entry or Secondary Entry entry fields with the 
words See or See Also. 

~ Duplicate the Primary Entry or Secondary Entry entry field 
string in the corresponding sort key entry field, minus the words See 
or See Also. 

Entry in InsertlEdit Index Index created by Manage Publication 
dialog box Make Index command 

Type of entry: 
Index 

~ 
Primary: 
Auto-Numbering 
Secondary: 

Type of entry: 
Index Auto-Numbering, 5-54 - 5-60 
Primary: ~ Example, L-39 
Auto-numbering See also, Section numbering 
Secondary: 
Example 

Type of entry: 
See Also 
Primary: 
Auto-numbering 
Secondary: 
Section numbering 

figure 11-4. Entries in the Insert / Edit Index dialog box are used by the 
Manage Publication option dialog box Make Index option to create index 
entries. 

Editing index You can edit index entries in the following manner: 
entries 

~ Place the text cursor at the location of the index entry. The location 
of the index entry is marked by a small circle if the Show Tabs & 
Returns option in the View menu in enabled. 

11 -7 
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~ If necessary, move the text cursor back and forth until the current 
selection indicator displays the word Index. 

~ Select the Edit Special Item option in the Text menu or press 
Ctrl+D. Make whatever changes you desire, and then select the OK 
button. 

Cut, copy, paste To cut or copy an index entry: 
index entry 

~ Place the text cursor immediately in front of the index entry. If 
necessary, move the text cursor until Index Entry is displayed in the 
current selection indicator in the lower left corner of the screen. 

~ To delete the index entry, click on the Cut function button, or press 
the Delete key. The index entry is deleted from the text. 

When an index entry is cut, the index entry is not copied to the clipboard. 
If you wish to restore the index entry, immediately click on the Undo 
function button. If you wish to move an index entry, copy the index entry 
to the clipboard using the Copy function button or the Shift + Delete 
keys, and then cut the index entry using the Cut function button or the 
Delete key. 

~ To copy the index entry, click on the Copy function button, or press 
Shift+Delete. The index entry is copied to the clipboard. 

Mter the index entry is copied to the clipboard, you can then paste this 
item in another location. Simply place the text cursor where you want 
the item to appear and then click on the Paste function button, or press 
the Insert key. This is especially useful for quickly inserting multiple 
index entries in text. 

Indexing in your You can type index entries in your word processor even if your word 
word processor processor doesn't support indexing. If your word processor does support 

indexing, you must still enter index references as shown below. For 
instance, to create the index entries shown in Figure 11-3, insert the 
following into the word processor text file: 

11 - 8 

<$IMovie Technologies;3-D[Threel> 

The Manage Publication option dialog box Make Index option places 
this entry into the final index in this format: 



Insert ~peclal Item 

Index entry 
sorted 

according to 
the sort word 

three 

M 

Motion Picture 

See Movies 

Movie Technologies 

Sound 4-12, 4-15 - 4-18 

See also Technology 

3-D 4-34,5-33 

Wide screen 4-25, 5-15 

Multiple page Entering the identical index entry in more than one location results in 
references multiple chapter and page references, separated by commas. If the 

identical entries appear on consecutive pages, the starting and ending 
pages are shown, separated by a dash (e.g., the secondary entry Sound 
in the previous example). 

For advanced users: to automatically index the range of pages oc­
cupied by a section or chapter, follow these steps: 

~ Use the 1st Match or Last Match option in the Headers & Footers 
option dialog box to automatically place tagged text at the top and 
bottom of each page. (Refer to the Headers & Footers section 
starting on page 8-20.) 

~ Insert the index entry in a paragraph. 

~ Tag that paragraph with the tag specified in the 1st Match or Last 
Match entry field string in the Headers & Footers option dialog 
box. 

The tagged text-along with the index-will automatically be dup­
licated at the top or bottom of each page until the next tagged heading 
is encountered. When the Make Index option is selected in the Manage 
Publication dialog box, it will generate a range entry (e.g., the 4-15 -
4-18) which covers the entire section. 

Refer to the Index Generation section in the File menu chapter (page 
5-45) and the Headers & Footers section in the Chapter menu chapter 
(page 8-20). 

11 -9 
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Equations 

You can create complex mathematical and scientific equations directly 
within the text of your document. With this feature you can produce 
most of the formulae and equations used in physics, mathematics, 
engineering, and science. 

The equation feature is used to create both simple mathematical for­
mulae such as 

as well as complex formulae such as 

art. 1 art. 1 art. 
V<1>=~r+-~S+--~<1> 

ar r as r sin S acp 

You can enter an equation at any point in the text of your document. 

Before you enter an equation, make sure that Grow Inter-Line To Fit 
option in the Paragraph Typography option dialog box is set to On 
for any paragraphs which will contain equations. This automatically 
creates vertical space to fit the equation as it grows. 

To enter an equation: 

~ Click on the Text tool button. 

~ Place the text cursor at the location in the text where you want the 
equation to appear. 

~ Select the Insert Special Item option in the Text menu. 

~ Select the Equation option from the secondary menu. The equation 
editor screen shown in Figure 11-5 is displayed. 



Insert Special Item I eX I MeNU 

Figure 11-5. Equation Editing screen. 

> Type the commands to create the equation. You can select the Insert 
Special Item option in the Text menu while in the Equation 
Editing screen to get a secondary menu which provides a few of the 
most commonly used commands (Figure 11-6). The complete com­
mand set is listed at the end of this section, and the rules for using 
these commands are provided on the following pages. 

Italic 
Small 
SUj!erscript 
liubscript 
llnderline 
Double Underline 
Strike-thru 
Qverscore 
Set Eont Attributes ... 

symmation 
integral 
matrix 
center .tol 
center 

Figure 11-6. Equation secondary menu. This is only available from within the 
Equation Editing screen. 

If you pause for a few seconds while typing, the equation is displayed 

below the line. For instance, to make -V X 2 + y2 appear, type: 

size 18 sqrt size 10 { x sup 2-+~y sup 2 } 

11 -11 
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The word sqrt produces the square root symbol, the word sup creates a 
superscript, the - characters add space between characters, size chan­
ges the size of the type, and the braces {} group a portion of the equation 
together. 

Press Ctrl+D to exit from the equation screen. The equation you have 
just defined is displayed in the text. 

Do not use the Text tool attribute options to change the font or place 
lines within the equation. Instead, use the commands described in Font 
Changes section beginning on page 11-18. 

Equations may not appear on the screen exactly as they are printed 
because Ventura Publisher must create all equations from the relatively 
few symbol screen fonts provided. To make equations on the screen more 
accurately reflect the printed result, install Adobe Type Manager as 
described in Appendix 1. 

Edit equations To edit an existing equation: 

> Place the text cursor directly in front of the equation. If necessary, 
move the text cursor back and forth, using the keyboard cursor keys, 
until the word Equation is displayed in the current selection in­
dicator. 

> Select the Edit Special Item option in the Text menu, or press 
Ctrl+D. 

The equation screen shown in Figure 11-5 is displayed and you can then 
edit the equation. 

Cut, copy, paste To cut or copy an equation 
equation 

11 -12 

> Place the text cursor immediately in front of the equation. If neces­
sary, move the text cursor until Equation is displayed in the current 
selection indicator in the lower left corner of the screen. 

> To delete the equation, click on the Cut function button or press the 
Delete key. The equation is deleted from the text and placed in the 
clipboard. 

When an equation is cut, the equation is not copied to the clipboard. If 
you wish to restore the equation, immediately click on the Undo func­
tion button. If you wish to move an equation, copy the equation to the 
clipboard using the Copy function button or the Shift + Delete keys, 
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and then cut the equation entry using the Cut function button or the 
Delete key. 

~ To copy the equation, click on the Copy function button or press 
Shift+Delete. The equation is copied to the clipboard. 

After the equation is copied to the clipboard, you can then paste this 
item in another location. Simply place the text cursor where you want 
the item to appear and then click on the Paste function button or press 
the Insert key. 

Equation style No special tags are needed for equations. However, you may want to use 
sheets the Paragraph tool Attribute Overrides option to adjust the size and 

height of superscripts and subscripts for the paragraphs which contain 
equations. 

You should not use tabs within equations. 

Some of the equation commands automatically grow the equation char­
acter to fit the expression which follows. On printers which use discrete 
size fonts (e.g., HP LaserJet), the exact size required may not be 
available. This may result in some overlap of a math operator, such as 
the square root symbol, and the numbers and text in the equation. 

Equation rules 

The Ventura Publisher equation language uses natural names and a 
simple syntax which lets you specify equations in the same manner as 
if you were speaking them out loud. For instance, to specify 
cos(Ol) + sin(02) you simply type: 

cos ( theta sub 1 )~+~sin ( theta sub 2 

The - characters add additional space between characters. 

The equation language has very few formal rules. There are, however, 
four rules which you must remember to follow: 

Rule I-You must place a space both before and after all commands and 
special words. The equation language recognizes over 100 commands 
and special words. For instance, the word omega gets translated to the 
Greek character n within an equation. As another example, the word 
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matrix is used to automatically place the characters which follow into 
a matrix. If you fail to place a space before and after a special word, the 
word will simply print as you typed it rather than be interpreted as a 
special command. 

Rule 2-Spaces placed in the equation do not print. This means that 
X + Y and X + Y will both print as X+ Y. To put a space between 
characters, use the tilde character - for a normal space and A for a thin 
space. 

Rule 4-CommaIids must always be entered into the equation edit 
screen in lower case letters. Commands entered as initial cap or upper 
case will be displayed just as they where entered. 

Rule 3-Commands modify the expression immediately following. The 
only exception is the diacritical mark commands, which modify the 
preceding expression (e.g., xyz bar produces xyz). An expression is: 

• Any character 

• Any special word 

• Any group of characters not separated by a space 

• Anything placed inside of braces { }. 

Typical expressions are: 

• X+ Y which producesX+Y 

• omega which produces n 
• {x sup 2~+~y sup 2} whichproducesx2+y2 

The most common mistake made by users when creating equations is 
forgetting to put a space between commands and special words. 

Typeface changes within an equation are created using the keywords 
font, size, bold, symbol, and italic. Do not use the < > codes shown in 
Appendix D. 
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How to create equations 

This section shows how to create equations. Once you know how to 
create them, you can use the exhaustive list of commands and special 
words given in the next section to produce any equation. 

All equations are made up of the following classes of commands and 
special words: 

• Symbol words. These are words which are translated into symbol 
character equivalents, including Greek characters and certain math-
ematical symbols. For example: PI produces n 

• Romanized words. These are words which are translated into 
Roman (normal) type. All text in an equation is otherwise printed in 
italic type. Romanized words include math operators such as sin, cos, 
and log. 

• Diacritical marks. A diacritical mark is any character, symbol, or 
accent which is displayed above a letter or group of letters. For 
example: xyz dyad produces~. As mentioned earlier, diacritical 
mark operators appear after the expression. 

• Font commands. These commands change the font of the expression 
which follows. For example: abc-+-bold xyz produces 
abc +xyz 

• Equation commands. These commands either' create a math sym­

bol (such as S), or modify the position of the expression which follows. 

For example, the equation command sum in the equation: 

sum from {i-=-l} to inf --{x sub i over {x sub i-+~l}} 

produces 

00 

x· 
L x.:l 

i = 1 l 

Typing equations The best way to learn how to create an equation is to enable the equation 
screen, as described at th~ beginning of this section, and then begin 
typing. To know what to type, practice saying the equation out loud. For 
instance, to create: 
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you would say: "x superscript 2 over y superscript 2." The code that you 
type is virtually identical: 

x sup 2 over y sup 2 

Don't be afraid to try something. You can see the results immediately 
and if what you typed is not right, delete or modify what youjust typed. 

Braces 

Larger equations require braces. For instance, 

requires braces around everything in the numerator and braces around 
everything in the denominator (with the exception of the sqrt com­
mand) in order for the over command to correctly place one expression 
over the other. The actual expression used to produce this equation is: 

{a sub -+-b sub 1} over sqrt {c sub l-+-d sub 1} 

A good habit to get into is to always type both the opening and closing 
brace at the same time. Then move the text cursor between the two 
braces and begin typing. This way you don't forget to add the closing 
brace. Failure to have the same number of left and right braces makes 
the equation format incorrectly. 

Spaces 

Note the - characters in the previous expression. Since spaces are used 
to separate expressions (not to add space), you must explicitly place 
space characters where you want more space in the equation. The -
character adds a normal space, and the A character adds a thin space. 

Equation commands 

The command and special word summary beginning on page 11-25 
provides a complete list of the equation commands available. The ex-
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amples provided show you how to use these commands. The examples 
at the very end of the chapter show you how to combine various com­
mands together to produce fairly complex equations. This section 
provides a brief description of each command along with a list of unusual 
uses. 

above The above command places one expression directly over the other in a 
matrix or pile (a pile is like a matrix except that adjacent elements are 
not forced to align). 

back, down, The back command moves the expression that follows to the left by the 
fwd, up amount specified. The down, fwd, and up commands move the follow­

ing expression down, to the right, and up respectively. The units used 
are lilO of a point. For example: 

A over back 30 A 

produces 

A 
A 

Use these commands to override the automatic placement provided by 
Ventura Publisher. 

Braces Braces group expressions together into a single expression. Braces 
should always be used in pairs. The one exception to this is when you 
use the brace with a left command. In this case you do not need a 
matching right brace. This lets you create expressions like: 

left {pile {x above y above z} 

which produces 

ccol, Icol, rcol These commands are used within a matrix to align the expression which 
follows-and every element in that expression-within the center, left, 
or right of a column. For instance, 

matrix { ccol { { x sub l + Y sub l } above 
y sub i above z sub i } } 
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produces: 

These three commands are always used within a matrix command. 
Outside a matrix command, use piles instead. A matrix must have the 
same number of elements in each column. 

See Above. 

color You can change the color of any portion of the equation using the color 
command. For example, 

x sub color 2 y 

will change y to the color currently defined for color index 2. Refer to 
page 10-51 for information on how to define colors. 

cpile,lpile,rpile, Piles are stacks of identical equations which should align above each 
pile other. The syntax and use are identical to ccol, lcol, and rcol except that 

no matrix command precedes the pile. The pile and cpile are the same. 
A typical example is: 

y-=-left { rpile {-l above -2 above O} --­
lpile { {roman when -x-=-l} above {roman when 
-x-=-O} above {roman when -x-=-l} } 

This produces: 

{

-I when x = 1 
y = -2 when x = 0 

o when x = 1 

down See back. 

Font changes You can change font within an equation using the font commands. These 
include: bold, fat, font, italic, roman, size, and symbol. The bold 
and fat commands are identical and both change the following expres­
sion to bold. The font command lets you change the font using the font 
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Fraction bar 

from 
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ID numbers given in Appendix I. For instance to change to Helvetica (or 
Swiss), you type: 

Change- ll toll-font 2 Helvetica. 

This produces 

Change to Helvetica 

The italic command changes to italic and roman changes to normal 
type, e.g., not italic. The size command lets you change the size of the 
type so that you can override the default sizes used to generate the 
equation. The symbol command is the same as font 128 and lets you 
access all the other characters in the symbol character set shown in 
Appendix E. Look at the examples at the end of this chapter to see how 
to use the font changes within equations. 

These commands affect only the following expression, not the entire 
equation. 

When entering fractions in a word processor, the slash is generally used 
as the fraction bar producing a fraction that looks like 112. Typo­
graphically, though, this is an incorrect format for fractions. Ventura 
Publisher's equation generator provides a fraction bar option which 
places a true fraction bar between two expressions. It also superscripts 
the expression in front and moves it to the left. It subscripts the 
expression after the fraction bar and moves it to the right to produce a 
fraction that looks like lf2. The slash key (I) is used to create the fraction 
bar, but in the Equation Editing screen it is handled as a fraction bar 
and not as a slash. 

The from command takes the text which follows from and places it 
directly under the expression which precedes the from command. It is 
used primarily in conjunction with the sum, prod, and union com-

mands, but also occasionally with the int f command. Example: 

sum from i=O to inf 

which produces 
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L 
i=O 

The command to is often used in conjunction with from and must follow 
the from command. 

The from command can also be used in other interesting ways. For 
instance: 

lim from {x -> inf}~~ {x~+~l} over x 

produces 

1
. x+ 1 
Im--
x~oo X 

fwd See down. 

int The integral command produces an integral sign J. Use the - and A 

characters and the fwd and back operators to move the expression 
which follows the integral to the location you want. The limits for the 
integral are set using the sub and sup commands. These commands 
place the limits in the typical positions to the right of the integral near 
the top and bottom. If you want the limits placed directly underneath 
and above the integral, use to and from in place of sub and sup. If you 
want to make the integral sign larger, lise the size command. Example: 

O~=~size 18 int sub {size 10 -1} sup {size 10 
{~~l}}~x sup 2~dx 

which creates 

inter The intersection command produces an intersection symbol n. 

leol See ccol. 
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left The left command coupled with the right command lets you place large 
braces { }, brackets [ ], parentheses ( ), bars I I, floor L, and ceiling I 
characters around the expression which follows. The enclosing marks 
automatically grow vertically to fit the expression. For instance: 

x-=-left ( a sup 2 over b sup 2 right ) 

produces x = (:: J 

Normally you should have a right to match each left command. How­
ever, you can omit the right if you want unbalanced parenthesis. 

The left command can be used with any character, although these other 
characters will not expand. This can occasionally be useful. For in­
stance, use left nothing to provide a match to a right brace or paren­
thesis which has no left counterpart. 

lineup, mark This command lets you align subsequent equations with a marked 
location in the current equation. One lineup and one mark command 
is allowed in each equation. 

The horizontal starting location of the expression which follows the 
mark command is remembered. In a later equation, the expression 
following the lineup command is moved to this location. For example: 

x- mark =-y-+-z 

produces 

x =y +z. 

Then, if a later equation uses the lineup command: 

y-+-z- lineup =x 

produces 

y+z=x 

Note how the equal signs in the two equations align with each other. 

The lineup and mark commands cannot be used within an equation to 
align text. Use the pile or matrix plus col commands instead. 
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~ The mark and its associated lineup must both appear on the same 
page. 

Ipile See epile. 

mark See lineup. 

matrix The matrix command creates a matrix with even vertical spacing be­
tween rows, regardless of whether each element in the matrix has the 
same height. Ventura Publisher looks at the entire matrix before decid­
ing on the proper spacing to use between rows. By contrast, the space 
between rows in each column in a pile varies depending on the height of 
each expression. 

Each column within the matrix must have the same number of ele­
ments. The lcol, ccol, and rcol are used to align elements within each 
column of the matrix. Each column can be aligned left, center, or right. 
For example: 

matrix {leal {a sub 1 above a sub 2}-leol 
{b sub 1 above b sub 2}} 

produces: 

See also leol. 

over The over command centers the previous expression over the top of the 
following expression and places a horizontal bar between them. The 
previous expression is shifted up and the following expression down. 
The over command is used for fractions. For example: 

produces 

b 
a+-+d. 

c 

pile See lpile. 
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prod The prod command creates a product symbol IT. This command is 

usually used with the from and to commands. Use the size command to 
make the product symbol bigger. For example: 

prod from {i-=-l} to inf -lover x sub 1 

produces 

00 

rr~ 
i = 1 Xl 

See also from. 

reol See ccol. 

right See left. 

rpile See cpile. 

sqrt The square root operator creates a square root symbol, which automat­
ically grows to fit the expression that follows. On printers which use 
discrete size fonts (e.g., HP LaserJet), the exact size required may not 
be available. This may result in some overlap of the square root and the 
numbers and text in the equation. An example of a square root is, 

y-=-size 18 sqrt size 10 { {x sup 2 over 2}-+-1 } 

which produces 

sub, sup The subscript command subscripts the expression which follows. The 
superscript command superscripts the expression which follows. The 
size and shift for superscripts and subscripts are defined in the At­
tribute Overrides option dialog box for the current tag used. A typical 
example is: 

a sub 1 

which produces 
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You can subscript or superscript to multiple levels. For instance, 

a sub n sub 1 

produces 

You can combine multiple superscripts and subscripts. For instance, 

x sup y sub z 

produces 

Each successive superscript or subscript formats further to the right. 
The one exception to this rule is a sub i sup 2 which produces 

The superscript and subscript commands are also used with the int 
command to place limits above and below the integral sign. 

When formatting superscripts and subscript, Ventura Publisher moves 
the base characters as necessary to make room for the shifted text. This 
can lead to problems. For instance: 

2 over X sup 2~+~1 over Y 

produces 

2 1 -+­
X2 y 

Notice how the X and Y do not align because the X was moved down to 
keep the exponent from touching the line. The trick in this and other 
similar situations is to create a phantom character using the nothing 
command. In this case: 

2 over X sup 2~+~1 over Y sup nothing 
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produces 

2 1 -+­
X2 Y 

to See from, int, and prod. 

up See down. 

union The union command creates the union character U. 

TEXT MENU 

Quoted text You occasionally may want one of the special characters or words to 
appear exactly as you type it rather than being interpreted as a com­
mand. Also, you may want to use other characters in the character set. 
Any text placed between two inch" "marks will appear exactly as you 
type it. 

Command and special word tables 

The following tables provide an exhaustive list of every command and 
special word used by the equation feature. 

The following is a list of special characters: 

Special Characters Result 
, ... , , ... 
... ... 
!= * 
+- ± 
-> ~ 

<- f-

« < 
<= < 

- - -
>= ;::: 

» > 
approx ::= 

cdot 
ceiling I 

del a 
floor L 
grad V 
inf 00 

11 -25 



TEXT MENU Insert Special Item 

Special Characters Result 
nothing 
.partial a 
.prime 

, 

times x 
Spaces Result 

- (space) 
A (thin space) 

Greek Character Name Greek Character 

DELTA ~ 

EPSILON E 
GAMMA r 
LAMBDA A 
OMEGA Q 

PHI <I> 
PI IT 

PSI 'II 
SIGMA L 
THETA e 

UPSILON y 

XI ...... 

alpha ex 
beta B 
chi X 

delta () 

epsilon c 
eta n 

g-amma 'Y 

iota t 

kappa K 

lambda A 
mu U 

nu v 
omega (0 

omicron 0 

phi <P 
pi 1t 

psi \II 

rho 0 

sigma (j 

tau 't 

theta e 
upsilon u 

xi C. 
zeta , 
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Romanized Word Name Romanized Word 
1m 1m 
He He 
and and 
arc arc 
cos cos 

cosh cosh 
cot cot 

coth coth 
det det 
exp exp 
for for 
if if 

lim lim 
In In 
log- log 

max max 
min min 
sin sin 

sinh sinh 
tan tan 

tanh tanh 

Diacritical marks To place a diacritical mark above a lower case letter, type the following 
commands in all lower case (e.g., x hat to get f>. To place the diacritical 
mark above an upper case lettxr, type the command with the first letter 
capitalized (e.g., X Hat to get X). 

Command Example Result 
bar xvz bar xyz 
dot xvz dot x.Yz 

dot dot xyz dotdot XYZ 
dyad xyz dyad ~ 
hat xyz hat XYZ 
tilde xyz tilde XYZ 

under xyz under xyz 
vee xyz vee ~ 

Font commands Font commands let you change the font of any portion of an equation. 
These commands must be used because the standard Ventura Publisher 
font and tag controls cannot be placed inside an equation. 
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Command Example Result 

color This-is- color 2 RED-text This is RED text 

fat This-is- fat FAT-text This is FAT text 

font This-is-in- font 2 Helvetica-face This is in Helvetica face 

italic cos ( theta )-or- italic cos ( theta) cos(S) or cos(S) 

roman This-is- roman ROMAN-text This is ROMAN text 

size This-is- size 12 {12-point}-text This is 12 point text 

symbol cos ( symbol f )-+-sin ( symbol g ) cos(<\» + siner) 

Equation commands 

Command Example Result 

braces text-roman {text} text text 

/ x-=-aIb x =a/b 

above (see pile) 

back yback 120 x xy 

ccol (see matrix) 

cpile (see pile) 

down y down 100 x y 
x 

from (see sum) 

fwd yfwd 100 x y x 

001 
int int sub 0 sup inf {AI over xAdx} J -dx 

o x 

inter C-=-A inter B C=AnB 

lcol (see matrix) 

left 
left {text right} {text) 

left {a sub b sup c right} {ag} 

lineup (see mark) 

lpile (see pile) 
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Command Example Result 

y sub n+1-mark =-y sub n"+"l Yn+l =Yn + 1 
mark y sub O-lineup =-0 yo=O 

y sub {last}-lineup =-inf Ylast = 00 

matrix matrix {eeol{a above b}-eeol {e above d}} ac 
bd 

a over {b"+"e} 
a 

over 
b+c 

rpile { 0 above 2x above 0 }--lpile {x < 0 above 0 o x<O 
pile 2x 0~:::;1 

<= x <= 1 above 1< x } 01<x 

00 

prod prod from {i-=-l} to infX sub i I1Xi 
i=l 

reol (see matrix) 

right left { rpile { {x-+-y} above x above x sup 2 } right} rx~} 
rpile (see pile) 

sqrt sqrt {x sup 2"+"y sup 2} --Jx2 + y2 

a subb ab 
sub 

a sub b sub e abc 

00 

sum sum from {i-=-l} to inf X sub i LXi 
i=l 

a sup b ab 

a sup b sup e be 
sup a 

a sub b sup e ab 

a sup b sub e abc 

to (see sum) 

union C-=-A union B C=AUB 

yup 100 x x up 
Y 
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Equation examples 

The following provide examples of fairly sophisticated equations. 

grad symbol f-=-{del symbol flover{del r 
sup nothing}"{roman bold r}-+-1 over {r 
sup nothing}"{del symbol flover{del theta 
sup nothing}"{bold theta}-+-1 
over{r"sin"theta sup nothing}"{del 
symbol flover{del phi sup nothing}"{bold 
symbol fl 

bold{grad-times-roman A}-=- left I 
{matrix{eeol{{{bold roman r}over 
{r sup 2"sin"theta}}above{del over 
{del r}}above{A sub r}}--eeol{{{bold theta} 
over{r"sin"theta sup nothing}} above{del 
overt del theta}} above 
{rA sub theta}}--eeol{{{bold symbol fl over 
{r sup nothing} } above {del over 
{del phi}}above 
{rA sub phi"sin"theta}}}} right I 

grad sup 2 symbol f-=-1 over {r sup 
nothing}"del over {del r sup nothing}" left 
({r "{del symbol flover{del r sup 
nothing}}right )-+-1 over{r sup 2}"{del 
sup 2 symbol flover{del phi sup 2}-+-{del 
,sup 2 symbol flover{del z sup 2} 

f(x)-=-left { Ipile { p sub 1 (x) -roman 
when -x sub 0 -<-x-<-x sub 1 above 
p sub 1 (x) -roman when -x sub 1 
-<-x-<-x sub 2 above ---edot above 
---edot above ---edot above p sub m (x) 
-roman when -x sub {m-l} -<-x-<-x sub 
m} 
fwd 100 { up 20 {nothing sup n}} size 30 
down 70 sqrt {size 10 n sup 2 over 2 sup n 
} -+-{ n sup { 2/n } lover 2 sup nothing 

F(x)-=-1 over { sigma sqrt { 2 pi } }­
int sub { - inf} sup {(x-u) 1 sigma} 
e sup {- u sup 212 }"sigma"du 

my dotdot -+-e y dot-+-ky-=-O 

c sup * (omega sub max )-+-2mF sub 0 
over { e sqrt { 4 m sup 2 { omega sub 0 } 
sup 2 "-" e sup 2 } } 
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am 1 am 1 am 
V<I>=~r+-~e+--~<I> 

ar r ae r sin e o<p 

VxA= 

((x) = 

r e ~ ------
r2 sin e r sin e r 

a a a -
ar ae a<p 

Ar rAs rAcp sin e 

PI(X) when xo < x < Xl 

PI(X) when Xl < X < X2 

Pm(X) when Xm-l < X < Xm 

1 fX-uvcr 2 

F(x) = crJ21t -00 e-
u

/2 0' du 

my+cy+ky=O 

* 2mFo 
C (ffimax) + ~ 2 2 2 

C 4m roo - c 
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1 over R ..... = ..... lim from { m -> inf} ..... left 1 .1 ~ lim I em+ II 
c sub {m+l} over c sub m right 1 R m~oo em 

bold A ..... = ..... left ( matrix { lcol { a sub 11 
above a sub 21 above .......... cdot above 
a sub ml } ..... lcol { a sub 12 above a sub 22 [all a12 ••• aln 1 
above .......... cdot above a sub m2 } ..... lcol { ... A = a~l a~2 ::: a~n 
above ... above ... above ... } ..... am1 am2 ... amn 
lcol { a sub In above a sub 2n above 
.......... cdot above a sub mn } } right) 

left 1 matrix { rcol { 3 above 1 above 3 6-4 
-6} ..... rcol { 6 above -1 above -12} ..... 1 -1 3 =0 
rcol { -4 above 3 above 8} } right 1 ..... = ..... 0 -6 -12 8 

int int from back 80 R I\symbol a 
Sf f(x,y) dx dy ~ j [f'<X) f(x, y) dY] dx (x,y)l\dxl\dy ..... = ..... int sub a sup bl\ left [ int 

sub g(x) sup hex) (symbol a (x,l\y)l\dy} R a g(x) 

right] ..... dx 

roman { div bold u } ..... = ..... f grad sup 2 
divu = fV2g + grad f· gradg g ..... + ..... roman "grad"l\fl\cdotl\roman "grad" g 

{ ( z sub 11\+l\z sub 2 ) } bar ..... = ..... { z sub 1 } 
bar ..... + ..... { z sub 2} bar (Zl + Z2) - Zl + Z2 

sum from n=O to infl\left [left ( {n ..... + ..... k} 
i[(n~kr over n right) right] sup { ..... -1} 

lpile {x sub -2 above x sub -1 above x 
sub 0 above x sub 1 above x sub 2} .......... 
lpile { f sub -2 above f sub -1 above 

X-2 f-2 'Of f sub 0 above f sub 1 above f sub 2} .......... lpile -Sf.! '02f 
{ delta f sub { -3/2 } above delta f sub {-I / X-1 f-1 'Of -1 '03f -Y.! 2 -1,-2 

2} above delta f sub { 1/ 2} above delta f xo fo 'O{112 a 10 '03f! 

sub {3 / 2} } .......... lpile { delta sup 2 f sub -1 
Xl f1 '02f Y2 

X2 f2 'Of% 1 

above delta sup 2 f sub 0 above delta sup 
2 f sub l} .......... lpile { delta sup 3 f sub { -1/2 
} above delta sup 3 fsub { 1/2} } 

Frame Anchor 

The Frame Anchor option allows you to place a frame anchor into text. 
This frame anchor links a specified frame to the anchor's location in the 
text. Ventura Publisher provides both an automatic anchor which in­
stantly moves the frame whenever the text containing the anchor is 
moved, and a manual anchor which moves the referenced frame only 
when you execute the Re-Anchor Frames command. 
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Definition To make a frame move when text gets moved from page to page, you 
must first label the frame, and then insert a reference to that label into 
the text of your document. This establishes a link between the frame and 
a particular location in the text. The frame label is entered using the 
Anchors & Captions option in the Frame menu. You then insert the 
reference to this label (called a frame anchor) using the Frame Anchor 
option of the Insert Special Item secondary menu. 

You can anchor a frame in one of three different ways: 

• Anchor the frame so that when text moves to a new page, the frame 
occupies the same location on the new page as it did on the old page 
(Fixed, On Same Page As Anchor). Use this option if illustrations 
always appear at the top or bottom of a page. 

• Anchor the frame directly above or directly below the text, but don't 
move it until the Re-Anchor Frames option (Edit menu) is selected 
(Relative, AbovelBelow Anchor Line). Use this option if you want 
illustrations to stay in their current positions until you give the 
command to move. 

• Anchor the frame in the line of text, and make it move whenever the 
text moves (Relative, Automatically At Anchor). Use this option 
if you want to anchor small pictures within a line of text so that they 
always move with the text. 

To insert a frame anchor into the text on the page: 

~ Place the text cursor where you wish to insert an anchor point. 

~ Select the Insert Special Item option in the Text menu. 

~ Select the Frame Anchor option from the secondary menu. The 
InsertlEdit Anchor dialog box (Figure 11-7) is displayed. 

Figure 11-7. Insert/Edit Anchor dialog box. 
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> In the Frame's Anchor Name entry field, type the name of the 
frame you wish to reference. 

Although the case used in this name doesn't matter, the frame anchor 
name spelling must exactly match the name entered for that frame in 
the Anchors & Captions option dialog box (Frame menu). If the 
spelling doesn't match, a VP Alert box is displayed. 

If you select the Relative, Below Anchor Line option, the top of the 
frame moves to the line below the line containing the anchor. If you 
select the Relative, Above Anchor Line option, the bottom of the 
frame is moved to the line above the line containing the anchor. 

If you select the Fixed, On Same Page As Anchor option, the frame's 
position on a new page is identical to its position on the old page. 

Automatic frame If you select the Relative, Automatically At Anchor option, the frame 
anchoring automatically moves as the text moves. This feature allows you to create 

small drawings and insert them within tiny frames into a line of text. To 
use this feature, the Grow Inter-Line To Fit option (Paragraph 
Typography option dialog box) for the paragraph tag of the paragraph 
containing the anchor should be set to On. When you anchor a frame 
using this feature, Ventura Publisher automatically sets the Flow Text 
Around option Off (Sizing & Scaling option dialog box) for this frame. 

You can also use Relative,Automatically At Anchor to anchor a large 
frame to the end of a paragraph or within a table. Follow the procedures 
in the previous paragraph. To make the feature work correctly with a 
full size frame, note the following: 

• You must insert the anchor directly after a line break (Ctrl+Enter) 
or in a blank paragraph. In either, case the frame anchor should be 
flush with the left or right margin. 

• The Column Snap option in the View menu should be enabled, and 
the frame drawn so that both sides are snapped to a column guide. 

Anchored You can attach graphics drawn using the graphic tools to any frame on 
graphics the page. Use this feature to anchor arrows and callouts to locations in 

the text. Follow these steps: 

> Anchor a small frame at the end of a paragraph using the Relative, 
Automatically At Anchor option as described above. 

> Select the small frame. 
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~ Click on the desired graphic tool button and draw the graphics. 

When the text moves, so do the frames and all graphics tied to the 
frames. 

The frame anchoring function works best if the Move Down To 1st 
Baseline option in the Chapter Typography option dialog box is set 
to Inter-Line. 

Cut, copy, paste To cut or copy a frame anchor: 
frame anchor 
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~ Place the text cursor immediately in front of the frame anchor. If 
necessary, move the text cursor until Frame Anchor is displayed in 
the current selection indicator in the lower left corner of the screen. 

~ To delete the frame anchor, click on the Cut function button or press 
the Delete. The frame anchor is deleted from the text. 

When a frame anchor is cut, the frame anchor is not copied to the clip­
board. If you wish to restore the frame anchor, immediately click on the 
Undo function button. If you wish to move a frame anchor, copy the 
frame anchor to the clipboard using the Copy function button or press 
the Shift + Delete keys, and then cut the frame anchor using the Cut 
function button or press the Delete key. 

~ To copy the frame anchor, click on the Copy function button or press 
Shift+Delete. The frame anchor is copied to the clipboard. 

Mter the frame anchor is copied to the clipboard, you can then paste this 
item in another location. Simply place the text cursor where you want 
the item to appear and then click on the Paste function button or press 
the Insert key. 

Cross Reference/Marker Name 

A cross reference is any reference to a page, chapter, figure, table, 
caption, variable text, or section number. The cross referencing feature 
creates and updates these references so that you don't need to keep track 
of where pictures and text have moved in your document. 
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• For newsletters, magazines and newspapers, this feature generates 
Continued On and Continued From references to help the reader find 
the next portion of an article. 

• For manuals and books, this feature creates and updates references 
to figures, tables, and pages. 

• For all documents, this feature can customize the document by insert­
ing product names, customer names, etc. prior to printing. 

Insert current The simplest use of the cross reference feature is to insert the current 
page or chapter page or chapter number anywhere on the page. To insert the current 

number page or chapter number anywhere on the page: 

~ Click on the Text tool button. 

~ Place the text cursor at the location where you want the page number 
to appear. 

~ Select the Insert Special Item option in the Text menu. 

~ Select the Cross Ref option from the secondary menu. The In­
sertlEdit Reference dialog box (Figure 11-8) is displayed. 

Figure 11-8. Insert/Edit Reference dialog box. 

~ Leave the At The Name entry field blank. 

~ Select the P# option from the Refer To list box to insert the current 
page number, or the C# option to insert the chapter number. If you 
select any other Refer To option when the At The Name entry field 
is blank, the current page number is inserted. 

Mark the To refer to a location in the document other than the current page or 
reference chapter, you must first mark the location to which you wish to refer by 

location inserting a marker name in text. You can mark: 
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• A place in the text 

• Aframe 

Mark text 

To insert a marker name into the text: 

~ Click on the Text tool button. 

~ Place the text cursor at the location you want to reference. 

~ Select the Insert Special Item option in the Text menu. 

~ Select the Marker Name option from the secondary menu. The 
InsertlEdit Marker Name dialog box (Figure 11-9) is displayed. 

Figure 11-9. Insert/Edit Marker Name dialog box. 

~ Enter a marker name. You can use both upper or lower case letters 
plus numbers. However, the case is ignored when this label is refer­
enced (e.g., PICT, Pict, pict are all treated as the same label). Write 
this marker name on a piece of paper so you can remember the label 
name you've chosen. 

Mark frame 

Frames are marked by assigning an anchor name to the frame. This 
anchor name is then used by both the frame anchor feature and this 
cross reference feature. To mark a frame: 

~ Click on the Selector tool button. 

~ Select the frame you wish to label. 

~ Click on the Anchors & Captions option button. 

~ Enter a name in the Anchor Name entry field. 
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Cut, copy, paste marker name 

To cut or copy a marker name: 

>- Place the text cursor immediately in front of the marker name. If 
necessary, move the text cursor until Marker Name is displayed in 
the current selection indicator in the lower left corner of the screen. 

>- To delete the marker name, click on the Cut function button or press 
the Delete key. The marker name is deleted from the text. 

When a marker name is cut, the marker name is not copied to the clip­
board. If you wish to restore the marker name, immediately click on the 
Undo function button. If you wish to move a marker name, copy the 
marker name to the clipboard using the Copy function button or the 
Shift + Delete keys, and then cut the marker name using the Cut func­
tion button or the Delete key. 

~ To copy the marker name, click on the Copy function button or press 
Shift+Delete. The marker name is copied to the clipboard. 

After the marker name is copied to the clipboard, you can then paste this 
item in another location. Simply place the text cursor where you want 
the item to appear and then click on the Paste function button or press 
the Insert key. This especially useful for quickly inserting multiple 
marker names in text. 

Generate the cross reference 

Once you have marked frames and places in the text, you can reference 
these points. To generate a reference, you insert a cross reference into 
the text. This cross reference automatically creates text when the 
publication is renumbered using the Renumber option in the Manage 
Publication option dialog box (File menu). 

To insert a cross reference, follow these steps: 

>- Click on the Text tool button and place the text cursor at the exact 
location where you want the reference to appear. 

>- Select th~ Insert Spechil Item option in the Text menu. 

>- Select the Cross Ref option from the secondary menu. The dialog box 
shown in Figure 11-8 is displayed. 

11 -37 

= 



I t:XI Mt:NU Insert Special Item 

11 -38 

>- Enter the name of the frame anchor or text marker to which you want 
to refer in the At The Name entry field. 

>- Select the type of reference you want to create from the Refer To list 
box. The options available are: 

Page number PI: 
Page number of referenced item 

Chapter number C#: 
Chapter number of referenced item 

Figure number F#: 
Figure number for referenced frame 

Table number T#: 
Table number for referenced frame 

Section number S*: 
Section number which precedes the referenced item 

Caption text C*: 
Generated caption text (the part set by the Anchors & Caption dialog 
box) from the referenced frame 

Variable text V*: 
Text defined for referenced variable 

>- If you select one of the # options (e.g., P#), you can select the format 
for this number from the Format list box. The Default option uses 
the currently defined numbering for each type of counter. If you want 
to use some other format, select this format from the Format list box. 

>- Click on the OK button. No number is displayed initially. 

>- V sing the Manage Publication option dialog box in the File menu, 
create a publication which contains all the chapters in your docu­
ment. Select the Renumber option in the Manage Publication 
option dialog box to update all cross references. 

References can be made either forward or backward within a publica­
tion. If you want to generate multiple references (e.g., both the chapter 
and page number), you need to insert multiple cross references. 

Error file If Ventura Publisher cannot find a marker name or frame anchor which 
matches the cross reference, it generates an error file which contains a 
list of all bad references. You can then load this file into a frame or use 
your word processor to read the text in this file. You should then use this 
information to correct the cross references or add the missing marker 
and anchor names. 



III~erl upel,;ldl Helll 

Cut, copy, paste To cut or copy a cross reference: 
cross reference 

~ Place the text cursor immediately in front of the cross reference. If 
necessary, move the text cursor until Reference is displayed in the 
current selection indicator in the lower left corner of the screen. 

~ To delete a cross reference, click on the Cut function button or press 
the Delete key when Reference is displayed in the current selection 
indicator. The cross reference is deleted from the text. 

When a cross reference is cut, the cross reference is not copied to the 
clipboard. If you wish to restore the cross reference, immediately click 
on the Undo function button. If you wish to move a cross reference, copy 
the cross reference to the clipboard using the Copy function button or 
the Shift + Delete keys, and then cut the cross reference using the Cut 
function button or the Delete key. 

~ To copy a cross reference, click on the Copy function button or press 
Shift+Delete when Reference is displayed in the current selection 
indicator. The cross reference is copied to the clipboard. 

After the cross reference is copied to the clipboard, you can then paste 
this item in another location. Simply place the text cursor where you 
want the item to appear and then click on the Paste function button or 
press the Insert key. This especially useful for quickly inserting multi­
ple cross references in text. 

Variable Definition 

The Variable Def option lets you customize documents by inserting 
variable text at cross reference points. When you renumber the publica­
tion, the current value of these variables is inserted at all of the locations 
in your document which you've specified. This is useful when you need 
to: 

• Insert the current date. 

• Insert the current revision number. 

• Change the name of the product. 

• Insert the name of the customer. 

While this can be done using the search and replace function in a word 
processor, you often don't want to replace every occurrence of a par-
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ticular phrase. Also, variable insertion lets you replace many different 
variables simultaneously. Finally, variable insertion will change every 
text file in every chapter associated with a publication. 

For example, you can create a variable called Product using the Vari­
able Def option in the Insert Special Item secondary menu (Text 
menu). To define this variable, enter Product in the Variable Name 
entry field. Then in the Substitute Text entry field, enter the text you 
wish to insert, for instance Widget. Then, at each location in the publi­
cation where you want the name of the product to appear, insert a cross 
reference. In the Cross Ref option dialog box, enter the name Product 
in the At The Name option entry field, and set the Refer To option to 
V*. To actually get the new name to appear, renumber the publication 
using the Manage Publication option dialog box Renumber option. 
At the end of the renumber operation, the word Widget will appear at 
each location where you inserted a cross reference that refers to the 
variable called Product. 

Variable To insert a variable: 
insertion 

~ Click on the Text tool button. 

~ Place the text cursor at the location where you want to store the 
variable definition. The beginning of the first chapter in the publica­
tion is the normal location at which to insert all variables. This makes 
it easier to find and edit them at a later time. 

~ Select the Insert Special Item option in the Text menu. 

~ Select the Variable Def option from the secondary menu. The In­
sertlEdit Variable Definition dialog box (Figure 11-10) is displayed. 

Figure 11-10. Insert / Edit Variable Definition dialog box. 

~ Enter the variable in the Variable Name entry field. This name is 
later referenced in the At The Name entry field in the Cross Ref 
option dialog box. Do not use square brackets [ ] or braces { } within 
the variable name. 
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~ Enter the text to insert into the cross reference. 

~ Click on the OK button. 

During the renumber operation, Ventura Publisher uses the current 
definition for each variable. This lets you change the variable definition 
at different locations throughout the document. In general, however, it 
is easiest to define each variable only once, and to place this definition 
at the beginning of the first chapter in the publication. 

Cut, copy, paste To cut or copy a variable: 
variable 

Table 

~ Place the text cursor immediately in front of the variable. If neces­
sary, move the text cursor until the word Variable is displayed in the 
current selection indicator in the lower left corner of the screen. 

~ To delete the variable, click on the Cut function button or press the 
Delete key. The variable is deleted from the text. 

When a variable is cut, the variable is not copied to the clipboard. If you 
wish to restore the variable, immediately click on the Undo function 
button. If you wish to move a variable, copy the variable to the clipboard 
using the Copy function button or the Shift + Delete keys, and then 
cut the variable using the Cut function button or the Delete key. 

To copy the variable, click on the Copy function button or press 
Shift+Delete. The variable is copied to the clipboard. 

You can then paste this item in another location. Simply place the text 
cursor where you want the item to appear and then click on the Paste 
function button or press the Insert key. This especially useful for 
quickly inserting multiple variables in text. 

The Table option operates identically to the Insert New Table option 
in the Table menu. When the Table option is selected from the Insert 
Special Item secondary menu, the InsertlEdit Table dialog box is 
displayed. Refer to the Insert New Table option section in the Table 
menu chapter from information on creating and editing a table. 

11 -41 



11 -42 

msen ::;peClal Item 

When creating a table using the Text tool and the Table option from the 
Insert Special Item secondary menu, the text cursor must be position 
at the very beginning or end of a paragraph. 
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Edit Special Item 

The Edit Special Item option allows you to easily edit the following 
special codes: 

• Index entries 

• Equations 

• Frame anchors 

• Cross references 

• Marker names 

• Variables 

You can delete box characters, footnotes, and page/chapter number 
special codes, but you cannot edit them. 

Operation 

To edit a special item: 

> Place the text cursor immediately in front of the special item. If 
necessary, move the text cursor until the name of the special item is 
displayed in the current selection indicator in the lower left corner of 
the screen. 

> Select the Edit Special Item option in the Text menu or press 
Ctrl+D. The dialog box for the special item is displayed. 

> Make whatever changes you desire, and then click on the OK button. 

Use the Ctrl+D keyboard shortcut to edit a special item. 
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Attribute options 
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The 10 attribute options described in this section allow you to easily 
change the appearance of the highlighted text. Attributes can be com­
bined, though some are mutually exclusive (e.g., superscript and sub­
script). Text attributes set using these attribute option override the 
settings of the paragraph tag. 

To change text attributes such as font size, typeface, and color for 
highlighted text (verses the entire paragraph), use the Set Font At­
tributes option described starting on page 11-46. 

The Normal option button resets the highlighted text to the font, size, 
and style attributes of the paragraph tag associated with the paragraph 
in which the text appears. 

The Bold option button changes the font attributes of the highlighted 
text to boldface. 

The Italic option button changes the font attributes of the highlighted 
text to italics. 

The Small option button allows you to easily change the selected text to 
a predetermined size. The size of the text is determined by the settings 
in the Attribute Overrides dialog box for the paragraph tag in which the 
selected text appears. 

The Superscript option button changes the highlighted text to super­
script. The size and amount of upward shift of the superscript text is 
determined by the settings in the Attribute Overrides dialog box for the 
paragraph tag in which the superscript text appears. 

The Subscript option button changes the highlighted text to subscript. 
The size and amount of downward shift of the subscript text is deter­
mined by the settings in the Attribute Overrides dialog box for the 
paragraph tag in which the subscript text appears. 

The Underline option button places a line below the highlighted text. 
The height and spacing of the underline are determined by the settings 
in the Attribute Overrides dialog box for the paragraph tag in which the 
underlined text appears. 



Attribute options 

The Dbl Underline option button places two lines below the high­
lighted text. The height and spacing of the underlines are determined 
by the settings in the Attribute Overrides dialog box for the paragraph 
tag in which the underlined text appears. 

The Strike-thru option button places a line through the highlighted 
text. The height and spacing of the strike-thru are determined by the 
settings in the Attribute Overrides dialog box for the paragraph tag in 
which the strike-thru text appears. 

The Overscore option button places a line above the highlighted text. 
The height and spacing of the overs core are determined by the settings 
in the Attribute Overrides dialog box for the paragraph tag in which the 
overscored text appears. 
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Set Font Attributes 
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The Set Font Attributes option allows you to change the appearance 
of a selected range of text. 

Operation 

To change the font of selected text: 

> Click on the Text tool button. 

> Select the text whose font you wish to change. 

> Click on the Set Font Attributes option button. The Font Setting 
For Selected Text dialog box (Figure 11-11) is displayed. 

Figure 11-11. Font Setting For Selected Text dialog box. 

> Select the Face, Size, Style, Color, and Attributes options you 
desire for the selected text, and then click on the OK button. 

Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in the Color list box. Custom colors can be created using the 
Define Colors option as described on page 10-60. 
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Move selected text 

The Set Font Attributes option dialog box lets you change the spacing 
between letters in the selected text, and also move the text up or down. 

To change the spacing of the selected text: 

>- Set the Kern option to Looser to move the characters apart. Set the 
Kern option to Tighter to move the characters together. 

>- Enter the amount of space to add (looser) or subtract (tighter) be­
tween each character in the Kern entry field. 

The amount you enter is measured in Ems, where one Em equals the 
width of the @ character in the currently selected font. 

To move an individual letter to the left or right: 

>- Select only a single letter. 

>- Press and hold the Shift key. 

>- Press either the right or left keyboard cursor key. The text following 
the selected letter will move in the direction of the arrow. 

To shift selected text up or down: 

>- Set the Shift option to Up to move the text up, or Down to move the 
text down. 

>- Enter the amount by which you wish to shift the text in the Shift 
entry field. 
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Change Text To 

11 -48 

The Change Text To option allows you to quickly change the case of 
letters in a selected block of text. 

The Capitalize option button converts the first letter of each word in 
the selected text to capital letters. 

The Upper Case option button changes every letter of the selected text 
to upper case. 

The Lower Case option button changes every letter of the selected text 
to lower case. 

The Normal option button restores the selected text to the attributes 
specified by the paragraph tag. However, it does not undo case conver­
sions (e.g., uppercase to lowercase). 
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Show On All eages 
.send to Back Ctrl+Z 
Bring to Front Ctrl+A 

Line Attributes ... Ctrl+L 
Eill Attri b ute s ... Ctrl+F 

Select All Ctrl+Q 
,grid Settings ... 

Figure 12-1. Graphic menu. 

The options in the Graphic menu allow you to perform four major 
functions on selected graphics: 

• Make them repeat on every page. 

• Move them in front or behind one another. 

• Change line and fill (shading) attributes. 

• Create a grid to which all graphics will snap. 

Refer to the Chapter 3 for information on how to use the graphic drawing 
features. 
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Show On AlllThis Page(s) 

12 -2 

This option allows you to make a graphic print on every page in the 
document. Use the Show On Allffhis Page(s) option to: 

• Create camera crop marks anywhere on the page. 

• Create custom column guides which are not centered in the gutter. 

Operation 

~ Click on the Selector tool button. 

~ Select the desired graphic and then select the Show On All/This 
Page(s) option button. 

If you select a graphic that already displays on all pages, then the 
Graphics menu selection for this option displays Show On This Page. 
If you want to stop the graphic from repeating on every page in the 
document, select this option. The graphic will be shown only on the 
current page. 

Graphics repeat at the same place on both left and right pages. If you 
want graphics to repeat at different locations on left pages than on right 
pages, follow these steps: 

~ Go to any left page. 

~ Click on the Add Frame tool button. 

~ Add a small new frame in the margin of your document. The place­
ment of this frame does not matter as long as it doesn't interfere with 
any of the text. 

~ Make sure that the frame youjust drew is still selected and then draw 
all the graphics which you wish to repeat on left pages. 

~ Click on the Repeating Frame option button and set the For All 
Pages option to Left. 

~ Go to any right page. 

~ Repeat the previous five steps except set the For All Pages option in 
the Repeating Frame dialog box to Right. 
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If you do not want graphics attached to a repeating frame to show on a 
particular page: 

>- Go to the page where you do not want graphics to appear. 

>- Select the frame to which you have attached graphics. 

>- Click on the Repeating Frame option button. 

>- Set the On Current Page option to Hide This Repeating Frame. 
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Send to Back 

The Send to Back option takes the selected graphic and places it at the 
bottom of all graphics associated with the currently selected frame. 

Operation 

12-4 

Use the Selector tool to select the graphic you wish to place behind all 
other graphics. Click on the Send to Back option button, or press and 
hold the Ctrl key and then press Z. 

Sometimes you cannot select a graphic because it is positioned behind 
another graphic. This situation can be corrected as follows: 

Figure 12-2. Line sent to back of rectangle. 

~ Click on the Selector tool button. 

~ Press and hold the Ctrl key. 

~ Position the mouse cursor over the graphic you wish to select and 
then click the mouse button until the graphic you want is selected. 

Each press of the mouse button, selects the next graphic further down 
in the stack. 



Bring to Front 

Bring to Front 

GRAPHIC MENU 

The Bring to Front option takes the selected graphic and places it on 
top of all graphics associated with the currently selected frame. 

Operation 

Use the Selector tool to select the graphic you wish to place on top of 
other graphics. Click on the Bring to Front option button, or press and 
hold the Ctrl key and then press A. 

Sometimes you cannot select a graphic because it is positioned behind 
another graphic. This situation can be corrected as follows: 

Figure 12-3. Line brought to front of rectangle. 

~ Click on the Selector tool button. 

~ Press and hold the Ctrl key. 

~ Position the mouse cursor over the graphic you wish to select and 
then click the mouse button until the graphic you want is selected. 

Each press of the mouse button, selects the next graphic further down 
in the stack. . 
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Line Attributes 
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The Line Attributes option allows you to change the thickness, color, 
and end style of a line drawn in Ventura Publisher or of an outline 
surrounding other graphics drawn in Ventura Publisher. Use the Line 
Attributes option to: 

• Change the thickness of graphic lines used as extra rules. 

• Create one- or two-way arrows for callouts. 

Operation 

~ Using the Selector tool, select the desired graphic. 

~ Click on the Line Attributes option button. The Line Attributes 
dialog box (Figure 12-4) is displayed. Each of the five graphic tools 
has its own dialog box. 

Figure 12-4. Line Attributes dialog box. 

Color The Color list box displays the available colors that can be applied to 
graphic lines. Colors are selected from the list by clicking on the desired 
color name. 

Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in this list box. 
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Thickness The Thickness list box displays a number of pre-defined line thick­
nesses that can be applied to graphic lines. Pre-defined line thickness 
are selected by clicking on the desired line thickness. To enter a custom 
line thickness, select the unit of measure button to display the desired 
unit of measure and then enter the desire line thickness in the Thick­
ness entry field. 

End Style The End Style option allows you to apply different line endings to the 
graphic lines. The beginning and ending of each line can have a different 
end style. Although this option is available regardless of the type of 
graphic selected, this option is applicable only to graphic lines. 

The End Style options do not necessarily correspond to the line as it is 
displayed on the screen but rather to the beginning and ending of the 
line as it was drawn. If, for example, you draw a line from the right side 
of the screen to the left, the end style for the right end of the line would 
be selected from the left column of the End Style option. This is because 
the right end of the line was the beginning of the line as it was drawn. 

Load defaultsl You can save the Line Attributes option settings for each graphic type 
Save defaults (box text, line, ellipse, rectangle, rounded rectangle) by using the Save 

Defaults option. If you select the Save Defaults button, the next 
graphic you create of the same type will have identical attributes. 

If you want to apply the saved defaults to an existing graphic of the same 
type: 

~ Select the desired graphic and select the Line Attributes option. 

~ Click on the Load Defaults button. When you click on the OK 
button, the saved defaults are automatically applied to the selected 
graphic. 

To copy attributes from one graphic to another: 

~ Select the graphic whose attributes you wish to copy and click on the 
Line Attributes option button. 

~ Click on the Save Defaults button. This makes the attributes of the 
currently selected graphic the default for that graphic type. 

~ Select the graphic whose attributes you want to change. 

~ Click on the Line Attributes option button and click on the Load 
Defaults button. The attributes just saved are copied to the selected 
graphic. 
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Fill Attributes 

The Fill Attributes option allows you to change the color and back­
ground pattern of each graphic. This option is not available for lines. 

Operation 

~ Use the Selector tool to select the desired graphic. 

~ Click on the Fill Attributes option button. The Fill Attributes dialog 
box (Figure 12-5) is displayed. Each of the graphic types has its own 
dialog box. 

Figure 12-5. Fill Attributes dialog box. 

Color The Color list box displays the available colors that can be applied to 
the fill area of a graphic. Colors are selected from the list by clicking on 
the desired color name. 

Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in this list. 

Pattern The Pattern option list box displays nine pre-defined ruling line pat­
terns. These patterns range in shading value from 0% to 100% in 12.5% 
increments. 

Transparent The Transparent option allows you to change overlapping graphics. If 
Transparent check box is not checked for the graphic on top, that 
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graphic will block completely any other graphics below it. If you check 
the Transparent check box for the graphic on top, and if its fill pattern 
is anything other than solid, then the graphics below will show through 
the graphic on top. 

Not all printers can print transparent graphics. Print the CAPABILI 
chapter (located in the TYPESET directory) to determine the 
capabilities of your printer. 

Load defaultsl You can save the fill attributes for each graphic type (box text, ellipse, 
Save defaults rectangle, rounded rectangle) by using the Save Defaults option. If you 

select the Save Defaults button for the current graphic, the next 
graphic of that type that you create will have the same attributes. 

If you want to apply any saved defaults to an existing graphic of the 
same type: 

~ Select the desired graphic. 

~ Click on the Fill Attributes option button. 

~ Click on the Load Defaults button. When you select the OK button, 
the saved defaults are automatically applied to the selected graphic. 

To copy fill attributes from one graphic to another: 

~ Select the graphic whose attributes you wish to copy. 

~ Click on the Fill Attributes option button. 

~ Click on the Save Defaults button. This makes the attributes of the 
currently selected graphic the default for that graphic type. 

~ Select the graphic whose attributes you want to change. 

~ Click on the Fill Attributes option button. 

~ Click on the Load Defaults button. The attributes just saved are 
copied to the selected graphic. 

1? _0 



GRAPHIC MENU 

Select All 

Select All 

The Select All option selects every graphic associated with the selected 
frame. Use the Select All option to: 

• Move every graphic associated with a frame to a new location relative 
to the frame. 

• Change the attributes for all graphics tied to a frame. 

Operation 

12 -10 

~ Click on the Selector tool button. 

~ Select the frame whose graphics you wish to select. 

~ Click on the Select All option button, or hold the Ctrl+ Q. 

If after choosing Select All you want to de-select individual graphics, 
follow these steps: 

~ Press and hold the Shift key. 

~ Select the graphics you do not want selected. 

To move all the graphics selected: 

~ Move the mouse cursor to the center of anyone of the selected 
graphics, then press and hold the mouse key. 

~ Wait until the mouse cursor changes to the shape of a cross with 
arrows at each end. 

~ While still pressing and holding the mouse button, move the graphics 
to a new location. 
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Grid Settings 

GRAPHIC MENU 

The Grid Settings option defines an invisible grid for the currently 
selected frame. All graphics attached to that frame will then snap to the 
grid points when drawn or moved. You can define a different grid for 
each frame on each page. 

Operation 

~ Use the Selector tool to select the frame for which you wish to define 
a grid. 

~ Click on the Grid Settings option button. The Grid Settings dialog 
box (Figure 12-6) is displayed. 

Figure 12-6. Grid Settings dialog box. 

~ Set the Grid Snap option to On. 

~ Set the horizontal and vertical spacing. 

For Vertical Spacing, you should normally enter a value equal to the 
inter-line spacing of the Body Text tag, or a sub-multiple of this space. 
For instance, if Body Text's inter-line spacing is 12.00 points, set Verti­
cal Spacing to 12.00, 6.00, 4.00, or 3.00 points. 

In general, enter the largest horizontal and vertical spacing values 
possible, which provides the resolution you need. Keeping the grid large 
allows you to easily see whether two graphics are indeed aligned with 
one another. 

The measurement of the grid begins at the upper left corner of the 
frame. If the grid settings are set for the base page, the measurement of 
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Grid Settings 

the grid begins at the upper left corner of the full page regardless of any 
margin, column, page size or layout settings. 
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...... ..-
Insert Bow ... 
Insert ~olumn ... 
Join Cells 
SUIit Cells 
Set lint... 
Set Column Width ... 

Normal Rules 
Custom Rules ... ~ 

Insert New Table ... 
Change ,Settings ... 

Figure 13-1. Table menu. 

The options in the Table menu allow you to insert and edit tables 
inserted into the text of your chapter. 

Refer to the Table tool section in Chapter 3 for a description of how to 
create and edit tables. 

The Forms section in Chapter 14 describes how to create forms using 
the Table tool. 
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Insert Row/Column 

13 -2 

These two options let you add additional rows and columns to an 
existing table. To delete rows and columns select the row or column to 
be deleted and then click on the Cut function button. 

Operation 

To add a new column or row to an existing table: 

~ Click on the Table tool button. 

~ Select the location where you want to insert the rows or columns. Any 
new row(s) will be inserted below the selected row; any new columns 
will be inserted to the right of the currently selected column. 

~ Press and hold the mouse button. 

~ Select as many rows below, or columns to the right, as you want to 
insert. 

~ Click on either the Insert Row or Insert Column option button. The 
following alert is displayed to confirm the operation. 

Click on the Insert button to insert the table column or row. Click on 
the Cancel button to cancel the operation. 

When inserting a row, the inserted row inherits the attributes of the row 
below the inserted row~ When inserting a column, the inserted column 
inherits the attributes as set in the InsertlEdit Table dialog box. 
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Join/Split Cells 
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TABLE MENU 

These options let you combine adjacent cells in the table together or, 
once joined, split them apart again. 

In most tables, some cells are larger than others such as in the example 
shown in Figure 3-16. This is useful for creating column heads that 
straddle across multiple columns. 

Operation 

You can create larger cells by selecting more than one cell and then 
clicking on the Join Cells option in the Table menu. The text in the 
upper left cell in the selected group is the text shown in the resulting 
single large cell. Text in the other cells is not immediately lost. It isjust 
hidden from view. It will be lost, however, when the chapter is saved. 

To un-join a cell select the cell and then click on the Split Cells option 
in the Table menu. 
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Set Tint 

Set Tint 

The Set Tint option lets you apply background color and pattern to 
selected cells in your table. The Define Colors option in the Para­
graph menu lets you define a color which can be applied to any cell in 
the table using the Set Tint option or to selected text in the table using 
the Text menu Set Font Attributes option. If you define a color which 
is simply a shade of gray, you can use this option to create any of 500 
different shades of gray. To define a shade of gray, select the Define 
Colors option in the Paragraph menu. Set the Color Mode option to 
CYMK, set the Cyan, Magenta and Yellow color options to 0%, then 
select the percentage of black that corresponds to the level of gray you 
desire. 

Operation 
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To apply a color (or shade of gray) to a cell in the table: 

~ Click on the Table tool button. 

~ Select the cell or cells you wish to tint. 

~ Click on the Set Tint option button. The Table Cell Tint dialog box 
(Figure 13-2) is displayed. 

Figure 13-2. Table Cell Tint dialog box. 

Color The Color list box lists the available colors that can be applied as table 
tints. A color is selected by clicking on the desired color name. 
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Custom colors and shades of gray defined in the Define Colors dialog box 
will appear in this list. 

Pattern The Pattern list box lists nine pre-defined ruling line patterns. A 
pattern option is selected by clicking on the desired pattern. The pattern 
options range in shading value from 0% to 100% in 12.5% increments. 
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Set Column Width 
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The Set Column Width option lets you precisely define the width of 
any column in the table. You can also interactively change column 
widths as described in the following section. 

Operation 

You can change the width of any column in one of two ways. The first 
way is more precise, while the second is useful when exactness is not 
required. 

• Dialog box. Select a column (you only need to select one row) and 
then click on the Set Column Width option in the Table menu. 

• Interactive. With the Table tool selected, press and hold the AIt key, 
move the mouse cursor to the middle of the column you want to 
change, press and hold the mouse button, then drag the right column 
boundary to the new location. The column width of all columns to the 
right of the adjusted column will be resized proportionately. 

If you choose to set a column width using the first method, the dialog 
box shown in Figure 13-3 is displayed. To change column widths: 

Figure 13-3. Set Table Column Width dialog box. 

> Set the Column Number option to the column for which you want 
to adjust the width. The column number for the currently selected 
column is displayed at the top of the box. You can modify any column 
number without exiting from this dialog box by selecting the arrow 
on either side of the Column Number scroll bar, or entering the 
desired column number in the Column Number entry field. This 
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changes the column number, allowing you to then change the settings 
for that column. 

~ For each column selected, choose a Width Setting option of either 
Fixed width or Variable width. A fixed width column sets the width 
you enter in the Fixed Width entry field. A variable width column 
takes a proportionate share of whatever space is left after all fixed 
width columns have been formatted. The portion of the space allo­
cated to each variable column is determined by the Variable Width 
setting. 

~ The Variable Width value is a dimensionless number which is 
compared to the other Variable Width settings for every other 
column in the table. A column with a Variable Width of 2 gets twice 
as much space as a column with a Variable Width of 1. If all columns 
are to have the same width, set them all to the same number. 

One way to set Variable Width is to set the narrowest column to a 
Variable Width value of 1 and all other columns to some integer 
multiple of this narrow column's width. Another approach is to allo­
cate a percentage of the space available to each column. For example, 
if you want a column to occupy 35% of the non-fixed space, simply 
enter 35 in the Variable Width entry field. Then enter the percent­
ages for each remaining variable width column. If you use this 
approach, make sure the widths for all Variable Width columns in 
the table add up to 100. 

~ Click on the OK button. Your column width settings take effect 
immediately. 
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Ruling Lines 

Ruling Lines 

You can change any ruling line in your table using the Normal Rules 
and Custom Rules options. To change all ruling lines in an existing 
table, use the Table menu Change Settings option instead. 

Operation 
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To change the ruling lines between cells: 

~ Click on the Table tool button. 

~ Place the mouse cursor at the beginning of the ruling line segment 
you want to change. 

~ Press and hold the mouse button. 

~ Move the mouse cursor to the end of the ruling line segment. 

~ Release the mouse button. The ruling line segment is selected and 
appears as a thick line. 

~ Select one of the Custom Rules option buttons. (The Normal Rules 
option returns the ruling line to the default ruling line specified in the 
InsertlEdit Table dialog box.) 

You can also select cells if you want to change all the rules around those 
cells. To select an entire cell, you must drag the mouse cursor from the 
upper left hand corner of the first cell to the lower right hand corner of 
the last cell while holding the mouse button. 

The ruling line definitions are stored in generated tags which are 
created when you first create the table. These tags are called Z_HID­
DEN, Z_SINGLE, Z_DOUBLE, and Z_THICK. You can change these 
tag's ruling line attributes as follows: 

~ Click on the Paragraph tool button. 

~ Select the Set Preferences option from the Edit menu. 
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~ Set the Generated Tags option to Shown. 

~ Select any paragraph and tag it with the tag whose ruling line 
attributes you wish to change, e.g., Z_SINGLE. 

~ Click on the Paragraph tool Ruling Line Above option button. 

~ Check the Show in Table Rules List check box. This will place the 
tag name in the Custom Rules dialog box. 

~ Set the ruling line options that you want. Click on the OK button. 

~ Re-tag the paragraph to its original tag. 

You can add any paragraph tag to the Table menu's Custom Rule op­
tion. Simply follow the previous eight steps. Once added, you can apply 
its ruling line definitions to any ruling line in a table. Thus you can have 
more than four ruling line definitions to choose from. 

The maximum number of ruling line overrides per table is approximate­
ly 640 if you use only the four default tag names (e.g., Z_HIDDEN, 
Z_SINGLE, Z_DOUBLE, and Z_THICK). If you use other tag names, 
the maximum depends on the length of the tag name: the longer the 
name, the fewer overrides are allowed. 
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Insert/Edit Table 

The Insert New Table option button performs the same function as the 
Table option in the Insert Special Item secondary menu. Once a table 
exists, you can edit many of its settings using the Change Settings 
option button. Both the Insert New Table and Change Settings 
options use the InsertlEdit Table dialog box (Figure 13-4). The 
remainder of this section describes the operation of this dialog box. 

Figure 13~. Insert/Edit Table dialog box. 

Operation 

Rows and When you first insert a table, this feature allows you to specify the 
Columns number of rows and columns which the table will initially contain. To 

add rows and columns to a table wp.ich already exists, use the Table 
menu Insert Rowand Insert Column option buttons. 
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When you first create the table, every cell in the table is the same width 
and height. You can change the width of any column after the table is 
created. The height of each row adjusts automatically as you add 
additional text. 



lfl:stHUI:.Ull I dUIt:: 

Header Rows 

When a table continues across page or column boundaries, you can make 
Ventura Publisher automatically repeat rows at the top of the continua­
tion of the table by entering the number of rows that make up the 
header. Note that the table is never broken in the middle ofheader rows. 

Breaks across pages 

You can keep a table from being broken across two pages. If you enable 
this feature, the table will continue across the bottom of a column or 
page, or from one frame to the next. If you disable this feature, the table 
is always placed in its entirety in one column, page, or frame. 

Rules You can place ruling lines around the entire table (Box Around), 
between each row (Horiz. Grid), and between each column (Vert. 
Grid). 

The Rules options in this dialog box set the default for the entire table. 
You can override these defaults for any line which you select. This 
procedure is described on page 13-8. 

The ruling line definitions which appear in each list box can be altered, 
and you can add new tags to the InsertJEdit Tables dialog box and 
Custom Rules option as follows: 

~ Click on the Paragraph tool button. 

~ Select any paragraph in your chapter and temporarily assign the tag 
you wish to change to this paragraph. If the tag doesn't appear in the 
Tags list, set the Generated Tags option to Shown in the Set 
Preferences option dialog box (Edit menu). 

~ Click on the Ruling Line Above option in the Paragraph menu. 

~ Define the ruling line for this tag. 

~ Before clicking on the OK button, check the Show in Table Rules 
List check box. Checking this check box makes the tag name appear 
in the InsertJEdit Table and the Custom Rules option of the Table 
menu. 

Alignment & These settings control the width of the entire table. By contrast, the 
Indent widths of the columns within the table are adjusted using the Set 

Column Width option button. 
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Alignment 

This option allows you to set the alignment of the entire table relative 
to the column or frame containing the table. This option is only available 
when the Width option Column check box is not checked. 

Indent 

This option allows you to set the indent distance of the table from the 
left side of the column or frame containing the table. This option is only 
available when the Width option Column check box is not checked. 

Width 

If the Width option Column check box is checked, then the table will 
fit into the current column width. If the table continues to another 
column, it will automatically adjust to that column's width. 

To create a table width independent of the width of the column, follow 
these steps: 

~ Ensure the Width option Column check box is not checked. This 
disables automatic column width adjustment. 

~ Select an Alignment option. The Alignment options specify where 
the table will be aligned relative to the current column. You can 
specify Left, Center, or Right. 

~ Enter a value in the Indent entry field. The Indent value lets you 
specify how far to move the table from the left edge of the column or 
frame containing the table. 

~ Enter a value in the Width entry field. The Width value lets you 
specify the overall width of the table. 

~ Click on the OK button. 

Spacing The Spacing options allow you to fine tune the spacing of the rows and 
columns of your table, as well as the spacing of the table in relation to 
other tables and paragraphs in your document. 

Space above 

This setting adds vertical space between the beginning of the table and 
the bottom of the previous paragraph. It operates in the identical 
manner to the Above option in the Paragraph tool's Spacing dialog box. 
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It's generally a good idea to add an amount equal to or greater than Body 
Text inter-line spacing. 

Space between rows 

This settings adds vertical space between each row in the table. If the 
Move Down To 1st Baseline setting in the Chapter Typography dialog 
box is set to Cap Height, then the total space between lines is the cap 
height plus the space between rows. If Inter-Line is selected in the 
Chapter Typography dialog box, then the inter-line spacing for the first 
tag in the table is added to the space between rows. 

Space between columns 

You can specify how much horizontal space to add to the left of each 
column. Use this control to keep text from touching the text in adjacent 
cells. 

Space below 

This setting adds space between the end of the table and the top of the 
following paragraph. It operates in the identical manner to the Below 
option in the Paragraph tool's Spacing dialog box. It's generally a good 
idea to add an amount equal to or greater than Body Text inter-line 
spacing. 

Vertical justification at top 

This provides the same control as vertical justification at the top of a 
paragraph. Refer to page 8-10, for more information. 

Vertical justification at bottom 

This provides the same control as vertical justification at the bottom of 
a paragraph. Refer to page 8-10, for more information. 
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PUTTING IT TOGETHER 

This chapter tells you how to combine all the features in Ventura 
Publisher to produce your documents. 

Creating typographic effects. This section shows how to combine the 
different paragraph attributes together into tags to produce both com­
mon as well as unusual typographic effects such as lead-ins, out dented 
headings, and reversed text. 

Creating text runarounds. This section shows how to manipulate 
frames so that text can be made to flow around in irregularly shaped 
picture. 

Creating continuation headers and footers. This section describes 
the various ways to use the header/footer current match feature to 
control the information displayed in the headers and footers of your 
chapter. 

Shortcuts. This section describes a number of alternate methods of 
working with the components of a document, and provides shortcuts to 
help you become more productive when using Ventura Publisher. 

14-1 
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Creating typographic effects 
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This section gives step-by-step instructions for combining several para­
graph options together to create common typographic effects. The style 
sheets in Appendix J contain other effects not explicitly covered here. 

This section describes the following effects: 

• Big first character (white on black) 

• Footnote superscripts 

• Headings (outdented) 

• Indents/Outdents 

- Lead-ins 

- Hanging indent 

- Simple indents 

• Reverse type/shaded type 

• Change bars 

Reversed big first character 

The Paragraph tool Special Effects option allows you to create a big 
first charaCter at the beginning of a paragraph. Occasionally, you may 
want to create an effect similar to the one shown in Figure 14-1, where 
white text appears inside a black l?ox. You can create this effect using a 
combination of Paragraph tool options. Once created, you can instantly 
format any paragraph in your document with this effect. 

D he Special Effects option in the Paragraph menu lets you create a 
big first character at the beginning of a paragraph. Occasionally, you 

may want to create an effect similar to the one shown in Figure 15-14, 
where white text appears inside of a black box. You can create this effect 
using a combination of options from the Paragraph menu, then format 
any paragraph in your document to display this newly-created effect. 

Figure 14-1. Reversed big character. 
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N at all printers can print white text on a black background. Print the 
CAPABILLCHP chapter located in the TYPESET directory to see 
whether your printer is capable of producing this effect. 

> Make the first letter (the one you want to make large) a separate 
paragraph. 

> Create two new tags, one for the first paragraph which consists of just 
one letter, and one for the paragraph that follows it. Both should have 
the same attributes initially. 

> Click on the Paragraph tool button, then select the paragraph that 
contains just the first character. 

All changes to the font attributes of the first big character will be made 
in the Special Effects option dialog box. Do not change any of this tags 
attributes in the Font or Spacing option dialog boxes. 

> Click on the Spacing option button and note the value in the Inter-
Line entry field. Click on the Cancel button. 

> Click on the Special Effects option button. 

> Select the Big First Character option. 

> Set the Space for Big First option to Custom. 

> Enter the number oflines you wish to create for the big first character 
in the Space for Big First entry field. 

> Click on the Set Font Properties button and select the desired 
typeface and color for the big first character. 

> Select the font size for the big first character. The optimal font size 
should be based on the following formula. 

P x L + (I x L + 2) - L = big first character font size 

where: 
P = the font size of the text following the big first character 
L = the number oflines entered in the Space for Big First entry field 
I = the inter-line spacing (in points) of the text following the big first 
character 

In the example shown in Figure 14-1, the text font size is 10 points, 
the inter-line spacing is 12 points, and the big first character is to take 
up 2 lines. The following is the equation for determining the optimal 
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font size of this big first character. 

10 x 2 + (12 x 2 + 2) - 2 = 30 

> Select the White color option from the Color list box. 

> Click on the OK button in the two dialog boxes to return to the main 
screen. 

If you deselect the paragraph, you will not be able to read the text, be­
cause the letters and background are both white. The following steps 
will create a black line over the text so that it can be read. 

> With the paragraph still selected, click on the Breaks option button. 

> Set the Line Break option to Before and then click on the OK 
button. 

> Click on the Ruling Line Above option button. 

> Select the Text option from the Width list box, and then click on the 
User-Defined button. 

> Make sure the Dimensions option is set to points. 

> Enter a Height for Rule 1 that is about 20% less than the point size 
of the big first character. 

> Enter a Space Below Rule 3 that is about 15% less than the point 
size of the big first character. Enter this value as a negative number 
so that the ruling line will be forced down over the big first character. 

The value entered in the Space Below Rule 3 entry field must be 
entered as a negative number. 

> If the big first character is the first paragraph in the column, enter 
the difference between the Space Below Rule 3 value and the 
Height of Rule 1 value in the Space Above Rule 1 entry field. 

Figure 14-2 shows the User-Defined Ruling Style dialog box for the 
example shown in Figure 14-1. 



Space Above Rule 1: 14 
~===: 

Space Above Rule 2: 10 
~===: 

Space Above Rule 3: 10 
~====: 

Space Below Rule 3: 1-1-2_4_--1 

Height of Rule 1: 120 
::=::~ 

Height of Aule 2: 10 ::=::===: 
Height of Rule 3: 10 

~===--. 
Dimensions: I points 

o vefall Height: 0 

. rQ~j . :11·. Cancel 

Figure 14-2. User-Defined Ruling Style dialog box for the first paragraph. Note 
that since the example was J2laced m a frame, and thus was at the top of a column, 
the difference between the Space Below Rule 3 value and the Height of Rule 
1 value (24 - 20 = 4) was entered in the Space Above Rule 1 entry field. 

~ Click on the OK button to exit the User-Defined Ruling Style dialog 
box, and click on the OK button to exit the Ruling Line Above dialog 
box. 

You can adjust the Height of Rule 1 and the Space Below Rule 3 
values to adjust the size of the ruling line and its placement over the big 
first character, respectively. 

You have now finished creating the tag attributes for the first para­
graph. To design tag attributes for the second paragraph: 

~ Using the Paragraph tool, select the text that will follow the reversed 
letter. 

~ Use the Add New Tag option to assign a new tag name to this 
paragraph. 

~ Click on the Alignment option button. 

~ Set the Relative Indent option to On. 

~ Enter an In/Outdent Width value of 2 or 3 points. 

~ Enter an In/Outdent Height number to indicate how many lines 
should be indented to allow for the reversed box. The number of lines 
should equal the number of lines selected for Space for Big First 
Character option in the Special Effects option dialog box. The 
Alignment option dialog box settings for this example are shown in 
Figure 14-3. 
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Tellt Rotation: l-----~""'f 
Hl!,Phenation: I-----,-r .... 

,liuccenive Hyphen$: 1---__ --1-1 
!lverall Width: I--___ ~ .. 

Eir$t Line: I--___ ~ .. 

Relative lndent: '--___ -'--' 

In/Outdent~idth: @JI] I·. inche$ . I 
In/Outdenl !:!.eight: IIJ lines 

B 
I .01(." I Cancel' 

Figure 14-3. Alignment option dialog box for the second paragraph. 

> Click on the OK button. 

> With the paragraph text still selected, click on the Breaks option 
button. 

> Set the Line Break option to Mter and then click on the OK button. 

The tags for this effect are complete. To apply the effect to a paragraph, 
simply setup the paragraph as described in the first step on page 14-3 
and apply the tags to the two paragraphs. 

Headings (outdented) 

One of the most common typographic effects is a heading or subhead 
which is outdented into the left margin. The headings which appear in 
the left margin of this Reference Guide are a good example (Figure 
14-4). Note how the text in the paragraph following these headings 
continues at the same vertical position as the first line in the heading. 

You must set all the tags in a style sheet correctly to make this effect 
work properly. Every tag, except the headings, should be set as follows: 

Paragraph option Setting 

Line Break Mter 

Equal to the left gutter 
Spacing In From Left space (this manual uses 7 

picas) 



The headings should be set as follows: 

Paragraph option Setting 

Line Break Before 

Column width minus left 
Spacing In From Right gutter (this manual uses 24 

picas) 

Indents/Outdents 

In From Right space for first paragraph. I 
1-' -----------------. 

Heading Note how this first line is placed on the same line as the first line of the 
for a heading which precedes it. Also note how the text for this paragraph is 

paragraph moved in from the left margin. This is not done by setting multiple 
columns in the Frame menu. Instead, create a blank left margin by 

I .... ------·1 setting the In From Left space for this paragraph. 
In From Left 

space for 
second 

paragraph. 

Figure 14-4. Outdented heading. Set Line Break: Before for heading, Line 
Break: After for paragraph which follows. 

The following sections describe common types of indents and outdents, 
along with the typical Paragraph settings needed to achieve these 
effects. The indents and outdents described include: 

• Lead-ins 

• Hanging indents 

• Simple indents 

Lead-in A lead-in is the first text in a paragraph. This text is often printed in a 
font that is different from that of the remaining text. 

The simplest way to create an occasional bold or italic lead-in is to select 
the lead-in text using the Text tool and assign one of attributes from the 
Text menu. However, if you use lead-ins frequently, you will find it 
easier to design a paragraph tag which creates the lead-in automat­
ically. If you use this method, the lead-in text is actually a separate 
paragraph from the text which follows, even though both appear to 
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constitute part of the same paragraph. The following steps show you 
how to design a lead-in. 

This is a lead-in paragraph. This is a separate paragraph from the 
lead-in. This paragraph has Relative Indent: On, Indent 5 points (both 
are in the Alignment option), and Line Break: After (Breaks option). The 
lead-in has Line Break Before, Keep With Next: Yes, and Allow Within: 
No. 

Figure 14-5. Lead-in example. Note that the lead-in is a separate paragraph. 

~ Click on the Paragraph tool button. 

~ Select the lead-in paragraph. (If necessary, click on the Text tool and 
make the lead-in a separate paragraph by placing the text cursor 
immediately after the lead-in and then pressing the Enter key.) 

~ Click on the Add New Tag option button and create a new tag name 
for the lead-in. 

~ Using the Paragraph option buttons change the lead-in attributes as 
follows 

- Set the Font Settings dialog box Face and Style options to Bold 
Italic (or other attribute which will highlight the lead-in). 

- Set the Breaks dialog box Line Break option to Before. 

- Set the Breaks dialog box Keep With Next option to Yes. 

~ Select the paragraph which follows the lead-in. 

~ Click on the Add New Tag option button and create a new tag name 
for the paragraph which follows the lead-in. 

~ Change this second paragraph's attributes to: 

Paragraph option Setting 

Alignment Relative Indent: On 

Breaks Line Break Mter, Beside Last 
Line of Prevo 

This effect will work correctly with justified text only if the lead-in is less 
than the width of one line. 
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Hanging indent The hanging indent shown in Figure 14-6 is identical to an outdented 
heading. Follow the procedures given in the previous section. 

To create this effect easily, assign both the outdented head, as well as 
the paragraph which follows, to function keys. Then, while typing using 
the Text tool, simply press the function key to make the text move into 
or away from the margin. 

Page 3 This is another example of a hanging indent. The words Page 3 are 
actually a separate paragraph. Refer to the previous section (Headings 
(Outdented) for a description of how to create this effect. This outdent 
has Horizontal Alignment set Right. 

This is an example of a hanging indent. In the Alignment 
option select First line: Indent, and In/Outdent Width: 4 picas (or 
whatever the first line indent should be). . 

This is an example of a hanging outdent. Select First Line: Outdent, and In/Outdent 
Width: 4 picas (or whatever the first line outdent should be). 

Figure 14-6. Hanging outdents and indents. 

Simple indents Create simple indents and outdents of the type shown in Figure 14-6 by 
and outdents using the In/Outdent Width markers on the tab bar. Refer to page 3-56 

for more information on using the tab bar. 

Reverse type 

Reverse type means that white letters are printed on a black back­
ground. 

Some printers are not capable of printing white text. Printing the 
CAPABILI.CHP will allow you to determine if your printer is capable of 
printing white text. 

To reverse all text on the page or frame: 

~ Click on the Selector tool button and select the page or frame. 

~ Click on the Frame Background option button. 
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~ Select the Black color option from the Color list box 

The text in this frame is automatically reversed by changing frame 
I background color to black. 

14-10 

Figure 14-7. Reverse type. Your printer must be able to print white text. 

You can also create a single line of white text inside a black ruling line, 
by creating a paragraph tag which has a ruling line shifted down over 
the paragraph. Follow these steps: 

Chapter! 

The Adventure Begins 

T;~lt:fn~~:fl~~:~~~tten~~~r~:~~arR:~~p~es~t:~~~31~ 
Luke's Medic~ Center holds: every year. The prize W~ two I()'Und 
ttip ,ick.~ ., Hang Kong on Uni,.d Airlin •• , and ,.n nigh" in ,he 
Hong Kong Hy.tt HOle!. Analyzing our good fortune, we concluded 
that we wanted to do more th;m. spend len days in Hong Kong and 
remrn, but at the Slime time, United. having just gotten its routes and 
equi~enl from P!ID American. h:rl. not yet received authority to fly 
to otherdestinatian.s: ell' between points in the Far E ast. 

Figure 14-8. Reverse text within a ruling line. 

~ Click on the Text tool and type the text you want to appear as reversed 
text. 

~ Click on the Paragraph tool button and select the paragraph. 

~ Create a new tag called, for example, White Text. 

~ Set the size, alignment, and other tag attributes as desired. 

~ Click on the Font Settings option button. Select the White color 
option from the Color list box, and the solid (bottom) Pattern list box 
option, and then click on the OK button. 
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If you deselect the paragraph at this point, you will not be able to read 
the text, because the letters and background are both white. The follow­
ing steps will create a black line over the text so that it can be read. 

> Click on the Ruling Line Above option button. Select the desired 
options from the Width and Color list boxes. Select the solid (bottom) 
option from the Pattern list box. 

> Click on the User-Defined button. Click on the Dimensions button 
until the points unit of measure is displayed. Since the values you 
will enter in this dialog box are based on the size of the tag font, 
setting the unit of measure to points will ensure that the correct 
values are entered. 

> In the Heig~t of Rule 1 entry field, enter a value that is larger than 
the point size of the tag. For example, enter 36 if the size of the fonts 
used is 24 point type, or 24 for 18 point type. 

The display area in the dialog box will not display lines higher than 36 
points correctly, although you can still create them. 

> In the Space Below Rule 3 entry field, enter a value corresponding 
to the distance required to move the ruling line down over the text. 
This value is calculated by adding the font size in points with the 
ruling line size in points, then dividing the sum by -2. For example, if 
you want to place 24 point white type within a 36 point ruling line, 
the equation would be: 

24 + 36 = -30 
-2 

The number entered in the Space Below Rule 3 entry field must be a 
negative number in order for the ruling line to shift downward over the 
text. 

> Click on the OK button in both the User-Defined Rule Style and the 
Ruling Line Above dialog boxes. 

Experiment with different Space Below Rule 3 amounts to place the 
text at different vertical positions within the rule. 

Shaded type You can also place text within backgrounds which are not completely 
black. Simply use one of the other patterns options for the frame 
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background or ruling line. Change the text color from white to black, if 
the pattern is an extremely light one. 

Change bars 

A change bar alerts the reader that the contents of a paragraph have 
changed. You can also use a change bar as a custom vertical rule to 
highlight headlines in newspapers, newsletters, or magazines. Design a 
change bar as follows: 

~ Click on the Paragraph tool britton and select a paragraph that is to 
have a change bar. 

~ Click on the Add New Tag optIon button. Select the Body Text tag 
name from the Copy From list box and enter a name for the new tag 
in the Name To Add entry field. Click on the OK button. 

~ Click on the Ruling Box Around option button. 

~ Select the Custom option from the Width list box. 

~ Click on the Dimensions button until points is displayed. 

~ Enter a value of 1 point in the Custom Width entry field. 

~ Click on the User-Defined button and enter a Height of Rule 1 of 
less than 2 points. Click on the OK button. 

~ Add a small (e.g., 1 pica) negative Custom Indent: value. 

Because change bars are created with a ruling box around, and because 
ruling boxes do not continue across column or page boundaries, change 
bars will not continue to the top of the next column or page. 
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Creating text runarounds 

Normally, text that is already on a page flows around a newly created 
frame. However, text can be made to flow behind a selected frame by 
setting the Text Flow Around option to Off in the Sizing & Scaling 
option dialog box (Frame menu.) You can use this feature to make text 
follow the outline of an irregular object (a runaround) as follows: 

> Use the Add Frame tool to create a frame. 

> With this frame selected, click on the Sizing & Scaling option 
button. 

> Set the Text Flow Around option to Off and click on the OK button. 

> Place a picture in the frame. You should now have an image which 
overlaps text, as shown in Figure 14-9. 

C bapll!r1 
The Advtnt.", Begins 
This trip ",.illy began in Sepll!mberlast yoarwhen 

Geaywonfilst ~in uafflt M tb.fashion show 
wbieh Rust>-Prosbyll!rian-S t. L,\.'s Medico.! Cel>­
Il!r hold; every year. The ~ was two ro u nd trip 
tickets ro Hong Kong on Unill!d Aidines,. and ten 
nights in the HongKong HyattHoll!l.Ano.!yzingour 
good lbrtune, we concluded thet we wanll!d to do 
too'" than spend Il!n days in Hong Kongand 
butat the sam. time. Unill!c\. h~vingjust go 
lOUtes and equipment flOm ra".",,,, •. u,.<,,~~ 
yot",ceivedautharity to fly roc 
between paints in the F ... East. 
On Februery 10th, United aeq' 

and on Fe bru ery 11th Debbia be~~~rur 
rog.ther. W. left on MatCh on 
M=h 26th. We entend sevtn'countrus, uave1ed 
over 25,000 nniles on lOur air1i;""'."mede,ovt' ,500 
KodachromeI!' slides, almost 200 Kodacolof' 
prints,. and 5112 hoursofcolorand soundvideo~pe. 
C bieago ro Tokyo 
11:03 PM. Chicago time. 39,000 feet so mew hen 

81% r;s § []l] .. 

cultivated grou nd. Tiny houses,. acldeven sm.ill foe­
tori.es. Evotything s .. med miniatu ... 
At 4:25 P.M." the sun was £llrly high in tho sky, 

bndu. !Owh4tllP~ued ro be Stoog visibility was 
• probably not moll! tan 5 miles. Quarantine and 

proved no problem, but immigration was 
much atll!~tion ro detdil. Our 5:15 P.M. 

i rather large bus deparll!d 
us on our hour and fifuen 

inro th.cenll!rof the city 
Much of the su per highway 
noise abating w.ills. Tr.rfic 
50 miles an ho ur and we 

no sp .. din::. The new Imperio.! HOIl!I is 
every bitas good as its"'pu ~tion-somewhat more 
elegant than tho Ritz. Carlron. Our room in the new 
_er looks e"""Uy hka the pictu", in the tmnl 
lb1ders. It's not exc.ption.illy large. It bas a bay 

... window,ovtrlook:i,~he Gin"" with the ccean in the 
baekgrou nc\. vtry nice furni ture, and a w.ll-lIP­
poinll!d onyx and plastic bathroom. 

"Extras" abourd: Toothbrushes, ll!aye1oth bath­
lObes,. kimonos, slippers. coff •• moking .quipmen~ 

Figure 14-9. Flow text around turned off. 

> Click on the Add Frame tool and draw frames over each portion of the 
picture that you want to be free of text. To keep the Add Frame tool 
selected, hold down either Shift key while placing these frames. See 
Figures 14-10 and 14-11. 
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.Eile .Edit Y:iew !;.hapter Frame 

Chapter! us IlI\ opportunity to soo many small patchos of 
Tbo Advootu~ Bogins cultivatodgmu rd. Tiny bou .... IlI\d ,von.mall £ac-
Tbis trip ~.ny began in SeptemberlastYOaIwbon . . s .. mod micoiatu",. 

~~;~~~~=:~_r~~:::::~':--~~;~~~!;tu~nd' wtoas be~!~~~~~;~ 
ter ooids overy y ..... Tho . than 5 milos. QUaIantino 
ticlcots to Hong Kong on no problom. but immi-
cig~tsin the: Hong Kong with much at~nti.on to 

good furtuno_ wo 15 P.M. limousine-~-
more than spord ten bor laIg. bus dOPaItod 
.D:!turC\ bu t a.t the same arC! carried us on our 
just gotten its lOute.andeq . fifteon minute, 6S 
Pan Arnorican. bad oot yot into tbo contor of tbo 
utbority to fly to otbor Much of tho .u por 
tion. or b,tweon points' nod by ooiso abating 
FaI EastOn Fobruary at abou t 50 mil .. an 
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+ 
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Figure 14-10. Multiple frames added to create runaround . 
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Creating continuation headers and footers 

The following section shows how to create continuation headers in 
Ventura Publisher using the current match feature in the Headers and 
Footers dialog box. 

The current match feature allows more flexibility in controlling the 
information placed in the header or footer. Unlike the First Match and 
Last Match options in the Headers and Footers dialog box, the current 
match feature allows you to specify that the text associated with a 
particular tag appear in the header offooter, even if the text appears on 
a previous page. This feature also allows you to specify additional text 
to appear in the header or footer if the text associated with the tag 
appears on a previous page. For example, the "Copy to Facing Page" 
heading on the previous page could appear as "Copy to Facing Page 
(Continued)" in the header or footer of this page. It is also possible to 
make text associated with a tag not appear in the header or footer if the 
text appears at the top of a page. The three general uses for this feature 
are described in this section. 

An overview of the current match feature 

The current match feature allows you to create continuation headers 
and footers. An understanding of its use is important. If you understand 
how it works you can create your own custom continuation headings. 

To use the current match feature, type the following in the Left, Right, 
or Center fields of the Headers & Footers dialog box. 

["tag namel,tag name2] 

You must type a caret (Shift+6) before the first tag name and must 
separate the two tag names with a comma. Do not use spaces before or 
after the comma. The whole must be enclosed by brackets. 

If the first paragraph on a page uses the tag specified by tag namel, that 
paragraph's text is printed as part of the header or footer. Otherwise the 
text of the last occurrence of tag name2 is printed as part of the header 
or footer. 
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A simple continuation header or footer 

Simplest and easiest to use continuation header or footer. General 
purpose for instances where topics span many pages. There are many 
instances when you want the header or footer on a page to accurately 
reflect the topic of the text that is at the top of the page. By contrast, 
first match and last match print the text of a topic introduced on the 
current page, regardless of whether the text at the top of the page is a 
continuation of a previous topic. The following is a simple example of 
how to create continuation headers or footers. 

~ Type the same tag name for tag name 1 and for tag name2 in the Left, 
Right, or Center fields of the Headers & Footers dialog box. Use 
the format of ["tag namel,tag name2]. 

If the page begins with the tag, the text of that paragraph is printed in 
the header or footer. If the page doesn't begin with that tag, the text of 
the last occurrence of that tag is printed in the header or footer. 

You might use this when you want a header or footer to indicate that 
text at the top of the page belongs to a topic heading that started earlier 
in the chapter. Only when a new topic starts at the top of the page will 
the header or footer contain text from a topic paragraph on the current 
page. 

A true continuation header or footer 

Easy to use continuation header or footer. Use this when you want the 
continuation header text to be different from the topic text. For example, 
you might want the word "continued" appended to the topic in the 
header or footer on subsequent pages after the first occurrence of the 
topic. 

A better example of how to use this feature is to create two tags for each 
topic paragraph. The first contains the actual text of the topic para­
graph, while the second contains the continuation text for headers and 
footers. 

You might use this if you want one header or footer string for topics that 
start at the top of a page and another header or footer string for topics 
that are continuations from another page. For this example, two 
separate topic headings are used for each topic. The first is for the topic 
itself. The second is for the continuation text. 
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~ Create two paragraph tags. The following are sample paragraphs and 
tags. 

@Heading = Ventura Publisher 
@HeadingCont = Ventura Publisher (Cont.) 

~ Type the two different tag names for tag namel and tag name2 in the 
Left, Right, or Center fields of the Headers & Footers dialog box. 
Use the format of ["tag namel,tag name2]. In this example, type 
[ "Heading,HeadingCont]. 

~ Set Keep With Next in the Breaks dialog box of the Paragraph 
menu to Yes for both of these tags. It is important that these para­
graphs always stay together. 

~ Set Line Break in the Breaks dialog box to No for the HeadingCont 
tag. This tag is created solely for use with the header or footer so it 
shouldn't take up any space. 

~ Set Color to White in the Font Settings dialog box of the Para­
graph menu for the HeadingCont tag. The color is set to white so it 
doesn't print on the page. 

If the Heading tag appears at the top of the page, the topic heading 
''Ventura Publisher" prints as the first paragraph on the page and are 
contained in the header or footer. On subsequent pages, until another 
HeadinglHeadingCont pair appears, the words "Ventura Publisher 
(Cont.)" print in the header or footer. 

If the Heading tag does not appear at the top of the page, the topic 
heading ''Ventura Publisher" prints somewhere after the first paragraph 
but is not contained in the header or footer. On subsequent pages, until 
another Headi~glHeadingCont pair appears, the words ''Ventura Pub­
lisher (Cont.)" print in the header or footer. 

Speci~1 continuation headers and footers 

A more complex use of continuation headers or footers. Use this when 
you want the continuation text to be different from the topic text and 
when you don't want the topic text to print in the header when it occurs 
at the top of a page. For example, you might want the word "continued" 
appended to the topic in the header or footer on subsequent pages after 
the first occurrence of the topic. In addition, you might not want the 
header or footer to print if the topic occurs at the top of a page. 
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This is useful if the topic paragraph and the header are of roughly equal 
size, for example. The following example creates three tags that print a 
topic heading, a continuation header or footer, and a blank header or 
footer when the topic appears at the top of the page. 

> Create two paragraph tags. The following are sample paragraphs and 
tags. Heading doesn't have any text. So if it appears at the top of a 
page the header or footer doesn't contain any text. 

@Heading= 
@HeadingCont = Ventura Publisher (Cont.) 

> Type the two different tag names for tag namel and tag name2 in the 
Left, Right, or Center fields of the Headers & Footers dialog box. 
Use the format of ["tag namel,tag name2]. In this example, type 
[ "Heading ,HeadingCont]. 

> Set Keep With Next in the Breaks dialog box of the Paragraph 
menu to Yes for both of these paragraphs. It is important that these 
paragraphs always stay together. 

> Set Line Break in the Breaks dialog box to No for the HeadingCont 
tag. This tag is created solely for use with the header or footer so it 
shouldn't take up any space. 

> Set Color to White in the Font Settings dialog box of the Para­
graph menu for the HeadingCont tag. It shouldn't print on the page 
so the color is set to white. 

> Create a third tag that is the real topic heading and that will print 
every time it is encountered. Note that neither one of the above tags 
(Heading and HeadingCont) ever print on the page. They are strictly 
used for the headers and footers. The following are the set of tags for 
this example. 

@Heading= 
@HeadingCont = Ventura Publisher (Cont.) 
@RealHeading = Ventura Publisher 

> Set Keep With Next in the Breaks dialog box of the Paragraph 
menu to Yes for all of these tags. It is important to keep all these 
paragraphs together. . 

The above set of tags result in the topic text being printed every time 
the topic changes and a continuation header being printed on every page 
except when a new topic starts at the top of a page. 
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Tips for working with tags and continuation headers or footers 

In the previous examples, some of the tags use no line break and use a 
color of white. These features make the paragraphs invisible on the page 
and hide them behind other paragraphs. This may make writing or 
editing the text difficult. If you observe some of the following tips, 
however, your task is much easier. 

• When adding one of these paragraphs, first write the text using the 
body text tag (or any other visible, easy to use tag) and then tag the 
paragraph with the no line break/white color tag. This makes text 
entry easy. 

• If you need to edit one of the paragraphs, consider using Search and 
Replace. While the text is invisible to you, Search and Replace can 
find and change it easily. 

• If you need to edit a specific paragraph, try using the cursor keys to 
move the cursor to the same line as the hidden tag. You can tell when 
the cursor is on the right line because the tag name appears in the 
tag list. Change the tag to Body Text. Edit the text and retag the 
paragraph. 

• If you need to edit many of the paragraphs, you can change the Color 
to Black in the Font Settings dialog box of the Paragraph menu 
and set Line Break in the Breaks dialog box to Yes. This lets you 
see the text so you may edit it. Remember that you are adding line 
breaks by doing this. If the text you are editing is in the middle of a 
long chapter, it may get pushed many pages from its original position. 
When you are done editing the text, remember to set the color back 
to white and set the line break back to no. 

• The Spell Check works with the hidden text, so any misspellings in 
the paragraphs, even though the text is invisible to you, will be 
caught and may be changed using the Spell Check. 
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Select frame/graphic underneath 

When you place one frame entirely under one or more frames or graphic, 
yo·u cannot select the frame or graphic on the bottom in the normal way. 
To correct this problem, press and hold the Ctrl key while you select. In 
this way, you can select each frame or graphic in succession, starting 
with the currently selected frame. 

Precise frame size and placement 

You can be place, size, and crop frames precisely using the Frame tool 
Sizing & Scaling option button. On the other hand, the mouse provides 
a much faster way to accomplish these functions. 

A good way to take advantage of both features is to enable the Show 
Rulers option in the View menu and then use the mouse to create and 
place the frame as closely as your eye and the resolution of the screen 
allows. Then select the frame and use the Sizing & Scaling option to 
make minor, but exact, adjustments to the frame's placement and size. 

Multiple frame/graphic selection 

You can select several frames (or graphics) at the same time, then move, 
cut, copy, paste, or resize them as a group. To select several frames or 
graphics, make sure the Selector tool is enabled. Press and hold either 
Shift key on the keyboard as you select each frame or graphic. Finally, 
release the Shift key, then move, cut, copy or paste the group of 
frames. 

To de-select one of a group of selected frames or graphics, hold down 
either Shift key and select that frame. 

Selecting any frame or graphic without pressing the Shift key de-selects 
all other frames or graphics. 
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Display without selection borders 

When you are using any tool other than Paragraph, a light textured 
border is displayed around each picture. This border illustrates the 
placement of the frame and will not be printed. Click on the Paragraph 
tool to display the frames without these selection borders. To add 
borders that will print, use the Ruling Lines options as described in 
the Frame menu chapter. 

Copy-fitting 

Copy-fitting is the process of making the copy (text) fit a given space. 
Ventura Publisher provides several copy-fitting tools that you can use 
individually or together to solve copy-fitting problems. A description of 
these tools and their application follows: 

1) Text Editing. The traditional way, and still the best, to get copy to 
fit a given space is to add and delete text. Ventura Publisher's Text tool 
gives you a word processor that not only allows you to add and delete 
text, but also allows you to see instantaneously how the page will look 
when it is printed. 

2) Frame Size. If a frame has been placed on the page, its size can be 
increased or decreased. As its size is changed, more or less text is placed 
in the page and text is "pushed" or "pulled" from the next column or page 
as needed. If the Line Snap option is enabled in the View menu, you 
can easily control the number oflines of text in the page that are pushed 
or pulled to and from the next column or page. 

A variation on this technique is to add an empty frame, with both 
Column Snap and Line Snap enabled. Make the frame exactly one or 
two lines high and equal to the width of either the column or the page, 
as necessary. This method is equivalent to the old practice of adding a 
one line block of lead, when type was set in lead. 

When using this technique, remember that the Widows and Orphans 
control and Keep With Next settings (in the Breaks option of the 
Paragraph menu) may cause several lines of text and any associated 
heading to move to the next column or page. If this happens, use one of 
the other copy-fitting techniques instead. 
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3) Change tracking. You can change the space between every letter 
within a selected text block, thus increasing or decreasing the space it 
occupies. This method is not approved by most designers, but it works 
and is easy to use. 

~ Click on the Text tool button and then select all the text which you 
wish to fit in a column. 

~ Hold either Shift key. 

~ Press the right arrow to add small amounts of space between each 
letter. Press the left arrow to decrease the amount of space between 
each letter. 

~ Continue pressing the appropriate arrow until the text fits the space. 

4) Vertical Justification. The vertical justification feature automat­
ically assures that text reaches the bottom of a page or column. 

Page break 

With many word processors, you can create a new page at any point in 
the text. Ventura Publisher allows you to do this using Paragraph tool 
Breaks. However, you may want to create a page break during editing 
process. This is easy to do: 

~ Using the Text tool, create an empty paragraph. 

~ Click on the Paragraph tool button. 

~ Select the blank paragraph and click on the Add New Tag option 
button. 

~ Select the Body Text tag name from the Copy From list box and 
enter a name for the new tag in the Name To Add entry field. Click 
on the OK button. 

~ Click on the Breaks option button. Set the Page Break option to 
Mter. -

~ Use the Assign Function Keys option in the Update Tag List 
option dialog box (Paragraph menu) to assign this tag to a special 
function key. 

To create a page break, press this function key while editing a Body Text 
paragraph. Text following the paragraph in which you are editing is 
then pushed to the next page or frame. 
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Force justification 

If the last line of a paragraph consists of nothing but a short word, you 
may want to force the last word from the previous line to go to this last 
line. One way to do this is use the line break feature (Ctrl + Enter). 
However, if the text is justified, this will result in a short line, which is 
incorrect. Another, better approach is to use Ventura Publisher's inter­
active tracking feature. Follow these steps: 

> Click on the Text tool button. 

> Select the next to last line in the paragraph, starting at the beginning 
of the first word in the line, and ending immediately in front of the 
last word on the line. 

> Press and hold either Shift key. 

> Press the right arrow key several times until the last word on the line 
jumps to the beginning of the next line. 

By adding space between every letter and every space in the line, you 
have produced a justified line. 
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Installation notes 

Memory adjustments 

APPENDIX A 
INSTALLATION SUPPLEMENT 

The Ventura Publisher program consumes about 400 kilobytes of 
memory. In addition, it normally allocates 144 kilobytes of memory to 
hold paragraph and text information and 128 kilobytes of memory for 
frames and tags. 

If you are experiencing slow screen refresh or typematic rate, or you are 
receiving Out of Frame Memory or Out of Text Memory alerts, these 
memory allocations can be increased as follows: 

>- Select the About Ventura Publisher option in the Ventura Publish­
er Help menu. 

>- For both memory types, enter the memory you wish to allocate in the 
Requested entry field. 

>- You must quit and restart Ventura Publisher in order for these new 
memory allocations to take effect. These settings are stored in the 
VPWIN.INF file. If you should have to delete the VPWIN.INF for any 
reason, these setting will need to be readjusted after starting Ventura 
Publisher again. 

~ Do not allocate more than the amount of real memory in your system. 

Installation parameters 

Each time you run Ventura Publisher, the following items are retrieved 
from a file called VPWIN.INF so that you can resume with Ventura 
Publisher in the same state as when you last used the program: 
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• The unit of measurement (e.g., inches, centimeters, etc.) used in each 
dialog box. 

• View menu settings 

• Toolbox (Table, Text, etc.) settings 

• The most recent style sheet used 

When you install Ventura Publisher, the installation program asks you 
where you want to save preferences. The answer you provide to this 
question determines where the VPWIN.INF file is located. If you wish 
to later change the location of this file, you can use the Windows 
Program Manager to alter the setup parameters for Ventura Publish­
er as follows: 

~ Open the Windows Applications window and click once on the Ven­
tura Publisher icon. 

~ Select the Program Manager File menu. 

~ Select the Properties option from the File menu. 

~ In the Command Line entry field, change the /I switch to point to a 
new directory. 

For example, if you changed the Command line to read: 

C: \ VENTURA \ VPWIN.EXE II=C: \MYPREF 

the VPWIN.INF file would be stored in the C: \ MYPREF directory. If you 
don't specify a/I switch, the VPWIN.INF file is stored in the VENTURA 
directory. 
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Network shared file management 

Most networks allow each workstation to use different drive desig­
nations for the same physical sectors on the file server. This means that 
one user may access the G drive while another user accesses the same 
file from the F drive. This drive mapping is controlled through each 
user's logon script. 

The Network Administrator must ensure that each workstation on the 
network uses the same drive letter to access the same files. If consisten­
cy is not maintained, then some users will not be able to successfully 
open a chapter. This is due to the fact that each chapter refers to specific 
drive and path names. As an example of the problem, if all the files are 
saved by the one user on drive F, then if the logon script for another 
makes those same files appear to be on drive G, Ventura Publisher will 
be unable to find these files because the F drive does not exist. 

Another file management issue which is more obvious also requires help 
from the network administrator. Users can create chapters which use 
files stored anywhere on the network system, including each user's local 
workstation. If a chapter refers to files on a user's local workstation, 
then another user who tries to open this chapter will not be able to 
access these files. Thus, the Network Administrator should notify all 
users that any chapter saved on the network server should only refer to 
files saved on the server. If a user is in doubt as to whether the chapter 
refers to files on their local workstation, they can follow these steps: 

~ .Select the Manage Publication option in the File menu. 

~ Use the Add Chapter option to add the chapter you wish to examine. 

~ Select the chapter name in the Multi-Chapter dialog box. 

~ Select the Open button. 

All the files contained in the chapter, including drive and path names, 
are displayed. Select Close when you are finished examining the con­
tents of the chapter. 

If a user cannot access a file in a chapter or does not have rights to a 
drive or path on which one or more files are contained, the owner of the 
chapter file must use the Manage Publication option (File menu) to 
place a copy of the chapter, and all files contained in the chapter, in a 
globally accessible directory on the file server. 
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Import file extensions 

The following table lists the default file name extensions shown in the 
Load TextlPicture dialog box. 

TextlPicture Option Extension 
ASCII TXT 

Auto CAD SLD 

CGM CGM 

DCA RFT 

DCS MAS 

GEM Line Art GEM 

GEM Image IMG 

HPGL HPG 

Lotus 1-2-3 PIC 

Macintosh Paint PNT 

Macintosh PICT PCT 

MS Word, Word for Windows DOC 

Multimate DOC 

PC Paintbrush PCX 

PostScript Encapsulated EPS 

PRN to Table PRN 

TIFF files TIF 

Video Show files PIC 

Windows metafile WMF 

Wordperfect (4.2 and 5.0) WP 

WordStar WS 

Xywrite TXT 
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Publication/Chapter data file extensions 

The following table lists the Ventura Publisher file name extensions 
applied to components of a chapter. 

Ventura Publisher Extension 
Document File 

Captions CAP 

Chapters CHP 

Chapter information CIF 

Frame tags file FRM 

Generated text GEN 

Graphics VGR 

HPGL converter settings PRF 

OLE object file vpo 
Publications PUB 

Style sheets STY 

Width tables WID 

If you can't find a file name, check to make sure that you are looking in 
the correct directory, on the proper disk drive, or are using a file filter 
that matches the type of file you are retrieving (e.g., CHP or STY files.) 

Program file extensions 

The following table lists the program file name extensions found in the 
VENTURA directory. If you don't need to translate from certain file 
formats, you can delete the appropriate BFF and WLD files in order to 
save disk space. For instance, if you delete the file WCGM.WLD, the 
CGM option will be removed from the Load TextlPicture dialog box. 

Program File Extension 
File translation filters BFF, WLD 

Translation information files CNF 

Hyphenation dictionaries HY* , DIC 

Personal spelling dictionary PD 

DAT, DLL, DSK, EXE, 
Program files FaN, HLP, MEN, MSG, 

RAM, SRN, STR, INI 

Session configuration files INF 
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Program 'File Extension 
Temporary files EMS, MEM 

Font mapping files UP, WFT 

Screening data file PPT 

Network serial number file SER 

CMYKPROC.TXT, 
Color index files CMYKSPOT.TXT, 

RGBPROC.TXT, RGBSPOT.TXT 
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Chapter Information File (CIF file) 

Ventura Publisher creates a Chapter Information File (CIF) whenever 
a chapter is saved. This file shows: 

• The time the chapter was first created 

• The date the chapter was first created 

• The time the chapter was last printed as a publication using the 
Manage Publication print 

• The date the chapter was last printed as a publication using the 
Manage Publication print 

• The time the chapter was last archived 

• The date the chapter was last archived 

• The time any portion of the chapter was last printed as a chapter 
using the Print option in the File menu 

• The date any portion of the chapter was last printed as a chapter 
using the Print option in the File menu 

The CIF file is designed to be used by other programs to provide 
document management facilities. Other programs can add any informa­
tion desired to these files as long as the format described below is 
followed. Multiple programs may contribute to the CIF file. Ventura 
Publisher will copy the resulting CIF file whenever a chapter is copied 
using the Copy All option in the Manage Publication option dialog 
box. 

The information which follows is provided for programmers who want 
to use this file to created their own document management software. 

Record header 

The Ventura Publisher CIF file format consists of a linked series of 
records. The first record is reserved for Ventura Publisher and is 128 
bytes in length. Other records may be added and maintained by other 
programs that need to save their own data within the CIF file. 
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The elF file has no header, e.g., it begins immediately with the first 
record. Each record begins with a record header consisting of the follow­
ing: 

• Offset 0-3. Long (32 bit) pointer to the next record in the file. This 
field contains the byte offset from the top of the file of the next record. 
A null value must be placed in the last record in the file and this field 
must contain zero (indicates end of file). Existing applications differ 
in the manner used to encode offsets in the pointer field. Refer to 
Record Pointer Encoding below. 

• Offset 4-5. Word containing a vendor code assigned by Ventura 
Software. If you are writing a program for noncommercial use, use 
decimal 102. Some older programs which create elF files may place 
a null in this field. 

• Offset 6-7. This word is used (optionally) by the program that you 
write to distinguish between different types of records your applica­
tion creates. 

The record header is followed by the data. The initial record created by 
Ventura Publisher is filled with Os from offset 8 through 128 (decimal). 
The record you create can be any length as long as you place a record 
with a 00 00 00 00 pointer in offset 0 as the last record in the file to 
indicate end of file. 

You must modify the elF file in such a way that records created by other 
programs and, by Ventura Publisher itself, are preserved. This means 
that you must maintain the pointer chain. 

Format of record #1 

The first record in the elF file is created and maintained by Ventura 
Publisher itself. As mentioned before, this record contains the date and 
time of the document's initial create, last archive, and last Manage 
Publication print. All dates and times are stored in DOS format. These 
dates and times begin following the record header (offset 8) and appear 
in the following order: 

Offset 
08 
10 
12 
14 
16 

· Value 
· Initial creation time 
· Initial creation date 
· Last publication print time 
· Last publication print date 
· Last archive time. 
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18 
20 
22 

Place Os through offset 128. 

Last archive date 
Last chapter print time 
Last chapter print date 

During a Copy All operation, the archive date is updated for the source 
and destination elF file. The format of the records you create can be 
anything, as long as the record pointer chain is maintained. 

Record pointer encoding 

The length of the first record created by Ventura Publisher is 128 (80 
Hex). If your application is going to add another record to the elF file, 
then your application must point to the location for the first additional 
record (e.g., 80 Hex). To do this, you should encode the record pointer at 
the beginning of the header with the low word first followed by the high 
word as follows: 

80 00 00 00 

Some applications which used the elF file before these specifications 
were published reversed the sense of the high and low words as follows: 

00 00 80 00 

If the elF file has been modified by a program other than Ventura 
Publisher, this other method may have been used. If so, it is the 
programmer's responsibility to maintain compatibility with these older 
programs by using this method instead. Therefore, your program should 
read the first word of the file. If it is non-zero, use the standard low 
wordlhigh word convention. If the first word is zero, and the second word 
is non-zero, however, your program must use the high/low convention 
for this elF file instead. 
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APPENDIX B 
HYPHENATION 

Ventura Publisher automatically hyphenates text whenever Hyphena­
tion (see the Paragraph menu Alignment option) is turned on. The 
placement of hyphens within a word is determined by a combination of 
the resident Houghton-Mifflin dictionary, plus a small exception diction­
ary contained in the file HYFHUSER.DIC. If you want to always add 
additional hyphens within a word, or always suppress hyphenation for 
certain words, you need to edit the exception dictionary. (To override or 
suppress hyphenation for just one word, use a discretionary hyphen 
instead.) 

Add words to hyphenation dictionary 

To add words to the dictionary, modify the HYPHUSER.DIC file (located 
in the VENTURA directory) using your word processor. Read this file 
into your word processor as an ASCII text file. Add the words with the 
hyphens inserted, as shown on the following pages, and then save the 
file back to disk as an ASCII text file. Words can be inserted in lower case 
only. Insert words alphabetically. Several words are already included in 
HYPHUSER.DIC to get you started. 

Failure to store this file as an ASCII file will result in incorrect hyphena­
tion. 

Suppress If you want to suppress hyphenation for a particular word-perhaps 
hyphenation your company's name-you can enter that word into the 

HYFHUSER.DIC file without hyphens. 

Long words Only the first seven characters (excluding hyphens) of each entry in the 
dictionary are read by the hyphenation algorithm. Thus, entering the 
following: 

con-sid-er-able 
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will not produce a hyphen between er and able because this part of the 
word occurs after the seventh character. If you want the algorithm to 
read more than seven characters, place an asterisk * before the eighth 
character and each character thereafter, e.g., 

con-sid-e*r-*able 

The asterisk means "read the next character." If you do not place an 
asterisk before the b, 1 and e at the end of the example word, the rest of 
the letters are not read. Consequently, other derivatives, such as con­
sideration and considerate, will be hyphenated at the same points as 
considerable, even if you do not enter them separately in the diction­
ary. 

The following are examples of entries into the hyphenation dictionary. 

in-de-fat-*i-*g*a-ble 
moth-er-h *o*o*d 
plu-ral-i-*t*y 
ventura 
xerox 

Using multiple hyphenation algorithms 

Ventura Publisher allows you to use two hyphenation algorithms at the 
same time by specifying one algorithm with a .HYI extension and 
another with a .HY2 extension. How a particular paragraph is 
hyphenated is dependant on the algorithm applied to the tag with which 
the paragraph is formatted. 

Since hyphenation of text is accomplished when the chapter is opened, 
if you change the algorithm applied to a tag, the hyphenation points will 
not be changed until the chapter is saved and again opened. 

Compatibility with GEM Ventura Publisher 

Hyphenation in the GEM version of Ventura Publisher is accomplished 
by the use of the following: 

• USENGLSH.HYI algorithm. Provides fast hyphenation and is the 
default hyphenation algorithm installed if the EDCO dictionary is not 
selected when the GEM version of Ventura Publisher was installed. 



If this algorithm is installed in the GEM version of Ventura Publisher, 
USENGLSH is displayed as a hyphenation option in the GEM version 
Alignment dialog box. 

• USENGLS2.HY2 algorithm. Provides exhaustive hyphenation. This 
is the alternate hyphenation algorithm and is installed manually. 
This algorithm provides compatibility with the Windows alternate 
algorithm as discussed later. If this algorithm is installed in the GEM 
version of Ventura Publisher, USENGLS2 is displayed as a hyphena­
tion option in the GEM version Alignment dialog box. 

• EDeO hyphenation dictionary. Provides a 130,000 word look-up type 
dictionary. This dictionary may be installed if the Professional Exten­
sion features of the GEM version are installed. If this dictionary is 
installed in the GEM version of Ventura Publisher, US DIeT is 
displayed as a hyphenation option in the GEM version Alignment 
dialog box. 

The Windows version of Ventura Publisher uses, by default, a 
Houghton-Mifflin dictionary. However, to ensure compatibility with the 
GEM version of Ventura Publisher, an alternate hyphenation algorithm 
is included with the Windows version. This algorithm, called 
WUENGLSH.WH1, is comparable to the GEM version 
USENGLS2.HY2 algorithm. This allows documents formatted in the 
GEM version using the USENGLS2.HY2 algorithm to maintain the 
same hyphenation when opened in the Windows version using the 
WUENGLSH.WH1 algorithm. 

At this time, the Windows version of Ventura Publisher does not provide 
a dictionary or algorithm comparable to the GEM version EDeO diction­
ary or USENGLSH.HY1 algorithm. If all or part of a document created 
in the GEM version uses the EDeO dictionary or the UENGLSH.WH1 
algorithm, hyphenation differences may occur when that document is 
opened in the Windows version. 

If the USENGLS2.HY2 hyphenation algorithm is used to hyphenate a 
document in the GEM version of Ventura Publisher, you can maintain 
the same hyphenation points when the document is opened in the 
Windows version. To ensure that documents created in the GEM version 
of Ventura Publisher maintain the same hyphenation points when 
opened in the Windows version, you must manually install the Windows 
version WUENGLSH.WH1 algorithm. 
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The file name extension of the USENGLS2 (GEM alternate algorithm) 
is important in determining how the WUENGLSH (Windows alternate 
algorithm) is to be installed. To determine the file name extension: 

> On the computer on which the GEM version is installed, change to 
the drive and VENTURA directory where Ventura Publisher is in­
stalled. 

> Type: 

DIR *.HY* 

> Note the file name extension of the file USENGLS2. Perform the 
following procedure corresponding to the file name extension of this 
file. 

If this file does not appear, the documents created in the GEM version 
are not hyphenated using the alternate algorithm and the same 
hyphenation points cannot be maintained. 

For file name > On the computer on which the Windows version of Ventura Publisher 
extension ,HY1 is installed, use the Windows File Manager or DOS RENAME com­

mand to rename the file WHMIFF.WHI in the VENTURA directory 
to WHMIFF.WH2. 

> Using the Windows File Manager or DOS COPY command, copy the 
file WUENGLSH.WHI from theALTHYPH directory of the Windows 
Ventura Publisher UTILITIES disk into the VENTURA directory in 
which Windows Ventura Publisher is installed. 

The Windows version of Ventura Publisher will now maintain hyphena­
tion points of documents created in the GEM version using the 
USENGLS2.HYI hyphenation algorithm. Also, the Houghton-Mifflin 
hyphenation dictionary (US DIeT) will be maintained as the second 
option in the Windows Ventura Publisher Alignment dialog box. 

For file name On the computer on which the Windows version of Ventura Publisher is 
extension ,HY2 installed, use the Windows File Manager or DOS COPY command to 

copy the file WUENGLSH.WHI from the ALTHYPH directory of the 
Windows Ventura Publisher UTILITIES disk into the VENTURA direc­
tory in which Windows Ventura Publisher is installed. 
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The Windows version of Ventura Publisher will now maintain hyphena­
tion points of documents created in the GEM version using the 
USENGLS2.HY2 hyphenation algorithm. Also, the Houghton-Mifflin 



hyphenation dictionary (US DIeT) will be maintained as the first option 
in the Windows Ventura Publisher Alignment dialog box. 

Ventura Publisher allows you to maintain two different hyphenation 
options. This means that a document may have some paragraphs that 
are hyphenated using the USENGLS2 algorithm and other paragraphs 
hyphenated using one of the other hyphenation options. If a document 
created in the GEM version has some paragraphs hyphenated with the 
USENGLS2 algorithm and other paragraphs hyphenated with one of 
the other hyphenation options, the paragraphs hyphenated with an op­
tion other than USENGLS2 may not maintain the same hyphenation 
points when opened in the Windows version. 

Using alternate hyphenation algorithms 

Ventura Publisher includes alternate hyphenation algorithms for 
several languages. The following table lists the countries for which 
alternate hyphenation algorithms are supplied and the file name as­
sociated with each language. 

Language Hyphenation File Name(s) 
English (United Kingdom) UKWH2, DHEXUKDIC 
Swedish SVENSKWH2, DHEXSW.DIC 
Finnish SUOMLWH2 
Portuguese PORTUGAL.WH2 
Norwegian NORSKWH2 
Italian ITALIANO.WH2 
Dutch HOLLAND.WH2, DHEXNL.DIC 
French FRANCAIS.WH2 
German DEUTSCH.WH2 DHEXGE.DIC 
Danish DANSKWH2 DHEXDKDIC 
Spanish ESPANOL.WH2 

Ventura Publisher, by providing the ability to load and apply two 
different hyphenation algorithms, allows you to produce multi-lingual 
documents while maintaining the correct hyphenation for each lan­
guage. 

The alternate hyphenation algorithm files are located in the ALTHYPH 
directory of the Ventura Publisher UTILITIES diskette. To install an 
alternate hyphenation algorithm simply copy the corresponding files 
from the program diskettes to the Ventura Publisher Windows version 
VENTURA directory. 
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The extension of the hyphenation algorithm determines its order in the 
Hyphenation option of the Alignment dialog box. An algorithm with 
the extension .HYI will appear first in the Hyphenation option list, 
and the extension .HY2 will appear second. Simply rename the exten­
sions to change the order in which the algorithms appear in the 
Hyphenation option. 

Only one file with the .HYI and one file with the .HY2 extension should 
appear in the VENTURA directory at any time. 

How a particular paragraph is hyphenated is dependant on the algo­
rithm applied to the tag with which the paragraph is formatted. Since 
hyphenation of text is accomplished when the chapter is opened, if you 
change the algorithm applied to a tag, the hyphenation points will not 
be changed until the chapter is saved and again opened. 



APPENDIX C 
TROUBLESHOOTING 

This chapter will aid you in determining the cause of a problem should 
one arise. You should refer to this chapter before calling the customer 
support line. This chapter contains two major sections. The first 
provides answers to the most common questions asked of our customer 
support staff. The second section provides a listing of error messages 
along with a description of what they mean and what to do if you receive 
one. 
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Common questions 

Fonts 
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The following is a list of common questions asked of our customer 
support staff. If you do not find the answer to your question in this 
section, refer to the Index under the heading "Troubleshooting" to find 
references to common problems, along with the recommended solutions 
to these problems. 

Can I buy additional fonts for my printer and use them with Ventura Publisher? 

Yes. Each font vendor provides a font generation and installation kit 
for installing their fonts in Windows. Follow the instructions 
provided with the font generation and installation utility. The fonts 
you add will immediately be available in the ENVIRON.WID width 
table. If you have generated a custom width table, you must rebuild 
the custom width table using the using the options in the Manage 
Width Table dialog box. 

When using the font vendors generation program, make sure you 
select the Windows, or Windows Ventura Publisher option, if one is 
available, for the environment for which to generated fonts. If the 
font generation program lists Ventura Publisher as an option, and 
the option does not specify the Windows version of Ventura Publisher, 
the fonts generated will be for the DOS/GEM version of Ventura 
Publisher and will not be compatible with Windows. 

What is the width table used for and why do I need it? 

Each printer creates individual letters and symbols differently, with 
a different shape, height, and width. Ventura Publisher must know, 
for each printer installed, the width of each character for each 
typeface and size. This width information is then used to adjust the 
position for each character on the screen so that the end of each line, 
paragraph, and page matches the printed output. This information 
is contained in a width table file. One width table file can contain 
width information for many different fonts. To create your own width 
table for the fonts currently installed for a specific printer, select the 
Use Environment's Width Table button in the Manage Width 
Table option dialog box (File menu). 
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Printing 

I changed the font for one paragraph, but now all the paragraphs have been changed 
to the new font. Why? 

The Paragraph menu controls the font of paragraph tags, not 
individual paragraphs. When you select a paragraph and change its 
font while using the Paragraph tool, you actually change the font of 
the tag which controls the format of that paragraph. Every other 
paragraph to which this tag is assigned will also change. 

My printer doesn't print. What should I check? 

1. Check that the printer is turned on, and that it is getting power. 

2. Check that the printer cable is connected. 

3. Check that the cable is attached to the correct connector on the 
computer. 

4. If you are using a serial cable, check the wiring diagrams in 
Appendix F. 

5. If you are using a serial cable and your computer contains more 
than one serial port, make sure these ports are not configured 
identically (e.g., both set to COMl). 

6. If you have connected several printers to your computer through a 
switch, make sure the switch is set in the correct position. 

7. Ensure that the printer is setup properly in Windows via the 
Control Panel. 

I can see my headers and footers on the screen but they don't print. Why not? 

Laser printers cannot print to the exact edge of the paper. Most leave 
between 0.25 and 0.50 inches blank space around the edge of the 
page. Ventura Publisher cannot know what your printer is capable of 
printing. However, you can easily find out. Load the CArABILI 
chapter located in the TYPESET directory and print it to your 
printer. The white space around the edge of the page indicates the 
area to which your printer can't print. Once you print CAPABILI, you 
should also note the other effects on the page which your printer can 
or cannot produce. 

If you find that your printer is not capable of printing a header or 
footer in its current position, you must reposition the text within the 
header or footer frame. To move the header down: 
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1. Select the Paragraph tool. 

2. Select the text in the header. 

3. Select the Spacing option in the Paragraph menu. 

4. Increase the Above space. 

You can also select the header frame using the Selection tool (the 
arrow) tool and increase the top margin. However, this will only 
affect the current chapter. Changing the paragraph tag, as described 
above, will affect every chapter and therefore fix the problem for all 
chapters using the current style sheet. 

You can use a similar approach to change the placement of footers 
within the footer frame. 

How can I send the printer output to a disk file instead of to the printer? How can this 
disk file then be printed? 

Copy files 

There are a number of reasons why one would want to print to a file. 
The procedures for printing to a file under the most common cir­
cumstances are described in the Putting It Together chapter (Chap­
ter 14). 

How do I copy all the files associated with a chapter? The DOS COPY command does 
not work. 

The Ventura Publisher chapter (CHP) files contain references to 
every file contained in your document. The DOS COpy command will 
not change these references when you copy the chapter file and all 
the associated files to another location on your hard disk, or when 
you copy them to a floppy disk. As a result, when you open the copied 
chapter, it will attempt to retrieve files from their original location. 
When it can't find them, an error message is displayed on the screen. 
In addition, when using the DOS COPY command, you may forget to 
copy some of the files in your chapter. 

Fortunately, Ventura Publisher provides its own copy function which 
copies all files associated with either a single chapter or with an 
entire publication. In addition, the chapter file is modified to retrieve 
the files from their new locations after the copy process has been 
completed. For details on how to use the Copy All option, refer to 
page 5-47. 
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General operation 

I loaded a text (or picture) file, but it doesn't appear on the page. What's wrong? 

You must do the following to place text or picture files on the page or 
in a specific frame: 

1. Select the Selection tool (the arrow). 

2. Select the frame or page where you want the text or graphic to 
appear. 

3. Select the file name from the Files list. 

If you select the frame or page prior to loading a file, that file will 
automatically be placed into the frame or page. 

If a frame contains a picture and the picture doesn't display: 

1. Select the frame and then select the Show This Picture option 
from the View menu. 

2. If a picture is placed into a frame which previously held another 
picture, the scaling and cropping values for the old picture still apply. 
This may position the new picture outside of the frame. Select the 
frame, then press and hold the Alt key. Put the mouse cursor in the 
center of the frame and while still holding the Alt key, press and hold 
the mouse button. Move the mouse around and see if the picture 
appears. You can also fix this problem as follows: select the frame and 
then select the Fit in Frame and Maintained options in the Sizing 
& Scaling option dialog box (Frame menu). 

My chapter has Os and 1 s in it. What happened to my text? 

You used the Load TextlPicture option to load a chapter (CHP) file. 
You should have used the Open Chapter option. Remember, the 
Load TextlPicture option allows you to add files to an existing 
chapter whereas the Save and Open Chapter options save and 
retrieve all files that were previously loaded. 

I can't see both pages of the document at once while in the facing pages view. 

In order to view facing pages using the View Facing Pages option, 
you must have the Sides option in the Page Size & Layout option 
dialog box (Chapter menu) set to Double. 

How do I change text attributes for part of the text in the headers or footers? 

Use the codes shown on page D-5 in Appendix D within the Headers 
& Footers dialog box. Figure 8-16 on page 8-20 provides an ex-
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ample of how to change point size. For example, to change to bold, 
use <B>. To change to italic, use <MI>. To change back to the font set 
by the paragraph's tag, use <D>. When changing kerning of the text 
in the header or footer, you must use the <Kn> command instead of 
the <%n> command. Refer to the Text attributes section of Appendix 
D for more information on adding attributes to headers and footers. 

I placed a tab in the text and now the rest of the line has moved beyond the edge of 
the column. What should I do? 

Tab stops move all text in a line to the right. Text does not automat­
ically wrap to the next line. Use a line break (Ctrl + Enter) to end 
the line. 

Why doesn't the text cursor appear in the middle of a blank page when I try to place 
it there? 

yentura Publisher is designed to format text within a given frame, 
starting at the upper left corner. If you want text to appear in the 
middle of a blank page, draw a frame (or box text) at this point, 
placing the upper left corner of the frame at the position where you 
wish to start typing. Then, place the cursor inside this frame and 
begin typing. 

When should I place text directly into a frame, and when should I use box text? 

Place text directly into a frame when: 

1. The text originates in your word processor. 

2. The text must continue into another frame (e.g., a newspaper 
article). 

3. The text must be formatted into more than one column. 

Use box text in all other situations. 

Which scanners does Ventura Publisher support? 

Images can be scanned directly into Ventura Publisher frames when 
the Ventura Scan color extension product is also installed. Other­
wise, any scanner that converts its images into TIFF, GEM image, or 
PC Paintbrush PCX (version 2.5 or above) format can be used to scan 
images for loading into Ventura Publisher. 

Can I make text flow around irregularly shaped images like circles and triangles? 

Yes. Ventura Publisher can generate "text runaround." The method 
is described in the Creating a Text Runaround section starting on 
page 14-13. 
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I can't get my PC Paint files to load. Why? 

PC Paint is a different product from PC Paintbrush, and is not 
compatible with Ventura Publisher. 

Does Ventura Publisher work on a network? 

Yes. This package contains all software necessary to install Ventura 
Publisher for network operation. Refer to the Installation and Con­
figuration Guide 
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The following is an alphabetical listing of messages that can appear in 
Ventura Publisher, along with an explanation of what they mean and 
what to do when they occur. Messages deemed self-explanatory are not 
listed. 

A file by that name already exists. Do you wish to choose a new name or overwrite 
the existing file? 

This message warns you that you are about to write over an existing 
file. You can either save the file under a new name, or overwrite the 
existing file. 

A second Z_ TBl_BEG tag was found in the midst of a table definition. Check for a 
missing Z TBl END tag or remove the extra Z TBl BEG tag and try again. 

Indicates that a file brought into Ventura Publisher does not have the 
proper beginning and end statements for a table definition. You must 
use a word processor to modify the file. Refer to Appendix D for more 
information. 

A tag/frame by that name already exists. Try again with a different name. 

Ventura Publisher prevents you from accidentally assigning the 
same name to two different tags or to different frames. 

Abandon changes to this chapter and revert to the previously saved version? 

If you elect to abandon, any changes made to this chapter, including 
changes to the style sheet, will be lost and the last saved version of 
the chapter will be opened. If you wish to retain the changes to the 
style sheet, but abandon changes to the rest of the chapter, select 
Save Style As option in the File menu prior to selecting the Revert 
to Saved option. 

All 6 of your repeating frames are already in use 

Ventura Publisher allows up to six repeating frames per chapter. To 
eliminate this error message, you must use the Repeating Frame 
option dialog box (Frame menu) to make one of the existing six 
repeating frames a normal frame. 
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An ASCII error file named: file has been created with a list of the errors that occurred 
during cross-referencing. 

Any references to markers or frame names which don't exist will 
result in an error. You can read the error file using the ASCII function 
in your word processor, or you can load it into Ventura Publisher (use 
the WordStar or XyWrite option) to see the list of marker and frame 
names which could not be referenced. You should then edit the text 
files in your chapter to add the missing references. 

An unexpected tag named: tagname was found between the Z_ TBl_BEG and the 
Z TBl END paragraphs. Check for missing Z TBl END. 

-or-

Incorrect Z_ TBl_BEG definition: table defThis string either is not correct or is not 
expected in a Z TBl BEG definition paragraph. 

-or-

Incorrect Z_ TBl_BODY definition: table defThis string either is not correct or is not 
expected in a Z TBl BODY definition paragraph. 

These errors usually result if you have accidentally changed the table 
header information while using your word processor to edit one of the 
text files in a chapter. This error is sometimes difficult to recover. You 
will need to make changes to the text file using your word processor 
rather than with Ventura Publisher. First try adding a Z_TBL_END 
= statement to the end of your table. If the error still occurs, eliminate 
the entire table from Z_TBL_BEG = to Z_TBL_END = and then 
reopen the chapter and reconstruct the table. 

Are you sure you want to print n spot color overlays per page of this chapter? If not, 
either print just one page for all colors or cancel the print reguest. 

If you answer Overlays, then a separate page will be printed for each 
color that is enabled. Thus, if you have defined three colors (including 
black), a ten page document will produce thirty printed pages. 

Are you sure you want to {paste/insert} #column(s) in front of COlUMN# x in your 
table? 

-or-

Are you sure you want to {paste/insert} #row(s) in front of ROW# y in your table? 

This alert gives you a chance to stop a paste or insert operation into 
a table. 
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Cannot create the TOC or index file. Verify that all sub-directories of the TOC or index 
file path exist. 

You must specify a valid disk drive and directory path in the table of 
contents or index dialog box. If you are unfamiliar with directory 
paths, refer to the DOS reference manual supplied with your com­
puter. 

Cannot make the following subdirectory: directoryas one of the Copy All destination 
paths. 

You must specify a valid disk drive and directory in the Copy All 
option dialog box. Do not put a chapter or file name on any of the 
destination lines. Instead, simply type the disk drive and directory 
path, e.g., A:\BACKUP\. 

Copy All destination directories should be prefaced with a drive and path, such as: 
C:\ or C:\TYPESEn. 

You must supply the final backslash (\) when typing a directory 
name. Thus C: \ is correct; C: is not. C: \ TYPESET\ is correct; 
C:\TYPESET is not. 

Currently, there is nothing on the clipboard. Therefore, you can't insert any text at the 
current cursor location. 

You must cut or copy text before you can paste text at the current text 
cursor location. 

Do you wish to {cut/copy} your entire table to the Clipboard? 

If you select only a part of a table, then only that portion of the table 
is cut or copied to the clipboard. However, if you select the entire 
table, then the entire table will be cut or copied to the clipboard. You 
can then paste the entire table in another location in the document. 

Do you wish to insert a reference to the current page or chapter number or cancel the 
request? 

If you insert a reference, but do not supply a reference name, a 
reference to the current page (or chapter) is inserted. 

You are about to overwrite an existing caption. You won't be able to recover the 
caption text. Is that OK? 

When you type text directly into a frame (rather than using the Load 
TextlPicture option to load text into a frame), this text is stored in 
the chapter's caption file, along with all other captions, box text, and 
text typed into other frames. If you later try to assign a picture or text 
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file to this frame, this message is displayed, warning you that the text 
in this frame will be permanently lost. If you don't want to lose this 
text, but you still want to place text into this frame, use the Text tool 
to cut the text from the frame, then go ahead and put the text or 
picture file into the frame. You can then paste the text on the 
clipboard to another location in the document. 

Do you wish to {cut/copy} m row(s) or ncolumn(s) from location RACyin your table? 

When you select cells in a table using the Table tool, all or part of both 
rows and columns are selected. When performing a cut or copy on a 
table the entire row or column is affected not just the selected cells. 
Ventura Publisher requires that you specify whether you want the 
selected row(s) or columnCs) cut or copied. 

Do you want to save, save as, or abandon the changes you've made to this style sheet 
by removing/assigning tags? 

This message is displayed when you select OK in the Update Tags 
list option. If you select Abandon, all changes made in the Update 
Tags List option dialog box are discarded. 

Do you wish to re-anchor just this page's frames, or all page's frames, or cancel the 
request? 

If you choose to only re-anchor frames on this page, only this page 
and the pages immediately before and after are affected. 

Failure - Network Detected with No NetBIOS 

The message occurs on non-Novell networks in one of two instances: 

• Full NetBIOS is not installed in a network seat attempting to run 
Ventura Publisher from copy installed on the network server. 

• Full NetBIOS is not installed on a stand alone system (system with 
Ventura Publisher installed on a local hard disk) attempting to access 
the network drive using Ventura Publisher. 

In either case, full NetBIOS must be installed when using Ventura 
Publisher on a network. 

File name collision: Itle. Do you wish to rename this file, ignore the collision & copy 
over, or cancel the archive process? 

During the Manage Publication option Copy All process, this 
message is displayed if two files with the same name, but located in 
different directories, are to be archived to the same place. If you 
rename the file, you will end up with two unique files on the target 
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directory. If you ignore, then the last file copied will be the only one 
used. The safest thing to do is to rename the file. This way no 
information is lost. 

Filename already exists on the target drive. Do you wish to overwrite the old version, 
keep the old file, or cancel the archive process? 

This message is displayed during the Manage Publication dialog 
box Copy All process if a file with the same name, but a different 
date and time, is found on the target disk drive. Choose the option 
desired. If the file has the same name and the same date and time, 
Ventura Publisher assumes that they are identical and does not 
bother to re-copy the file. 

Headers, Footers, and other Repeating Frames can't be cut or copied to the clip­
board. 

You cannot cut, copy, or paste frames which are automatically 
generated by Ventura Publisher. This includes headers, footers, and 
footnotes. 

If you intend to type text on an empty page, choose New File and enter the name and 
select the type of the file that will hold that text. Otherwise, choose Cancel. 

This message is displayed if you insert a page and then try to type on 
this new page. 

In order to delete the paragraph in front of a table, you must first make sure it is an 
empty paragraph by deleting all of its characters. 

To delete a paragraph which precedes a table, first delete all text 
from the paragraph. Then, with the text cursor placed at the end of 
the now-empty paragraph, press the Delete key. 

Multiple users trying to open: file for reading and writing. Try Again or Cancel. 

Only one user can open a chapter at anyone time. If you want to view 
a chapter which has already been opened by someone else, use the 
Browse option in the Open Chapter option dialog box instead. 

No file by the name you've typed exists. Therefore, it can't be removed or have its file 
type changed. 

The file name you specified in the Remove TextIFile option dialog 
box does not exist or was spelled wrong. A better way to perform this 
operation would be to select the frame containing the file you wish to 
have removed, and then select the Remove TextlFile option. The 
name of the file in the selected frame will appear in the dialog box. 
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No tag by the name you've typed exists. Therefore, it can't be renamed, removed, 
converted to, or assigned to function key. 

Check the tag name as shown in the Tags list and try again. You 
probably typed the wrong name. Remember, spaces within the name 
make a difference. For example, Heading land Headingl are two 
different names. 

Only one paragraph is allowed per table cell. Do you want to insert a blank paragraph 
above or below this entire table, or cancel the request? 

If you want to produce multiple lines of text within a table cell, use a 
line break instead (produced by pressing Ctrl + Enter). 

Only text files can be renamed and retyped using this command. 

The File TypelRename option is available only for frames that 
contain text. 

Output file already exists. 

When generating an index or table of contents, Ventura Publisher 
will alert you if the name you specified for the output file already 
exist. You will be given the opportunity to overwrite the file that 
already exists, rename the output file, or cancel the operation. 

Renaming the base page's text file to match this chapter name leads to a conflict with 
a filename that already exists. 

If you start typing on a blank page in a new chapter, and if you then 
use the Save or Save As options, Ventura Publisher automatically 
creates a text file with the same name as the chapter file name. (The 
extension used will be the same one used for the text file in the last 
chapter you saved.) However, if a file by this name already exists, you 
must provide a different name. 

Save or Abandon changes to this chapter? 

-or-

Save or Abandon changes to this style sheet? 

You have selected the New or Open Chapter option from the File 
menu before saving changes to the currently opened chapter or style 
sheet. Select the Save option to save the chapter or style sheet before 
opening or starting another chapter. Select Abandon to abandon all 
the changes made to the currently opened chapter or style sheet 
before opening or starting another chapter. 
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Save or Abandon changes to this publication? 

When you select OK in the Manage Publication option dialog box, 
Ventura Publisher reminds you to save the publication if any changes 
have been made since it was last saved. Since table of contents and 
index settings are saved with the publication, any changes made 
while generating a table of contents or index will cause this message 
to appear. 

The current width table & the merge width table are set for different devices. What 
should be done? 

You cannot add fonts from a width table intended for a different 
printer (e.g., HP LaserJet Plus and PostScript). 

The file named: file referenced in the chapter or publication you are currently loading, 
could not be found. 

A text, picture, or chapter file has been deleted or moved to another 
subdirectory. This message often occurs if you use the DOS COPY 
command to copy chapters. You must use the Manage Publication 
option dialog box Copy All command (refer to page 5-47) to copy 
chapters. Otherwise the chapter will look for text and picture files in 
the location where they resided prior to the copy operation. When it 
doesn't find them, this message is displayed. 

The file you're trying to open as a Ventura Publisher CHP file is not in the standard 
chapter file format. 

You have selected a file which is not a standard chapter file. You 
probably renamed or copied an incorrect file; edited a CHP file and 
saved it as something other than an ASCII file; or specified the wrong 
file name. 

The file you're trying to open as a Ventura Publisher PUB file is not in the standard 
publication file format. 

You have selected a file which is not a standard publication file. You 
probably renamed or copied an incorrect file, or specified the wrong 
file name. 

The file you're trying to load as a Ventura Publisher STY file is not in the standard 
style sheet file format. 

You have selected a file which is not a standard style sheet file. You 
probably renamed or copied an incorrect file, or specified the wrong 
file name. 
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If you receive this message while Ventura Publisher is loading, delete 
all files in the VENTURA directory which have the extension INF. 

The file you're trying to use as a Ventura Publisher WID file is not in the standard 
width table file format. 

You have selected a file which is not a standard width table file. You 
probably renamed or copied an incorrect file, or specified the wrong 
file name. 

The new Width Table file couldn't be loaded. You may wish to try reloading this width 
file after doing a NEW. For now, we are using the current file instead. 

Whenever you load a style sheet file, either directly or by opening a 
chapter, the style sheet file automatically loads the width table that 
was in use when the style sheet was last saved. If that width table 
has been deleted, or if the style sheet has been copied to another 
system using the DOS COpy command, Ventura Publisher will not 
be able to find the width table. The current width table (e.g., 
ENVIRON.WID, located in the VENTURA sub-directory) will be 
used instead. 

To prevent this problem, always use the Manage Publication 
option dialog box Copy All command rather than the File Manager 
or the DOS COpy command, when copying chapters. To correct the 
problem, look at the contents of the style sheet file using the DOS 
TYPE command. While most of what is displayed on the screen will 
not be readable, you will see the name of the width table and the disk 
drive and subdirectory in which the width table file should be placed. 
Copy the width table to this directory. 

If you receive this message and Ventura Publisher will not load, 
delete the file VPWIN.lNF from the VENTURA directory. 

The paragraph you are trying to tag/edit is made up of text that was automatically 
generated. This text can't be tagged or edited directly. 

Text generated by Ventura Publisher, such as figure numbers and 
section numbers, cannot be editing using the Text tool. 

The picture file you tried to load couldn't be converted. Either it wasn't in the proper 
format or there wasn't enough disk/memory space for the conversion. 

The most common reason this message occurs is when you try to load 
pictures directly from a floppy disk. If your disk is almost full, and 
the picture file is large, the floppy disk will not have room for both 
the original picture file and the GEM format file which is created 
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during conversion. The solution is to copy the picture to your com­
puter hard disk before loading the picture file into your document. 

If the error occurs when you try to load a picture from the hard disk, 
delete some files to make room on your hard disk. This message also 
occurs if you select a file which does not match the picture file format 
for the type of file you specified (e.g., You selected AutoCAD in the 
Load TextlPicture option dialog box, but loaded a LOTUS file 
instead). 

The style sheet file you requested could not be found. Therefore, it was not loaded. 

Whenever you run Ventura Publisher, it automatically loads the style 
sheet which was in use at the end of the last session. However, it 
suppresses any reading of floppy disk drives to avoid Windows error 
messages should you forget to put a disk in the drive prior to running 
Ventura Publisher. Therefore, this message is displayed if, when you 
previously ran Ventura Publisher, the last chapter opened resided on 
a floppy disk, or the style sheet was deleted between sessions. The 
style sheet values stored in DEFAULT. STY are used instead. 

The tabs you have defined for this tag won't show up since the tag is marked as 
Justified. To make them show up, choose Left Aligned in the Alignment dialog. 

Justification overrides tab settings. Therefore, you must select a 
horizontal alignment setting other than Justify (Alignment option, 
page 10-6) in order for tab settings to take effect. 

The text file you're trying to load is not stored in the word processing format that you 
just specified or that the CHP file indicates. 

Some word processing programs create files which can be identified 
through information stored in the file header. If the file can be 
identified, and if the file does not match the file format option 
selected in the Load TextlPicture option dialog box, then this error 
message occurs. 

The time/date of the file named: file has been updated since it was loaded. Should we 
cancel the save or overwrite with this later version? 

This message indicates that someone else on the network has 
modified one of the files in your chapter using a program other than 
Ventura Publisher. You may either overwrite, in which case you will 
destroy the other person's work, or you may cancel and then use the 
File TypelRename option to change the name of the file so that 
when you save the chapter, your new version will not corrupt the 
other person's changes. You should then consult with the other 
person in order to merge your changes together. 
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The values you're setting for margins and columns exceed the width or height of the 
frame. 

This message occurs if you try to specify margin and column dimen­
sions that are larger than the actual page size as set in the Page Size 
& Layout option dialog box. You must either set the page size larger, 
or specify margin and column dimensions that will fit within the page 
size. 

There is not enough space on the target disk to save the file. Do you wish to continue 
with a new disk or cancel the archive process? 

This message indicates you've run out of room on the target disk 
during a Manage Publication option dialog box Copy All opera­
tion. Insert the next disk and then select Continue to continue the 
archive process. 

There isn't enough memory to merge these two width tables into one width table. 

This message occurs using the Add Fonts from Width Table option 
within the Manage Width Table option dialog box. You must delete 
files on your hard disk to make room for the new, merged width table. 

There was not enough memory to begin the archive process. 

Terminate the Manage Publication operation by selecting OK, 
then select the New option in the File menu to remove the existing 
chapter from memory. Finally, select the Manage Publication op­
tion and resume the archive process. 

There wasn't enough memory to load and hyphenate all of the text file you requested. 
You may have to split this chapter & file into two parts and try again. 

You may have exceeded the number of paragraphs allowed per 
chapter, or the total amount of text per paragraph. 

There were no rows of table data between the Z_ TBl_BEG tag and the Z_ TBl_END 
tag. Add some data rows and try again. 

You must edit the text file with your word processor to either remove 
the @Z_TBL_BEG and @Z_TBL_END tags, or else place appropriate 
table text between them. The information provided under the Tables 
heading in Appendix D defines the format for tables. 

This chapter has at least one hidden picture. Do you want to print all hidden pictures 
or keep them hidden? 

This message occurs if any picture in your chapter is hidden. To 
eliminate the message the next time you print: 
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1. Select the Paragraph tool. 

2. Select the Hide All Pictures option in the View menu. 

3. Select the Show All Pictures option in the View menu. 

If the View menu initially displays Show All Pictures, select this 
option, then proceed with steps 2 and 3 above. 

This chapter is opened for browsing only, no changes can be saved. To make 
changes and save them, you must use OPEN CHAPTER not BROWSE CHAPTER. 

You cannot save any changes made while browsing a chapter. 

This file could not be found: file. Do you wish to skip over it, or retry with a new disk, 
or cancel the archive process? 

This message is displayed when you use the Manage Publication 
option dialog box Copy All option to retrieve a large publication from 
several floppy disks. When you receive this message, insert the next 
disk, and select Retry. If you can't find the file, but want to continue 
the archive process, select Skip. 

The message also occurs if a file to which a chapter points has been 
deleted. If you select Skip, the rest of the files in the chapter will be 
copied. 

This frame has text which won't fit on any page due to invalid tag/column settings. 
Change the tag/column settings so that it can format correctly. 

This message is displayed under a number of different circumstan­
ces. First, if you accidentally create a tag which makes it impossible 
to fit any portion of a paragraph on a page. Examples include: any of 
the Spacing options set to very large numbers; Keep With Next 
(Breaks option dialog box) set to Yes for Body Text (this causes every 
paragraph to "chase" after each following paragraph, resulting in 
nothing being placed on any page); and fonts larger than the frame. 
This message also occurs if you place text inside a frame (or box text) 
and then reduce the size of the frame or box. The solution is to: 

1. Tag a paragraph with the tag you suspect may have been improper­
ly set, and then check each Paragraph menu option for obviously 
erroneous settings, or 

2. Make the frame (or box text) larger. 

This message may also appear if you create a caption for a frame. If 
the message does occur, select the Selection tool (the arrow), select 
the caption, and then increase the size of the caption frame until the 
message goes away. You can also decrease the above and below space 
for the two paragraphs inside the caption frame. 
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This message also occurs if you place another frame on top of a frame 
which contains text (either in the frame itself, in box text, or in the 
frame's caption). The solution is to move the frame on top, so that the 
text in the frame underneath now displays. 

This style sheet file is marked with the DOS Read Only attribute. Changes to it can 
only be saved using Save Style As with a different name. 

You can use the DOS ATTRIB command to set style sheets to read­
only. This is useful if you don't want others to change a master style 
sheet. Any changes made to such a style sheet will result in this 
message when the chapter is saved. 

This variable definition string is too long or complex to show in the dialogue. Only 
what can be shown will be shown. 

You can create variable definitions that are longer than Ventura 
Publisher can place in the dialog box. This message indicates that the 
variable string cannot be displayed. However, it is still usable. 

To edit a special code you need to place the text cursor just in front of the special 
code. Some special codes can't be edited in this way. 

The text cursor needs to be position in text where the special item 
has been inserted. Place the text cursor in the text at the ap­
proximate location of the special code and use the cursor keys to move 
the cursor until the special item name (e.g., Index, Frame Anchor, 
Cross Ref) is displayed in the current selection indicator. Some 
special codes, such as footnotes, hollow boxes, and filled boxes cannot 
be edited this way. 

Too Many Active Users 

This message occurs when the number of users attempting to run 
Ventura Publisher from the network server exceeds the number of 
network nodes installed. Either wait until another user quits Ven­
tura Publisher, or install addition network nodes. Refer to Chapter 2 
for the more information on network nodes and their installation. 

Unable to find Anchor Frame: anchor. Do you wish to ignore, rename, or delete this 
unresolved anchor frame reference? 

This message indicates that Ventura Publisher can't find any frame 
in the chapter which has an anchor name to match an anchor you 
placed in the text. If you select Ignore, Ventura Publisher continues 
with the anchoring process. If you select Rename, you are then 
asked to specify a new text anchor name. If you can remember the 
name which you specified for the frame, enter that name. If this 

C-19 



At"'t"'cNUIX v-I HUUI:jLc~HUUTING Error messages and alerts: General operation 

C-20 

name is correct, this new name replaces the old name in the text, the 
frame is re-anchored, and the frame anchoring process continues. If 
you select Delete, the anchor name in the text is deleted. 

You can only insert a table before a text paragraph that is not part of a table, header, 
footer, or footnote. Reposition the table selection and try again. 

-or-

You can only insert a table before the 1 st character or after the last character of an 
existing paragraph. Reposition the text cursor and try again. 

Tables can only be placed between paragraphs, and they cannot be 
placed into frames which are generated automatically by Ventura 
Publisher, such as headers, footers, and footnotes. 

You can only inserVedit a special code if you have first placed the text cursor at a 
single text location. 

If you have selected a range of text, you cannot insert or edit a special 
code. Press the left or right arrow keys to position the text cursor at 
the correct location, and then try again. 

You can't merge a width table with itself. 

When using the Add Fonts from Width Table option in the 
Manage Width Table option dialog box, you must first load the 
width table to which you wish to add fonts, and then add fonts from 
a different width table into the first one. The two width tables must 
be for the same device (e.g., both for a PostScript printer) and be 
named differently. 

You can't remove a tag and then convert the paragraph back to the same tag. 

The name on the Name to Delete and Name to Convert to entry 
fields cannot be the same. 

You can't remove every face, size, and style font from a width table. 

You must leave at least one font in a width table. 

You can't remove or rename the default Body Text tag. 

The Body Text tag can not be removed or renamed. However, you can 
change any of the attributes of the Body Text tag just as you would 
any other tag. 
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You're about to overwrite an existing caption. You won't be able to recover the 
caption text. Is that OK? 

If you type text into a blank frame, the text in this frame is saved in 
the chapter's caption (CAP) file. If you later try to place text into this 
frame from a file in the Files list, this message warns you that the 
text currently in the frame will be lost. If this is a probiem, cancel 
this operation, then select the File TypelRename option in the 
Frame menu. Specify a file name and word processor format, and 
then select OK. If you then save the chapter, the text in this frame 
will instead be saved as a separate text file. If you then place text 
from another file into this frame, the original text will still be 
available in the external file. 

Your disk is full. The file named: file has not been saved. Before trying to save it again, 
delete enough files to make room. 

You have run out of room on your hard disk. Use the Windows File 
Manager to delete enough files to make room for the chapter or style 
sheet you are saving. If you Quit from Ventura Publisher at this point 
without deleting some files and then saving, all changes made since 
the chapter or style sheet was last saved are lost. 

You're trying to load a file containing a paragraph that is larger than 8000 characters. 
This has corrupted memory, so quit as soon as possible. 

Paragraphs are limited to 8,000 characters. This is about 1,600 
words or eight typewritten pages. Paragraphs longer than this may 
cause problems in some circumstances. The solution is to reduce the 
size of the paragraph by splitting it into several paragraphs. If you 
want to maintain the appearance of one solid paragraph, create a 
new tag for the second paragraph and set its Line Break option to 
Mter (Breaks option dialog box) and its Relative Indent option to 
On (Alignment option dialog box). Set the Line Break option 
(Breaks option dialog box) to Before for the first paragraph. This 
will cause the second paragraph to continue immediately after the 
first paragraph. 

You're out of non-text memory! Turn backups on, save your document, and quit the 
program as soon as possible. 

-or-

You're out of text memory! Turn backups on, save your document, and quit the 
program as soon as possible. 

These messages appear when the combination of text, number of 
frames, number of paragraphs, and number of tags exceeds the 
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amount of memory available. Immediately save your chapter. Select 
the About Ventura Publisher option in the Help menu. Increase 
the Frame & Tag Memory and Paragraph & Text Memory 
values by placing the text cursor in the Requested entry fields and 
entering greater than the In Use value. You must exit and restart 
Ventura Publisher in order for the new values to take affect. 

You're trying to load a file that contains an incorrect table description. Edit the file to 
correct the problem, and try again. 

This message usually results from editing the contents of a table 
from within your word processor. Refer to the Tables section in 
Appendix D for the correct syntax for data within a table. 

You've used 128 tags, files, or chapters. There are no more available. If possible, 
remove those that are no longer in use and try again. 

The combination of tags in the style sheet, plus generated tags, and 
tags in the chapter text files that don't match the style sheet, cannot 
exceed 128. This error message usually occurs when you load a text 
file containing tags that don't match the style sheet currently loaded. 
The tags which don't match are added to the tags already in the style 
sheet. The solution is to select New, load the correct style sheet, and 
then load the desired text file(s). 



APPENDIX D 
TEXT FROM OTHER PROGRAMS 

Ventura Publisher can read text directly from many popular word 
processors. It can also read text from many other programs which save 
text as a standard ASCII file. Text is read using the Load Text/Picture 
option. Text is saved automatically by saving a chapter using the Save 
or Save As options. Once saved, text can be edited using a word 
processor. The text can also be checked for spelling errors using a word 
processor's spelling checker, or from within Ventura Publisher using the 
Spell Check option. Finally, text originally loaded into Ventura Pub­
lisher in one word processor format can be converted to another word 
processor format using the File TypelRename option in the Frame 
menu. 

The two-way communication between a word processor and Ventura 
Publisher allows you to combine the familiar user interface and ad­
vanced text processing capability of your favorite word processing pro­
gram with the graphics and typesetting features of Ventura Publisher. 

This section explains how to prepare text from various word processors, 
spreadsheets, and databases for use by Ventura Publisher. 

The information in this appendix can also be used by a programmer to 
convert text from a word processor or other program into text which can 
be read by Ventura Publisher as an ASCII or word processing file. 

Scope of text translation 

Ventura Publisher creates typeset documents. The information needed 
to produce these typeset documents is far more complex than that 
needed to simply print typewriter-style text from a word processor. 
Therefore, Ventura Publisher adds typesetting margins, indents, 
hyphenation, page breaks, bullets, page numbering, headers and 
footers, footnotes, tab settings, picture anchoring, font information, 
table of contents, index, and section numbering into the text which is 
ultimately stored back into the word processor file. In addition, much of 
the format information used by the word processor is ignored when the 
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text is read into Ventura Publisher. For instance, a center command in 
a word processor is used to center text across a page. However, in a 
typeset page, text can be centered not only across a page, but within a 
column, across two columns, or within a frame. Thus, the word 
processor's center command does not provide sufficient information to 
unambiguously define what Ventura Publisher should do. 

Since the format information from the original word processor is 
eliminated as soon as the chapter is saved, you must save the text file 
under a different name before loading it into Ventura Publisher if you 
want to retain the original word processor formatting. 

However, text attribute information used by the author to convey mean­
ing is used. All attributes assigned using Ventura Publisher's Text tool 
(e.g., underline, boldface, font settings) can be transferred to and from 
any word processor or ASCII file. This is described in the sections which 
follow. 

In order to store typesetting information into a word processor format, 
much of the word processor's format information-other than text at­
tributes-is replaced by Ventura Publisher attribute codes when Ven­
tura Publisher saves the chapter. 

Ventura Publisher's paragraph format tags can be inserted from within 
your word processor as follows (the @ must be the first character in the 
line at the beginning of a paragraph): 

@TAGNAME A = A 

where TAGNAME is replaced by the name of the tag assigned to the 
paragraph. (The A symbol indicates that you should insert a space.) 
Thus, whether tagged originally by the author, or whether entered in 
the word processor or in Ventura Publisher, these tags can be inserted 
into the text as shown in Figure D-l. 
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@HEADING 1 = Common questions 

The following is a list of common questions asked of our customer 
support staff. If you do not find the answer to your question in this 
section, refer to the Index under the heading <169>Troubleshoot­
ing<170> to find references to common problems, along with the 
recommended solutions to these problems. 

@HEADING 2 = Fonts<$IFonts;Adding new> 

@HEADING 4 = Can I buy additional fonts for my printer and use them 
with Ventura Publisher? 

Figure D-1. Text for Appendix C, as it appears in a word processor Note index 
entries, line break, typographic quotes «169> and <170» and tag names. 

Non-keyboard characters 

Tabs 

Additional characters not found on the keyboard can be inserted into 
text by enclosing the ASCII decimal equivalent within brackets. (Refer 
to Appendix E.) For instance, to insert a trademark symbol (ni), you 
type: 

<191> 

To use the < > characters without having them interpreted as part of a 
character attribute code, type two brackets in a row. For instance, to 
produce: 

<text in brackets> 

type: 

«text in brackets» 

If the word processor can create and edit foreign characters, Ventura 
Publisher will translate these without the need to use the < > codes. 

Any time you press the Tab key on the keyboard, you insert a tab 
character into the text. The word processor then moves the cursor to the 
next tab stop setting for that paragraph. If the tab settings in the 
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Ventura Publisher style sheet are at different locations from the tab 
stops in the word processor, this will lead to incorrectly formatted tables, 
as shown in Figure D-2. To avoid this problem, use tab settings in the 
word processor that are similar to the style sheet to be used. Because 
word processor tab stops are set according to the number of characters 
which you want to skip, while Ventura Publisher's tab stops are set 
according to distance from the left column edge, this may require a little 
experimentation. However, you can closely approximate the word 
processor's tab settings by setting the Tab Alignment option in the Tab 
Settings option dialog box (Paragraph menu) to Left, and setting the 
distance (in inches) to a value given by the following formula: 

Tab Stop Left Margin . 
. h - . h = Dlstance Pltc Pltc 

Text in your word processor 

Tab stop settings in 
your word processor I I I 

Text before tab 1 

Text on second line 

Tab stop settings in 
Ventura Publisher 

Text before tab 1 

Text on second line 

~Text after tab 1 ~Text after tab 2 
~This text is longer than line 1 ~Text in line 2 

Text in Ventura Publisher 

I I I 

~Text after tab 1 ~Text after tab 2 

Text 
misalignment 

~This text is longer than line 1 ~Text in line 2 

Figure D-2. Tab stops set differently from those in your word processor causes 
text to mis-align witliin Ventura Publisher. 

The tab stop and left margin options are measured in numbers of 
characters. Pitch is measured in characters per inch. Distance is 
measured in inches. For instance, if your word processor prints at 10 
pitch (e.g., 10 characters per inch) and you have a tab stop set at 30 
characters from edge of the page, and a left margin of 15 characters, the 

Ventura Publisher tab stop should be set for ~~ - i~ = 1.50 inches. 

Tab check list • Set the Horiz. Alignment option in the Alignment dialog box 
(Paragraph menu) to a setting other than Justified for any para­
graph that contains tabs. 

0-4 



Text attributes Mrrl::.l .... UIA U-I L-,,, I I I ''-'IVI '-' I ........ I I • 1 ___ ...... _ 

• Make sure the word processor is configured to insert tabs. Certain 
word processors (such as WordStar) when configured incorrectly, add 
spaces rather than tabs. 

• Text which includes tab characters does not automatically wrap 
around frames (use line breaks if lines extend beyond the edge of 
frames). 

Text attributes 

Ventura Publisher correctly translates, displays, and prints text at­
tributes, such as boldface and underline, from each word processor 
supported. Similarly, any text attributes added using the Text tool are 
stored back in the word processor's native file format. 

However, because Ventura Publisher can create a much wider range of 
text attributes than any word processor, and because combinations of 
these attributes are treated differently within Ventura Publisher, many 
attributes are stored back into the original file using the codes shown 
below. 

For instance, the beginning of medium italic text is set by inserting the 
following directly before the text to be italicized: 

<MI> 

In general, attributes native to the word processor, such as boldface, 
when used alone, are translated back to the original attribute when a 
chapter is saved in Ventura Publisher. When used in combination with 
other attributes, they are translated back to the original attribute using 
combinations of the following Ventura Publisher codes. 

Attribute Code 
Medium weiJ!ht tYDe <M> 

Bold weiJ!ht type <B> 
Italics d> 

Underline <U> 
Double underline <=> 

Overscore <0> 
Strike-thru <X> 

Small <8> 
Superscript <"> 
Subscript <v> 
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Attribute I Code 
Color index J <Cn> 

Replace n with the desired color number. Use the Print Stylesheet option in the Update Tag List dialog box 
for a listing of the color numbers defined in the current style sheet. 

n=255 resets color to paragraph tag color. 
Typeface I <Fn> 

Replace n with one of the Font ID numbers shown in the Typeface section of Appendix I. 
Reset to the tag's paragraph font with <F255>. Additional fonts which you purchase may have font IDs 

different than those shown. The legal range of font ID numbers is 1 to 65 535. 
Point Size I <Pn> 

Replace n with the type size, measured in points (1 point equals 1172 inch). 
n=255 resets to point size specified by the paragraph tag. 

Base Line Jump I <In> 
Replace n with the vertical offset. n may range from 1 to 255. 

The amount of jump up, in points (p), is translated to n as follows 
300 

n = 256 - (72)(P). 

The amount of jump down, in points (p), is translated to n as follows 
300 

n = (n)(p). 

<JO> is reserved and used to reset the Base Line Jump to zero. 
For example jump up 6 points is <J231>. Jump down 6 points is <J25>. 

BeJdn Kernin~ I <Kn> 
This method is used for controlling kerning in headers and footers only. 

Replace n with the amount ofleft horizontal shift, measured in 11300 of an inch. n may range from -127 to 
127. The measurement -001 is used to reset the kerning to zero. 

Use the following method for kernin~text other than headers and footers. 
Kern/Track J <%n> 

Replace n with the number of ems to add (positive values ofn) or subtract (negative values ofn) between 
each character in the selected text. Place <%0> to mark the end of the text which should be kernedltracked. 

0-6 

Resume Normal J <D> 

All attributes are terminated at the end of a paragraph, even if the 
Resume Normal character code «D» is not encountered. Also, all pre­
vious attributes are terminated any time new attributes are set. 

Examples: Attributes can be grouped together into sequences. For example, to set 
Bold, Italic, Blue text, the code is <BIC4>. Any new text attribute 
sequence encountered cancels all previous attributes. 

Attributes native to the word processor and the codes described on the 
previous pages can be intermixed. For example to create the following 
effect using WordStar: 

airplane automobile 
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where the first word is boldfaced and underlined, and the second word 
is boldface only, would require the following within WordStar: 

I\UI\Bairplanel\U automobilel\B 

This same effect can be produced using the codes described on the 
previous pages as follows: 

<BU >airplane <B>automobile<D> 

The author can choose either to use the attribute set shown above, or 
continue to place attributes in the text using the word processor's own 
commands. 

Other inserted text 

In addition to paragraph tags and text attributes, Ventura Publisher 
also inserts other fields into the text file, including line breaks, discre­
tionary hyphens, non-breaking spaces, frame anchors, index references 
and footnotes. These are always stored back into the word processor file 
inside of < > brackets. The codes for each attribute are as follows. Some 
of these are described more fully in the paragraphs which follow this 
table. 

Text Attribute Text Code 

Box (Hollow) <$BO> 

Box (Filled) <$Bl> 

Chapter number <$R[C#]> 

Discretionary Hyphen <-> 

Em space < > 

En space <-> 

Figure Space <+> 

Footnote <$Ftext> 

Fraction <$Enumerator/denominator > 

Fraction <$Enumerator over denominator> 

Hidden text <$!text> 

Index <$IPrimary[Primary sort] ;Secondary[Secondary sort]> 

Line Break <R> 

Non-Breaking Space <N> 

Page number <$R[P#]> 
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Text Attribute Text Code 

Picture anchor (below) <$&anchor name[ v]> 

Picture anchor (same page) <$&anchor name> 

Picture anchor (above) <$&anchor name[ A]> 

Picture anchor (automatic) <$&anchor name[ -]> 

Thin Space <I> 

TrueType The follow table lists the TrueType text attribute weight codes. These 
weights codes are entered into text in exactly the same manner as other text 

attribute bracket codes. 

TrueType Wei2'ht Attribute Code 
Thin <WI> 

Extra Light or Ultra Light <W2> 
Light <W3> 

Normal or Regular <W4> 
Medium <W5> 

Semi Bold or Demi Bold <W6> 
Bold <W7> 

Extra Bold or Ultra Bold <W8> 
Black or Heavy <W9> 

Line Break <R> A line break begins a new line without creating a new paragraph. Use 
line breaks when printing large database files to separate individual 
lines within a record. The fewer paragraphs in a database printout, the 
larger the database file can be. Make sure, however, that you do not 
create a paragraph longer then 4-6K bytes. 

Discretionary A discretionary hyphen <-> presents an additional hyphenation oppor­
Hyphen <-> tunity to Ventura Publisher's hyphenation algorithm. If the word which 

contains a discretionary hyphen is not placed at the end of a line, no 
hyphen is shown on the screen and no hyphen is printed. 

Placing a discretionary hyphen at the beginning of the word disables 
hyphenation for the one occurrence of that word. 

Non-Breaking The non-breaking space <N> inserts a space, but unlike a normal space, 
Space <N> no break (line break, page break, etc.) may occur at this point. The 

non-breaking space is used to keep words together on the same line. 

0-8 

The non-breaking space is expanded and compressed during justifica­
tion, unlike the thin, figure, em, and en spaces which are always fixed 
width, regardless of justification. 
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Footnotes <$F> Footnotes can be inserted at any point in a text file by specifying 
<$Ftext> where text is the footnote text which will appear at the bottom 
of the page. Within Ventura Publisher, the appropriate footnote number 
is generated at the location in-'the text where the <$Ftext> appears. 

Frame anchors Frames can be anchored in one of four ways: 

• Fixed, on the same page 

• Relative, above the anchor location 

• Relative, below the anchor location 

• Relative, automatically at anchor 

The anchor reference is placed in the text as indicated in the earlier 
table. For instance, <$&SCREEN23[ v]> will anchor the frame named 
SCREEN23 to the spot immediately below the line which contains the 
anchor. 

Hidden text The hidden text allows you to place comments and other text in your 
files which Ventura Publisher will not display or print. Thus, if you place 
the following in a text file 

<$!Note: this section revised on June 26, 1989> 

this text will not appear in your document, but will still be available to 
edit within your word processor. 

Index Index entries are placed within a text file as follows: 

<$IPrimary[Primary sort]iSecondary[Secondary sort]> 

where Primary is replaced by the primary index entry; Secondary is 
replaced by the secondary index entry; and Primary sort and Secon­
dary sort are replaced with the two sort keys. For See references, $S 
is used in place of $1. For See Also references, $A is used in place of $1. 

If no sort keys are specified, the correct code is: 

<$IPrimarYiSecondary> 

If only a primary reference is used, the code is: 

<$IPrimary> 

0-9 
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Index references can easily be entered directly into your favorite word 
processor. Simply locate the point you wish to index and type the index 
references. For instance, this paragraph was indexed within Word­
Perfect by typing: 

<$IWord processoriDeveloping index in> 

at the beginning of the paragraph. 

Box characters To place box characters (e.g., 0 or.) in your document, enter: 

<$BO> or <$Bl> 

Additional inserted text 

The following shows additional codes which can be entered from within 
a word processor or from any other program to create the effects used 
by Ventura Publisher. 

Cross references Marker 
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-------------------------------------------------------
<$M> - Text marker used to provide a reference point in a text stream 
which may be referenced (forward or backward) by a <$R> code. Syntax: 

<$M[label]> 

label is the identifying label (name) of the marker. (Note: case will be 
ignored.) 

String variable 

<$V> - String variable used to define a string variable which may later 
be backward referenced by a <$R> code. The most recent declaration of 
a string variable is the one used when referenced. Syntax: 

<$V[label] string> 

where label is the identifying label (name) of the string variable (note: 
case will be ignored). 

string is the string which is to be substituted when the variable is 
referenced. The string is not limited in length and may be an empty 
string. 
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Reference 

<$R> - Reference used to cause a reference substitution into the text 
stream. Syntax: 

<$R[type,label,forrnat]string> 

type may be one of the following: 

• C# to designate the chapter number of the referenced frame or 
marker. 

• P# to designate the page number of the referenced frame or marker. 

• F# to designate the figure number of the referenced frame. 

• T# to designate the table number of the referenced frame. 

• S* to designate the section number string of the referenced marker 
(e.g., the text is derived from the section number paragraph immedi­
ately preceding the paragraph in which the marker appears). 

• C* to designate the caption label text of the referenced frame. 

• V* to designate a string variable substitution. 

label is the name of the desired string variable or marker, or the anchor 
name of the desired frame. This parameter is optional. Refer to restric­
tions below (note: case will be ignored). 

format is a format identifier, using the same syntax as is used for the 
format identifier for chapter, page, figure, and table counters. This 
parameter is optional; refer to restrictions below. 

string is the text which is last determined to be the appropriate substitu­
tion during publication reference generation. Initially, it may be an 
empty string or any default string. A specified default string will be 
overwritten when publication cross-referencing is performed. Optional 
parameters in the <$R> code may be used only when appropriate. 
Specifically, the following formats are the only valid ones. 

• [C#] or [P#]: substitute the current chapter or page number in the 
format specified for the current chapter or page. 

• [C#,label], [P#,label], [F#,label], or [T#,label]: substitute the 
chapter, page, figure, or table number of the object or position refer­
enced by label, using the format currently defined for the ob­
jectllocation's chapter or page. The label must reference a frame for 
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figure and table numbers. It may reference either a frame or a text 
marker for chapter and page numbers. 

• [C#,label,format], [P#,label,format], [F#,label,format], or 
[T#,label,format]: as described for the optional syntax immediately 
above, except that the specified format is to be used. 

• [8*]: substitute the section number string of the current paragraph. 

• [8* ,label]: substitute the section number string of the paragraph 
which holds the marker referenced by label. The label must reference 
a text marker. 

• [C* ,label]: substitute the caption label string of the frame referenced 
by label. 

• [V*,label]: substitute the variable string referenced (and already 
defined) by label. 

Reference Error Two types of error messages may be generated during cross referencing 
Messages and written to an error file with the same file name as the publication 

with the last three letters change to ERR and an extension of GEN. The 
entries in this file have the following format: 

0-12 

• XXX.CHP, page 51: No section number defined. 

This type of error indicates that a [8*] or [8* ,label] reference was 
made to a paragraph which has no active section number. 

• XXX.CHP, page 52: Unresolved reference label (LABEL 1). 

This type of error indicates that reference was made to a label which 
does not exist. 

An alert directing the user to examine the error file will appear on the 
screen if an error is encountered. 

Equations Equations are entered in a word processor exactly as you type them from 
within the Ventura Publisher equation editor. Precede the equation with 
<$E and end it with >. For example, 
<$E2-sqrt { _A{ a over 3 } cos theta sub 1 }> 

produces 

Any> character should be entered as ». 
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No attributes (e.g., <B» should be included within the equation. Use 
fon t and size instead. 

Tables Tables begin with a @Z_TBL_BEG = statement and end with a 
@Z_TBL_END = statement. The information directly after the 
@Z_TBL_BEG = statement defines the structure of the table as 
described below. Each row in the table is entered in a separate para­
graph. Each column in each row is separated by a comma followed by a 
space (type two commas followed by a space to make a comma followed 
by a space appear within a column). Ifno space follows the comma, (e.g., 
within a number) only one comma is needed. What follows is the 
definition of each element within a table. These elements should appear 
in the order shown. The example following the definitions shows the 
actual structure for this table as it appears within a word processor. 

Command Use Example 
@Z_TBL_BEG = Place at the beginning of a table. @Z_TBL_BEG = 
COLUMNS( ) Defines the number of columns in the COLUMNS(4) 

table. 

DIMENSION( ) Defines the dimensions used for the DIMENSION(IN) 
parameters which follow. IN 
specifies inches; PT specifies 
points; CM specifies centimeters; PI 
specifies picas. You can locally 
override the global setting by placing 
these parameters directly after the 
parameter. 

COLWIDTHS(Wl, W2, ... Defines the width of each cell within COLWIDTHS(.67,2.97,El), 
WN) the table. E specifies variable 

width. 

WIDTH( ) Optional parameter. Width of table if WIDTH(5.00) 
Custom is specified. 

INDENT( ) Optional parameter. Indent from left INDENT(1.00) 
column if custom width is less than 
current column width. 

ABOVE( ) Optional parameter. Space above the ABOVE(.049) 
table. 

BELOW( ) Optional parameter. Space below the BELOW(.017) 
table. 

VJTOP( ) Optional parameter. Vertical VJTOP(.015) 
justification above the table. 

VJBOT( ) Optional parameter. Vertical VJBOT(.031) 
justification below the table. 

HGUTTER( ) Optional parameter. Space between HGUTTER(.032) 
columns. 

VGUTTER( ) Optional parameter. Space between VGUTTER(.059) 
rows. 

BOX( ) Optional parameter. Tag to be used BOX( Z_DOUBLE) 
for ruling lines around. 
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Command Use Example 
HGRID( ) Optional parameter. Tag to be used HGRID(Z_SINGLE) 

for ruling lines between rows. 

VGRID( ) Optional parameter. Tag to be used VGRID(Z_SINGLE) 
for ruling lines between columns. 

KEEP( ) Breaks are allowed (OFF) or not KEEP(OFF) 
allowed (ON). 

RULE(Tag Name, Cell Optional parameter(s). Defines ruling RULE(Z_HIDDEN ,R9C2 .. R9C3) 
Range) line override for any range in the cell. 

List all ruling line overrides at the 
beginning of table in one paragraph 
separated by commas. 

LO(Cell Range), Ll(Cell Defines the line type override for a LO(R3C1..R5C5) 
Range), L2(Cell Range), line or cell. If the specified range is a 
L3(Cell Range) number of cells, attributes will apply LO = Hidden line 

only to the lines bordering the L1 = Single line 
specified range. L2 = Double line 

L3 = Thick line 

@Z_TBL_HEAD = tag1, Defines the tags for each column in @Z_TBL_HEAD = TABLE TEXT, 
tag2, ... , tagn the header row. TABLE 2, TABLE 3, TABLE 4 

@Z_TBL_BODY = tag1, Defines the tags for each column in a @Z_TBL_BODY = TABLE TEXT, 
tag2, ... , tagn row. Use before first non-header row TABLE TEXT, TABLE TEXT, TABLE 

and before any row whose tags are TEXT 
different from preceding row. A tag 
for each column must be specified. 

C1, C2, C3, C4 Data for each column in a row. Use a 1,2,3,4 
1\ character before the comma to 5,6,1\, 8 
indicate this cell is joined with the 9, 10, 11, +, + 
one above; + to indicate this cell is 
joined with cell to the right. 

<$!Bnm> Set tint for cell. Tint appears at end Ib,2b,3b,4b<$!B26> 
of cell entry. n is color, rn is pattern. 

@Z_TBL_END = Indicates the end of the table. @Z_TBL_END = 

Heading for the preceding table as it appears in a word processor. 
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@Z_TBL_BEG = COLUMNS(3), DIMENSION(IN), HGUTTER(.083), 
VGUTTER(.083), BOX(Z_DOUBLE), HGRID(Z_SINGLE), VGRID(Z_SINGLE), 
KEEP(OFF) 

@Z_TBL_HEAD = TABLE TEXT, TABLE TEXT, TABLE TEXT 

<$!Bll>, <$!Bll>, <$!Bll>, 

Command, Use, Example 

@Z_TBL_BODY = TABLE 6, TABLE 6, TABLE 6 

body of table 

@Z_TBL_END = 

Deleting null paragraphs 

Each time you press the Enter key when using the word processor, you 
create a new paragraph. If you press Enter twice in a row in order to 
place a blank line between paragraphs, Ventura Publisher creates a null 
paragraph, complete with all the space normally placed between para­
graphs. If this is not desirable, you can delete all extra carriage returns 
by using your word processor to place the following tag at the beginning 
of the text file: 

@PARAFILTR ON .-__ Enter a space after 
the equal sign. 

This must be added from within your word processor, not from within 
Ventura Publisher. The extra paragraphs will be eliminated the next 
time you load this text file or open a chapter containing the text file. 
When you save the chapter, the extra paragraphs are permanently 
eliminated. 

If you want to retain two carriage returns at a few places in a document, 
but still use the @PARAFILTR ON = feature, place a space in front of 
the second carriage return. Ventura Publisher will see carriage 
return-space-carriage return rather than two carriage returns in 
a row and will not eliminate the second carriage return. 
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ASCII text 

0-16 

Most word processors, spreadsheets, and database programs save infor­
mation in their own file format, usually identified by a unique file 
extension. For instance, Lotus 1-2-3 saves worksheets in WKS or WK1 
files, and dBase III saves databases in DBF files. Text can be moved to 
and from many of these popular programs as standard ASCII text files. 
You can load ASCII files using either the ASCII option, 8 Bit ASCII 
option, or WordStar option. Loading as an ASCII or 8 Bit ASCII file 
requires two carriage return-line feed combinations to create a new 
paragraph. Loading as a WordStar file treats single carriage returns as 
a new paragraph. Most spreadsheet and database files should be loaded 
as WordS tar files. 

Characters not used in ASCII text 

The American Code for Information Interchange (ASCII) uses seven bits 
for data and one bit for parity. This allows 128 characters. However, to 
allow for non-English and typographic characters, Ventura Publisher 
provides an 8 Bit ASCII converter which uses the parity bit as data. 
This allows the entire Ventura Publisher character set to be represented 
in a pseudo-ASCII format. Please note that ASCII characters below 
decimal 32 (except tab-decimal 9-) are not translated to or from 
Ventura Publisher. 

Text from mainframe computers 

Some ASCII files, especially those transferred via a communication 
program to your PC from mainframe computers, do not have two pairs 
of carriage return (decimal 13) and line feed (decimal 10) characters at 
the end of each paragraph ([CR][LF][CR][LF].) Additional carriage 
returns without a matching line feed (or vice versa) will cause unpre­
dictable results. 
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Spreadsheets 

Data from both DOS-based and Windows-based spreadsheet applica­
tions can be imported into Ventura Publisher. The procedures used for 
importing the spreadsheet data into Ventura Publisher is dependent on 
whether the spreadsheet application is DOS-based or Windows-based, 
the how the data is exported from the spreadsheet application. The two 
methods for importing spreadsheet data are: 

• Exporting the data from the spreadsheet application as an ACSII file, 
or via the Windows clipboard (for Windows-based spreadsheet ap­
plications). The data is then imported into Ventura Publisher as 
tabbed text. 

• Exporting the data as a space or comma delimited ASCII file and 
importing it into Ventura Publisher as a table using the PRN to 
Table option. 

Windows spreadsheet applications 

Data from Windows-based spreadsheet application can be imported into 
Ventura in two ways. The first method is to print the data to a file and 
then load the file into Ventura Publisher as a table. The second will 
import that data as tabbed text via the Windows clipboard. 

Print data to a Most Windows-based spreadsheet applications have the ability to print 
file the spreadsheet data to a file that can be loaded into Ventura Publisher 

as a table using the PRN to Table format option in the Load TextlPicture 
dialog box. Refer to the documentation accompanying the spreadsheet 
application for the procedures required for printing the spreadsheet 
data to a file. 

For those Windows-based spreadsheet applications that do not have the 
capability to print to a file as a function of the application, the data can 
be printed to a file using the Generic/Text Only Windows printer driver. 
This driver is installed in Windows using the Printer option in the 
Windows control panel. Refer to the Windows documentation for infor­
mation on installing this driver and configuring it to output to a file. 

By installing this driver and setting it to output to a file, the spreadsheet 
can be output through this driver to a file that can then be loaded into 
Ventura Publisher as a table. However, the spreadsheet must output 
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this data to the printer driver with either two spaces (space delimited), 
or a comma and two spaces (comma delimited) between each cell. This 
can generally be done by adding two spaces after the data in each cell. 
or by adjusting the column width so that two spaces will follow the data 
in each cell when the spreadsheet is printed to a file. 

Import via The Windows clipboard can be used to import data from Windows-based 
Windows spreadsheet applications into Ventura Publisher as tabbed text. To 
clipboard import the data: 

~ Open the spreadsheet application and load the desired spreadsheet. 

~ Highlight the cells containing the data you want to import into 
Ventura Publisher. 

~ Select the Paste option from the spreadsheet application's menu. 

~ If not already running, start Ventura Publisher. 

~ Load the chapter in which you want the data imported. 

~ Click on the Text tool and place the text cursor in text at the location 
you want the spreadsheet data to be imported. 

~ Click on the Paste function button. 

The spreadsheet data will be pasted into the chapter as tabbed text. The 
spacing of the data will be dependant on the tab settings set for the tag 
associated with the spreadsheet data (typically Body Text). Assign 
another tag to the data, adjust the tab settings, and format the data as 
desired. 

DOS spreadsheet applications 

Data from DOS-based spreadsheets can be saved as ASCII files using 
the spreadsheet's print-to-file option (IPF in Lotus 1-2-3.) In 1-2-3, the 
file name chosen automatically has the extension PRN added. Most 
spreadsheets, including Lotus 1-2-3, place spaces, not tabs, between 
each column and cannot be configured to automatically insert tab 
characters between columns. Therefore, when using proportionally 
spaced fonts on Ventura Publisher, the columns will not align, unless 
you manually place tabs between each column, as described in the Tabs 
section starting on page D-3. 
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When loading a text file generated by a spreadsheet application, first set 
the tab stops for Body Text to the desired positions. Then, use the Load 
TextlPictures option button to load the spreadsheet print file as a 
WordStar file. (Because each row is separated by a single carriage 
return, and because Ventura Publisher ignores single carriage returns 
in ASCII text, loading as an ASCII file would cause each line to run 
directly into the next line. In WordStar files, Ventura Publisher treats 
single carriage returns as paragraph breaks.) Finally, use the Text tool 
to delete all spaces and then insert tabs between each column in each 
row. 

A simpler solution which doesn't require inserting tabs is to simply 
change the imported spreadsheet text to Courier or some other font 
which is not proportionally spaced. This can be done by creating a new 
tag, changing its font to Courier, and then tagging the spreadsheet 
paragraph(s) with this new tag. Make sure to set the Normal Space 
Width option in the Paragraph Typography option dialog box to 1.0 
in order to get the columns to align perfectly. 
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Databases 
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Most database applications will allow you to export selected database 
information to an ASCII file using commands such as REPORT and 
LABEL. To import database information into Ventura Publisher, the 
files generated by the database application must be either comma 
delimited (a comma and two spaces are placed after the information 
from each field) or double space delimited (two spaces are entered after 
the information from each field) files. Refer to the documentation for 
your specific database application for information on generating a 
delimited ACSII file from the database application. 

ASCII files generated by database application can be imported into 
Ventura Publisher using the PRN to Table import option. 
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Word processors 

Ami Pro 

DCA 

Ventura Publisher can read and write standard Ami Pro 2.0 text files. 
Ventura Publisher automatically converts standard Ami Pro text at­
tributes into Ventura Publisher text attributes, (e.g. bold, italic, super­
script, subscript). 

Ventura Publisher cannot import Ami Pro protected text files. Save the 
file as an unprotected file before importing it into Ventura Publisher. 

Attribute Keyboard keys 
Begin/End Bold Ctrl B 

Begin/End Superscript (Special Effects) 
Begin/End Subscript (Special Effects) 

Begin/End Strike-thru (Special Effects) 
Underline CtrlU 

Discretionary Hyphen Ctrl-
Non Break Space Ctrl Space 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into Ami Pro using the < > com­
mands outlined earlier in this chapter. 

Ventura Publisher can read and write standard DCA version 2.0 files. 
Displaywrite III and Displaywrite IV can save and retrieve DCA files. 

Ventura Publisher automatically converts standard DCA text attributes 
to Ventura Publisher text attributes. 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into DCA using the < > commands 
outlined earlier in this chapter. 

Lotus To convert a Lotus Manuscript file into DCA format, follow these steps: 
Manuscript 
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~ Select File Conversion Utility from the Document ManagelMain 
Menu. 

~ Select DCA Revisable Form Export. 

~ Type the DCA file name. The RFT extension is added automatically. 

~ Press the Insert key. 

Displaywrite III To convert a Displaywrite III document into DCA, follow these steps: 

~ Select J-Document Utilities from the main menu. 

~ Select F-Convert Document from the document utility menu. 

~ Enter the Displaywrite III file name and then type the file name of 
the DCA file you wish to create. 

~ Select A-Document to Revisable Form Text. Press Enter. 

Displaywrite III automatically assigns the RFT extension to the con­
verted file name. 

Displaywrite IV To convert a Displaywrite IV document into DCA, follow these steps: 

~ Select 6-Utilities from the main menu. 

~ Select 6-Document Conversions from the utility menu. 

~ Enter the Displaywrite IV file name and then type the file name of 
the DCA file you wish to create. 

~ Select Document to Revisable Form Text. Press Enter. 

Displaywrite IV automatically assigns the RFT extension to the con­
verted file name. 

Volkswriter 3 To convert a Volkswriter 3 document into DCA, follow these steps: 
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~ Select the U utility from the main menu. 

~ Select B-Volkswriter to DCA Revisable Form Text from the 
Utility menu. 

~ Type the Volkswriter document name. 

~ Type the Converted DCA file name. The extension RF is automat­
ically assigned. 
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~ Press Enter. 

~ Answer Y to the question "Do you want to continue?" 

Office Writer To convert an Office Writer document into DCA, follow these steps: 

~ Select Convert from the main menu. 

~ Select Office Writer to DCA from the Convert menu. 

~ Type the Office Writer document name. 

~ Type the DCA file name. The extension DCA is automatically as­
signed. 

~ Press Enter. 

Note: only Office Writer version 4.0 and above support DCA. 

WordStar 2000 To convert a WordStar 2000 document into DCA, follow these steps: 

~ Select A-Additional Features from the main menu. 

~ Select Convert from the Additional Features menu. 

~ Type the WordStar 2000 document file name. 

~ Type the DCA file name. The extension RFT is automatically as­
signed. 

~ Press Enter. 

Samna Word To convert a Samna Word document into DCA, follow these steps: 

~ Press F9 from the Samna main screen. 

~ Press T (translate) from the Do What? prompt. 

~ Press D (Samna to DCA) from the Translate prompt. 

~ Press S (Samna to DCA Revisable Form). 

~ Type the name of the Samna document. 

~ Type the name of the DCA document. Type the file extension. 

~ Press Enter. 
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Microsoft Word 

Ventura Publisher can read and write standard Microsoft Word files. 
Microsoft Word style sheets are not usable by Ventura Publisher. 

Ventura Publisher automatically converts standard Word text at­
tributes to Ventura Publisher text attributes. 

Attribute Keyboard keys 

BeginlEnd Bold AltB 

BeginlEnd Superscript Alt + 

BeginlEnd Subscript Alt -

BeginlEnd Strike-thru AltS 

Underline AltU 

Discretionary Hyphen Ctrl-

Non Break Space Ctrl Spacebar 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into Microsoft Word using the < > 
commands outlined earlier in this chapter. 

Microsoft Word for WindowslWindows Write 

Ventura Publisher can read and write standard Microsoft Word for 
Windows and Windows Write files. Microsoft Word for Windows style 
sheets are not usable by Ventura Publisher. 

In order to load text files created in Windows Write, the file must be 
saved using the Microsoft Word format option. 

Ventura Publisher automatically converts standard Word text at­
tributes to Ventura Publisher text attributes. 

Attribute Keyboard keys 

BeginlEnd Bold AltB 

BeginlEnd Superscript Alt + 

BeginlEnd Subscript Alt -

BeginlEnd Strike-thru AltS 



Multimate APPENDIX D-TEXT FROM OTHER PROGRAMS 

Attribute Keyboard keys 

Underline AltU 

Discretionary Hyphen Ctrl-

Non Break Space Ctrl Spacebar 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into Microsoft Word using the < > 
commands outlined earlier in this chapter. 

Ventura Publisher will import Word for Windows text files containing 
graphics. However, the graphics will not be imported into Ventura 
Publisher, and all graphics codes will be stripped from the text file when 
the file is saved by Ventura Publisher. 

Ventura Publisher cannot load Microsoft Word for Windows documents 
saved using the Fast Save option. Before loading a Word for Windows 
document into Ventura Publisher, use the Word for Windows Save As 
option and disable the Fast Save option before saving the document. 

Multimate 

Ventura Publisher can read and write standard Multimate files. 

Ventura Publisher automatically converts standard Multimate text at­
tributes to Ventura Publisher text attributes. 

Attribute Keyboard keys 

BeginlEnd Bold AltZ 

BeginlEnd Superscript AltQ 

BeginlEnd Subscript AltW 

BeginlEnd Strike-thru AltO 

Underline Shift -
Discretionary Hyphen Shift F7 

Non Break Space AltS 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into Multimate using the < > 
commands outlined earlier in this chapter. 
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WordPerfect 

WordStar 

Ventura Publisher can read and write WordPerfect version 4.1 or 4.2 
files using the WordPerfect 4 option in the Load TextIPicture option 
dialog box. Use the WordPerfect 5 option to load version 5.x files. 

Password protected WordPerfect files cannot be imported into Ventura 
Publisher. In order to import a WordPerfect file that is password 
protected, you must first open the text file in WordPerfect, save the text 
file under a different name as a non-password protected file, and then 
import the new file. 

Ventura Publisher automatically converts standard WordPerfect text 
attributes to Ventura Publisher text attributes. 

Attribute Keyboard keys 

BeginlEnd Bold F6 

BeginlEnd Superscript Shift Fl 

BeginlEnd Subscript Shift Fl 

BeginlEnd Strike-thru AltF5 

Underline F8 

Discretionary Hyphen Ctrl 

Non Break Space Home 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into WordPerfect using the < > 
commands outlined earlier in this chapter. 

Ventura Publisher can read and write standard WordStar 3.3, 3.4, 4.0, 
and 5.X files. Other versions of WordS tar may also work. 

Ventura Publisher automatically converts standard WordStar at­
tributes to Ventura Publisher text attributes. Ventura' Publisher also 
reads all WordStar dot commands as text, so you should eliminate these 
codes from the text file before loading the file into Ventura Publisher. 
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Attribute Keyboard keys 

Start/Stop Bold Ctrl B 

Start/Stop Superscript Ctrl T 

Start/Stop Subscript Ctrl V 

Start/Stop Strike-thru CtrlX 

Start/Stop Underline Ctrl S 

Discretionary Hyphen Soft hyphen 

Non Break Space CtrlO 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into WordStar using the < > 
commands outlined earlier in this chapter. 

Foreign characters entered in WordStar 3.4 which are not available in 
both the Ventura Publisher and the IBM character sets will not display 
or print. 

WordStar tabs When you press the tab key, WordStar does not always place a tab 
character into the text, but instead inserts multiple spaces. As described 
earlier in this chapter, Ventura Publisher requires the actual tab char­
acter in order to correctly format tabular information. If you use Word­
Star 3.0, turn the Vari-Tab feature within WordS tar Off. When using 
WordStar 4.0 or 5.X, use the non-document mode and type Ctrl + PI for 
a tab character. The tab character will not display on the screen, but it 
will be inserted in the text and recognized by Ventura Publisher as a tab. 

Xywrite 

Ventura Publisher can read and write standard Xywrite II and Xywrite 
III files. 

Ventura Publisher automatically converts standard Xywrite text at­
tributes to Ventura Publisher text attributes. 

All other attributes, attribute combinations, footnotes, index references, 
and text characters must be entered into Xywrite using the < > com­
mands outlined earlier in this chapter. 
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APPENDIX E 
CHARACTER SETS & CODES 

Ventura Publisher includes two character sets: 

• An international character set which includes characters for many 
languages, including English, Spanish, French, and Italian. 

• A symbol character set which includes mathematics and Greek char­
acters which can be used for simple formulas and equations. 

Not all of these characters can be typed directly from the keyboard. 
Characters not available on your keyboard can be entered from inside 
Ventura Publisher by holding down the Alt key and then typing the 
ANSI equivalent for that character, or by entering the Decimal code 
into the text file using your word processor. The tables on the following 
pages show both the decimal and ANSI equivalents. Ventura Publisher 
provides a number of shortcut keyboard entries for more commonly used 
symbols (e.g., © and ®). It is recommended that you use these shortcut 
entries instead of the ANSI code whenever possible. Refer to page 2-15 
for a complete listing of the shortcut characters provided by Ventura 
Publisher. 

The interpretation of the keys entered from the keyboard is a function 
of Windows and not of Ventura Publisher. Windows reads all keyboard 
entries as ANSI code characters and passes the code to Ventura Publish­
er. To enter characters not available on the keyboard, press the Alt key 
and enter the ANSI equivalent of the desired character. You must enter 
the full ANSI code as it is listed in the table on the following pages. 

The ANSI code must be entered using the numeric keypad. The ANSI 
code cannot be entered using the number keys across the top of the key­
board. 

The ANSI code character set is used only when entering characters from 
the keyboard while you are in Ventura Publisher. It is important to note 
that a character entered into a chapter file using the Alt + ANSI code 
combination will be translated to the decimal code equivalent of that 
character when the text file is saved. For example, to enter an accented 
lowercase E (e) from the keyboard while in Ventura Publisher, you would 
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press and hold the Alt key and enter the ANSI code 0233 on the 
keyboard number pad. When the text file is saved and opened in your 
word processor, the ANSI code (0233) entered inside Ventura Publisher, 
is saved in the text file as the decimal equivalent and appears as <130>. 

Decimal code Ventura Publisher uses the decimal code character set when reading 
and interpreting characters entered into a text file in a word processor. 
These characters are entered into your text file by enclosing the Decimal 
equivalent of the desired character in brackets. When the text file is 
read into Ventura Publisher, the decimal numbers contained in brackets 
are converted to the corresponding character. Use the decimal code only 
when entering these character directly into the text file using your word 
processor. 
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When using your word processor to enter foreign characters and other 
characters above decimal 127 , you must enter these characters by using 
the < > codes, as explained in Appendix D. For word processors which 
support foreign characters, Ventura Publisher will accept these charac­
ters without placing numbers inside of < >. However, the decimal 
equivalent of these characters must be less than 169, and the foreign 
characters in your word processor must have the same decimal 
equivalents as those shown on the following pages. For characters above 
169, use the decimal code inside of brackets, e.g., <185> for §. 
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Ventura Publisher character set 

Decimal ANSI Inter- Symbol national 

32 032 

33 033 ! ! 

34 034 II V 

35 035 # # 

36 036 $ :3 

37 037 0/0 % 

38 038 & & 

39 039 
, 

;) 

40 040 ( ( 

41 041 ) ) 

42 042 * * 
43 043 + + 
44 044 , , 

45 045 - -

46 046 

47 047 / / 

48 048 0 0 

49 049 1 1 

50 050 2 2 

51 051 3 3 

52 052 4 4 

53 053 5 5 

54 054 6 6 

55 055 7 7 

56 056 8 8 

Decimal ANSI Inter-
national 

57 057 9 

58 058 

59 059 , 

60 060 < 
61 061 = 
62 062 > 

63 063 ? 
64 064 @ 

65 065 A 

66 066 B 

67 067 C 

68 068 D 

69 069 E 

70 070 F 

71 071 G 
72 072 H 

73 073 I 

74 074 J 
75 075 K 

76 076 L 

77 077 M 

78 078 N 

79 079 0 

80 080 P 

81 081 Q 

M,,~I"'UI" L. 

Symbol 

9 

, 

< 

= 
> 
? 

-

A 

B 

X 

~ 

E 

<I> 

r 
H 

I 

t} 

K 

A 

M 

N 

0 

II 

e 
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Decimal ANSI Inter- Symbol 
national 

Decimal ANSI Inter- Symbol 
national 

82 082 R P 109 0109 m ~ 

83 083 S L 110 0110 n V 

84 084 T T 111 0111 0 0 

85 085 U y 112 0112 P 1t 

86 086 V ~ 113 0113 q e 
87 087 W Q 114 0114 r p 

88 088 X ... 
~ 115 0115 S (j 

89 089 Y \{' 116 0116 t 't 

90 090 Z Z 117 0117 U U 

91 091 [ [ 118 0118 V rn 
92 092 \ .. 119 0119 W 0) 

93 093 ] ] 120 0120 X ~ 
94 094 A. ..1 121 0121 Y W 
95 095 - - 122 0122 Z C; 

-
96 096 

, 
123 0123 { { 

97 097 a a 124 0124 I I 
98 098 b P 125 0125 } } 

99 099 C X 126 0126 ,.., -
100 0100 d 8 127 0127 

101 0101 e E 128 0199 Y 
102 0102 f <I> 129 0252 0 1 

103 0103 9 y 130 0233 e I 

104 0104 h 11 131 0226 a ~ 

105 0105 i t 132 0228 a / 

106 0106 j <p 133 0224 a 00 

107 0107 k K 134 0229 a f 
108 0108 I A 135 0231 <; ... 
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Decimal ANSI Inter- Symbol 
national 

Decimal ANSI Inter- Symbol 
national 

136 0234 e • 163 0250 U go 
137 0235 e • 164 0241 n ® 

138 0232 e • 165 0209 N Ef) 

139 0239 'I' H 166 0170 ~ 0 

140 0238 I ~ 167 0186 Q (l 

141 0236 I t 168 0191 i U 

142 0196 A ~ 169 0147 " ::J 

143 0197 A J, 170 0148 " d 

144 0201 E 0 171 0139 * 
< c:t. 

* 145 0230 ce ± 172 0155 > C 

146 0198 ,lE " 173 0161 i C 

147 0244 6 ~ 174 0171 « E 

148 0246 <5 X 175 0187 » e: 
149 0242 0 oc 176 0227 a L 

150 0251 a a 177 0245 6 V 
151 0249 U • 178 0216 (2} ® 

152 0255 Y 179 0248 0 © 

153 0214 b * 180 0156 * TM 00 

154 0220 0 - 181 0140 (E* II 
155 0162 ¢ ::::; 182 0192 A -V 

156 0163 £ ,., 183 0195 A 
157 0165 ¥ I 184 0213 <5 --, 

158 0164 a - 185 0167 § A. 

159 0136 f .J 186 0135 :f:* v 

160 0225 a ~ 187 0134 t * ~ 

161 0237 f 3 188 0182 ~ <== 
162 0243 6 9\ 189 0169 © 11 
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190 0174 ® ~ 

191 0153 TM V. 
192 0132 

" 
0 

193 0133 
'" ( 

194 0137 %0 * ® 

195 0149 • * © 

196 0150 - TM 

197 0151 - L 
198 0176 0 ( 
199 0193 A I 
200 0194 A _l 
201 0200 E r 
202 0202 E I 
203 0203 E L 
204 0204 1 r 
205 0205 f i 
206 0206 i l 
207 0207 'I' I 
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Decimal ANSI Inter- Symbol national 

208 0210 0 
209 0211 6 ) 

210 0212 6 J 
211 0138 s* ( 

212 0154 v * I S 

213 .0217 CJ ) 

214 0218 U 1 
215 0219 0 I 
216 0159 .. * ) y 
217 0223 B l 
218 Z I 
219 Z J 
220 / 1 
221 r 
222 J 

* In order to access these characters using the ANSI 
code, you must have Adobe Type Manager (version 
2.0 or above), Bitstream FaceLift (version 2.0 or 
above) or TrueType fonts installed and active. 



Text codes 

Text codes 

A complete description of the text codes is provided in Appendix D. 

Text attributes Codes 
Box (Hollow) (Filled) <$BO> <$B1> 

Base Line JumJ2 <Jnnn> 
BeEinlEnd (%0) Kemin£! <%n> 

Bold wei£!ht type <B> 
Color index <Cnnn> 

Double underline <=> 
Italics <1> 

Line Break <R> 
Medium wei£!ht type <M> 

Overscore <0> 
Point Size <Pnnn> 

Resume Normal <D> 
Small <S> 

Strike-thru <X> 
Subscript <v> 

Superscript <"> 
Tvpeface <Fnnn> 

Underline <U> 
8Daces 

Em space < > 
En space <-> 

Fi£!Ure Space <+> 
Non-Breakin£! Space <N> 

Thin Space <I> 
Inserted text 

Discretionary Hyphen <-> 
Footnote <$Ftext> 
Fractions <$E 1/2 > or <$E lover 2 > 

Hidden text <$!text> 
Index <$1 primaryIsort];secondaryLsort]> 

Page number (chapter number C#) <$R[P#]> 
Picture anchor (below) <$&anchor name[v]> 

Picture anchor (same pa£!e) <$&anchor name> 
Picture anchor (above) <$&anchor name[A]> 

Picture anchor (automatic) <$&anchor name[ -]> 
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APPENDIX F 
PRINTER INFORMATION 

This appendix provides important additional information about your 
printer. 

General limitations 

YOUR PRINTER MAY NOT BE CAPABLE OF PRINTING 
EVERYTHING YOU SEE ON THE COMPUTER SCREEN. 

Speed, resolution, maximum picture size, character set, and unprint­
able space at the edge of the page are different for each printer. Also, the 
document may not be centered on the page due to manufacturing 
tolerances in your printer. 

How to see your To see the limitations of your printer, print the chapter called CAPABILI 
printer's limits (contained in the TYPESET directory, if you installed the example files). 

Printer troubleshooting 

Wrong font sizes in pictures 

On printers which do not use a page description language or scalable 
font technology (e.g., dot matrix printers), the fonts which appear in line 
art can only be discrete sizes. Therefore, when the picture is imported 
or scaled, the fonts may be slightly too large or too small for the picture. 
Solution: 

> Make the picture slightly larger or smaller. 
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> Better yet, don't put text in pictures. Instead, attach box text to the 
frame which contains the illustration and use the considerable typo­
graphic power of Ventura Publisher to produce annotations for your 
pictures. 

Headers or footers disappear 

Ifheaders & footers don't appear on the printed page, this most likely is 
caused by your printer not being able to print all the way to the edge of 
the page. The solution: increase the above and below space for the 
header and footer tags. You can also compensate for the blank space at 
the edge of the page by adjusting the margins. 

Graphics will not print on an HP laser printer 

In order for graphics to print on an HP LaserJ et, the printer setup must 
be properly configured. Check the Windows printer setup settings for 
the HP printer as follows: 

> Select the Printers option in the Windows Control Panel. 

The Printers dialog box is displayed. 

> Select the HP printer from the list of Installed Printers. 

> Select the Configure button. 

The Printers - Configure dialog box is displayed. 

> Select the Setup button. 

The PCL / HP LaserJet settings dialog box is displayed. 

> Check the following settings: 

- Make sure the Graphics Resolution option is set to 300 dots 
per inch. 

- Make sure the correct printer type is selected for the Printer 
option. 

- Make sure the Memory option is set for the proper amount of 
memory installed in your printer. 
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> Select the OK button in each dialog box until you have exited from all 
dialog boxes. 

Another problem that may cause graphics not to print on an HP Laser­
Jet printer is the lack of a SET TEMP= line in your AUTOEXEC.BAT 
file or insufficient disk space for the temporary file to be stored. 

Nothing prints from any program 

If nothing will print to your printer from any program in Windows, the 
following steps will help to isolate the problem. Some of the latter steps 
are printer specific. After each step, try the print operation again before 
continuing to the next step. 

Verify settings Use the Printers option in the Windows Control Panel and verify that 
the settings (e.g., printer type, print resolution, printer memory, port 
configuration, etc.) for the printer are correct. Go through each available 
option and verify the settings. 

Printer self-test Refer to the printer documentation and perform the printer self-test, if 
your printer has one, to see if the basic printer mechanism is working. 
This causes the printer to print one or more pages. If nothing happens 
in this self-print mode, consult your printer manufacturer or dealer for 
further help. Also check the printer's configuration switches as outlined 
in the printer manufacturer's documentation. 

Temporary files Using the Windows Notepad, Sys Edit, or other ASCII text editor, make 
sure that a SET TEMP= line is present in your AUTOEXEC.BAT file. 
This line tells Windows and Windows applications where to put tem­
porary files they create. If the SET TEMP= line is not present, enter it 
in the AUTOEXEC.BAT file. The line should include the drive and path 
in which Windows and Windows applications are to store the temporary 
files they create. For example: 

SET TEMP=C:\TEMP 

would cause Windows and Windows applications to store the temporary 
file in the TEMP directory of the C drive. 

After this line is entered in the AUTOEXEC.BAT file, you will have to 
quit Windows and reboot your computer for the changes to take effect. 
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The drive selected should have at least 2 megabytes of free disk space 
available while Windows is running. To verify the available disk space 
on the hard drive while Windows is running, run the Windows File 
Manager and select the drive on which the temporary files are to be 
stored. The amount of free disk space will be displayed at the bottom of 
the File Manager window. 

MODE command If your printer is connected a serial port on your computer, you may have 
to enter a DOS MODE command to initialize the printer port. The 
MODE command should be entered at the DOS prompt as: 

MODE port:9600,8,1,n 

replace port with the correct COM port on which the printer is connected 
(e.g., COMl, COM2). If this solves the problem, this command can be 
entered into your AUTOEXEC.BAT file so that the printer port will 
automatically be initialized each time you boot the computer. 

Printer cabling Another problem may be in the printer cable itself. Disconnect the cable 
from the printer and count the number of pins. If the connector has 36 
pins, it is a parallel cable, and the cable is probably not the cause of 
your problems. If the connector has 25 pins, it is a serial cable, and you 
may not have the correct cable. Many people try to connect the laser 
printers to their computer with a standard serial cable that has the right 
set of connectors, but is not wired as required by a laser printer. Most 
printers which use a serial cable use one which is wired similarly to a 
null modem cable. The correct wiring diagrams for HP LaserJet and 
Apple LaserWriter cables are shown in figures F-2 and F-l. 
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Computer 

Computer 
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25 pin to 25 pin 
Adaptor Cable 

Female Connector Male Connector 

[D-------IC]] 

Female Connector Male Connector 

Chassis Gnd 1 ............ 1 Chassis Gnd 

TD 2··········· . 3 RD 

RD 3··········· . 2 TD 

CTS :.~ ........ 20 DTR 

DSR 

DTR 20 ········C·: CTS 

DSR 

Signal Gnd 7 ............ 7 Signal Gnd 

Printer 

Figure F-2. Wiring diagram for 25 pin to 25 pin adaptor cable. 

Female Male 

9 pin to 25 pin 
Adaptor Cable 

Female Male 

Female Male 

25 pin to 25 pin 
Printer Cable 

Female Male 

Printer 

Chassis Gnd NC······ 1 1 ...... Chassis Gnd 

TO 3····· . 2 2 ...... 3 RO 

RO 2····· . 3 3 ...... 2 TO 

CTS 8····· . 5 :~ ... 20 OTR 

OSR 6 6 
Signal Gnd 5····· . 7 7 ...... 7 Signal Gnd 

Figure F-l. Wiring diagram for 9 pin to 25 pin adaptor cable. 

Nothing will print on a PostScript printer 

If nothing will print to your PostScript printer from any program, and 
the procedures discussed previously do not rectify the problem, the 
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PostScript 
Header 

PostScript header or the handshake settings may be set incorrectly. The 
following paragraphs describe how to verify these settings and correct 
them if they are set incorrectly. 

The header is necessary for Windows to properly print to your Post­
Script printer. The header can be downloaded one of two ways; either at 
the beginning of each print job, or you can download the header once 
after the printer has been turned on. The following paragraphs describe 
how to setup Windows for each of these download options. 

The default and recommended setting is to download the header at the 
start of each print job. If you are printing to a PostScript printer over a 
network, or printing to a PostScript file the header must be download 
at the start of each job. If you are in doubt as to which option to select 
or are unfamiliar with copying files directly to printer ports, select this 
option. 

Download at the start of each print job 

If the header is set to download at the start of each job, Windows will 
automatically download the header for you when you print to a Post­
Script printer. The automatic downloading of the header will add only a 
few seconds to each print job. To set the header to download at the start 
of each print job: 

~ Select the Printer Setup option from the Ventura Publisher File 
menu. 

~ Select the appropriate PostScript printer option from the Printers 
list and select the Setup button. 

~ Select the Options button to display the Options dialog box. 

~ Set the Header option to Download each job. 

~ Select the OK button in each dialog box to save your settings and 
return to Ventura Publisher. 

Download once when printer is turned on 

If this option is selected, Windows will not download the header, but will 
expect it to be manually downloaded to the printer. This option will save 
a couple seconds at the start of each print job. 
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To use this option, you must write the PostScript header to a file and 
then copy the header file to the printer each time the printer is turned 
on. 

This option should not be used if you are printing over a network or 
printing to a PostScript file. 

> Select the Printer Setup option from the Ventura Publisher File 
menu. 

> Select the appropriate PostScript printer option from the Printers 
list and select the Setup button. 

> Select the Options button to display the Options dialog box. 

> Set the Header option to Already Downloaded. 

> Select the Header button. 

The Header dialog box is displayed. 

> Set the Send Header to option to File. Select the OK button. 

A dialog box is displayed prompting you for a path and file name for 
the header file. 

> Enter the complete path and file name for the header file. Select the 
OK button. 

The header file is written to disk and the Options dialog box reap­
pears. 

> Select OK in each dialog box to save your settings and return to 
Ventura Publisher. 

The generated header file must be copied to the printer each time the 
printer is turned on. The file can be copied to the printer by entering the 
following command line at the DOS prompt, in the AUTOEXEC.BAT 
file, or in a batch file. 

COpy d:\path\filename COMx: 

Where d: \pa th \ is the complete drive and directory where the header 
file is located, filename is the name you selected for the file when it 
was generated, and COMx is the printer port on whIch the printer is 
connected (e.g., COMl, COM2). 
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When the header is successfully downloaded to the printer, a page will 
be printed with the message "Windows PostScript header loaded" ap­
pearing at the bottom. 

Handshaking The handshake setting determines how the printer and the computer 
printer port communicate with each other. Normally the default settings 
should be correct; however, if you are experiencing problems printing 
and have not been able to isolated the problem, the handshake setting 
should be changed as follows: 

F-8 

~ Openthe Windows Control Panel and double-click on the Ports icon. 

~ Select the port on which the printer is connected and select the 
Settings button. 

~ Unless you are certain that the setting should be different, ensure the 
options are set as follows: 

Baud Rate 9600 

Data Bits 8 

Parity None 

Stop Bits 1 

~ Set the Flow Control option to XonIXoff. Select the OK button in 
each dialog box until the Control Panel is displayed. 

~ Double-click on the Control Panel Printers icon. 

~ Select the appropriate PostScript printer from the Installed 
Printers option and then select the Configure button. 

The Printers - Configure dialog box is displayed. 

~ Select the Setup button from the Printers - Configure dialog box. 

The printer setup dialog box is displayed. 

~ Select the Options button from the printer setup dialog box. 

The Options dialog box is displayed. 

~ Select the Handshake button from the Options dialog box. 

The Handshake dialog box is displayed. 

~ Set the Set Handshake to option to Software. Select the OK 
button. 
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~ When the dialog box asking to permanently alter the printer's hand­
shaking is displayed, select the OK button. 

When the handshaking is successfully changed, a page will be printed 
with a message acknowledging that the software handshake setting 
has been enabled. 

~ Select OK in each dialog box until the Control Panel is displayed. 
Close the Control Panel. 

Paper size Ventura Publisher and the HP LaserJet handles 8V2 X 11 inch, 8li2 X 14 
inch, and A4 (21.0 X 29.7 centimeters) paper. The LaserJet 2000 sup­
ports B5 and Double in addition to these sizes. However, the LaserJ et 
cannot print to the edge of the page. This means that text and pictures 
placed near the edge of the page will show correctly on the computer 
screen, but may not print as displayed. Also, the document may not be 
centered on the page due to manufacturing tolerances. To see the 
amount of blank space around the edge of the page on your printer, as 
well as the offset from center, print the CAPABILI.CHP chapter in the 
TYPESET directory. You can compensate for the offset by adjusting the 
left and right margins. You can avoid disappearing headers and footers 
by changing the above and below space for the header and footer tags. 

Fonts are loaded by Windows into the HP LaserJet Plus as needed for 
each page. The space taken by these fonts decreases the space available 
for pictures. If a page contains many big pictures, and a large number 
of different fonts-especially larger size fonts-the LaserJet runs out of 
memory and displays error 20 (LaserJet Plus) in the status display. To 
continue printing, press the CONTINUE button on the front of the 
LaserJet, and place the printer back on-line, if necessary. The LaserJet 
attempts to print at least a portion of the page. Unless a similar problem 
exists on the following pages, the remaining pages should print correct­
ly. 

Once an out of memory error has occurred, you must simplify the page 
that caused the problem in order to print the problem page. To simplify 
the page, do one or more of the following: 

~ Reduce the size or number of fonts used on the problem page. 

~ Reduce the number or size of pictures on the problem page. 
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~ Add more memory to your printer. 

Draft printing You can use the LaserJet printer to produce draft copies of documents 
which will ultimately be printed on a typesetter or other printer. If you 
use the width table for the ultimate device but print directly to the 
LaserJet, each line will end at the correct location and the amount of 
text on each page will match the ultimate printout. 

F-10 

LaserJet limitations 

The LaserJet printers have the following limitations: 

• The LaserJet Plus and Series II printers cannot print both portrait 
and landscape fonts on the same page. Therefore, the rotated text 
feature (Alignment option) cannot be used with these LaserJ et 
printers. The LaserJet Series III does not have this limitation. 

• The LaserJet Plus and Series II printers cannot print white text on a 
black background. The LaserJet Series III does not have this limita­
tion. 

• The LaserJet Plus cannot print text larger than 36 points. The 
LaserJ et Series II and Series III do not have this limitation. 

• The LaserJet Plus and Series II printers cannot print opaque images 
which obscure the text or pictures below. The LaserJ et Series III does 
not have this limitation. 

• The LaserJet prints text, or lines drawn using any of the graphic 
tools, in 100% black only. It cannot print these objects in shades of 
gray. The LaserJet Series III does not have this limitation. 

• More than 512K memory may be required to print pages which 
contain a large number of fonts. 
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PostScript 

Resolution Text and graphics print at different resolutions, depending on the 
capability of the specific device. For instance, you will get 300 dots per 
inch resolution with the LaserWriter, IBM, and other "desktop" printers, 
1270 dots per inch for the Linotronic 100, and 2540 dots per inch for the 
Linotronic 300. 

Fonts Initially, only the fonts which are stored permanently in your printer 
can be printed by Ventura Publisher. For most PostScript printers this 
includes: 

Helvetica Times Roman 
Symbol Courier 

Avant Garde Bookman 
Century Schoolbook Helvetica Narrow 

Palatino Zapf Chancery 

ZapfDingbats 

However, other fonts can be installed in Windows for the PostScript 
printer. These fonts will automatically be included in any dialog box 
displaying a font option after the width table for the PostScript printer 
is rebuilt. Refer to Appendix I for more information on installing fonts 
and building width tables. 

Printing to a file You may find it useful to print to a disk file and then later send this disk 
to the printer or typesetter. The methods for doing this are covered in 
the Putting It Together chapter (Chapter 15). 

Draft printing 

You can use your PostScript printer to produce draft copies of documents 
which will ultimately be printed on a non-PostScript typesetter or other 
printer. If you use the width table for the ultimate device but print 
directly to your PostScript printer, each line will end at the correct 
location and the amount of text on each page will match the ultimate 
printout. 
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PostScript limitations 

Transparent PostScript cannot print transparent overlapping graphics. This means 
graphics that if one graphic overlaps another, the graphic on the bottom will 

always be completely obscured. 

Ruling line Because PostScript cannot print transparent overlapping graphics, a 
around images ruling box around an image will not print. The solution is to set the 

frame margins equal to the overall ruling box height. 
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PICTURES 

This appendix describes limitations inherent in the process of convert­
ing from a variety of different graphic formats into Ventura Publisher's 
internal graphic format. This chapter also includes other important 
information about pictures. 

AutoCAD pictures 

DCS 

CGM 

Ventura Publisher converts slide files from AutoCAD. AutoCAD .SLD 
files are created using the AutoCAD ADE (Advanced Drafting Exten­
sion) package. The AutoCAD MSLIDE command is used. The use of this 
command is covered in the AutoCAD User Reference manual. Refer to 
the AutoCAD Reference Manual index under Slides. Better resolution 
can be obtained by configuring AutoCAD's plotter option for a Hewlett­
Packard plotter and then plotting your drawing to an HPGL format file. 

DCS (Desktop Color Specification) format pictures are pre-separated, 
CMYK, pictures produced by high-end graphics programs including the 
ColorPro color extension product. 

Ventura Publisher converts CGM files. Key features and limitations 
include: 

• All typefaces are converted to Helvetica. 

• Colors are retained. 

• Pattern fills are converted based on the GSS CGI definition .. 
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EPS 

Ventura Publisher converts EPS files. Key features and limitations 
include: 

• EPS files will display on screen only if the EPS file includes either a 
TIFF or Windows metafile description of the PostScript image. Other-
wise, a large X is placed in the frame. 

• EPS files can only be printed to PostScript printers. However, if the 
EPS file includes either a TIFF or Windows metafile description of 
the PostScript image, then this image will print to non-PostScript 
printers. The resolution of this image depends on the quality of the 
TIFF or Windows metafile representation. 

• All colors in the EPS file are retained. Ventura Separator provides 
additional features when loading EPS files containing colors. 

• A PostScript file must be specifically made into an Encapsulated 
PostScript file. The rules for converting PostScript files can be ob­
tained from Adobe Systems Technical Support. Write: 

Technical Support 
Adobe Systems 
1870 Embarcadero Road 
Palo Alto, CA 94303 
USA 

Tagged information file format (TIFF) 

Ventura Publisher supports the importing of TIFF format files, includ­
ing gray-scale and 24-bit color TIFFs. It may take considerable time to 
redraw a page containing a TIFF file (particularly 16- and 24-bit TIFFS) 
since Ventura Publisher will always display the TIFF file at the highest 
possible resolution. If you load TIFF files into a chapter, you should hide 
the images when not actually working with the image. This will greatly 
reduce the time it takes Ventura Publisher to redraw a page containing 
a TIFF file since Ventura Publisher will not be required to display the 
TIFF file. 

Displaying When a gray-scale TIFF file is loaded into a Ventura Publisher chapter. 
gray-scale TIFF Ventura Publisher will attempt to display the TIFF file as a gray-scale 

files image instead of a dithered black and white image. The properties of the 
graphics card and the driver installed in Windows determine if a gray-
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scale image will display as a gray-scale on the screen. In order for a 
gray-scale TIFF image to display gray-scale, one of the following criteria 
must be met. 

• The graphics card and installed driver are capable of displaying 
32,565 or more colors. 

• The graphics card and installed driver display 256 colors or less, but 
are gray-scale instead of color devices. 

• The graphics card and installed driver display 256 colors or less, but 
the driver provides 3 shades of gray plus black and white to the 
Windows palette. 

The best way to test if your graphics system is capable of displaying gray 
scale in Ventura Publisher is to load the file POT4. TIF included on the 
EXAMPLES Ventura Publisher program disk. If this image displays on 
the screen as a gray-scale image, other TIFF images containing gray­
scale information will display as gray-scale. If the image appears as a 
black and white dithered image, your graphics system is not capable of 
displaying gray-scale. 

The Hewlett-Packard Graphics Language (HPGL) is a two-letter 
mnemonic graphics language which is used to by many applications to 
send graphic pictures to plotters. If an application program is told to 
send the output to a file instead of the plotter, an HPGL file is created 
which can be loaded into Ventura Publisher using the Load TextlPic­
ture option. 

The technology used in plotters is quite different from that used in laser 
printers and typesetters. Therefore, when translating pictures from 
HPGL, Ventura Publisher must make many assumptions about which 
plotter was originally used, how the plotter was configured, and many 
other factors. While the default assumptions built into Ventura Publish­
er provide adequate results for many uses, you can override the defaults 
by using the dialog box shown in the following figure. The application of 
each setting in the dialog box is described below. 
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Figure G-l. HPGL dialog box. 

Plotter-Paper The Plotter Type and Paper Size options let you communicate to 
Ventura Publisher both the plotter model and paper size to which the 
HPGL picture was originally to be sent. If you are unsure, select HP 
7475A -- U.S.A. 

The HPGL conversion process was optimized for the HP 7475A plotter. 
Therefore if you have an option, select the 7475A as the output device 
when originally creating the HPGL picture. If you cannot create the 
image for the 747 5A, then if the plotter selection in this dialog box does 
not match the plotter for which the image was intended, you may find 
that the image is clipped or flipped. 

Plotter mode The Mode option controls interpretation of the User Defined Character 
Instruction (UC). The normal setting is Standard. If your plotter was 
set for enhanced when the picture was originally printed, you may want 
to change this setting to Enhanced, especially if user-defined charac­
ters don't print at all or print incorrectly. 

Input window The Input Window Commands option enables (On) or disables (Off) 
the clipping rectangle specified by the Input Window (IW) instruction. 
The normal setting is Off. If you find that parts of the picture appear in 
the Ventura Publisher frame which were outside the original plotted 
copy of the picture, enable the Input Window Commands option. 
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Rotation The Paper Rotation Commands option uses (enabled) or ignores the 
Rotate Coordinate System Instruction (RO). The RO command is only 
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supported for the 7475 plotter in U.S. sizes Aand B. If you find that parts 
of the picture appear rotated and other parts do not, enable this option. 

Pen number The Pen Number option lets you select each of 16 pens. For each pen, 
you can select the pen color and pen width. Thus, you can define how 
each color in the plotted version of the picture should be transformed to 
the printed version. 

Pen color You can select a different color for each of the pen from the Color list 
box. Color options other than black and white will produce different 
colors on a color printer, and these colors cannot be customized. When 
printing from Ventura Publisher to a black and white printer, these 
colors will be mapped to shades of gray, depending on the printer 
selected. Colors are not converted to gray when printed to a color printer 
or separated using the Ventura Separator color extension product. 

Pen width The thickness of each pen can be individually specified. 

If the fill pattern with objects in a pictures looks different than you ex­
pect, experiment with thicker pen widths. 

If only one pen is used for the entire drawing, then making this pen 
thicker may make the fill pattern look better but may degrade the rest 
of the picture. You may need to experiment to find the best setting. Also, 
if several pens are used, you may need to experiment to discover which 
pen thickness controls which part of the drawing. 

Save as new Once you have customized your HPGL settings, you can save them for 
default settings future conversions. Simply select the Save As button and the current 

settings will automatically be retrieved the next time you load an HPGL 
image. The current default settings are saved in the HPGL.PRF file in 
the VENTURA directory. 

The settings used for each picture are stored in a file with the same 
name as the picture but with the extension PRF. This file is copied by 
the Manage Publication option dialog box Copy All command so that 
if the picture later is reconverted, the HPGL Converter Settings dialog 
box will appear, however, the settings will be the same as when the 
HPGL file was previously converted. 

Text The Ventura Publisher HPGL conversion converts all text into "stroked" 
text. This means that the letters will appear to have been drawn with a 
plotting pen. Part (although not all) of the reason that HPGL conver-
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sions take longer than other graphic conversions is due to the time 
needed to create each letter at the appropriate size. The character 
conversion was implemented using Bitstream's Courier font which 
means the fonts have serifs. Also, fonts have thickness which is control­
led by the Pen Width setting. 

The stroked font information is contained in the HPGL.BFF file. If you 
delete this file, text conversion will be done using bitmaps, similarly to 
the way it was done in earlier versions of Ventura Publisher, although 
since fonts are drawn differently than before, you won't get an exact 
match to Ventura Publisher version 2.0. 

The following commands are supported in this release. This command 
set fully supports 7440, 7470, and 7475 type plotters. 

HPGL Full name Description Mnemonic 

AA Arc absolute Chord angle in degrees. 

AR Arc relative Chord angle in degrees. 

CA Alternate set 

CI Circle Chord angle in degrees. 

CP Character Plot 

CS Standard set 

DF Set default 
values 

DI Absolute 
direction 

DR Relative 
direction 

DT 
Define label Any character except ESC 
terminator and; 

EA 
Edge rectangle 

Always solid line style. 
absolute 

EP Edge polygon 
Only RA,RR,EA,ER,WG,EW 

supported. 

ER 
Edge rectangle 

relative 

EW Edge wedge 

FP Fill Polygon Only RA,RR,EA,ER,WG,EW 
supported. 
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HPGL Full name Description Mnemonic 

Parallel hatches only 
su pported at 

FT Fill Type Odeg,+45deg,90deg. Hatch 
spacing not supported. Cross 

hatches supported at 
0,45,90,-45 degrees. 

IN Initialize 

IP Input PI P2 

IW Input window 

LB Label string 

Pattern length is not 
supported. Adaptive line 

LT Line type types are drawn the same as 
fixed line types. Does not 

affect EA,ER. 

PA Plot absolute 

PD Pen down 

PG Page feed 
Does not support multiple 

pages. 

PR Plot relative 

PU Pen up 

RA 
Fill rectangle 

absolute 

Rotate 
RO coordinate Supports 0,90 degrees. 

system 

RR 
Fill rectangle 

relative 

SC Scale Supports types 0,1,2. 

SI 
Absolute 

character size 

SL 
Character 

slant 

SM Symbol mode 

SP Select Pen 
Supports 1-16 with control 

over color and width. 

SA 
Select 

alternate set 

SR 
Relative 

character size 
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l~iC Full name Description 

SS Select 
standard set 

TL Tick length 

UC 
User defined Supports Enhanced mode or 

character standard mode. 

WG Fill wedge 

XT X tick 

YT Ytick 

The following commands are NOT supported in this release. 
Unsupported features of 7550 type plotter are: 

HPGL Full name 
Mnemonic 

BF Buffered plot 

BL Buffered label 

CC Character chord angle 

CM Character selection mode 

CT Chord tolerance 

CV Curved line generator 

DL Downloadable character 

DS Designate character set into slot 

ES Extra character space 

IV Invoke character slot 

LO Label origin 

PB Print buffered label 

PM Polygon mode 

RP Replot 

UF User defined fill 

Unsupported features ofHPGU2 type device are: 

HPGL Full name 
Mnemonic 

AD Alternate font definition 

AT Absolute three point arc 

RT Relative three point arc 

PE Polyline encoded 

HPGL 
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HPGL Full name Mnemonic 

SD Standard font definition 

CF Character fill mode 

TD 'I'ransparent data 

DV Define variable text path 

LA Line attributes 

PW Pen width 

WU Pen width unit selection 

FT Fill type (Includes dithers and user) 

AC Anchor corner 

RF Raster fill definition 

UL User define line type 

IR Input relative PI P2 

Lotus 1·2·3 pictures 

Lotus 1-2-3 .PIC files are created using the 1-2-3 Save option, which is 
found in the 1-2-3 Print menu. Within 1-2-3, the keystrokes required 
once a graph has been created on the screen, are: 

IGS filename 

Filename is replaced by the name of the 1-2-3 picture file you wish to 
create. 

The Lotus 1-2-3 graphics converter supports the Lotus International 
Character Set (LICS). 

Macintosh Paint 

Ventura Publisher converts Macintosh Paint files. Transfer files from 
the Macintosh to the PC using a network or communication program. 
Features and limitations include: 

Pictures always transfer as a full 8 x 10 page. Therefore, a small image 
on a white page must be enlarged considerably within the frame. 
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Macintosh Pier 

Ventura Publisher converts Macintosh PICT files. You must transfer 
files from the Macintosh to your PC using a network or communication 
program. Bit images within PICT files do not convert. 

Fonts in the PICT files are converted to fonts available in your PC 
according to the table in the PCTTOGEM.CNF file. This file is stored in 
the VENTURA directory and is an ASCII file which begins with the 
keyword fontmap and ends with the keyword endfontmap. Each line in 
between the two keywords defines which Ventura Publisher fonts will 
be used in place of the Macintosh fonts. The first number in each line is 
the font ID on the Macintosh; the second the ID of the font which will be 
used on the PC. The remainder of the line is treated as a comment. The 
following table lists how PICT fonts are converted when brought into 
Ventura Publisher. 

Macintosh Ventura 

Font ID Publisher Macintosh Font Name Ventura Publisher Font 

Number FontID Name 
Number 

0 1 System Font Courier 
1 2 AjJplication Font Helvetica 
2 14 New York Times Roman 
3 2 Geneva Helvetica 
4 14 Monaco Times Roman 
5 14 Venice Times Roman 
6 14 London Times Roman 
7 14 Athens Times Roman 
8 14 San Francisco Times Roman 
9 14 Toronto Times Roman 
11 14 Cairo Times Roman 
12 14 Los Angeles Times Roman 
20 14 Times Times Roman 
21 2 Helvetica Helvetica 
22 1 Courier Courier 
23 128 Symbol Symbol 
24 14 Taliesin Times Roman 
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PC Paintbrush/PCX pictures 

Many popular graphics and scanning programs will save images in PCX 
format. Ventura Publisher supports PCX versions 3.0 and above, includ­
ing 24-bit PCX images. 

Ventura Publisher will display all colors produced using the original 
graphics or scanning program. 

An PCX format image saved once from Windows Paint will not contain 
a palette (definition of colors for the image). When this image is loaded 
into Ventura Publisher, Ventura Publisher will, to the best of its ability, 
generate a palette for the image. The colors produced in this palette may 
not be the same as those produced in Windows Paintbrush. If the image 
is saved a second time from Windows Paintbrush before being loaded 
into Ventura Publisher, the palette will be saved with the image and 
Ventura Publisher will not be required to generate the palette. 

Video Show 

Text in General Parametric Video Show files may be mapped to white. 
Turn the Frame Background to black to see if any white text appears. 
Key limitations include: 

• Only 7 -bit (not 8-bit) pictures are converted. 

• Color is converted into shades of gray. 

• The 3D bar function is not implemented. 

Windows Metafile 

Windows applications support two formats of Windows Metafile; place­
able and standard. Most Windows applications will output Windows 
Metafile pictures in the placeable format. Ventura Publisher uses the 
standard format. When a Windows metafile picture is loaded using the 
Load Text/Picture option, Ventura Publisher looks at the format of the 
Windows metafile and determines the format. 

If the file was written using the standard Windows metafile format, the 
picture is loaded directly into the chapter. If the file was written using 
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the placeable Windows metafile format, the file must be converted to 
standard Windows metafile format before being loaded into the chapter. 

When loading a placeable Windows metafile format picture, the follow­
ing VP alert box is displayed. 

Click on the Cancel button to prevent the file from being loaded into the 
chapter. Click on the OK button to continue loading the image. If the 
OK button is selected, the Save File As dialog box is displayed. This 
dialog box allows you to select a new name for the converted Windows 
metafile picture keeping the original placeable Windows metafile pic­
ture file unchanged. 

Select a location and a name for the new standard Windows metafile 
picture. The default extension for Windows metafile is .WMF and will 
be added if no extension is specified in the file name. If you select an 
existing file name, a VP alert box appears asking you to confirm the file 
overwrite. 

Once the file has been converted to a standard Windows metafile format, 
the new file will be loaded into the chapter. The original placeable 
Windows metafile picture will not be included in the chapter, nor will it 
be copied if the chapter is moved using the Manage Publication 
option. 
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GLOSSARY 

ASCII Text Files. American Standard Code for Information Inter­
change. ASCII text is stored in exactly the same order as you see it on a 
printed page, with no additional characters added or deleted. ASCII files 
are often called "print" files. 

Ascender. The part of a lower case character which rises above the 
height of the lower case "x." 

Attribute. Any style used to enhance readability of text. Typical at­
tributes include boldface, underline, and italic. Font changes assigned 
to selected text are also considered attributes. Examples of these font 
attributes include 14 point, blue, and kern. 

Baseline. An imaginary line on which type rests. Descending char­
acters hang below the baseline. 

Binding Margin. The additional space added to the side of the page 
that will be drilled or punched prior to insertion into a binder. Use 
different margins for left and right pages to create binding margins. 

Body Text. The text of the main part of the document. 

Body Text is also the name of the default tag in a Ventura Publisher style 
sheet. All text in a Ventura Publisher chapter is automatically formatted 
with this Body Text tag unless you assign other tags to specific para­
graphs using the Paragraph tool. 

Box Text. Box created using the graphic tool which contains text. Box 
text does not flow around frames, and can have graphics (e.g., arrows) 
directly attached to it. Use box text for tables and callouts. Use frames 
containing text files for newspaper-type make-up. 

Break. The interruption in the flow of text from one paragraph to the 
next. Normally each paragraph continues directly below the previous 
paragraph or, if no more room is left on the current column or page, it 
continues at the top of the next column or page. This is called a normal 
Line Break. 
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Chapter. - Em Dash. 

If you want a paragraph to always begin at the top ofa new column, you 
set a Column Break. If you want a paragraph to always begin at the 
top of a new page, you set a Page Break. 

Any two paragraphs which contain no break of any kind between them 
will print on top of each other, unless you use the paragraph Spacing 
options to move one paragraph to the left and the other paragraph to the 
right. 

Chapter. A combination of text and picture files, formatted with a style 
sheet. A chapter file consists of pointers to each of these files, along with 
instructions on how to combine them together on the computer screen 
or on the printer. All Ventura Publisher documents are saved as chap­
ters. 

Clipboard. A temporary, invisible holding place for text, pictures, and 
graphics. Any text block or picture placed on the clipboard using a cut 
or copy operation can be placed anywhere else in the chapter. 

Crop. Eliminate unwanted portions of a picture. The portions not 
displayed in the document are still stored in the original picture file. 

Crop Marks. Alignment marks which delineate the outside edges of 
the printed page. Also sometimes called trim marks or register marks. 
Crop marks can be automatically added at print time or you can draw 
your own using the Line tool. If you draw your own, select the crop 
marks you have drawn and then select Show On All Pages in the 
Graphic menu. This will make the crop marks appear on every page. 

Descender. The portion of a letter which extends below the baseline. 
The tail on the lower case y is a good example of a descender. 

Discretionary Hyphen. A hyphen, placed in a word, which only 
prints if the word appears at the end of a line. Used to add hyphens 
beyond those produced by the hyphenation dictionary. Discretionary 
hyphens always take precedence over any hyphens inserted by Ventura 
Publisher. 

Em. A unit of measure which is exactly as wide as the@in the font and 
point size being used. Em units are often used to specify the width of a 
column or the amount of indentation. 

Em Dash. An em dash (decimal 197) is one em long and is used to 
separate parenthetical statements-such as this one-from the sur­
rounding text. An em dash is created by pressing and holding the Ctrl 
key and then pressing]. 
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Em Space. An em space equals the width of the letter m in current 
point size. An em space is created by pressing and holding both the Ctrl 
and Shift keys and then pressing M. Ventura Publisher actually uses 
the width of the @ character. 

En. A unit of measure which equals one half the width of an em. 

En Dash. An en dash (decimal 196) is used between numbers. For 
example: Figure 5-35. The en dash is also used in place of a hyphen in 
a compound adjective one element of which consists of two words or a 
hyphenated word. For example: non-stop-no-frills flight. An en dash 
is created by pressing and holding the Ctrl key and then pressing [. 

En Space. An en space equals one half the width of an em space. Its 
width is equal to the letter n in the current font. An en space is created 
by pressing and holding both the Ctrl and Shift keys and then 
pressing N. 

Figure Space. A figure space equals the width of a number in the 
current point size. Use figure spaces between numbers in tables to keep 
tabular information aligned properly. A figure space is created by press­
ing and holding both the Ctrl and Shift keys and then pressing F. 

Font. A unique combination of typeface, type size, type style, and type 
weight. For instance, Swiss (typeface), 12 point (type size), bold (type 
weight) is one font; Swiss, 14 point, bold is another. 

Footer. Text which appears at the bottom of every page in the docu­
ment. 

Frame. A rectangular box used to hold text or pictures. Each page is 
also a frame. Pages are automatically created as needed to accommodate 
all text in a file. You create frames by using the Add Frame tool, and then 
modify their attributes using the options in the Frame menu. 

Generated Tag. A tag created automatically for text which Ventura 
Publisher generates (e.g., figure numbers, section numbers). All 
generated tag names begin with Z_. 

Greeking. The act of representing text by dummy type having no 
meaning, or by a series of straight lines. Within Ventura Publisher, 
greeking is used to increase screen drawing speed when the text is too 
small to be legible. Does not affect what gets printed. 

Gutter. The blank space between columns, or the blank space between 
two pages in a bound document. 
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Halftone. The process of representing a shade of gray by a series of 
black dots of different size. The bigger the dots, the darker the shade of 
gray. On printers which cannot print different sizes of dots (e.g., a laser 
printer), the halftone is produced by printing different numbers of dots 
in a given area. 

Image. A picture which is composed of individual dots created with a 
"paint" program or with a scanner. See also Line Art. 

Indent. The blank space at the beginning of the first line of a para­
graph. 

Inter-line Spacing. The space between lines In a paragraph. See 
Leading. 

Justification. Text aligns evenly with both the right and left margins. 

Kerning. Space reduction between specific letter pairs. Even when 
proportionally spaced, certain letter pairs should be placed more closely 
together eliminate excessive white space. This space is especially notice­
able with larger type sizes. For instance, an upper case V which follows 
an upper case A should be placed closer to the A. For example: 

This is not kerned: A V. 

This is kerned: AV. 
Landscape. A page printed so that as you read it, the width of the page 
is greater than its height. 

Layout. The arrangement of text and pictures on any given page. 

Leaders. Characters placed in the blank space between items in a list. 
For example: 

Table Item 1 .... .Item 2 .... .Item 3 .... .Item 4 

t t t 

Leading. The distance in points from the baseline of one line of type to 
the next. Within Ventura Publisher, leading is adjusted using the Inter­
line setting in the Paragraph menu Spacing option dialog box. 
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Letter spacing. The process whereby the visual impact of loose lines 
(lines with too much space between words) is reduced by adding space 
between letters. 

Line art. A picture which is produced on the computer and stored as 
mathematically defined objects. In traditional typesetting, line art 
refers to illustrations containing only black or white, with no shades of 
gray. 

Line Break. The blank line which separates two paragraphs. Ifno line 
break is set between two paragraphs, the second paragraph will begin 
at the same vertical point as the first line in the first paragraph (Next 
Y Position: Normal); or at the same vertical point as the last line in 
the first paragraph (Next Y Position: Beside Last Line of Previous 
Paragraph.) 

Line Length. The length of a line of type. Usually expressed in picas 
and points. 

Mechanical. A finished "camera ready" piece of artwork, generally one 
or two pages. 

Maximum Space Width. The largest space between words that Ven­
tura Publisher will allow in a justified line of text. This maximum is 
specified in the Paragraph Typography option of the Paragraph 
menu. If more space than this maximum is required, the line is flagged 
as a loose line. If Letterspacing is enabled in the Paragraph Typo­
graphy option dialog box, additional space is added between letters, 
and the space between words is not allowed to exceed the maximum. 

Minimum Space Width. The smallest space between words that Ven­
tura Publisher will allow in a justified line of text. This minimum is 
specified in the Paragraph Typography option dialog box of the 
Paragraph menu. Ifless space than this maximum is required, the last 
word on this line is moved to the next line. 

Monospaced. An equal amount of character width for each character. 
Most typewriters and printers are monospaced, whereas most typeset 
material is proportionally spaced. Also called monopitch. See Propor­
tional Spacing. 

Non-breaking space. A special space used to keep words from being 
separated at the end of a line. To create a non-breaking space press: Ctrl 
+ spacebar. 
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Normal Space Width. The space between words in an un-justified 
line of text. 

Orphan. One or more lines of text left at the bottom of a column or 
page. Also, see Widow. 

Outdent. Text on the first line of a paragraph which prints to the left 
of the paragraph margin. 

Page. The frame defined by the Page Size & Layout option in the 
Chapter menu. Additional frames are placed on top of this page. The 
page counter on the screen shows the number of pages in the document. 

Paste. The act of moving text or a picture from the clipboard to the 
page. 

Paragraph. Any line or lines of text ended by pressing the Enter key. 
A single letter, word, or line is considered a paragraph if the Enter key 
is pressed at the end of the letter, word, or line. 

Pica. Typographic unit of measurement equal to V6 inch. Twelve points 
equals one pica. 

Picture. Any drawing or illustration placed in a frame. A picture can 
be either image or line art. 

Point. Typographic unit of measurement equal to J/72 inch. 

Proportional Spacing. Different space is given to each character in 
a font. When proportionally spaced, the letter i gets less space than the 
letter w. 

Portrait. A page printed so that, as you read it, the width of the page 
is less than its height. 

PostScript. A language used to describe how to print a page which 
consists of both text and pictures. This description is completely inde­
pendent of the printing device. This means that the page can be printed 
on any printer or typesetter that uses PostScript, and the page will be 
printed at the full resolution that each printer or typesetter can produce. 

Publication. A combination of chapter files. Each chapter file can 
have its own set of text, picture, and style sheet files. Use the Manage 
Publication option in the File menu to create a publication. Once 
created, you can copy, renumber, or print every page in the publication. 
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You can also create a table of contents or index for all of the chapters 
contained in the publication. 

Reflect. Reflected settings place a mirror image of that setting on 
alternating pages. For example, if a picture is placed at the left side of 
a left page and then reflected using the For All Pages Left & Right in 
the Repeating Frame option dialog box, the picture will then be placed 
on the right side of right pages. 

Ruling Line. Any horizontal or vertical line used to separate text or 
frames from the surrounding layout. Use the Frame menu ruling line 
options to place ruling lines around frames, and the Paragraph menu's 
ruling line options to place lines above, below, or around paragraphs. 
You can also draw ruling lines using the Line tool. These lines can be 
attached to frames and will move whenever the frame moves. 

Run around. Text which follows the outline of a picture. 

Sans serif. Type style which does not have small horizontal strokes at 
the top and bottom of each letter. This is sans serif type. 

Scale. Increasing or decreasing the size of a picture. 

Scanner. A device which converts a paper drawing into a computer 
image. 

Serif. Type style which has small horizontal strokes at the top and 
bottom of each letter. All body text in this manual is serif type. 

Style Sheet. A file which is stored separately from text, but which 
controls the typographic format of that text. When you design a style 
sheet, you give each set of typographic attributes a name. These names 
are called tags. You assign attributes from the style sheet to each 
paragraph in the document by first selecting a paragraph and then 
selecting the appropriate tag from the Tags list. 

Tag. The format applied to a particular paragraph using the Paragraph 
tool. Tags are stored in the style sheet. The Tags list window shows all 
tags available in the currently loaded style sheet. 

Thin Space. A thin space is the width of a period. 

Typeface. The style of type e.g., Bookman, Palatino, Avant Garde, 
Zap! Cfiancery. 
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Typeset. The act of producing a document on a typesetting machine. 
Ventura Publisher can produce documents on a laser printer that have 
near typeset quality. 

Vertical Justification. The process which forces text in each column 
to the exact bottom of each column or page. 

Widow. One or more lines of text left at the top of a column or page. 
Note: a widow also refers to a single word on the last line of a paragraph. 
While this is considered poor form, Ventura Publisher does not attempt 
to prevent this kind of widow. Also, see Orphan. 

Width Table. A file which contains all information about the height 
and width of each character - in each size and weight - for every 
typeface you might want to use in a document. The width table is totally 
independent from the font itself. It merely controls the positioning of one 
character relative to the next. Thus, you can create documents for 
ultimate printing on printer or typesetter which contains fonts not 
available on your local computer or printer. To actually display or print 
a font, the font must exist in either your computer or printer. 

WYSIWYG. What You See Is What You Get (printed.) Refers to the 
ability to display on the computer screen a close representation of what 
is printed. A word processor which uses special characters to mark the 
beginning and end of underlined text, rather than showing text with an 
underline is an example of a program which does not have WYSIWYG. 



APPENDIX I 
FONTS 

Font installation 

Width tables 

Fonts can be installed in Windows in two ways; direct installation into 
Windows using an installation kit or the Windows Control Panel (e.g., 
TrueType, Bitstream, Zenographics SuperPrint, etc.), or by the use of a 
font rasterization utility (e.g., Adobe Type Manager, Bitstream Face­
Lift). 

It is important to remember when installing fonts using an installation 
kit, to install them for the Windows environment, or for Windows 
Ventura Publisher if this option is available. 

Font installation kits will have options for generating fonts for Ventura 
Publisher. However, unless the option specifically refers to the Windows 
version of Ventura Publisher, the fonts generated when using this option 
can only be used with the DOS/GEM version of Ventura Publisher. 

The first time Ventura Publisher is run, a width table file called EN­
VIRON.WID is created. This width table gives Ventura Publisher infor­
mation about the fonts installed for the default printer. Depending on 
the number of fonts installed for the default printer and the speed of 
your computer, generating the width table could take from a few 
seconds, to several minutes. 

Each time you run Ventura Publisher, it loads the style sheet that was 
in use at the end of your last session. If this style sheet points to the 
ENVIRON.WID width table, Ventura Publisher will rebuild this width 
table. This also occurs when a chapter is loaded. 
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To speed load time, you should generate a custom width table and apply 
it to all your style sheets. When a style sheet uses a width table with a 
name other than ENVIRON.WID, Ventura Publisher will not attempt 
to rebuild the width table when the style sheet is loaded, thus speeding 
the program or chapter loading time. 

To generate and apply a custom width table: 

> Click on the Load Diff. Style function button. 

> Use the Drives and Directories list boxes to located the style sheet 
to which you want to apply the custom width table. Select the style 
sheet name in the File Name list box and click on the OK button. 

> Select the Printer Setup option from the File menu and select the 
printer for which you want to generate a width table. 

> Click on the OK button. An ENVIRON. WID width table will be built. 
This can take from a few seconds if you have only a few fonts installed 
in Windows, to several minutes if you have a many fonts installed. 

> Select the Manage Width Table option from the File menu. 

> Edit the font list as desired. 

> Click on the Save As New Width Table button. 

> Specify a path and name for the custom width table and then click on 
the OK button. The name of the width table should not be EN­
VIRON.WID. 

> Select the OK button to exit the Manage Width Table dialog box. 

> Click on the Save Style As function button and select the same style 
sheet name from the File Name list box. Click on the OK button. 

> When the alert box is displayed, click on the Overwrite button to 
apply the custom width table to the style sheet. 

If the style sheet using the custom width table is in use at the end of 
your session, the next time you run Ventura Publisher the width table 
will not be rebuilt and the program will load faster. Also, when loading 
a chapter using a custom width table, the chapter loading speed will be 
increased because the width table will not be rebuilt. 

Because custom width tables are never automatically rebuilt by Ventura 
Publisher, if you add or delete fonts from Windows you must manually 
rebuild the custom width table using the previous steps. 



PostScript font metric (.PFM) files 

If your document is to be sent to a service bureau for output on a 
typesetter, you may wish to have access to the additional fonts available 
in the typesetter memory without having to purchase each font. This can 
be done by using the PostScript font metric (.PFM) files supplied with 
Ventura Publisher. 

When installed and applied to text in your document, these font metrics 
allow you to use fonts for which you do not have corresponding printer 
fonts. The correct font will not be displayed on the screen or printed on 
a desktop laser printer unless the corresponding printer font (not sup­
plied with Ventura Publisher) is installed, however, the line endings and 
alignment for the correct font will be maintained. When the document 
using the .PFM files is printed to a file and sent to a service bureau for 
printing on a typesetter, the correct font will be printed. 

Refer to page 5-65 for information on outputting your document to a file 
for printing on a typesetter at a service bureau. You must inform the 
service bureau of all typefaces used in you document to ensure that the 
font will be loaded into the typesetter memory when your document is 
printed. 

The following table lists the font metric files supplied with Ventura 
Publisher and the corresponding typefaces. 

Font Metric Filename Typeface 

AGDO - .PFM AvantGarde-D emiObli que 

AGD .PFM AvantGarde-Demi --
AGWO - .PFM AvantGarde-BookOblique 

AGW __ .PFM AvantGarde-Book 

ATB --.PFM AmericanTypewriter-Bold 

ATM --.PFM AmericanTypewriter-Medium 

BDBI .PFM Bodoni -BoldI talic -

BDB .PFM Bodoni-Bold --
BDI __ .PFM Bodoni-Italic 

BDPS .PFM Bodoni -Poster -

BD .PFM Bodoni --
BGB --.PFM B engui at-Bold 

BGW __ .PFM Benguiat-Book 

BKDI_.PFM Bookman -DemiItalic 
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BKD .PFM Bookman-Demi --
BKLI_.PFM Bookman -LightItalic 

BKL .PFM Bookman-Light 

CHBI_.PFM Chel tenham -BoldItalic 

CHB .PFM Chel tenham -Bold --
CHWI_.PFM Chel tenham -Book! talic 

CHW __ .PFM Cheltenham-Book 

CSB --.PFM CenturyOldStyle-Bold 

CSI __ .PFM CenturyOldStyle-Italic 

CSRG_.PFM CenturyOldStyle-Regular 

FQB __ .PFM FrizQuadrata-Bold 

F'L-.PFM FrizQuadrata 

FRDO_ .PFM FranklinGothic-Demi Oblique 

FRD .PFM FranklinGothic-Demi 

FRHO --.PFM FranklinGothic-HeavyOblique 

FRH __ .PFM FranklinGothic-Heavy 

FRWO --.PFM FranklinGothic-BookOblique 

FRW __ .PFM FranklinGothic-Book 

FS --.PFM FreestyleScript 

GABI_.PFM Garamond-BoldI talic 

GAB .PFM Garamond-Bold --
GALl --.PFM Garamond -LightItalic 
GAL __ .PFM Garamond-Light 

GLBI --.PFM Galliard -BoldItalic 

GLB __ .PFM Galliard-Bold 

GLI .PFM Galliard -Italic --
GLR __ .PFM Galliard -Roman 

GOBI _.PFM Goudy-BoldItalic 

GOB --.PFM Goudy-Bold 

GOI __ .PFM Goudy-Italic 

GO --.PFM Goudy 

GYB 0_. PFM Glypha-BoldOblique 

GYB __ .PFM Glypha-Bold 

GYO __ .PFM Glypha-Oblique 

GY __ .PFM Glypha 

HVBLO - .PFM Helvetica-BlackOblique 

HVBL_ .PFM Helvetica-Black 

HVCBL_ .PFM Helvetica-Condensed-Black 
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HVCBO .PFM Hel vetica-Condensed-BoldObl -
HVCB .PFM Helvetica-Condensed -Bold 

HVCDO .PFM Helvetica-Condensed-Oblique 

HVCLO .PFM Helvetica-Condensed-LightObl 

HVCL_ .PFM Helvetica-Condensed -Light 

HVCO .PFM Helvetica-Condensed-BlackObl 

HVC .PFM Helvetica-Condensed 

HVN .PFM Helvetica-N arrow-Black 

HVNO .PFM Helvetica-N arrow-Oblique 

HVNB --.PFM Helvetica-N arrow-Bold 

HVNBO_ .PFM Helvetica-N arrow-Oblique 

HVLO --.PFM Helvetica-LightOblique 

HVL .PFM Helvetica-Light 

KRB .PFM Korinna-Bold 

KRKB .PFM Korinna-Kursi v Bold --
KRKX_ .PFM Korinna-KursivRegular 

KRRG_ .PFM Korinna-Regular 

LGBSL .PFM LetterGothic-BoldSlan ted 

LGB .PFM LetterGothic-Bold 

LGSL .PFM LetterGothic-Slan ted 

LG __ .PFM LetterGothic 

LUDO .PFM LubalinGraph-DemiOblique 

LUD .PFM LubalinGraph-Demi 

LUWO .PFM LubalinGraph-BookOblique 

LUW .PFM LubalinGraph-Book 
MA __ .PFM Machine 

MEBI .PF'M Melior-BoldI talic 

MEB .PFM Melior-Bold --
MEl .PFM Melior-Italic 

ME .PFM Melior 

NBBI .PFM New Baskerville-BoldI talic 

NBB --.PFM New Baskerville-Bold 

NBI __ .PFM New Baskerville-Italic 

NBR .PFM New Baskerville-Roman 

NCB I .PFM NewCenturySchlbk-Boldltalic 

NCB .PFM NewCenturySchlbk-Bold 

NCI .PFM NewCenturySchlbk-Italic 

NCR .PFM N ewCenturySchlbk-Roman 
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Font Metric Filename Typeface 

OPBO _.PFM Optima -BoldOblique 

OPB --.PFM Optima-Bold 

OPO --.PFM Optima -Oblique 
OP __ .PFM Optima 

ORSL_ .PFM Orator-Slanted 

OR __ .PFM Orator 
PA __ .PFM ParkAvenue 

PEBSL_ .PFM PrestigeEli te-BoldSlanted 

PEB --.PFM PrestigeElite-Bold 

PESL_ .PFM PrestigeEli te-Slanted 

PE .PFM PrestigeEli te 

POBI - .PFM Palatino-Boldltalic 

POB __ .PFM Palatino-Bold 

POI --.PFM Palatino-Italic 

POR __ .PFM Palatino-Roman 

S 0 __ . PFM Sonata 

SUDI - .PFM Souvenir-Demiltalic 

SUD __ .PFM Souvenir-Demi 

SULI_ .PFM Souvenir-Lightltalic 

TMBI_ .PFM TrumpMediaeval-Boldl talic 

TMB --.PFM TrumpMediaeval-Bold 

TMI __ .PFM TrumpMediaeval-Italic 

TMR __ .PFM TrumpMediaeval-Roman 

ZCMI - .PFM ZapfChancery-Mediumltalic 

ZD __ .PFM ZapfDingbats 

Installing font metrics 

Before you can use the font metrics in your document, you must have a 
PostScript printer driver installed and properly configured in the Win­
dows Control Panel. Once the printer is properly installed you must 
modify your WIN.INI file and generate a custom width table in order to 
use the printer font metrics. 

~ Using the Windows File Manager, create a directory for the .PFM files 
on your hard drive. Copy the .PFM and . TXT files from the PFM 
directory on the Ventura Publisher UTILITIES diskette. 



~ Make a backup copy of the WIN .INI file in the directory in which 
Windows is installed. 

~ Using a Windows text editor or word processor with search and 
replace capabilities (e.g., Windows Write), open the SOFTFONT.TXT 
file from the directory you created for the .PFM files. This file must 
be opened as an ASCII file. 

~ Highlight all of the text in the SOFTFONT. TXT file and select the 
Copy option from the Edit menu of the Windows text editor. Close 
the SOFTFONT. TXT file. 

~ Open the WIN .INI file from the directory in which Windows is 
installed. This file must be opened as an ASCII file. 

~ Locate the section in the WIN.INI labeled [PostScript,FILE]. 

~ Place the typing cursor after the last entry of the [PostScript,FILE] 
section and select the Paste option to paste the text copied from the 
SOFTFONT.TXT file. 

~ If there where other font entries in the [PostScript,FILE] section; you 
will have to renumber the softfont number of each of the entries 
copied from the SOFTFONT.TXT file. To do this, locate the entry: 

softfontl=X: \AGD __ .PFM 

. Starting with the number following the softfont number of the entry 
above this one, consecutively renumber all the softfont entries pasted 
into the WIN.IN!. For example: 

softfont23=C:\PSFONTS\PFM\RVB __ .PFM 
softfontl=X: \AGD __ .PFM 

softfont115=X: \ZD __ .PFM 

would be renumbered to 

softfont23=C: \PSFONTS\PFM\RVB __ .PFM 
softfont24=X: \AGD __ .PFM 

softfont138=X: \ZD __ .PFM 

~ Locate the last softfont entry in the [PostScript,FILE] section and 
note the softfont number. 
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~ Go to the top of the [PostScript,FILE] section. 

~ If one exists, change the softfonts= number to the number of the last 
softfont entry. If it doesn't exist, enter: 

softfonts= 115 

above the first softfont entry. 

~ Using the search and replace capabilities of the text editor, change 
the string X: \ to the drive and path of the directory in which you 
copied the .PFM files. 

~ Save the WIN .INI file and exit the text editor. 

~ Exit and restart Windows. 

~ Run Ventura Publisher. 

~ Click on the Load Diff. Style function button. 

~ Load the style sheet used to format chapters that are to be sent to the 
service bureau. 

~ Select the Printer Setup option from the File menu. 

~ Select the PostScript printer from Specific Printer list box and click 
on the OK button. 

~ Select the Manage Width Table option from the File menu. 

~ Edit the font list as desired and then click on the Save As New Width 
Table button. 

~ Specify a path and name for the custom width table and then select 
the Save button. The name selected for the width table should not be 
ENVIRON. WID. 

~ Select the OK button to exit the Manage Width Table dialog box. 

~ Select the Save Style As option from the File menu. 

~ Locate and select the style sheet you previously loaded or enter a new 
style sheet name and then select the Save button. If you selected the 
same style sheet name as that already loaded and wish to apply the 
width table to this style sheet, select the Overwrite button when the 
alert box is displayed. 

When this style sheet and width table are applied to a chapter, the fonts 
listed in the previous table will be available in all dialog boxes having a 
font menu. 
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Because custom width tables are never automatically rebuilt by Ventura 
Publisher, if you add or delete fonts from Windows you must manually 
rebuild the custom width table using the previous steps. 
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Font troubleshooting 
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The following paragraphs will help isolate a problem relating to fonts if 
one should arise. 

Fonts for Epson or dot matrix printers do not display or print 

If you have used the Bitstream Fontware installation kit to generate 
screen and printer fonts for an Epson or dot matrix printer, you must 
make sure that the resolution setting for the printer is set correctly. The 
Bitstream Fontware installation kit generates fonts for Epson and dot 
matrix printers at certain resolutions. If the resolution setting in the 
printer properties dialog box are set for the resolution for which the 
fonts where generated, they will not print or display. 

To determine the resolution at which Bitstream will generate the fonts, 
you can view the .DDF file for the printer. The .DDF files are located on 
the Bitstream Fontware disks. The file name of the .DDF file is descrip­
tive enough that you could determine the correct .DDF file for your 
printer. 

When you have located the correct .DDF file for your printer, use the 
Windows Notepad or other ASCII text editor to open the file. The file will 
contain a line similar to the following: 

vdpi=120 

the number following the vdpi= is the resolution at which Bitstream 
Fontware will generated the font. This resolution is the setting you 
should select for the printer in the printer settings dialog box. 

Do not change or save the .DDF file while in the ASCII text editor used 
to view the file. 
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Typeface codes 

The following is a list of industry standard typefaces and their as­
sociated Ventura Publisher ID's. These font ID are used for entering font 
codes into word processors, and Ventura Publisher dialog boxes that 
support entering of font codes (e.g., Make Index, Make TOC). Refer to 
Appendix D for more information on the syntax for entering font codes. 

The PostScript file name is listed for reference. Additional fonts which 
you purchase may have font IDs different then those shown here. 

Typeface PostScript 
File Name 

System Faces (International Character Set) 

Courier-Bold. . . . . . . . . . . . . . . . . . . . . . . . . . . . .. COURIB 

Courier-Bold Oblique. . . . . . . . . . . . . . . . . . . . . .. COURIBO 

Courier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. COURI 

Helvetica-Oblique ......................... HELVEO 

Helvetica-Bold ................... . . . . . . . .. HELVEB 

Helvetica ................................ HELVE 

Helvetica-Bold Oblique .............. . . . . . .. TIMESBO 

Times-Bold Italic. . . . . . . . . . . . . . . . . . . . . . . . .. TIMESBI 

Times-Italic .............................. TIMESI 

Times-Bold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. TIMESB 

Times-Roman. . . . . . . . . . . . . . . . . . . . . . . . . . . .. TIMESR 

Serifed Faces (International Character Set) 

New Century Schoolbook-Italic ............. . NCI __ 

FaceID 

1 

1 

1 

2 

2 

2 

2 

14 

14 

14 

14 

20 

New Century Schoolbook-Roman . . . . . . . . . . . .. NCR__ 20 

New Century Schoolbook-Bold Italic ......... . NCBI __ 20 

New Century Schoolbook-Bold ............... NCB__ 20 

Palatino-Italic ........................... . POI __ 21 
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Typeface 

Palatino-Bold Italic ........................ . 

PostScript 
File Name 

POBI __ 

FaceID 

21 

Palatino-Bold ............................. POB__ 21 

Palatino- ................................. POR__ 21 

Garamond-Bold ............................ GAB__ 22 

Garamond-Bold Italic ....................... GABI __ 22 

Garamond-Light . . . . . . . . . . . . . . . . . . . . . . . . . .. GAL__ 22 

Garamond-Light Italic ...................... GALI __ 22 

Bookman-Demi . . . . . . . . . . . . . . . . . . . . . . . . . . .. BKD__ 23 

Bookman-Light Italic 

Bookman -Demi Italic 

BKLI __ 

BKDI __ 

23 

23 

Bookman-Light ............................ BKL__ 23 

Lubalin Graph-Demi Oblique ................ LUDO__ 24 

Lubalin Graph-Book. . . . . . . . . . . . . . . . . . . . . . .. LUW__ 24 

Lubalin GraphBook Oblique ................. LUWO__ 24 

Lubalin Graph-Demi ....................... LUD__ 24 

Souvenir-Light ............................ SUL__ 25 

Souvenir-Light Italic ....................... SULI __ 25 

Souvenir-Demi ............................ SUD__ 25 

Souvenir-Demi Italic ....................... SUDI __ 25 

Benguiat-Book ............................ BGW__ 26 

Benguiat-Bold ............................. BGB__ 26 

Glypha-Bold .............................. GYB__ 27 

Glypha . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. GYR__ 27 

Glypha-Oblique ............................ GYO__ 27 

Glypha-Bold Oblique ....................... GYBO__ 27 

Friz Quadrata . . . . . . . . . . . . . . . . . . . . . . . . . . . .. FQRG__ 28 



Typeface codes 

Typeface 

Friz Quadrata-Bold ....................... . 

Zapf Chancery-Medium Italic ............... . 

APPENDIX K-FONTS 

PostScript 
File Name 

FQB __ 

ZCM1 __ 

FaceID 

28 

29 

Trump Mediaeval-Italic. . . . . . . . . . . . . . . . . . . .. TM1__ 30 

Trump Mediaeval-Bold Italic ................ TMB1__ 30 

Trump Mediaeval-Roman ................... TMR__ 30 

Trump Mediaeval-Bold..................... TMB__ 30 

Melior-Bold Italic ......................... . MEB1 __ 31 

Melior-Bold............................... MEB__ 31 

Melior-Italic ............................. . ME1 __ 31 

Melior . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. MER__ 31 

Galliard-Bold Italic ....................... . GLB1 __ 32 

Galliard-Bold . . . . . . . . . . . . . . . . . . . . . . . . . . . .. GLB__ 32 

Galliard-Italic ........................... . GL1 __ 32 

Galliard ................................. GLR__ 32 

New Baskerville-Bold Italic ................ . NBB1 __ 33 

N ew Baskerville-Bold ...................... NBB__ 33 

New Baskerville-Italic ..................... . NB1 __ 33 

New Baskerville-Roman.................... NBR__ 33 

Goudy-Bold Italic ......................... . GOB1 __ 34 

Goudy-Bold ............................... GOB__ 34 

Goudy-Italic ............................. . G01 __ 34 

Goudy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. GOR__ 34 

ParkAvenue . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. PAM__ 35 

Bodoni-Bold Italic ........................ . BDB1 __ 36 

Bodoni-Bold .............................. BDB__ 36 

Bodoni-Italic ............................. . BD1 __ 36 
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1-14 

Typeface 
PostScript 
File Name 

FaceID 

Bodoni ........................ . . . . . . . . . .. BDR__ 36 

Bodoni-Poster ............................. BDPS__ 37 

Century Old Style-Bold ..................... COB__ 38 

Century Old Style-Italic . . . . . . . . . . . . . . . . . . . .. COI __ 38 

Century Old Style-Regular .................. CORG__ 38 

Cheltenham-Bold Italic ..................... CHBI __ 39 

Cheltenham-Bold .......................... CHB__ 39 

Cheltenham-Book Italic ..................... CHWI __ 39 

Cheltenham-Book .......................... CHW__ 39 

Sans Serifed Faces (International 
Character Set) 

Helvetica-Narrow-Bold. . . . . . . . . . . . . . . . . . . . .. HELVENB 50 

Helvetica-Narrow-Bold Oblique .............. HELVENBO 50 

Helvetica-Narrow-Oblique . . . . . . . . . . . . . . . . . .. HELVENO 50 

Helvetica-Narrow. . . . . . . . . . . . . . . . . . . . . . . . .. HELVEN 50 

Avant Garde-Book ......................... AGW__ 51 

Avant Garde-Demi Oblique .................. AGDO__ 51 

Avant Garde-Demi ......................... AGD__ 51 

Avant Garde-Book Oblique .................. AGWO__ 51 

Optima-Bold Oblique ....................... OPBO__ 52 

Optima-Bold .............................. OPB__ 52 

Optima-Oblique ........................... OPO__ 52 

Optima .................................. OP 52 

Korinna-Kursiv Bold ....................... KRKB__ 53 

Korinna-Bold. . . . . . . . . . . . . . . . . . . . . . . . . . . . .. KRB__ 53 

Korinna-Kursiv Regular ..................... KRKX__ 53 

Korinna-Regular . . . . . . . . . . . . . . . . . . . . . . . . . .. KRRG__ 53 



I ypetace cOdes 

Typeface 

Helvetica-Light .......................... . 

Helvetica-Light Oblique ................... . 

Helvetica-Black .......................... . 

Helvetica-Black Oblique ................... . 

Franklin Gothic-Demi ..................... . 

Franklin Gothic-Book ..................... . 

Franklin Gothic-Demi Oblique .............. . 

Franklin Gothic-Book Oblique .............. . 

Franklin Gothic-Heavy .................... . 

Franklin Gothic-Heavy Oblique ............. . 

Helvetica-Condensed-Light Oblique .......... . 

Helvetica-Condensed-Light ................. . 

Helvetica-Condensed-Bold Oblique .......... . 

Helvetica-Condensed-Oblique ............... . 

Helvetica-Condensed ...................... . 

Helvetica -Condensed-Bold ................. . 

Helvetica-Condensed-Oblique ............... . 

Helvetica-Condensed-Black ................ . 

Typewriter (mono-spaced) faces 
(International Character Set) 

American Typewriter-Bold ................. . 

American Typewriter-Medium .............. . 

Machine ................................ . 

Courier-Oblique .......................... . 

Prestige Elite ............................ . 

Prestige Elite-Bold ........................ . 

Prestige Elite-Bold Slanted ................. . 

APPENDIX K-FONTS 

PostScript 
File Name 

HLV __ 

HLVO __ 

HVBL __ 

HVBLO_ 

FRD __ 

FRW __ 

FRDO __ 

FRWO __ 

FRH __ 

FRHO __ 

HVCLO_ 

HVCL __ 

HVCBO_ 

HVCDO_ 

HVC __ 

HVCB __ 

HVCO __ 

HVCBL_ 

ATB --

ATM __ 

MAM --

COURIO 

PERG --

PEB --

PEBSL -

Face ID 

54 

54 

55 

55 

56 

56 

56 

56 

57 

57 

58 

58 

69 

59 

59 

59 

60 

60 

100 

100 

101 

102 

103 

103 

103 
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Typeface 
PostScript 
FileName Face ID 

Prestige Elite-Slanted ...................... PESL__ 103 

Orator-Slanted ............................ ORSL__ 104 

Orator ................................... ORRG__ 104 

Letter Gothic-Bold ......................... LGB__ 105 

Letter Gothic-Slanted. . . . . . . . . . . . . . . . . . . . . .. LGSL__ 105 

Letter Gothic . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. LGRG__ 105 

Letter Gothic-Bold Slanted .................. LGBSL_ 105 

PI Fonts (Different Character Sets) 

Symbol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. SYMBOL 128 

Zapf Dingbats ............................. ZDM__ 129 

Sonata . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. MUSO__ 130 



APPENDIX J 
STYLE SHEETS 

Ventura Publisher includes 20 different style sheets. Each style sheet is 
named according to the following formula: 

• &-identifies an original style sheet supplied with the software 

• P or L-identifies the printing orientation as portrait (vertical) or 
landscape (horizontal) 

• Digit-number of columns in the style sheet 

• STY-file extension for a style sheet 

Thus, a book style which is printed portrait mode in two columns is 
&BOOK-P2.STY. Below is a complete list of style sheet titles with a brief 
description: 

&BOOK-Pl.STY 
&BOOK-P2.STY 
&BRO-L2.STY 
&BRO-P3.STY 
&INV-Pl. STY 
&LSTG-P2.STY 
&LTRI-P 1. STY 
&MAG-P3.STY 
&NEWS-P2.STY 
&NEWS-P3.STY 
&PHON-P2.STY 
&PREL-Pl.STY 
&PRPT-Pl.STY 
&PRPT-P2.STY 
&TBL-Pl.STY 
&TBL2-Ll.STY 
&TCHD-Pl.STY 
&TDOC-Pl.STY 
&VWGF-Ll.STY 
&VWGF-P 1. STY 

Book, 1 column 
Book, 2 column 
Brochure, landscape, 2 column 
Brochure, portrait, 3 column 
Invoice form with line items 
Product listing 
Letter 
Magazine 
Newsletter, 2 column 
Newsletter, 3 column 
Phone listing 
Press Release 
Proposal/report, 1 column 
Proposal/report, 2 column 
Tabular financial table 
Columnar table 
Technical manual 
Technical manual 
Viewgraph, landscape 
Viewgraph, portrait 

The style sheets provided with Ventura Publisher represent common 
publishing applications. Any style sheet can be modified to fit your exact 
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APPENDIX J-STYLE SHEETS 

needs. Just remember to make a copy of the style sheet before editing so 
the original remains intact. Any changes made to a style sheet affect all 
chapters which use it. To make a copy of a style sheet, use Save Style 
As in the File menu. 

Ventura Publisher also provides an example chapter file for each of the 
style sheets. The chapter file provides a text and frame template for the 
style sheet to format. 

To look at an example of each style sheet: 

> Select the Open Chapter option in the File menu. 

> Select the chapter name which corresponds to the style sheet you 
want to see (e.g., &BOOK-Pl.CHP uses &BOOK-Pl.STY). 

Ventura Publisher also contains several other style sheets: 

CAPABILI.STY Used by the CAPABILI chapter to visually show you the limitations of 
your printer. Open this chapter and then print it to see whether your 
printer can print white text on a black background or transparent 
graphics. This chapter also shows you what font sizes your printer can 
print, and how much space it leaves around the edge of the page. The 
CAPABILI chapter is shown on the next page. 

SAMPLE1.STY Used for training exercises. 

CHARSET.STY U sed by the CHARSET chapter to display and print the Ventura Pub­
lisher character set. Printing this chapter will show you what characters 
your printer can print. 

J-2 

SCOOP.STY U sed by the SCOOP chapter to display an example of a typographically 
sophisticated page. You should open this chapter, then select individual 
frames to see how to create a complex document. 

To see an example of each style sheet:, open the chapter which has the 
same name as the style sheet, e.g., to see an example of the &PHON-P2 
style sheet, open the chapter &PHON-P2.CHP. 
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pnnterwidtht:lhlC'~conl.llnlem-

109 infonnatlon.IfyourrnnlC'r 

~I:~I~:~e :;c~:;~ ~~:~, i;: 
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CAPABILI.CHP 

Chapter! 

The Adventure Begins 

T~:.e~16:=:~I~~~I~ ... I~n~::~~:f:l:~~:::e 
fa,hlOn ,howwhn:h Ro,h-Pre\bylt"flan-St. Loke'~ 
M"dlc<l1 Center holth e~ery yC'ar. The pnze wa~ Iwo 
roundtriptid(,l~toHongKongonCnut'dAlrhne~. 

and ten night, in the Hong Konil Hyatt Hotel 
AnalyzlngoorgoodfonullC'.weconciutkdthatwC' 
wanted 10 do moretholll ,pend ten day, in Hong 
Kong and return. bUI at the .... me Um.:. L'mted. 
ha~mgju'lgOllC'njl,roule~andeqOlrn\C'ntfromPan 

Amencan. had not yet recei~"d aulhonty 10 Ily to 
otherde~unauonsorbc:lweenpoinL,mthehrEa'L 

~ 
Figure 1-1. Place yoorown picture in this 
frame 

The Adventure Begins 

On Fehru<l/)' IOth,lJnlledacqulredthj~authonty. 
andonFebruatyllthDebbiebc:ganpouingourtrlp 

~~;~e;6:.C' ~C'C'ftC'~;e~t:~e~n~o:~n~:.u:!,~~ 
o~er 25.000 m"e~ on four airlin.e ... made o~er 500 
Kodachrome@ ~Ijde~. almo~t 200 Kodacolor@ 
pnnL\. and 5 112 hour-. of color and wund \lu.leowpe 

Chicago to Tokyo 

o~~~~~ !:~;:;;.a::~~~~'~:'r::: ~e~~::m:~he4~ 
mlnotes 001 of los Angele~ WIth .. bout 2 more hour 
logo to Tokyo. Wt!! were aboot an hooraod ten 
mmote~latcoutofLosAngeles 

TreveiLog 
So far. u's reen a long and mtere\ungday and I 

goes~ ifsjo~l about halfo~er. Wedld the followmg 

o Aro-.eat5:30A.M 
ouftlhehou..eaI7:00A.M, 
o Am~edin LosAngde~aI 12.35 P M. 
o Amoved In Tokyo:1I 11.46 P.M. 

&BOOK-P2.CHP 

Mr I ~1"'LlI" \oJ-v I I L-L- vi IL-L- I V 

The Adventure Begins 

Chapter! 

The Adventure Begins 

Thi~ tri.preall~ began in Sc~temhcrla'i ~earwhen Gerry w{.m firsi. 
pnlelnaralneallhcf.l.,hton-"how~hu.;hRu!<.h-Pre!<.bYlenan-SI 

lukc'!! Medical Center holds every ycar. The priLc was IwO round 
lnp tu;kels 10 Hong Kong on Unilcd Airhnc~. and ten mghts in the 
Hong Kong Hyatt HOle!. AnalYLIng our g{kld fortune, we concluded 
Ihal we wanted 10 do more Ihan -"pend Icn days in .Iong Kong and 
rclurn.bulalthe!<.ametime. Unitcd.havingJusl gouen il'i routes an d 
clJuipmenl from Pan Amerkan, had nol yel rccei\'ed uUlhority 10 ny 
loolherdc!<.tinalion.\orbctween polOl.~ In Ihe FarEa!<.l. 

I~ 
F.gurel-1 ThiS pICture has very litlle 10 do with Ihls slOfy. You mlghl 
wanlloplaceemoreappropn8leplclurelnthlslrame. 

On February 10th. Uniled acquired Ihis authonlY, and on February 
Illh Debbie began pUllmg our tnp IOgelher. We left on March 2nd 
andrclurnedonMJrch26Ih.WecnlerC'd~\lcncountries.lravcled 

over 25.000 milcs on four airlines. made over 500 Kodachrome<!!l 

&BOOK-Pl.CHP 

ACME PUBLISHER 
Professional Publishing For Your Desktop 

The Power of the PC 
Meets the Power of the 
Press 

Specifications ments, catalogs. proposals, 
and magazines, Plus, you 

Acme Software introduces a 
new generation of desktop 
publtshing. for the IBM~ PC 
family which is fast. easy. 
and designed so you never 
need to learn a point from a 
pica, or a serif from a sub­
head. 

Now you can take text from 
your favorite word proces­
sor, and graphics from 
popular graphics programs 
or scanners. and Create 
professional, typeset quality 
documents. Without being a 
professional layout artist. 
typesetter or graphic desig­
ner. You don't even have to 
think like one. 

You can compose any docu­
ment that you desire in a 
fraction of the time it would 
take to send it to a typeset­
ter, proof it, and print it. 

Feature Mull. Mod. Rel.1 can design your own, or 
mochfyours. 

Text Yes Yes Yes 
You choose your design by 

Picture Yes No Yes selecting a style-sheet. 
Click. Load lexl from your 

Graphic Yes Yes Yes wOfd processor. Click. And 

Figure 1. ThiS IS the caption 

With the Acme Publisher™, watch it flow, instantly. into 
all you need to know is how your format. 
to point. The mouse driven 
software contains dozens of You want three columns. not 
professionally designed two? Click, Done, The whole 
style-sheets-for newslet- chapter, up to 100 pages. is 
ters, flyers, technical docu- now three column format 

&BRO-P3.CHP 
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1-\1'"'1'"'t:.I\lUIA .J-\::I I Y Lt:. \::Int:.t:. I \::I 

The Title of The Seminar 

A Short Description of the Seminar 

July 23. 1987 
MariottHotei 

Detroit Michigan 

Some sales bturbthat makes a person want 10 attend your seminar. 
Highlights of lasl year's seminar. How many people showed up. What 
you can expect this year. 

Firslevenl 
Mr. Joe Smith 
VICtI-Presidsn! 
XYZCorp 

A brief descriplton ofwhal Mr,Smllh will talk aboul. 

Second Evenl 

Exhibits 
All kinds of InterestingexhibilS. 

NeKltalk 

~;;;~~~~ales 
RTYlndustries 

Ms. Jane Schwartz 
Treasurer 
NBCo.Ltd. 

Whal he plans to lalk about. 

Ms. Schwartz Will lalk aboul all kinds of Interesting things 

&BRO-L2.CHP 

Digitizers 

microPublishing Report 
Digitizers 

DeciaionWare..lnc ••••••••••••• (555)3836059 
RlghtWnter 
~~ment end style proofreader for IBM PC 

Small Computer Solutions for Publications Professionals 

March1,1986 

Mr. Joe Smith 
ABC Corporation 
123 Main St. 
Detroit, M143434 

Quantity Description 
1 Subscription 

Seminar fee including 
late charges 

AedondoBeaCh,CA90278 

INVOICE 

Price 
$175.00 
$575.00 

(213)376-5724 

Subtotal 
............... $175.00 

... $2.875.00 

Total now due: ....................................................................................... $3,050.00 

&INV-P1. CHP 
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ChoruaDltaSy.tem ••• 
PC·Eye 

.... (555) 424 2900 IBM PC 96K, DOS 2.0 

~~~~caPture Image digitizer EmerglngTechnology ••••••••• (555)4479495 
Professional Wrilers Package 

IBM PC 256K, long slot :~~:r~sSlng and document development 

~::I~i~;~;'~'system .(555)9657900 ~~~~ 
~~~~~~gltlzmg camera wrth computer interface 

~e~~~:~rd 
~~r;:a~~doetext,lnc, •••••••.•• (555)9646300 

~:s~~ngsoftware 

~~~'~i~:hnologl •• ,lnc .•••••.• (555) 676 5655 IBM PC Of'Macintosh 

;a~~~:llzerfor Macintosh computer ~~~:~~::Ire ..•••••.••. (555) B2B 2222 

89.00 
~~c:~i:i,'on Co. •.•.•..•..•.•.. (555) 43B 5520 IBM PC 

~M~a~~;,~~~lIzer for MaCIntosh =~::~~~~nc •••••••••••••••• (555) 742 6677 

..... ',""'" J:r~~iling,colT8cting,andcomposilionsottware 

~~I:~~~a~:::!' .............. (555) 923 6666 :;5.00 
~~~~npul digitizer MS DOS 

laM PC 360K, DOS 2.1 Tel Software Research •••••••• (555) 522 4600 
T3 

Editorial Software :5~~fiC word processing syslem 

IBM PC, 512K, graphics 

:~;,;=~.tem'lnc, ....... (555)292 6425 :,r=~/~~~sultants ........... (555) 377 0130 

~~~~~sed text processing system ~;~~~; thesaurus 

IBM XT IBM PC 

.. ,.1 

&LSTG-P2.CHP 



Mr.J.Smllh 

123 MainSt. 
Dctroit. MI 98989 

Dear Mr. Smith. 

12]SoIppolToRoad 
Palo\V(rtk\.CA90::!74 

(S~~) S",I-12]", 

NovembcrlS.1987 

It ha~ been called to our allentlon that you have been having a difficult time with our new 
widgel. Upon reviewing your ,a~e. we have found that you have failed to plug your widget into 
an electrical outlet As may know. our widget dO(Joo require power to operate properly. 

Thank you for buying our widgets. and we IlXlk forward to your cOOlinued bu~iness. 

Sincerely. 

lohn L. Smith 
Customer Service Manager 

&LTR-P1.CHP 

Widget World News 
Views and News of Widget Manufacturing In the 80s 

Software Salaries: How do you stack up? 
by Joe Smllh 

Howmu~hyourM)ftwareprofe"'\lonal\artp'lldl\afunction 
ofmanYYlU1able!..anda~ub.tectofcon\lder"h1emtere'llOyour 
organlzallon 

CD-ROM Breaks New 
Ground 

Compllcl Ol~k Read Only unalterable. al .... a~~ em.urmg 
Software lalary pay scale. Memory KO-ROM) i\ II r ... p· Ihe ongln ... 1 copy h mtact. 

Becau~ of Ihe dynamic growth. of the ~fl .... an: indu\lry idly emergmg new technol- making archl ... mg ea~y 

~:~r:':~~ ~~~~~~ i~:;~d.t:U~~~~~I~c~~ ~::~~~: ~~o:~~.\ I~: l:r,~~"'a~o~f f;:~ c':'~n~'::.ae~~0~~r~r~0:,. 
of-.alancs. lin opllcal di~k. Thl\ new CD·ROMbringanenonnou~ 

Bul whal CdU!ot~ mllllllgeT"l 10 pay nne: progr-olmmer IfIUf't penpheral de'lce allow~ a 10- new capolb.tlly 10 nllCrocum­
lhananOlher?[)oe<,lhelypeOf~aOllaIlOn.ll\\llc.orlocal1on lally ncw le ... el of funL" pUler u ..... r.. -!hat h. mfor­
rnakc,ditlerenL"e1Whal"lII'ft'rpalhorpm8r-... mmms~peciahl' Iionailly In Ihc u~c of m~hCNl rttnc~ill ofycl')' largc 
leads 10 Ihe mo\1 rtmuocral1on? mlCrtl(;ompuren;. reference publl!;aIICNl~. How 

do~T:/i~~:~~~~~u~~~:~"n~~i= :::~~;~: :.~;~ ~~: de:'~:~~~I~ia~ ;~~~~ ::~~!, :c~~el~,!~~~n~: 
fe~~lonals. Thl~ nc:w\!etter article pre-.enl~ the re\ults of !hl~ (or "player") the !WIll'll!! ~iu a~ long tenn i'ulurt .... 111 be dra­
~tu,Jy and e~plore~ whallhe findlng\ may mean 10 you. II tradItional S 114H tlmc. The malically changed by CD· 

Acme Magazine a~ked Joe Smllh. a compen!WIuon con~ull- removablc dl,J;. is 4 3/4". lind ROM 
ing !.peClah~1 for !he M)ft .... ~ inJU!>lry.lo ~~Ig~ and ConduCI ha~ II cap;u;lty of 5S0M bytes In ailiiltiCNlIO lhe huge "11_ 

the~urvey.Twenly-fourpo-.lUon,,-repre-.enlmgloorprogram- (e4uhaleruto 1500 360K padlY of raw informallon 
mer Job fanl1he~ plu~ managemenl. were mcluUed. tloppydl\h) \lonlge. ~ciahzcd soflware 

Data .... a\ colle~1ed for ba ..... pay.l!ono~ and in .. enl1~e pay- forthe !otarch of thai infonna. 
ments. and whelher nor nOllocumbenh recelllcd \Iock opllon~ Theory of Operation lIOn i\ currently being iruro-
orolhtrfonnsofequity Informallon stored on a duced. This :.oftwane allo .... ~ 

Que~tionnaire~ were !oent to the data proch,mg head\ 01 CD-ROM can be loaded into !oearching lhe mformallon in 
2.400organizauons throughout the Uniled State~ memory (RAM). di\played areas.melhod~lInd\peed~not 

and prmted. II~ with olher pre ... iou~lyfea\lble. 
me<llil. While that data in It now bfi:omt', .... " .... hle to 

RAM may be altered and eleclromcally publi~h rtler· 
\tored 10 a .. on ... en[ional mag- c.w;ematenalmore«onoml-

~~~~O~I!~ I~ o~b~~~~o~: ~!~~:t7n I~n~!:. ~": 
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Laser Printers Anive 

~::'l:;Sccr:~~..a~ Competing T.chnologle. 

Computer 8usin~ • OIlI\Y Wheel 

;",rphSmllhpllmrrrrd,hrp"hlnhIIIK 
"ly'l"r""'''I'~tnKlhrfiflll/llllr'hr 
I'hrulrp",(rlli,mulPllbI .. hlllK 

A~la-crpnnlCr~i:alnmllltlitlCnll'lO 
with lower pn~'(". hillher \fIt"tu~ anu 
4UIIIII)' oUlput. hlj;h-end dill-millr.,. 

·I.Il ..... rpnnttl'll 

• I ........ ' Jlnnltno: wuh .... nlt· .... hlle 
tnglne~and,npltropuon~.u .. nl 
dr)'po",tJcrtoocr 

La ..... ' pontelli \1111 hu~c • Ie .... IU't'lI\ 
th.il could he IInproYed. lICcordlng 10 

~~·~.~~J·:~o!r~r~;~::~:~~:~ 

FlguR!.I. 
Japant: ..... S.tles 

prmlel'oare!>latllni:lolu!ot\Omcofthclr 
appeal. 

ThouGh PC u ..... 1'0 aR! \1111 bUYlngdtlt­
matrl" prlnttrs. Ihc I",cr pnnler 1\ 

~IYInt: thcm lin ~ltcrnulI ... e 10 Ihlllk 
at1out.oII:~unlmgtolnuu,tl')'oh ..... rve .... 
u.~r pnnle ..... lrnl\lgh rtlall~cly u-

~~~I;:. elln~I:::~~cn~~~~~el: :~ 
Inbuted u ..... or the prmler Ju,"f1e~ lhe 
upcn ...... -.c'Ytroll.mal}'l\ .... ld. The non· 
Imp",,'1 pnme .... "I\O~""h u...:rmtere't 
be .. dU ..... they are Ie" n')I'Y. on'cr \har_ 
per graphics (~ommOflly 300-l'Iy']00 
dOl~ per In~h) lind f;:un produce from 
el[;hllolOpolge'fIt"rnunulc 

~t)nlrollt" farla"" pnnl!;' .... alkl hUI the 
CO\I of U'lng. la<,tr I~ no .... Ic ..... thlll1 .II 

~~~U:oI~:~~\ on ... o\I-pc:r·copy pcr 

Tht I" ..... r pnnln pro ... lde\ ~harper 
graphiC llnal!t\. lllne~ oOlell. II.nd lhe 

This is a liftout. It 
highlights a key quote or 
statement in tire artic/e. 

I ........ r no .... ha~ the wnhh of ~.ofl .... are 
~uppon dOI·matra pnn1l!' .... h .. ~e .Iway~ 
enJoycLi. So. if M u-.er mo~e~ to a la..er 

ponlerfnlmIlU(} ... matrl~prlnter"heClin 
I1,In much ofhl~ gr"phl~\ .. urtW1l!e and 
~I~ '-:lItr graphlC~ rt'olullon:" Junc' 

"The OCll 'lep I~ de"'elopmg leocnc 
grnph ... :~ dn ... en. whl~h ~uppon la ..... r~ III 
.1()()-l'Iy •. \(Xlrt..oJul1on.ll'la .. M .... hen 
you .... II!>«. hUlle Impllcl on dul· 
ffiUlnlpnnten..hmhinpr,.:candlhe 
numhcrnlunlt~\hlpplnl:."he\ald.lld· 

ulnl,llhalll"'llIhellyearlolllmonlh\ 
be'IllC Ihl~ h"pptn\ 

Jtlne ..... a,qUl .. k 10 pomloullhalhe 
nc ... er !oeC\ lltlt·matrl~ pnnlCn. lll-.ap­
(leolnng, "Mulllple·p.u1lorm~ ure \[.11 

::~:~a~~~ ~~,~nH~m~:1 :~I~~e:h:~ 
~:~~~ I:~I~:~:~,~~;I':~~O~\~~:~; ~~; 
4ul .. ke .... mo\t coo.l·elth·lenl .... lIy of 
dOing th .. t 1\ [hruugh • low_~o\1 dOI­
ffiUtrlllprlnler-.... llhoulha~InIIOWIlII 
mhne'or.-.harela""'rpnnter.Curren, 
sale\ flj!:urc .. <otenllO bear Jont:~ oul. In 
II .. June 1911~ Siore BOlIId SUrYty. 
markcl-rt..e..,~h fIrm La ..... rCompulmg 
ofAloImo.Teu,,-pollcdoyerbOOf;:om. 
puter \pe~loIJly\ltlre\ rtndlnl thai. \o\hlle 
la ..... r·pnnter \II!c\ OIne lip. lhe)' ha~t nOI 
edlp-.eddo[·matrl~p"nlef'\ 

La ..... ' CtlmpUlln~ anal)\1 Todd Wlg­
gln~ \ald he elJlCl'l~ UOHIl"lrIl prmlr" 

:~~;:~I:I~: .. ~~::::g~~~~-;:~~;:~~ 
nologle' un .... ork welll\l~thfr. "II 
you· ... t- gOl.llla-cr ~h1llCd hy sn 10 10 
people. you ma~ ~hll have dOI-mallm 
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Widget World News 
Views and News of Widget Manufacturing In the 80s 

142GuilrepPkwy Detroit.M/98987 (413)567-9888 

Software Salaries: How 
do you stack up? 

byJoeSomh 

tllIW mu .. h )our \O', ... are profe\ 
\lonal~are paId i\ II fuOCllOn of many 
yunah!c\.unt!'MlbjCClolcon\ltkrahle 
mtere..z10 yourorgaml.llion 

Softw., ... larypay scalel 
Bef;:au ..... oflhe dynamic I:rowthof 

thc M)liware mdU!>lry o~er the la\1 
de~·aJe.lhet.lemanll for uperienL'(d. 
4u..thlkd prollrllmmer\ha~gn:"tly m· 
~::~. Ihu~ leadmg tO.ll '1malmg ot' 

But WhMI ~au..e~ manager. 10 p~y 
ont: programmer mon: Iholnanother'! 

~(~~~~~~:eoi~~;·:::~~~~'~l~~~~~; 
~e ... :~rl:~~ :!~~~~:~;I~;.'7dalty 

To IIn~ .... cr lhe ..... 4ue\lInn~" Acme 
Maga.zmertcentl~contJucled it~lhlrd 

annual compen\allOn \uryey for 
:.o'iware prolt~\jonal\. Thl~ new\lel­
ler artiCle pn:~ms the re\ulllo ofthl~ 

~y ~-::. ~:~~:s whal lhe lindmg~ 

A .. me Magazlnt: a,l.edJoc SmIth. a 
compcn...alloncon~ulung~pecllih"'lix 
the soli .... 1IIC jndu~uy. 10 de\lgn .. nLl 
conducllhe~uney.T .... ent)'·'ourpo\l­
Ilon~. repre-.enling four programmer 
job fllmllics plu\ management. were 

included 
Dalll wa~ collected for bu!oC p~y. 

::~~~:~orl~:~~;:::n~e~;~I:: 
~Io..k opuon\OfOlherform~ofequIlY 

Que,lionnalre''''eresenllothcd.ua 
proce\!.lug head~ of 2.400 orgamza­
Ilon~lhrou,h(IUllhe L'nllcdSwte~ 

CD-ROM Breaks New 
Ground 

Compact Ol!ok Read Only Memor), 
(CD· ROM) I~' raplJI~ emergmg lit ... 
le .. hnuhlgyforlherelrJe\lIlofYII-\1 
amounl~ofln'urmill1on from an opu­
ul d"k. Thl~ new pcnpher.tl tk ... IL'( 
allow .. a klwlly new leYel of fun .. -

uonaht)inlhC'u..eofmluocomputer~ 

PhY\lCdlly. lhe CD-ROM de~lce 
has ~ la ..... rdl~1. dnve (or "player") Ihe 

~ r:~~~:b~etr~~l~\n~ ~41.~.4~n~n~:~ 
a capa .. lly 01 550M byte~(eqUivalenl 
10 150036()Ktloppydl,k .... ). 

T~~u~~~(~r~~~n ,CD-ROM 
can helooded into mcmury(RAM). 
dhpla~ed ~nd printed. a~ wllh other 
media. While Ihat dala m RAM may he 
aitcredandMol'I!dto aconvenllon ... 1 
magnellcdl ... k.lheongmalmformation 
on lhe CD-ROM I~ unaltcr ... ble. alway~ 
enwnng the onginal copy is intact. 
making archlvmg ea\y. 

The~lor ... geCap;H;lIy.lowoo\I.llnd 

R'adonlyfculureofCD-ROMhnngun 
enormou .. new c ... pahlilly 10 
mlcrocompulcr u ..... 111 - 111 ... 1 I~. mfor­
mallonrelne ... alotltrylolrgeref\·t\·nce 

~~It~~:~~;;.~nn~ ~~:~I:~~~~: :~~ 
Jongtcrmfuture ... illbedramilllc"lIy 
changcd h~ CD-ROM 

In ilddlllon 10 the hUlle C"pol"l~ of 

~,~~~70~~~:~·~~a!;;h:~~;~~eM~ 
1I0001\t,;Urremlybemgmlroduced.ThI\ 
.. (]II .... areallow~>C .. rchmglhelnfonn ... -
lion III oIre ... \. n1C[h()d~ and ,peed\ nol 
preYlou .. l~f""'Mbl .. 

II now hecome\ pO~\lble 10 
electronlcall), puhll~h relerence 
mal~nal more ecooomlCally than 10 
pnnllhCloiimematenallllboukhlrm. 

~I~~I ~~;:I~ ... o;r,~~;.:~~~~ .... ~ha~ar~~ 
.. \lonl\hlnllpnce/pcrtormancerolilo 
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PROPOSAL TO ACME INSURANCE CORPORATION 

Corporate Training 
The Corporate Training depanment has identified an objective to redesign and reformat over 
9000 pages of textual and graphic information which constitutes the company's training 
documentation elements. In addition to redesigning this substantial amount of information, 
the depanmem will also add new sections to the current training curriculum. The training 
documentation is currently available in a variety of media. mostly on m uchcopiedpapers. 
The documentation is somewhat out of date since the collection of materials dates back ten 

years_Accord;nS'Othecorporateo;rec,orD 

~~J~~in_f~~g~ht.i~e~f~~. ~I_~~~~%:a~~:~~ 
bon has hired a consuJtam. Ms. Joan Belden 
who has deSigned a specific format and 
process forthe trainingdocumemation. Ms. 
Belden will become a member of the Acme 
Insurance staff to coordmate the processes 
ofrewnting the documentation. 

~~:~~~r~~h~~~~. a~~~~~~~s~f~~:!;~ a;dd FIgure 1-1 The caption for Ulis figure 

priorities, the training depanmem does not 
havereadyaccesstothisfacility,Duetothesizeandnatureofthisproject,adecisionhas 
been madetoevaluatedepanmemal or work-group desk-top publishing s olutionsspecifi­
cally for the training facility. Havingandepanmemal facilityfordocum entation will give 
the training operation the following benefits: 

• Fast turn-around time wilhout having to depend on another corporate dep anment 
to print documentation. 

• Ability to make immediate changes and update training modules. 

• Ability to use already installed Personal Computers and Word Processing equip­
ment in association with the new publishing equipment. 

• Ability to incorporate the new machinery directly into the day-to-dayope rations 
ofthedepanment. 

Tho TXN Solution 

It is the recommendation of TXN Corporation that Acme Insurance consider the 3544 
graphic workstation as the input terminal fortheredesignfreformat proces sesinthetraining 
facility. TXN was the first company to offer this unique type of workstation. In 1976. we 
introduced the 9967 professional computer which had the power of combining textual and 
graphic elements on the same screen. Now. ten yean later. after many modifications and 
refinemems of our original technology. we are proud to introduce the 3544 Professional 
Workstation for publishing applications. 

Pagel 
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AlaxCorp. 
uaders m Industrial Innovation 

pal~~3';e~~~:~~74 
(555)541-1234 

FOR IMMEDIATE RELEASE 
For mort information· 

Mr. lot Flack 
(2/2)555-1212 

XVZ COrp. Ships 1000th Product 

WS ANGELES, CA, July 17 -XYZ Corp .• the leading manufacturer of widgets for the 
automated widget supply industry. announced that it has shipped its 1000thModeI123-Xenhanced 
widget. The customer is ABC Inc. of Livonia Hi!1s. MI. 

"This is an imponant step for XYZ Corp .• and the emerging widget industry," said Fred Smith. 
president of XYZ Corp. "We have now shipped more widgets than the other ten companies 
combined. We believe our technology is second to none." 

Marketing plans, availability, and pricing for the new widget line will be announced later this fall. 

XYZ Corp .• Inc. was formed in 1975. Headquaners are in Los Angeles California. 
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PROPOSAL TO ACME INSURANCE 
CORPORATION 

Corporate Training 

The Corporate Training depanment has 
identified an objective to redesign and 
reformat over 9000 pages of textual and 
graphic information which constitutes the 
company's training documentation ele­
ments.lnaddiliontoredesigningthissub­
stanlial amount of information, the 
department wiIJ also add new sections to the 
current training curriculum. The training 
documentation iscurrentlyavailableina 
vanetyofmedla,mostlyonmuchcopied 
papers. The documentation is somewhat 
out of date since the collection of materials 
dates back ten years. According to the Cor· 
porate Director of Training, there is no or­
derlyfashionordesignforthisinfonnation. 
The corporation has hired a consultant, Ms. 
Joan'Belden who has designed a specific 
format and process for the training 
documentation. Ms. Belden will become a 
member of the Acme Insurance staff to 
coordinate Ihe processes of rewriting the 
documentation. 

Currently. there isan in-house printing and 
type-setting shop. Because of delays and 
priorities, the training depanmem does not 
have ready access to this facility. Due to the 
size and nature of this project. a decision 
has been made to evaluate departmental or 
work.-group desk-top pubJishing solutions 
specifically for the training facility. Having 
andepanmemal facility for documentation 
will give the training operation the follow­
ingbenefits: 

• Fast tum-around time without 
having to depend on another cor-

Tltleof Repor1 

porate department to print 
documentation. 

• Ability to make immediate chan­
ges and update training modules. 

• Ability to use already installed 
Personal Computers and Word 
Processing equipment in associa­
tion wilh the new publishing 
equipment. 

• Ability to incorporate the new 
machinery directly into the day­
to-day operations of the depart­
menl. 

D 
RgUr1J1-1 The captIon for this figur&. 

The TXN Solution 
It is the recommendation ofTXN Corpora­
tion that Acme fnsuranceconsiderthe 3544 
graphic workstation as the inpul terminal 
for the redesignfreformatprocesses in the 
(raining facility. TXN was the first com­
pany to offer this unique type ofworksta­
tion. In 1976. we introduced the 9967 
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Header for Table 

Firat Entry 

Entry 13 

Income 
Sales.... . ... $1,234,567.00 
O'ber!ncome l?fiZ8M 

Totallncome .......... .......... $1247245.00 

Coal of Solie. 
CoslofGoods ... , ............... $234,344.00 
PaCkaging... ..12.654.00 
Olber 12212 00 

TotaICostofSale ............... $259230.00 
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Title of this table 

Next Column 

The second column deSCribes some 
leaturesoltheilemcalledoutlnthehrsl 
column. Nollce thai th.18KI for the 
column III 100 wide to III on one Ime. 
ThiS type 01 style mtght be uselul Ina 
~:Sflson chart where flowing text Is 

More descnptlV9 teKt about entry num­
ber three. 11'1 called WYSIWYG. II 
means thai as you edit and modlty. 
your screen showS you ,xactly what 
yau'regomgtoQ6twh6nyouprlnlltOUI. 
Nosurpnses. It'S .11 there In ffOfltoi 
your eyes 

Third Col. 

The third column might expound a btl 
on lhe second column. Bulthe lourth 
column just holds a number. luch8S 
prK:8. 

Price 

$66 
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$1,345,678.00 
2467700 

$1370355.00 

$456,765.00 
54.678.00 
56 56700 

PUBLISHING CHAPTER 

MENU COMMANDS 

Mo!>! of Vt'nlura Puhh,ht'r's rUlICllon~ 11ft' conuollt'd through lilt' 
menu~allhelopoflhe Sl:reen. Thi~~cuon de'oCrJOe,thc operatJOnof 
each oflhe~ Olenu~ and lilt opllon~ wllhm them. The..e command, Ilft' 
pre..ented in the order in which they uppearon Iht Sl:rcen. UIIC the 
InJell,roranalphabeucalrefertncetothe..ecommand~ 

Menu Often, a menu option Will be .... own In gl1ly and canllOI be highlighted 
Convention. TtIJ~ u.\uatly mdlCates thai the proper fUlK:tmn hll~ nO! been IICleCled 

lbt'lablebelowlIldiclllestlw:..edependencle, 

1--_---""-''--_-+__''=lw''''",,-· a\l .. ai!~~ 

1----'~~_-+__'A=lw~~ 

AvaJ~e~ ~:a:a~~r ha~ 
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1. USER INTERFACE Presentation Title 

1.1. WYSIWYG Presenter's Name 
Presenter's Organization 

FlgureH 
This is the caplion lor 

~h:c~~~;~' b~~ 
WYSIWYG 

Ventura Publisher is de~tgned to provide Whal You See (on the screen) Is What You Gel 
printed (WYSIWYG). This mean~ that the computer display ~hould match as (lo\ely as 
possibJe, III all times, what you I!. ill see on Ihe final printed page. Of course, th edlffcrence 
betwet'n the technolo,y used to display a pagcon a CRT screen, and Ihetechnolo glcsused 
toprintapallconllll!lerprinlCrorIYPC:loetler,docrt'3tcSUmeunavoldalllcdlfftrences.ln 
pal1lcular, because the computer CRT screen cannot produce anywhere near the same 
ftsolutionofaprinterortypesettcr,lI1ldbecau5elA-liatisdlsplllycdlsshownin. different 
a~peclralio(heighltowidthraho).thespacebetwecnwordsandbetweenline5mayappear 

to be bigger or smaller than thc printed page undercertam circumstanceS. Se\leral thin ruling 
lines, V.lth httle space belween. may s.how on theiCreen as one thick line 

1.1.1 Keyboard KeYI 

VIITlOUs keys on Ihe ke)board perform special functions; 

• The keyboard Cursor keys control theTe~ICursor(Thete~tcursorisdlsplayed 
asathm\lerticalline.) 

• The Home key gocs 10 the firsl page of the document 

• 'TheEndkeygoe5IOthela~tpageofthedocumen. 

• The Pg Upkey got~lothepre\llouspage 

• ThePIDnkeygoe~lOthenu.page 

Main Topic is the Most Important 

Use line breaks to add space vertically 
Use the special function keys as you type 
to tag the paragraphs you are typing 

For instance, this paragraph was 
tagged by pressing function key 
F5 

Another subtopic 
Still another subtopic 

This Is a Diagram 

1.2. ITEM SELECTOR Another Main Topic 

1.2.1 Delcrlption 

The di'if'l~y sho~n in Fil!ure 10-2 iscaUeoJ an Item Selecwr. The hem Selector 15 used for 
saving alld retrie\'ing files 

Subtopic 
Subsubtopic 
Subsubtopic 
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Presentation Title 

Presenter's Name 
Presenter's Organization 
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Main Topic Is the Most Important 

Use line breaks to add space vertically 
Use the special function keys as you type to tag the 
paragraphs you are typing 

For instance, this paragraph was tagged by pressing 
function key F5 

Another subtopic 
Still another subtopic 

Another Main Topic 

Subtopic 
Subsubtopic 
Subsubtopic 

Subtopic 
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APPENDIX K 
WORKING WITH OLE 

OLE (Object Linking and Embedding) is a function that allows Windows 
applications to not just transfer data, but to share common data by 
establishing a link between two applications. Both applications must 
have OLE capabilities in order to establish this link. 

The application generating the data in this link is called the server, the 
application receiving the data is called the client, and the data that is 
shared between the server and the client is called an object. Links are 
established by copying to, and pasting from, the Windows clipboard. 

Ventura Publisher is strictly a client application. Ventura Publisher can 
receive objects from server applications, but cannot act as a server ap­
plication to provide objects to another application. Also, Ventura Pub­
lisher cannot directly edit the contents of any object. Any editing of ob­
jects must be done using the original server application and file 

Ventura Publisher is completely compliant with version 1.0 of 
Microsoft's standards for OLE client applications. Ventura Publisher 
does not directly support DDE functions. If an application only supports 
DDE functions, this application will be unable to perform as a server 
application for Ventura Publisher. Likewise, if an application does not 
conform to version 1.0 of Microsoft's standards for OLE server applica­
tions, the application may not be able to perform as a server application, 
or may be limited in its capabilities with Ventura Publisher. 

Using OLE functions 

An OLE object can be pasted into Ventura Publisher in one of two ways; 
as a linked object (hot link) or as an embedded object (cold link). The 
main difference between embedding and linking an object is which 
application maintains control over the object. 
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When an object is linked with a Ventura Publisher chapter, the server 
application maintains all control over the linked object. Any changes 
made to the original server file from which the object was copied, will 
automatically be applied to the object and all client links to the object. 

The automatic updating of specific linked objects can be suppressed 
without changing the linked status of the object by using the options in 
the Object Properties dialog box. Refer to the Object Properties option 
description starting on page 6-52 for more information on editing object 
properties. 

When an object is embedded into a Ventura Publisher chapter, Ventura 
Publisher maintains control over the object. This allows the embedded 
object to be isolated from changes made to the original server file from 
which the object was copied. The original server file can be edited in the 
server application, however, the only time the embedded object will be 
updated is if the server application and file are launched from within 
Ventura Publisher. Once the server application and file are launched 
from within Ventura Publisher, the original server file can be edited and 
the changes applied to the embedded object in Ventura Publisher. 

Because Ventura Publisher modifies text by adding formatting informa­
tion, and Ventura Publisher cannot directly modify OLE objects, it is not 
recommended that OLE functions be used to copy text into Ventura Pub­
lisher. Using OLE functions to copy text into Ventura Publisher will 
limit the Ventura Publisher formatting functions that can be used with 
the text. 

Linked object 

When an object is linked to a Ventura Publisher chapter, a .VPO file 
containing data about the server application and file from which the 
object was copied and a screen image of the object is created. Each time 
a Ventura Publisher chapter containing a linked object is opened, Ven­
tura Publisher, using the information in the .VPO file, requests the most 
current copy of the object from the server application (if the object is set 
for automatic update in the Object Properties dialog box). If the server 
file has been updated in the server application a copy of the updated 
object is passed to the Ventura Publisher chapter. 

If the server application or file is no longer available (e.g., server 
application or file deleted or moved, or the chapter containing the object 
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is multi-chapter copied to a system which does not containing the server 
application or file) the object copied to Ventura Publisher cannot be 
automatically updated until the server application and file are again 
available. Refer to the File Management and OLE section later in this 
appendix for information on how to manage and move chapters contain­
ing OLE links. 

Linking an OLE The following exercises will demonstrate how to link OLE objects to 
object Ventura Publisher chapters and how the links function. 

~ Open an application (other than Ventura Publisher) having OLE 
capabilities. This application will be the server application in the 
OLE link. 

~ Open a previously saved file or create a new file using the server 
application. 

If you have opened a previously saved file and do not want this file 
changed, save the file under another name before proceeding. If you are 
creating a new file, the file must be saved before you can establish a link 
with Ventura Publisher. 

~ Using the tools in the server application, select all or part of the data 
and copy it to the clipboard (normally done by using the Copy option 
in the application's Edit menu). 

~ If not already running, start Ventura Publisher. Do not exit from the 
server application at this time. 

~ Although OLE objects can be linked with a previously saved chapter, 
for this exercise you should create a new chapter. The style sheet and 
chapter should be saved before the object is linked. 

~ Create a frame to hold the object. Objects can also be placed on the 
base page. 

~ Select the Paste Link option from the Ventura Publisher Edit menu. 
You can also select the Link Object option from the Paste Special 
option dialog box. If either of these options are not available (grayed) 
the application you copied from does not have OLE capabilities. 

The Save File As dialog box shown in Figure K-l is displayed. 
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Editing a linked 
OLE object 

K-4 

Figure K-l. Save File As dialog box for object (VPO) files. 

~ When the Save File As dialog box is displayed, select a location and 
enter a name for the .VPO file. Click on the OK button. 

The object should appear in the selected Ventura Publisher frame just 
as it appeared in the server application. 

~ Arrange the Ventura Publisher and the server application windows 
so that they appear side by side. This can be done using the Windows 
Tile option. 

~ Make the server application window active by clicking anywhere in 
the application window. 

~ Using the tools in the server application, edit the file. If only a part of 
the data in the file was copied to the clipboard, edit that part of the 
file. 

As you edit the file in the server application you should notice that 
the object linked to the Ventura Publisher chapter is also displaying 
the changes. 

Do not exit from either the server application or Ventura Publisher at 
this time. 

As discussed earlier, when an object is linked to a Ventura Publisher 
chapter a .VPO file is created containing information about the server 
application and file from which the object was copied. This information 
allows Ventura Publisher to run the server application and automat­
ically load the server file when you wish to edit the object. 
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~ Save both the file in the server application and the Ventura Publisher 
chapter. 

~ Exit from the server application. 

~ Click in the Ventura Publisher window to make it active. 

~ Select the frame containing the OLE object. 

~ Select the Object Properties option from the Edit menu. If the 
Object Properties option is not available (grayed) the selected 
frame does not contain an OLE object. 

The Object Properties dialog box is displayed. The Object Properties 
dialog box options allow you to change the properties of the selected 
OLE object. Refer to page 6-52 for more information on the options in 
this dialog box. 

The server application and file can also be opened by double-clicking in 
a frame containing an object. 

~ Select the Edit button. 

The server application and file from which the object was copied is 
loaded. The server file can then be edited with any changes to the server 
file automatically being shown in the Ventura Publisher chapter. 

~ Save the Ventura Publisher chapter and click on the New function 
button to display a new untitled chapter. 

~ Click in the server application window to make it active. 

~ Edit the server application file. Save the server file and exit from the 
server application. 

~ Click in the Ventura Publisher window to make it active. 

~ Open the chapter containing the OLE object. The OLE object will 
reflect the changes made in the server file from which the linked 
object was copied. 

When you open a chapter containing a linked OLE object, Ventura 
Publisher queries the server application as to whether or not the server 
file from which the linked object was copied has been modified. If the 
server file has been modified, the most current version of the object is 
passed to Ventura Publisher from the server application and the linked 
object is updated. 
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The OLE capabilities of Ventura Publisher and server applications are 
functions of the OLE dynamic link library (DLL) files. When Ventura 
Publisher queries a server application for information as to whether or 
not a server file has been modified, Ventura Publisher uses functions 
supported in newer OLE dynamic link library files. If the server applica­
tion from which a linked object was copied is using older versions of the 
OLE support files, the server application may not have the capability to 
correctly answer Ventura Publisher's update query. As a result, the 
server application will report to Ventura Publisher that the server file 
has not been modified (even though you know it to be modified), and the 
OLE object will not be automatically updated. 

If you find that linked objects set for automatic update are not automat­
ically updating, contact the manufacturer of the server application from 
which the object was copied for information about receiving a newer 
version of the OLE dynamic link library support files for that applica­
tion. 

To manually update objects that are not automatically updating when 
they should, select the frame containing the object, select the Object 
Properties option from the Edit menu and select the Update option. 

Embedded object 

When an object is embedded into a Ventura Publisher chapter, a .VPO 
file is created containing information about the server application and 
file from which the object was copied, as well as a copy of the object data. 
When a Ventura Publisher chapter containing an embedded object is 
opened, only the object data in the .VPO file is used and no communica­
tion or data exchange occurs between Ventura Publisher and the server 
application. If updated object information is required, the embedded 
object's server application and file can be opened from within Ventura 
Publisher, the server file edited, and the object data in the .VPO up­
dated. 

Embedding an The following exercises will demonstrate how to embed OLE objects into 
OLE object Ventura Publisher chapters and how the embedded links function. 
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~ Open an application (other than Ventura Publisher) having OLE 
capabilities. This application will be the server application in the 
OLE link. 

~ Open a previously saved file or create a new file using the server 
application. 
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If you have opened a previously saved file and do not want this file 
changed, save the file under another name before proceeding. If you are 
creating a new file, the file must be saved before you can establish a link 
with Ventura Publisher. 

~ Using the tools in the server application, select all or part of the data 
and copy it to the clipboard (normally done by using the Copy option 
in the applications Edit menu). 

~ If not already running, start Ventura Publisher. Do not exit from the 
server application at this time. 

~ Although OLE objects can be embedded into a previously saved 
chapter, for this exercise you should create a new chapter. The style 
sheet and chapter should be saved before the OLE link is established. 

~ Create a frame to hold the object. Objects can also be placed on the 
base page. 

~ Select the Paste Object option from the Ventura Publisher Edit 
menu. You can also select the Embedded Object option from the 
Paste Special option dialog box. If either of these options are not 
available (grayed) the application you copied from does not have OLE 
capabilities. The Save File As dialog box (Figure K-2) is displayed. 

Figure K-2. Save File As dialog box for object (VPO) files. 

~ When the Save File As dialog box is displayed, select a location and 
enter a name for the .VPO file. Select Save. 
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The object should appear in the selected Ventura Publisher frame just 
as it appeared in the server application. 

~ Arrange the Ventura Publisher and the server application windows 
so that they appear side by side. This can be done using the Windows 
Tile option. 

~ Make the server application window active by clicking anywhere in 
the application window. 

~ Using the tools in the server application, edit the file. If only a part of 
the data in the file was copied to the clipboard, edit that part of the 
file. 

As you edit the file in the server application you should notice that 
the object embedded in the Ventura Publisher chapter does not 
change. Embedded objects are isolated from automatic changes made 
to the server file. To update the object, you must use the Update 
option in the Object Properties dialog box. 

Updating an As discussed earlier, when an object is embedded into a Ventura Pub­
embedded OLE lisher chapter, a .VPO file is created containing information about the 
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object server application and file from which the object was copied as well as 
the object data. This information allows Ventura Publisher to run the 
server application and automatically load the server file when you wish 
to update the object. 

~ Save both the file in the server application and the Ventura Publisher 
chapter. 

~ Select the New option from the Ventura Publisher File menu to load 
a new untitled chapter. 

~ Make the server application window active and edit the server file. 

~ Make the Ventura Publisher window active and reopen the chapter 
containing the embedded OLE object. 

When the chapter opens notice that no update dialog box is displayed 
as it does with a linked object, nor is the embedded object changed. 

~ Make the server application window active and save the server file. 

~ Exit from the server application. 

~ Click in the Ventura Publisher window to make it active. 

~ Select the frame containing the OLE object. 
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~ Select the Object Properties option from the Edit menu. If the 
Obj ect Properties option is not available (grayed) the selected 
frame does not contain an OLE object. 

The Object Properties dialog box is displayed. The Object Properties 
dialog box options allow you to change the properties of the selected 
OLE object. Refer to page 6-52 for more information on the options in 
this dialog box. 

~ Select the Edit button. 

The server application and file can also be opened by double-clicking in 
a frame containing an object. 

The server application and file from which the object was copied is 
loaded. Because the server file has been edited since the object was 
embedded in Ventura Publisher, the server file and the object in the 
Ventura Publisher should not appear the same. 

If the server application or file is no longer available (e.g., server ap­
plication or file deleted or moved, or the chapter containing the object is 
multi-chapter copied to a system which does not containing the server 
application or file) the object copied to Ventura Publisher cannot be up­
dated until the server application and file are again available. Refer to 
the File Management and OLE section later in this appendix for infor­
mation on how to manage and move chapters containing OLE links. 

~ Select the server application Update option. This option is generally 
located in the Edit menu. 

The Update option will send a copy of the edited server file to the object 
embedded in the Ventura Publisher chapter, thus applying the changes 
in the server file to the object in the Ventura Publisher chapter. 
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File Management and OLE 

The use and operation of OLE presents certain file management re­
quirements for both server applications and Ventura Publisher. This 
section will describe the procedures necessary for file management of 
chapters and server files associated with OLE links. 

Server application and files 

The importance of how server files from which objects pasted into 
Ventura Publisher are handled depends on how the object was pasted 
into the chapter. The following paragraphs describe file management 
considerations to take into account when moving server files associated 
with objects pasted in Ventura Publisher chapters. 

Linked objects When an object is pasted as a linked object, only information about the 
server application and file and a screen representation of the object are 
saved in the object (and the .VPO file). With linked objects, no data is 
saved with the object. In order for the object to be edited and automat­
ically updated, both the server application and original file must be 
available in the same location as when the object was linked with the 
Ventura Publisher chapter. If either the server application or the 
original server file are not available, no editing or automatic updating 
can occur until both are again available. If the server file name or 
location is change no editing or updating can occur until the server name 
or location saved in the object is modified. 
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If the original server file from which the object was created is moved or 
renamed, the Object Properties option dialog box (Edit menu) will 
allow you to modify the object in order to specify the new location and 
name of the server file. To modify the location or name of the server file 
in the object: 

~ Select the frame containing the linked object. 

~ Select the Object Properties option from the Edit menu. If this 
option is not available (grayed) the selected frame does not contain an 
OLE object. 

~ Place the typing cursor in the Document Name entry field and edit 
the name to reflect the new location or name of the server file. 
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Embedded When an object is pasted as an embedded object, the data for that object 
objects. is saved in the object (and the .VPO file). The original server file is no 

longer linked to the embedded object and can be moved or deleted 
without affecting the embedded object. When an object is embedded, 
only the server application itself is required to edit the object. All data 
necessary to recreate the object in a format native to the server applica­
tion is contained in the object. If the server application is not available, 
the embedded object cannot be edited until the server application is 
available. 

When an embedded object is used to start a server application from 
within Ventura Publisher, the object data is passed to the server applica­
tion and the data is reconstructed in a form native to the server 
application. 

Ventura Publisher chapters 

When you use the Manage Publication option to copy a chapter to 
another location, all files associated with the chapters are copied (in­
cluding the .VPO file). However, if a chapter contains an OLE object 
none of the server files will be copied. 

If you are copying a chapter to another location on your system the links 
will be maintained because the server applications and files are in the 
same location. 

If you are copying the chapter to another system, and the server applica­
tions and files are not available, no editing or updating of the objects in 
the chapter can be done until the server application and file are again 
available. 

It is important to note that if the server application or file is not 
available on the system to which the chapter was copied, the link is not 
terminated, but simply suspended. Ifit is necessary to edit the object on 
the system to which the chapter was copied and the object was em­
bedded, simply installing the application will allow you to edit the 
embedded object. If the object was linked to the chapter, installing the 
server application and copying the original server file will allow the 
object to be automatically updated and edited. If the location (drive or 
directory) of the copied server file is different than it was on the initial 
system, you can use the Object Properties option dialog box (Edit 
menu) to edit the server file location saved in the object. 
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~ With the chapter containing the object open in Ventura Publisher, 
select the frame containing the object. 

~ Select the Object Properties option from the Edit menu. If this 
option is not available (grayed) the selected frame does not contain an 
OLE object. 

~ Place the typing cursor in the Document Name entry field and edit 
the path and name to reflect the new location of the server file. 
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Equations, 10-24 
Creating, 11-10 
Cut, copy, paste, 11-12 
Examples, 11-30 
Expression defined, 11-14 
Not displaying properly, 11-12,1-11 - 1-16 
Reserved words as text, 11-25 
Word processor, entering from, D-12 

Error file 
Cross reference, D-12 

Error messages, C-8 - C-22 
Escape (ESC) key, 2-13 
Exit 

File menu, 5-72 
Expression 

Defined, 11-14 

F 

Facing pages view 
View menu, 7-2 -7-3 

Feathering, 8-10, 8-15 
Features 

List, 1-3 

INDEX-4 

Figure numbering across chapters, 6-19 - 6-21 
Figure space, 2-15, H-3 
File 

Change format of text file, 9-37 
Convert frame text to a file, 9-37 
Creating new text, 3-32 
Graphics files created, 5-15 
Print to file, C-4 
Removing, 3-9, 9-33 - 9-35 
Removing excess, 9-34 
Renaming, 9-36 - 9-37 

File list window 
View menu, 7-13 - 7-14 

File menu, 5-1 - 5-72 
Exit, 5-72 
Load diff style, 5-18 - 5-19 
Load text/picture, 5-11- 5-17 
Manage Publication, 5-31- 5-51 
Manage width table, 5-22 - 5-30 
New, 5-2 - 5-3 
Open chapter, 5-4 - 5-6 
Print, 5-54 - 5-61 
Printer setup, 5-52 - 5-53 
Revert to saved, 5-10 
Save, 5-7 
Save as, 5-8 - 5-9 
Save style as, 5-20 - 5-21 

File type/rename 
Converting frame text to a file, 9-37 
Converting text file format, 9-37 
Frame menu, 9-36 - 9-37 

Files 
Backup, 5-7 
CAP, 5-7, 5-9 
CIF, 5-7, 5-9 
Data file extensions, A-4 - A-6 
Name conventions, A-4 - A-6 
Program file extensions, A-4 - A-6 
VGR, 5-7, 5-9 

Files list 
User interface, 2-5 

Fill attributes 
Custom colors and shades of gray, 12-8 
Graphic menu, 12-8 - 12-9 
Pattern option shading values, 12-8 

Filled box, 11-3 
First line indent/outdent, 10-8 
Fit to page 

Reduced view, 2-9 
Fit to window 

See Window width view 
Floppy disks 

Don't load from, 5-12 
Font settings 

Frame menu, 10-3 -10-4 
Font typeface codes, 1-11- 1-16 

r-r 
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Fonts 
Adding new, 5-22 - 5-30, C-2, 1-1 
Changing, 3-25 - 3-26, D-6 
Changing for selected text, 11-46 - 11-47 
Character set, E-1 
Custom colors and shades of gray, 10-4, 11-46 
Defined, H-3 
Installing for Ventura Publisher, 1-1 
Interactive size changing, 3-25, 11-46 - 11-47 
Kerning, 3-26 
Paragraph tag doesn't change, 10-4 
PostScript, F-11 
Printing, won't print font, 10-4 
Selected text, 3-25, 11-46 - 11-47 
Size limitations, 10-4 
TrueType weight bracket codes, D-8 
Typeface codes, 1-11- 1-16 
Wrong size in line art, F-1 

Footed 
Generating continuation, 8-23 

Footer 
Current match, 14-15 -14-19 
Date in footers, 8-23 
Defined, H-3 
Time in footers, 8-23 

Footnotes, 8-26 - 8-29 
Changing placement, 8-28 
Deleting, 11-4 
Editing, 11-4 
Inserting, 11-4, D-9 
Length limitation, 11-4 
Margins & Columns, 9-5 
Superscript footnote number, 8-29 
Tum onl off, 11-4 

Forced justification, 14-23 
Foreign characters, 3-28, D-3 
Formulas 

See Equations 
Frame anchor 

Cut, copy, paste, 11-34 
Frame background 

Custom colors and shades of gray, 9-31 
Frame menu, 9-31 - 9-32 
Pattern option shading values, 9-32 

Frame menu 
Add new tag (frame), 9-43 - 9-44 
Anchors & captions, 9-14 - 9-20 
File type/rename, 9-36 - 9-37 
Frame background, 9-31- 9-32 
Frame typography, 9-12 - 9-13 
Image settings, 9-38 - 9-42 
Margins & columns, 9-2 - 9-5 
Remove text/file, 9-33 - 9-35 
Repeating frame, 9-21 - 9-24 
Ruling lines, 9-28 - 9-30 
Sizing & scaling, 9-6 - 9-11 

Update frame tag list, 9-45 - 9-48 
Vertical rules, 9-25 - 9-27 

Frame ruling lines 
Custom colors and shades of gray, 9-30 
Dashes, 9-30 
Pattern option shading values, 9-30 

Frame tag 
Adding, 9-43 - 9-44 
Attributes not saved with frame tags, 3-12 
Changing tag attributes, 3-13 
Creating, 9-45 
Defined, 3-12 
Deleting, 3-13, 9-46 
Described, 3-12, 9-43 - 9-44 
Frames that cannot be tagged, 3-12 
Frames with captions, 3-14 
Loading from another chapter, 9-47 
Making a tagged frame a repeating frame, 3-12 
Merging from another chapter, 3-13 
Renaming, 3-13 

Frame text 
Converting to text file, 9-37 

Frame tool, 3-15 - 3-17 
Frame Typography 

Frame menu, 9-12 - 9-13 
Frames 

Anchoring, 11-31, D-9 
Attributes not saved with frame tags, 3-12 
Background, 9-31- 9-32 
Changing frame tag attributes, 3-13 
Changing size, 3-11 
Column snap, 7-11 
Creating automatic captions using frame tags, 3-14 
Creating captions for, 9-14 - 9-20 
Creating multiple, 3-16, 9-33 
Defined, 3-15 - 3-17, H-3 
Defining colors for, 10-49 - 10-63 
Deleting frame tags, 3-13 
Frame anchors, 9-14- 9-20 
Frame captions and frame tags, 3-14 
Frame tags, 3-12 
Frame tags assigned to repeating frames, 3-12 
Frames that cannot be tagged, 3-12 
Gray selection lines, 9-22 
Grid settings, 12-11-12-12 
Handles, 3-11 
Line snap, 7-12 
Margins, 7-4 
Menu, 9-1- 9-48 
Merging frame tags, 3-13, 9-47 
Moving, 3-10 
Moving to another page, 3-10 
Placement, 9-6, 14-20 
Placing files in, 3-6 
Re-anchor, 6-22 - 6-23 
Removing file from, 3-9, 9-33 
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Renaming frame tags, 3-13 
Repeating, 9-22 - 9-23 
Ruling box around, 9-28 - 9-30 
Ruling lines, 9-28 - 9-30 
Selecting frame on bottom, 3-5 
Selecting multiple, 3-5, 14-20 
Selecting underneath, 14-20 
Selection borders, 14-21 
Sizing & Scaling, 9-6 - 9-11 
Text fit, 14-21 
Text flow around, 9-6 
Text in, 3-69 
Vertical rules, 9-25 - 9-27 
Wordwrap around, D-5 

Function buttons 
Default buttons, 2-3 
User interface, 2-3 

Function keys 

G 

See also Assign function keys 
Assigning, 10-71 
Assigning paragraph tags to, 10-66 -10-76 

Generated tags, 3-64, 6-25 
Glossary, H-1 
Go to page 

Chapter menu, 8-32 - 8-33 
Keyboard shortcuts, 8-33 
Relative to file, 8-33 

Graphic menu, 12-1-12-12 
Bring to front, 12-5 
End styles, 12-7 
Fill Attributes, 12-8 - 12-9 
Grid settings, 12-11 - 12-12 
Line attributes, 12-6 - 12-7 
Select all, 12-10 
Send to back, 12-4 
Show on this page, 12-2 - 12-3 

Graphic tools, 3-47 - 3-53 
Drawing graphics, 3-48 
Drawing multiple graphics, 3-48 
Keep tool selected, 2-13 
Option buttons, 3-47 

Graphics 
Changing line attributes, 12-6 - 12-7 
Changing the fill attributes, 12-8 - 12-9 
Circles, 3-49 
Constraints, 3-49 
Cut, copy, paste, 6-7 
De-selecting, 12-10 
Defining colors for, 10-49 - 10-63 
How to use, 3-47 
Load defaults, 12-7, 12-9 
Moving, 3-10, 3-50 

INDEX-6 

Moving to another page, 3-10 
Repeating, 3-51, 12-2 
Save defaults, 12-7 
Select all, 3-49, 12-10 
Selecting, 3-49 
Selecting graphic on bottom, 3-5, 3-50 
Selecting multiple, 3-49, 14-20 
Squares, 3-49 

Gray 
Defining custom shades of, 10-60 

Gray-scale 
Displaying, 9-38 

Gray-scale images 
Half toning, 9-38 - 9-42 
Slow displaying, 5-17 

Greek characters, 3-29 
Greeking, 6-26, 7-2 

Defined, H-3 
Grid settings, 3-48 

Graphic menu, 12-11-12-12 
Gutters, 9-3, H-3 

H 

Halftoning, 9-38 - 9-42 
Hanging indent, H-6 

See also Headings 
See also Outdent 

Header & Footer 
Current match feature, 14-15 -14-19 

Header and footer continuations 
Using the current match feature, 8-23 

Headers 
Current match, 14-15 - 14-19 
Date in headers, 8-23 
Generating continuations, 8-23 
Time in headers, 8-23 

Headers & Footers 
Chapter menu, 8-19 - 8-24 
Don't print, C-3 
Kerning codes, 8-22 
Large, 9-23 
Margins & Columns, 9-5 
Multi-column, 9-23 
Tags, 3-64 
Text attributes in, C-5 
Turn on/off, 8-25 

Headings 
Outdented, 14-6 

Help 
Button description, 2-3,2-6 
Context sensitive, 2-13 
General help, 2-13 

Hidden characters, 7-9 

\,;I-n 

Ventura Publisher symbols appear iilcorrect, 7-9 
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Hidden text, D-9 
Hide all/this picture(s) 

View menu, 7-4 
Highlight text, 3-23 
Hollow box, 11-3 
Home key, 2-13 
Horizontal tabs, 10-22 - 10-24 
HP LaserJet 

Font size limits, F-10 
Paper size, F-9 
Rotated text, F-lO 
White text, F-10 

HPGL, 5-17, G-3 - G-8 
Conversion settings, G-5 

Hyphenation 
Alternate hyphenation algorithms, B-5 
Changing hyphenation applied to a tag, B-2, B-6 
Compatibility with GEM version hyphenation, B-2 
Dictionary, B-1 
Foreign hyphenation algorithms, B-5 
Overriding for specific words, 3-31 
Turning on/off, 10-6 
Using multiple hyphenation algorithms, B-2 

Hyphens 
Discretionary, 3-31, D-8 
Non-breaking, 3-31 
Removing, 3-31, D-8 

Image 
Cropping, 9-9 

Image settings 
Frame menu, 9-38 - 9-42 

Images 
Color, 5-17 
Cropping, 2-14, 9-8 
Defined, 3-9, H-4 
EPS screen display, G-2 
Gray-scale, 5-17 
Half toning, 9-38 - 9-42 
Pasting from other Windows applications, 6-11 
Scaling, 9-8 
Sizing, 9-11 

Importing files 
See Load text/picture 

In from left/right 
Description, 10-13 
Interactively setting, 3-56 

Inch,2-17 
Indent, 10-8 

Defined, H-4 
First line, 10-8 
From both margins, 10-13 
Interactively setting, 3-56 

Indents/Outdents, 14-7 
Index 

Creating, 11-5 
Creating within word processor, D-9 
Deleting, 11-7 
Generating, 5-44 
Repeat automatically throughout section, 8-22 
Tags, 3-64 

Index entry 
Cut, copy, paste, 11-8 

INF files, A-1 
Insert column 

Table menu, 13-2 
Insert key, 2-13 
Insert new table, 13-10 -13-14 
Insert row 

Table menu, 13-2 
Insert special item, 11-36 

Box character, 11-3 
Cross reference, 11-34 
Equation, 11-10 
Footnote, 11-4 
Frame anchor, 11-31 
Index entry, 11-5 
Marker name, 11-34 
Table, 11-41 
Text menu, 11-2 -11-42 
Variable definition, 11-39 

Insert/edit anchor, 11-31 
Insert/edit index, 11-5 
Insert/edit table, 3-37 
Insert/remove pages 

Chapter menu, 8-30 - 8-31 
Inter-line spacing, 10-11 

Defined, H-4 
Inter-paragraph spacing, 10-12 
Italics, D-5 

J 
Join cells 

Table menu, 13-3 
Justification 

Defined, H-4 
Forced, 14-23 
Vertical,8-10 

K 
Keep with next, 10-21 
Kerning, 3-26 

Automatic, 10-29 
Defined, H-4 
Global On/Off, 8-9 
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Interactive, 3-26 - 3-27 
Manual, D-6 
On-screen, 3-27, 6-27 

Keyboard 
Characters not on, 3-28, D-3 
Keys, 2-13 - 2-16 
Shortcuts, 2-15 

Knockout 
Defining a color as, 10-53 

L 

Labels 
See Call outs 

Landscape, 8-3 
Defined, H-4 

Large documents 
Creating, 5-31 

Layout 
Defined, H-4 

Lead-ins, 10-18, 10-20 
Creating, 14-7 

Leaders 
Defined, H-4 

Leading 
Defined, H-4 

Left justify text 
See Alignment 

Letter spacing, 7-10,10-29 
Letterspacing 

Interactive, 3-27 
Line art 

Cropping, 9-9 
Defined, 3-9, H-5 
Importing from other Windows applications, 6-11 
Scaling, 9-8 

Line attributes 
Custom colors and shades of gray, 12-6 
Graphic menu, 12-6 - 12-7 

Line break, 2-14, 10-18 - 10-21, D-8 
Defined, 3-29, H-5 

Line length, H-5 
Line snap 

View menu, 7-12 
Lines 

Drawing straight lines, 3-49 
Horizontal or vertical, 3-49 

Load defaults, 12-7 
Load different style 

File menu, 5-18 - 5-19 
Load text/file 

Loading several files, 5-12 
Load text/picture 

Ami Pro, D-21 
ASCII text, D-16 
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Changes to text, 5-14 
Database data, 3-46, D-20 
DCA, D-21- D-23 
Destination, 5-13 
Don't load from floppy, 5-12 
File menu, 5-11- 5-17 

L-M 

Loading and displaying color images, 5-17 
Loading and displaying gray-scale images, 5-17 
Loading too many files, 5-13 
Microsoft Word, D-24 
Microsoft Word for Windows, D-24 
Multimate, D-25 
PRN to table, 3-46 
Several files, 5-12 
Spreadsheet data, 3-46, D-17 
Windows Write, D-24 
WordPerfect, D-26 
WordStar, D-26 
Xywrite, D-27 - D-28 

Loading a style sheet, 3-60 
Loading several files, 5-12 
Logoff 

See Exit 
Loose lines, 7-10 
Lotus 1-2-3, D-1 

Creating pictures, G-9 
Lotus Manuscript, D-21 

M 

Macintosh 
Paint, G-9 
PICT, G-10 

Main screen 
Button bar, 2-2 
Classic interface, 2-18 
Current selection indicator, 2-6 
Menu bar, 2-2 - 2-9 
Page buttons, 2-9 
Page number indicator, 2-6 
Rulers, 2-10 
Tab bar, 2-10 
Zoom controls, 2-7 

Mainframe 
Text files from, D-16 

Maintain aspect ratio, 9-8 
Manage Publication 

Add chapter, 5-33 
Copy all, 5-47 
File menu, 5-31- 5-51 
Make index, 5-44 
Make TOC, 5-42 
Modes, 5-33 
Multi-chapter printing using soft fonts, 5-40 
Print, 5-39 
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Rearranging chapter order, 5-34 
Renumber, 5-46 

Manage width table 
ENVIRON.WID width table, 5-23 
File menu, 5-22 - 5-30 
Generating a custom width table, 5-29 
Renaming ENVIRON. WID, 5-29 

Manuscript, D-21 
Margins 

Binding, 9-4 
Interactive temporary text margins, 3-56 
LefUright page, 9-4 
Temporary text margins, 10-13 

Margins & Columns 
Frame menu, 9-2 - 9-5 

Marker name, 11-36 
Cut, copy, paste, 11-37 
Editing, 11-43 

Math characters, 3-29 
Measurement units 

Changing, 2-17 
Rulers, 7-5 

Mechanical, H-5 
Memory 

Changing memory requirements, A-1 
Menu 

"Click" vs. "Select" in the documentation, 1-4,4-1 
Can't select, 4-1 
Gray text, 4-1 

Menu bar, 2-1 
User interface, 2-2 - 2-9 

Menu options, 4-1 - 4-4 
Merging frame tags, 3-13 
Microsoft Word, D-24 

Style Sheets, D-24 
Microsoft Word for Windows, D-24 
Minimum space width, 10-31 
Monospaced, H-5 
Mouse 

Cursor, 2-11 - 2-12 
Operation, 2-11- 2-12 

Move 
See CuUcopy/paste 

Multi-chapter operations 
Modes, 5-33 

Multi-chapter printing 
Printing to file using soft fonts, 5-40 

Multimate, D-25 
Multiple article chapters, 3-69 
Multiple copy printing, 5-55 
Multiple frames, 3-5, 3-16, 14-20 
Multiple graphics, 3-49 
Multiple paragraph tagging, 3-19, 3-34 

N 

Network operation, C-7 
Open chapter, 5-5 

New 
File menu, 5-2 - 5-3 
Loading a style sheet with a new chapter, 5-2 - 5-3 

New page, 3-72 
Newsletter layout, 3-69 

Reusing, 3-73 
Non-breaking space, 2-15, 3-30, D-8 
Normal space width, 10-33 
Normal view 

Normal view button, 2-9 
View menu, 7-2 - 7-3 

Numbering 
Automatic section numbering, 10-41- 10-48 
Chapter, 6-19 - 6-21 
Chapter numbers, 5-46 
Lists, 10-46 
Page, 6-19 - 6-21 
Pages of a chapter, 5-46 

o 
Object properties 

Edit menu, 6-52 - 6-56 
Embedded objects, 6-54 
Linked objects, 6-52 

Office Writer, D-23 
OLE 

Linking or embedding text based objects, K-2 
Object properties, 6-52 - 6-56 
Paste link, 6-15 - 6-16 
Paste option not available, 6-13, 6-15, 6-18, K-3, K-7 
Paste special, 6-17 - 6-18 

OLE objects 
Importing from other Windows applications, 6-13 

Open 
Can't open file, A-3 

Open chapter 
File menu, 5-4 - 5-6 

Option buttons 
User interface, 2-4 

Options 
"Click" vs. "Select" in the documentation, 1-4, 4-1 

Orientation, 8-2 
Orphan 

Defined, 8-5, H-6 
Outdent, 10-8 

Defined, H-6 
First line, 10-8 
See also Indents/Outdents 
Interactively setting, 3-56 

Outlines, 10-41 - 10-48 
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Overprint 
Defining a color as, 10-53 

Overscore 
Change defaults, 10-27 - 10-29 

p 

Padding, 9-8 
Page 

Buttons, 2-9 
Create new, 3-72 
Custom size, 9-10 
Defined, H-6 
Go to, 8-32 - 8-33 
Insert/remove, 8-30 - 8-31 

Page break, 10-18 -10-21,14-22 
Page buttons, 2-1 

User interface, 2-9 
Page counter, 6-19 - 6-21 
Page down, 2-13 
Page layout 

Chapter menu, 8-2 - 8-4 
Page number indicator 

User interface, 2-6 
Page numbering across chapters, 6-19 - 6-21 
Page up, 2-13 
Paper size, 8-3 
PARAFILTR, D-15 
Paragraph 

Adding and deleting, 3-34 
Alignment, 10-5 -10-9 
Changing tag attributes with the Text tool, 3-35 
Changing the font for a paragraph, 10-3 - 10-4 
Defined, H-6 
Line break, 3-29 
Modifying attributes of multiple paragraphs, 10-2 
Numbering automatically, 10-41- 10-48 
Selecting, 10-2 
Spacing, 10-14 

Paragraph menu, 10-1- 10-76 
Add new tag (paragraph), 10-64 - 10-65 
Alignment, 10-5 -10-9 
Attribute overrides, 10-27 -10-28 
Auto-numbering, 10-41 - 10-48 
Breaks, 10-18 - 10-21 
Define colors, 10-49 - 10-63 
Font settings, 10-3 - 10-4 
Paragraph typography, 10-29 - 10-35 
Ruling lines, 10-36 -10-40 
Spacing, 10-10 - 10-17 
Special effects, 10-25 - 10-26 
Tab settings, 10-22 - 10-24 
Update tags list (paragraph), 10-66 - 10-76 

Paragraph ruling lines 
Custom colors and shades of gray, 10-38 
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Dashes, 10-39 
Pattern option shading values, 10-39 

Paragraph tags 
Adding new, 10-64 -10-65 

Paragraph tool, 3-18 - 3-21 
Option buttons, 3-18 

Paragraph typography, 10-34 
Paragraph menu, 10-29 - 10-35 
See also Vertical justification 

Paste 
Defined, H-6 

p p 

Determining format of data on the clipboard, 6-10 
Edit menu, 6-5 - 6-14 
Paste link, 6-15 - 6-16 

Paste link 
Edit menu, 6-15 - 6-16 
OLE, 6-15 - 6-16 

Paste special 
Edit menu, 6-17 - 6-18 

PC Paint 
Can't load files, C-7 

PCTTOGEM.CNF, G-10 
PCX pictures 

Color, G-11 
Creating, G-11 

Pens 
HPGL,G-5 

Performance 
Decreasing program and chapter load times, 5-23 
Slow screen refresh, A-I 

Picas, 2-17 
Defined, 2-17, H-6 

Picture anchor, D-9 
Pictures 

ACAD, G-1 
CGM, G-1 
Cropping, 9-9 
DCS, G-1 
Defined, 3-9, H-6 
EPS, G-2 
Flowing text around irregular shaped pictures, 14-13 

-14-14 
HPGL, 5-17, G-3 - G-8 
Loading, 5-11- 5-17 
Lotus 1-2-3, G-9 
Macintosh paint, G-9 
Macintosh PICT, G-10 
Obscures text, F-12 
PCX/PC Paintbrush, G-11 
PostScript, 5-16 
Scaling, 9-8 
Video Show, G-11 
Windows Metafile, G-ll- G-12 

Placeable Windows metafile, G-11- G-12 
Pointer 

See Selector tool 
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Points, 2-17 
Defined, 2-17, H-6 

Portrait, 8-3 
Defined, H-6 

PostScri pt, F-11 
Defined, H-6 
Encapsulated, G-2 
EPS screen display, G-2 
Files, 5-16 
Files don't display, 5-16 
Fonts, F-11 
Resolution, F-11 

Pound character (#) in dialog boxes, 2-17 
Print 

File menu, 5-54 - 5-61 
Style sheet, 10-66 - 10-76 

Print file 
LaserWriter, F-11 

Print style sheet, 10-72 
Printer 

Capabilities, 12-9 
Determining limitations of, F-1 
Formatting chapter for a different printer, 5-52 

Printer setup 
ENVIRON.WID width table file, 5-53 
File menu, 5-52 - 5-53 

Printer troubleshooting, F-1- F-8 
Nothing prints from any program, F-3 
Nothing will print on a PostScript printer, F-5 

Printers 
Changing printers, 5-52 - 5-53 

Printing 
Chapter, 5-54 - 5-61 
Collated copies, 5-55 
Color separations, 5-58 
Crop marks, 5-58 
Double sided, 8-3 
Draft printing, 5-67 
Duplex, 5-55 
Fonts won't print, 10-4 
Large format, 5-58 
Mulitple chapters to file, 5-39 
Multiple copies, 5-55 
Portrait or landscape, 8-3 
Print hidden pictures, 5-58 
Printer won't print, C-3 
Printing to a file, 5-62 - 5-71, C-4 
Publication, 5-39 
Publication to file, 5-39 
Reversed printing order, 5-58 
Selected pages, 5-54 
Setup, 5-56 
Stopping, 5-54 
Using .PFM font metric files, 5-65 

PRN to table, 3-46 
Importing PRN type files, 3-46 

Using the destination option, 3-46, 5-14 
Program limitations, 1-3 
Publication 

Q 

Copy, 5-47 
Creating, 5-31 
Defined, H-6 
Importance of chapter order, 5-34 
Making a publication, 5-33 
Making and index, 5-44 
Rearranging order of chapters, 5-34 
Renumbering, 5-46 

Quit 
See Exit 

Quotes 

R 

Auto conversion, 6-27 
True typographic, 3-29 

Re-anchor frames 
Edit menu, 6-22 - 6-23 

Redraw screen, 3-33 
Reduced view 

Screen flicker while in, 7-2 
User interface, 2-9 
View menu, 7-2 - 7-3 

References 
Word processor, entering from, D-10 

Reformat page, 2-13 
Register marks, H-2 
Registration marks, 5-58 
Remove 

File, 9-33 - 9-35 
Frame tags, 9-46 
Page, 8-30 - 8-31 
Paragraph tag, 10-66 -10-76 

Remove text/picture 
Frame menu, 9-33 - 9-35 

Rename 
Paragraph tag, 10-66 - 10-76 

Renaming 
Frame tags, 9-46 

Renumber chapter 
Edit menu, 6-24 

Renumber chapters, 5-46 
Repeating Frame 

Frame menu, 9-21- 9-24 
Repeating frames 

Text in, 3-8 
Repeating graphics, 12-2 - 12-3 
Reset section number, 10-46 

INDEX-11 



Reverse type, 10-39, 14-9 
Revert To Saved 

File menu, 5-10 
Revision nuinbers, 11-39 
Right justify text 

See Alignment 
Ruler 

Setting the ruler, 7-5 - 7-6 
Zero point changing, 3-54, 7-5, 7-7 

Rulers 
Interactive setting, 7-6 
Measurement units, 7-5 
Showing the ruler, 7-7 
User interface, 2-10 

Ruling lines 
Custom width, 10-37 
Dashes, 9-30, 10-39 
Defined, H-7 
Frames, 9-28 - 9-30 
Paragraph menu, 10-36 - 10-40 
Table menu, 13-8 - 13-9 
Vertical, 9-25 - 9-27 

Ruling lines (frames) 
Frame menu, 9-28 - 9-30 

Runarounds, 14-13 - 14-14, C-6 
Defined, H-7 

5 

Samna Word, D-23 
Sans serif 

Defined, B-7 
Save 

File menu, 5-7 
Save as 

File menu, 5-8 - 5-9 
Save defaults, 12-7 
Save Style As 

File menu, 5-20 - 5-21 
Scale 

Defined, B-7 
Scaling, 9-8 
Scanned images, 9-38 - 9-42 
Scanner, 5-16 

Compatibility, C-6 
Defined, H-7 

Search 
Special items, 6-49 

Search and replace 
Edit menu, 6-37 - 6-51 
Searching for whole words, 6-40 
Tags, 6-44 
Text/attributes, 6-38 

Secondary leading 
See Inter-paragraph spacing 
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Section numbering, 10-41 - 10-48 
In frames, 10-43 
Tags, 10-45 

Select 
Defined, 1-4 
Text, 3-23 

Select all, 3-49 
Graphic menu, 12-10 

Selector tool, 3-4 - 3-14 
Frame tags, 3-12 
Option buttons, 3-4 
Selecting frames, 3-5 
Selecting graphics, 3-5 
Using the Selector tool, 3-4 - 3-14 

Send to back 
Graphic menu, 12-4 

Serif 
Defined, B-7 

Set column width 
Table menu, 13-6 - 13-7 

Set font attributes 
Text menu, 11-46 - 11-47 

Set preferences 
Edit menu, 6-25 - 6-28 

Set ruler 
View menu, 7-5 - 7-6 

Set Screening 
Chapter menu, 8-34 - 8-36 

Set tint 
Custom colors and shades of gray, 13-5 
Pattern option shading values, 13-5 
Table menu, 13-4 - 13-5 

Shaded type, 14-11 
Shift 

Font, 3-28, D-6 
Shift keys, 2-13 
Shortcut, 2-15 

Keyboard, go to page, 8-33 
Show all/this picture(s) 

View menu, 7-4 
Show column guides 

View menu, 7-8 
Show loose lines 

View menu, 7-10 
Show on all pages 

Graphic menu, 12-2 - 12-3 
Show on this page 

Graphic menu, 12-2 - 12-3 
Show page header/footer 

Chapter menu, 8-25 
Show rulers 

View menu, 7-7 
Show tabs & returns 

View menu, 7-9 
Sizing & scaling, 14-20 

Frame menu, 9-6 - 9-11 
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Sort keys, 11-6 
Space, 3-30 

Em, 2-15, H-3 
En, 2-15, H-3 
Figure, 2-15, H-3 
Non-breaking, 2-15, 3-30, D-8 
Thin, 2-15, H-7 

Spaceband, 10-31 
Spacing 

Adding additional between paragraphs, 3-17 
Mter period, colon, 5-15 
Between paragraphs, 5-14, 10-12 
Between words, 10-31 
Inter-line, 10-11 
Interactive in from leftJright setting, 3-56 
Paragraph menu, 10-10 - 10-17 
Paragraphs, 10-14 
Total paragraph space, 10-16 

Special effects 
Paragraph menu, 10-25 - 10-26 

Special function keys, 2-14 
Special item 

Editing, 11-43 
Insert, 11-2 - 11-42 

Special items 
Search for, 6-37 - 6-51 
Spell check, 6-32 

Speed 
Improve chapter loading speed, I-I 
Improve program loading speed, I-I 
Improving screen drawing speed, 7-4 
Slow loading due to excess files, 9-34 

Spell check 
Add to personal dictionary, 6-33 
Change to, 6-33 
Edit menu, 6-29 - 6-36 
Editing the personal dictionary, 6-35 
Guess, 6-33 
Special items within a word, 6-32 
Special items within words, 6-32 
Suggestion list, 6-33 
Unknown word, 6-32 

Split cells 
Table menu, 13-3 

Spreadsheets 
Converting to tables, 3-46 
Importing data from, D-17 

Square box, D-I0 
Squares 

Drawing, 3-49 
Standard Windows metafile, G-11- G-12 
Stretch to fit, 9-8 
Strike-thru 

Change defaults, 10-27 - 10-29 
Style sheet 

Changed unexpectedly, 5-20 

Copying tags between, 6-10 
Creating, 3-60 
Defined, 3-60, H-7 
Equations, 11-13 
Examples, J-l 
How to create, 3-61 
Loading, 3-60, 5-18 - 5-19 
Margins & Columns stored in, 9-1 
Menu options affecting, 3-62 
Modifying, 3-21, 3-60 
Print, 10-66 - 10-76 
Saving, 3-60, 5-20 - 5-21 
Unwanted changes in, 5-7 

Style sheets 
Compatibility with previous versions, 5-21 

Subscripts, 3-23, 10-28, D-5 
Superscripts, 3-23, 10-28, D-5 
Support, 1-2 
Suppress previous level, 10-43 
Symbols, 3-28 - 3-29, E-l 

T 

Tab bar 
Adding a tab, 3-55 
Deleting a tab, 3-55 
In from leftJright marker, 3-56 
In/outdent marker, 3-56 
Moving a tab, 3-55 
User interface, 2-10 
Using the tab bar, 3-54 - 3-57 

Tab buttons, 3-54 
Tab key, 2-14 
Table menu, 13-1- 13-14 

Insert column, 13-2 
Insert row, 13-2 
Join cells, 13-3 
Ruling lines, 13-8 - 13-9 
Set column width, 13-6 -13-7 
Set tint, 13-4 - 13-5 
Split cells, 13-3 

Table numbering across chapters, 6-19 - 6-21 
Table of contents 

Generating, 5-42 
Tags, 3-64 

Table text, 3-37 - 3-38 
Table tool, 3-36 - 3-46 

Option buttons, 3-36 
Tables, 3-36 - 3-46 

Aligning numbers (figure space), H-3 
Changing cell background color, 13-4 - 13-5 
Cut/copy/paste, 3-40 
Definition, 3-36 
Edit, 3-39 
Grouping cells, 3-41 

INDEX 
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Insert row/column, 13-2 
Insert Special Item option, 11-41 
Insert/edit tables, 13-10 - 13-14 
Join/split cells, 13-3 
Max. ruling lines/table, 13-9 
Rules between cells, 13-8 
Ruling lines, 13-8 - 13-9 
Ruling lines, changing, 13-8 
Ruling lines, creating new, 13-9 
Selecting cells, 3-39 
Set column width, 13-6 - 13-7 
Set tint, 13-4 - 13-5 
Vertical justification, 10-35 
Word processor, entering from, D-13 

Tabs, 10-22 - 10-24 
Changing decimal, 6-28 
Deleting, 3-55 
From word processor, D-3 - D-4 
Text right margin, 10-24 
Using the tab bar, 3-54, 10-22 
Versus spaces, D-4 
WordStar, D-27 

Tag list window 
View menu, 7-13 - 7-14 

Tag multiple paragraphs, 3-19, 3-34 
Tagging using the text tool, 3-34 
Tags (frame), 3-12 

Adding, 9-43 - 9-45 
Attributes not saved with frame tags, 3-12 
Changing frame tag attributes, 3-13 
Defined, 3-12 
Deleting frame tags, 3-13 
Frames that cannot be tagged, 3-12 
Frames with captions, 3-14 
Merging, 9-47 
Merging frame tags from another chapter, 3-13 
Renaming, 9-46 
Renaming frame tags, 3-13 
Repeating frame, 3-12 
Update tag list, 9-45 - 9-48 

Tags (paragraph) 
Applying tags to paragraphs, 3-19 
Assigning to function keys, 10-66 - 10-76 
Assigning to text, 3-18 - 3-21 
Auto-numbering, 10-45 
Captions, 9-19 
Changing attributes with the Text tool, 3-35 
Changing font, 10-3 
Choosing names, 3-63 
Copying between style sheets, 6-10 
Defined, 10-1, H-7 
Extracting tagged text, 8-21 
Frame-wide, 10-8 
Function keys, 2-14 
Generated, 3-21, 3-64 
Headers & Footers, 8-24 

Hidden, 6-25 
In a word processor, D-2 
Modifying, 3-21 
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Modifying attributes of multiple paragraphs, 10-2 
Removing, 10-66 - 10-76 
Renaming, 10-66 -10-76 
Search and replace, 6-37 - 6-51 
Spacing automatically changed, 10-4 
Tagging multiple paragraphs, 10-2 
Unexpected new names, 3-63 
Z_ tags, 3-64 

Tags list 
User interface, 2-5 
Using with Headers and Footers dialog box, 8-21 

Technical support, 1-2 
Template, 3-73 
Text 

Adding and deleting, 3-28 
Alignment, 10-5 -10-9 
Ami Pro, D-21 
See also ASCII text 
Automatic text insertion, 10-47 
Beyond right margin, 10-24 
Changes during loading, 5-14 
Converting frame text to a file, 9-37 
Converting to another word processor format, 3-59, 

9-37 
Copy-fitting, 14-21 
DCA, D-21- D-23 
Defining colors for, 10-49 - 10-63 
From databases, D-20 
From spreadsheets, D-17 
Hidden, D-9 
In frames, 3-69 
Keep away from frames, 9-8 
Linking or embedding as an OLE object, K-2 
Loading, 5-11- 5-17 
Microsoft Word, D-24 
Microsoft Word for Windows, D-24 
Multimate, D-25 
Overlapping frames, 3-72 
Reverse, 10-39 
Ruling lines, 10-36 - 10-40 
Search and replace, 6-37 - 6-51 
Spell check, 6-29 - 6-36 
Text entered in captions, 9-16 
TrueType text attribute weight codes, D-8 
Ventura Publisher symbols appear incorrect, 7-9 
White on black, 9-31, 10-39 
Windows Write, D-24 
WordPerfect, D-26 
WordStar, D-26 
Xywrite, D-27 - D-28 

Text attribute options 
Text menu, 11-44 - 11-45 

Text attributes 
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Canceling, D-6 
Changing, 3-23 
Cut/copy, 6-6 
Deleting vs copying, 3-33 
End of paragraph, D-6 
Precedence over tags, 3-25, 11-48 
Search and replace, 6-38 
Selected text, 11-44 - 11-45 
Word processor, D-5 - D-6 

Text cursor 
Defined, 1-4 

Text editing, 3-28 
Across page boundaries, 8-33 
Adding non-keyboard characters, 2-14 
Adding/deleting text, 3-28 
Alt key, 2-14 
Arrow keys, 2-13 
Backspace key, 2-13 
Blank frame/page, 3-32 
Ctrl key, 2-14 
Delete key, 2-13 
End key, 2-13 
Enter key, 1-4 
Escape (ESC) key, 2-13 
Insert key, 2-13 
Line break, 2-14, 3-29 
Non-breaking space, 3-30 
Non-keyboard symbols, 3-28 
Page down key, 2-13 
Page up key, 2-13 
Paragraphs, adding/deleting, 3-34 
Section numbers, 10-43 
Select text, 3-23 
See also Shift font 
Shift keys, 2-13 
Show tabs & returns, 7-9 
Special function keys, 2-14 
Tab key, 2-14 

Text flow around, 9-6 
Text menu, 11-1- 11-48 

Change text to, 11-48 
Edit special item, 11-43 
Insert special item, 11-2 -11-42 
Set font attributes, 11-46 - 11-47 
Text attribute options, 11-44 - 11-45 

Text tool, 2-13, 3-22 - 3-35 
Changing tag attributes, 3-35 
Changing typeface, 3-25 
Kerning, 3-26 
Modifying tag attributes, 10-2 
Option buttons, 3-22 

The basics, 3-1- 3-80 
Thin space, 2-15, H-7 
Thumb tab, 9-21 
TIFF 

Displaying gray-scale TIFF files, 9-38, G-2 

Time 
In headers and footers, 8-23 

Title bar, 2-1, 5-7 
Tool buttons 

User interface, 2-3 
Toolbox window 

View menu, 7-13 - 7-14 
Tracking 

Interactive, 3-26 - 3-27 
Trim pictures 

See Cropping 
Troubleshooting 

# character in dialog box, 2-17 

INDEX 

Alert messages while copying publication, 5-50 
Apostrophe and quotes won't print, 6-28 
Blank columns, 10-8 
Blank near edge of page, F-9 
Button grayed, 4-1 
Can't select button, 4-1 
Can't select frame or graphic under another, 3-5 
Cannot find the SPLDICT.PD dictionary file, 6-35 
Cannot tag a repeating frame, 3-12 
Caption doesn't appear, 9-18 
Change All option did not change all, 6-34 
Chapter different than saved, 3-61, 5-20, 10-68 
Chapter does not hyphenate the same as in GEM, B-2 
Chapter loads slowly, 5-23, I-I 
Character doesn't print, 3-29 
Columns don't balance, 8-8 
Copy, all files not copied, 5-49 
Dashed lines do show on the screen, 9-30, 10-39 
End styles appear on wrong end ofline, 12-7 
Enter doesn't end dialog, 5-49 
Error messages, C-8 - C-22 
Facing pages view inoperative, 8-4 
Facing pages view not available, C-5 
File, can't find, A-5 
Files list, can't select, 2-5 
Font style selection unavailable, 10-4 
Font, won't change, 10-4 
Fonts won't print, 10-4 
Footer spacing too large, 8-24 
Footnote space above, 8-28 
Footnotes don't appear, 8-27, 11-4 
Frame/graphic moves instead of changing size, 3-11 
Graphic repeats on every page, 3-51 
Graphics do not print on HP printer, F-2 
Gray-scale TIFF images do not display grays, 9-38, 

G-2 
Header not displayed, 8-25 
Header spacing too large, 8-24 
Header/footer doesn't display, 8-20 
Headers & footers do not print, F-2 
Menu option gray, 4-1 
Nothing will print, F-3 
OLE objects not updating automatically, K-6 
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Open chapter is slow, 5-5 
Overprint color acts like a knockout color, 10-52 
Overprint color separates like a knockout, 10-53 
Pages with color images redraw too slow, 5-17 
Paragraph menu, can't select options, 10-1 
Paragraph overwrites other text, 10-8 
Paragraph ruling box stops at column/page, 10-36 
Paragraph selection lost, 3-21 
Picture doesn't appear, C-5 
Picture obscures text, F-12 
PostScript printer will not print, F-5 
Print, page numbers wrong, 5-55 
Program appears to hang when loading chapter, 5-23 
Program appears to hang when run, 5-23 
Program loads slowly, 5-23, 1-1 
Ruler zero point not staying where set, 3-54, 7-5, 7-7 
Ruling box doesn't print, 14-21, F-12 
Screen flickering in reduced view, 7-2 
Slow screen refresh, A-I 
Spacing changed, 10-4 
Spreadsheet columns don't align, D-19 
Style sheet changed, 5-20 
Tab, first line indent, 10-24 
Tabbed text beyond margin; 10-24 
Tabs and return symbols displaying incorrect, 7-9 
Tabs don't work, 10-23 
Tags added to style sheet, 3-63 
Tags and graphics don't display on Clipboard, 6-6 
Text attributes change, 3-33 
Text disappears, 3-33 
Text doesn't appear in frame, C-5 
Text doesn't match, 3-62 
Text flow around irregular shape, C-6 
Text format changed in word processor, D-2 
Text formatting speed, 8-7 
Text imported as OLE object will not format, K-2 
Text in reverse video or colored, 7-10 
Text in wrong frame, 3-72 
Text into right margin, 10-8 
Text moves to next column/page, 14-21 
Text on top of text, 10-46 
Text, can't place where I want, C-6 
Text, can't read, 6-26 
Text/picture file will not load properly, 5-12 
Vertical rule doesn't show, 9-27 
Wrong font size in pictures, F-1 

True Type 
Text attribute weight codes, D-8 

Typeface 
Defined, H-7 

Typeset 
Defined, H-8 

Typographic controls, 10-27 - 10-35 
Typographic conventions, 1-4 
Typography 

Kerning, interactive, 3-26 
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u 
Underline, D-5 

Change defaults, 10-27 - 10-29 
Undo 

Attribute delete, 3-33 
Text delete, 3-33 

Undo/redo 
Edit menu, 6-2 - 6-4 

UNTITLED.CHP, 5-7 
Update counters 

Edit menu, 6-19 - 6-21 
Update frame tag list 

Frame menu, 9-45 - 9-48 
Update tag list (paragraph) 

Paragraph menu, 10-66 - 10-76 
Upper Case, 3-25 
User interface, 2-1- 2-18 

Button bar, 2-2 
Current selection indicator, 2-6 
Enlarged view button, 2-8 
Files list, 2-5 
Function buttons, 2-3 
Menu bar, 2-2 - 2-9 
Normal view button, 2-9 
Option buttons, 2-4 
Page buttons, 2-9 
Page number indicator, 2-6 
Reduced view button, 2-9 
Rulers, 2-10 
Tab bar, 2-10 
Tags list, 2-5 
Tool buttons, 2-3 
Ventura Publisher classic interface, 2-18 
Window wide view button, 2-9 
Zoom controls, 2-7 
Zoom menu button, 2-7 

Using the Windows Clipboard 
Paste ASCII Text option, 6-11 

u-v 

Paste Bitmap and Paste Metafile options, 6-11 
Paste Object option, 6-13 
Text from other Windows applications, 6-10 

v 
Variable definition 

Cut, copy, paste, 11-41 
Editing, 11-43 

Variable insertion, 11-39 
Vertical justification, 8-6, 8-10 

Above and below tables, 10-35 
Allowed,8-18 
Around frame, 8-16 
At top of frame, 8-17 
Between lines, 10-35 
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Between paragraphs, 10-34 
Carding, 8-15 
Feathering, 8-15 
General guidelines, 8-12 
Tables, 10-35 
Within frame, 8-15 

Vertical rules 
Frame menu, 9-25 - 9-27 

Vertical shift 
See Shift font 

VGR files, 5-7, 5-9 
Video show, G-11 
View menu, 7-1 - 7-14 

Column snap, 7-11 
Enlarged view, 7-2 -7-3 
Facing pages view, 7-2 - 7-3 
File list window, 7-13 - 7-14 
Hide all/this picture(s), 7-4 
Line snap, 7-12 
Normal view, 7-2 -7-3 
Reduced view, 7-2 - 7-3 
Set ruler, 7-5 - 7-6 
Show all/this picture(s), 7-4 
Show column guides, 7-8 
Show loose lines, 7-10 
Show rulers, 7-7 
Show tabs & returns, 7-9 
Tag list window, 7-13 - 7-14 
Toolbox window, 7-13 - 7-14 
Window Width, 7-2 - 7-3 

Volkswriter 3, D-22 
VPWIN.INF file, 5-72 

w 

White letters on a black background 
See Reverse type 

Widow 
Defined, 8-5, H-8 

Widows & Orphans, 8-5 
Width table 

Creating, 1-1 
Description, 5-22 - 5-30 
Generating a custom width table, 5-29 
Printer setup option, 5-52 - 5-53 
Adding kerning to, 10-31 
Defined, H-8 
ENVIRON.WID width table file, 5-23 
Loading a different width table, 5-25 
Merging two width tables, 5-26 
Not in standard format, C-15 
Stored with style sheet, 5-21 
Use, 5-19 

Won't load, C-15 
Window wide view 

Window width view button, 2-9 
Window width 

View menu, 7-2 - 7-3 
Windows applications 

Importing data from, 6-10 
Windows Clipboard, 6-6 
Windows metafile, G-ll- G-12 
Windows Write, D-24 
Word processor, D-1 

Attributes, E-1 
Developing index in, D-10 
Equations in, D-12 
Information deleted, D-1 
Loading text from, D-21 
References in, D-lO 
Tables in, D-13 
Text attributes, D-5 - D-6 
Writing custom converter, D-1 

WordPerfect, D-26 
Password protected files, D-26 

WordStar, D-26 
Tabs, D-4, D-27 

WordStar 2000, D-23 
WYSIWYG 

Defined, H-8 

x 
Xywrite, D-27 - D-28 

z 
Z_ tags, 3-64 
Zero point 
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Adjusting to column edge, 3-54, 7-5,7-7 
Zoom 

Enlarged view button, 2-8 
Fit to page button, 2-9 
Normal view button, 2-9 
Reduced view button, 2-9 
Window width button, 2-9 
Zoom control buttons, 2-7 
Zoom menu button, 2-7 
Zoom starting point, 2-7 

Zoom controls, 2-1 
User interface, 2-7 

Zoom in, 7-2 
Zoom menu button 

User interface, 2-7 
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